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A Message from E. LaVerne Johnson 
CEO, President and Founder - International Institute for Learning, Inc. 

In today’s world, organizations are placing an ever-increasing emphasis on achieving more 
with less. As a business professional, it is absolutely vital for you to continually build upon 
your skills, learn new abilities, and always find ways to stay ahead of the crowd to ensure 
your survival and your success.

So congratulations on taking this next step in your learning process and career! I’m 
confident that this book will help you master new skills to apply to your endeavors and strengthen those 
you already have. We hope that at the conclusion of this book, you feel an active desire and readiness to 
use what you’ve learned to benefit yourself and your organization. 

I would like to dedicate this book to all of the forward-thinking individuals who have worked to further 
project management as a recognized and critical discipline. International Institute for Learning, Inc. 
(IIL) is actively engaged in the advocacy of the project management profession and we commend those 
professionals who seek to advance their own skills and abilities, as well as those of entire organizations 
and communities. They seek to do this in order to increase their collective knowledge and capabilities, to 
advance constructive change and to have their organizations operate more adeptly and efficiently. 

Our hope in writing this book was to inspire those in the project management profession to not only 
better understand and apply underlying project management principles and techniques in their day-to-
day jobs, but to challenge them to break away from the common mindset and develop new and improved 
ideas. 

I’d also like to acknowledge all those individuals who played a role in creating this book—from the 
initial release of the book on up to each new edition we publish. Your hard work and dedication have 
helped to create a resource that has truly become an industry standard. I recognize that the success of 
any collaborative effort is only as good as the sum of the contributions of all of those involved. From the 
original team members who had the vision to create such a powerful book, to those who have helped 
refine it over time, I am grateful to all of you for making this an indispensable reference to those who 
work throughout the project management community.

With kind regards,

E. LaVerne Johnson
Founder, President and Chief Executive Officer
International Institute for Learning, Inc.
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International Institute for Learning, Inc. (IIL)
With a wholly-owned network of operating companies all over the world and clients in more than 150 
countries, IIL is a global leader in training, consulting, coaching, and customized course development. 
Our core competencies include: Project, Program, and Portfolio Management; Microsoft® Project 
and Project Server; Business Analysis; Lean Six Sigma; PRINCE2®; ITIL®; Agile, Leadership and 
Interpersonal Skills, Sustainability, and Corporate Consciousness. 

IIL delivers innovative, effective, and consistent training solutions through a variety of learning 
approaches, including Traditional Classroom, Virtual Classroom, On-Demand, simulation training, 
videos, and mobile apps. Now in our twenty-fourth year of doing business, we are proud to be the learning 
solution provider of choice for many top global companies.

IIL’s business divisions include: 

hh IIL Media, a full-service digital video production company 

hh IIL Printing, providing sustainable digital printing, binding, and fulfillment 

hh IIL Speakers, a bureau of leading industry experts in the areas of Leadership, Sustainability, Project 
Management, and Business Analysis 

hh IIL Publishing, a focused full-scale publisher unit delivering unique, creative, educational resources 
addressing a variety of business topics

IIL and Microsoft: a Rich History
IIL is a Microsoft Partner with a Gold Competency in Project and Portfolio Management. We are 
dedicated to providing individuals, teams, and companies with the training they need to successfully 
manage projects and programs using the Microsoft Project and Project Server solutions.

Since 1998, IIL has provided comprehensive training and certification in Microsoft Project and Project 
Server. Since that time, we have trained tens of thousands of people in Microsoft Project and Project 
Server through our “Belt” certification programs. In addition, IIL has developed the Microsoft Official 
Curriculum (MOC) for past versions of Microsoft Project and many of our instructors have participated 
with Microsoft as SMEs, speakers, and collaborators in Microsoft Project forums.

Many organizations request customized onsite training to support the deployment of Microsoft Project 
Server. IIL has developed a series of role-based Enterprise Project Management (EPM) courses that can 
easily be adapted to the specific needs of a company, depending on its existing business processes and the 
course configuration chosen.

What Sets Us Apart
Three key values define the IIL brand and guide us in all that we do: Intelligence, Integrity, and 
Innovation. We pride ourselves in creating customer loyalty and building relationships that endure, 
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and a large percentage of our clients are multi-year repeat customers. Strengths that have earned us our 
reputation as a frontrunner in the learning industry include:

hh We believe that learning must yield practical, quantifiable benefits to have value, which is why all of 
our courses integrate training approaches that are easy to understand and assimilate. Our curriculum 
is designed to engage your critical thinking skills and give you real-world knowledge that you can 
take back and apply in your work environment.

hh IIL program evaluations point overwhelmingly to the excellence of our trainers. We hold our staff 
to the highest standards of professionalism, and their expert facilitation skills complement extensive 
industry and classroom experience.  

hh To cater to diverse learning styles and preferences, we use a wide variety of delivery methods for 
our courses and programs. These methods include Traditional Classroom, Virtual Classroom, On-
Demand, simulation training, videos, and mobile apps. Choose the approach that best aligns with 
your needs and your schedule.

hh Our wide global reach gives you the opportunity to leverage the power of our wholly-owned network 
of IIL companies, strategically located all over the world. We have deep experience working in 
different languages, cultures, countries, and industries.

Beyond Training Courses
Because we believe in a holistic approach to learning, we offer our clients all the key building blocks they 
need to achieve excellence in vital project processes, including:

hh Assessment tools such as the Kerzner Project Management Maturity Model (KPM3) and our 360° 
Competency Assessments.

hh Needs analysis to define gaps and to address the organizational and process changes needed to fill 
them.

hh Measurement of efficiency and productivity performance including changes in team behavior, 
return on investment for training and development initiatives, and specific key performance 
yardsticks in Project Management, Lean Six Sigma, and Business Analysis.

hh Group coaching and individual mentoring to assure that classroom lessons are actually put into 
practice and integrated into the daily work flow

hh Process development and improvement through direct, hands-on support or knowledge 
management solutions such as our Unified Project Management® Methodology (UPMM™), which 
assures enterprise-wide consistency and quality in project, program, and portfolio management 
implementation

For more information about IIL’s services and offerings, please visit www.iil.com, email learning@iil.
com or call +1-212-758-0177.
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Download Resource Center

Free value-added materials available from the Download Resource Center at:

www.jrosspub.com

At J. Ross Publishing we are committed to providing today’s professional with practical, hands-on tools 
that enhance the learning experience and give readers an opportunity to apply what they have learned. 
That is why we offer free ancillary materials available for download on this book and all participating 
Web Added Value™ publications. These online resources may include interactive versions of material 
that appears in the book or supplemental templates, worksheets, models, plans, case studies, proposals, 
spreadsheets, and assessment tools, among other things. Whenever you see the WAV™ symbol in any of 
our publications, it means bonus materials accompany the book and are available from the WAV Web 
Added Value Download Resource Center at www.jrosspub.com.

Downloads available to all readers of Dynamic Scheduling® with Microsoft® Project 2013 consist of the 
Case Studies appendix with its solution files, tools, and filters to check the quality of your own schedules, 
references, a glossary of terms, and an Advanced Topics appendix. There is also a solutions manual for 
instructors containing answers to the remaining questions in this book.

This Training Material is MICROSOFT CERTIFICATION EXAM VALIDATED!

Microsoft Certification Training Validation authenticates and verifies that this material aligns with 
the topics identified in the external Microsoft Objective Domain. Only a select few can display the 
official Microsoft Project 2013 Validation seal. This sought-after accolade also certifies that this material 
prepares the user for the new Microsoft certification exam 74-343: Managing Projects with Microsoft 
Project 2013. 
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What’s New in This Edition
hh The content of the book has been aligned with the PMBOK® Guide − Fifth Edition published by PMI®.

hh The text has been updated to reflect the 2013 release of Microsoft Project:

h` The new Project 2013 features are discussed throughout and marked with a “2013” icon to make 
them easy to find.

h` All of the screenshots were replaced to reflect Microsoft’s makeover of the Project 2013 interface 
with the enhanced Fluent User™ interface (Ribbon).

hh We’ve added more IIL best practices throughout the book, based on our extensive experience as 
project management practitioners and teachers. They are identified with a star icon and reflect the 
authors’ consensus about an approach, method, or technique that we believe will provide you with 
the best results.

hh In this edition we assume that most readers are now using either Windows 8, 7, Server 2008 r2, or 
2012. There may be some slight differences for users of other operating systems, but they shouldn’t 
be troublesome.

hh Valuable content is now available for download.

hh The concepts in the book are aligned with the Objective Domains of the Microsoft Project 2013 
Certification exam 74-343.

h` These Objective Domains are:

Initializing a Project 

Creating a Task-Based Schedule

Managing Resources and Assignments

Tracking and Analyzing a Project

Communicating Project Information
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Foreword by Dr. Harold Kerzner
As the project management environment increases in complexity, project scheduling tools have become, 
quite simply, indispensable. The rapid rate of change in economic conditions as well as the need to 
compete in a global marketplace have forced us to rethink the way we schedule projects.

Being able to compete, and being successful at it, requires the taking of risks. And the rate at which we 
respond to these risks could very well dictate our competitive posture. The days of project teams working 
from paper charts hung on war room walls are gone. Expecting the schedule that is prepared at project 
initiation to be the same schedule that we have at project completion is wishful thinking. Simply stated, 
the factors of risk, competitiveness, global competition, and possibly the need for several breakthroughs 
in technology are making standard scheduling techniques outdated and unable to keep up with the needs 
of the business. We need the dynamic project models that only scheduling software can support: models 
that manage complexity, identify slippages, and support alternative scenarios — fast.

Fortunately, as the complexity of our environment has increased, so has the robustness and agility of 
project scheduling software tools. However, this increased functionality comes at a price: a steeper 
learning curve, making expert instruction in tool use a critical component of our scheduling efforts.

I believe there are a number of features that distinguish the instruction offered in this book from that 
offered by others in the field.

First, there is the skillful integration of project management theory with practical instructions on the use 
of the software. A solid understanding of project management principles is key to effectively harnessing 
the capacity Project 2013 offers. This book addresses both the principles of effective project management 
and the techniques for implementing those principles using Project 2013.

Another important feature of this book is its emphasis on dynamic modeling. There is thorough 
instruction on how to create a dynamic model in Project 2013 during project planning so that as change 
occurs during project execution, the schedule can be easily kept up to date and the true impact of changes 
quickly identified and addressed. Used properly, a dynamic model in Project 2013 will help keep your 
projects on course.

Other distinguishing features of this book are tools that readers can use to evaluate their own schedules: 
macros, filters, and a full array of best practices for using Project 2013.

In terms of the Project Management Maturity Model I’ve introduced, this book creates a common 
language (Level 1) that will help you establish common processes for project scheduling (Level 2). The 
best practices described in the book will help you move toward a singular methodology (Level 3). Then, 
once your organization recognizes and uses the singular methodology, you can perform benchmarking 
on a continuous basis (Level 4), and finally, you can evaluate the results and enhance the processes 
defined in Level 3, applying continuous improvement (Level 5) with each new edition.
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The IIL authors who contributed to this edition are expert project management practitioners and 
experienced teachers of the software. They were able to draw on literally thousands of hours spent with 
both real life projects and students in the classroom. Their combined experience and wisdom will provide 
you with the insights you need to manage your projects more effectively.

Harold Kerzner, Ph.D., MS Engineering, MBA
Senior Executive Director, International Institute for Learning, Inc.
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Introduction

Microsoft® Project 2013
Microsoft Project helps you easily plan and control your projects. It can help you create Gantt charts, 
network diagrams, resource histograms, and budgets. It will provide reports tailored to your needs and help 
you to determine and depict the progress of your project. The strengths of the software include:

hh Ease of use for both novice and power users

hh Flexibility in scheduling and re-scheduling

hh A powerful reporting feature: you can extract almost any information from the project database and 
present it in concise reports

hh A project management system design that facilitates collaboration by working seamlessly with other 
Microsoft applications and cloud services

Project 2013 is a powerful tool and, like other tools, to use it proficiently requires knowledge and skill. The 
software is not a magic bean that will grow a successful project by itself. Experience has taught us that a 
successful project results from the combination of executive support, competent project management, a 
committed team, and the right tools.

What’s New in Microsoft Project 2013?
Previous versions of Microsoft Project such as 2003 and 2007 included basic features for creating and 
managing schedules: they helped you do task creation, resource management, assignment development, 
progress tracking, and reporting. Project 2010 offered improvements that helped you develop your 
schedule control with greater flexibility and ease. Project 2013 cumulates all previous advantages with new 
and enhanced features that keep your projects organized, allowing users to measure and communicate 
progress with modern reports and streamline everyday collaboration by working seamlessly with other 
Microsoft applications and cloud services.

New in Project Standard 2013  
Here are new and enhanced features of Project Standard 2013
hh Enhanced Fluent User Interface
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Project 2013 has the same enhanced interface used in Microsoft Office 2013 and allows users 
to quickly start projects within an enhanced visual experience. Part of this new experience is the 
improved array of new project templates.

h` Highlight Task Path

This new feature facilitates the proactive discovery of task paths determined by logical dependencies 
and prevents potential scheduling problems.

h` Enhanced Reports

The old table-like built-in reports of previous versions have been replaced by great looking 
graphical reports and dashboards. The enhanced reports enable you to quickly share information 
and communicate progress with easily customizable reports. A guide to Getting Started is also 
included as part of the reports.

h` Apps in the Office Store

Powerful Apps that extend the capabilities of Project 2013 can be explored and acquired from 
Microsoft Partners at the Office Store.

New in Project Professional 2013
The new and enhanced features specific to Project Professional 2013 include the same described for Project 
Standard 2013 plus the following:

hh Enhanced Team Planner

This is a great feature for managing your resources while visually creating the right mix of resources. In 
summary, with the team planner view you can:

h` See at a glance where your resources are assigned, who is over-allocated, and which tasks are 
unassigned or unscheduled. The look and feel has been improved for better identification of 
potential problems.

h` Enhanced drag and drop tasks to change assignments or drag unassigned tasks to resources to 
make planning more efficient. Time constraints won’t be added while dragging and dropping tasks 
in the original timeframe or by using the reassign option (right click the task).

h` Level over-allocated resources automatically on a task-by-task basis using Task Inspector and see 
the results instantly.

h` Be visually alerted to potential resource allocation issues as you update your progress.

hh Enhanced Collaboration

Project Professional 2013 supports easy information sharing. The Backstage view contains new 
collaboration options, including:

h` Publish the project in Project Server 2013 or Project Online (if a Project Web App Account is 
available)
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h` Create your project site or export and synchronize project details to an existing site when using 
Microsoft SharePoint Online or SharePoint 2013 task list. Everyone in the project team will keep 
connected and organized sharing the latest status, conversations, and the Project Timeline.

h` Connect Project Professional 2013 with Project Server 2013 or Project Online and use all the 
features of a fully integrated enterprise project management (EPM) solution.

h` Account management of services such as Office 365, OneDrive, Office Store or other sites.

hh Call or instant message team members from within Project

Users of Microsoft Lync Online or Microsoft Lync 2013 will have the ability to collaborate and 
communicate with real time talk, instant message, file, and screen sharing.

New Project Pro for Office 365
Project Pro for Office 365 is a new version of the software that delivers Project Professional 2013 as a 
subscription to Office 365, the online Office suite software that allows users to stream the complete desktop 
client of Microsoft Project on demand—practically from anywhere. One advantage of this version is that 
the software is automatically kept up to date with the latest improvements.

Discontinued features in Project 2013
No relevant features and functionality have been discontinued in Project 2013, however, you must be 
aware that the standard reports evolved in a way that you won’t be able to use the old table form of these 
reports anymore. Instead you will have fresh built-in reports and dashboards with plenty of options and 
information—explained in Chapter 11.

If you skipped Project 2010, you may want to know all the features and functionality discontinued since 
Project 2010:

hh Custom Forms. You can’t create custom forms or use any that were created in previous versions; instead 
you can now use Visual Basic for Applications (VBA) to create custom forms. 

hh Task splitting by double-clicking on the Split Task button. Double-clicking on Split Task in previous 
versions allowed you to split a task several times with just one click of the Split Task icon. In Project 
2010 and 2013 you can single-click on the button to enable task splitting one time.

hh Resource availability graphs. It’s not possible to view resource availability graphs on the Assign 
Resources dialog box without temporarily assigning the resource to a task. You can only graph one 
resource at a time. The Team Planner, described in the previous section, is now the way to view, assign, 
modify, and fix issues with resource allocation.

hh Project Guide. This was removed in Project 2010. Instead, you can find features for setting up new 
projects in the Ribbon, neatly organized by tabs.
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hh Add-ins and sample macros. Add-ins and sample macros were discontinued with Project 2010. There 
are two add-ins now incorporated into the program as standard commands: Adjust Dates and Compare 
Project Versions.

Macros created for older versions of Project can be programmed to work with this version. 

hh PERT Analysis. You are no longer able to provide an optimistic, expected, and most likely value and 
have the three-point estimating formula applied to generate the duration estimate. 

This can still be done in Excel and the information can be copied over, or you can create 
custom fields and add formulas as needed as a work-around to calculate PERT in your 
project.

hh Standard Templates: Now, standard project templates are available on-line from Office.com.
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Is This Book for You?
The first edition of this book was written for Project 2000. This sixth edition retains the main characteristic 
that differentiates this book from other books written on Project 2013: it not only shows you how to use 
the Project 2013 software, but also provides real life insights and experiences from the IIL authors who are 
both expert project management practitioners and experienced teachers of the software. The book teaches 
you how to manage projects using Project 2013, instead of teaching you only how to click on features.

This book is intended for the following target groups:

hh Project managers who use Project 2013 on a day-to-day basis
This book is aimed at the novice to intermediate user of Project 2013, but we’re confident that advanced 
users will find it worthwhile as well, particularly if they mentor other users.

hh People who schedule and manage mainly single projects
This book is aimed at people who manage a single project at a time with Project 2013. We have included 
a section on Master Schedules in the Appendix that will be helpful for those involved in program 
management, but we will not delve deeply into multi-project management issues.

This book is used as the course book in the Project Orange Belt 2013: Managing Projects with 
Microsoft Project 2013 course at the International Institute for Learning (IIL). (For our other Project 
2013 courses, see IIL’s Microsoft Project and Project Server 2013 Curriculum later in this chapter.)

hh Students and professors at colleges and universities
For effective delivery of college courses, we’ve included:
h` Review questions for self-evaluation of understanding
h` Start to finish exercises on an office relocation project
h` Trouble shooting exercises drawn from real-life technical support

All readers have access to the Web Added Value (WAV) files for this book, which include the Case Studies 
appendix for the office relocation exercises and its solutions. Additionally you will find an Advanced Topics 
appendix that extends information on more sophisticated topics such as applying Earned Value techniques 
with Microsoft Project 2013. 

What You Will Find in This Book
At IIL, we’ve asked thousands of our course participants what features they use, why they use them and 
how. We’ve captured the insights we’ve gained in this book and cover the features that will benefit you most 
in practice. We’ll present the Project 2013 features that will help you create effective schedules, and create 
them efficiently.

Many people have asked us for a good process to follow for creating schedules. The structure of the book 
matches the order of steps we recommend: it’s as simple as following the Short Table of Contents. The book 
is aimed at the busy, practicing project manager who needs to get up to speed quickly with Project 2013.

This book is entirely based on and aligned with the PMBOK® Guide – Fifth Edition, published by PMI®. It 
is also aligned with other related PMI standards: Practice Standard for Scheduling – Second Edition, Practice 
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Standard for Work Breakdown Structures – Second Edition, and Practice Standard for Earned Value Management 
– Second Edition. We recommend you read these standards first or at least keep them nearby, as we won’t 
explain the PMBOK® Guide and other PMI Standards concepts, but simply refer to them.

You may use this book as a preparation guide for passing the Microsoft Project 2013 Certification exam 74- 
343: Managing Projects with Microsoft Project 2013. We’ll cover the following major objectives: 

hh Initialize a Project 
hh Create a Task-Based Schedule
hh Manage Resources and Assignments
hh Track and Analyze a Project
hh Communicate Project Information

On the Microsoft website you will find more detailed information about the exam and how to register. 

This book has an attitude. It is not a complete description of the features of Project 2013. We will 
recommend certain features and we’ll argue against using some others. An important criterion we use for 
our recommendations is that the schedule you build with Project 2013 should be a good representation of 
your project.

In our opinion, a good schedule is a valid, dynamic model of the project:

hh A model is a deliberate but smart simplification of the complex reality of the project.
hh A model is valid if it reflects the reality of your project and provides reliable forecasts.
hh A dynamic model updates itself when a change is entered. When one change happens in your project, 

ideally you should have to update only one field in the model to have a new, valid representation of 
your project. Changes happen often during project execution—a very busy time. Therefore, a dynamic 
model is a tremendous help during project execution because it helps you keep your project schedule 
current and useful. Hence the title of this book: Dynamic Scheduling® with Microsoft® Project 2013.

Static schedules do not maintain themselves. Some features in Project 2013 are nice to have, but create 
schedules that require a lot of maintenance. Therefore, we don’t recommend features that continue to need 
attention from you. We have found the judicious application of features to be critical in effectively using 
Project 2013 and thousands of our students have helped determine which are the most beneficial.

In this book we will cover one main edition of Project 2013 currently in use: Project Professional 2013 used 
in the default configuration for the standalone tool.

What You Won’t Find in This Book
hh We won’t provide an explanation of all of the features in Project 2013. We have made a careful selection 

of features that will benefit users most when managing a single project. This book is not a complete 
reference on Project 2013.

hh Project Server, Project Online, or SharePoint are out of the scope of this book, however, some 
explanations may point out some interactions to these tools that project managers need to know. 
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The Authors’ Perspective on Scheduling
In our years of consulting and training project managers, we’ve identified a number of common problems 
with the way that Microsoft Project is implemented.

hh Schedules Need a Logical, Hierarchical Structure

Some large schedules we’ve seen don’t have a work breakdown structure (WBS). All of the tasks are 
on the first (and only) indentation level or are broken down into too many unrecognizable sub-levels.

Imagine trying to make sense of this book if it didn’t have a hierarchy of sections, chapters and 
paragraphs. Organizations which don’t use logical and hierarchical work breakdown structures create 
schedules that are difficult to explain to anyone who isn’t interested in detail activities (like many 
executives).

hh Schedules Need to Identify All Dependencies to Keep them Dynamic

Many schedules created by experienced project managers turn out to have only a few dependencies 
(links between tasks). Not surprisingly, those schedules have many schedule constraints that anchor 
the tasks to specific dates. Constraints, however, make a schedule very rigid or static. Every time a 
change occurs, the entire schedule needs to be reviewed and updated. Isn’t this reminiscent of the time 
when we made schedules on paper to hang on our walls? Such schedules are nice charts of the project, 
but are definitely not useful dynamic models of the project. Updating a static schedule is onerous, and 
project managers with static schedules inevitably stop updating early in the execution of their projects.

hh Schedules Need the Right Level of Detail

Many organizations create schedules that are so complex it takes weeks to understand them. If the 
model of a project is as complex as the reality itself, it doesn’t give you a better handle on that reality.

Modeling is, by definition, simplifying the reality to get a better handle on it. Too many project 
managers seem to forget this. If you can’t explain your project schedule to your team, the schedule is 
simply too complex. If your team understands it, you get much more value from your schedule and 
scheduling efforts. If other stakeholders can also understand your schedule, even better.

hh Include Resources in Your Schedule

Many project managers don’t enter resources (e.g., people, equipment, materials) into Project 2013. 
Those who do, often don’t check on whether the resources are over-allocated. A schedule without 
leveled resources may display agreeable finish dates, but it’s doubtful they’ll be realistic. When you enter 
resources into Project 2013 and level the workloads, it may become painfully clear that the promised 
dates are not feasible. If you notice that deadlines are often not accomplished in your organization, a 
lack of modeling resources may very well be the cause. 

Any organization that shares its resources across projects but doesn’t have a central, shared resource 
pool is also likely to suffer from missed deadlines. The cause is unidentified resource impacts across 
multiple projects. Even though an individual schedule with leveled resources may show what appear to 
be realistic dates, once project execution starts and project managers start pulling each other’s resources 
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in order to meet deadlines, the individual schedules prove to be too optimistic. The total workload of 
the resources needs to be modeled across all of the projects that share resources. 

hh Apply Earned Value Management (EVM)

Earned Value Management (EVM) is an approach to measuring project performance based on 
comparing planned and actual progress related to scope, time, and cost. We’ve run into a fair number of 
people who think that EVM is a complex technique that isn’t worth the effort necessary to implement 
it. We believe that many of those may not know how to simplify the application of EVM with a tool like 
Project 2013. We have addressed this with the EVM chapter in this book.

EVM in Project 2013 will help you answer questions like: What is the planned and actual progress to 
date? Are we ahead of or behind schedule? Under or over budget? What is the remaining work going 
to cost? When is the project going to finish? Having this information at hand will enable you to make 
the right decisions on a timely basis.

hh Consolidate Schedules to Facilitate Management of Large Projects or Programs

Multiple projects performed simultaneously have become the norm, with projects logically related to 
each other and sharing resources. The ability to bring several subprojects into a single consolidated 
(master) schedule makes it much more practical to accomplish tasks like leveling when you use a 
shared resource pool, reporting on multiple projects and providing a big picture view of the work going 
on between several related projects.

hh Don’t Abandon Ship!

Many organizations invest in making schedules, but abandon them once project execution starts. The 
chance that a schedule will be abandoned increases with the complexity of the schedule, the lack of 
dependencies or an abundance of constraints. This book tries to address all of these problems.

hh Consider Certification

The kinds of problems we’ve observed have led us to encourage people to consider becoming certified 
in Project. We’ve found that the process of pursuing certification can significantly elevate the skills 
of Project 2013 users and improve the accuracy of forecasts. For organizations this can mean more 
successful projects, more reasonable workloads, less burnout, and more reliable long-term forecasts 
of resource needs. The cost of managing projects should decrease and the competitiveness of the 
organization should increase in the global marketplace.

Why Do We Need Dynamic Schedules?
A dynamic schedule is one that relies on a thorough definition of the relationships between tasks to 
determine scheduling and minimizes the use of hard constraint dates. There are several reasons why we 
need schedules to be dynamic:

hh Changes happen so frequently in projects that it’s hard to keep up with them. If your schedule is static 
— it relies on hard constraint dates that you’ve entered — whenever you make a change to one task, 
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you’ll have to review every other task to see how it’s affected. This is why static schedules quickly 
become outdated and ignored: they simply require too much time and effort to update.

With a dynamic schedule when you change one task, Project 2013 is able to update the other tasks 
based on the dependencies you’ve entered. Your updating efforts are manageable and your ability to 
forecast the results increases: you can keep your schedule alive and valid during project execution.

hh Dynamic schedules make it possible to explore what-if scenarios in Project 2013. This is an enormous 
advantage when you’re trying to fine-tune your schedule or adjust for slippages. If you’ve created a static 
schedule, the hard constraint dates you’ve entered interfere with Project 2013’s what-if capabilities: it’s 
hard to assess the impact of proposed solutions. 

hh If you want to roll up subprojects into a master schedule, the subprojects need to be dynamic models. 
Otherwise, you’ll spend too much time making changes in the master schedule. When dynamic models 
are rolled up, problems become visible in the master schedule and can easily be resolved by creating 
what-if scenarios.

hh In order to do schedule simulation for quantitative risk analysis, you need dynamic models. Monte 
Carlo schedule simulation is essential to provide stakeholders with data to support contingency 
reserves and realistic forecasts.

We made an attempt to quantify the amount of time saved by working with a dynamic schedule 
instead of a static schedule. We calculated that for a 3 month project with 100 tasks, you would 
save about 50 hours of effort by using a dynamic schedule. We’re sure you can find better ways 
to spend that time.
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IIL’s Microsoft® Project and Project Server 2013 Curriculum

Project White Belt® 2013

Getting Started with Microsoft® 
Project 2013
1-day • IIL Certification

Project Orange Belt® 2013

Dynamic Scheduling with 
Microsoft® Project 2013
3-day • IIL Certification

Microsoft® Exam 74-343: Managing Projects with 
Microsoft® Project 2013 

Project Blue Belt® 2013

Managing Projects with Microsoft® 
Project Server 2013
3-day • IIL Certification

Project Black Belt® 2013

Managing the Portfolio and 
Configuring the EPM Envirnonment
3-day • IIL Certification

Microsoft® Exam 74-344: Managing Programs and 
Projects with Project Server 2013 

IIL’s Project “Belt” courses
Everyone wants to increase their project success 
rate. Sometimes, using the right tools can make all 
the difference. Microsoft® Project software contains 
powerful, collaborative tools that allow you to easily 
plan and manage your projects. IIL is dedicated to 
providing organizations and practitioners with the 
training they need for the successful management 
of projects using Microsoft® Project 2013, Project 
Server 2013, and Project Online (EPM solutions). 
We keep our courseware aligned with the needs of 
the advancing project manager, as well as those of 
progressive organizations looking to be competitive 
in the global marketplace by increasing their project 
management maturity level and capabilities.

IIL’s Project Belt courses prepare project managers for 
certification. Our series of Belt courses is progressive, 
with successful completion of one Belt course (or the 
equivalent) being a prerequisite to enrollment in the 
next level.

Project White Belt® 2013
Getting Started with Microsoft® Project 2013

Project White Belt 2013 earns you IIL’s White Belt 
Certification and serves as an introduction to the 
interface and features of Microsoft® Project Standard, 
Professional, or Pro for Office 365, applying important 
scheduling concepts. It is suitable for anyone with 
a need to use scheduling software and enables 
participants to practice and start preparing for the 
Microsoft Specialist (MS) credential.

Project Orange Belt® 2013 
Managing Projects with Microsoft® Project 2013

Project Orange Belt 2013 earns you IIL’s Orange Belt 
Certification, and is a more advanced course that 
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will equip you with the knowledge and skills to build, maintain, and control well-formed project plans in 
Microsoft Project standard, Professional, or Pro for Office 365. This course also includes best practices and 
tips and tricks to use Project more effectively. The Orange Belt course fully prepares you for the new Project 
2013 Microsoft Specialist (MS) exam 74-343.

Project Blue Belt® 2013
Managing Projects and Programs with Microsoft® Project Server 2013

Project Blue Belt 2013 earns you IIL’s Blue Belt Certification and is ideal for busy practicing project 
managers, program managers, portfolio managers, executives, team members, functional managers, or any 
person who needs to get up to speed quickly with Project Server 2013 or Project Online. Project Blue 
Belt teaches you how to select, initiate, plan, execute, monitor, and control enterprise projects from the 
different perspectives of specific roles. This course enables participants to practice and start preparing for 
the Microsoft Specialist (MS) exam 74-344: Managing Programs and Projects with Project Server 2013.

Project Black Belt® 2013
Mastering Microsoft® Project Server 2013

Project Black Belt 2013 earns you IIL’s Black Belt certification and it designed for people responsible 
for managing, analyzing, and reporting on projects, programs, and portfolios that require an in-depth 
understanding of Microsoft Project Server to configure and customize the enterprise project management 
(EPM) solution according to the organization’s requirements. This course along with the Project Blue Belt 
2013 course enables participants to practice and conclude preparation for the Microsoft Specialist (MS) 
exam 74-344: Managing Programs and Projects with Project Server 2013.

Microsoft EPM Role-Based Courses
Many organizations request customized onsite training to support the deployment of Microsoft Project 
Server 2013. IIL has developed a series of role-based courses that can easily be adapted to the specific needs 
of a company, depending on its existing business processes and the course configuration chosen. Typically, 
these courses will be delivered onsite or in dedicated Virtual Classroom sessions.

hh Microsoft EPM for Project Managers: This course is designed to offer project managers the 
information needed to effectively build, optimize and update schedules in the enterprise environment 
using Microsoft® Project 2013 and Project Web App.

hh Microsoft EPM for Team Members: In this course project team members will learn how to directly 
interact with Project Web App in order to view and update project tasks.

hh Microsoft EPM for Resource Managers: This course covers the necessary elements for effective 
resource management in both Project Web App and Microsoft® Project 2013.

hh Microsoft EPM for Executives: This course offers business and PMO executives information they 
need to effectively support the adoption of the Microsoft EPM solution within their organizations. It 
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will also equip them with the knowledge and skills to view, analyze, and respond to project, program, 
and portfolio health indicators.

What Are the Benefits of Certification?
Professional certification provides value to organizations as well as to individuals desiring to advance their 
skills and career opportunities within the field of project management. By validating a more comprehensive 
set of skills, these credentials give candidates and their hiring managers a reliable indicator of on-the-job 
performance.

IIL’s Project Belt series of certifications is driven by customer demand for project management 
competencies that include practical and tool-specific capabilities. Certifications quantify proficiency in the 
use of Microsoft Project 2013, Project Server 2013, and Project Online to effectively select, initiate, plan, 
execute, monitor, control, and close projects, programs, and portfolios.

Why Choose IIL for Your Microsoft® Project Training?
hh IIL has a strict instructor qualification process, which includes all of the following:

h` Instructors must have hands-on experience managing projects and demonstrate this with a best 
practices schedule

h` Instructors must hold the Project Management Professional (PMP®) designation awarded by 
PMI®

h` Instructors must demonstrate expertise in training, which includes completing our Train-the-
Trainer program

h` Instructors must hold the relevant certification for any course they will be teaching; in fact, most 
of our instructors are certified at a level above that which they are teaching 

hh IIL has led the Microsoft Project training industry by providing recognized professional certifications 
in Microsoft Project and Project Server. To date, we have trained many thousands of individuals 
through our Belt programs.

hh IIL offers a rare blend of project management methodology training aligned with PMI’s standards 
within our Microsoft® Project Belt curriculum.

hh IIL is a Microsoft Partner with the Gold Project and Portfolio Management competency. We provide 
customized training and consulting solutions to help organizations enhance their project management 
capabilities using the Microsoft Enterprise Project Management Solution.
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Please Give Us Your Feedback
If you have any questions or if you would like to discuss any recommendations we make in this book, we 
would love to hear your feedback. Please don’t hesitate to contact us at learning@iil.com. 

Thank you for the time you are about to invest in reading this book. We hope you will find it well worth the 
effort! 

Rodolfo Ambriz, PMP, PMI-SP, PMI-RMP, MS, MCP
Managing Director, IIL Mexico and Microsoft EPM Division,
International Institute for Learning, Inc.

Mario Landa, CE, MBA, MGM, PMP, MS, MCP
Director of Microsoft EPM Curriculum and Course Development
International Institute for Learning, Inc.

learning@iil.com
www.iil.com
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Learning Objectives
After reading this book you will be able to:

hh Apply the basic project management principles outlined in PMI’s PMBOK® Guide – Fifth Edition to 
the planning, executing, monitoring and controlling, and closing of your Project 2013 schedules

hh Consider concepts from other PMI Standards such as the Practice Standard for Scheduling - Second 
Edition, the Practice Standard for Work Breakdown Structures - Second Edition, and the Practice 
Standard for Earned Value Management - Second Edition 

hh Understand that a project schedule is a model of a real world project and be able to recognize and 
analyze the pulling forces of a project 

hh Create a valid and dynamic model of your own project:
h` Choose effective settings for options
h` Create the project calendar
h` Enter tasks, estimates, dependencies, constraints, resources, and assignments

hh Optimize your schedule in order to meet deadlines and budget restrictions, while keeping the 
workloads of your resources within their available limits

hh Efficiently update your schedule during project execution so that you can continuously forecast the 
project cost and finish date

hh Create reports, dashboards, custom views, and visual reports for your project that meet the needs of 
stakeholders

hh Implement Earned Value Management with Project 2013

hh Build and maintain consolidated schedules

hh Assess how well you’ve implemented the best practices of scheduling, established by IIL based on 
our research of thousands of real-life schedules

hh Understand new features of Project Professional 2013

In general, you should feel very comfortable with Project 2013 and have a good understanding of how 
the tool functions and behaves. This knowledge will enable you to efficiently and effectively manage your 
project(s). 

J. Ross Publishing; All Rights Reserved



16

Dynamic Scheduling® with Microsoft® Project 2013

Outline of This Book
First you initiate a project, then you plan it, and while you execute it, you monitor and control it. At the 
end, you close it out. This is an iterative or repeating 
cycle—over the life of the project things change and you 
need to cycle back and re-plan.

The illustration shows these five process groups as 
defined by the Project Management Institute (PMI) in 
the PMBOK® Guide – Fifth Edition. 

We’ve considered the five process groups to structure this 
book. In fact, we treat the creation of the project plan as 
a mini-project in itself, and we have mapped all steps for 
creating a schedule with Project 2013 to the five process 
groups.

Planning

2 Setup
1 Concepts

Initiating

Executing,
Monitoring & 
Controlling
  9 Optimizing
10 Updating
11 Reporting
12 Earned Value

13 Evaluating
Closing

3 Tasks
4 Estimates
5 Dependencies
6 Constraints
7 Resources
8 Assignments

The result can be seen in this illustration 
that provides an overview of the 
contents of the book. Each balloon 
represents one of the five process groups 
and each item within the balloons 
represents a chapter, as well as a step in 
the process of creating and managing a 
project using Project 2013. We 
recommend you use these same 
sequential steps when you model your 
own project with Project 2013.

Let’s take a closer look at each step.

Concepts of Project Management (Chapter 1)
To use Project 2013 effectively, it’s important to understand the project management concepts and 
processes that the tool supports. In this chapter, we explain basic concepts of project management and 
provide a conceptual framework for the project management business process. While this isn’t a book 
on project management theory, throughout the book we’ll provide as much background information as 
you need to utilize Project 2013 effectively, starting in Chapter 1 with a high level overview of projects 
on your desktop.

Planning
Processes

Initiating
Processes

Executing
Processes

Closing
Processes

Monitoring & 
Controlling Processes

J. Ross Publishing; All Rights Reserved



About This Book

17

Initiating
This is where we initiate the project.

Getting Started with Project 2013 (Chapter 2)

This chapter will help you become familiar with the Project 2013 interface. We’ll discuss file management, 
the ribbon, templates, and views. Then we’ll guide you through the steps of creating a new project, 
including naming the project and entering the project start or finish date. We’ll pay particular attention 
to the default settings in Project 2013, because some important options need to be set before tasks are 
entered. We’ll also create the project calendar.

Planning
During the planning phase, we’ll develop and enter all of the schedule data into Project 2013. This phase 
requires most of the effort needed to create a schedule. There are six types of data that Project 2013 needs 
to create a schedule, as discussed in the next six chapters.

Tasks (Chapter 3)
Tasks answer the question: What needs to be done? The task list is developed from the deliverables 
that together with the tasks form the work breakdown structure (WBS). We’ll discuss techniques for 
ensuring that your task list is complete, well organized and reflects an appropriate level of detail. Then 
we’ll cover how to enter the structured task list in Project 2013, import the task list from other sources, 
and reorganize the task list by indenting, outdenting, moving, and copying tasks.

Estimates (Chapter 4)
An estimate answers the question: How long will the task take? There are many factors to consider when 
estimating. We’ll provide a process to clarify the estimating process and help you understand how Project 
2013 can assist you when you have complete or even incomplete information about an estimate. We’ll 
also discuss factors that can lead to inconsistent or biased estimates and suggest techniques for handling 
these difficulties.

Dependencies (Chapter 5)
Dependencies deal with the question: In what sequence do the tasks have to be done, and how will the tasks 
affect each other? Dependencies are the logical cause-and-effect relationships between tasks and they are 
critical for creating dynamic schedules. By entering dependencies instead of hard dates, you can build a 
very powerful, dynamic model of your project. If you change the duration of one task, Project 2013 will 
reschedule all affected dependent tasks. The core secrets of dynamic schedules will be revealed in this 
chapter.
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Constraints (Chapter 6)
Constraints are the answer to the question: What limitations are imposed on the schedule? Constraints are 
dates that are imposed or promised on the project. Constraints can also be used for restricting Project 
2013’s freedom to move task bars around in the timescale, if practical circumstances require this. In 
addition to constraints, we will also discuss deadlines and task calendars.

Resources (Chapter 7)
Resources answer the question: Who will do the work? Resources can be people, facilities, machines, 
materials, or costs. In this chapter, we’ll describe these types of resources, plus how to create a budget-
based resource. We’ll explore how to enter resources and identify important resource-related fields and 
features that can impact your schedule in Project 2013.

Assignments (Chapter 8)
Assignments answer the question: Who does what? This chapter focuses on assigning human, material, 
and cost resources. We’ll explain the formula that Project 2013 uses to recalculate data when you make 
or change assignments, and help you understand and predict Project 2013’s behavior. We’ll also explore 
the cost side of managing projects. The goal of this chapter is to make sure Project 2013 works for you 
instead of you working for Project 2013. If you’ve found in the past that Project 2013 doesn’t do what you 
want it to do, make sure you read this chapter. 

Executing, Monitoring, and Controlling
During these phases of the project, many cycles will be made through the next three project management 
activities of optimizing, reporting, and updating. Delivering a project involves many cycles of making 
progress (updating), monitoring the progress (reporting), and taking corrective actions (optimizing).

Optimizing (Chapter 9)
The first draft of your schedule rarely meets your time, resource, and cost constraints. You may need to 
make changes to stay within the deadline, the budget, or the availability of resources; applying these 
changes is called optimizing the schedule.

We’ll present three different approaches for optimizing schedules: optimizing for time; optimizing for 
time and cost; and optimizing for time, cost, and resources. We’ll also discuss using the Critical Path 
Method to optimize logic-constrained schedules and the Resource-Critical Path to optimize resource-
constrained schedules by leveling workloads.

Updating (Chapter 10)
Once your project schedule is approved, you set a baseline schedule against which you track your 
progress. You need to update your schedule on a regular basis in order to identify variances that have 
occurred on the project and to adjust your forecasts for the remainder of the project. Different strategies 
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and options for updating tasks are presented depending on the information available for the project, as a 
result, an updated schedule shows the actual performance compared to the baseline.

Reporting (Chapter 11)
In this chapter, we’ll show you how to use Project 2013 to communicate with your stakeholders, and 
select the best option to tell the story of your project.

We’ll discuss Project 2013’s built-in reports and dashboards, how to customize fields and views to create 
additional reports, and how to use the Visual Reports feature that generates PivotTables, PivotCharts, 
and PivotDiagrams for Microsoft® Office Excel and Microsoft® Visio.

We’ll also cover using filtering, grouping, and formatting to create reports targeted for specific purposes 
and stakeholders.

Earned Value Management (Chapter 12)
While you are optimizing, updating, tracking, and controlling your project; you may want to analyze 
project progress to get a good estimate of current status. Earned Value Management (EVM) analysis 
helps you with this and evaluates cost and work estimates on the project. EVM is concerned with 
measuring the value that you have earned on the project, based on the work planned and the work 
actually completed. This analysis is conducted by comparing captured baseline information to actual 
information.

EVM helps you evaluate the effectiveness of the plan, analyze progress, review trends, propose forecasts, 
and define any corrective action that may be needed to meet your project goals.

Closing

Evaluating (Chapter 13)
It’s important to take some time to look back on a project to see what went well, what went wrong and to 
analyze why. In this chapter, we’ll discuss how to evaluate your project.

The purpose of project evaluation is to help you conduct better projects in the future. Only by learning 
from the past can we become better prepared for the future. 

Summary (Chapter 14)
In this chapter, you’ll find a handy reference summary of the scheduling guidelines for creating valid 
and dynamic schedules. These reflect the results of our search for best practices in thousands of real life 
schedules. 
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End of Chapter Review Questions
At the end of each chapter we’ve included review questions to help you consolidate the knowledge you 
gained in the chapter. These questions review both the theoretical concepts and techniques covered in 
the chapter. Most answers can be found literally in the text of the book itself.

Appendix 1: Consolidated Master Schedules
This appendix describes how you can use Project 2013 to manage multiple projects in the context of a 
consolidated project schedule. You can use a consolidated schedule to bring separate schedules together 
for managing, reporting, analyzing, and/or leveling shared resources. 

We’ll take you through the process of embedding project schedules into a consolidated schedule, and 
show you how to create cross project dependencies, level multiple projects, and create a shared resource 
pool. We’ll also discuss some of the issues involved in creating consolidated schedules.

Additional Content Available for Download
You will be able to access this material from www.jrosspub.com in the Web Added Value (WAV) section: 

Case Studies Appendix
Provides structured practice using Project 2013 to help you solidify what you’ve learned throughout 
the book. We’ve organized the material by chapter and recommend that you do each set of exercises 
immediately after reading the related chapter.

You’ll find the following types of practice:

hh A hands-on exercise where you are the project manager responsible for an office move of about 100 
co-workers to a new location that you have yet to find. The exercises will take you through scheduling 
of the project from initiating to closing. You can compare your results to a model schedule available 
in the solution files to be downloaded at the same site.

hh Troubleshooting exercises which are based on situations we’ve encountered over many years of 
reviewing and certifying Project schedules. The exercises will help you understand some of the 
pitfalls people commonly encounter using Project 2013 and can help you prepare for providing 
technical support to other Project 2013 users.

hh Case studies to give you additional practice in the Dynamic Scheduling techniques.

Advanced Topics Appendix
This appendix provides additional content that enriches the information presented in Chapter 11 about 
Reporting and Chapter 12 about Earned Value Management. 

You’ll find the following information:
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hh About reporting: Formatting and printing views such as the Network Diagram, Calendar, Resource 
Sheet, Assignment, and Team Planner.

hh About Earned Value Management: Additional information when managing progress and EVM in 
Project 2013 with methods such as Fixed Formula, Weighted Milestones, and Percent Complete.

Conventions in This Book

Symbols and Typeface

Best 
Practice

This icon identifies the practices and techniques that we’ve found to be the most 
valuable in our years of experience in the project management field. 

Tip The light bulb highlights a tip or recommendation that may help you use Project 
2013 more efficiently. Many tips are time savers.

Caution Project 2013 is a robust, complicated program. We use exclamation points to 
highlight warnings that may help you avoid potential problems, unexpected results 
or loss of data in Project 2013.

New 
Feature

The 2013 icon indicates a new feature in the Project 2013 release. New features 
apply to all, Project Standard 2013, Project Professional 2013, and Project Pro for 
Office 365, unless otherwise noted in the text.

Note Notes simply contain additional information.

File Words in bold type are words that can be found on your screen in Project 2013 — 
either as a menu item or as a label or phrase in a dialog box.

Quotes Italicized words are literal references. These can be quotes from people, or literal 
data you need to enter into Project 2013.

<file name> Any text enclosed between smaller than (<) and greater than (>) signs is text that 
should not be taken literally, because it refers to other things. For example, < file 
name> refers to the name of a project file with which you are currently working.
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Word Choice and Step Formulation
hh For the Microsoft® Fluent™ User Interface (hereafter referred to as the Ribbon) tabs, we use the 

verb choose as in:  
On the File tab (of the Ribbon), in the Microsoft® Office Backstage™ view, (hereafter referred to as 
Backstage view), choose Options. 

We assume you use the Ribbon tabs in their default layout. If you can’t find commands that we 
refer to, consider resetting the tabs to their default appearance: on the File tab, click Options, then 
in the Project Options dialog box, click Customize Ribbon, and then in the bottom right, under 
Customization: click Reset and select Reset all Customizations. 

hh For tab pages in dialog boxes we use the verb click with the name of the tab as in: 
Click Advanced (in Task Information dialog box).

hh For shortcut key combinations on your keyboard we use the verbs hold and press:
h` For a single keystroke: Press F2.
h` For two keystrokes: Hold down Alt and press F1.
h` For three keystrokes: Hold down Alt + Shift and press the Right Arrow key.

hh For entering text with your keyboard into named fields we use type or enter as in: 
Type in a file name of your choice in the field File Name.

hh KeyTips are keyboard shortcuts that let you quickly perform tasks on the Ribbon without using the 
mouse:
h` Press the Alt key to display KeyTips over the available features
h` Press the keystroke letter that appears over the feature you want
h` Additional KeyTips may appear depending on which feature you select
h` Continue to press the letters of the commands that you want to use. You may first need to press 

the letter of the group, then the letter of the command within that group.
h` Press the Alt key again to cancel and hide Key Tips

hh For check boxes we use the verb select or clear as in:
Select the New tasks are effort driven checkbox
Clear the New tasks are effort driven checkbox

hh For radio buttons we use the verb select as in:
Select the On radio button.

Screenshots and Illustrations
Most illustrations in the book only show a small portion of a larger schedule. This allowed us to keep the 
illustrations concise and to the point.

The screen shots that we used are from Microsoft® Project Professional 2013. Depending on whether 
you use Project Professional or Project Standard, what you see on the screen may vary slightly from 
our screenshots. Some items displayed in the Ribbon, tabs, and dialog boxes (dealing primarily with 
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collaboration capabilities) will be “grayed” in Project Professional unless you are connected to Project 
Server. In Project Standard, these items simply won’t exist. Depending on the operating system you are 
using, your computer screen may also look different. These differences should not hinder your ability to 
understand the concepts offered in the book or to perform the techniques presented.

We’ve annotated most of the screenshots with blue lines and callouts, so you can easily find the option 
or field referred to in the text. The annotations sometimes contain extra tips, so we suggest you take the 
time to read them.

Cartoons
The cartoons in each chapter depict project management scenarios related to topics covered in the 
chapter and will help us to laugh about some common frustrating situations in our professional lives. 
Special thanks to Vonno A. Ambriz for your cartoons.
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1
Planning

2 Setup
1 Concepts

Initiating

Executing,
Monitoring & 
Controlling
  9 Optimizing
10 Updating
11 Reporting
12 Earned Value

13 Evaluating
Closing

3 Tasks
4 Estimates
5 Dependencies
6 Constraints
7 Resources
8 Assignments

Chapter 1: Concepts of Project 
Management

To use Project 2013 effectively, you’ll want to understand the project 
management concepts and processes that the tool supports. In this chapter 
we’ll look at the big picture of project management. We’ll discuss what project 
management is and where it fits in the enterprise and in the context of programs 
and portfolios.

After reading this chapter you’ll be able to:
hh Define what a project, program and portfolio of projects are and describe 

how they relate to one another in the context of Enterprise Project 
Management

hh Describe the critical role of projects and programs in an enterprise
hh Describe the basic principles and processes for managing individual 

projects and dynamic project scheduling
hh Describe the advantages of a dynamic model over a static chart 
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I think I should start learning about dynamic models...

In this chapter, we’ll define what projects and project management are, 
position project management in the context of the multi-project enterprise, 
and focus in on the principles and processes for managing individual projects.

This book deals primarily with managing a single project but we do address 
some issues related to multiple projects. This is because we rarely perform a 
project in a vacuum: multiple projects performed simultaneously have become 
the norm. Some projects are logically related to one another, while others 
may be related only because they share resources and occur within the same 
organization.

Project 2013 provides features and functions that can help you manage 
multiple projects and we’ll point those out throughout the book. However 
to fully address multi-project management, you’ll need Project Server, the 
software that enables multiple users to effectively collaborate on projects.

“Project management (PM) is the application of knowledge, skills, tools and 
techniques to project activities to meet the project requirements. Project 
management is accomplished through the appropriate application and 
integration of the 47 logically grouped project management processes, which 
are categorized into five Process Groups.

Overview

What is Project 
Management?
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1
These five Process Groups are:

hh Initiating,
hh Planning,
hh Executing,
hh Monitoring and Controlling, and
hh Closing”1

The project management process is effective when projects are aligned with the 
organization’s strategy, completed to the satisfaction of the client (fitness for 
use) and sponsor, and produced on time and within budget. It is increasingly 
important that we also do this while maintaining and building relationships.

Projects are critical to the success of any organization: they are how an 
organization brings about change. But projects are often poorly managed and 
the costs of this mismanagement are high. They include projects that are late, 
over budget, produce substandard products, don’t satisfy stakeholders and 
don’t align with the organization’s business strategy.

Projects are complex: they involve people and variables that make it impossible 
to follow a simplistic cookbook approach and to predict outcomes with 
complete accuracy. We need project management to manage dynamic and 
complex efforts to achieve objectives within a project’s competing demands of 
scope, time, cost, quality, resources and risk.

Completing projects efficiently and effectively provides a competitive edge and 
enables an organization to improve the way it serves its clients, stakeholders 
and employees. Effective project management improves the likelihood that 
projects will be completed successfully.

“A project is a temporary endeavor undertaken to create a unique product, service 
or result.”2 

Projects are the means for making changes (new and improved products and 
processes, mergers and acquisitions, etc.) in any organization. They represent 
a significant expenditure of money and critical resources. Projects are critical 
factors in meeting strategic objectives. 

Some organizations have projects as their core operations, like construction, 
aerospace and consulting companies. There are full-time project managers in 
these companies. In other organizations, projects are often used to implement 
changes (like relocations and reorganizations) or for creating new systems 
(such as information and financial systems). These organizations may also 
have professional project managers, but many projects may be managed by 

1 ——— PMBOK® Guide – Fifth Edition, PMI, 2013, p. 5.
2 Ibid., 3.

Why Project 
Management

What is a Project?
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occasional or incidental project managers. The line manager of today often has 
one or more projects in progress. 

Here is a list of some common project types with examples. Each may have a 
wide range of complexity, cost, duration and criticality:

hh Organizational change projects: implementing a new methodology or 
relocating an office

hh Regulation implementation projects: meeting new environmental or 
reporting requirements

hh Event projects: conducting a conference or making a presentation to 
investors

hh New product development: developing a new pharmaceutical drug
hh Information systems projects: developing new software or maintaining 

existing software
hh Construction projects: designing and constructing buildings or roads 
hh Education projects: developing new courseware or conducting workshops

There is a tendency to downplay the importance of small projects to justify 
not bringing project management principles into play. Small projects are as 
important as any, particularly because there are so many of them and they may 
be critical to business operations.

The formality of project management must be scaled to the size, complexity 
and setting of the project to be managed. The fact that a project is small may 
seem to indicate less of a need for formality. However, when there is a dynamic 
flow of many small projects, as in a maintenance environment, you may in fact 
need greater formality.

Some small projects are complex and critical. For example, when a condenser 
needs to be replaced in a coal-fueled power plant (a project that is small in the 
context of major facilities projects), it can require that operations be suspended 
for several weeks. The potential for this “small” project to fall off track has huge 
financial consequences and therefore a need for greater formality. 

Every project needs to be managed effectively. 

Project management is a process designed to improve project performance. 
Before we look at the principles of managing a single project, it’s important to 
understand the context within which projects exist.

Enterprise Project Management (EPM) or Organizational Project Management 
(OPM) is the higher-level process within which project management fits. EPM 
improves organizational performance by linking project work, along with 
operational work, to organizational strategy.

Examples of 
Projects

A Word About 
Small Projects 

Enterprise 
Project 
Management 
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EPM addresses the multi-project environment of an organization and the 
relationships between projects, programs, portfolios of projects, resources and 
the organization’s strategies, goals and objectives, across all the organization 
units.3

EPM is made up of three complex processes: project, program, and portfolio 
management, as described below. In addition, it includes the continuous 
improvement of the overall PM process and the way it relates to other business 
processes like quality management, engagement management and new 
product development.

As we said earlier, project management is “the application of knowledge, skills, 
tools, and techniques to project activities to meet project requirements.”4 
The focus of PM is the individual project, where the detailed action of PM is 
defining scope, estimating, scheduling, executing, controlling, etc. Projects 
deliver results. 

Program and portfolio management are different: they focus on strategic 
thinking, optimizing resources and prioritizing, coordinating, and facilitating 
multiple projects. 

hh Portfolio Management
Portfolio management is “the centralized management of one or more 
portfolios to achieve strategic objectives.”5 

A project portfolio is a collection of projects, programs and/or other 
portfolios. There may be multiple portfolios of projects which roll up into 
a complete enterprise wide portfolio. 

Portfolio managers and decision makers prioritize among projects within 
portfolios and select those which will best support the organization’s 
objectives by effectively utilizing resources in a way that is aligned with 
the organization’s strategy. 

hh Program Management
Program management is “the application of knowledge, skills, tools, and 
techniques to a program to meet the program requirements and obtain 
benefits and control not available by managing projects individually.”6 It 
is the coordinated application of marketing, strategic planning, project 
management, and general management to meet program objectives.

3 In this context we are talking about the general enterprise project management environment, not 
Microsoft’s® enterprise solution. 

4 ——— PMBOK® Guide – Fifth Edition, PMI, 2013, p. 5.
5 ——— The Standard for Portfolio Management – Third Edition, PMI, 2013, p. 178.
6 ——— The Standard for Program Management – Third Edition, PMI, 2013, p. 167.

Components of 
EPM
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A Program is “a group of related projects, subprograms, and program 
activities that are managed in a coordinated way to obtain benefits not 
available from managing them individually.”7

Programs deliver benefits that cannot be delivered in the context of 
individual projects and portfolios and their management assures that the 
right projects are done to satisfy organizational strategy.

The graphic of the EPM process model below shows EPM as a process that 
combines governance, portfolio, program, and multi-project management, 
as well as individual project management. Portfolio management is a critical 
component that relies on the effective performance of project and program 
management and at the same time drives their performance. The whole EPM 
process is supported by collaboration and consultative support, relationship 
management, organizational change management, coaching, knowledge 
transfer, etc. 

You can see the following steps in the diagram: 
hh Step 1.0, Originating, is a bridge between portfolio and program 

management and individual project initiation. It is where requests for 
projects arise, are evaluated, and decisions are made as to which will be 
proposed as project possibilities. Originating is really a part of portfolio 
management and governance.

hh Steps 2.0 through 6.0, Initiating through Closing, represent the 
management processes for a single project. 

hh Step 7.0 addresses the way the overall process is continuously improved 
based on lessons learned from individual projects, best practices, and new 
PM tools. 

The “Gates” in the diagram are decision checkpoints at major points in a 
project’s life. At the gates, portfolio management and individual project 
management meet. Decisions regarding the continuation of the project are 
made. 

7 Ibid, 166.

EPM Process 
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EPM Process Model8

“Strategic planning for project management is the development of a standard 
methodology for project management, a methodology that can be used over 
and over again, and that will produce a high likelihood of achieving the 
project’s objectives.” 9

In every organization, there is a desire to achieve excellence in project 
management: to reach success in projects by obtaining the benefits that were 
initially expected. 

To achieve excellence in project management, you need to have the foundation 
of a project management maturity model (PMMM) in place. There are many 
models that the organization can use. The following PMMM graphic that 
represents an industry-validated model.

8  IIL’s Unified Project Management Methodology Model™ (UPMM™)
9 Kerzner, Harold, Using the Project Management Maturity Model: Strategic Planning for Project Management, 

Second Ed., New Jersey: Wiley, 2005, p. 42.
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The five levels of project management maturity, using the PMMM by Harold 
Kerzner10, are: 

hh Level 1 – Common Language: The organization recognizes the importance 
of project management and the need for a common project management 
language and terminology.

hh Level 2 – Common Processes: The organization recognizes the need for 
common processes that can be repeated and also recognizes the application 
and support of project management principles to other organizational 
processes.

hh Level 3 – Singular Methodology: The organization recognizes the 
synergistic effect of combining all corporate methodologies into a singular 
methodology.

hh Level 4 – Benchmarking: The organization recognizes that process 
improvement is necessary to maintain a competitive advantage and that 
benchmarking must be performed on a continuous basis to achieve this. 

hh Level 5 – Continuous Improvement: The organization evaluates the 
results from benchmarking and enhances the processes defined in Level 3.

Any project management singular methodology, as mentioned in Level 3, 
needs to include sound scheduling processes. This is the main objective of this 
book. A sound scheduling methodology will not cover all project management 
processes, but will help you cover the majority of them.

10 Kerzner, Harold, Using the Project Management Maturity Model: Strategic Planning for Project Management, 
Second Ed., New Jersey: Wiley, 2005, p. 42.
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As we have said, the focus of this book is on how to use Project 2013 to manage 
individual projects. To do this, you need a solid understanding of the basic 
principles of project management and how to adapt and apply them to specific 
project situations. 

According to the PMBOK® Guide – Fifth Edition published by PMI® there are 
ten areas of knowledge that must be addressed to manage any project: 

As a stand-alone tool, Project 2013 is most helpful in managing time (schedule 
development and control), cost (budget development and control), and 
resources (the availability and workloads of the people, machines, and other 
resources). It helps in managing scope (what is to be accomplished) to the 
extent that it reflects the work activities to be performed. 

Project 2013 also provides features that help to manage communication 
among project stakeholders. Reports of project status, progress and predicted 
outcomes can be produced, emails can be triggered, etc.

Project Server 2013 can be of even greater help to the project manager in 
managing communication, risk, and other areas. Program management and 
portfolio management are also covered thanks to Project Server 2013. 

Every project is a response to a request for some outcome (deliverable) within 
a stated time and cost. The requester wants a new or changed product, process, 
or event in a certain amount of time and for a desired cost.

During the project life-cycle, the project may be pulled by many forces that 
compete against one another and can make strong demands upon it. These 
are commonly referred to as the competing demands and include: scope, 
time, cost, quality, resources, and risk. These competing demands are initially 

Managing 
Individual Projects

Areas of 
Knowledge

Where Project 
2013 Fits

Project Demands
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client- and sponsor-driven. Then, through negotiation, they are turned into a 
realistic plan that considers other demands on the project such as the size and 
complexity of the deliverables, the size and complexity of the project team, 
the availability and capacity of the human and other resources, the reliance on 
other projects, the cultural and legal restrictions, as well as any and all factors 
that influence project performance. 

In delivering the project to its requested or required scope within the defined 
time and cost constraints, it is important to recognize the interdependencies 
of scope, time, and cost. The project team should identify the primary drivers 
of the project and be able to measure the impact of a potential change in scope, 
time, or cost for each.

Discipline promotes best practices and a broader perspective, and supports 
continuous improvement. Further, it helps the organization comply with both 
regulatory and due diligence constraints. 

However, flexibility is essential to provide people the autonomy and support 
they need to creatively navigate the intricacies of the organization while 
meeting objectives effectively and efficiently. 

A balance between flexibility and discipline is needed to create a dynamic 
project management process that meets the needs of complex organizations in 
fast-paced environments. 

Over-discipline can lead to unnecessary costs, delays, frustration and poor 
products. Over-flexibility can lead to the same results. The nature of the project 
and its environment should drive the degrees of discipline and flexibility 
needed and the forms they take. Project planning includes making decisions 
regarding the way procedures and approaches will address discipline and 
flexibility. While the PMBOK® Guide – Fifth Edition represents “good practice,” 
it is not necessary to apply every PMBOK® Guide – Fifth Edition principle to 
every project. It is up to the project manager and the project team to determine 
which processes to apply and to what degree of rigor they should be applied.

Balance Flexibility 
and Discipline
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The PMBOK® Guide – Fifth Edition defines PM as a process with five process 
groups: Initiating, Planning, Executing, Monitoring and Controlling, and 
Closing. 

The illustration below graphically represents these process groups and their 
complex interrelationships. 11 

Planning
Processes

Initiating
Processes

Executing
Processes

Closing
Processes

Monitoring & 
Controlling Processes

The process groups are defined in detail below. The following explains the 
relationships among the process groups, which are iterative and non-linear: 

hh Initiating is typically thought to be the first step in any process; however, 
there is need for planning before initiating any project. Further, there are 
decision points in some projects at which initiating is revisited.

hh Planning continues throughout the life of the project. It overlaps with 
initiating to provide cost, time and resource information for use in decision 
making. Planning also provides the baseline for controlling the project.

hh Monitoring and Controlling provide information for refining the plan. 
hh Executing provides the deliverables as well as the data for use in Monitoring 

and Controlling. 
hh Closing is a process that begins well before the project ends and influences 

future projects.

11 Adapted from PMBOK® Guide – Fifth Edition, PMI, 2013, p. 50.

The PM 
Process
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The next sections will briefly describe the five process groups. The planning 
process group is covered in more depth than the others, as it is the central 
process and a principle focus of this book. 

Initiating results in a project that (1) has been authorized by those who have 
the responsibility to decide which projects are to be funded and (2) can begin 
to use resources to execute the project. Authorization often extends up to a 
checkpoint at which the project will be reevaluated.

To initiate a project, decision makers use information regarding project scope, 
time and cost. These “triple constraints” plus others like resource availability, 
risk, and market and regulatory issues, are factors to consider when initiating 
a project. This implies that planning must begin prior to project authorization. 
Early estimates should be provided as a range, understanding the risks that 
could be encountered at this stage of the project.

While initiating, potential project stakeholders are identified and may take 
part in providing supporting information to be used in decision making.

Planning is arguably the most central and critical part of project management. 

Planning results in a project plan that is the baseline for directing and 
controlling project performance. The plan is a model of the project and since 
projects are dynamic the plan must also be dynamic. Planning begins as soon 
as anyone begins to describe the project and continues throughout the project’s 
life. Planning is the opportunity to learn about the needs and character of the 
participants and identify optimum ways to fulfill their needs. It is the means 
for managing expectations as well as acknowledging and reducing risk.

Planning is part of the “real work.” The value of planning was impressively 
demonstrated in a project some years back: a project team coordinated 
equipment and multiple suppliers to build a real house that met stringent 
building codes in only three hours. The only way this was possible was to do a 
significant amount of planning beforehand to minimize chance and make sure 
everything went well. Of course, over-planning and expecting the plan to be 
rigidly followed is as ineffective as not planning. The plan is a useful guide as 
opposed to a set of orders to be followed.

Planning can be done with a wide variety of levels of detail and formality. It 
consists of the following activities:

Initiating

Planning
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hh Identify scope — objectives and requirements
hh Agree on the approach
hh Identify and describe the activities 
hh Estimate and schedule the work (this includes addressing risk and 

uncertainty)
hh Optimize the plan
hh Adjust as needed and throughout the project cycle to keep the plan up-to-

date to truly reflect the project’s real-world situation 

These planning activities are not performed in a simple sequence. Each step’s 
outcome is influenced by the outcomes of previous steps and may influence 
those outcomes as well. Optimizing the schedule might require adjustments 
to the objectives and requirements. Planning is a complex, iterative process.

Risk and uncertainty are realities. To manage them, you should include 
allowances for contingencies, issues, and changes. State your assumptions and 
clearly communicate the degree of uncertainty.

Planning is done throughout the life of a project. Rolling wave planning 
(as illustrated in Chapter 4) is an approach that recognizes the uncertainty 
faced by many project managers. In rolling wave planning, a high-level plan 
is developed for the whole project and the next phase of work is planned in 
greater detail. At the completion of that phase, the overall plan is reviewed and 
possibly refined, and a detailed plan for the next phase is created. This rolling 
wave approach is used to give project stakeholders increasingly accurate 
estimates and schedules as more becomes known about the project and its 
requirements.

The more people know about what they expect to receive or deliver, the more 
likely it is they will be satisfied. Objectives and requirements define what’s 
expected. They answer questions like:

hh What are the overall intent and major outcomes of the project?
hh What is the underlying reason for performing the project (e.g., save money, 

make more money, improve service to customers)?
hh What is the desired outcome (the product), when is it desired and what are 

the cost expectations and limitations?
hh What are the specific behavioral and functional requirements?

Objectives and requirements drive the project and form the basis for 
determining whether the project was successful. They are progressively 
elaborated starting with a relatively abstract definition and proceeding to 
greater degrees of detail and specification as the project unfolds.

Identify scope — 
objectives and 
requirements
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It is essential to forge agreements among the stakeholders early in the life 
of the project. Establish guidelines, standards, and procedures scaled to the 
needs of the project. Get agreement on how communication, procurement, 
issues, change control, and quality control will be handled. This will help 
avoid confusion during the project and promote best practices that increase 
effectiveness and efficiency. Avoid bureaucracy and seek the right balance 
between flexibility and discipline. The use of Project 2013 to manage this area 
of planning is covered in Chapter 3: Entering Tasks.

Identify all of the project’s outcomes or deliverables and the work required 
to deliver them. The work breakdown structure (WBS) is a “hierarchical 
decomposition of the total scope of work to be carried out by the project team 
to accomplish the project objectives and create the required deliverables.”12 
Each descending level of the WBS represents an increasingly detailed 
definition of the project work. The WBS organizes and defines the total scope 
of the project and represents the work specified in the current approved project 
scope statement. 

Taking a layered or hierarchical approach enables planners to more accurately 
identify all of the work that needs to be done and manage it at different levels 
of detail. The WBS also becomes a focal point for project accounting and for 
assigning responsibility and accountability. It is the basis for estimating and 
scheduling.

Project 2013 is designed to automate work breakdown structures. Chapter 3: 
Entering Tasks will explore the WBS and how it is used in Project 2013. 

When you estimate you are attempting to predict a project’s effort, cost, and 
duration. Scheduling brings together the availability of resources and their 
numbers and capability; the activities to be done, including their sequence, 
estimated labor, and other costs; the environmental conditions; and the 
calendar. The output of scheduling is a time line predicting when tasks will 
be performed, resources will be needed, and deliverables will be completed. 
The estimated cost of the project can be calculated and a budget created based 
on the schedule. You should estimate based on past experience and at an 
appropriate level of detail.

Dynamic scheduling recognizes and accepts that change is inevitable. It 
is based on a systematic linking of project activities to one another and to 
resources so that change in one part of the model can be easily analyzed to 
determine its impact elsewhere. 

Sequencing or linking is a critical part of scheduling. Analyze the dependencies 
among activities to determine which activities must be done serially and which 

12 ——— PMBOK® Guide – Fifth Edition, PMI, 2013, p. 126.
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can be done in parallel. For example, if an activity is completed late and other 
activities are delayed waiting for the results of the first activity, there is a ripple 
effect through the project. Chapter 5: Entering Dependencies, will discuss 
various techniques and thoughts about linking tasks.

Will resources be available? Planning requires realistic assessment as to 
whether the staff and other resources will be available at the right time. 
Resource availability and capability directly affect the schedule. Assess the 
likelihood of resources being what, when, and where you expect them to be. 
Chapters 7 and 8 address resource-related aspects of scheduling.

The project manager is responsible for keeping the project plan up to date 
and realistic. A dynamic schedule allows Project 2013 to minimize the work 
required and to give stakeholders the ability to assess risks and impacts. 
Further, it enables planners and managers to explore “what-if ” scenarios to 
explore alternatives and come up with various actions to take.

Unfortunately, project management tools do not automatically estimate 
or sequence project activities. That is why many of the chapters are titled 
“Entering …” People enter estimates, resources, and dependencies. Once the 
unconstrained schedule is built, it may be necessary to indicate constraints on 
the project. This is covered in Chapter 6: Entering Deadlines, Constraints, and 
Task Calendars.

The use of Project 2013 to manage this area of planning is covered early in the 
material.

Scheduling is modeling. A model is a simplification of reality that enables 
modelers to reflect reality without spending undo time, effort, and other 
resources. Dynamic scheduling, as described in this book, is predicated on 
the idea that a schedule is only truly useful if it is kept up-to-date and allows 
for change. A dynamic model allows the schedulers to come up with multiple 
alternatives and to optimize the plan.

An optimized plan is one that comes to the right combination of product 
quality, cost, and time, given resource and other constraints. Come to an 
agreement with the client and/or sponsor about priorities and trade-offs to 
ensure optimization applies to all stakeholders. In reaching this agreement, 
the project’s outcome, target date, budget, available resources, tools, 
techniques, and the project environment may all be adjusted to find a realistic 
and optimum plan to achieve objectives. Pushing back and justifying why you 
may have to say “no” is part of the process of managing expectations that will 
ensure project success.

Chapter 9: Optimizing the Schedule addresses how to re-plan the schedule 
using Project 2013. 

Optimize
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Planning continues throughout the project’s life and should always accurately 
reflect the project in its current state. The plan is a baseline for determining 
if expectations are being met and for identifying actions needed to keep the 
project on track.

Dynamic scheduling using Project 2013 enables project managers to assess 
the impact of changes, compare the current plan for the rest of the project 
against the baseline and determine any needed course of actions. 

Chapter 10: Updating the Schedule will address keeping your schedule up to 
date.

Planning is where most of the management is. Executing is where 90% of the 
action is. Project activities are performed, deliverables are produced and data 
is created. You can use Project 2013 to capture time and cost data and provide 
a repository for performance data such as the amount of effort expended to 
complete a task. Another important aspect of executing is to manage and 
document project issues and changes.

Chapter 11 addresses reporting and will introduce many new ways to report 
on a project’s progress, status, and forecasts. 

In Monitoring and Controlling you take the project performance data and 
compare it to the plan to determine whether expectations are being met, 
changes are needed to the plan, or corrective action is needed.

Project 2013 provides a rich collection of reporting features to present 
progress, status and forecast reports.

Remember, the process is iterative: as the project progresses there may be 
variance from the original plan and there certainly will be more information 
available for validating assumptions. You need to go back into planning to 
refine the plan so as to make it more realistic. Further, planning is performed 
at key points in the project to make more refined short term estimates and to 
re-estimate out to the end of the project. 

Chapter 12 on Earned Value Management addresses how to use Project 2013 
to monitor and control your projects.

Monitoring and Controlling is not limited to the budget and schedule. You 
should also assess the quality of the product and the relationships among the 
project stakeholders.

Keep the Plan Up to 
Date

Executing

Monitoring and 
Controlling
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Projects MUST end. They end when they are cancelled or when they achieve 
their objectives and the end product is delivered. Closing includes the processes 
that formally terminate a project and transfer the completed product to those 
who will support, use, manage, or maintain it for its life. Formal termination 
includes archiving project documents, closing out cost accounts and contracts, 
and obtaining formal acceptance of the project results.

Closing also includes the review and evaluation of the project’s performance 
and the identification of lessons learned. In large, complex projects, closing 
processes may also occur at the end of key project phases.

We use the term “Dynamic Scheduling” in the title of this book. We present 
here a brief explanation about why we schedule and what we consider a 
dynamic schedule.

There are many reasons for preparing project schedules. Here are four examples 
which require varying levels of challenge and detail:

hh Sell
You can use schedules to sell upper management or a client on undertaking 
a new project.

Project 2013 schedules support this type of selling with the Timeline 
View graphic with the main dates, or by making the timing of milestones 
visible in a high-level Gantt chart. Schedules built for this purpose often 
look very slick.

Selling requires the least detail in your schedule, but requires a high level of 
knowledge and experience about the situation, because you must present a 
realistic prediction without a deep analysis of details. The expected result 
would be that you get the contract or project authorization.

hh Delegate
Once your project is authorized, you need a more detailed schedule to 
delegate the work. 

With Project 2013, you can develop this from the high-level schedules you 
used for authorization or selling purposes. Create your work breakdown 
structure and use the details from it to generate activities to assign to 
team members or subcontractors. Use your schedule to communicate 
commitments: everyone will know what to do and when to do it, and 
you’ll also have a budget of your project. The expected result is a plan with 
commitments agreed upon and the project baseline set.

Closing

Dynamic 
Scheduling
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hh Track
In order to track your project, you enter the current status regularly 
into your Project 2013 schedule and compare the progress against the 
previously defined baseline. The output of tracking is a status report that 
shows how far the project has progressed. 

Tracking allows you to report to stakeholders what has been accomplished 
in the project and provides a history that allows you to learn from past 
successes and failures. If you use Earned Value Management for tracking, 
you will also obtain variances and performance indices which are the basis 
for trend analysis and forecasting.

hh Forecast
You can use Project 2013 to model your project to forecast the finish date 
and the total cost. You have to create the schedule in such a way that it 
immediately shows what impact actual events have on the project finish 
date and cost as you enter progress information.

Forecasting provides answers for questions such as: When will deliverables 
be available? On what dates will individual resources be needed? When 
will the project be done? What will the project cost? If the answers to 
these questions aren’t acceptable according to your commitments, you 
will need to apply corrective actions and replan the remaining activities. 
If this is not possible, you will need to renegotiate the main objectives or 
maybe even look at some trade-offs.

In order to use your schedule for the four purposes described above, you will 
need to prepare your Project 2013 schedule model for the initial planning 
phases. We will provide you with all the guidelines to help you set up a dynamic 
schedule that will give you this predictive power. 

Your project schedule is a model: a simplification of reality. We use models 
because we can build a model at a fraction of the cost of building the reality. 
Models let us simplify complex realities so we can manage them to make 
decisions. But it’s crucial to represent that reality in a way that helps us make 
the right decisions.

A static chart is one that requires you to do all of the updating. A dynamic 
model updates itself: when you enter change in one part of the project, other 
parts are automatically updated. 

As a project manager, you should make it your goal to create a dynamic model 
of your project situation, not just draw a static chart that will look impressive 
hanging on your wall. The advantages of a dynamic model are:

hh A dynamic model is easier to update

Static Chart or 
Dynamic Model?
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A static schedule might initially represent a good model of the real project 
timeline and costs, but in a fast-changing environment, a static schedule 
will soon be obsolete. The re-work to build a new static model can be huge 
and you’re likely to miss some important progress updates which could 
result in wrong decisions for the future.

A dynamic schedule is a living document and should be kept alive until 
the project ends. If a schedule model is not or cannot be kept easily up-to-
date, it is not a dynamic schedule.

hh A dynamic model is responsive
In order for schedules to be easily kept up-to-date, they need to be 
responsive. A responsive model updates itself as much as it can. Schedules 
can do this if they were created with as many dependencies as needed 
and as few fixed dates (constraints or manually scheduled tasks in Project 
2013) as possible. A dynamic schedule uses all of Project 2013’s automatic 
updating features to keep it updated as you enter information on progress.

hh A dynamic model has predictive power
Schedules need to show the latest forecasts of the finish date and the final 
expenses of the project. Only then can a schedule truly be a powerful 
decision-support system for the project manager and key stakeholders. 
This requires that the model use empirical, actual data that is translated 
into forecasts using algorithms. To complement these algorithms, it 
is necessary for the project manager to use trend analysis. And most 
importantly, corrective actions need to be taken if the project deviates 
from the original objectives. A dynamic schedule will allow all of these.

Another advantage a dynamic model has over a static chart is that you 
can use a dynamic model to develop different scenarios to analyze other 
possible situations and then implement what could be a better option. 

hh A dynamic model is easily accessible online and in real time
In order to keep the project team working together and aligned, all 
information from the dynamic schedule model needs to be easily 
accessible to everyone. This is essential in order for good decisions and 
corrective actions to be made in a timely manner.

The project manager is responsible for making the schedule readily 
available. The traditional solution is to deliver reports at different levels of 
detail following pre-established reporting periods. The other option is to 
have all of the information online and in a real time, using the advantages 
of Project Server 2013 and SharePoint Server 2013. With this solution, 
you’ll have the powerful and dynamic features of Project 2013 accessible 
through a user-friendly interface that executives and team members can 
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use to keep their fingers on the pulse of their portfolio, programs and 
projects. 

In the chapters that follow, we will show you how to create a model of your 
project—one that meets all the criteria of a dynamic schedule we just described.
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In this chapter we have defined terms and set a conceptual foundation for what 
project management is: what its basic principles are and what process groups 
make up the overall process of managing a project.

The remainder of the book addresses the use of Project 2013 in planning, 
executing, monitoring and controlling, and closing a project. The book is 
centered on the concept of dynamic scheduling.

Former US President and Military General Dwight D. Eisenhower once said, 
“In preparing for battle, I have always found that plans are useless, but planning 
is indispensable.” In the time in which he lived (1890–1969), most project 
plans were static in nature and “dead” as soon as they were written. A plan that 
can’t be or isn’t updated is of limited use. Clearly, President Eisenhower was a 
very knowledgeable project manager.

With the introduction of Project 2013, we can create plans that are alive and 
dynamic. In Project 2013, the project schedule is a model that shows the most 
current status and allows predictions based on the combination of dependency 
and resource linkages. This easy to update electronic model of your project 
allows you to make forecasts at any time during the life of the project, adjusting 
for the inevitable changes. 

Such a dynamic model is a powerful tool for project managers. Maybe if 
President Eisenhower were still alive, he’d say: “In preparing for the global 
marketplace, I have found that planning is indispensable and dynamic models are 
a critical success factor.”

But planning by itself is not enough. We must apply the principles of project 
management throughout the project management process groups, from 
initiating to closing, and we must do it with full awareness of the enterprise 
and environmental conditions that influence our projects.

The remainder of this book addresses the way that Project 2013 can be used to 
enable effective scheduling and budgeting, as well as project control, through 
dynamic scheduling.

Recap
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1. What is a project and what makes it different from other kinds of work?

2. Are there organizations that never have any projects?

3. Are there organizations that only have projects?

4. What is the difference between project management, program 
management and portfolio management?

5. What are the PM knowledge areas according to the PMBOK® Guide – Fifth 
Edition from PMI®?

6. What are the competing demands in project management and why are 
they important?

7. What is the rolling wave approach to project planning?

8. What are the six activities of project planning and are they always done in 
sequence?

9. What advantages does a dynamic schedule have over a static schedule?

Review 
Questions
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Planning

2 Setup
1 Concepts

Initiating

Executing,
Monitoring & 
Controlling
  9 Optimizing
10 Updating
11 Reporting
12 Earned Value

13 Evaluating
Closing

3 Tasks
4 Estimates
5 Dependencies
6 Constraints
7 Resources
8 Assignments

Chapter 2: Getting Started with 
Project 2013

Now that we’ve reviewed the terminology and basic concepts of project 
management, we’re ready to explore the Project 2013 application interface and 
set up a new project.

After reading this chapter you will be able to:

hh Describe the basic functions Project 2013 performs
hh Discuss the differences/benefits of the task scheduling modes in Project 

2013
hh Identify the components of the Enterprise Project Management (EPM) 

tools
hh Navigate the Project 2013 interface
hh Identify where Project 2013 stores data 
hh Identify and select among the Project 2013 views
hh Select and use a project template
hh Set up a new project and choose the appropriate options
hh Create a Project Calendar
hh Identify and describe best practices for setting up new project schedules

J. Ross Publishing; All Rights Reserved



48

Dynamic Scheduling® with Microsoft® Project 2013

In any project, you need to answer these seven questions to provide the basic 
information needed for scheduling:

Question Used to define
1. What needs to be done? Deliverables and Tasks

2. How long will it take? Duration Estimates or Work Estimates

3. In what order? Dependencies

4. When must it happen? Constraints

5. Who is going to do it? Resources and Assignments

6. When will it happen? Start and Finish Dates

7. How much will it cost? Total Cost of the Task or Deliverable

Project 2013 helps you record, manage, maintain and even create the data that 
answers these questions.

hh You enter the answers to the first five questions

hh Project 2013 computes the last two bolded questions (and allows you to 
adjust them, if needed)

Project 
Management 
Software

Okay, I know I have everything I need but I just don’t know how to swim!
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hh Project 2013 stores the data, organizes it and reports on it

You typically enter the answers to the first five questions. However, it is a 
best practice and beneficial to you to let Project 2013 assist you in accurately 
answering questions 6 and 7. Lets look at questions 6 and 7 below:

6. When will it happen?
You can enter start and finish dates for auto scheduled tasks using Project 2013. 
However, this usually results in your task dates being bound or constrained in 
one way or another. As we will discuss later in the chapter, we recommend that 
you let Project calculate Start and Finish dates for your auto scheduled tasks 
so that you can reap the benefits of a dynamic schedule. With the manually 
scheduled tasks, you can enter as much information about the task as you have 
to get started with planning. Once you have all the needed information about 
the task, you can make the task auto scheduled and let the powerful scheduling 
engine of Project 2013 calculate your Start and Finish dates for you.

7. How much will it cost?
Project 2013 can capture and calculate costs in a variety of ways. You can enter 
costs that are fixed or generated by Cost resources directly into your schedule. 
However, another advantage of using project management software is its ability 
to quickly calculate variable costs—i.e. costs that are rate, time, or consumption 
based. By simply setting up standard rates for Work resources and assigning them 
to tasks, Project 2013 can calculate costs of items in your project. You can also 
track costs related to items that are consumed in the project, (like lumber, paper, 
or cement). Here, you can set up Material resources to track these individual 
items on a task-by-task basis. Lastly, you can track your current budgets 
using Budget resources. We will discuss how Project 2013 calculates costs in  
Chapter 7: Assigning Resources. 

Project 2013 reduces the effort needed to manage project management 
processes. It serves as a project management information system, maintaining 
information on the project, its tasks, resources, dependencies, estimates, costs, 
etc. Dynamic scheduling helps you use Project 2013 not only for creating your 
schedule, but also for keeping it up-to-date and reporting on the status vis-à-vis 
the plan. 

In Project 2013, you have the ability to specify the “task mode” of specific tasks 
to be either automatically or manually scheduled. With manually scheduled 
tasks, you are responsible for entering and maintaining the start and finish dates 
of each task. For more Dynamic Schedules, however, we recommend you set 
your tasks to be automatically scheduled. This way, Project 2013 can compute 
start and finish dates based on duration estimates, resource dependencies, and 
logical dependencies. A schedule with dependencies is flexible; the tool knows 
how to update the other tasks automatically when preceding tasks or resource 
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availabilities change. That said, we don’t want to give the impression that the tool 
does all the work once you set up a dynamic schedule with dependencies—it 
doesn’t.

For example, the tool doesn’t know much about the relationship among project 
stakeholders or about the project environment. In its standalone form, the tool 
doesn’t know about other projects and how changes in those projects may affect 
your project. Changes in resources can have effects that can’t be interpreted 
by the tool to accurately recalculate finish dates unless you enter durations, 
assignments, and revised effort estimates. Further, based on the cause of slippage 
and on the corrective action to be taken, you must enter revised tasks, estimates, 
dependencies, constraints, and resources to enable Project 2013 to re-compute 
start and finish dates.

Project 2013 has the capability to schedule tasks automatically or manually. 
When manually scheduled, the start and finish dates of tasks do NOT move 
when other linked or related tasks are moved. Manually scheduled tasks are ideal 
for placeholders you can use as you wait for approval or further information 
about a task.

Manually scheduled tasks are not to be confused with Inactive tasks. Inactive 
tasks are visible within the project schedule but the information is not counted 
toward project or summary task totals.

If you use manually scheduled tasks in your project schedule, changes in 
resources or tasks will not affect these tasks’ start and finish dates in the schedule.

Based on the resource cost rates, effort estimates, and assignments you enter, the 
software calculates the total cost per deliverable, per level of detail in the work 
breakdown structure (WBS) and for the whole project. If you enter actual effort 
data, actual costs can be compared to planned costs.

Project 2013 does efficient reporting. The software is a database in that you can 
pull data to focus on any task or deliverable at any level of summary, any period, or 
any resource you want. The new report format permits a degree of customization 
to provide meaningful and appealing graphical reports. These reports show cost, 
schedule, and other data from which users can compare actual against planned 
progress.
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Individual projects don’t exist in a vacuum. Project 2013 Professional is one 
component of a larger system.

While Project 2013 Professional can be used on its own it is much more powerful 
in the context of an enterprise solution that makes use of the power of servers 
and the Web by weaving together a number of products: Microsoft Project 
Professional 2013, Project Server 2013, Project Web App (PWA), Microsoft 
Windows Server 2012, Microsoft SharePoint Server 2013, and the rest of the 
Microsoft Office 2013 suite (this solution is also available in the cloud as Project 
Online and Office 365). There are also add-on tools and Office Apps from third 
parties that help to manage knowledge and perform other functions such as 
assessing risk through Monte Carlo Simulation.

Working together, these tools enable functions such as: 
hh Automatic notification of project events to relevant stakeholders with access 

from many devices
hh Management of multiple projects with shared resource pools
hh Aggregate reporting and analysis of multiple projects and resources in 

portfolios and programs
hh Rich collaboration including risks and issues management as well as social 

experiences like discussions, tags and documents with newsfeeds
hh The ability to integrate document and deliverables management with 

project management
hh Align vision and effort of new initiatives in optimized portfolios that 

contribute to the business strategy

Project 2013 comes in three editions: Microsoft Project 2013 Standard, 
Microsoft Project 2013 Professional, and Project Pro for Office 365. The 
Professional editions—Project Professional and Project Pro for Office 365—
can connect to a Project Server 2013 or Project Online database, which provides 
the capability to implement EPM. There are other differences in functionality 
between the Professional editions and Standard edition of Project 2013 that 
were discussed in the Introduction chapter of this book. 

There are also differences between using Project 2013 Professional with Project 
Server (or its equivalent in the cloud—Project Pro for Office 365 with Project 
Online), and using Project 2013 Standard, Professional, or Project Pro for Office 
365 without a server environment. In this book, unless otherwise specified 
we will use the term Project 2013 or Project 2013 standalone when addressing 
functions that are the same for the Standard, Professional, and Pro for Office 
365 versions used by themselves. It is also important to mention that we will 
concentrate on Project 2013 in the standalone configuration without being 
connected to Project Server or Project Online; however, unless otherwise 

Enterprise PM 
Tools

Microsoft 
Project 2013 
Standard, 
Professional, 
and Pro for 
Office 365
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specified we will reference some features to Project Server 2013 that cover both 
Project Server 2013 and Project Online.

Project 2013 can store its data in various types of files. Two commonly used file 
types that are native to the application are:
hh Regular Project files (extension .mpp for Microsoft Project Plan)
hh Template files (extension .mpt for Microsoft Project Template)

Template files are similar to project files, but with an added protection against 
accidental changes: when you open a template, you work with a copy of the 
template. The original template stays unchanged.

Project templates can be used to store layouts, settings, and information that you 
want to use for multiple projects. Each time you start a new project you start with 
a copy of the template, which you can adjust as needed for the specific project. 

Project files (.mpp) and project template files (.mpt) can both contain:

hh Data: tasks, estimates, dependencies, constraints, resources, assignments

hh Objects: views, reports, tables, filters, calendars, groups, maps, fields, 
groups and modules (Visual Basic for Applications [VBA])

hh Project-specific options: these relate to the project only and are stored in 
the individual project. You can easily recognize which options are project 
specific (local) in the Project Options dialog. (To view this, on the File 
tab, in the Backstage view, choose the Options tab, and then select the 
specific tab for the functions you want to set as project specific.) Where 
the section heading has the suffix “________ options for this project:” 
<name of current file>, the option is local and stored with the project. We will 
discuss the Project Options dialog later in this Chapter.

There is a default template file for Project 2013 called Global.mpt which 
contains default objects—like views, tables and filters that you use for reporting 
purposes. The Global.mpt is always open when Project 2013 is running. The main 
difference between the Global.mpt template and other project template files is 
that the Global.mpt cannot contain schedule data like tasks and dependencies.

You can view the available objects in the Global.mpt in the Organizer. We will 
talk more about the Organizer in the Backstage – Info section, later in this 
chapter.

Working with 
Files in Project 
2013
File Types
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Project 2013 is compatible with previous versions of Microsoft Project.

You can use Project 2013 to create mpp files compatible with previous versions 
of Project (2000-2003 and 2007). When you do this, however, features which 
are specific or new to Project 2013 will be lost. You can also use Project 2013 
to open and edit files created in older versions of Project. These files will be 
opened in Project 2013 in a reduced-functionality mode. Between Project 2013 
and Project 2010 there are no compatibility problems, they have similar features 
and functionality; if you save a project in 2013 you can open it in 2010 without 
losing data or causing your schedule to change. 

Items created using features that are unique to Project 2013, such as graphical 
reports and dashboards, may not appear as expected when viewed with Project 
2010.

When you use Project 2013 in standalone mode, (not connected to Project 
Server), the projects are stored as separate files on your file directory system. 
When you use Project Server, the projects are stored in one SQL Server database. 

At first glance, the Project 2013 application with its columns and rows bears a 
striking resemblance to a spreadsheet application. However, instead of seeing it 
as a spreadsheet, we suggest you 
think of Project 2013 as an 
application to access a relational 
database.

A relational database has several 
different tables that are related 
to each other through fields they 
have in common. In Project 2013, 
these common fields are the ID 
fields.1 You can see this in the 
illustration. Both the Tasks and 
Assignments tables have what is called a one-to-many relationship, since one 
task can be assigned to multiple resources. Similarly for resources, one resource 
can be assigned to multiple tasks. It is the one-to-many relationships in the data 
that are hard to manage within a spreadsheet application.

There are three reasons for seeing Project 2013 as a relational database 
application:

1 In fact, the Unique ID field contains the unique identifiers, because the ID values are just row numbers 
that constantly change when items are inserted or moved.

Backwards 
Compatibility

Working with 
Schedules from 
Project 2013 
Standalone
Project 2013 
as a Relational 
Database 
Application

Resources
Proj.ID Res.ID R.Name

2
2

1
2

Projects
Proj.ID P.Name

1
2

Assignments
Proj.ID Task ID Res.ID

2
2
2

1
1
2

1
2
2

Tasks
Proj.IDTask ID T.Name

2
2

1
2
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1. There are four types of data.
There are four distinct types of data or data entities in the database: projects, 
tasks, resources, and assignments. In a spreadsheet table you typically 
monitor only one type of data.

2. The data have one-to-many relationships.
The data entities are related and have one-to-many relationships between 
them.

3. Each data entity has its own table.
h` Projects can be found in the Projects table
h` Tasks can be found in the Task table that can be seen in any of the Task 

views
h` Resources are stored in the Resource table and can be seen in the 

Resource views
h` Assignments are in their own table as well. Assignments can be found in 

between the tasks in the Task Usage view or in between the resources 
in the Resource Usage view.

Project Server 2013 users store their projects in SQL Server as the relational 
database instead of in .mpp files. In a relational database, you can see each 
data entity in its own table. The (simplified) data model for the Project Server 
database is shown in the illustration on the previous page. A multi-project 
database like Project Server has an extra table at the top that contains all projects. 
The Projects table is where Project Server stores all the project level data for all 
projects in the database including project name, project manager, and project 
start and finish date.

Project 2013 enhances the concept of the Ribbon, which was first introduced 
with the release of the 2007 version of Microsoft Office. With the Ribbon, 
options are no longer listed under dropdown menus. Instead, related commands 
are placed together in groups and displayed in a series of topic-specific tabs 
across the top of the project window/screen. For example, when you click on 
the Task tab, you will see commands that relate to manipulating tasks such as 
copy, paste, link, and indent/outdent. The commands themselves are organized 
into logical groups such as Clipboard, Font, and Schedule. 

The Project 
2013 Interface

The Ribbon
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To choose a command from the Ribbon, just click on it with the primary mouse 
button. If there is a small down arrow next to the command or option, click on 
the arrow to show a dropdown list of additional options. At the lower right hand 
corner of a group of commands you may also find a small arrow pointing toward 
the 4 o’clock direction that opens a dialog box/window of options.

The Format tab of the Ribbon is context sensitive and shows different options 
depending on the current Project view you are working in. 

You can customize the appearance of the Ribbon by adding or removing tabs, 
groups, or commands. You will not be able to add new commands to the pre-
defined groups but you can create your own groups either within the standard 
tabs or on your own custom tab.

1. Right-click on any section of the Ribbon and select Customize the Ribbon. 
The Project Options dialog box will open. 

 

Customize the 
Ribbon
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2. On the right hand side of Project Options, click on New Tab. Two new 
rows will be added to the window on the right, one showing New Tab 
(Custom) and a second indented below it showing New Group (Custom). 

3. Click on New Tab (Custom) then Rename to give the tab a more 
meaningful display name. 

4. Click on New Group (Custom), then Rename, to give the group a more 
meaningful name. 

5. If you want to create a group in one of the pre-defined tabs, select the tab 
where you want to add the command, then click the New Group button.

If you need to re-position your custom group or tab, select the group or tab and 
use the (Up/Down) arrows.

6. To add a command to your custom group, in the Choose commands from 
dropdown, select All Commands then scroll to find the command you 
want.

7. Select the command on the left and the custom group on the right, then 
click Add.

You can only add commands to custom groups. 
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In addition to the Ribbon, Microsoft Project 2013 presents you with the Quick 
Access Toolbar. This toolbar can be displayed either above or below the Ribbon. 
You can use the toolbar to run the commands you use most often. 

You can customize the items on the Quick Access toolbar. To do this, click the 
downward arrow at the end of the toolbar and select More Commands. The 
Project Options dialog will open.

Commands can also be added directly from the Ribbon to the Quick Access 
Toolbar. Right-click on the command in the Ribbon then select Add to Quick 
Access Toolbar.

To remove a command from the Quick Access Toolbar, right-click on the 
command, then select Remove from Quick Access Toolbar. 

You can activate the new Touch/Mouse Mode feature which modifies the layout 
of the commands with more space optimized to be used with touch devices. To 
do this, click the down-arrow to the right-end of the Quick Access Toolbar and 
select Touch/Mouse Mode command. The Touch/Mouse Mode command 
appears at the end of the toolbar, click on it and select Touch.

Backstage is another feature updated for Project 2013. Apart of accessing the 
Project Options dialog, you can use the Backstage view to perform most file-
related functions such as Open, Save, Save As, Print, Share, and Close. You 
can also use the Backstage view to manage your Project Server and Services 
connections such as OneDrive or Office 365. 

To get to the Backstage view, click on the File tab to the left end of the Ribbon. 
You will find the Backstage is divided with the Commands section to the left 
and the additional information section to the right. You can always click the left 
arrow to exit the Backstage. 

The Quick  
Access  
Toolbar

The  
Backstage  
View
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Enhanced in this version, the Open command in the Backstage view allows you 
to access multiple locations of existing project files in order to edit or view. 

h` The first option, Recent Projects, gives you access to the files you 
worked with recently in Project 2013. 

You can modify the limit of recent files to open from the Advanced Option 
tab (File tab, Options, Advanced, under Display, modify Show this number of 
Recent Projects box.

Opening a  
Project File  
in Project  
2013
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h` The second option, OneDrive, allows you to log into your OneDrive 
account. Once you are logged in, you can click the Browse button from 
the right side of the Open window and select the folder where the file 
is stored. 

h` The third option, Computer, allows you to access your own computer. 
By clicking Browse, the Open dialog appears.

If the project is on a drive or directory other than the current one, navigate to 
it by using the dropdown list at the top of the window or the option in the left 
side pane.
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Double-click on the name of the file to open 

OR

Single-click on the file name and click Open.

The method above can also be used to open .mpp files that were saved using 
previous versions of Project.

You can open files other than .mpp files by clicking the dropdown box to the 
right of the File name box in the lower portion of the Open dialog. We will 
discuss opening different file types using the Import Wizard, in Chapter 3.

h` The last option, Add a Place, allows you to access other locations to save 
files to the cloud. This could be Office 365 SharePoint or OneDrive.

1. On the File tab, in the Backstage view, click Close. If you have made changes 
to an open project, Project 2013 will prompt you to save the changes: 

 

2. The Save As dialog appears if the project had not been saved before.

To save your changes, click Yes

To discard changes, click No

To interrupt closing the file, click Cancel

Closing a File
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The Info area of the Backstage view is divided into three sections. 

h` The Project Information section shows high-level characteristics of 
the project including the project’s Start, Finish, and Calendar.

h` The Organizer shows the objects (views, tables, fields, etc.) that you 
can use in the current project. The list includes the objects present in 
the default Global.mpt. You can also use the Organizer to transfer 
objects from one open Project file to another. 

Other Backstage 
Commands
Backstage – Info
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h` You can use the Manage Accounts button to control access to project 
information stored in Project Server. Project Server 2013 is beyond the 
scope of this book.

Enhanced for the 2013 version, you can use the New button to create new blank 
projects or projects based on templates stored locally or online. Project 2013 
also makes it easy to create projects from Excel workbooks and SharePoint task 
lists. 

Backstage – 
New
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The Print command in the Backstage view provides a single place to prepare 
your project file for printing. We will discuss each of the printing options in 
depth in Chapter 11: Reporting. 

The options under the Save command make it easy for you to store your project 
information in any of the different features available in the Save As command 
such as your Computer, OneDrive, or SharePoint. The first time you Save a 
Project in Project 2013, the Save As page will open to have you select the place 
where you can store the information. Once you save a project for the first time, 
the information will be saved immediately each time you use the Save feature 
afterwards. 

Backstage – Print

Backstage –  
Save & Save As
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The options under the new Share command make it easy for you to send your 
project information to stakeholders. You can send your entire project schedule 
as an attachment by email or have tasks saved and synched with SharePoint. 

In the new Export command, you can save your file in the format of a different 
version of Project 2013 or create a static PDF or XPS document. We discuss 
sharing project information in Chapter 11: Reporting. 

Backstage –  
Share

Backstage –  
Export
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A new Account command available in Project 2013 allows you to administer the 
user information and services available such as Storage, SharePoint Online, or 
Office Store (left side) as well as to review product information (right side) such 
as Product key, Product Version, Support, etc.

The User Information feature is available in every window in Project 2013 
(upper right menu), this will display the information account of the user and 
credential connected (Domain). When you select the Account setting, the 
Account Backstage view will open.

Backstage – 
Account
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When you use Project 2013, you can set many options that affect how the 
application behaves on your computer or for a specific project file. We’ll discuss 
the Project Options as we go through the life-cycle of your project throughout 
this book.

 

In addition to the Ribbon, Backstage, and Quick Access Toolbar, Project 2013 
has many different screen areas that appear when they are needed. In order to 
follow our procedural steps, you have to know the names of the parts of the 
screen, as labeled in this screenshot: 

Backstage – 
Options

The Project 2013 
Main Screen
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Project 2013 includes a Timeline that you can use to get a concise view of your 
entire project schedule. You can add or remove tasks from the Timeline and have 
it displayed at the top of your other Project 2013 views. The Timeline can also 
be printed or copied to presentations and reports. We will discuss the Timeline 
as a view later in this chapter.

The main portion of the screen in the illustration is divided into two sections. 
The left area is referred to as the Table or Spreadsheet. This area shows a subset 
of task, resource or assignment information in an arrangement of rows and 
columns. You can customize the display by inserting or hiding columns (data 
fields) as necessary. The right side of the screen is referred to as the Chart Area 
or Timescale. This area features a time-phased view of the project. The view can 
be adjusted to show different time periods. You can adjust the relative size of the 
Table and Chart areas by dragging the vertical divider to the left or right, and 
the relative size of Timeline and Gantt Chart views by dragging the horizontal 
divider up or down.

To add new columns to the table area in Project 2013 simply click the Add new 
Column heading at the right end of a Table area, then type or select the name of 
column you wish to add from the column drop-down.

Timeline

Table and Timescale
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The View Bar lets you switch from one view to another. It appears along the left 
side of the Project 2013 window and contains icons representing the different 
views available. If the View Bar is visible and you want to hide it, right-click on 
the bar and select View Bar from the list (to remove the check mark). The View 
Bar will now be replaced by a single strip showing the name of the current view. 
To display the View Bar again, right-click on the strip and select View Bar. 

The scroll bar consists of three parts: 

The Status Bar shows notifications, options, and features that facilitate the 
navigation and edition of the schedule. You can switch whether new tasks are 
Auto Scheduled or Manually Scheduled. You can also see a notification if a 
filter is applied or activate the view shortcuts to change among the most popular 
views. 

You can customize the status bar by right clicking on it and selecting what 
information you want to see.

You can use the Zoom Slider, located on the status bar, to adjust the view of the 
project’s timescale. Move the slider’s cursor to the left to zoom out and see a 
higher-level timeframe of the project, such as years or months. Move the slider 
to the right to zoom in and view the finer time details of the project schedule. 
You can find the zoom slider on the lower right hand corner of the screen on 
the Status Bar. The slider only works on the Gantt Chart, Network Diagram, 
Calendar, and for all graph views.

For those who are right-handed, the right mouse button or right touchpad click 
button under your middle finger 
can pop up shortcut menus that 
relate to a particular screen area. 
For example, in the stylized version 
of a Gantt Chart in the illustration, 
you can right-click on all of the 

The View Bar

Scroll Bars

Status Bar

Zoom Slider

Selected Cells

Title Bar
Menu Bar
Tools Bars
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Task Bar

Background of  Task Bars

Forms

Columns Time ScaleTable
Selector

View 
Selector

Mouse or Touchpad: 
Right-Clicks and 
Double-Clicks
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labeled locations to call up shortcut menus. You can do this in other views, as 
well.

Alternatively, you can double-click with either the left mouse button or left 
touchpad click button in these places; this will display a dialog box for the most 
likely shortcut for that area.

In addition to the Ribbon, you can also use the keyboard to move around in 
Project 2013. When you press the Alt key, KeyTips pop up next to each of the 
commands available in the Ribbon and the current view. The tips tell you which 
keys you can use to execute the command you want. 

The table below shows some of the more popular commands and shortcuts. The 
following convention is used: Alt + Right arrow means hold down Alt key and 
press Right arrow key.

Move to By keyboard By mouse
Next row Enter or Down arrow Click

Next column Tab or Right arrow Click

Next minor time unit in 
the timescale, 
or 

Previous

Alt + Right arrow
Alt + Left arrow

Click the Left and Right 
arrow buttons in the scroll 
bar

Next screen in timescale Alt + Page up or
Alt + Page down

Click to the left or right 
of the scroll box in the 
horizontal scroll bar

The start date of the 
project

Alt + Home Left align the scroll box in 
the horizontal scroll bar

The end date of the 
project

Alt + End Right align the scroll box in 
the horizontal scroll bar

Moving Around in a 
Project
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Move to By keyboard By mouse
The first task of the project Control + Home Drag the vertical scroll box to 

the top

The last task of the project Control + End Drag the vertical scroll box to 
the bottom

A specific task ID or Date, 
or specific resource, etc.

F5 
or
Control + F

On the Task tab, in the 
Editing group, click Find 

The other view in a split 
window

F6 Click in the other view to 
make it active

Move the timescale to a 
task bar

Control + Shift + F5 On the Task tab, in the 
Editing group, click Scroll 
to Task . 

The following convention is used in the table below: Alt + Tab means hold 
down Alt and press Tab

Action By keyboard By mouse
Move to next field in a 
dialog box, or

Move to previous field

Tab

Shift + Tab

Click in the field

Move to any field in a form Alt + Underlined letter 
of the field name

Click in the field

Increase or decrease value 
in a field

Alt + Up arrow or
Alt + Down arrow

Use the spin button

While the tab label is 
selected, move to the next 
tab in the direction of the 
arrow

Control + Right 
arrow or
Control + Left arrow

Click on the tab

The following convention is used in the table below: Shift + Space bar means 
hold down Shift key and press Space bar key.

Select By keyboard By mouse
An entire row or record 
(task or resource)

Shift + Space bar Click on a row heading

An entire column Control + Space bar Click on a column heading

Moving Around in a 
Dialog Box

Selecting Data
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When you select an entire row as explained in the previous table, ALL the fields 
of a task are selected, even if they are not visible. It is important to select a task in 
its entirety before moving or copying it. 

The view of a project is a predefined layout that presents the project from a 
certain perspective. The views allow you to enter or edit data, review or report 
on your project. Certain views are more appropriate for performing certain 
functions.

View Shows
Calendar Tasks are shown as bars on a calendar

Gantt Chart The tasks over time, plus Table columns and Timeline View

Network Diagram The network of dependencies between tasks (dependencies 
are shown as arrows)

Resource Sheet The Table area with resource information

Resource Usage Resources with their assigned tasks, with the workloads or 
cost over time

Resource Form Information about a single resource

Resource Graph The workloads for resources in a bar chart format

Task Usage Tasks with their assigned resources and the effort or cost 
over time

Task Sheet The Table area with task information

Team Planner Resources with their assigned tasks, shown graphically 
over time (only in Project 2013 Professional editions)

Timeline Graphical representation showing selected tasks relative to 
each other over time

Tracking Gantt The original (baseline) schedule versus the most recently 
revised schedule

Project 2013 
Views
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To see the Calendar view, on the View tab, in the Task Views group, click 
Calendar OR click Calendar on the View Bar.

Perhaps the greatest value of the Calendar view is that it shows the schedule in 
a familiar format similar to a conventional wall calendar. We recommend you 
use the Calendar view to communicate to-do lists to team members (unless you 
use Project Server). You can create a calendar view for a specific resource by 
applying a filter. To do this, on the View tab, in the Data group, click the Filter 
down-arrow, Using Resource…

Notice that the Calendar view is different from the Project Calendar. The 
Calendar view, like the Gantt Chart, displays task bars, whereas the Project 
Calendar is used to define the working times and holidays.

The Calendar view is not suitable for showing the entire schedule. As you 
can see in the next screenshot, not all task bars always show within a day because 
of the limited height of the day box. If there is too little room vertically, Project 
2013 displays a down-arrow in the top-left corner of the date heading: 

Calendar View

To See All Tasks on 
a Day
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To display all of the tasks occurring on a day, click on the down arrow; a list 
showing all the tasks on that day appears.

To show all the task bars on any day, modify the zoom by clicking the Month, 
Week, or Custom buttons, or position your mouse pointer on any of the 
horizontal grid lines and double-click when you see the mouse pointer change.

Creating new tasks in the Calendar view is not recommended because the new 
tasks end up at the end of the task list. You will still have to move them to the 
right place in the work breakdown structure (task list) in the Gantt Chart. We 
recommend instead that you enter tasks directly in the Gantt Chart view. (If 
you insist, you can create new tasks in the Calendar view by going to the Task 
tab, Insert group, and clicking on Insert. Once the new task is inserted in the 
calendar view you can drag the shape of a new task bar onto the date where you 
want it. Double-click on it to give it a task name. Notice that the task will have 
a constraint that is visible on the Advanced tab, and you should replace it with 
appropriate dependencies.)

To Create  
Tasks
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1. Double-click on a task bar; the Task Information dialog appears:

2. Make the changes, and click OK.

You can move task bars horizontally and vertically within a day or between days. 
Using your mouse you can affect several things through the task bar:

1. If you click in the middle of the task bar and drag to the next task bar you can 
create a finish-to-start dependency.

2. If you click on the outline edge of the task and drag to another period in the 
calendar, you can reschedule the task (this places a “Start No Earlier Than” 
constraint on the task).

3. If you click on the end of the task bar and drag horizontally you can increase/
decrease the duration of the task.

Unless you stay within the same day, you are creating “Start No Earlier Than” 
constraints on the tasks. Constraints are undesirable in schedules, since 
they make schedules less dynamic. We recommend you show restraint using 
constraints. There is a full discussion of constraints in Chapter 6.

To Edit the  
Data of a Task

To Move  
Task Bars
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To apply the Gantt Chart view, on the View tab, in the Task Views group, click 
Gantt Chart OR click Gantt Chart in the View Bar.

The Gantt Chart shows tasks over time with the duration of each task reflected in 
the length of its task bar. The Gantt Chart also shows the list of deliverables and 
tasks, which is commonly referred to as the work breakdown structure (WBS). 
The WBS typically has a logical hierarchy of summary tasks with detail tasks 
indented beneath them. The WBS/task list is discussed in detail in Chapter 3.

Notice that most items in the schedule explain themselves in a screen tip that 
pops up when you rest your mouse pointer over them. For example:

hh The icons in the Indicators column explain problems in the schedule

hh If the task name is cut off, you can pop up the complete name

hh The timescale time units will display the year you are in The task bars inform 
you of the type of task (summary, detail, milestone) and the deadline, task 
name, start, finish, and duration

hh The dependency arrows show which two tasks are linked by the dependency 
and if there is lag

The Gantt Chart is one of the best views to use when creating or modifying tasks 
in your project. Because it’s useful, we recommend that you provide some brief 
training on it to your team members who aren’t familiar with it.

Gantt Chart
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You can change the amount of the table you see on the left of the screen and the 
length of the timescale on the right of your screen. Revealing more of one will 
show you less of the other. You do this by pointing to the divider line between 
the table and the timescale. When you see the mouse pointer change, click and 
hold down to drag it to the desired position.

If you double-click on the divider, it will jump to the nearest split between two 
columns. This allows you to clean up the look of the view.

The task list or WBS on the left side of the Gantt Chart view can be structured 
to show summary tasks and detail tasks (as described in Chapter 3). To collapse 
or expand levels:

hh Click the Collapse outline button next to a summary task name to hide its 
detail tasks

OR

Press Alt + Shift +Minus keys 

hh Click the Expand outline button of a summary task to reveal its detail tasks 

OR

Press Alt + Shift + Plus keys.

To zoom the timescale into smaller time units to see the details: on the View tab, 
in the Zoom group, click the Zoom down-arrow, Zoom In. 

OR

Press CTRL + / (slash key)

To zoom the timescale out to larger time units in order to get an overview, on the 
View tab, in the Zoom group, click the Zoom down arrow, Zoom Out. 

OR

Press CTRL + * (asterisk key)

If you put the horizontal scroll box of the timescale at the extreme left on the 
scroll bar, you will always see the start date of the project. You can also press Alt 
+ Home.

You can also zoom the timescale using the Zoom Slider on the lower right of 
the screen. Drag the slider to the right to zoom in on the timescale and to the 
left to zoom out.

To fit the entire project duration within the timescale so you always see task bars 
when you are paging up or down, on the View tab, in the Zoom group, click 
Entire Project.

To See More Table 
or Timescale

Collapsing and 
Expanding Levels

Zooming the 
Timescale
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The Ribbon in Project 2013 includes a Timescale dropdown that you use to 
adjust how you see your project. This dropdown is in the Zoom group of the 
View tab.

If there are tasks in your project but you don’t see any task bars in the Gantt 
timescale, the timescale is just displaying a time period when no tasks happen 
to be scheduled.

To quickly see the task bar of a task, click on the task and then, on the Task tab, 
in the Editing group, click Scroll to task or press Ctrl+Shift+F5. 

To apply the Network Diagram view: On the View tab, in the Task Views 
group, click Network Diagram; OR click Network Diagram on the View Bar.

The Network Diagram shows the network of dependencies between tasks, with 
the dependencies depicted as arrows.

When you enter this view for the first time, you often don’t see many dependencies, 
in which case you need to zoom out to see more boxes and arrows. When you 
zoom out too far, the text becomes illegible. If you rest the mouse pointer on a 
task box, a screen tip pops up that allows you to read the task data. An example 
of such a screen tip is: 

To zoom back in, use Zoom In under the View tab or use the Zoom Slider.

Finding the Task 
Bars

Network Diagram
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By default, the Network Diagram displays the different types of tasks in boxes 
with distinct shapes:

hh Summary tasks in a parallelogram 

hh Detail tasks in a rectangle 

hh Milestones in a hexagon 

We’ll learn more about each of these in Chapter 3.

The critical tasks (discussed in Chapter 9) have a red border instead of the 
(default) blue.

The Network Diagram view is typically used to check the logic in the network. 
To follow the logic, just use the arrow keys on your keyboard to move the 
highlight from task to task. If the text is too small, keep your eyes on the entry 
bar which will show the name of the task.

As we’ll discuss in Chapter 5, you can easily add and delete dependencies in this 
view.

 

To apply the Task Usage view: On the View tab, in the Task Views group, click 
Task Usage; OR from the View Bar click Task Usage.

The Task Usage view shows the assignments in between the tasks. You can 
differentiate the assignments from tasks by the lack of ID numbers and the 
italicized text on the assignments.

The Task Usage and Resource Usage views are the only views that display the 
assignments as separate line items.

The timescale on the right of your screen shows how Project 2013 schedules 
the tasks and assignments. It shows the detailed numbers behind the task bars 

Task Usage
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of the Gantt Chart. This view helps in understanding the Gantt Chart and 
troubleshooting it, if needed.

If you zoom in or zoom out, Project 2013 immediately calculates the totals for 
the new time unit. This allows you to create interesting management reports by 
month, for example.

You can report on the spread of the effort or cost across the life of the project 
with this view: a time-phased budget by activity or deliverable. 

 
To apply the Tracking Gantt view: On the View tab, in the Task Views group, 
click the Gantt Chart down-arrow, Tracking Gantt; OR click Tracking Gantt 
on the View Bar.
You can use the Tracking Gantt view during project execution to track your 
progress against your original schedule (the baseline). In this view all task bars 
are split into two halves: a top half that represents the current schedule and a 
bottom half for the baseline. If you don’t have a baseline in your schedule, it only 
shows the thin top task bars for the current schedule. 

Tracking Gantt
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To apply the Resource Graph view: On the View tab, in the Resource 
Views group, click the Other Views down-arrow, Resource Graph; OR click 
Resource Graph on the View Bar.

The Resource Graph shows bar charts of the workload over time for one 
resource at a time. This view is also called a workload histogram. By pressing the 
Page down key or by using the bottom left horizontal scroll bar you can browse 
from resource to resource. If you don’t see any bars in the timescale pane, press 
Alt + Home key to jump to the project start date. If you still don’t see any, zoom 
out using the Zoom Slider or the Zoom options in the View tab.

Notice that the Resource Graph shows Peak Units by default. Showing Peak 
Units means that if you zoom out and go from days to weeks, the highest daily bar 
will be shown as the peak for the week. This helps you find any over-allocation. 
However, the more you zoom out, the more pessimistic the depiction of the 
workload becomes; if you are double-booked during only a one hour meeting 
task, the entire quarter will depict you as double-booked. You can change from 
displaying peak units by using the Graph pulldown, in the Data group on the 
Format tab. If you select Work from the Graph pulldown OR right-click in the 
chart area and choose Work from the pop-up menu, you will see the “real” totals 
of the work hours charted for the time period shown.

Resource Graph
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To apply the Resource Sheet view: On the View tab, in the Resource Views 
group, click Resource Sheet; OR click Resource Sheet on the View Bar.

The Resource Sheet is used to enter the resources needed in a project. Resources 
can be human resources, facilities, machines, materials or cost resources.

Important fields in the Resource Sheet are:

hh Name: Name of the resource.
hh Type:

h` Material: a material resource that is consumed on tasks
h` Work: equipment or human resources that work on tasks
h` Cost: cost items incurred in the performance of a task

hh Max Units: The maximum units represent the maximum availability of the 
resource to the project expressed as a percentage (default) or in decimals 
depending on the setting in the Schedule section of Project Options. 
For example, a full-time individual would either be “100%” available 
(percentage) or be shown as “1” (decimals).

Resource Sheet
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To apply the Resource Usage view: On the View tab, in the Resource Views 
group, click Resource Usage; OR click Resource Usage on the View Bar.

The Resource Usage view shows the amounts of work or cost over time. As in 
the Task Usage view, this view shows the assignments as separate line items. You 
can differentiate the assignments from resources by the lack of ID numbers and 
the italicized text on the assignments. 

This view allows you to analyze workloads and resolve any over-allocations.

To display the Timeline: On the View tab, in the Split View group, select the 
Timeline checkbox; OR click the Timeline icon on the View Bar.

The Timeline is a compact and concise view that can provide a high level 
summary of either the entire project or selected parts. You can easily copy the 
timeline to share in an e-mail or presentation.

Resource Usage

Timeline View
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Not all project tasks show in the Timeline view. You must explicitly add the 
task for it to appear in the view. To add a task to the Timeline, select the task 
in the Table area, then, on the Task tab, in the Properties group, click Add to 
Timeline. You can also add the task to the Timeline by selecting the option in 
the General tab of the Task Information dialog for the task, or by right-clicking 
on the task and selecting Add to Timeline from the dropdown list. (You can 
even drag and drop tasks from the table to build your timeline. To do this, click 
on the task ID, grab the task with your mouse, and then drag and drop the task 
to the timeline).

The Team Planner view is only available in Project 2013 Professional. It gives 
a graphical representation of each resource’s assignments along a timeline. It 
is one of the new viewing features to assist Project and Resource Managers in 
understanding where over-allocations might exist within the team.

To apply the Team Planner view: On the View tab, in the Resource View 
group, click Team Planner; OR click Team Planner in the View Bar; OR click 
Team Planner on the view shortcuts of the Status Bar (next to the zoom slider).

You can use the zoom commands in the View tab of the Ribbon or the Zoom 
Slider to adjust the timeframe shown on the right hand side of the screen.

You can also mouse over the specific assignments to get more information.

Team Planner
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The Resource Form is used to view resource and assignment information for 
a single resource at a time. It is similar to the Task Form view that existed in 
previous versions of Project and provides a quick and easy way to view and 
update information about a specific resource.

To access the Resource Form: On the View tab, in the Resource View group, 
click the Other Views down-arrow, Resource Form; OR click Resource Form 
on the View Bar.

You can use the Next and Previous buttons to scroll through for other resources.

Resource Form

J. Ross Publishing; All Rights Reserved



Chapter 2: Getting Started with Project 2013

85

2
You can select views by using the View Bar or view options on the Ribbon. The 
View Bar is usually visible along the left side of the screen. If the View Bar is not 
displayed, right-click on the thin blue bar at the left of your screen and select the 
View Bar (or the required view) from the pop-up menu.

The View Shortcuts in the Status Bar (next to the zoom slider) gives you one-
click access to the following views: Gantt Chart, Task Usage, Team Planner, 
Resource Sheet, and the most recent used Report.

You can also switch views using the commands in the Ribbon. On the View 
tab, there are groups representing Task Views and Resource Views. Each of the 
most commonly used views for each group is always accessible through a series 
of icons. If the view you want is not shown as a command icon, click on the 
down-arrow next to any view and select More Views. The More Views dialog 
will open showing all available views.

A single view is a one-view screen; most of the views shown on the previous 
pages are single views. A combination view is a screen with two views, one on 
the top and one on the bottom.

The bottom view only shows information pertaining to the tasks (or resources) 
selected in the top view. This interaction between top and bottom view can be 
very useful for data entry with a sheet view in the top and a form view in the 
bottom. Form views allow you to enter detail information.

The Task Entry view is a combination view with the Gantt Chart in the top and 
the Task Form in the bottom, as in the next screenshot: 

Navigating the 
Views
To Switch Views

Single View 
Versus 
Combination View
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The Task Entry view allows you to enter detailed information on tasks. You 
can enter resource assignments and predecessors. The task you select in the top 
Gantt Chart view is shown in detail in the bottom Task Form view. The top and 
bottom views interact; whatever you select in the top is shown in more detail on 
the bottom.

This makes combination views well suited for schedule analysis. For example, 
with a task view in the top and a resource view in the bottom (or vice versa), you 
can check assignments.

With a resource view in the top and a task view in the bottom you can check 
over-allocations. An example of this is shown below in the Resource Allocation 
view. To get to this view: On the View tab, in the Resource Views group, click 
the Other Views down-arrow, More Views. The More Views dialog will open. 
Click Resource Allocation, then Apply.

The Resource Allocation view has the Resource Usage in the top view and 
the Leveling Gantt view in the bottom. This combination view allows you 
to analyze and resolve over-allocations. The interaction between the top and 
bottom view is such that the assignments on the task selected in the top view are 
shown in detail in the bottom.

You can click the Timeline checkbox in View tab, Split View group to create 
a combination view that shows the Timeline in the top view of the screen. To 
change the top section of your new combination view, click on the Timeline 
down-arrow, More Views. The More Views dialog will open. Select the new 
view you want at the top then click Apply. 

To create a combination view by adding a new view to the lower section, on the 
View tab, in the Split View, click the Details down-arrow, More Views. Select 

To Create a 
Combination View
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the view you wish to have at the bottom of your combination view, then click 
Apply.

You can also create a combination view by pointing with the tip of the mouse 
pointer to the sliding window handle at the bottom right of your screen (the tiny 
little horizontal bar under the scroll down button). 

The mouse pointer will become a double-headed arrow. Drag it up or double-
click on it to display the bottom view. You now have two views on the screen, one 
in the top and one in the bottom.

You can change the size of each view by pointing to the divider line between the 
views. Hold down and drag when you see the changed mouse pointer. To move 
the cursor between the views, press F6 key or click in the other view.

You can drag both the horizontal border and the vertical dividers at the same 
time. Put your mouse pointer on the intersection between the two divider lines:

You should see a four-headed arrow mouse pointer. Drag both dividers to create 
the needed sizes for each respective view.

Drag the view divider line to the top or bottom (depending on which view you 
want to keep). 

OR

Double-click on the view divider line.

OR

On the View tab, Split View group, clear the Details or Timeline. 

To Switch Back to a 
Single View
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1. On the main window of Project 2013, in the upper right section, click on the 
Help icon (Question mark) or press F1 key. 

2. The Project Help window appears: 

3. In the Project Help window, enter keywords for your search. More words 
usually give more accurate results (and the shortest list to dig through). It is 
recommended entering between 2 and 7 keywords. Click on Search or hit 
the Enter key.

4. The search results will be displayed in the same window. Click one of the 
help topics listed; each of the help topics is a hyperlink. When clicked, the 
link will display information about the topic you searched for. If you did not 
find what you need, you can enter different keywords in the search text area 
or you can use the Back Arrow at the top left of the window to return to the 
list of search results. 

Using Help

Project Help Task 
Pane
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5. To close the help panes, click the Close button.

If you are not connected to the internet, you can´t have the search engine 
browse online content. The only help available without an online connection 
is the Basic Help; clicking on Project Help while no web access is available will 
direct you to this window: 
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Position your mouse pointer over a column heading and a screen tip giving a 
brief description of the field will pop up. If you do not see the pop ups, check the 
Screen Tip Style setting in the General section of the Project Options dialog.

The Planning Wizard can help you find your way around Project 2013. The 
Wizard searches for ambiguity, and if it finds it, provides you with choices to 
resolve the problem.

We recommend keeping the Planning Wizard turned on. If you start to get 
annoyed with a particular type of message, select Don’t tell me about this again 
at the bottom left of the dialog: 

There are three categories of Planning Wizard messages and each time you select 
Don’t tell me about this again, that message in the category will be turned off. 
When all the messages in a category have been turned off, the category will be 
turned off as well. To turn the messages back on: On the File tab, in the Backstage 
view, click on Options, Advanced. Select the Advice from Planning Wizard 
checkboxes.

Help on Fields

Help with 
Scheduling: 
Planning Wizard
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We recommend that you turn on all of the Planning Wizard options to assist 
you with scheduling. 

Whenever you see a small graphical tag appear to the left of where you have 
made changes to a schedule, you are given additional choices. These pop-ups 
are called Smart Tags. Smart Tags ask for clarification when you do something 
that may produce unintended side effects. Depending on the situation, different 
Smart Tag graphics appear:

hh You press the Delete key on a task name

hh You change the duration 

hh You change the work 

hh You change the units 

hh You add a resource to a task, or remove one 

hh You change the start or finish date

An example of the choices you get when you increase the duration and click the 
Smart Tag button is: 

Help When 
Making Changes: 
Smart Tags
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You can use the Task Inspector view to quickly get a look at the factors that are 
affecting a task. The Task Inspector will show you if there are constraints, Task 
Calendars, or special Resource Calendars applied to the selected task.

To launch the Task Inspector select the task you want to review, then on the 
Task tab in the Tasks group, click Inspect. The Task Inspector Pane will open 
to the left, next to the View Bar. 

For information on the specifications of your system, on the File tab, in the 
Backstage view, select the Account option and click About Project. The 
About Microsoft Project window will open. You’ll see which version or 
release of Microsoft Project 2013 you are using as well as copyright and license 
information. Other options here are:

hh Click System Info to get the technical specifications of your computer 
system.

hh Click Tech Support to get contact information on how to reach technical 
support people on the telephone.

Help with  
Tasks: Task 
Inspector

Technical 
Specifications and 
Support
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There will be some situations where certain processes need more information, 
analysis, functionality, or support. The new Apps for Office are third party mini 
programs that include powerful additional features for the entire Office family 
including Project 2013. 

To access the Apps for Office in Project 2013, go to Project tab, Apps group. 
You will need a valid Microsoft Account to login and buy or use your apps. 

When you are logged in to the Office Store service, you can access your 
acquired apps by going to Project tab, Apps group, clicking the Apps for Office 
downward button, and selecting the app you want to use. The app panel will 
open to the right of the main view.

Now that you are familiar with the Project 2013 interface you are ready to set up 
a new project. Setting up the project results in either a project that has no tasks 
or one that has tasks derived from a project template. Once the project is set up 
you are ready to enter and/or edit the tasks that make up the project.

The standard steps for setting up a new project schedule are:

hh Create new project schedule from the ground up OR base your project on 
a project template. Project 2013 lets you create new project schedules by 
importing Excel spreadsheets and SharePoint lists (this will be discussed in 
more detail in Chapter 3: Entering Tasks). 

hh Save the file.

hh Describe the project in the dialog boxes:
h` Project Information
h` Properties

Using the  
Apps for  
Office

Setting Up a 
New Project 
Schedule
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hh Set the options. Options to consider are:
h` Date format
h` Schedule Options
h` Advanced Options
h` Level Resources…
h` Undo levels

hh Set the Project Calendar (Change Working Time). Use the Exceptions or 
Work Week tabs to decide:
h` Normal working hours and working business days
h` Exceptions like holidays or non-working times
h` Any special alternate work weeks

Project 2013 provides you with many different options to create new project 
files.

These include:
hh Blank Project—you add all task, resource and project information
hh Featured—if you previously created a project from a local or online template
hh Personal—personal templates you created and saved
hh New from existing project—if your new project is similar to another one
hh New from Excel Workbook—you can import basic task information from 

Excel
hh New from SharePoint task list—if you want to now manage your SharePoint 

task list using Project 2013
hh Search for online templates—available for download if you are online 

To access these options and to create a new file, on the File tab, in the Backstage 
view, click New. The screen below is displayed. 

Creating a New 
Project Schedule
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You can also create new projects using templates posted online using the Search 
box and the Suggested searches classifications. This section provides you with 
search capability so you will be able find templates for the type of project you 
are looking for.

If you use an existing project file (with company information already in it) as 
the basis for a new project file, you should make sure you remove any residual 
information such as the Author, Manager, Company, and Last Saved by. To 
clear these fields check the checkbox Remove personal information from file 
properties on save. You can find this checkbox on the File tab, in the Backstage 
view. Click Options, Trust Center, Trust Center Settings, Privacy Options 
tab.

If you use an existing project file as the basis for a new project file, adjust the 
dates to reflect the new start date. To do this on the Project tab, in the Schedule 
group, click Move Project. The Move Project dialog will open. Enter the date 
required in New project start date.

One of the first things you should do is to set up basic parameters that define 
your specific project: 

1. On the Project tab, in the Properties group, click Project Information. 
The Project Information dialog appears: 

2. Enter the basic project information in this dialog. There are two choices in 
the list Schedule from:

Describing the 
Project
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h` Project Start Date (forward scheduling): Enter the Start Date and 
Project 2013 will schedule all tasks As Soon As Possible (ASAP) after 
the project start date. After you have entered all the data, Project 2013 
will show what the earliest finish date will be for the project.

h` Project Finish Date (backward scheduling): Enter the Finish Date 
and Project 2013 will schedule all tasks As Late As Possible (ALAP) 
working backward from the project finish date. After you have entered 
all the data, Project 2013 will show what the target start date of the 
project should be.

The choice you make depends on which you’re most certain of: the start 
date or the finish date for your project. Neither approach will prevent the 
common occurrence that the initial schedule is too long. You usually have 
to squeeze the project into a time box that is available for the project. This 
makes the choice between entering the start or the finish date less important, 
and most people leave it to the default: scheduling from the project start 
date forward. Click OK.

3. On the File tab, in the Backstage view, click on Info. 

4. On the right pane, click Project Information, Advanced Properties. The 
Properties dialog appears. 

5. Click the tab Summary and enter:
h` The name of the project in the field Title
h` Your name as the Author and/or Manager
h` The project objective or a description of the final project product in the 

Comments field. Try to come up with a single sentence that captures 
the essence of your project.

6. Click OK.
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We recommend that you enter as much information as possible concerning 
Title, Subject, Author, Manager, and Company in the Properties dialog. The 
entries you make can be used in the headers and footers of reports you create. 
They save time, particularly since when you change an entry, all of your reports 
will be updated automatically.

Project templates are useful as a jumpstart for your project plan. They store 
layouts, settings and information 
that you want to use for multiple 
projects. Each time you start a new 
project you start with a copy of the 
template, which you can adjust as 
needed for the specific project. 

Templates can be created centrally 
by your project office to promote 
consistent work breakdown structures, common project options, reports, 
shared Project Calendars and standard resource names. 

Templates are protected from accidental changes. When you open a template, 
Project 2013 copies it; you never open the template itself. When saving the 
template, you will always be asked for a (new) file name or schedule name. 
Template files have the extension .mpt.

1. On the File tab, in the Backstage view, click New. The options to create a 
new project will be displayed.

2. Click on PERSONAL. Templates you created and saved locally will 
appear, as well as those you previously downloaded from Office.com. If the 
PERSONAL templates option is not visible, you need to define the default 
location at File tab, Options, Save, Save templates, in Default personal 
templates location click Browse and select the location. 

Template
Project

Schedule

Open template copies the template

Creating a New 
Schedule from a 
Project Template

Using a Project 
Template
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3. Double-click on a template OR select a template; in the dialog, indicate 
the Start Date and click Create—a copy of the template opens with the 
project-specific options and project calendar set. There may also be tasks, 
dependencies, estimates, generic resources, and assignments, as well as 
custom views and reports.

4. If you want to use a template stored online, click on a suggested search or 
type the type of template you are searching for in the search text box and 
press enter. 

To Save a file in Project 2013 you have a number of different options: 

You can save the changes to an existing .mpp file while you are editing it by: 

1. On the File tab, in the Backstage view, click Save; OR on the Quick Access 
Toolbar, click Save.

2. If your file exists already, the file on your hard disk will be updated with the 
changes. 

Saving Changes 
in an Existing 
.mpp File
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If you save a schedule for the first time or if you opened the file read-only and 
then save it: 

1. In the Backstage you can either click Save or Save As. 

2. In the Save As Backstage view, click Computer and then Browse. 

3. In the Save As dialog, select the drive and directory, enter the new name in 
the File Name box and click Save. Each project file will be saved with the 
extension .mpp by default.

Saving in a 
New File in your 
Computer
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If you need to convert the file to an older version of Project or a different format, 
modify the selection of the Save as Type box which include older version of 
Project, Project template, PDF, XPS, Excel workbook, Tab delimited text, CSV, 
and XML.

Available only for the Project 2013 Professional editions, this enhanced feature 
of saving and synching with SharePoint allows you to share your schedule created 
in Project 2013 in a SharePoint Task List in a way that all team members can 
view the schedule and update their work from the SharePoint Task List while 
you see and manage the changes in Project 2013. In order to synchronize tasks, 
you can either create a new project site or synchronize to an existing project site 
that contains a task list. To create a new project site you can:

1. Go to File tab, in the Backstage view, click Save As, and then select Sync 
with SharePoint. 

2. In the Sync with list (to the right), select whether you want to create a New 
SharePoint Site or Use an Existing SharePoint Site.

3. Creating a New SharePoint Site, in the Project name box, type a name for 
the project site. 

4. In the Site Address box, add or select the address of the SharePoint parent 
site where the project site will be created.

5. Click Save. You may need to enter your credentials to the SharePoint site.

6. A new SharePoint Site with a Tasks List is created and tasks are synchronized. 

The project file is also saved to SharePoint in the Assets library for future 
editions.

Saving and 
Synching  
with  
SharePoint
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7. Access the new SharePoint Task List in the File tab, click Info. In the Save 
and Sync Your Project section, click the link to the SharePoint site.

Future updates

To update consecutive editions, once you save and sync for the first time in 
Project 2013 you will have ability to update the tasks editions just by clicking 
the Save button.

You can access the schedule for future editions by doing either of the following:

h` In SharePoint 2013, from the SharePoint task list, on the Ribbon, on the 
List Tools click List, and on the Connect & Export group click Open 
with Project button; Project 2013 will open and sync the updates.

h` In Project 2013, in the File tab, in the Backstage view, click Open. You 
will need to browse the Site Assets library in the SharePoint site for 
future editions of your project. 

More options and scenarios about syncing tasks with SharePoint 2013 are 
discussed in Chapter 3: Entering Tasks. 

This explanation considers SharePoint 2013 and Project 2013. If you synchronize 
between differentiated versions, you may find limitations or need additional 
steps.

You can save your files to the cloud and access them from anywhere, in this way 
you can work off line and the changes will sync when you reconnect.

1. On the File tab, in the Backstage view, click the Save As option, then select 
OneDrive. 

2. In the OneDrive section, select Sign in. 

Saving an  
.mpp File in 
OneDrive
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3. In the Add a Service window, type a valid Microsoft Account. (Xbox, 
Hotmail, Skype, or Outlook.com) and click Next.

4. In the Sign in window, type in the password and click Sign in.

5. The folders from your OneDrive account appear, select the folder where 
you want to store the file, and save it.

The way Project 2013 operates is controlled by the settings in Project Options. 
The steps to change the options are:

1. On the File tab, in the Backstage view, click Options. The Project Options 
dialog appears. 

Setting the 
Options
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2. Select the category of options you want to work with from the left pane. 

3. Set the options.

4. Click OK to accept the changes and close the dialog.

There are two types of options:
h` Global options that are in effect for all projects
h` Project-specific options that affect the active project only. You can 

recognize these because they start with a section divider showing the 
name of the project schedule. These options are stored in the project 
file (.mpp) or in the schedule (Project Server database).

The date order (ddmmyy or mmddyy) cannot be set inside Project 2013. You 
have to set it in the Windows Control Panel. If you do this, it will affect the date 
order in all of your Windows applications.

1. In Windows system, access the Control Panel. Access the category Clock, 
Language and Regional and then the Region and Language settings.

2. In the Region and Language dialog click the Formats tab and in the 
Short Date dropdown select the required date format; click OK. (NOTE: 
International date format is “d/M/yyyy”.)

3. All lists in Project 2013 that provide choices for date formats will now show 
items in the date order you chose in the Control Panel.

Setting the Date 
Order
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Set scheduling options as described below to match your organization standards 
before you enter any tasks.

This table indicates the most important options we recommend you review at 
this point. Typically, at the start of each chapter, we will discuss the options most 
relevant to that chapter.

Project 
Options

Recommended Choices

General Set the Options on the General tab: 
Show feature descriptions in Screen Tips: When you set the 
ScreenTip style to include feature descriptions you will get the most 
possible information about an object when you position the mouse 
over the object.

Date Format: To avoid confusion about dates in international 
projects, a date format should be chosen with the month spelled out, 
i.e., 31 Jan. ’16. Americans will interpret a date like 7-8-2016 as July 8, 
2016. Most of the rest of the world will interpret it as August 7, 2016.

User Name: Enter your name. (If you are connected to Project Server, 
it will be filled in already.)

Show the Start screen when this application starts: Selected 
by default, when you start Project 2013, a blended screen showing 
Recent files and Start a new project options are shown. Unselect if 
you prefer to start a blank project by default.

Display Set the Options on the Display tab:
Currency: Use the dropdown to select the currency you want to 
use for your project costs. Project 2013 will fill in the appropriate 
Symbol for the selected currency.

Schedule Set the Options on the Schedule tab:
Hours per day: 8. Project 2013 uses this number to convert days 
that are entered in the Duration and Work fields into hours. This 
number should represent the hours worked by a full-time equivalent 
employee.

Hours per week: 40. Project 2013 uses this number to convert 
weeks into hours. If this number does not reflect your situation, the 
schedule will not be accurate. It should correspond to the Hours per 
Day setting.

Days per month: 20. Project 2013 uses this number to convert 
months into days. This number should reflect your situation.

Show scheduling messages: will give helpful messages when it 
notices a problem in the schedule.

Options for a  
New Project
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Project 
Options

Recommended Choices

Tasks will always honor their constraint dates: We recommend 
you keep this option on to make sure your schedule observes the few 
real and hard constraint dates that you may have in it. (We’ll cover 
this briefly.)

Calculate project after each edit: will ensure that you see the effect 
of changes immediately. We recommend that you leave this setting 
On unless schedule performance becomes a concern.

Advanced Set the Options on the Advanced tab:
Prompt for the project info for new projects: Enable this option 
to facilitate the creation of new projects.

Advice from Planning Wizard. This is most useful for novice users. 
You may want to clear the check box once you are more experienced 
with Project 2013.

Do not use a fiscal calendar if your schedule will be shared with anyone outside 
of your organization as it can create confusion when reading the Gantt Chart.

You have to decide on the Calendar option Hours per Day before entering any 
tasks into the schedule and it can’t be changed without re-entering all durations. 
You have to specify how many work hours a workday has. Project 2013 uses 
this setting to convert between time units (the time unit conversion factor). For 
example, if the Hours per Day is set to 8 hours and you enter a duration of 5 
days, Project 2013 knows this equals 40 hours (8 * 5). If you then change the 
Hours per Day setting to 7 hours per day, Project 2013 changes the duration to 
5.71 days (= 5 * 8 / 7). You must consider this option before entering any tasks. 
If you start with the wrong number, Project 2013 will interpret the durations 
you enter incorrectly which may result in a schedule that is too optimistic or 
pessimistic.

There is one way to keep the current durations without having to re-enter all 
durations again when you change the Hours per Day setting. Before changing 
the Hours per Day, copy all durations to one of the extra fields (Text1 for 
example), change the Hours per Day, and then copy the durations from the 
Text1 field back into the Duration field. Make sure you have the task field Type 
set to Fixed Units for all tasks. 
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In Project 2013, you select a base calendar from which to develop your Project 
Calendar. The base calendar is based upon your organization-wide working 
hours, working days, and non-working days. The three base calendars that come 
with Project 2013 are Standard, Night Shift, and 24 Hours. 

The Change Working Time 
dialog, which can be found on 
the Project tab of the Ribbon, 
allows you to modify the 
Project Calendar to model the 
work week. 

The default Project Calendar 
is called Standard. Working 
time for the Standard calendar 
is set to Monday through Friday, 8:00 A.M. until 5:00 P.M., with one hour off 
for lunch between 12:00 P.M. and 1:00 P.M. each working day. You can change 
these defaults to correspond to your organization’s working times.

On the Project Calendar you indicate:

hh Business days and standard working hours
Which days are working days and what are the working hours in a regular 
work week?

hh Calendar exceptions (national and corporate holidays)
What days are nonworking days (weekends, holidays, etc.) throughout the 
year?

hh Alternate work weeks
Do some weeks require a special schedule to get a specific phase completed 
in time?

Set the Project Calendar with standard business days, working hours, calendar 
exceptions, and any alternate work weeks before entering task information. 

In addition to the Project Calendar there are:

hh Task calendars
These can be used to schedule individual tasks. For example, outdoor 
construction tasks can only take place when the weather permits, and a 
Task Calendar could be created for all tasks affected by winter weather. Task 
calendars are covered in Chapter 6.

hh Resource calendars
These can be used as calendars for individual people or groups of people. A 
Resource Calendar for an individual typically contains individual working 

Setting 
the Project 
Calendar

Task and Resource Calendars

Project Calendar
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days and vacations; sometimes the working hours are individualized as well. 
These are covered in Chapter 7.

We recommend that where possible you create a new Resource Calendar for 
large groups of resources, not individual resources. For example, if you had 
international resources or 2nd shift resources working on a project, you would 
create a Resource Calendar for the group instead of creating a new calendar for 
each international resource or each resource on the 2nd shift.

The business days, working hours, calendar exceptions like national and 
corporate holidays, and any specific alternate work weeks of the Project Calendar 
will be transferred to all Resource Calendars.

Project 2013 allows you to provide the name for each holiday or exception 
day and gives you the option to make an exception recurring. The recurring 
feature works like a recurring appointment in Outlook and allows you to set the 
recurrence on a specific day or in a specific pattern. 

For example, a holiday could occur on the fourth day of each month or could 
occur on the first Monday of every month. This feature can save you considerable 
time because you do not have to scroll month-to-month and year-to-year to add 
all of the exception days.
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Notice the tabs below on the Change Working Time dialog window:

hh Exceptions: Regularly scheduled working day on which work will not 
occur, which includes exceptions to the normal working time. An example 
would be company holidays. 

hh Work Weeks: Includes alternate work weeks specified for a certain period 
of time. An example would be an accelerated work week for a construction 
company to get the job done before a major snow storm arrives.

The changes you make on the Project Calendar apply to every task and every 
resource in the project (unless you have overwritten those settings in the Task 
or Resource Calendars). At this point, we will only edit the Project Calendar; 
later we will create Task calendars and Resource Calendars, which override the 
Project Calendar.

In summary, the Project Calendar has two functions:
hh It is a timesaving device to change all Task and Resource Calendars.
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hh It is used to schedule tasks that don’t have a Task Calendar or resources 
assigned.

The following is very confusing to many people. If you change the number of 
hours per day in the Project Options (via Backstage), Project 2013 does not 
automatically update the working times in the Project Calendar. Project 2013 
uses the hours per day option for conversion purposes only. When you enter a 
duration of 1w, it will convert it to hours. If the setting in the Project Options is 
40h/w, then it knows that 1w = 40h.

In the Project Calendar, you can indicate the regular working hours for a full-
time resource. Project 2013 uses these settings to schedule the 40 hours of effort 

within the working hours. 40 
hours of effort for a full-time 
resource will take 5 business days 
(Monday–Friday). 40 hours of 
effort for a compressed workweek 
resource who works 10 hours a 
day will only need 4 business 
days (see the illustration). The 
conclusion is that the Hours per 
Day setting in the Project 

Options dialog needs to be aligned manually with the working hours in the 
Project Calendar.

Make sure the hours per day and per week in the Standard calendar match the 
calendar options settings in the Project Options.

1. On the Project tab, in the Properties group, click Change Working Time. 
The Change Working Time dialog box opens. 

Hours per  
Day Option 
versus Working 
Time

 Full-Time 
Resource
M T W T F M T W T F

0:00 0:00

7:00
8:00

17:00
18:00

24:00 24:00

10h/day8h/day

Compressed 
Workweek 
Resource

Enter Business 
Days with 
Standard Working 
Days & Hours
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2. From the: For Calendar: dropdown at the top of the dialog, select Standard 
(Project Calendar). 

3. To specify the normal business work week for working days and working 
hours in the Standard Project base calendar, select the Work Weeks tab 
near the middle of the Change Working Time dialog box. If you have a 
Monday to Friday work week, you can select the workdays of the week by 
selecting the Default row on the Work Weeks tab and then clicking on the 
Details button to open the Details for the Default dialog box. 

 

Notice that when you select any Monday through Friday, the default is set 
for all weekdays as working days with working hours of 8:00 AM-12:00 
PM and 1:00 PM-5:00 PM.
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It is here, in the Details dialog box, that you can change these normal default 
working times.

4. You have three choices in the Set working time for this work week buttons 
above the From/To table: 
h` Use Project default times for these days
h` Set days to nonworking time
h` Set day(s) to these specific working times

5. Select the specific days that you want to change in the table. (Select 
consecutive days by left clicking the mouse and dragging downward, or 
select nonadjacent days by holding down the Control key and selecting the 
other days needed.)

6. To set these days as nonworking time, select Set days to nonworking 
time. To change the working times of a working day (or days) or to change 
a nonworking day to a working day, select Set day(s) to these specific 
working times. 

7. In the From/To table, enter the start and finish working times. (Click into 
the next lower blank cell when completed to make sure your start and finish 
times are entered.)

8. Click OK at the bottom of the Details dialog box and then click OK in the 
Change Working Time dialog box. 

9. Make sure you also click Options to adjust the time unit conversion factors.

Sometimes you need to set up an alternate work week to reflect changed work 
schedules for the week(s). (For example, your team might be working on an 
accelerated testing schedule before a server installation.) In this situation, you 
could set up an alternate work week to reflect the accelerated work week. 

1. On the Project tab, in the Properties group, click Change Working Time. 
The Change Working Time dialog box opens.

2. From the For Calendar dropdown, select Standard (Project Calendar).

3. If you did not set the hours per day in Project Options, do this first by 
clicking Options to adjust the time unit conversion factors. Upon clicking 
OK you will be returned to this dialog.

4. Click the Work Weeks tab near the middle of the Change Working Time 
dialog box.

5. In the Work Weeks tab, click the blank row under the Default row. In the 
Name column for the new Work Week, type in the name for the alternate 
work week. For example, Server Set-up/Test Week.

Enter Alternate 
Work Weeks with 
Specific Working 
Hours
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6. Click in the Start field and enter the date when the alternate working times 
should start.

7. On the same row, click in the Finish field and enter the date that when the 
alternate working times should end.

8. With the same new row selected, click the Details button.

9. In the Select Day(s) box, click the days of the week you want to change. 
Select consecutive days by clicking the mouse and dragging downward, or 
select nonadjacent days by holding down the Control key and selecting 
each day you need. To set these days as nonworking time, select Set days to 
nonworking time. 

10. To change the working times of the specified alternate work week, select 
the day(s) in the Select day(s) table and select Set day(s) to these specific 
working times. Next, in the From/To table, enter the start and finish 
working times. (Hint: Click into the next lower blank cell when completed 
to make sure your start and finish times are accepted.) 

11. Click OK at the bottom of the Details dialog box and then click OK in the 
Change Working Time dialog box.

Sometimes you need to record exceptions such as holidays on the Project 
Calendar. These can be either one-time only (e.g., a corporate picnic) or recurring 
(e.g., New Year’s Day). In Project 2013, you can set up these exceptions.

1. On the Project tab, in the Properties group, click Change Working Time. 
The Change Working Time dialog box opens.

2. From the For Calendar: dropdown, select Standard (Project Calendar).

3. If you did not set the hours per day in Project Options, do this first by 
clicking Options to adjust the time unit conversion factors. Upon clicking 
OK you will be returned to this dialog.

4. On the Change Working Time dialog box, click the day in the calendar 
whose working times you want to change. The working times for that day 
will be displayed.

5. Next, select the Exceptions tab and select the next available blank row in 
the Name column. Enter the name of the calendar exception and press the 
Tab key. The start and finish dates are entered, defaulting to the date that 
you clicked in the calendar. You can change this date now, if needed. Notice 
that to the right of the calendar it says that the date is nonworking.

6. Click on Details to open the detail dialog box. Notice that the default 
changes to a non-working day for the date that you selected. 

One-Time 
& Recurring 
Calendar 
Exceptions 
Entering One-
Time Calendar 
Exceptions 
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7. If the exception is a change other than to a non-working day, you can 
change this in the Details dialog box. If you want to change working time 
to something other than the default, you can select Non-default Working 
Time, then change the times in the From/To boxes as needed. 

8. Click OK at the bottom of the Details dialog box and then click OK in the 
Change Working Time dialog box.

1. On the Project tab, in the Properties group, click Change Working Time. 
The Change Working Time dialog box opens.

2. From the For Calendar: dropdown, select Standard (Project Calendar).

3. If you did not set the hours per day in Project Options, do this first by 
clicking Options to adjust the time unit conversion factors. Upon clicking 
OK you will be returned to this dialog.

4. On the Change Working Time dialog box, click the day in the calendar 
whose working times you want to change. The working times for that day 
will be displayed.

5. Next, select the Exceptions tab and select the next available blank row in 
the Name column. Enter the name of the calendar exception and press the 
Tab key. The start and finish dates are entered, defaulting to the date that 
you clicked in the calendar. You can change this date now, if needed. Notice 
that to the right of the calendar it says that the date is nonworking.

6. Click on Details to open the detail dialog box. Notice that the default 
changes to a non-working day for the date that you selected. 

7. If the exception is a change other than to a non-working day, you can 
change this in the Details dialog box. If you want to change working time 
to something other than the default, you can select Non-default Working 
Time, then change the times in the From/To boxes as needed. 

8. Under the Recurrence Pattern selection heading, select if the calendar 
exception will take place daily, weekly, monthly, or yearly. To the right of 
that selection, enter the frequency or interval for which the exception will 
take place. 

9. Under the Range of Recurrence select the Start date for the recurrence. 
Then either:
h` Select End after and enter the number of times the recurring exception 

is to take place

OR

h` Select End by and specify the date when the recurring exception will 
end.

Entering “Recurring” 
Calendar 
Exceptions 
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10. Click OK at the bottom of the Details dialog box and then click OK in the 
Change Working Time dialog box.

Create recurring corporate holidays on the Project Calendar and set the dates 
into the future by a couple of years. This will help in not having to remember to 
add corporate holidays every year into your Project Calendar. 

Calendar working days and working times set in the standard Project Calendar 
are carried over to the Resource Calendars and the Task Calendars. However, 
if the Project Calendar is changed after Resource Calendars are created, the 
changes will show up automatically in Resource Calendars, but not in Task 
Calendars.

Nonworking days including national and company holiday, which apply to 
almost everyone, should be marked in the Project Calendar. Use Resource 
Calendars to override the Project Calendar and set nonworking days to working 
days for any resources that are exceptions.

The calendar information is saved in the Project Schedule. To distribute a Project 
Calendar to your colleagues, you have to transfer them via the Organizer.

Here are some checks to verify that you used best practices when setting up your 
project:

hh Does the Comments field in the Project Properties (File, Info, Project 
Information, Advanced Properties) contain a succinct description of the 
objective or final product of the project?

The description is visible as a Note on the project summary task. You need 
to have some background information on the project to properly evaluate 
the schedule.

hh Do the working hours as specified in the Project Calendar through Change 
Working Time, correspond to the Hours per day conversion values set in 
the Project Options (File, Options, Schedule)?

For example, working times of 8:00 AM-12:00 PM and 1:00 PM-5:00 PM 
are consistent with 8 hours per day and 40 hours per week. If the settings 
are inconsistent, your forecasts are either too optimistic or too pessimistic. 
Also, you might see decimals in the task durations.

The quickest way to check consistency is by launching the Change Working 
Time window from the Project tab of the Ribbon. The button Options will 
take you directly to the Project Options.

When you first create your project, set all of the project options to match your 
organization’s standards and your personal selections before entering tasks. 

Checks on 
Setting Up a 
Project
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On the Backstage view click the File tab, then click Options to review all the 
settings.
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1. Why should anyone use Project 2013 instead of Microsoft Excel?

2. What is the function of the Global.mpt file?

3. In which situations would you recommend the use of project templates?

4. Which view would you use for:

Task Recommended View
Entering tasks?

Entering resources?

Entering assignments?

Checking the network logic?

Viewing workloads?

Recording to-do lists?

5. Why would you use a split view (combination view) in Project 2013?

6. What steps do you recommend as a process for creating a new project 
schedule?

7. How do the Hours per day setting in the Project Options and the working 
hours in Change Working Time of the Standard (Project) Calendar relate 
to each other?

8. How can you change the default calendar, i.e., how can you edit the Standard 
Project Calendar in Global.mpt file?

9. What functions are on the Backstage view? What functions are on the 
Ribbon? What functions are on the Quick Access Toolbar? Can you 
customize the Ribbon and the Quick Access Toolbar?

For experience working with the features you’ve learned about in this chapter, 
we strongly suggest that you do the additional exercises for this chapter that 
are included in the Case Studies appendix, available to download in the WAV 
Download resource center at www.jrosspub.com.

Review 
Questions

Additional Practice
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Chapter 3: Entering Tasks

We’ve finished the Setup process and are ready to begin the Planning Processes. 
In this chapter we’ll focus on the first process: defining tasks and entering them 
in Project 2013.

After reading this chapter you will be able to:

hh Define what a work breakdown structure (WBS) is
hh Discuss the benefits of a WBS and its importance as the foundation of the 

project schedule
hh Establish an appropriate level of detail for your WBS
hh Write effective summary tasks, detail tasks, and milestones
hh In Project 2013 you will be able to: 

h` Create and change an indented WBS
h` Create summary tasks, detail tasks, and milestone tasks
h` Create tasks using the user-controlled scheduling feature
h` Edit, copy, and move tasks
h` Check the WBS of the project schedule using scheduling best practices
h` Import tasks to the WBS from Microsoft Excel and Microsoft Outlook
h` Import and Export tasks to/from SharePoint 2013
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The planning processes are performed in an iterative cycle: you revisit them 
repeatedly throughout the project in order to refine and optimize your schedule. 
The key processes are:

hh Define and enter the tasks needed to complete the project

hh Identify the Task Mode — manual or auto-scheduled — for each task or 
for the whole project 

hh Estimate the time needed to complete each task

hh Identify dependencies between tasks

hh Identify task constraints

hh Identify the resources needed to get the tasks done

hh Make staff assignments to get the work done

hh Refine as you go to optimize the schedule and manage client expectations

User-controlled Scheduling means that you can either schedule your tasks 
manually, controlling the start and finish dates, or automatically. With automatic 
scheduling, as in prior versions of Project, you’ll have the powerful scheduling 
engine schedule start and finish dates for you for all tasks. We will talk more 
about this later.

We’ll start with the process of defining tasks and entering them in Project 2013.

The Planning 
Processes
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Before you enter tasks in Project 2013, you need to decide what your project 
tasks are. The starting point for this is to develop a WBS.

We strongly suggest that you start by creating a WBS and use that as the basis for 
creating your schedule.

According to PMI, a WBS is “a hierarchical decomposition of the total scope of 
work to be carried out by the project team to accomplish the project objectives 
and create the required deliverables.”1

Whew! Let’s look at a couple of the key phrases of this definition.

A deliverable is “any unique and verifiable product, result, or capability to perform 
a service that must be produced to complete a process, phase, or project.”2

Deliverables are the products the project is going to produce: both final 
deliverables that you hand off to your client, (e.g., a completed computer 
program, building, or relocation) and interim deliverables that your stakeholders 
use during the project (e.g., a weekly status report). 

The WBS should cover 100% of your project’s scope and capture all of your key 
deliverables.

It is a generally accepted project management practice that work not in the WBS 
is outside the scope of the project.

You need to establish this understanding early with your project stakeholders: if 
the client requests a deliverable during project execution that is not in the WBS, 
it is out of scope and must be negotiated under the project’s change control 
procedures as an addition to the project.

The work described in the WBS is also the basis for estimating, scheduling, 
and assigning responsibilities on the project. It is the means for tying project 
objectives and requirements to the work necessary to deliver them.

When we say that a WBS is a hierarchical decomposition, it simply means 
that your WBS should break down (decompose) your primary deliverables 
into smaller, more manageable parts, and that this decomposition should be 
organized in a logical (hierarchical) way.

1 ——— PMBOK® Guide – Fifth Edition, PMI, 2013, p. 567.
2 Ibid, p. 537.

The Work 
Breakdown 
Structure

A WBS is 
Deliverable-
Oriented

A WBS is a 
“Hierarchical 
Decomposition”
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Shown below is a portion of a simplified WBS:

Software Implementation
1. Project Management
2. Software

2.1 Software Requirements
2.2 Initial Software Design
2.3 Final Software Design
2.4 Software Development
2.5  Software Delivery

3. Hardware
3.1 Hardware Requirements
3.2 Initial Hardware Design
3.3 Final Hardware Design
3.4  Hardware Acquisition
3.5 Hardware Installation

4. User Documentation
4.1 Documentation Requirements
4.2 Documentation
4.3 Approved User Documentation

5. Training 
5.1 Training Requirements
5.2 Training Materials
5.3 Approved Training Materials

6. Testing
6.1 Test Plan
6.2 Test Cases
6.3 System Test
6.4 User Acceptance Test

7. Go Live

As you can see, the sample WBS:

hh Contains the project deliverables (e.g., “2.1 Software Requirements”, “2.2 
Initial Software Design” and “2.3 Final Software Design” are all deliverables)

hh Has deliverables decomposed into smaller parts

hh Is organized in a logical manner to identify the work required to produce 
the deliverables

There are many ways to organize your WBS, e.g., by key deliverables, physical 
components, chronological phases in the project life-cycle, functional specialties, 
or in a program by project and sub-project.

Organizing Your 
WBS
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In our sample WBS above, we organized the WBS by deliverable. Here’s the 
same WBS, organized by phases—requirements phase, design phase, etc.

Software Implementation
1. Project Management
2. Requirements

2.1 Software Requirements
2.2 Hardware Requirements
2.3 Documentation Requirements
2.4 Training Requirements

3. Design
3.1 Initial Software Design
3.2 Final Software Design
3.3 Initial Hardware Design
3.4 Final Hardware Design

4. Construction
4.1 Software Development
4.2 Hardware Installation
4.3 Documentation
4.4 Training Materials

5. Testing
5.1 Test Plan
5.2 Test Cases
5.3 System Test
5.4 Approved User Documentation
5.5 Approved Training Materials
5.6 User Acceptance Test

6. Go Live

Notice that both examples contain the same deliverables.

Regardless of how you organize your WBS, it should be deliverable-oriented, i.e., 
it should explicitly state all of the key deliverables for your project. 

According to PMI, a WBS with only phases and activities and no deliverables 
is not a WBS! Every phase, activity, or task must have one or more deliverables. 

Including deliverables in your WBS makes sense:

hh The WBS should be an elaboration of the deliverables promised in the 
project’s scope statement. A deliverable-oriented WBS makes it easier to 
track work back to the scope statement.

hh Because many of your deliverables are the key products you’ll be delivering 
to your client, your client will find it easier to understand a deliverable-
oriented WBS.
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hh Deliverables are often tangible and easily understood when making team 
assignments. Imagine that you were made responsible for either “researching 
requirements” (an activity) or for delivering the “list of requirements” (a 
deliverable) for a project. The latter is a concrete deliverable; it is verifiable 
and therefore creates a firmer commitment.

hh A deliverable-oriented grouping enables you to get useful reports from 
Project 2013, like an effort or cost by deliverable report. 

hh Once you identify and describe deliverables, it is easier to identify, estimate, 
and schedule the activities needed to create those deliverables.

Our definition of a deliverable includes the phrase: a deliverable is “any unique 
and verifiable product, result, or capability.”3 By describing each deliverable 
identified in the WBS, you create verifiability in the project: you clarify what 
you are going to produce each step of the way. When you ask your client to sign 
off on the WBS and the definition of deliverables, you have established how 
task and project completions will be verified. This practice of identifying and 
describing deliverables early in the project will decrease misunderstandings that 
can become fatal if not surfaced until near the end (when they typically result in 
nasty disputes or litigation).

You may not be used to thinking in terms of deliverables and it can take practice 
to learn to identify them. However, it’s important to put some effort into this. 
After all, if you can’t define the deliverables, how will you and your stakeholders 
ever agree upon what needs to be done? It’s a common view that if you can’t 
identify the deliverables for a project, you don’t have a project.

Often the WBS is organized by phases—distinct periods in the life of a project 
such as requirements, analysis, and development. If you organize by phase, 
it’s important to identify the deliverables for each phase. For example, the 
requirements phase may produce a requirements definition, analysis phase 
designs, and development phase software modules. These interim deliverables 
are necessary in many projects to enable a controlled process with checkpoints 
between phases.

While phases can establish a chronology for the project, it’s important to note 
that the focus during WBS development should be on identifying, defining, and 
decomposing deliverables; not on sequencing and scheduling. This comes later.

Chronological breakdowns in your WBS can make it harder to manage iterative 
(repeating) processes.

Iterative processes are common in projects, often as a result of the progressive 
elaboration of project requirements and designs as the product is developed. For 

3 Ibid.

Phases in the 
WBS
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example, you might create a requirements document during the requirements 
phase, refine it in the analysis phase, and finalize it in the development phase. 
If your WBS is organized by chronological phases, work on your requirements 
document will be scattered across all three phases, making it more difficult to 
track progress on the deliverable—a finalized requirements document. In a 
deliverable-oriented WBS the work on the requirements document will all be 
listed in a single section and you can add activities with ease.

The bottom line: there are times when organizing your WBS by phase makes 
perfect sense. We recommend that in large projects you consider using a 
combination of phases and deliverables in your WBS. Just make sure that if you 
do use phases in your WBS, you’ve also captured all your deliverables.

You can build your WBS either as an indented list or in a format similar to an 
organization chart, with the summary tasks—generally the largest or most 
important deliverables—toward the top and the detail tasks underneath. 

The next illustration shows a WBS for an aircraft manufacturer in chart format.

Aircraft

Airframe Propulsion Nav/Comm Test Support

Nose Barrel

Flight Controls

Landing Gear

Cockpit

Center Sect.

Aft Section
Tail

Nose Gear

Main Gear

Inner Wings

Outer Wings

Procurement

Test

Fuel tanks
Fuel Lines

Fire Control

Processors

Displays

GPS Recvr.
Radar

Voice/Comm.

Transponder

Structural
Integration

Spares

Equipment

Manuals

Simulators

Maintenance

Fuselage

Wings

Engines

Fuel System

Radios

Flight Test
Navigation Sys.

Wind Tunnel

Ground Test

Logistics

Training

Project Mngt

Indented List 
or Organization 
Chart Format?
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      If you create your WBS as a chart 
(rather than an indented list), 
you’ll need to convert it to an 
indented list in order to enter it 
into Project 2013. You do this by 
simply rotating your chart 90 
degrees and then indenting the 
lower levels.

Many people find the graphic format easy to read and understand because it 
enables them to see relationships among the elements more clearly. While 
Project 2013 doesn’t support this view, add-on tools are available which do.

Using the Project 2013 Visual Report feature, it is possible to export the WBS 
to Microsoft Visio 2013. (See Chapter 11 to learn more about Visual Reports.)

Your WBS is not a static document. As you proceed through your project, you’ll 
gain information and experience which will help you improve the quality and 
specificity of your WBS; you should flesh out your WBS accordingly. 

An ideal starting point for creating your 
WBS is the scope statement, which 
should list the key deliverables for the 
project. Analyze the scope statement 
carefully to make sure you understand 
both the stated and any implied 
deliverables. Then use these to form the 
basis for building your WBS.

It can also be useful to base your WBS on 
the WBS from another, similar project, 
or on a template. Many organizations 
have developed internal standards 
and templates to help promote WBS 
consistency and quality.

Two common methods for developing the WBS are:

hh Top-down: You list the deliverables first and then identify all the tasks 
needed to accomplish the deliverables.

hh Bottom-up: You brainstorm about all of the tasks and then group them 
under their deliverables. Each deliverable becomes a summary task.

While the two approaches can lead to the same result, experienced project 
managers usually find it more efficient and effective to take the top-down 

90º

WBS - Chart WBS - List

How to Create 
your WBS

Bottom-Up Approach

Top-Down Approach
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approach. The top-down approach also lends itself well to the use of models and 
templates to assist less experienced project managers in developing a WBS.

We suggest that you have your project team help construct the WBS. For 
example, you can assign the breakdown of an activity or deliverable at any level 
of the WBS to the responsible person for decomposition.

Your team members are the people who will be doing the work and they usually 
bring a different perspective that is valuable to capture. Having the team help 
develop the WBS also promotes team members’ understanding of and buy-in 
to the project.

Deliverables should create both measurability and verifiability in the project 
plan. 

We find that most plans can be greatly improved in this respect. Describing 
deliverables as specifically as possible is a critical factor in aligning the 
expectations of your project stakeholders.

You should define each deliverable in terms of its form, content, behavioral 
characteristics, and level of quality. This includes using a name that as much as 
possible captures the meaning of the deliverable.

The following are examples of deliverables that we came across in real life 
schedules and our suggestions for tighter naming. In our view, the renamed, 
right-hand column deliverables would be easier to verify on completion:

Ambiguously named 
deliverable

Verifiable, measurable  
deliverable

Closing Customer approval of the project product

Subcontracting Signed contract

Moving to new location Operational, new location

Higher revenue 30% increase in revenue marketing

Renovation Renovated facility

Planning Project plan

Material procurement Procured construction materials

Prototype development Developed prototype

Training 300 trained application users

Staff 50 newly hired staff members

Implementation New workstations operational for entire team

Naming and 
Describing 
Deliverables
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We recommend that when naming tasks and milestones you use nouns or 
gerunds.4 Whenever possible use a term that names the deliverable to be 
produced.

Milestones should make clear exactly what event is to have occurred at the 
milestone.

An important advantage of using nouns in task and milestone names is that they 
focus you on the deliverables of the project, rather than on the process. You may 
find it helpful to add adjectives if they clarify or improve the measurability of 
deliverables, for example, “draft report” or “final report.”

More important than the exact naming conventions you use are that:
hh Every task at every level must have one or more Deliverables

hh You are consistent in your naming conventions

hh Your WBS and Project 2013 task list read coherently so they can be 
understood as a story of how the project will unfold. 

You will probably use your WBS as a primary communication tool for your 
project. The clearer and more consistent it is, the simpler it will be for your 
stakeholders to understand and participate in your project.

If you find yourself explaining your WBS all the time, it is not (yet) a good 
communication piece. Ideally, a WBS should be self-explanatory. If needed, 
provide a legend of abbreviations with it. The WBS should enable readers to see 
the big picture and then drill down to the details without losing track of the big 
picture.

The WBS dictionary is “a document that provides detailed deliverable, activity, 
and scheduling information about each component in the work breakdown 
structure.”5 

While in small simple projects this may be overkill, the more complex the 
project the more necessary it is to have a complete description of the work to 
be done and the deliverables. In Project 2013, the task description for each task 
represents the WBS dictionary entry for the task.

4 In English, gerunds are verbs that are used as nouns. For example, in the phrase “We’re training the staff ” 
the word “training” is used as a verb. In the phrase “We’re going to conduct training” the word “training” 
is used as a gerund.

5 ——— PMBOK® Guide – Fifth Edition, PMI, 2013, p. 567.

The WBS 
Dictionary

J. Ross Publishing; All Rights Reserved



Chapter 3: Entering Tasks

127

3

One of the biggest challenges in creating a WBS is decomposing it to an 
appropriate level of detail. The WBS should have neither too little detail nor too 
much! A logical structure with an appropriate level of detail is key to tracking 
work throughout the project.

On average, you’ll want each summary task to have detail tasks that describe 
the entire scope of the summary task. This helps to make the meaning of the 
summary task more easily understood by readers and makes the task manager’s 
job easier. The specific number of detail tasks that fall under each summary task 
should be appropriate to effectively manage the project and it’s deliverables.6

In the illustration, we’ve indicated the right level of detail for this project with 
the bold lines of the chart. Notice that they are not consistently on one level in 
the WBS. If it makes sense to break down one deliverable into more levels than 

another, you should do this. 
Adding levels generally improves 
the accuracy of the estimates; 
however with too much detail, 
you’ll create a schedule that’s a real 
chore to update during project 
execution. Validating that you’ve 
found the right level of detail in 

your WBS and project schedule will help you keep your schedule alive during 
project execution. Use the following guidelines to validate your WBS.

If your answer to any of the following questions is “no” you may need to add 
detail to your WBS:

hh Is it clear how the deliverable will be created and what the activities involved 
are?

hh Do these activities correspond to meeting the acceptance criteria for the 
deliverable? 

hh Can I estimate the duration, effort, and cost of the detail tasks?
hh Can I find the dependencies between the tasks?

Dependencies are links between tasks that capture how they affect each 
other. (For example, you have to obtain equipment before you can install it; 
the second task is dependent on completion of the first.) Dependencies will 
be discussed in Chapter 5.

hh Can I assign the detail task to somebody?
If you can’t assign each detail task to an individual, you may have too little 
detail in the WBS. If you cannot assign the deliverables in large projects to 

6 This concept is adapted from The Practice Standard for Work Breakdown Structures – Second Edition, PMI, 
2006.

The Right Level 
of Detail

Too Little Detail?

Too Much Detail?

Too Little Detail?
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organizational departments, you may need to add components to those 
deliverables or perhaps even to the detail tasks.

We will discuss estimating, dependencies, and assignments in later chapters.

If your answer to any of the following questions is “no,” you may have too many 
tasks:

hh Is this task necessary in the WBS?
If it’s not, get rid of it. Otherwise you’ll have to spend time updating it 
during the project. 

hh Is this task merely a reminder to yourself?
A WBS is not meant to be a personal reminder system. A WBS is supposed 
to capture tasks with significant effort involved. You can enter reminders 
in the Notes field using the task Notes on the Task tab. In the Properties 
group, click Notes.

hh Is this task a to-do list item or a real task that will take significant effort?
If the items do not take much time or effort, you have not created a WBS, 
but a to-do list. To-do list items are what you list at the start of the day to 
organize your work for that day. They may represent steps to be taken to 
perform an activity (for example, call Fred to discuss the design idea; set up 
a log in on the client’s website). To-do items can be entered in the Notes 
field using task Notes as described above.

hh Does this task have an acceptance criterion? 
Acceptance criteria are part of the WBS dictionary and are typically captured 
in a checklist format in the Notes field (using task Notes as described 
above). The task name could then read complete checklist. 

hh Will I continue to update all these detail tasks when I am busy during project 
execution?
If you think that you may not be able to update all of the tasks during the 
execution phase, then you would be better off rolling them up into a higher-
level task.

We recommend keeping your schedule lean and mean! Only by doing so will 
you be able to keep it alive as a forecasting model during the hectic execution 
phase of the project. Lean and mean means your schedule has the right level of 
detail, is deliverable-oriented, and is realistically related to the way the work will 
be done.

Too Many Tasks?
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We won’t cover estimating durations for WBS tasks until the next chapter, but 
there are two duration considerations you’ll want to consider when defining the 
level of detail in your WBS: reporting periods and the 1% – 10% guideline. Both 
are applied to work packages: a unit of work that will be used in controlling the 
project.

hh Reporting Period
The reporting period is the time frame in which you will report the status 
of your project. For example, if your project manager wants you to report 
the status of your project every week, your reporting period is one week. 
Reporting periods can vary from one project to another, depending on 
the project’s complexity and communication needs. As a general rule, the 
duration of your detail tasks should not be longer than one reporting period, 
or in this example, one week.

This allows you to ask your team members at status time the very pointed 
question: Is this task done now, or are we still working on it? As a project 
manager, you know that if a task is still in progress in two consecutive status 
meetings, there may be a bigger problem that requires your immediate 
attention.

What to do if a task takes longer than a reporting period? If possible, break 
the task down so that there are two or more sub tasks that fit within reporting 
periods. For those tasks that you can’t or choose not to break down, you 
can monitor their progress in other ways, (see Earned Value Management 
in Chapter 12). Remember, in the end you can only rely on the receipt of a 
deliverable as proof that a task is done. The amount of effort expended or 
time passed does not indicate accomplishment.

hh The 1% – 10% Rule
The 1% – 10% guideline suggests that the duration of any detail task should 
be between 1% of the project duration and 10% of the project duration.

For example, if you have a project that will take about 60 business days the 
minimum duration is 1% of 60 or 0.6 day, which you could round to half a 
day. Detail tasks should not last less than half a day (unless the project or 
part of it requires very tight control). If they are smaller, you could logically 
bring them together into larger tasks. The maximum is 10% of 60 or 6 days; 
let’s round it to one week. Detail tasks would be no more than one week in 
duration.

The 1% – 10% rule should be applied to detail level tasks or work packages, 
and may not be appropriate for:
h` Summary tasks
h` Level of effort tasks 

Task Duration 
Considerations 
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h` Recurring detail tasks
h` Milestones
h` Rolling wave planning

The 1% – 10% rule may not be appropriate when using rolling wave planning for 
the entire project schedule, since you are not detailing the whole WBS at one 
time. You may want to apply rolling wave planning to the individual periods or to 
the “planning window” of the schedule, but take note that this may not be a true 
representation of the overall project duration. We will talk more about rolling 
wave planning in Chapter 4.

It can be helpful to blend the 1% – 10% guideline with the reporting period 
guideline. But neither should be used as an absolute rule: there will be instances 
where they just don’t provide the level of control that you need. For example, if 
in a very large project, tasks at the 10% level were to take a month in duration, 
it would be wise to break the tasks down further to enable more precise control 
and estimating.

Filters 01 IIL Level of Detail < 1% of Proj Dur… and 02 IIL Level of Detail 
> 10% of Proj Dur… will help you to quickly apply this rule to your projects.7 

The rationale behind finding the right level of detail is to create enough 
checkpoints for monitoring and controlling the progress of the project and to 
enable estimating and scheduling. 

In project management, we need feedback loops to control a project. A feedback 
loop is the communication between the project team members, the project 
manager, the client and sponsor, and other stakeholders.

The project manager assigns tasks and the plan tells performers what they 
need to deliver and by when. Performers tell the project manager how much 
time and effort they have spent, what deliverables they have produced, what 
issues and changes have come up, and what obstacles need to be cleared. The 
project manager (with an electronic assist from Project 2013) summarizes and 
interprets the analysis of the data. The project manager communicates to all of 
the project stakeholders the project’s progress against the plan as well as whether 
corrective action is required.

If the WBS is structured so that it’s easy to understand at every level of detail, 
the sponsor and client can see the big picture and be confident that they are 
getting an accurate depiction of the project scope; they can go into detail as they 
see fit. Detail level data from performers can be automatically summarized for 
reporting and control at multiple levels.

7 Filters can be found in the file IIL Project 2013 Tools.mpp available for download at www.jrosspub.com. 
Click the link WAV Download Resource Center to enter the download site.

Why Is the Right 
Level of Detail 
and Structure 
Important?
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The right level of detail and its use in reporting enable effective control. The 
diagram below shows the relationship between the recognition of the need for 
corrective action, taking the corrective action, and the ability to see its results.

1 2 3 4 5 6 7 8 9 10
Start Finish

Project Status Periods

first status report
corrective action taken

results achieved with corrective action
results visible in status report

The first status report is 
normally made available 
halfway through the second 
status period. If the report 
shows a problem, a decision is 
made to take corrective action. 
If you take the corrective action 

for the duration of the second period, you may not see the results appear until 
the third period. The report on the third period becomes available in the fourth 
period. So problems in the first period will be corrected visibly for the client or 
executives only in the fourth period—or even later, depending on the situation. 
There is always a delay in determining the problem, taking action, and seeing the 
result of the action. If you have ten checkpoints, clients really only have six or so 
manage-points. You therefore need a number of reporting periods that will 
enable both the catching of problems as early as possible as well as the ability to 
see the results of corrective action.

Clients and executives tend to get nervous when you don’t give them enough 
opportunities to know where you are and to make a difference in your project. 
As a result, they may start micro-managing you as the project manager.

Of course, successful project managers don’t depend on their own status reports 
to find out what is happening in their projects: they make sure they know the 
status of their projects at all times. They continually check up with their teams 
and communicate frequently on the work floor. In some projects there are brief 
daily meetings to report progress and raise issues and obstacles. This increases 
the number of feedback loops dramatically and thus the chance for successful 
completion of the project.

When you’re creating your WBS, keep these structural rules in mind:8 

hh Keep the most important items—your key deliverables—on the highest 
level. Make sure they represent the entire scope of the project.

hh Under any WBS element there should be at least two detail elements. If 
there is only one detail element remove it and reword the summary level 
element as needed to incorporate it, or identify another element to fully 
describe the summary element.

8 These checks have been adapted from The Practice Standard for Work Breakdown Structures – Second 
Edition, PMI, 2006.

Characteristics 
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hh There should be no duplication or logical overlap between WBS elements. 
There can be an overlap in the schedule, which is a chronological overlap. 
But each deliverable or task should be shown once and only once on your 
WBS.

hh Each group of detail elements should completely capture its summary 
element (top-down check).

Ask yourself: If we do all of the detail elements will we have completely 
accomplished the summary deliverable? 

hh Each element should relate to its summary elements on all higher levels 
(bottom-up check).

In an organization chart, the greater the scope of a function, the higher it is in the 
chart. The CEO function encompasses the entire organization while the direct 
reporting functions—business units, divisions, etc.—follow. The WBS works in 
the same way. The project as a whole breaks down into a few major deliverables 
or phases, and these break down into the work that is needed to deliver them. 
Each element of the work has its own deliverable(s).

However, a WBS should not follow the lines of an organization. Do not break 
down the project work by functional group. Eventually, the deliverables will be 
assigned to functional groups in the responsibility assignment matrix, but this 
is a later step. In your WBS, concentrate on breaking down work by deliverables 
and/or phases and activities.

The WBS is the most important document in a project plan:

hh Many key project management documents (e.g., your project schedule, 
your budget) need the WBS as input. This means that the quality of these 
documents rests in part on the quality of your WBS.

hh The WBS serves as an important communication tool between the project 
manager and the stakeholders of the project, such as the sponsor, the 
customers, and the internal and external suppliers. Along with the scope 
statement, it is the source for defining what needs to be done on the project.

Working out a detailed WBS with your clients helps you manage their 
expectations and ensures a veritable meeting of the minds early in your project. 
Like all other parts of the plan, the WBS is subject to change as the project 
progresses. Time spent on your WBS is generally time well spent. 

Note that a Work Breakdown Structure is not a project schedule. It only tells us 
what needs to be done, not how or when or by whom. These steps come later.

Importance of 
the WBS
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Before you begin entering tasks, set the Default task type option and Effort 
driven options to match the majority of your tasks. 

On the File tab, in the Backstage View, click on Options and consider the 
following options:

Project 
Options

Recommended Choices

Schedule Set the Scheduling Options on the Schedule tab:
Set the Scheduling options for this project for the current open 
project <schedule name of the project> in the drop-down or select All 
New Projects for any new schedules you want to create. 
If you choose All New Projects existing schedules are not affected 
because these options are stored in the project schedule.

Default task type
Most people enter the task duration immediately, and Project 2013 
should not change it, unless required. If you normally enter duration 
estimates, we recommend setting the default task type to Fixed 
Duration. On a task-by-task basis, you can easily change this default task 
type to what is needed.

New Tasks are effort driven
We recommend that you turn this option off (unchecked). This option 
changes the number of resources assigned (assignment units) and is 
similar to Fixed Work tasks. We recommend you use Fixed Work tasks 
instead.

You can easily set options for the current project or for all new projects on the 
Schedule and Advanced tabs. Go to the File tab in the Backstage View and 
click on Options. Both the Schedule and Advanced tabs have sections that 
allow you to apply the settings that follow to either the current project <current 
project name> or All New Projects.

Entering WBS 
Tasks in Project 
2013
Choosing the 
Options
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You’ll enter your WBS in Project 2013 as a series of tasks. It’s important to 
remember that though Project 2013 terms its WBS elements as tasks, they can 
(and should!) include your deliverables as well as the tasks and activities needed 
to produce those deliverables. Remember, every task at any level of detail should 
have one or more well defined deliverables. 

Project 2013 has a number of task types including a project summary task, 
summary tasks, detail tasks, and milestones. It’s important to understand the 
difference between these components because each is treated differently in 
Project 2013.

Project Summary 
Task

Summary Tasks

Detail Tasks

Manually Scheduled 
Tasks

Milestone

hh Project Summary Task
Each project has a single project summary task which represents a summary 
of the project. It is automatically generated by Project 2013 and shows totals 
for the entire project in all of its standard and customized fields. It also 
displays a bar in the timescale that represents the whole project. 

In the example above, Software Implementation is the project summary task.

The project summary task may be hidden (the default) or displayed, as we’ll 
see below. When displayed, it will always appear in row 0 and will display a 
bar in the timescale that represents the whole project. 

You cannot assign regular resources to the project summary task (row 0); 
only budget resources can be assigned here. It is also important to remember 
that they must be specifically identified as a budget resource when created, 
otherwise Project will not allow you to assign them to row 0. (For more 

Types of Tasks 
in Project 2013
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information, see Chapter 7 on entering resources and Chapter 8 on entering 
assignments.)

It is possible to assign a fixed cost to the project summary task, but we urge 
you not to do this. You will have much greater control of costs if you manage 
them on a more detailed level of the project.

Always use the project summary task that Project 2013 automatically 
generates in row 0 to show the totals for the project. Avoid using a task 
you create yourself in row 1 that represents the project totals, because this 
task will not function in the same way as the automatically created project 
summary task in row 0. 

By default, the project summary task (row 0) is turned off. To turn it back on 
for your current project or for all new projects go to the File tab and in the 
Backstage view, click on Options, Advanced. Under the Display options 
for this project section, check the box Show Project Summary Task. You 
can select this option for the current project <Current Project Name> that 
you have open or for All New Projects going forward. 

If you just wanted to display the project summary task for the current open 
project and not all new projects going forward, you can go to the Task tab in 
the View group, and click Gantt Chart. On the Format tab, in the Show/
Hide group, click the Project Summary Task box.

hh Summary Tasks
A summary task is any task that includes a lower level (or levels) of detail 
tasks. 

In the example on the previous page, 2. Requirements, 2.1 Software 
Requirements, and 2.1.1 Initial Requirements are summary tasks because 
they include lower levels of detail tasks. For example, the summary task 2. 
Requirements includes all of the detail tasks indented beneath it.

Note, however, that the summary task 2.1.1 Initial Requirements, includes 
only the tasks indented beneath it. For example, the task 2.1.2 Final 
Requirements is not part of the task 2.1.1. Initial Requirements.

The top-level summary tasks are often the key deliverables or phases of your 
project—the components that you’ll be delivering to your client. In the 
example above, Requirements and Equipment are two key deliverables for 
the project. 

You generally do not assign costs, work, or duration to summary tasks—
unless you are entering budgets by assigning Budget Resources to the project 
summary task. Instead, it is usually better to allow Project 2013 to calculate 
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these totals for the summary task based on its detail tasks. (That’s why these 
are called summary tasks.) We’ll cover more on this in later chapters.

The Project 2013 default settings are for summary tasks to show up in 
boldface with an outline symbol in form of a small triangle pointing 4 o’clock 
in front of the summary task name if all of the detail tasks are displayed, or a 
small triangle pointing 3 o’clock in front of the summary task name if there 
are hidden detail tasks. The outline symbol in front of the task 2.1 Software 
Requirements tells us that there are detail tasks associated with this summary 
task that currently aren’t displayed.

In Project 2013, you can directly insert summary tasks with just a click. 
To do this, on the Task tab, in the View group, click Gantt Chart. Select 
the task name just before where you want to insert the summary task, then 
on Task tab, in the Insert group, click Summary. Type the name of the 
summary task. Project will convert the task that is immediately below the 
inserted summary task to be a child task (a detail task under the parent 
summary task).

hh Detail Tasks
A detail task is any task that doesn’t have lower level subtasks (in other 
words, it’s not a summary task). Detail tasks are the units of work for which 
duration estimates and resources must be assigned. 

Detail tasks can be scheduled either manually or automatically, as we’ll 
discuss later in this chapter.

In our example, the tasks 2.1.1.1.1 Conduct Session One and 2.1.1.1.2 Conduct 
Session Two are detail tasks because they don’t have any lower level subtasks.

Each detail task belongs to the summary task under which it’s indented. For 
example, 2.1.1.1.1 Conduct Session One belongs to 2.1.1.1 User Requirements 
Session. 

hh Milestones
A milestone is an event you define in your schedule; it might be an evaluation 
point or the completion of an important deliverable.

A milestone has a zero duration; it is a point in time, an event and not an 
activity.9 You can insert milestones in your schedule wherever you think 
they’ll be useful. As a general rule of thumb, we recommend you enter at 
least one milestone as the last item for each summary task. Most people 
indent the milestone on the same level as the detail tasks for the summary 
task. 

9 You can mark tasks with non-zero durations as “milestones” also. This creates hard-to-explain gaps 
between task bars in the timescale. We recommend you use lag on dependencies as described in Chapter 
5 instead.
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You may fix the dates of milestones to set initial scheduling targets, but be 
careful not to make a schedule that looks like it will make a milestone target 
when the probability of doing so is small. 

In our example, 2.2 write report is a milestone for the 2. Requirements task. 
We’ll see later how to identify milestones in Project 2013.

Unless you are using the Insert Summary Task or Insert Milestone Task on 
the Task tab, Insert group of the Ribbon, Project 2013 doesn’t always know 
whether you’re creating a summary task, a detail task, or a milestone. For 
example, a summary task doesn’t become a summary task until you indent a 
detail task beneath it. So you enter all tasks into a field simply called Task Name 
(known in the database as the field Task). Remember that although the field 
is named task, you use it to enter not only tasks, but deliverables, phases, and 
milestones as well.

You can directly insert a Milestone task with just a click. To do this, on the Task 
tab, in the View group, click Gantt Chart. Select the task name prior to where 
you want to insert the Milestone task, then on the Task tab, in the Insert group, 
click Milestone. Type the name of the Milestone task.

If you analyze an indented list of tasks, you’ll find that a standard module recurs: 
a summary task with its detail tasks and a milestone. These standard modules 
can even be nested inside one another, 
thus creating the next indentation level, 
as the illustration also shows. The 
indentation level is captured in the field 
Outline Level. The first level is outline 
level 1, the next indentation outline 
level 2, etc.

Build your plan in a modular way and 
use the following standard module of 
tasks. Your WBS will consist of several 
of these standard modules (with a 
varying number of detail tasks):

Standard Module Example
Summary task 1

Detail task 1.1
Detail task 1.2
Detail task 1.3
Milestone 1.4

REPORT
Data Gathered
Data Categorized
Report Written
Report Ready

Task Structure 
in Project 2013

WBS 

Standard Module 
Summary Task 1

Detail Task 1.1
Detail Task 1.2
Detail Task 1.3
Milestone  1.4
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Project 2013 has two scheduling features that facilitate your control over your 
schedule: one is copy and paste and the other is user-controlled scheduling.

At times you may want to create an initial task list in another Microsoft 
application (e.g., Word or Excel) and then decide to manage this list using the 
full, powerful, and robust functionality of Project 2013. You can copy and paste 
content between other Microsoft Office 2013 programs and Project 2013 and 
still retain its formatting, outline levels, and column headers. With two clicks of 
the mouse, you can then generate an instant report and copy it to other Microsoft 
Office programs. (We will talk more about this in Chapter 11: Reporting).

You can schedule tasks automatically, using the same powerful and robust Project 
scheduling engine as always, or you can schedule tasks manually, keeping the 
task dates where you want them.

Manually scheduled tasks differ from automatically scheduled tasks in two key 
ways:

hh Typically you schedule a task by assigning duration estimates and resources, 
even though you might not have this information readily available. With 
manually scheduled tasks, you can provide high-level task information for 
the task without assigning duration estimates and resources. For example, 
you could enter “TBD” in the Start Date or “Go ask Nate” in the Duration 
field until you know the estimated duration and start date. This allows you to 
start planning your project right away without knowing all the information 
about the manually scheduled tasks up front. 

hh For manually scheduled tasks, changes to the schedule (such as task 
dependencies and the project calendar) will not automatically adjust task 
dates. So manually scheduled tasks will stay where you want them to stay in 
your project schedule. 

hh By default, new tasks are manually scheduled in Project 2013. If you want 
to schedule a specific task to be auto-scheduled, select the task, then on 
the Task tab, in the Tasks group, select Auto Schedule, or change the 
scheduling option for the specific task in the Task Mode column. 

hh If you want all of your new tasks to be automatically-scheduled, on the File 
tab, in the Backstage view, click on Options, Schedule. In the Scheduling 
options for this project section, select the current project <Current Project 
Name> that you have open, or select All New Projects for all projects going 
forward for the settings to be selected. In the New tasks created section, 
select either Manually Scheduled or Auto Scheduled from the drop-
down, depending on your preference.

Project managers who are used to automatic scheduling (the only choice avail-

Entering  
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User-controlled 
Scheduling: 
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Scheduling
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able with versions prior to 2010 Project) may prefer to turn manual scheduling 
off. For some projects, especially complicated ones, you may want Project’s 
powerful scheduling engine to schedule and reschedule tasks for you.

 Now, we will discuss how to enter summary tasks, detail tasks, and milestones.

You can use either the Gantt Chart view or the Network Diagram view for 
entering tasks. You may find the Gantt Chart view more comfortable because 
you can see the levels of the breakdown structure shown through the indentation 
of the tasks and graphically in the chart. The farther indented to the right, the 
lower the level of the task. 

To switch to the Gantt Chart view, on the Task tab, in the View group, click 
Gantt Chart, OR on the View tab, in the Task Views group, click Gantt Chart. 

As mentioned above, we recommend that you not enter a project summary task 
on row 1, but instead display the project summary task automatically generated 
by Project 2013 on row 0: 

To display the Project Summary task: 
1. On the Task tab, in the View group, click Gantt Chart. 

OR 

On the View tab, in the Task View group, click Gantt Chart. 

2. On the Format tab, in the Show/Hide group, click Project Summary 
Task. The project summary task will be displayed in row 0.

For summary tasks you only need to enter the name, since most of the other 
fields are calculated.
1. On the Task tab, in the View group, click Gantt Chart.

2. Select the task name prior to where you want to insert the new summary 
task. On the Task tab, in the Insert group, click Summary. Notice that a 

Summary Tasks, 
Detail Tasks, and 
Milestone Tasks

Displaying the 
Project Summary 
Task

Entering Summary 
Tasks
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new summary task is inserted and the task you selected is now a “child task” 
of this new summary task.

3. Type the name of the summary task. The Summary task can be named 
with a noun. We recommend that you add an adjective to the noun if it will 
help clarify acceptance criteria for the deliverable. If one adjective is not 
enough, use Notes on the Task tab, Properties group to add more explicit 
acceptance criteria.

With the Insert Summary Task function, Project 2013 will convert the task that 
is immediately below the inserted summary task to be a child task. If necessary, 
adjust the indentation level as needed. 
4. Press Enter key to go to the next task, which is automatically indented for 

you after creating the new summary task,

OR

You can insert new detail tasks. On the Task tab, in the Insert group, click 
Task and then select Task from the drop-down menu. 

5. Adjust the other tasks as needed. 

We recommend that you type summary tasks in UPPERCASE. In dialog boxes 
where there is a drop-down list of tasks, indenting does not show, and putting 
the summary in uppercase allows you to more easily view a long list of tasks. It 
also helps you avoid linking to summary tasks (linking is covered in Chapter 5).

For detail tasks, you can just enter the task name or you can add in the duration 
estimate and other information (description of deliverables, hyperlinks to 
deliverables, notes, responsible parties, etc.) if that information is available. 
We will discuss adding these other elements in more detail in later chapters 
and strongly suggest that you read the chapter on estimating before you enter 
duration estimates. 

You can insert and attach documents or link deliverables to a task. To do this, 
insert the Hyperlink column and right-click on the Hyperlink cell for the task. 
Then you can add or edit the hyperlink text by clicking Hyperlink from the 
drop-down and then completing the Text to display box.

Entering Detail 
Tasks
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1. If you need to insert a new row for a detail task, click on any cell in the row 
before where you want to insert a new task.

2. On the Task tab, in the Insert group, click Task OR right-click the selection 
and click Insert task from the shortcut menu that appears.

3. Enter the Task Name; make it meaningful so users will fully understand the 
task at hand.

4. Press the Tab key to go to its Duration field. Enter an estimate and press 
Tab again.

If necessary, indent it under its summary task by clicking Indent to indent 
the task or Outdent to outdent the task on the Task tab in the Schedule 
group,

OR

You can right-click and select the Indent or Outdent icons commands from 
the Mini-Toolbar menu that appears.

The last task under a summary heading should be a milestone task that 
represents completion of everything within the summary. This way you can 
verify completion of the summary. We don’t recommend assigning resources or 
the person responsible to the milestone task. Instead we recommend entering 
the person responsible for the milestone task in the Milestone Note field.

Inserting Milestone tasks:

1. To insert a milestone task, on the Task tab, in the View group, click Gantt 
Chart. 

2. Select the task name prior to where you want to insert the Milestone task, 
then on the Task tab, in the Insert group, click Milestone.

3. Enter the name of the milestone in the Task Name field.

4. The Duration of this milestone task is set to 0 (zero). This zero duration is 
what tells Project 2013 that you are entering a milestone, and two things 
happen: the field Milestone is toggled from No to Yes behind the screen, 
and a black diamond is inserted on the Gantt Chart timescale on the right 
of the screen if the task is auto-scheduled, (if the task is manually scheduled, 
the diamond will be gray in color).

5. If necessary, adjust the indentation level to the same level as the detail tasks 
above it by using the Indent and Outdent tools on the Mini-Toolbar menu 
that appears when you right-click on the milestone.

Entering  
Milestones
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The Task Information dialog box has a Mark task as milestone feature on 
the Advanced tab, but we recommend that you not use this feature. It creates 
confusion because the task will show the real duration in the Duration field, 
using this duration for all schedule calculations, and will show a milestone 
symbol (for example a black diamond) at the end of the task in the Gantt Chart. 
We recommend that you use a normal task with a duration other than zero to 
model activities and that you designate zero duration for those tasks that are to 
be modeled as milestones.

To open the Task Information dialog box, either double-click on the Task 
name; or select the task and on the Task tab, in the Properties group, select the 
Information icon.

Use the Advanced tab

Leave this box unchecked

Now that you’ve entered some tasks, you’ll want to use indenting and outdenting 
to create an outline in Project 2013 that reflects the structure of your WBS.

Outlining makes the plan easier to read and 
understand. It also generates extra aggregate 
information on the summary tasks. Project 
2013 automatically calculates the duration, cost 
and work fields on the summary tasks. You can 
immediately see what a deliverable costs. For 
example, if your deliverables are software features, 
executives can now compare the efforts and costs 
associated with the various software features. This 

Creating a 
Hierarchical 
WBS in Project WBS - List 

Outline Structure
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is invaluable if tough choices have to be made about which features will make it 
into a particular software release.

Summary tasks can be collapsed to hide detail tasks or expanded to reveal them 
on an as-needed basis, providing just enough detail to perform your analysis or 
to focus your reports. If you collapse the summary tasks, you have the kind of 
overview that many executives prefer.

Select the detail tasks by dragging anywhere over them in the table.

To indent, right-click and select the Indent icon command from the Mini-
Toolbar menu that appears

OR

Hold down the Alt + Shift keys and then press the Right arrow key.

After indenting, the summary task shows a duration that summarizes all its 
detail tasks.

Indenting a task cannot be done by inserting spaces in front of the task name. 
Project 2013 will not recognize this as a lower level subtask, even though it may 
look like one. Project 2013 also does not allow you to use the Tab key to create 
indentation, as you would in Word or PowerPoint.

1. Select the tasks by dragging over them in the spreadsheet.

2. To outdent, right-click and select the Outdent icon command from the 
Mini-Toolbar menu that appears.

OR

Hold down the Alt + Shift keys and then press the Left arrow key.

You can also indent or outdent tasks by dragging them:

1. Select the tasks by dragging over them in the task table.

2. In the Task Name column, point to the first characters of the task name; the 
mouse pointer changes to a two-headed arrow. Before proceeding, make 
sure you see this arrow (and not the mouse pointer).

3. Hold down and drag the task to the right for indenting or to the left for 
outdenting. A vertical gray line gives you feedback on which outline level it 
will end up on when you release the mouse. The higher the level, the greater 
the indentation.

4. Release the mouse button when the gray line appears at the right level of 
indentation.

Indenting a Series 
of Detail Tasks

Outdenting Tasks

Indenting and 
Outdenting by 
Dragging
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Click the outline symbol in front of the summary task name to hide its detail 
tasks. 

OR

Select the summary task, hold down the Alt + Shift keys and then press the 
Minus key.

The detail tasks can be displayed again by clicking the outline symbol in front of 
the summary task name. 

OR

Select the summary task and hold down the Alt + Shift keys and then press the 
Plus key.

On the View tab, in the Data group, click Outline and select Level 1 in the list. 

OR

1. Click on the heading of any column; the entire column should be highlighted 
now.

2. On the View tab, in the Data group, click Outline and select Hide Subtasks 
in the list. You should now only see the first outline level.

Click on the title of any column. On the View tab, in the Data group, click 
Outline and select + Show Subtasks in the list. 

OR

On the View tab, in the Data group, click Outline and select the next Level to 
be revealed. 

On the View tab, in the Data group, click Outline; and select the specific Level 
you want to be revealed.

If you are not sure how Project 2013 counts the levels, insert the column Outline 
Level and study the numbers that Project 2013 displays. The left most level is 
Level 1.

On the View tab, Data Group, click on Outline; a list is displayed with the 
available outline levels. Click the item All Subtasks.

It’s critical to understand that what you do to a summary task affects all its detail 
tasks as well. If you delete a summary task, you will also delete its detail tasks. 
The same applies to cutting, copying, and indenting. 

To Hide and Re-
display Detail 
Tasks

To Hide All Detail 
Tasks

To Reveal  
the Next Level

To Reveal a 
Certain Level

To Reveal  
All Levels

What You  
Do to a  
Summary  
Task, You Do to 
It’s Detail Tasks
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As you enter and edit tasks, Project 2013 automatically assigns each task an 
Outline Number. You can choose to display or hide these numbers in the Task 
Name field:

1. On the Task tab, in the View group, click Gantt Chart. On the Format tab 
in the Show/Hide Group, select the Outline Number check box.

2. You will now see the Outline Code for each task displayed before the task 
name in the Task Name field. Project 2013 will automatically adjust the 
Outline Codes if you change the order or indent level of tasks by moving, 
inserting, deleting, indenting, etc.

WBS Codes are stored in the WBS field. By default, they have the same numbers 
as Outline Codes. 

To display WBS Codes you can insert a column in your table:

1. Right-click on the column heading to the right of where you want to insert 
the new column and select Insert Column.

2. Type or select WBS from the dropdown that appears.

3. The WBS field will be displayed.

You can’t change the Outline Codes assigned by Project 2013. If you want to use 
a different numbering scheme, you can do this by customizing the WBS Code 
field.

1. On the Project tab, in the Properties group, click on WBS and select 
Define Code… from the list.

2. The WBS Code Definition dialog will be displayed.

Outline Numbers

WBS Codes

Customized WBS 
Codes
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3. If you want a prefix to appear at the beginning of all of your tasks, enter it in 
Project Code Prefix.

If you’re creating task dependencies across projects, or creating consolidated 
or master projects, the Project Code Prefix is very useful in identifying the 
subproject. 

4. Use the Code mask to define the Sequence, Length, and Separator for 
each level of your WBS:

h` The Sequence can be: Numbers (ordered), Uppercase Letters (ordered), 
Lowercase Letters (ordered), or Characters (unordered).

h` You can define any length for each level of your WBS code (if you 
choose Any, Project 2013 will allow any length up to 255 characters).

h` Enter the character that you want to use to separate the WBS code 
levels. This separator is optional; the default is a period.

5. Select the check box Generate WBS code for new task to have Project 
2013 automatically generate a WBS code when you create a new task.

6. Select the check box Verify uniqueness of new WBS codes to have Project 
2013 warn you if you enter a WBS code that has already been used.

7. Click the OK button.

To display your customized WBS codes:

1. Right-click on the column heading before where you want to insert the 
WBS column.

2. Type or select WBS from the list that appears.

You can replace a task name by typing over it. If you need to make small editorial 
changes (correct a typo), you are better off editing the task name rather than 
replacing the entire name. 

1. Click once in the field and press the F2 key. The cursor will blink as a line 
in the cell.

OR

Click once in the field and after one second, click another time; a blinking 
insertion point will appear in the cell.

OR

Changing the 
WBS
Editing a Task 
Name

J. Ross Publishing; All Rights Reserved



Chapter 3: Entering Tasks

147

3

Click in the entry bar at the top of the screen; the cursor will blink as a 
vertical line.

2. Move the cursor by clicking with the mouse or by using the arrow keys on 
the keyboard. 

OR 

Press the Home key to jump to the start of the cell and the End key to jump 
back to the end.

OR

Hold down the Control key and press the Left arrow key to jump one word 
to the left, or the Right arrow key to jump to the right.

3. Make the changes.

4. Press the Enter key to accept the changes and finish the editing. The red-
cross and green-checkmark buttons in the entry bar should now disappear.

If Project 2013 seems stuck and does not allow you to click on menu items, 
chances are that you are still in the middle of an editing process and still in Edit 
Mode. Check if you see blinking insertion points or the red-cross and green-
checkmark buttons in the entry bar. Press the Enter key or click on another cell 
to finish the editing. Now you can proceed to the menu items again. You should 
return to Ready Mode.

The Status Bar displays project status information. 

You can view the Status Bar at the bottom of the Project 2013 window to see 
your project status information and the current mode: either Ready, Edit, or 
Busy Mode, will be displayed. See below:

The Status Bar consists of three sections:

Status Items: Reports on the status on a property of the project. Now 
in Project 2013, you will be able to tell if a filter or AutoFilter has been 
applied and if new tasks are manually scheduled in this section. There are 
also additional status items that inform you about your connection state to 
Project Server.

Status Bar
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Temporary Pool: Reports on temporary actions that are currently taking 
place in the project, for example, when the project is being saved or 
published.

Quick View Switching and Zoom: Allows you to quickly switch to 
another view and zoom in or zoom out on the timescale. The icons listed to 
the left of the Zoom Slider are Gantt Chart, Task Usage, Team Planner, 
Resource Sheet, and Report.

We already discussed how to insert one task; you press the Insert key. To insert 
multiple tasks:

1. Point to the row heading before which you wish to insert multiple tasks, 
click and drag down to highlight as many rows as you need inserted.

2. Press the Insert key and the number of rows you highlighted are inserted 
as blank rows.

If you insert tasks between linked tasks, Project 2013 may set dependencies 
automatically if the Autolink option is turned on. On the File tab, in the 
Backstage view, click on Options. In the Project Options window select the 
Schedule tab to verify if the option Autolink inserted or moved tasks has a 
checkmark or not. Always check the dependencies after adding, copying, or 
moving tasks (or turn Autolink off, if you don’t want Project 2013 to think and 
link for you). See Chapter 5 for more information on dependencies and links.

To delete tasks that you don’t need, follow these steps: 

1. Select the tasks by dragging over their row headings (where you see their 
ID numbers). 

2. Right-click on the selection and the Shortcut Menu appears, select Delete 
Task

OR

Press the Delete key.

OR

3. For auto-scheduled tasks, you can also click the task name instead of the 
row heading and then press the delete key. The delete indicator Smart Tag 
(an “X”) appears in the Task’s Indicator column.

Smart Tags are indicators that contain drop-down option buttons to help you 
make certain adjustments to your project plan. Smart Tags list the action that you 
have just taken plus any other possible actions suggested to help avoid mistakes 
in uncertain situations. Smart Tags appear when you: add, change, or remove 
resource assignments; change the start or finish dates; change work, duration, 

Inserting Multiple 
Tasks

Deleting Tasks
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or units; or delete either auto-scheduled tasks or a Resource from the Name 
column.

4. Click on this Smart Tag (an “X”) and you can now choose to either delete 
just the task name (Only clear the contents of the Task Name Cell) or the 
entire task (Delete the entire task) from the drop-down menu.

When deleting specific cells, the Smart Tag will only activate when the delete 
key is pressed for auto-scheduled tasks. Clicking the cell containing the task 
name on a manually scheduled task and pressing the delete key will delete the 
contents of the cell but will not bring up the Smart Tag.

5. If you delete only the task name, you can now enter the new task name into 
the cell, then press enter.

Note that the Delete key deletes cells instead of entire rows just like in Excel 
(unless you selected row headings first). Also remember that when you delete a 
summary task you delete all of its subtasks.

For copying or moving tasks, it is important to select the entire task (including 
its fields that are hidden from view). Do this by clicking on its row heading (the 
first column with the ID numbers and the gray color).

Clicking on the row heading ensures that you get the entire task row—all fields, 
including the ones that aren’t displayed. It also ensures that you don’t accidentally 
overwrite other tasks. In addition when you click a row number for a summary 
task, all subtasks are affected and will be copied or moved with it.

The gray color of the first column tells you that the column is locked, which 
means that:
hh It will not scroll off the screen
hh Its data cannot be edited
hh You can select the entire task by clicking on it

Some project managers use this locked first column to display the WBS-codes 
(field WBS) instead of the ID field. Other project managers lock the Task Name 
column to prevent task names from scrolling off of their screen.

If the first column is not gray, you will have to lock the column first.

 If the first column of the table is not locked, follow these steps: 

1. On the Task tab, in the View group, click Gantt Chart. On the View tab, 
Data group, select Tables: <name of the table>, More Tables.

2. Click the Edit button.

3. Select the check box Lock first column.

Copying or Moving 
Tasks

Locking the First 
Column of a Table
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4. Click the OK button and then click the Apply button.

5. If you now click on a locked row heading, the whole row should be selected.

1. Select the tasks by clicking and dragging over the locked row headings by 
using the mouse pointer.

2. Release the mouse button when you have selected all tasks to copy; they are 
now highlighted.

3. Point to one of the selected row headings and the mouse pointer changes to 
to a drag pointer. Hold down the Control key, and hold down the primary 
mouse button. The mouse pointer changes to Pointer Copy where the 
small plus sign indicates that you are copying. Drag the copied tasks to their 
new place.

OR

Select the row number of the row you want to copy. Right-click to display 
the Shortcut Menu and click the Copy button from the list that appears.

Select the row number where you want to place the copied row. Right-click 
to display the Shortcut Menu and click the Paste button from the list that 
appears.

To preserve dependencies when copying tasks, on the File tab, in the Backstage 
view, click on Options, Schedule. Clear the check box Autolink inserted or 
moved tasks. You should make a habit of checking the dependency links after 
adding, copying, or moving tasks.

1. Select the tasks by dragging over locked row headings using the mouse 
pointer.

2. Release the mouse button; the tasks should now be highlighted.

3. Point to one of the selected row headings; you should now see the mouse 
pointer as a drag pointer.

4. Drag the tasks to their new place; a horizontal gray line will indicate where 
the tasks will be placed when you release the mouse.

OR

Right-click on the row number of one of the selected tasks. Click the 
Cut button on the Shortcut menu list that appears. The tasks are now 
temporarily stored in the clipboard. 

5. Right-click on the row number where you want to insert the tasks you’re 
moving. Click Paste on the Shortcut menu list that appears on the 

Copying Tasks

Moving Tasks
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Clipboard grouping of the Task tab on the Ribbon. Project 2013 creates 
new rows and inserts the moved tasks.

To preserve dependencies when moving tasks, on the File tab, in the Backstage 
View, click on Options, Schedule. Clear the check box Autolink inserted 
or moved tasks. You should make a habit of checking the dependencies after 
adding, copying, or moving tasks.

1. Select the summary task by clicking on its row heading. 

2. Hold the Control key down to copy. 

3. Hold down the primary mouse button and Project 2013 will immediately 
highlight all its detail tasks and move or copy them as well.

4. Drag the summary task and its subtasks to where you want it.

If you use the clipboard instead, the detail tasks will also be copied or moved.

When creating a task list, you may find it useful to import a list created in another 
program, such as Outlook or Excel. Importing is a time-saving technique that 
brings information from one software program into another.

In order for Project 2013 to import information in non-default file formats, you 
first need to allow non-default formats:

1. On the File tab, in the Backstage view, click on Options, Trust Center.

2. Click Trust Center Settings to reveal the Trust Center dialog then click on 
Legacy Formats.

3. Select one of the following options:

Prompt when loading files with legacy or non default file format (medium 
security) or Allow loading files with legacy or non default file formats (low 
security).

4. Click OK button.

To import a file:

1. On the File tab, in the Backstage view, click on Open. The Project 
2013 import wizard automatically opens when you attempt to open an 
alternative file format. 

2. Specify the location of the file you want to import in the Look in menu.

3. Specify the file type (e.g., Microsoft Excel Workbooks), or select All Files from 
the Files of Type drop-down.

4. Select the file you want to import.

To Copy or Move 
a Summary Family

Importing Tasks
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During the import process, Project 2013 will prompt you to match source 
fields with Project 2013 fields. This is called mapping. To simplify the mapping 
process, predefined maps contain a subset of all of the available fields in Project 
2013. Mapping allows you to concentrate on a desired subject area and import 
only the related fields.

The Import Wizard is designed to work with fields created in the Excel (.xls or 
.xlsx) format.

Project 2013 also allows you to import from an Outlook task list. However, 
importing from Outlook generates static data. No link between data in Outlook 
and data in Project 2013 is created.

It is not within the scope of this book to address the functionality of SharePoint, 
(SharePoint Foundation 2013, SharePoint Server 2013, or SharePoint Online). 
However, we will address importing and exporting tasks between Project 2013 
Professional editions and SharePoint 2013.

Sync with SharePoint Task List feature is available only for Project Professional 
2013 and Project Pro for Office 365.

SharePoint 2013 offers tools to build business applications to better organize, 
store, share, and manage digital information within a company.

Importing Tasks from SharePoint 2013 to Project Professional 2013:

If your company has SharePoint 2013 installed, you can share information 
within the enterprise. If you have a SharePoint task list in place, you can import 
these tasks into Project Professional 2013 to create your WBS, and you can do 
this without using Project Server 2013.

Exporting Tasks from Project Professional 2013 to SharePoint 2013:

If you are using Project Professional 2013, you can create a new project schedule 
and export it, saving and syncing the task list to SharePoint 2013. 

After your project has been synced to a SharePoint task list, any changes to the 
task list within Project Professional 2013 will be displayed in the task list on the 
SharePoint 2013 site, and vice versa. 

Importing  
and  
Exporting  
Tasks  
Using 
SharePoint 
2013
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Syncing more than 1,000 tasks between Project Professional 2013 and 
SharePoint 2013 is not recommended. If you want to sync more than 1,000 
tasks, it is recommended that you use Microsoft Project Server 2013. Even if 
you have more than 100 tasks, we recommend Project Server 2013 because it is 
a better solution to manage collaboration.

How to Import a SharePoint Task List into Project

To import a list of tasks from SharePoint 2013 into Project Professional 2013:

1. In Project Professional 2013, click the File tab to open the Backstage view, 
click New, New from SharePoint task list. The Import SharePoint Tasks 
List dialog appears.

2. In the Site URL list, select or enter the URL name of the SharePoint site 
that contains the task list you want to use and then click Check Address.

3. In the Tasks List, select the name of the SharePoint task list you want. 

4. Click OK.

OR

1. In SharePoint 2013, from the SharePoint task list, on the List Tools, click 
List and on the Connect & Export group click Open Schedule button. 
Project Professional 2013 opens and the dialog window indicates the site 
you are opening.

2. Click Yes. The task list is available in Project Professional 2013 to edit.

Options to Sync to Tasks Lists are only available when Project 2013 is not 
connected to a Project Server.

How to Export and Synchronize Project Tasks to SharePoint

To export project tasks from Project Professional 2013 to SharePoint 2013.

1. In Project Professional 2013, click the File tab to open the Backstage View 
and click Save As. 

2. Click Sync with Tasks Lists. 

3. In the Sync with list, select whether you are using an Existing SharePoint 
Site or creating a New SharePoint Site. 

4. Using an Existing SharePoint Site, in the Site address list, select or enter 
the URL address of the SharePoint site that contains the list that you want 
to sync to and then click Validate URL.
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5. In the Tasks List, select the name of the SharePoint task list to which you 
want the project tasks list to sync.

If you want to sync the Project task list with a new list in SharePoint, type 
a new name. A new task list will be created in SharePoint, and will become 
synced up with the one in Project.

6. Click Sync. 

After the two task lists are synced, changes to one list will be reflected in the 
other. If changes are made to the two lists at the same time, a dialog box appears 
that prompts you to decide which version of the change you want to keep.

After the two task lists are synced, you can go to the SharePoint version of the 
task list from Project. Click the File tab, click Info. In the Sync to Tasks Lists 
section, click the link to the SharePoint site.

Here’s a quick checklist you can use to evaluate your WBS in Project 2013:

hh Are there deliverables in the WBS and are the deliverables complete as well 
as lean?

hh Does the WBS have a logical hierarchy?
h` Is the WBS an indented list with multiple hierarchical levels instead of 

a long list without structure?
h` Does each summary task have at least two subtasks?
h` Is there any duplication or logical overlap between deliverables?
h` Does each group of subtasks capture all the work of their summary task 

(top-down check)?
h` Does each item logically relate to its summary tasks on all higher levels 

(bottom-up check)?
h` Is the Project Summary Task (row 0) used instead of a physical project 

summary task? 

hh Are there enough milestones—roughly one for each summary task? You 
can check this by applying the standard filter Milestones.

hh Does the WBS have the right level of detail?
h` Is it clear how deliverables will be created and what the activities 

involved are?
h` Is the WBS lean enough that you’ll be able to update all detail tasks in 

the schedule during project execution?
hh Is the WBS clear to all project stakeholders?

Checks on the 
WBS for Your 
Project
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1. What is the definition of a WBS according to PMI’s PMBOK® Guide Fifth 
Edition?

2. Why is the WBS an important project tool?

3. What is a deliverable and why is it important that your WBS be deliverable-
oriented?

4. What are the differences between a to-do list and a WBS?

5. Why is using consistent naming conventions for your deliverables, activities, 
and milestones important?

6. How do you know you have found the appropriate level of detail in your 
WBS? Why is finding the right level of detail important?

7. What is the difference between manually scheduled tasks and auto-
scheduled tasks in the schedule? What are some of the advantages that 
manually scheduled tasks offer? What are some of the disadvantages?

8. Why would it be beneficial to export task lists to SharePoint 2013 with 
Project Professional 2013? 

For experience working with the features you’ve learned about in this chapter, 
we strongly suggest that you do the additional exercises for this chapter that 
are included in the Case Studies appendix, available to download in the WAV 
Download Resource Center at www.jrosspub.com.

Review 
Questions
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Chapter 4: Entering Estimates

Now that we have the work breakdown structure including the activities (tasks) 
entered into our project schedule, our next step is to enter estimates—predictions 
for how much time each task will take to complete. The goal is always to produce 
accurate estimates with a high probability of being actualized. 

After reading this chapter you will be able to:

hh Discuss the human tendencies in estimating and techniques to handle them
hh Discuss the practical difficulties in estimating and techniques to address 

them
hh Apply the rolling wave approach
hh Define the difference between pure and gross work time estimates
hh Define buffers and discuss the tradeoffs between hiding them and leaving 

them visible in the schedule 
hh Employ a process for generating estimates
hh Define duration and work/effort estimates
hh Use Project 2013 to:

h` Enter activities with incomplete estimates
h` Enter duration and work estimates
h` Set the appropriate task type and effort-driven settings for specific 

estimates 
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h` Describe Project 2013’s scheduling formula and its importance when 
estimating (D * U = W) 

h` Differentiate between task bar style formats
h` Create milestones, split tasks, and recurring tasks
h` Enter, move, and copy data efficiently 
h` Check the estimates of your project schedule using best scheduling 

practices

“How do we estimate?” is the question we are asked most often in our project 
management courses. Estimating is one of the most difficult skills in project 
management. It is particularly difficult when you or your team:
hh Have little or no experience with the work
hh Have incomplete or nonexistent knowledge of deliverables and acceptance 

criteria 
hh Have to estimate for tasks with uncertain outcomes, like many research and 

development tasks 

How can you know how much effort it will take to do something if you have 
never done it before or if you don’t really know what you are to deliver? How can 

Yes… after careful analysis, I think you and your team 
should be able to finish this in four months!
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you map out the latter stages of a project if they depend entirely on the results of 
research you are currently conducting?

And if the work is to be performed by people you don’t know, how can you 
estimate effort if you don’t know their skill levels and capacities?

To answer these questions, let’s start with exploring the human side of estimating.

People tend to:
hh Not want to commit themselves when there is uncertainty
hh Work better when they estimate their own work and are involved in setting 

their own deadlines
hh Be overly optimistic about what they can do

It is accepted project management practice that the person who is most familiar 
with the work involved in an activity should make the estimate for that activity. 
In general, this is the person who will actually be doing the work.

Someone who hasn’t performed a task before may naturally be reluctant to 
provide you with an estimate. Estimating is a skill, and the only way to acquire a 
skill is through practice. As a project manager, you should be a mentor for novice 
estimators: coach them through the process of making estimates and make sure 
they check the accuracy of their estimates after the work is done. 

This is not only how your team will improve their estimating skills, it’s also the 
process through which team members increase their sense of ownership of and 
commitment to their work. People are more likely to meet deadlines that they 
set for themselves.

Here are four common problems that you’re likely to encounter in the estimating 
process: 
hh “I can’t predict the future!” from team members
hh “I am always off!” from team members
hh “Can’t you do it?” from executives and sales representatives
hh “What is the date you’ll be done?” from project managers

Team members often have difficulty coming up with estimates, particularly if 
they are new to estimating or to the types of tasks to which they’re assigned. 

As an experienced project manager, why not just supply the estimate yourself? 
Do this and if a task is late, you’re likely to hear: “I never told you I’d have it done 
by that date; you came up with that yourself!” You really want to get estimates 
from your team members; they have to “own” them and then own up to them.

Ask your team members to provide a range of estimates rather than a single 
estimate. Get three estimates: a most likely estimate, a pessimistic estimate, and 
an optimistic estimate.

The Human 
Tendencies in 
Estimating

“I Can’t Predict the 
Future!”
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hh The most likely estimate is the estimate that has a high probability of being 
accurate, given normal circumstances. Questions to solicit good “most 
likely” estimates might be: “What is the expected estimate?” or “To feel 
confident that you can accomplish the task, how long would it take you?”

hh The pessimistic estimate answers the question, “How long would it take if 
more than the usual number of things went wrong?” Make sure your team 
understands that this is not the same as a worst case estimate. If you ask for 
a worst case estimate, people will tend to consider extreme and extremely 
unlikely situations (e.g., natural disasters). 

hh The third estimate is an optimistic estimate: “If many things go smoothly, 
how long would it take you?” or “What would be an aggressive estimate?”

Asking for more than one estimate gives you a better idea of what to expect. It 
forces the estimator to think about the assumptions he or she is making and to 
evaluate risks and uncertainties. It also helps you determine how much buffer 
you may want to apply to the duration estimate. Best of all, range estimates are 
much easier for people to make, particularly when you deal with people who 
want to get it right. A three-point estimate also allows you to do a PERT analysis, 
or apply a Monte Carlo simulation to the schedule. A three-point estimate 
formula is as follows: (Optimistic + Most likely *4 + Pessimistic)/6 

The three-point estimate is not automatically calculated by Project 2013; 
however, you can use custom fields and create this formula if you desire (custom 
fields and formulas will be discussed in Chapter 11).

And finally, make it clear that you are not looking for a guarantee, just a good 
sense of how much time and effort will be required under different conditions. 

Remember that estimates are not actuals. If a target date is not quite met, forgive 
the estimator and help her learn for the future by finding out why it wasn’t met. 
Making errors is human, but not learning from them is truly regrettable.

People are optimistic or pessimistic by nature, and this can greatly affect their 
estimating. Many estimating gurus have found that in general estimators tend to 
be more optimistic than pessimistic. 

You may gain a rough insight into people’s tendencies by studying their track 
records from previous projects. You can get a quick impression if you look in 
the Actual Work field and compare it to the Baseline Work field of a finished 
project. (Since the numbers are aggregated from all of the team member’s tasks, 
the more confidence you can have in the data they provide.)

While this analysis may give you an idea about a person’s estimating accuracy, 
the key to improving that accuracy is to find out what assumptions the person is 
making and what other causes of variance there might be. 

“I Am Always Off!”
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A pattern of inaccuracy often indicates that the estimator is making unconscious 
assumptions that are consistently wrong. What are the assumptions? What are 
the habitual behaviors that cause the variance?

People tend to be consistent in their tendency toward optimistic or pessimistic 
estimates until they see the reasons for their errors. Once you have learned the 
tendencies of your team members, you can look into making sure that they are 
aware of the assumptions they are using to arrive at their estimates.

We have seen organizations get stuck in scheduling a project when they use 
estimates produced by people other than the people who do the work. Examples 
of people who tend to produce these “estimates” are:

hh Executives and upper management: “Can’t you do it in two weeks?”
Project managers know the stress that occurs when executives impose their 
“estimates” on a project. You’re put in a double bind position: you are in 
trouble if you do commit to their estimates and in trouble if you don’t.

hh Estimates from executives should really be treated as targets, not as 
estimates. It is possible to enter these as deadlines in Project 2013 and then 
create a detailed schedule. If you sincerely feel the work cannot be done 
in the timeframe requested, report this back to the executive. With your 
detailed schedule in hand, you’ll be able to make a clearer, stronger case for 
more rational deadlines. In short, push back and negotiate.

hh Sales representatives: “The client gets what she wants.”
Project managers know the disastrous effects that occur when salespeople 
present their own “estimates” to a client without consulting you. You 
cannot win in such a situation. These “estimates” are not estimates; they 
are commitments to please the client and win a sale, often at the project 
manager’s and the team’s expense.

hh “PIT” estimating teams. Some larger companies have something like a 
“PIT” Team, or a “Project Initiation Team”. These teams create all of the 
estimates for projects in the corporation and then hand them off to the 
project manager. Sometimes, they don’t even know the team members or 
complexities of the tasks involved. Yet the project manager is expected to 
follow these estimates and deliver the project on time, usually without input. 

Estimates from executives or salespeople or estimating teams are often based 
on factors that are external to the project work, like client demands and market 
conditions. Realistic estimates, on the other hand, are based on the work 
required to deliver the deliverables.

As a project manager, you must manage expectations by bringing to light 
assumptions, resource availability, scope, work effort requirements, risk, and 
other factors. Negotiate both ways: downward to assure that team member 

“Can’t You Do It?”
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estimates are realistic and upward to make sure that demands and expectations 
are rational.

Some project managers habitually ask for dates from their team members and 
then enter these into their schedule. There are two problems with this practice:

hh You should not enter dates into a Project 2013 schedule when using auto-
scheduled mode. As we’ll see, if you do, you lose an enormous part of the 
power of Project 2013 to support dynamic scheduling. You might as well 
create your schedule on paper or in a spreadsheet; doing so would produce 
the same unresponsive, static schedule.

hh Dates are the most difficult estimates you can ask for. They require people 
to accurately recall and factor in their entire to-do list, the dates of their 
other tasks, dates promised to other project managers, the hours they 
will be working, co-worker availability, co-worker efficiency, personal 
commitments, personal vacations, national holidays and more.

We recommend that instead of asking for start or finish date estimates on auto-
scheduled tasks, you ask the simpler questions: How much effort is required 
to complete this task or what is its expected duration? Techniques to estimate 
duration include but are not limited to: expert judgement, parametric estimating, 
analogous estimating, three-point estimating, bottom-up estimating (breaking 
the work down to a next level of detail). 

There are any number of unknowns that can make estimating difficult. You may 
need to apply special project management techniques like stage-gate project 
management, the rolling wave approach, and risk management.1

When you have yet to find the new location in an office relocation project, it is 
hard to estimate how long it will take to remodel it. Will it require a quick touch 
up or a complete overhaul?

Rolling Wave 
Planning Window

One approach for dealing with 
this kind of uncertainty is to start 
with a high-level “safe estimate” 
and provide detailed estimates 
later when more information is 
available. A safe estimate is one 
that is expressed as a range with a 
pessimistic estimate that is highly 
likely not to be exceeded. This 
clearly communicates the 

1 Risk management is not fully covered in this book. Please refer to risk literature or courses  
(see www.iil.com).

“On What Date 
Will You Be 
Done?”

The Unknowns

Unknown Events: 
The Rolling Wave 
Approach
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uncertainty of the situation. Points in the range are associated with assumptions 
that define different scenarios.

In this example, at the beginning of your project you might enter just one line 
item for the remodeling in the work breakdown structure (WBS) and include an 
uncertain but safe estimate. Once you have an idea which remodeling activities 
the new location actually needs, you could then start adding detail in the WBS, 
fleshing it out as the project proceeds.

This is called the rolling wave approach: you don’t detail the plan until you have a 
good idea of what to expect. You cast the plan for the project as a whole at a high 
level of the WBS, with a wide range of possible outcomes. You then do a detailed 
estimate and schedule for the next set of work (it might be a phase). Based on 
its outcome, you estimate the next phase and reassess the total project estimate. 
The general expectation is that the estimate range will be narrowed as you get 
closer to the end of the project.

A key concept for using the rolling wave technique is the planning window: a 
look-ahead window of a certain time period. In a project of one year, you might 
use a planning window of three months. As time goes by, the planning window 
moves ahead and as soon as a deliverable falls within the planning window, you 
break it down into more detailed tasks. In a one-year project you might typically 
monitor this every month and add detail to the WBS at the start of every month.

The rolling wave technique is useful for handling unknown events that are far in 
the future. It can keep you from having to redo large portions of the WBS that 
were uncertain. Instead the WBS is extended. 

You can even apply the 1% – 10% rule described in Chapter 3 when working 
with rolling wave planning to find the right level of detail for both the detail 
schedule and the high-level schedule. You take between 1% and 10% of the 
planning window period to find the right level of detail for the detailed schedule. 
And you take between 1% and 10% of the total project duration to find the right 
level of detail for the high-level schedule of deliverables.

During the planning phase it is often unclear whether enough resources will be 
available, who those resources will be, and whether they’ll be available when 
needed.

Despite these uncertainties, you still need to make assumptions for planning 
purposes: otherwise, you can’t develop a schedule. One common assumption 
project managers make is that resources will be available when they are needed. 
Of course, it is a good idea to discuss your resource needs with the resource 
manager, HR, or your executives as a reality check on this assumption. Make 
the assumption loud, clear, and explicit in the project plan, so no one’s lack of 
memory will come back to haunt you.

Unknown 
Resources
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If you don’t know the names of your team members, enter them in terms of 
their roles. For example, instead of “Illeana”, you simply enter “Purchasing 
Manager.” This allows you to make your estimates and enter resources as well 
as assignments. You can now produce a detailed schedule. Once you know the 
names of the individuals, there are simple techniques to update your schedule 
to reflect this. 

Entering a role instead of an individual’s name is an example of a generic 
resource. Generic resources are placeholders for specifically named resources. 
In Project 2013 you can define generic resources on the resource sheet by setting 
the field Generic to Yes. Although setting the field is not required, this allows 
you to generate views that display accumulated workload estimates which could 
be useful in staffing decisions. If you anticipate replacing the role with a specific 
resource name, we recommend you list generics that represent individuals 
instead of representing consolidated resources which are more difficult to 
replace. 

Earlier we said that it is best to have the performer make the estimate. That is not 
always possible and if estimates are made before resources have been assigned, 
the estimates should be reviewed and accepted by the performer.

Even if you know who will be doing a particular job, you may not know much 
about that person’s experience or skill levels. This creates a challenge for 
estimating because as the project manager you should look not only at the job 
but also at who will do the job, since this has a significant impact on estimates 
and your schedule.

Learning curve theory states that the time needed for performing a task will 
decrease with each repetition until it reaches an optimum pace. Learning curves 
are considerations both in estimating and in making resource assignments.

Because each project is by definition unique, some say that the effect of the 
learning curve in projects is limited. Still, learning plays an important role: 
because each project is new, participants have to be willing to learn.

Research and development projects along with product development projects 
are prime examples of when learning plays a key role. There are some repetitive 
tasks in all projects, for example preparing status reports and time sheets and 
performing quality control. And in some projects, there is a lot of repetition. 
In an implementation project the same system might be installed in multiple 
locations.

Together, the amount of learning and the lack of repetition in projects imply 
that resources hired on projects should be very fast learners. The ability to learn 
quickly is perhaps the most important characteristic of good project resources.

Unknown 
Experience 
and Skill Level

Unknown 
Learning Curves

J. Ross Publishing; All Rights Reserved



Chapter 4: Entering Estimates

165

4

Fast learners (B and C in the illustration on the left) have a learning curve that 
has a steep slope down. The second time they repeat something, the time needed 
goes down fast. Fast learners can also end 
up with a faster time per deliverable after 
many repetitions than slow learners 
(compare the horizontal dotted lines for 
A and B). However, it is not a given that 
the fastest time possible per deliverable is 
eventually lower for fast learners. To see 
this, compare the horizontal lines for B 
and C. 

Because of the lack of repetition in projects, the initial learning rate seems to 
be more important than the eventual fastest time per unit for most projects. 
We therefore recommend you that you try to retain people with a C learning 
curve—fast learners—for your projects. We also recommend that you manage 
the knowledge in your environment to enable the slower learners to be more 
productive more quickly.

An exception is implementation projects where there are many repetitions of 
the same activities (e.g., installing software in a number of locations). Here you 
probably want resources who have learning curve B instead of C, because B 
resources will eventually be the fastest, whereas C learners may become bored 
by frequent repetition.

So remember, look not only at the job, but also at who will do the job in order 
to produce a good estimate. How much repetition does the job have? Is the 
resource a slow or a fast learner? How can you maximize the learning by mixing 
fast and slow learners on an implementation team? You may have to make some 
assumptions about the learning rates of your resources. Make these assumptions 
explicit in your project plan. Otherwise you may end up with a slow learner (and 
be blamed for late delivery). In addition, if you don’t document how you arrived 
at your estimates, you won’t be able to learn from the discrepancies between 
your original plan and actual execution.

As we’ve seen, there are many unknowns in projects: events, resources, 
experience and skill levels, and learning curves. A common way to deal with 
these unknowns is to make assumptions and treat the project plan as a living 
document. An assumption is something you treat as true just for estimating 
purposes.

We urge you to document the assumptions on which you base your estimates: 
if any of your assumptions change, you have a more supportable position for 
revising your estimate.

A

B
C

0 1 2 3 4 5 6 7 8 9

Time Needed

Number of  Times Done

Living 
Document 
Approach
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With the living document approach your detailed project plan is not finished 
and final until the project is closed. The project plan “lives”: you keep reviewing 
your assumptions and refining your task list, estimates, and assignments during 
the entire project life. Rolling wave is one example of how the living document 
approach can be implemented.

Note that most often, the high-level project plan does not change in a living 
document approach; the scope and quality requirements, the major deadlines, 
and the budget may not change at all. The baseline may not change either. 
Changes in the high-level project plan only happen through a formal approval 
process that typically involves your executives and clients. In the living document 
approach, changes happen at the lower levels of detail.

Plan at a high level and later expand the estimate (rolling wave). For example, 
enter a manually scheduled summary task and an estimate for the summary until 
you are able to elaborate on the details. As the project continues, you can review 
the duration considering the detail tasks against the duration you have initially 
estimated for the manually scheduled summary task.

Pure work time is working 100% of your time with 100% focus on the project 
task. Pure work time is 100% productive time without interruptions.

Gross work time includes time spent on things other than project tasks. 

It’s your job as project manager to make sure your team understands whether 
you want them to provide estimates expressed in pure work time or gross work 
time. Particularly if work is to be billed to a client, it has to be very clear what 
should and shouldn’t be included in estimates.

People spend their time at work on three basic types of activities:

hh Project tasks (pure work time for project planning purposes)

hh Non-project, but work-related tasks, for example:
h` Operational tasks
h` Answering e-mails and phone calls that don’t pertain to the project
h` Blogging on the company website
h` Company meetings (for example, on employee benefits)
h` Professional development training (not project-related)
h` Providing emotional or technical support for colleagues
h` Introducing and training new staff
h` Changing into the company uniform
h` Troubleshooting and answering support calls (helpdesk)
h` Debugging released versions of software applications (hot fixes, service 

packs)

Pure Work Time 
or Gross Work 
Time?
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hh Non work-related activities (personal time), for example:

h` Private telephone calls
h` Chats with colleagues and other passers-by
h` Daydreaming
h` Visits to the washroom, water fountain, coffee pot, and fridge
h` Updating social networking sites
h` Celebratory lunches for colleagues
h` Sick leave
h` Vacation days (this is a special case that can be captured separately in 

Project 2013 on the resource calendar)

All the listed items are included in gross work time. At IIL, our course participants 
tell us that only about 70% of gross work time is spent on project work (pure 
work time), although this percentage can vary significantly from industry to 
industry. If you don’t take the difference between gross and pure work time 
into account, you’ll underestimate the time needed to complete tasks and your 
projects will always be late. Therefore, it is important that you incorporate gross 
work time in your project schedule.

In addition, it is also important to understand the availability of each resource 
to work on a project, considering other projects, vacation, and non-Project 
work which could include Administration (i.e., Training, Company Meetings), 
Maintenance, and Support. 

For gross working time, estimates should be entered in the schedule with gross 
working hours (typically 8:00 AM – 5:00 PM).

For pure work time working hours correspond to a shorter working day, for 
example, 8:00 AM –3:00 PM.

Let’s say your normal workday has 8 hours. If you estimate that the productive 
hours are 70% of the hours worked, the working hours should be 70% * 8h = 
5.6 hours, rounded to 5.5 hours (68.75%). Working hours that correspond to 
this are, for example, 9:00 AM – 12:00 PM and 1:00 PM – 3:30 PM. We prefer 
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that you set working hours like these on the Project Calendar. You can set other 
working times, as long as the total number of hours adds up to 5.5.

It is important that:

hh All team members estimate consistently in either pure work time or gross 
work time; you cannot use a mix of the two.

hh Every estimator has the same understanding of what a “gross working 
time estimate” or “pure working time estimate” means. For example, some 
organizations include non-project, work-related time in “pure” working 
time estimates, though most exclude it. 

hh Whatever basis the team uses for estimates is also used for time sheets of 
actual hours. Otherwise, you can’t compare your estimates to actuals.

hh You consider whether you want the costs in your project to be calculated 
based upon pure work estimates or gross work estimates. The cost of pure 
work estimates may be lower than you want to report, since personal time is 
typically included in cost estimates to clients or executives. If you use pure 
work estimates, you may need to apply a multiplication factor to correct for 
this.

Of the thousands of schedules we’ve evaluated, an estimated 80% used gross 
working time estimates and gross working times on the Project Calendar. 
Particularly if you use your schedule for developing cost estimates, it is important 
to use the gross working time system. However, if your team members have a 
large portion of non-project work (like operations, maintenance, and technical 
support), gross estimates may be too rough from a cost perspective. In that case, 
you may want to exclude these from the gross estimates and include the rest of 
the non-project work factors. Effort on the excluded tasks is tracked outside of 
the project and team members bill only time spent on included work. 

Whenever you get or give a date forecast, ask questions like these to help 
determine the accuracy of the estimate:

hh Is this estimate based on 100% fully focused work time or does it include the 
normal workday interruptions like e-mail and voice mail?

hh Do you have other ongoing responsibilities that will take time as well, 
like providing technical support, help-desk duties, troubleshooting, other 
projects, attending meetings, or training?

hh Do you have any personal commitments or other work commitments that 
will take time out of your workday?

hh Are there any gaps where you will have to wait for other tasks to deliver 
results you need?
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hh Is the effort estimate accurate?

hh What are the unknowns and risks that might impact the ability to deliver?

Standardize your schedule on either pure or gross work time and ask your team 
to provide a specific type of estimate. This ensures a consistent schedule.

Project 2013 is set up by default to receive gross work time estimates based on 8 
hours for a full workday, because the default working times are 8:00 AM – 12:00 
PM and 1:00 PM – 5:00 PM.2 If everybody estimates in gross work time based 
on 8 hours per day, you don’t have to change the default settings in Project 2013; 
in any other case, you do have to make changes.

If you want to work with pure work time estimates, you have to do one of the 
following:

hh You can adjust the working times for everybody in the Project Calendar 
by choosing Change Working Time on the Project tab. Here you simply 
shorten the working times. For example, if you believe that your resources 
are productive on project work for 75% of the day, you could change the 
working times to reflect 75% of an 8 hour day or 6 hours. This could be 
entered on the Project Calendar as: 9AM – 12PM and 1PM – 4PM. 

hh Another solution is to decrease everybody’s availability from 100% to less 
than 100%. If you have found that people are productive 75% of their work 
time, you have to enter this as their availability in the Max Units field in 
the Resource Sheet (refer to Chapter 7 for a discussion on setting resource 
availability).

Before we discuss techniques for entering estimates, it’s important to cover a 
sometimes controversial issue that arises on almost every project: the appropriate 
use of buffers.

For purposes of this discussion, we’ll define buffers as additional time added 
to the project schedule to allow for unforeseen events. It’s generally accepted 
project management practice that project managers who are responsible for 
meeting hard deadlines include a buffer in their projects in order to mitigate risk. 
Buffers are not padding or artificial and hidden inflation of estimates. Questions 
sometimes arise about whether and how these buffers should be communicated 
to project stakeholders; that is the focus of the following discussion.

Performance measurement involves not only the quality of the project’s 
performance with respect to the plan, but also the quality of the planning itself. 
Both the baseline and the performance relative to the baseline are products of 
the project manager. For example, if a project manager deliberately pads his 

2 Times are for the English USA version of Project 2013. Other international versions may have different 
default standard working times.

Buffers

Measure Planning 
and Performance?

J. Ross Publishing; All Rights Reserved



170

Dynamic Scheduling® with Microsoft® Project 2013

schedule by 50% and then boasts that he delivered his project in 30% less time, 
is this good performance or poor planning? We think the latter.

Executives can’t measure performance by itself; they need to measure the quality 
of the planning as well. Executives need to be involved in the planning process to 
make sure they have a solid grasp of the project’s baseline. With a good baseline, 
an executive can delegate the execution phase and measure the project’s real 
performance with confidence.

When you optimize a schedule, you may find you have a healthy amount of time 
as a buffer to accomplish the deadline. This buffer helps compensate for risk. 
How to display the buffer can be a difficult choice. If you show the buffer, you 
may lose it. If you hide the buffer, you enter into a game of secrecy, and you 
may have to do double bookkeeping with your schedule. We recommend you 
consider the following:

hh What is the dominant pulling force in the project?
Is the project driven by time, cost, quality, or availability of resources? If 
time is the dominant force, everybody will be scrutinizing your schedule 
to find time. The more people who look for it, the less the chance you will 
succeed in keeping any buffer hidden. 

hh How mature is upper management in terms of project management?
Does management accept that as the project manager, you should own 
a buffer to meet the hard deadlines? It is generally accepted project 
management practice that project managers who are responsible for 
meeting hard deadlines own a buffer in their projects. However, upper 
management may not understand that the buffer is there as a legitimate 
assist for managing risk and may wish to remove it.

hh If you are performing work for an external client, what type of contract do 
you have?
If you have a time and materials contract, the client will likely be looking 
over your shoulder and you won’t need a buffer at all. If the contract is a firm 
fixed price contract, you may need a buffer that you discuss with the client 
in terms of mitigating risks.

We strongly support clearly showing buffers and educating everyone in what they 
mean and why they are important. The following are methods that have been 
used to hide buffers. Most of them are the opposite of the optimizing methods 
that will be discussed in Chapter 9. They are ranked in order of ascending 
sophistication. The likelihood that a buffer will stay hidden from examining eyes 
increases as you move down the list:

Eliminate Hidden 
Time Buffers

Methods That 
Have Been Used 
To Hide Buffers
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1. Overestimating lags
Lags are gaps between task bars of dependent tasks. They model waiting time 
that is out of your control, as when you are waiting to receive a construction 
permit. Some prefer to estimate these lags on the (very) safe side. However, 
they can easily be noticed in the Gantt Chart. This method is cost neutral.

2. Inserting extra holidays in the Project Calendar
You can insert extra common holidays in the Project Calendar. The task bars 
that span these days will simply stretch. This can be noticed in the Gantt 
Chart by sharp analysts. This method is cost neutral.

3. Decreasing the working hours in the Project Calendar
Resources are not focused and productive throughout an 8 hour workday. 
In the Project Calendar, start the business day later or finish it earlier. This 
may make the calendar inconsistent with the Hours per day setting in the 
Project Options dialog box. Durations may start to show decimals and will 
be obvious. This method is cost neutral.

4. Ignoring the benefits of learning curves
If you have repetitive activities in your schedule, you will likely benefit from 
a decreased learning time with every repetition. Your estimate should be 
lower with every repeated action. If you ignore this effect of the learning 
curve you are in fact keeping a buffer in your schedule. The cost of the 
project will be overstated with this method.

5. Introducing ramp-up and wind-down factors
If your resources are involved in more than one project at a time, your 
resources will be less productive because of setting up and closing down 
work when moving from project to project. You can include this time in 
your estimates, which will also affect the cost. 

6. Introducing distraction factors for high-focus tasks
Certain tasks require full focus, but the world around will not stop spinning. 
Writing a report or a book is a situation in which most people need to 
concentrate fully and need consecutive, uninterrupted time. 

7. Introducing extra revision cycles
Every revision cycle has two tasks: revise and modify. For writing, you could 
add tasks like edit and rewrite. You might even get away with another cycle of 
re-edit and re-re-write, but you may want to call it something else. Inserting 
extra revision cycles increases the cost as well, but could have a positive 
impact on quality.

8. Keeping maximum units of resources low
In a resource-constrained schedule you can influence the forecasted project 
end date by changing the availability of resources (Max Units). If you are 
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not entirely sure how many you will receive, you can create a time buffer in 
your schedule if you keep the maximum units on the low and safe side. This 
will only affect the duration of the project, not the cost.

9. Assigning one scarce expert to more tasks than needed
If an expert is in great demand, he will likely drive the project finish date. 
If you assign him to more tasks than strictly needed, he will drive out the 
forecasted finish date even further, thus creating a time buffer for you. It is 
hard to argue with using the best resource on many tasks. If the expert is 
paid at a higher rate than other resources, you are also increasing the cost.

10. Creating extra inconspicuous tasks
One project manager confided that she adds the task Find alternative 
resources in the task list wherever it is appropriate. Others that are hard to 
argue with are Apply quality check or Update the project plan. These extra 
tasks increase the cost as well.

11. Padding the duration and work estimates
As one project manager once put it, “To pad or not to pad” is similar to the 
Shakespearian “To be or not to be.” However, if you start padding, you are 
entering into a culture of secrecy. Padding also increases cost. 

12. Not using overtime yet
If you know you can count on your resources working some overtime, don’t 
enter it into the schedule during the planning phase. Whenever your team 
members work a weekend, the 2 days will be pure gain. Be careful with this 
method if you pay a higher rate for overtime, since the planned cost of the 
project may be understated because it is based on regular rates. You may gain 
time but run over budget. Also, be aware of the impact on the team member 
who works too many overtime hours. This can affect quality, morale, and 
ultimately have negative impacts on time and cost.

13. Setting extra soft dependencies
Soft dependencies are dependencies that are not absolutely needed, but can 
be defended with an argument such as: “We prefer to do it this way, because 
it has the following advantage ...” and you rationalize away. This method is 
cost neutral.

14. Being pessimistic about material delivery dates
When you are dependent upon receiving a shipment before you can do your 
work, you can create a delivery milestone on a date later than the date you 
were promised by the supplier. In this way you create some buffer on the 
performance of others on whom you depend. Now you face a new dilemma: 
Will you tell your supplier? This method is cost neutral.
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15. Inserting extra holidays for your critical resources
Determine who the most critical resources are in your schedule and insert 
extra holidays in their resource calendars. This cannot be easily seen in 
the Gantt Chart and is a very sophisticated way of hiding buffer time. This 
method is cost neutral.

As you may have noticed, all these methods boil down to not fully optimizing 
your schedule. In our opinion you should not hide your buffers. Hiding buffers 
tends to obscure when resources will actually be needed and obscures the true 
return on investment in the project. We acknowledge that the practice takes 
place and we have discussed some of the methods employed. That said, let’s 
move forward with our suggestions and reasons for making buffers visible.

As we’ve stated, we strongly recommend that you keep the buffer you own 
visible in your schedule. There are several reasons for this:

hh It is the professional thing to do, because it is generally accepted project 
management practice that when upper management asks project managers 
to commit to hard deadlines, project managers are allowed to own time 
buffers.

hh Hiding time buffers from executives creates a culture of secrecy in projects.
If the different levels of management stop communicating openly with each 
other, the situation worsens over time. Ideally, the time and money buffers 
should be on the table instead of under it. If a project manager habitually 
hides time buffers and an executive happens to find out, the executive may 
start cutting time off future schedules. In turn, the project manager will then 
hide bigger buffers in harder to find places. The executive may start slashing 
the schedules more, making arbitrary cuts. The situation deteriorates in a 
downward spiral. As consultants, we have witnessed organizations that 
continuously play this game instead of conducting projects in an open and 
professional manner. If you think you can defend the buffer in your project 
successfully, we recommend you do that. Openness is greatly preferred over 
a culture of secrecy that can create a vicious downward spiral.

hh Your team members will follow your example as the project manager and 
start hiding their buffers from you. If you pad your schedule estimates, your 
team will almost certainly follow your lead and start padding the estimates 
and time sheets they give you. Like it or not, you are leading by example. 
This will make it impossible to come out ahead of schedule and, at best, 
you will finish on time. More likely, you will finish a little late every time, 
which is typical for a culture of secrecy that may have developed slowly over 
a long period within your organization. From a statistical point of view, it 
is abnormal if your projects always run a bit late. Statistically, it is normal 
if several projects run over and several under, some much over and some 

Why You Should 
Make Buffers 
Visible

J. Ross Publishing; All Rights Reserved



174

Dynamic Scheduling® with Microsoft® Project 2013

much under. This is typical for a healthy organization where a culture of 
openness and integrity reigns.

hh If project managers hide time or money buffers, their organizations never 
get clarity on the true return on investment, true profit margins, and true 
time-to-market gains. It’s important to know how much you contributed as 
a project manager to the bottom line. That would be a point to talk about 
during your performance appraisal.

There are several ways for project managers who want to be professionally 
responsible to defend buffers that are explicitly visible in the schedule:

hh First make sure that you understand the appropriate use of buffers as 
referenced in the PMBOK Guide – Fifth Edition, page 178. 

hh Then make sure that your executives understand what buffers are for and 
why they’re needed. Talk to them about the uncertainty and risks (both 
known and unknown) that are a part of every project, and the setting aside 
of time reserves for protection. 

hh Draw a parallel between financial and time reserves: monetary budgets have 
financial reserves as a generally accepted budgeting practice. Why can’t 
schedules have time reserves?

hh Create a separate line item for the time buffer in the task list instead of leaving 
it as an undefined, gaping hole in your schedule. You can assign yourself as 
the resource, so it becomes clear to everybody that you own it (this also 
adds a buffer of effort and cost). Make sure this line item is dependent on 
the last tasks. Set the project end milestone as its sole successor.

hh Name the time buffer line item Time Contingency Reserve—a technical term 
that may lend weight to the idea that this is a formal item which may prove 
less likely to be questioned.

hh Split a large buffer into smaller ones that you then spread across your 
schedule. Visually, this will look more acceptable and it also allows you to 
tie the buffers to areas that are prone to more risk where they are needed to 
protect the project’s delivery date.

hh Use a Monte Carlo simulation to demonstrate that you need a reasonable 
time buffer. You can use simulation to create a probability curve of project 
end dates. When you have the curve, you can decide which probability 
you feel comfortable with and find out what buffered end date results. 
This indicates how much time you need as a buffer. Or you can ask upper 
management with what level of confidence they feel comfortable and quote 
the corresponding date from the S-curve. You then add the buffer as a line 
item that makes the schedule extend to this date.

Defending Visible 
Buffers
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hh If executives still try to cut your time buffer, you may respond in a number 
of ways. One way is simply to recognize that you have been open and honest 
about the risks and now your role is to do the best you can to manage your 
project to a successful completion.

Getting started with estimating can be difficult when you are not able to gather 
all the information necessary to generate a valid estimate for a task. In this 
situation, you should create an unscheduled activity. This is done by switching 
the task mode to manually scheduled. In the Task Mode column of the desired 
task, simply select manually scheduled from the list. Next, enter the task name 
in the field Name and a note in the field Duration. For example, tbd or Ask Amit.
You could also create an unscheduled activity by entering a note in the Start or 
Finish fields. 

Manually scheduled tasks display a push pin in the Task Mode column. If the 
task is missing either the duration, start, or finish information, you will see a 
push pin with a question mark in the Task Mode column. 

The note you left in the duration field will provide a reminder to you that further 
planning will be required. Notice the task mode is set to manually scheduled. 
Both bottom-up and top-down planning support unscheduled activities. Top- 
down planning lets you create a summary task along with a series of indented 
detail tasks, and then lets you provide a note in the summary task duration to 
indicate that perhaps your proposed project phase might be 10 weeks even 
through you have only entered the details to tasks within that phase for the first 
2 weeks.

An unscheduled task or manually scheduled task is not driven by the scheduling 
engine. 

When using the rolling wave approach to planning your schedule, create 
unscheduled tasks to represent activities that will occur in the future and are 
difficult to plan until after the planning window has moved forward. 

To switch the task mode back to auto scheduled, in the Task Mode column of 
the desired task, simply select Auto Scheduled from the list. Notice the fields 
where you entered notes are reset to default values. 

Duration is the number of units of calendar time (e.g., business days) it will take 
to complete a task. Work effort is the number of resource units (e.g., person 
days) it will take to complete a task.

Entering 
Estimates in 
Project 2013
Entering Activities 
with Incomplete 
Estimates

Duration and Work 
Effort

J. Ross Publishing; All Rights Reserved



176

Dynamic Scheduling® with Microsoft® Project 2013

Here’s an example of the difference between duration and work effort: If you 
have 3 carpenters working for 2 business days, the duration is 2 business days, 
and the work effort is 6 person days (3 carpenters x 2 business days).

As the project manager, you will most likely know either the duration estimate 
or the work estimate. You can make your estimates in terms of the duration of 
a task or the work effort required to perform a task. The duration is based upon 
the time for the task, which may include other factors like non-project work. The 
work effort is based solely on the deliverable and does not include non-project 
work. 

Task duration is typically expressed in business hours or in business days. 

You enter a duration estimate in the field Duration. The default time unit for 
duration is days. By default, a business day has 8 hours in Project 2013, but 
you can change this on the File tab, in the Backstage view, click on Options, 
Schedule. 

Assuming the default of 8 hours per day, to enter a duration of five days (1 week), 
you could type any of the following:
hh 5 days
hh 5d
hh 5
hh 1w

Notice that while Project 2013 displays durations as elapsed time (calendar 
days) and not as business days, it will help you if you think of the duration as 
the number of business days (to distinguish them from calendar or elapsed days, 
which we’ll cover below).

Assigning a duration to a summary task will change the task mode to manual 
when it is auto scheduled. Instead, Project 2013 will calculate this based on the 
duration of its detail tasks. For example, suppose a summary task has two detail 
tasks scheduled in parallel. One task has a duration of 5 days, the other 8 days. 
The summary task would indicate a duration of 8 days—the duration of the 
longer task because the other is being performed at the same time.

In the Project Calendar you can find which days are working days and which are 
non-working days. Project 2013 uses the business days provided in the duration 
column to determine the finish dates on auto-scheduled tasks and to create the 
Gantt bars for these tasks. 

Duration or 
Business Day 
Estimates 
Entered in the 
Duration Field
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Work is the amount of effort applied directly to the task. It may also be referred 
to as person hours, or person days as it represents one person working full-time 
for one hour or one day. For example, if you have to write 20 pages of text and 
it takes you 2 hours per page, the total work or effort is 20 * 2 = 40 hours. This 
would also be the number of person hours because you are working on the task 
yourself. If you have help to perform this task (from someone working at the 
same pace), so that each of you would only have to write 10 pages, the total work 
would still be 40 hours because each person would be spending 20 hours on  
his/her section of the task.

When we estimate the amount of Work, we are estimating the effort it would 
take one person to complete the task while working fulltime. 

You enter a work effort estimate in the task-related field Work in Project 2013. 
(Refer to Preparing the Gantt Chart for instructions on how to insert the Work 
field later in this chapter.) The default time unit of the Work field is Hours. To 
enter effort of 16 hours on a task, you could type:

hh 16 hours
hh 16h
hh 16
hh 2d (Project 2013 will convert 2d into the default time unit of hours).

Project 2013 displays work estimates in the Work field as hours and not as 
person hours. 

Person hour estimates are needed to calculate the cost of the project. Each person 
hour applied needs to be multiplied by the appropriate rate to arrive at the cost.

Another key concept to understand is the calendar day. Calendar days are the 
number of consecutive days or 24-hour periods, which could include Saturdays, 
Sundays, or nonworking days. For example, if paint dries in 2 days, the number 
of calendar days is 2. The number of calendar days needed is not dependent on 
the working times, since paint dries during the night and weekend as well.

Calendar days are also known in Project 2013 as elapsed days. Project 2013 does 
not have a field that corresponds to elapsed days; however, you can easily modify 
the Duration field to indicate elapsed days.

A working day has 8 hours for most of us, whereas an elapsed day has 24 hours 
and may be either a working or nonworking day. 

Work Effort or 
Person Day 
Estimates Entered 
in the Work Field

Calendar Days: 
Elapsed Time
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Examples where elapsed days are important include backing up a computer 
system or the drying of paint. At 
food companies, new products 
are shelved for months in order 
to test food preservation 
procedures. These months are 
elapsed months: they continue 
24 hours a day and 7 days a 
week.

If you want to enter an elapsed 
duration in the Duration field, you have to specify the time unit as follows:

Time unit Enter normally as
Enter in  
elapsed time as

Minutes m em

Hours h eh

Days d ed

Weeks w ew

Months mo emo

Instead of typing in “5d” to get 5 days, you have to enter “5ed” to get 5 elapsed 
days, which would always represent 5 consecutive days on the calendar.

In Chapter 6 you’ll learn that you can create Task Calendars for tasks that need 
to operate on a different schedule from your Project Calendar. However, we 
recommend that you use elapsed duration instead of creating a new calendar for 
a task that operates on a continuous basis through holidays and weekends, 24 
hours a day. It’s easier to create and very visible to others who view the schedule.

A separate issue is whether estimates should include waiting time, e.g., time spent 
waiting to receive a permit or approval. Many people include waiting times in 
their duration estimates. We recommend entering them as lags on dependencies 
(covered in Chapter 5) or as separate tasks instead. 

Project 2013 uses the formula: Duration * Units = Work.
hh Duration is how many business days you have to finish the job
hh Units are how many resource units will do the work
hh Work is how many person hours or days it will take

It’s crucial to understand that you only have to enter two of these three variables. 
The formula is meant to make your life easier: when you provide two of three 
variables in the formula, Project 2013 will calculate the third one for you. 
However, if you are not aware of this formula, you can’t predict how Project 

Business Days Elapsed Days
S M T W T F S

0:00 0:00

8:00

17:00

24:00 24:00

S M T W T F S

Duration * Units 
= Work  
(D*U=W)

J. Ross Publishing; All Rights Reserved



Chapter 4: Entering Estimates

179

4

2013 will behave, and your life will be not easier, but more difficult (refer to 
Chapter 8 for a thorough discussion of these concepts).

Enter either a duration or work estimate for a task, not both when tasks are auto 
scheduled. Entering both interferes with Project 2013’s ability to calculate a 
third variable once resources are assigned.

What you estimate first is entirely up to you, but will typically depend on the task 
and the situation. If you first estimate the duration, you have a Fixed Duration 
task. This is quite common. In any situation you will have to estimate the first 
variable, decide on the second and let Project 2013 calculate the third. The result 
is that you will know the date the task will be done. For a detailed explanation of 
how Project 2013 calculates variables, refer to Chapter 8 where we introduce the 
concept of units when we talk about assigning resources. 

On the next pages we will discuss Fixed Work tasks and Fixed Duration tasks. 
The Fixed Units tasks are less common when planning a project, (you tend to 
know more about the duration or work of a task, rather than who is going to 
work on it), and we will postpone discussion of those. You need Fixed Units 
mostly when you make changes to assignments as we will see when we discuss 
resource assignments.

If you don’t intend to enter resources and assignments, but would like to see 
Gantt bars for each task, you will have to estimate the durations for all tasks since 
Project 2013 needs durations to create the Gantt Chart! 

Let’s assume you want to repaint the interior of your house. You wonder on what 
date you could be done painting; how many calendar days will this project take?

To begin by simply estimating the number of calendar days is a difficult process, 
so you start with estimating the number of business days (workdays) the job will 
take. Once you know the number of business days and on which day of the week 
you will start, you can convert the business days into actual days on the calendar.

Estimating in business days, however, may be difficult as well, because you may 
not know how many resources will be available. You take another step back 
and decide to focus on an effort estimate in person days. To estimate the effort 
(work), you realize you must look at parameters like the difference between the 
old and new color, the number of coats needed, area to be painted, and what you 
will do with the wallpaper. After you have decided all of those factors, you figure 
it will take, let’s say, 10 person days (see the next illustration).

An Estimating 
Example
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Parameters

Organizations’
Resources

Calendar
Days (CD)

Resources

10 PD

5 BD
5-7 CD

Ted  5 PD
Sue  5 PD

painting:
wallpaper? 
area?
color difference?
number of  coats?

Person
Days (PD)

Business
Days (BD)

You still can’t say how many 
business days this requires, 
because you have no firm 
commitments from family 
members or friends to help you. 
You ask around, and you find 
that your significant other is 
willing to help and that you are 
going to share the workload. 

Each of you will contribute 5 person days of effort, so the 10 person days of 
effort can be delivered by 2 people in 5 business days. But, will it? Will there be 
extra time and effort because two people are working on the job? Will they 
argue, play, or chat? Will there be upfront planning of who does what? While 
each of these variables could be a factor, for the sake of this example let’s say it is 
5 business days.

If you start on Monday and you decide not to work on the weekend, you can have 
your house painted by Friday (5 business days and 5 calendar days). However, if 
you start on Tuesday, you will be done on Monday of the next week (5 business 
days, but 7 calendar days). You now know what you wanted to know: the project 
end date.

The last conversion from business days to calendar days is elegantly taken care 
of by Project 2013. Once you have filled in the Project Calendar, you can count 
on the eager and rapid cooperation of Project 2013. The challenge in estimating 
with Project 2013 lies in solving the puzzle of person days, resource units, and 
business days. We will present a process for solving this puzzle.

Eventually, Project 2013 needs to know the start date and the finish date of a 
task in order to fit it into the time line. To get to those dates, it needs to find 
out the number of calendar days 
a job will take, as shown in the 
illustration. You will find it too 
difficult to estimate the number 
of calendar days. You will 
immediately get bogged down 
with questions like: When will 
we start this task? If we start it on 
a Monday, it will take two calendar 
days, but if we start on a Friday, it will take four calendar days! You don’t want 

A Process 
for Estimating

Person
Days (PD)

Business
Days (BD)

Resources

Fixed Work Fixed
Duration

Fixed Units

Calendar
Days (CD)

Parameters

Organizations’
Resources

Estimating: 
Types of Tasks
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to deal with those issues at this point. You should instead try to estimate the 
number of business days and have Project 2013 do the conversion from business 
days to calendar days for you. The software does an excellent job here once you 
have filled in the Project Calendar.

In some situations, it is possible to estimate the number of business days 
(or business hours) directly, for example for tasks like meeting, training, and 
presentation. For a meeting you set the duration to, let’s say, two business hours. 
Activities like these do not shorten in duration when you add more resources to 
them; these are Fixed Duration tasks.

For many other tasks, it is impossible to estimate the number of business days 
without knowing how much effort it will take and how many resources are 
available to do the work. You have to step back in the process and estimate the 
amount of effort first in person hours or person days. Project 2013 calls effort 
“Work.”

In order to estimate work (effort), you may find that you have to look at the 
parameters of the job. Each industry has its own metrics to refine the estimates 
of a job; this is known as parametric estimating, for example:

hh The construction industry has quantity surveyors; they can tell exactly how 
much a brick wall will cost given the square footage and choice of brick.

hh The software industry works with function points. Once software estimators 
know the number of function points of an application to be built, they 
can calculate their estimates. Dividing the function point total by 150 
approximates the number of analysts, programmers, and technicians they 
will need.

For each job there are relevant parameters to consider. You may have to ask the 
client to provide some of these; others come as a result of design work. With the 
parameters known it may be possible to compute the estimate by multiplying 
the number of units by a per unit effort estimate. For when there is no algorithm, 
or for more refined estimates, bottom-up, expert, and analogous estimating are 
used. 

Once you have determined the amount of work, you have to decide how many 
resources will be assigned to the job. After that you can usually determine how 
many business days the task will take (duration). 
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Before you enter estimates, it’s important to be aware of how Project 2013 
treats them. On the File tab, in the Backstage view, click Options. The Project 
Options dialog box appears. We recommend you set or accept the following 
options to alter Project 2013’s behavior.

Project 
Options

Recommended Choices

Schedule Set the Options on the Schedule tab:
Duration is entered in:
Choose the unit (e.g., days, hours) that fits the majority of your inputs. 
Project 2013 will use this as the default time unit for the Duration 
field. 
With the default duration time unit set to days, you can type in 5 
instead of 5d to get 5 days in the duration fields. 

Work is entered in:
Choose the unit (e.g., days, hours) that fits the majority of your inputs. 
Project 2013 will use this as the default time unit for the Work field.

It’s important to note that the Work field, unlike the Duration field, 
will convert entries to the default time unit according to the hours per 
day value.

Default task type:
Most people enter the duration immediately, and Project 2013 should 
not change it unless required. If you normally enter duration estimates 
rather than work (effort) estimates, we recommend setting the Default 
Task Type to Fixed Duration.

New Tasks are effort driven
When turned on, this option can divide work based on the number 
of resources assigned; we recommend you turn it off when setting up 
your schedule. (Effort driven is discussed in greater detail in Chapter 
8.) 

Show that scheduled tasks have estimated durations 
When turned on, the task will add a question mark to the durations 
that you did not enter yourself.

New scheduled tasks have estimated durations will add a question 
mark to the durations of new tasks you may create.

Scheduling Options for this project: All New Projects 
Sets the options under this heading as the default settings for any new 
schedules you create. Any existing schedules are not affected because 
these options are stored in the project schedules. To change the 
scheduling options for an existing schedule, make sure it is open first 
and then choose it from the Scheduling Options for this project: 
drop-down list. 

Choosing 
the Options
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Project 
Options

Recommended Choices

Advanced Set the Options on the Advanced tab:
Allow cell drag and drop 
This allows you to move or copy the selected cells, rows, or columns 
by dragging. 

Under the heading Display options for this project: you will find 
options for these items: 
Minutes, Hours, Days, Weeks, Months, and Years
This allows you to change the way time units are labeled in your 
project or all new projects. The shorter you make the label, the more 
space you save, so you may want to set them to the shortest label. 

It’s a good idea to make sure the duration time unit is different than the work 
time unit (for example, use days for duration and hours for work). This makes it 
easier to avoid confusion (particularly in phone discussions).

Make sure the Effort Driven field is displayed when working with task types on 
a task-by-task basis. The effort driven flag may not turn off when switching from 
fixed work to fixed duration and you may not get the results you were looking 
for.

If you are not 100% sure of your duration estimate, you can mark it as an 
“estimated duration” by adding a question mark “?” to the duration entry. For 
example, enter “3 day?” in the duration field if you are not entirely sure of the 
3-day estimate and plan to re-visit it shortly. 

In its default settings, Project 2013 will fill in “1 day?” for the duration of newly 
created, auto-scheduled tasks. Durations displayed with a question mark are 
referred to as “estimated durations” by Project 2013. This is a reminder to 
you that you have estimated the duration and plan to come back with a more 
confident estimate, i.e., you have not filled in the duration; instead it has been 
filled in automatically for you. 

To remove the question mark symbol for an individual task, simply double-click 
the task. The Task Information dialog box appears. On the General tab, clear 
the Estimated option. 

If you type over the duration value with a new value, the question mark will also 
disappear. 

This is a useful option if you only supply duration estimates in your project. But 
on the other-hand, if you supply a duration estimate for some tasks and a work 

Estimated 
Durations  
in Project 2013
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estimate for other tasks, you may wish to disable the “estimated duration” option 
since there is no similar option for the work field. Refer to the section Choosing 
the Options above for more information. 

 

In order to use the Gantt Chart to enter estimates, we suggest you customize the 
Entry table to make the data entry process more efficient. 

Let’s prepare the Gantt Chart so we have the right fields to enter our estimates. 
The illustration above shows which fields we will insert. We recommend you 
insert them in the order shown. You typically have to insert the fields Type, 
Effort Driven, and Work into the Entry table.

For now we need the following fields in the Entry table:
hh ID: Generated automatically 
hh Indicators: Generated automatically
hh Task Mode: To switch between manually scheduled or auto scheduled 

mode for a task. Some fields such as Type or Effort driven will not be 
editable while the task is in manually schedule mode

hh Task Name: Note that the database name of this field is simply Name. You 
can see this if you double-click on the column heading

hh Type: By setting the right task type, you tell Project 2013 to leave the 
estimate you entered alone. For example, if you estimate that a task will take 
10 person days, you enter 10 days or 80 hours in the Work field and you set 
the task type to Fixed Work

hh Effort Driven: By including this field, you can easily switch it to “Yes” or 
“No” 

hh Duration: To enter the duration for Fixed Duration tasks
hh Work: To enter the effort for Fixed Work tasks

If you have the default Entry table displayed, you need to insert the fields Type, 
Effort Driven, and Work:

1. On the Task tab, in the View group, click Gantt Chart. 

Preparing the 
Gantt Chart
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2. Right-click on the Duration column heading and click Insert Column; the 
list of available fields/columns appears.

3. Select from the list Type. If you type the first characters of the field name, 
you will get to it more quickly; the list is very long. 

4. Repeat steps 2 and 3 to insert the columns Effort Driven and Work.

5. You are now ready to enter duration and work estimates.

We recommend that you also hide the start and finish columns to avoid  
accidental entry in these columns.

1. Right-click on the Start column heading and select Hide Column.

2. Right-click on the Finish column heading and select Hide Column.

A fixed duration task is a task where the duration doesn’t change if you change 
the number of resources assigned to it or the working hours of those resources. 
Examples of fixed duration tasks might be status meetings, training, backing up 
computer systems, or drying paint. Tasks tend to have a fixed duration when 
you assign many resources to them (a meeting, training) or none (backing up a 
computer system, drying of paint).

Person
Days (PD)

Meeting of  1 Day

Resources

We can 
only send 
5 people

We can only 
spend 5 PDs

It will take 10 PDs

10 people 
will attend

For Fixed Duration tasks, enter the 
duration first. A task such as a 
meeting is a prime example of a 
fixed duration task, because you 
decide the duration up front (it is 
more a matter of deciding than of 
estimating). Then you can decide 
who you will invite to the meeting 
and assign them as resources 

(counterclockwise arrows in illustration). Once you have assigned the number 
of resource units, Project 2013 will calculate the total amount of work.

Sometimes you know the maximum number of person hours you are willing 
to spend in the meeting and you enter it as work (clockwise arrows in the 
illustration). In this case Project 2013 will calculate the number of resources 
needed (refer to Chapter 8 for a discussion about providing multiple pieces of 
information and related calculations).

1. Enter the name of the task in the field Task Name.

2. Press the Tab key; the cursor moves to the field Type. (If you press the 
Enter key, the cursor will move down to the next task.)

3. Select from the task Type field list, Fixed Duration, and press the Tab key.

Entering a 
Duration Estimate 
for Fixed Duration 
Tasks

J. Ross Publishing; All Rights Reserved



186

Dynamic Scheduling® with Microsoft® Project 2013

4. Change Effort Driven to No (if you didn’t switch the default to No in 
Project Options.) and press the Tab key to move to the Duration field.

5. Enter in the Duration field, the number of business days you estimate the 
task will take. This will override the default duration of 1 day? that Project 
2013 had entered. You only need to enter the number and Project 2013 
will append days. If you want to display a different time unit, for example 
hours, you have to type the time unit abbreviation as well (e.g., 2h). Valid 
abbreviations for the time units are: m for minutes, h for hours, d for days, 
w for weeks and mo for months. Notice the m for minutes versus the mo for 
months.

6. Press the Enter key and then the Home key to position the cursor for the 
next task.

When a task is set to Fixed Duration, Project 2013 will keep the value in the 
Duration field constant while applying the scheduling formula.

A fixed work task is one where the amount of effort is only dependent upon the 
parameters of the job, i.e., the technical specifications of the finished work, and 
not dependent upon the number of resources that you assign or the working 
times (calendars). For example, it might take 100 hours to create a specific 
design, regardless of whether you have one or more people working on it.

the paint job 
takes 10 PDs

Business 
Days (BD)

Resources

There are 2 
resources 
available

It has to be 
done in 4 BDs

It will take 5 BD

You need 
2.5 resources

As in the house painting example, 
once you determine the amount 
of work, often your next step will 
be to establish how many 
resources will do the job 
(clockwise arrows in the 
illustration). When you know the 
work and the number of resource 

units, Project 2013 will derive the number of business days (duration).

Once you know the amount of work (10 person days), you can potentially know 
in how many business days it needs to be done (counterclockwise arrows in 
the illustration). Let’s say you have only 4 business days for the task (duration). 
From this, Project 2013 can derive for you the number of resources you need 
(2.5). Keep in mind that the algorithm used to calculate the number of resources 
may not take into consideration overhead or other factors that might change the 
effort estimate when resources are increased or decreased. You may have to adjust 
by changing the task to a fixed duration task (refer to Chapter 8 for a discussion 
about providing multiple pieces of information and related calculations).

1. Enter the name of the task in the field Task Name.

2. Press the Tab key; the cursor moves to the field Type. 

Entering a Work 
Estimate for Fixed 
Work Tasks
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3. Select the task type Fixed Work. Press the Tab key repeatedly to reach the 
Work field. The field Effort Driven is set to Yes and cannot be changed for 
Fixed Work tasks.

4. Enter in the Work field the number of person hours you estimate the 
task will take. You only need to enter the number and Project 2013 will 
append “hrs”. If you want a different time unit, for example weeks, add the 
appropriate abbreviation: m for minutes, h for hours, d for days, w for weeks 
and mo for months. Notice the m for minutes versus the mo for months.

5. Review the parameters of the job, if needed. Press the Enter key and then 
the Home key to position the cursor for the next task.

If you started with the wrong default task type, you can change all existing tasks 
at once by clicking on a column heading to select all tasks and clicking Task 
Information on the Tasks tab. Choose the Advanced tab, select the type you 
want from the Task type list, and select the check box for the Effort Driven 
option as required. If you want to turn off Effort Driven, make sure it is clear, not 
shaded. Click the box again if it is shaded (the check box has three states when 
multiple tasks are selected: on, off, and shaded for some on, others off). Click 
OK.

When a task is set to Fixed Work, Project 2013 will keep the value in the Work 
field constant when Project 2013 applies the scheduling formula.
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As you enter tasks in the Gantt Chart view, you’ll see durations appear as bars 
in the timescale. As you enter your estimates the bars will adjust to reflect the 
duration of the task. Each category of task has a different task bar style. (Bar style 
formatting is discussed in Chapter 11). 

hh Summary task bar 
A summary task bar has small shapes (pentagons by default) at its start 
and end points. The summary task bar summarizes all its detail tasks and 
milestones: it starts when its first detail task starts and it ends when its last 
detail task or milestone ends for auto-scheduled tasks.

By default, summary tasks are auto scheduled and are represented by the bars 
described above. However, with Project 2013, you can change the task mode 
for summary tasks so that they are manually scheduled. This creates a manual 
summary rollup which is shown by a thin bar directly under the usual summary 
bar. The thin rollup bar extends or shortens depending on the earliest start and 
latest finish of the detailed sub tasks, and will be red as a warning sign if there is 
some conflict between the manual duration and the summary rollup duration.

Task Bars
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hh Detail task bar
A detail task bar is shown as a bar which represents its estimated duration. 
For auto-scheduled tasks, the bar is solid with rounded edges. If the task is 
manually scheduled, the shape of the bar reflects the known information 
provided: if only Duration is entered, the semi-transparent bar is shown; 
if a Start and Finish Date is also provided, the ends of the bar are shown as 
closed solid corners. 

hh Milestone diamond
A milestone appears as a diamond. 

Milestones typically have zero days duration; however, Project 2013 will 
allow you to set the Milestone flag for any task regardless of the duration 
(using the Mark as Milestone option in the Task Information dialog box). 
These tasks are also shown in the Gantt Chart as diamonds. 

hh Split task bars
A split task bar has multiple parts connected by dots. The work on a split 
task bar is scheduled to be interrupted and resumed at a later date.

Even though the feature is called split “task,” it is truly the bar that is split 
into multiple pieces, not the task itself. While the task remains on one line 
with the bar, the bar is split into multiple pieces visible on the Gantt Chart.

hh Recurring task bars
Recurring task bars represent tasks that have multiple parts that occur at 
regular intervals throughout the project, as described below. They are set up 
in Project 2013 as summary tasks with detail tasks indented beneath. 

In Chapter 3 we discussed summary tasks, detail tasks, and milestones. Two 
additional task types come into play when we consider task durations: split tasks 
and recurring tasks.

Some tasks need to be split into multiple time periods. For example, when 
electricians wire a building, they have to come back to install the switch plates 
after the inspection. Or perhaps a resource has to interrupt work on a task to 
attend a one-day meeting. Splits are often not planned, but occur during project 
execution.

We discourage you from splitting tasks during the planning phase, since splits 
typically need frequent rescheduling and increase your schedule maintenance. 

As we’ll see in the next chapter you also can’t set dependencies on the start or 
finish of a split to move it when the split task moves; doing so will increase the 
time you spend on schedule maintenance as well.

Split and 
Recurring Tasks

Split Tasks
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Instead of splitting task bars when you are planning your project, we recommend 
that you try to divide the task into multiple components and schedule each 
separately. 

For example, instead of having a single task for the electricians wiring our 
building, simply split it into two tasks: pull cables and install switch plates. Now set 
dependencies on these smaller tasks. You can set a dependency from the activity 
inspect electric wiring to install switch plates task, and you have a fully dynamic 
model (as described in Chapter 5). 

Where you must have a split task, you can add a second task bar to an existing 
one. You do this by drawing a second bar in the timescale to the right or to the 
left (but not before the project start date) of the existing task bar. Just click, hold 
down, and drag to where you want the second part of the task bar.

To split an existing task bar into two parts:

1. Click Split Task on the Task tab; a pop-up window appears with a different 
mouse pointer.

2. Point to a task bar and click and drag the split part to where you want the 
split to start. The new start and finish dates of this part appear in the pop-up 
window when you release the mouse: 

3. Drop it where you want it by releasing the mouse button; the task bar is now 
split into two parts. Notice that the two parts are connected by dots: 

To remove a split, just drag the right-most part of the bar to the left and reconnect 
it to its original bar part. If you have split it multiple times and you want to 
reconnect the parts, just keep doing this.

We recommend using recurring tasks for scheduling things you do regularly 
such as team status meetings, schedule updates, change request reviews, and 
status reports.

Recurring tasks are in fact summary tasks with detail tasks indented beneath. 

Recurring  
Tasks
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Choose the Task tab, in the insert group, click Task down-arrow; and select 
Recurring Task…; Recurring Task Information dialog appears:

 

1. Type the name in the Task Name field.

2. Type the duration for a single occurrence of the task in the Duration field 
or use the Updown button to change the duration with pre-set increments.

3. Under Recurrence Pattern select the interval at which the task recurs. The 
dialog will change and present appropriate choices for the selected interval.

4. Under Range of recurrence choose the period or the number of 
occurrences. Click OK.

Some remarks about recurring tasks:

hh Notice that the duration of the recurring summary task encompasses the 
entire period of its detail tasks for auto-scheduled tasks.

hh Project 2013 sets constraints on each recurring detail task that will keep 
it on its dates in the timescale. Even though we recommend against using 
constraints in schedules (described in Chapter 6), there is nothing wrong 
with constraints on recurring detail tasks. They are a legitimate exception to 
the rule. Recurring detail tasks are typically not hooked up into the network 
of dependencies, and only scheduling constraints will keep them on the 
proper dates.

hh If one occurrence accidentally falls on a non-work day (as entered in the 
Project Calendar), Project 2013 will ask you what to do with it: drop it or 
move it to the next business day.

hh You can set dependencies for recurring tasks, although in practice, we have 
found that project managers normally don’t.
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hh Assigning resources to recurring tasks is okay, but Project 2013 will not level 
recurring tasks by default! (described in Chapter 9).

To mark a task as a milestone, on the Task tab click Information; choose 
the Advanced tab and then check Mark task as milestone. However, if the 
task you’ve marked as a milestone has a duration, although Project 2013 will 
change the regular detail task bar into a diamond and shrink the task bar from 
10 days to a 0 day diamond in the timescale, it keeps the 10 day duration in the 
spreadsheet. This means that when dependencies stem from the task, it looks 
like there is a gap between the milestone task and its linked task(s). 

To avoid this we recommend that your milestone tasks have an estimated 
duration of 0. 

Entering estimates can be a tedious job. Here are some ways to speed up estimate 
entry.

Several of the following techniques rely on using Project 2013’s drag and drop 
feature. After your task list is finalized, you may want to disable drag and drop to 
avoid accidentally moving one task name on top of another. Do this by choosing 
the File tab; Backstage view appears. Choose Project Options; and select 
Advanced. Under the Edit heading, clear Allow Cell Drag and Drop.

1. Select the tasks by clicking on the first task, holding down the Control key 
and clicking on the next ones until they are all selected.

2. Click View Information on the Task tab, Properties group

OR

Hold down the Shift and key press the F2 key; the Multiple Task 
Information dialog appears: 

Milestone 
Durations

Copying and 
Moving Data to 
Speed up  
the Entry  
of Estimates

Editing Fields for 
Multiple Tasks
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3. Make the changes needed on each tab. 

4. Click OK. The changes will be applied to all of the tasks you selected.

You can use the Multiple Task Information dialog for many purposes, 
including:

hh Setting the duration of all milestones to zero on the tab General and clearing 
Estimated to make the question mark disappear.

hh Changing the task type—for example from Fixed Duration to Fixed 
Work—on the Advanced tab in the field Task type. This shows up in the 
field Type in the spreadsheet.

hh Assigning or adding a resource to multiple tasks on the tab Resources.

You use the fill down feature to duplicate the same value in multiple adjacent or 
nonadjacent cells. 

1. Enter the value you want to copy in the top cell of the area you’re going to 
fill.

2. Click and hold down on the top cell and drag down over all adjacent cells 
you want to fill.

OR

Hold down the Shift key and press the down-arrow key to select all cells 
you wish to fill. 

OR

Copying with Fill 
Down
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Hold down the Control key and click on all nonadjacent cells to fill with 
the value.

3. Choose Task tab, Editing group, select from the list Fill and then click 
Down.

OR

Hold down the Control + D key.

You can use the fill down feature for various reasons including:

hh Changing the constraint types for many tasks. To get rid of constraints, fill 
As Soon As Possible in the field Constraint Type.

hh Setting the Level Assignments field for all detail recurring tasks to Yes to 
include them in the workload leveling.

hh In the resource sheet you can fill down the department (field Group) for 
your resources.

You use the fill handle feature to duplicate the same value in multiple adjacent 
cells.

1. Enter the value you wish to fill in the top or the bottom cell of the area to 
be filled.

2. Make sure you have the cell selected: at the bottom right of the cell you will 
see a fill handle:

 

3. Point to the fill handle; watch the mouse pointer: 

Copying Values 
Using the Fill 
Handle
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4. When you see a crosshair mouse pointer, click and hold down, and then 
drag over the cells to be filled.

You can even enter a pattern of values in some cells: select the cells that define 
the pattern and drag the fill handle. Project 2013 will copy and repeat this same 
pattern as many times as you drag up or down. (Project 2013 does not work like 
Excel in this regard: Excel will increment values in the pattern, not repeat the 
same pattern.)

Project 2013 will prevent you from copying or moving data to incompatible 
cells. For example, you can’t copy dates into the duration field.

1. Select the cells you want to copy and point to the border of the selected 
area. Make sure the mouse pointer changes from a plus sign to a four arrow 
pointer.

2. Hold down Control key and drag the cells to their place.

You can’t use copy and paste to copy one cell and paste it into many other cells 
like you can in Excel. Project 2013 will only paste the value into the first cell of 
a copy-to range.

1. Select the cells and point to the border of the selected area. Make sure the 
mouse pointer changes from a plus sign to a four arrow pointer.

2. Click and drag the cells to their new place.

The Delete key clears the content from a cell. When you press the Delete key 
in the task name column, a smart tag of an “x” will appear to ask if you want to 
delete the entire task. 

OR

Select the cells (not the row heading or ID column—as this is a locked first 
column), right-click, and click Clear Contents from the short-cut menu. 

Properly clear a cell by pressing the delete key which will reset the value in the 
cell to its default. Warning: do not type in the default value. If you manually type 

Copying, 
Moving, or 
Clearing Cells

Copying Cells

Moving Cells

Clearing Cells
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in a value—even if it is the same as the default value—you impose a restriction 
on that cell that impacts calculations.

Select one or more rows to delete by selecting the rows first and then pressing 
the Delete key. 

Select multiple adjacent tasks by dragging over their row headings. Select non-
adjacent tasks by holding down the Control key then clicking on tasks.

1. Select the column by clicking on its column heading.

Be sure to release the mouse button before doing the next step to indicate that 
you are done selecting columns.

2. Point the mouse on the selected column and click and drag to move it to its 
new location. Notice the T shape to help you position the column. 

1. Select the column by clicking on its column heading.

2. Click Copy on the Task tab in the Clipboard group, or right-click, and then 
click Copy from the short-cut menu.

3. Select the column into which you want to paste the data.

4. Click Paste on the Task tab or right-click and then click Paste.

Click the ID number and then follow the same process as described above when 
copying or moving cells. 

Copy or move an entire row by clicking the task ID number. This ensures that all 
data associated with the task gets copied with it.

1. Open the project you want to copy from.

2. Select the tasks or resources by dragging over their ID numbers (the very 
first column) to select entire tasks or resources.

OR

Select non-adjacent tasks or resources by holding down the Control key 
and clicking on the ID-number of each task or resource.

3. Click Copy on the Task tab in the Clipboard group, or right-click and then 
click Copy from the short-cut menu.

4. The data is now temporarily stored in the clipboard.

5. Open the project into which you want to copy.

6. Select the row before which you want to insert the data and click Paste on 
the Task tab in the Clipboard group, or right-click and then click Paste 
from the short-cut menu.

Clearing Rows

Moving a Column

Copying a  
Column

Copying or Moving 
a Row

Copying  
Between  
Projects
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The steps are the same as the previous steps, except that you select cells instead 
of entire rows. If you do this, you have to be careful to paste the data into a blank 
area of the sheet; otherwise existing line items may be overridden. Choose 
Undo on the Quick Access toolbar if an accident occurs.

Objects are views, reports, calendars and other things that change the  
appearance of the data or affect the scheduling. You copy objects between 
projects using the Organizer.

If necessary, open the project that contains the object(s) you want to copy from 
and the project that you intend to copy to. 

1. On the File tab, choose the Backstage view. Then choose Info, and click on 
the Organizer; the Organizer dialog appears: 

2. Click on the tab for the type of object you want to transfer.

3. From the lists at the bottom of the dialog select the schedule from which to 
copy the object and the schedule to copy to.

4. Select the object and click Copy from Right to copy from left to right or 
Copy from Left to copy from right to left.

5. Click Close or Cancel when done.

The organizer allows you to copy objects to other project schedules or to the 
global template Global.mpt. Any objects you put into the global template are 
visible in all your projects, unless they have the same name as other objects that 
are part of a particular project schedule.

With the organizer you can, for example:
hh Make your Project Calendar available to other project managers

Copying Cells 
Between  
Projects

Copying Objects 
Between Projects
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hh Create a standard report and make it available to colleagues
hh Share views, tables, and filters

 If you want to duplicate an entire project, open the project file you want to copy 
and then choose File tab; Backstage view appears. Choose Save As and save it 
under a different name.

If you try to duplicate a project by simply copying all of the project’s rows and 
pasting then into a new schedule, you’ll lose all the settings stored in Project 
Options.

Once you’ve gathered initial estimates, you’ll want to perform some reasonability 
checks on them.

hh Are the estimates reasonable given the work that needs to be performed?
You will need some technical expertise and recorded past experience to 
verify if estimates are reasonable. If you don’t have this technical expertise, 
you can:
h` Review the schedules of previous, similar projects
h` Ask team members with technical knowledge to peer review each 

others’ estimates
h` Ask a subject matter expert to review the estimates

hh Did you include manually scheduled tasks for items where you are not able 
to provide a complete estimate?

hh Was the rolling wave approach applied to activities in the future that you are 
only planning at a high level?

hh Did your estimate for each task include a work or duration estimate and did 
you set the appropriate task type and effort-driven settings?

hh Are the estimates that you collected consistent with the working hours 
entered in the Standard (Project Calendar)? For example, if you collected 
pure estimates did you reduce the hours per day to reflect purely productive 
hours per day, such as 5.5 or 6. If they are not consistent the schedule will be 
too long or too short.

hh Do the durations of your estimates fall within the 1% – 10% rule (as 
discussed in Chapter 3 and reviewed below)?

hh Are the completion of deliverables of your project modeled as milestones 
with the number of duration days set to zero. 

hh Did you include buffers to address schedule risk?

Once you have done your estimating and the other steps in the process (including 
assigning resources and setting dependencies), you can find the project duration 
easily by: 

Clicking Project Information on the Project tab and clicking Statistics. 

Copying an  
Entire  
Project

Checking 
Estimates
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OR 

Viewing the Duration field of the project summary task. You can display the 
project summary task by choosing the Project Summary Task check box on the 
Format tab. This task will appear at the top of the list as a task with ID number 0.

In Chapter 3 we covered the 1% – 10% rule: the duration of any detail task 
should be between a minimum of 1% of the project duration (rounded) and 
a maximum of 10% of the project duration (rounded). Note that this rule is a 
guideline.

If you find a task that is longer than 10% of the project, you can split the task into 
multiple subtasks. Or if the assigned resources are working part-time on the task, 
you can increase their commitment to full-time, and the duration will decrease. 
This is more refinement to the WBS, discussed in Chapter 3.

Notice that the 1% – 10% rule should only be applied to the durations and not 
to the work values (effort). If there are many part-time assignments or many 
multiple assignments per task, the boundaries for work estimates should be 
narrower or wider than for the duration. In general, the minimum and maximum 
values for work are harder to indicate, which is why we stayed away from that.
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1. Why is estimating the duration of project activities difficult?

2. You are the project manager. While working with your team members on 
task estimates, someone makes one of the following statements. What 
would you say?

Statement Your response
Your team member says:
“I can’t give you an estimate because I can’t 
predict the future!”

Your team member says:
“Listen, we went over this already. I’m 
not going to give you any more estimates 
because my estimates are always off! My 
estimates don’t help you anyway!”

Your executive says: 
“You are one of our most experienced and 
best project managers. Can’t you do this 
project in three weeks?”

3. In your own words, what is the difference between Duration and Work?

4. What formula is working behind the screens of Project 2013 that relates 
Duration to Work?

5. What is the difference between a pure work time estimate and a gross work 
time estimate?

6. Somebody gives you an estimate of 100 person hours of effort for a task and 
says that the estimate assumes uninterrupted and fully focused work time. 
You just created a new project schedule that has all options set to the default 
settings in Project 2013.

What other fields or dialog boxes would you have to change in order to get 
a valid finish date forecast for this task from Project 2013?

In which field would you enter this estimate in Project 2013?

7. What are manually scheduled tasks? How can these be used in the rolling 
wave approach for estimating when some information is unavailable for 
future activities. 

For experience working with the features you’ve learned about in this chapter, 
we strongly suggest that you do the additional exercises for this chapter that are 
included in Case Studies appendix, available to download in the WAV Download 
Resource Center at www.jrosspub.com.

Review 
Questions

Additional Practice
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Chapter 5: Entering Dependencies

We have the tasks and the estimates entered into our project schedule and are 
ready to enter the dependencies. Dependencies are relationships between tasks.

After reading this chapter you will be able to:

hh Describe what dependencies are and why they are important for dynamic 
schedules

hh Enter dependencies into a Project 2013 schedule
hh Choose the right type of dependency
hh Determine if you need a lag or lead on a dependency, expressed in absolute 

or relative terms
hh Set multiple predecessors or successors on a task
hh Apply best practices for the network logic in project schedules
hh Apply dependencies to integrate manually scheduled tasks in your network 
hh Review the impact to changes in the network with the new Task Path feature
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Ship Building Project
 1. Gather all parts
 2. Move parts from warehouse to pier
 3. Assemble boat
 4. Launch boat

Oops... I think I forgot Step 2!

“Dynamic scheduling” isn’t just a fancy marketing term. A dynamic schedule 
is one that can be kept up-to-date easily when you are busy during project 
execution.

Every time a change happens—and changes occur on every project—you need 
to change your schedule. If you have a static model—one where you haven’t 
identified the relationships between tasks—you need to review all future tasks 
every time a change occurs to determine how that one change may impact the 
completion of other tasks. This is a formidable amount of analysis and schedule 
updating to manage for every change throughout the life of your project. 

Instead of a static schedule, you should create a dynamic schedule.

With a dynamic schedule, when one thing changes in your project, you only have 
to change one field in your Project 2013 model and the software will generate 

Dependencies
The Principle 
of Dynamic 
Schedules
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valid forecasts for all impacted tasks. This is the fundamental principle of 
dynamic schedules.

You will only come close to this ideal if your schedule meets the following 
requirements:

hh You find and enter all the relationships between tasks that may impact your 
forecasts. These relationships are called “dependencies”; they are concerned 
with the order in which tasks are done, and are discussed in this chapter.

hh You minimize the number of manually scheduled tasks and hard dates 
in your schedule. Hard dates or fixed dates may also be called schedule 
constraints in Project 2013. We’ll discuss constraints in the next chapter.

The simple truth is that you cannot create a valid schedule without knowing 
which tasks precede which other tasks. Dependency analysis is a MUST. 

If you do an excellent job of defining dependencies, theoretically you don’t even 
need to review the impact of a change on future tasks. Of course, in the practical 
world of complex projects, we use the tool as an aid but we always verify the end 
product.

The good news is that network logic—the logical dependencies between tasks—
tends to stay the same during the entire project. So if you define the network 
logic well once during the planning phase, you’ll be rewarded with a minimum 
of maintenance during the hectic days of project execution.

In Project 2013 there is the ability to choose between auto-scheduled and 
manually scheduled tasks. While this book is dedicated to the art of dynamic 
scheduling, there are situations in which creating a static schedule with manually 
scheduled tasks is useful. One such case involves schedules where there are 
few, if any, dependencies between tasks. For example, if a company has several 
locations that are independently hosting multiple events and you would like to 
schedule these events showing the dates each will occur. In this case, each event 
is independent of any other event and the addition, deletion, or delaying of an 
event would not affect another event.

In Project 2013, the default scheduling mode for new tasks is manually 
scheduled. In manually scheduled mode the initial dependencies are honored, 
but any changes that affect linked tasks are not calculated immediately. Refer 
to Chapter 4 for information about setting or changing the options for new 
schedules. This default behavior can be changed to Auto Schedule by clicking 
on the File tab, Options, Schedule and under Scheduling Options for this 
project: New tasks created: Auto-Scheduled.

We recommend you set the default option for new tasks to auto-scheduled when 
you are in a phase where you have enough information and detail about the 
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tasks; otherwise we recommend that you leave this default setting to manually 
scheduled. 

Other Options settings that can affect manual or auto scheduling behavior are:

hh Update Manually Scheduled tasks when editing links
hh Keep task on nearest working day when changing to Automatically 

Scheduled mode, and 
hh Selecting Off or On for the Calculate project after each edit radio buttons.

Switching from Manual to Auto scheduling (or vice-versa) can also be 
accomplished on the Task tab. The Respect Links icon serves as a recalculate 
button for your tasks with manually scheduled mode, or when the scheduling 
mode is set to manual.

As a reminder, the advantage of dynamically scheduling your project is primarily 
one of being able to respond to changes and updates that occur in the schedule. 
The project manager is responsible for keeping the project plan up-to-date and 
realistic. A dynamic schedule allows Project 2013 to minimize the work required 
and to give stakeholders the ability to assess risks and impacts. For example, edit 
one task, and all the dependent tasks are automatically updated. This feature can 
prevent you from missing a critical update and makes forecasting future impacts 
much easier and more time effective.

Note that when using the manual scheduling mode for a task, you cannot change 
the constraint type. By default, the constraint stays As Soon As Possible.
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A dependency is a relationship between the start or finish of one task and the 
start or finish of another. With each dependency we need to define which task is 
driving the other.

Write

Print

Prepare for Exam

Take Exam

F

S

FS Dependency

SF Dependency

Predecessor

Successor

Successor

Predecessor

In the first example in the 
illustration, once writing is 
finished, printing is to begin. The 
task Write (predecessor) is 
driving the dependent task Print 
(successor) to begin. By defining 
a Finish-to-Start or FS 
dependency between the two 
tasks, when the finish date of 

Write changes, the start date of Print must move with it. 

It’s important to understand that the predecessor does not always come first 
chronologically. In the second illustrated example, the completion date of 
Prepare for Exam is driven by the start date of Take Exam. This means that if 
the start date for Take Exam changes, the finish date of Prepare for Exam must 
also change. This is a Start-to-Finish or SF dependency. (We’ll discuss types of 
dependencies in more depth later in this chapter.)

So dependencies are relationships. From a scheduling perspective, think of the 
predecessor as the driving task (driver) and of the successor as the dependent or 
driven task (follower).

In order to find the predecessor, ask “Which task drives the scheduling of 
which other tasks?” Then link the tasks to establish the predecessor/successor 
relationship that serves best to model the relationship. 

The whole network of dependencies is also called the network logic. It shows the 
logical relationships among the tasks. 

It’s not necessary to indicate start and end dates when you work with Project 
2013. In fact, we strongly recommend that you not enter start and finish dates, 
unless you want to intentionally 
create schedule constraints or 
manually scheduled tasks. You 
should let Project 2013 drive 
start and end dates based on the 
relationships (dependencies) 
you define between the tasks 
and the task durations.

In the illustration, the duration of the third task was extended, and all the 
dependent tasks were immediately rescheduled by Project 2013 as a result.

What Are 
Dependencies?

Why Should I Use 
Dependencies?

WBS

Time
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If you didn’t identify the dependencies in Project 2013, you would have to 
review and redo the future portion of the schedule by hand. Too often, early 
in the execution phase of the project as things start to change, the schedule is 
abandoned: the Gantt Chart is dumped in a drawer and never looked at again. 
There are companies that have never been able to keep any of their schedules 
alive during project execution. The linking of dependencies facilitates keeping 
the schedule up-to-date.

The great benefit from a dynamic schedule is the continuously valid forecasts of 
project end date and final cost. Without a dynamic schedule, running alternative 
schedule scenarios during planning and keeping the schedule up to date during 
execution become too tedious and time consuming to continue. 

On the File tab, in the Backstage view click on Options, Schedule. Here are 
the options we recommend for setting dependencies.

Project 
Options

Recommended Choices

Schedule Set the Schedule Options for this Project:
Autolink inserted or moved tasks
With Autolink on, Project 2013 itself will set or break dependencies 
inside a chain of Finish-to-Start dependencies. It assumes that you 
want sequential dependencies for the tasks you inserted or moved 
inside a chain.

Take exam

Inserted Task

Autolink works inside a chain of 
sequentially dependent tasks. If 
you insert a task inside the chain 
as shown in the illustration, 
Project 2013 will immediately 
incorporate it in the chain of 
dependencies. It breaks one 

dependency (the one crossed out) and sets two new ones (the thick blue 
arrows).

If you move a task, it closes the chain by cutting two dependencies and creating 
one new one, and it incorporates the task in the chain of dependencies (cutting 
one dependency and creating two new ones) at the destination.

This is a time saver during planning and we recommend that you turn on 
Autolink inserted or moved tasks when planning your schedule.

Choosing the 
Options
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During project execution you may want to turn off the Autolink inserted 
or moved tasks feature so that when you move around tasks doing “what-if 
scenarios”, the tasks will not automatically link when they are inserted or moved. 
You can then get a clearer analysis of the task. 

You will be using mostly FS-dependencies that run from the finish (F) of the 
driver to the start (S) of the follower. The driver task (predecessor) can be linked 
from its start or from its finish. 
The follower task can be linked to 
its start or to its finish. This gives 
a total of four different 
possibilities and four types of 
dependencies. The dependencies 
are identified by these 
abbreviations: FS, SS, FF, and SF, 
as shown in the illustration.

Here are examples of each type of 
dependency:

hh Finish-to-Start (FS): The finish of the predecessor determines the start of 
the successor.
h` The foundation must be poured before the walls are erected. 
h` A report must be written before it is printed. 

hh Start-to-Start (SS): The start of the predecessor determines the start of the 
successor.
h` When you pour concrete, you want to level it immediately before 

it cures. There is an SS link between the tasks pour concrete and level 
concrete.

h` Two days after the carpenters start to break out old drywalls and put up 
new ones, the electricians can start (SS plus 2 days).

hh Finish-to-Finish (FF): The finish of the predecessor determines the finish 
of the successor.
h` If you train people in using new software, you want the software 

installed just as they return to their workstations. There is an FF link 
between the tasks train users and install application.

h` Two days after the writing is finished, the editing will be finished (FF 
plus 2 days).

hh Start-to-Finish (SF): The start of the predecessor determines the finish of 
the successor.
h` The fixed start date of an exam will force the preparation to end 

(whether or not you are ready!).

Types of 
Dependencies

FS

SS

FF

SF

Finish-to-Start

Start-to-Start

Finish-to-Finish

Start-to-Finish
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h` A newspaper reporter must submit copy before the paper’s deadline or 
the article will not be in tomorrow’s edition.

Sometimes you want to separate a predecessor and successor by a defined 
amount of time. You do this by using lags or leads (negative lags).

FS

FS + 6W

FS - 3W

0 (zero)

Positive

Negative

Sequential Dependency

Waiting Time 
(lag)

Partial Dependency 
(lead)

For example, you apply for a 
building permit (predecessor), 
and estimate that you’ll have to 
wait six weeks from the time 
you apply before you can dig the 
foundation (successor).

To accommodate this, you 
add a lag to the dependency: 
a waiting time between the 
predecessor and the successor. 

In this example, you’d have an FS dependency with a lag of six weeks between 
the tasks apply for permit and dig the foundation, as shown in the first example in 
the illustration.

The lag is expressed in business days just like the duration. Using a lag avoids 
calculating Work during this period (which is what would happen if you simply 
increased the duration of a task) and it always keeps the predecessor and 
successor separated by the amount of lag time you define.

The lag can be negative. A negative lag is called a lead, since the start of the 
successor will be earlier than the finish of the predecessor. In such a partial 
dependency, the follower (successor) is dependent upon the partial completion 
of its predecessor. As a result, the task bars overlap each other in time. For 
example, if you write a report, you might send the first half of the report to an 
editor, and then writing and editing would take place concurrently. This would 
be an FS dependency between write report and edit report with a lead of, say, 
three weeks, as shown in the second illustration.

Project 2013 only has one field called Lag, and you enter leads as negative lags, 
so in this case you would enter FS-3W.

Note that although in the previous illustration lag and lead are shown only on 
the FS dependency they can be applied to all other types of dependencies as 
well.

You can even enter the lag as an elapsed time and Project 2013 will schedule 
the follower accordingly. Elapsed time is 24 * 7 time (elapsed durations are 
scheduled 24 hours a day, 7 days a week, until finished). You can enter an elapsed 
duration lag by entering, for example, “2ed” instead of “2d” in the Lag field. If 
the driver finishes at the end of Friday, a lag of 2ed will cause the FS follower to 

Absolute Lead or 
Lag Time
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start on Monday (weekend days count as elapsed days), whereas 2d will make it 
start on Wednesday (Monday and Tuesday count as business days).

Use lag or lead time to adjust the schedule for reality instead of putting in an 
inaccurate duration estimate.

Put a note on a task that has lag or lead time to explain its purpose.

Use absolute lag/lead time for values that won’t change (fixed value).

You can also express the amount of lead or lag as a percentage of the duration 
of the driver task (predecessor). The follower task is scheduled relative to the 
driver task.

FS + 50%

FS - 50%

Positive

Negative

Waiting Time 
(lag)

Partial Dependency 
(lead)

In the second illustration, we 
have two tasks: write report and 
edit report. After the first half of 
the report is written, we want to 
send it to the editor. We need an 
FS-50% dependency between 
write report and edit report.

With this feature it is possible to have a successor start halfway through the 
duration of the predecessor and to keep it at the halfway mark. It will stay at the 
halfway point even if the duration of the driver task is changed later on.

Use relative lag/lead time when the amount of lead or lag time should adjust 
because of a change in the duration of the predecessor.

As the illustration shows, each task can have more than one predecessor and 
successor. This allows you to schedule several activities concurrently. Tasks that 
do not have a logical relationship 
generally should be scheduled in 
parallel. This creates a network of 
dependencies where some 
parallel tasks or chains of tasks 
will take longer than other 
shorter ones. An example of 
activities that might take place in 
parallel is installing systems at several different sites.

Relative Lead  
or Lag Time

Multiple 
Predecessors and 
Successors
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You may not always be certain about the type of dependency to use. In the 
Prepare for Exam/Take Exam example, whether to use a FS or SF dependency 
depends on the situation that is 
being modeled. If the situation 
allows you to postpone the 
exam when you are not finished 
preparing for it, the FS 
dependency is the best 
alternative because the schedule 
will be adjusted depending on a 
change in the duration of the 
preparation. An example is the 
PMP exam,1 which can be 
postponed if you are not ready to take it.

If you cannot postpone taking the exam, the Start-to-Finish dependency is the 
best choice. The moment an exam starts, the preparation will have to stop. This 
allows you to count backwards in preparing for the exam: What is the latest date 
I have to start preparing for the exam so that everything will be fresh in my memory?

You could argue that when you schedule backwards from the project finish date, 
the SF dependency should be the dependency you use most often. After all, in 
backward scheduling, the finish date drives every task in the project. However, 
Project 2013 does not change the default dependency to SF when you switch to 
backward scheduling. In forward scheduling, you will use the FS dependency 
most often, which is the default in Project 2013.

Ask yourself the following questions, in the order shown, to help you choose the 
right dependency relationship:

1. Which task drives the other? or What do you need in order to do this 
task and where does it come from?
To determine which task is the predecessor, first ask “What do you need 
in order to do this task?” Once you know what is needed, then ask “Where 
does it come from?” and finally, “Which task drives the other task’s dates?” 
Then choose the dependency type that best models the actual situation.

People often ask themselves: “What should be scheduled first or earliest?” 
This question asks for the chronology of tasks, not the dependency. 
Remember, the predecessor task doesn’t always come first: in an SF 
dependency the predecessor task is chronologically later than the successor.

1 PMP® stands for Project Management Professional, an accreditation of the Project Management Institute 
(PMI). See www.pmi.org for more information.

Choosing the 
Right Type of 
Dependency

Write

Print

Prepare for Exam

Take Exam

F

S

FS Dependency

SF Dependency

Predecessor

Successor

Successor

Predecessor

Steps for 
Choosing the 
Right Type of 
Dependency
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2. Does the start or the finish of the predecessor drive the other task?
This tells you whether you need a F or S for the predecessor end of the 
dependency.

3. Does the predecessor drive the start or the finish of the successor?
This tells you whether you need an F or S for the successor end of the 
dependency.

Once you know the answer to questions 2 and 3, you know the type of 
dependency you need: FS, SS, FF, or SF.

4. Should there be a gap or overlap between the two tasks?
If your answer is “no,” you’re ready with this dependency. If the answer is 
“yes,” continue with the next questions.

5. Do you need a positive lag or a negative lag (lead)?
A positive lag delays the successor in time and creates a gap in an FS-
dependency. This is equivalent to adding a buffer to compensate for the 
unknowns that can arise during the project life-cycle. A negative lag (lead) 
schedules the successor earlier in time and creates an overlap in a FS-
dependency.

6. Is the lag an absolute number of days (weeks), or is the lag relative to 
the duration of the predecessor?
h` If absolute, ask: “Should it be in business days or in elapsed days?” 

Enter the number of business days (or weeks) including the time unit, 
for example 5d or 5ed for elapsed days.

h` If relative, enter a percentage in the Lag field, like 50% or -30% 
(including the percent sign).

7. How much should the lag or lead be?
At this point you should know the complete dependency definition, for 
example FS+50%, SS+3d, or FF+2ed.

Often dependencies follow the flow of data, information or deliverables 
(documents) that are passed between team members. For example, the detailed 
design document is passed on from the software architect to the software 
programmer. If you ask your team members to identify what they need from 
other people to do their tasks, you will slowly but surely identify all dependencies 
from the end of the network to the beginning.
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Different situations need different applications of dependencies, including:
hh Decision point dependencies
hh Hard and soft dependencies
hh External dependencies
hh Resource dependencies
hh Dynamic link dependencies

We’ll discuss each of these in more detail.

Decision points (also called gates or checkpoints) are important nodes 
(intersections) in the network of dependencies. If your schedule has decision 
points, you are using gate project management, also known as stage-gate project 
management (stage gates may also be known as phase-gates, quality-gates, toll-
gates, etc.).

Gates are to dependencies as 
central stations are to railroads; 
many tracks come together and 
spring from them, as you can 
see in the illustration. All the 
deliverables that are needed for 
making the right decision are 
drivers (predecessors) for the 
decision point. All activities 
that rely upon the decision 
being made are followers of the 
decision point (dependent successors). What you will see in a schedule with 
decision points is that several sub-networks of dependencies are linked together 
at the decision points.

Tasks with hard or mandatory dependencies (also referred to as logical 
dependencies) have to be done in an absolute sequence, while tasks with soft 
dependencies have a preferred sequence.

In hard dependencies there is a physical requirement that the predecessor 
must drive the successor. For 
example, you physically can’t 
print a report until after the 
writing is finished. The finish of 
Write must precede the start of 
Print. (If you find another way 
to do this, let us know; you’ll 
make the authors really happy.) 
Common sense and knowledge 
of your project tasks dictate when to create these hard dependencies.

Different 
Applications of 
Dependencies

Decision Point 
Dependencies

Go/No-Go

Go/No-Go

Go/No-Go

Hard and Soft 
Dependencies

Write

Print

Install Cabinetry

Lay CarpetLay Carpet

Hard

Soft
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Soft or discretionary dependencies are a matter of preference. For example, the 
two tasks Installing Cabinetry and Lay Carpet are not necessarily dependent on 
each other. The project manager may prefer to set a dependency to make sure 
that the cabinetmakers do not spill glue that damages the new carpet. However, 
if he’s in a time crunch, he could save time by doing both tasks in parallel. 

There is no hard or soft dependency “setting” in Project 2013, but it’s important 
to distinguish between the two so that you can quickly distinguish between 
tasks you may be able to shift (soft dependencies) and tasks you can’t shift (hard 
dependencies).

Note which tasks have soft dependencies for easy optimization later. If you 
remember where you created the soft dependencies, it will be easier to optimize 
the schedule later on. Because Project 2013 doesn’t distinguish between hard 
and soft dependencies, it is a good practice to document the soft, discretionary 
dependencies in the Notes field. Double-click the affected task and enter notes 
on the Notes tab.

External dependencies are dependencies where the successor task is dependent 
on a predecessor that is outside your control. For example:

hh You need to receive materials from a supplier before you can construct 
something

hh You need input from another department before you can complete a report

We recommend that when you have an external dependency, you insert an 
extra milestone for the event with a “Start No Earlier Than” schedule constraint 
(constraints are covered in Chapter 6). This is a simple technique that helps tell 
the entire story in the case of a slippage or, worse, a contract dispute.

In the illustration, if you don’t have a milestone set if the cabinets arrive late, it 
appears to be simply a slipped start date on the task Install Cabinetry. Who is 
accountable for the slip in the schedule? The installers appear to be.

However, if you insert a 
milestone for the event in 
your schedule with a “Start 
No Earlier Than” schedule 
constraint, the constraint will 
keep the milestone on the 
date you’ve agreed to. Then 
create dependencies from the 
milestone into your activities. Now if the cabinets arrive late, it’s clear that this 
was beyond the control of the installers. 

External 
Dependencies

Install Cabinetry

Cabinets Received
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Until now we’ve been discussing logical dependencies. Now let’s talk about 
resource dependencies.

Resource dependencies force tasks to be sequenced to avoid work overloads. A 
resource dependency occurs 
when two tasks compete for the 
same resource. If you can’t find 
another solution for the 
overload, one or both tasks have 
to be delayed in order to keep 
the workload reasonable for the resource. Of course, you could force the 
sequence by setting an extra logical dependency as shown in the illustration, but 
let’s say the two tasks are really independent and could be done in any order. 
Harry could either read report X or Y first.

We don’t think you should model resource dependencies by setting extra logical 
dependencies. What happens if you reassign one of Harry’s tasks to Sam? Will 
you remember to take the logical dependency out again? (We added the question 
marks to the illustration for this reason.) You should at least write yourself a 
reminder in the Note field if you specifically set resource dependencies by 
creating extra logical dependencies. 

Do not create a link dependency because of a resource limitation. Project 2013 
has special features to keep the workloads leveled and we suggest you use those 
features as described in Chapter 9: Optimizing the Schedule.

Project 2013 offers a variety of ways to enter dependencies into the schedule. 
We’ll discuss entering dependencies in the Gantt Chart and Network Diagram 
views. In both views, the tools and forms work in a similar manner. For both 
views, we’ll discuss using:

hh The Planning Wizard
hh The Link tool
hh The mouse
hh The Task Information dialog box
hh The Task form

Resource 
Dependencies

Harry

Harry

???
Read X

Read Y

Entering 
Dependency 
Logic
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Before you start, make sure the Planning Wizard is still on. On the File tab, in the 
Backstage view, click Options, Advanced. Select Advice from the Planning 
Wizard under Planning Wizard. Select the indented check boxes as well. 

If you attempt to enter a date for a task, the Planning Wizard will suggest to you 
that this is not the best way to schedule this task and will instead remind you to 
implement the principle of dynamic scheduling by linking tasks.

You will get an “accidental” constraint of Start No Earlier Than when:

hh You enter a start date into the field Start that immediately follows the finish 
date of a nearby task above or below it, or

hh You drag a task bar after the task bar of a nearby task above or below. This 
can be a very quick method for linking tasks. Here are the steps:

Point to the middle of the task bar; make sure you see a four-headed arrow.

1. Click and hold down to drag the bar horizontally to where you want it 
scheduled. Make sure you see a horizontal two-headed arrow.

2. Look at the pop-up window to see what the new dates will be:

Entering 
Dependencies 
in the Gantt 
Chart
Using the 
Planning  
Wizard
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3. Release the mouse when the task bar is scheduled on the date you want, 
but this should be near the end of another nearby task bar that is above 
or below it. The following dialog will appear: 

4. Select Link them and click OK.

With the link tool you can create a waterfall of multiple Finish-to-Start 
dependencies with one click after selecting the tasks:

1. If the tasks you want to link are adjacent and in the order you want, simply 
select them by dragging over their task names. You can select more than two 
tasks.

OR

If the tasks are not adjacent or not in the order you want, select the driver 
(predecessor) first, hold down the Control key and click on the first 
follower (successor). You can click on the task name in the spreadsheet or 
on its task bar in the timescale. Click on as many tasks as you want to link. 
Make sure you select the tasks in the order in which you want the tasks 
linked (from driver to follower). Let go of the Control key when you have 
them all selected.

2. On the Task tab, in the Schedule group, click Link Tasks or hold down 
Control and press F2; the tasks are now Finish-to-Start dependent.

This method allows you to set Finish-to-Start dependencies only.

1. If the tasks are adjacent, select all predecessors and successors by dragging 
over their task names.

OR

Using the Link 
Tool

To Delete a  
Chain of 
Dependencies 
Between Tasks
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If the tasks are not adjacent, select the predecessor first and then hold down 
and click the successor. You can click on the task name or on the task bar, 
and you can click on more than two tasks that you want unlinked.

2. On the Task tab, in the Schedule group, click Unlink Tasks or hold down 
Control + Shift and press F2.

On the Task tab, in the Schedule group, select the task and click Unlink Tasks.

Be careful: you can easily delete all dependencies in the entire schedule if you 
select all tasks first by clicking on any column heading and then click Unlink 
Tasks. 

Using your mouse to draw dependencies is useful if you have many dependencies 
pointing up instead of down and also when you want to create parallel paths. 
Usually this works best when the dependencies are close together.

1. Click the predecessor task bar and drag down, then drag vertically toward 
the successor task bar, making sure the mouse pointer now looks like chain 
link. A pop-up window tells you between which two tasks you are about to 
set a Finish-to-Start dependency: 

Do not drag a task bar horizontally to try to link to another task in the Gantt 
Chart view. 

If you drag horizontally, you are rescheduling the task bar and setting a 
schedule constraint that will make your schedule static instead of dynamic!

2. Release the mouse button inside the task bar of the successor. A dependency 
is set and shows up as an arrow. The task bar of the successor moves out 
to just after the finish date of the predecessor’s task bar. A Finish-to-Start 
dependency is set: 

If you drag into the edge of the screen, the screen starts scrolling very fast in the 
Gantt Chart.

To Delete All 
Dependencies  
on one Task

Using the Mouse

To Draw 
Dependencies
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This method of setting dependencies allows you to set Finish-to-Start 
dependencies only, but you can use the next steps to change to another type of 
dependency. 

1. Point with the tip of the arrow mouse pointer precisely to the dependency 
arrow you want to change, as in the next screenshot: 

2. Dependency arrows can overlap each other, so wait one second until the 
feedback window pops up to confirm which dependency you are on.

3. If you have the proper dependency arrow selected, double-click and the 
Task Dependency dialog appears: 

4. Select the type of dependency using the list Type

AND

Enter a positive lag or a negative lag (lead) time, or if needed, a percent in 
the Lag field if you want to set a relative lag. 

OR

5. Click Delete to get rid of the dependency.

To Edit or Delete  
a Dependency
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You may need to use this method if the predecessor and successor tasks are a 
screen or more apart.

1. Select the successor task.

2. On the Task tab, in the Properties group, click Information or hold down 
Shift and press F2; the Task Information dialog appears.

3. Click the Predecessors tab; the dialog should now look like this: 

4. Click in the Task Name field in an empty row and select the predecessor 
task from the list.

OR

Enter the ID number of the predecessor in the ID field.

5. Select the type of dependency in the Type field.

6. Enter a positive lag or a negative lag (lead) time, if needed, or a percent in 
the Lag field if you want to set a relative lag. Click OK and the dependencies 
are entered into the schedule.

This method allows you to assign multiple predecessors to one task. The next 
method allows you to set both multiple predecessors and successors to a task.

The Task Details form allows you to set multiple dependencies—both 
predecessors and successors—to a task at the same time. The Task Details form 
also lets you see the dependencies: the arrows in the Gantt timescale run on top 
of one another and the Task Details form shows you exactly how they run.

Using the Task 
Information Dialog

Using the  
Task Details 
Form
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1. On the Task tab, in the Properties group, click on Display Task Details. 
The Task Details form appears in the bottom of the screen.

2. Click on the Task Details form (this will change the context-sensitive 
description above the Format tab) and choose the Format tab. In the Details 
group, click on Predecessors & Successors to view all dependencies of the 
selected task. Your screen should now look like this: 

3. Click in the field Predecessor Name or Successor Name in an empty row 
and use the list to create the dependency. 

OR

Type the ID number of the predecessor or successor task in the ID field.

4. Enter a positive lag or a negative lag (lead) time, if needed, or a percent in 
the Lag field if you want to set a relative lag. 

5. Click OK.

To delete a dependency on the Task form, select the Task name, and when it is 
highlighted press the Delete key on your keyboard. Then click OK.

To show predecessors and successors of a particular task in a graphical view you 
may want to use a combination Gantt Chart/Relationship Diagram view. On 
the Task tab, in the View group, click Gantt Chart. Next, choose Display to 
Display Task Details from the within the Properties grouping on the Task 
tab to turn on a combination view. In the lower pane, right-click the title Task 
Details form, click More Views. The More Views dialog box appears. Select 
Relationship Diagram, and then click Apply. You now see the entire chain, 
which makes checking the logic even easier.
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To apply the view, on the Task tab, in the View group, click on the Gantt Chart 
down-arrow, Network Diagram.

The Network Diagram can display an overview of all the dependencies you have 
set; the dependencies are depicted as arrows.

By default, the Network Diagram displays tasks in differently shaped nodes:

hh Summary tasks in a parallelogram 

hh Detail tasks in a rectangle 

hh Milestones in a hexagon 

The critical tasks have a red border instead of the (default) blue. The color and 
the shape of the nodes can be changed by choosing the Format tab, Box Styles 
within the Format grouping.

Once you’ve gained the overview and start to identify places where you are 
missing important links, you can create them right here in the Network Diagram.

1. Point to the center of the predecessor node and make sure the mouse 
pointer is a plus sign.

2. Click and hold down the primary mouse button, then drag towards the 
node of the successor; the mouse pointer should change to a chain link 
cursor. Even if the node is not visible, you can drag against the side of the 
screen, which will then start scrolling automatically.

3. Release the mouse button in the center of the successor node; an arrow 
appears and the dependency is set.

This method allows you to set FS dependencies only, but you can easily change 
the type by double-clicking on a dependency arrow.

If you change the type of dependency from FS, the arrows will still look like you 
only have a FS dependency, however, the Link Labels option will display the 
true nature of the link.

Do not release the mouse in an empty white space or drag in an empty white 
space in the Network Diagram view.

Entering 
Dependencies 
in the Network 
Diagram
The Network 
Diagram

Using the 
Mouse to Set 
Dependencies
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If you release the mouse button outside of the successor node, a new task is 
created! For those who like to build the task list and the network at the same 
time, this is a great feature. If this happens inadvertently, press Delete right away, 
while the new task is still selected, to get rid of it.

When you use the Link button, select the tasks in the order in which you want 
to link them (select the predecessor first, then its successor, then the successor 
of the successor, etc.).

1. Hold down Control and click on all tasks to link. 

OR

You can select multiple tasks quickly by dragging a box around them. When 
you drag, you are drawing a box with a green border. Any tasks that you 
enclose in the box will be selected upon releasing the mouse button. You 
can even select another set of tasks by holding down Control before you 
drag again.

2. On the Task tab, in the Schedule group, click the Link button to link the 
tasks.

As in the Gantt Chart view, you can also set dependencies in the Network 
Diagram view using the Task Information dialog or the Task Details form. The 
steps are the same as for the Gantt Chart view.

1. Point with the tip of the mouse pointer to the dependency arrow you want 
to delete. 

2. Double-click and the Task Dependency dialog appears:

3. To edit the dependency, change the Type of the dependency using the list. 

AND

Enter a positive lag or a negative lag (lead) time, if needed, or a percent in 
the Lag field if you want to set a relative lag.

You delete a dependency by clicking Delete in the Task Dependency dialog.

Using the Link 
Button to Set 
Dependencies

To Edit or Delete a 
Dependency in the 
Network Diagram
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When you delete a dependency arrow, all dependent tasks are rescheduled to 
their “As Soon As Possible” date under forward scheduling. They may zip all the 
way to the project start date and disappear from your screen. We recommend 
you create the new dependency first and then delete the old dependency to 
prevent nodes from disappearing from your screen.

Although you may change the dependency type, in the Network Diagram view it 
will still appear as a FS dependency. You can see the actual dependency type in 
the Gantt Chart view or by using the Link Labels button on the Format tab while 
viewing the Network Diagram.

The Network Diagram has an invisible grid, like a spreadsheet. When you press 
the arrow keys to move the cursor, they will only take you to the visible “cells” in 
the grid, the task nodes. If you leave the layout challenge to Project 2013, it uses 
this invisible grid:

1. Turn Automatically position all boxes off. If you have it on, the nodes 
are rearranged with every change you make. It is very difficult to check the 
logic in the network when the nodes keep jumping all over the place. We 
recommend turning this off. On the Format tab, in the Format group, click 
Layout. The Layout dialog box appears. 

2. Select Allow manual box positioning and click OK.

3. To see if the logic of the dependencies makes sense, use the arrow keys to 
follow a chain of dependencies. Click on the first task node in a chain and 
press the Right arrow key to follow the chain forward. When there is a split, 
press the Right arrow key once more to move into one path, and then you 

Using the 
Network 
Diagram to 
Display the 
Schedule 
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can switch between the chains by pressing the Down-arrow key, OR press 
the Left arrow key to go backward and press the Down-arrow key or Up 
arrow key to switch chains.

4. Use the methods discussed before to delete, add, or modify dependencies, 
if necessary.

Even a large screen can’t display a large network in its entirety. In the past large 
networks were printed on plotters and hung like wallpaper. However, one of 
the points of this book is that we need to conserve our resources (natural and 
otherwise), and we have to find a way to see the entire network while keeping 
task details legible. Here are some tips for how to see more of a large network:

hh Double-click on the active tab. This will temporarily remove the ribbon.
hh If you have the window split, remove it: on the Task tab, in the Properties 

group, click on Details or point to the divider between the top and bottom 
view and double-click when you see the mouse pointer change.

hh Adjust the level of detail by using the Zoom Slider located in the lower 
right-hand corner. 

hh In the Layout dialog box, check Hide all fields except ID. This option 
allows you to see many tasks in the diagram.

If you want to see data about a task while you are zoomed out, point the mouse 
pointer to a task node and a pop-up window will appear with the task data.

To read and analyze the network while you are zoomed out, you can zoom back 
into the detail by clicking the Collapse Boxes button in the Display group on 
the Format tab. Project 2013 always keeps the selected task on the screen when 
toggling between hiding and displaying the fields. Toggling back and forth is 
perhaps the easiest way to analyze the network and this button allows you to do 
this.

Remember that you have to be in the Network Diagram view while selecting 
the Format tab in order for the correct formatting options to be presented for 
this topic.

Gaining an 
Overview of the 
Network
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There are advantages and disadvantages of setting dependencies on summary 
tasks.

Advantages of summary dependencies

hh Setting dependencies on summary tasks seems easier and quicker

hh Summary logic is high-level logic that executives sometimes like to see

hh In certain situations, you can make do with one summary dependency 
instead of setting several dependencies on detail tasks. When detail tasks 
all start at the same time independently of each other, one dependency on 
their summary task makes sense. In the next screenshot, tasks 21 to 23 are 
all driven by the dependency on their summary task, 20. 

Disadvantages of summary dependencies

hh It can be difficult to check whether the network of dependencies is complete. 
The check is simple if you only have dependencies between detail tasks: 
you just have to find the detail tasks and milestones without an entry in the 
predecessor or successor field. If you have logic both on summary tasks and 
detail tasks in parallel, you cannot perform this simple check any longer. 
Checking the logic then becomes a very painstaking and laborious process. 

hh The critical path (the longest path in the network and therefore the one 
that sets the end date)2 is more difficult to find when the dependencies 
run over detail tasks and summary tasks in parallel. When you follow the 
critical path, a critical detail task may not have any successor or predecessor. 
It looks like the critical path stops, and you may not realize that the critical 
path continues through a dependency on the summary task. In the next 
screenshot, task 19 appears to be the end of the critical path, but it actually 
continues via the summary dependency to task 23: 

2 See Chapter 9: Optimizing the Schedule for more information on critical paths.

Dependency 
Logic on 
Summary Tasks
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hh On summary tasks, you can only set rough, high-level logic. High-level logic 
often does not allow you to create the tightest schedule possible.

hh Not all types of dependencies can be used on summary tasks; you cannot 
link FF or SF to summary tasks.

We recommend that you not set dependencies (links) on summary tasks. Even 
though there seem to be some advantages to setting dependencies on summary 
tasks, they don’t measure up against the disadvantages. Time gained with setting 
fewer dependencies is lost threefold when checking the logic and analyzing the 
critical path. We therefore recommend that you keep the dependency logic on 
detail tasks and milestones only.

As we mentioned, you can set dependencies with manually scheduled tasks, but 
you need to consider that these tasks have different internal considerations.

First, when you enter a new manually scheduled task and its duration, you will 
have a duration only manually scheduled task with this format in your schedule: 

 

As you see in the above screenshot, we have populated the following fields: 
Scheduled Duration, Scheduled Start, and Scheduled Finish. These were added 
to manage manually scheduled tasks. For manually scheduled tasks, these fields 
are the recommended duration, start, or finish and are read-only. These are the 
equivalent of the Duration, Start, and Finish fields for automatically scheduled 
tasks.

Dependencies 
and  
Manually 
Scheduled 
Tasks
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When you establish a dependency in a duration only manually scheduled task, 
the Scheduled Start and Scheduled Finish fields are copied to the Start and 
Finish fields: 

Note that manually scheduled tasks respect the dependency, in this case finish 
to start, when you first establish the dependency. But if you change something in 
a manually scheduled task, for example its duration, any predecessor tasks will 
maintain the same previous dates and won’t honor the new date as automatically 
scheduled tasks do: 

In the previous screenshot you can see that the predecessor manually scheduled 
task, “Review Design,” doesn’t honor the dependency, but gives you warning 
signs about a potential scheduling problem (red squiggly line under the Finish 
date and the dotted-line around the Gantt bar). You can also notice that fields 
Scheduled Start and Scheduled Finish have the information that honor the 
dependency, but the fields Start and Finish have the previous information. If 
you want a manually scheduled task to honor the dependencies, you need to 
select the task and click Respect Links, in the Task tab, Schedule group. The 
Scheduled Start and Scheduled Finish data will be copied to the Start and 
Finish fields, and the bar will move to the new dates.

Now that you’ve entered dependencies, you need to check the network of 
dependencies to determine if it will indeed give you the benefit that you created 
it for in the first place: if you change one field (Work, Duration, Resources, 
Constraints, or Dependencies in the schedule), is the rest of the schedule 

Checks on 
Dependencies
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updated automatically, so that you immediately have a valid schedule of your 
project again? The schedule will update itself only if the answers to the following 
questions are all yes:

hh Is the network of dependencies complete?

hh Is the network logic simple enough?

hh Is the network free of circular dependencies?
A circular dependency exists where two tasks drive each other: task A drives 
task B, but task B also drives task A. A schedule with circular dependencies 
will not be dynamic, but entirely static: Project 2013 can’t recalculate a 
schedule as soon as a circular dependency is created. The application will 
warn you if you try to create circularity in the logic within a single schedule.

Do not create any circular dependency references within or between 
projects.

hh Does the logic of the network make sense?

hh Are resource dependencies accounted for?

hh Are manually scheduled task warnings considered or resolved in your logic?

After all the previous checks are done, perform one more high level check to see 
if the resulting schedule actually makes sense.

You can check this best by showing only the first outline levels of the work 
breakdown structure and checking if the timing of the deliverables (or phases) 
makes sense on this high level, given business targets and experience with 
other similar projects. If you go to the View tab, in the Data group, and click on 
Outline you can display Outline level 2 or Outline level 3 depending on the 
size of your project. Even though you may not be an expert in the field of this 
project, you can always pick up on common sense things like design scheduled 
before construction, write before print, etc.

If you followed our recommendations to minimize the number of constraints 
and set all dependencies, the start and finish dates of the tasks are driven by 
the network of dependencies. If the resulting schedule does not make sense, it’s 
likely you’ve overlooked an essential dependency, been overly optimistic in your 
estimations, provided overly pessimistic task durations, over or under allocated 
resources, etc.

The next screenshot shows a schedule that doesn’t make sense from a common 
sense perspective: it looks like the move task starts too early. In this case 
the probable cause is a missing dependency in a schedule where all tasks are 
scheduled ASAP. However, if you expanded the move summary task it would 
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become clear that the actual move takes place during the week of November 7 
and all the essential logic seems to be there: 

The network is complete if the task bars of all detail tasks and milestones are tied 
up at the end of the schedule. The network can have multiple starting points, 
but only one ending point. The critical path method is the most widely used 
technique to manage the time dimension of a project, and you must have only 
one ending point in the network for the critical path calculation to be correct in 
a single project.

A
B

C

D

A typical network will look like the 
illustration. We do not require the 
network to start with just one 
starting point: we find that this can 
make the network unnecessarily 
complex and that it does not 
provide additional benefits. 

However, when you have multiple 
starting points, check to see if the 

detail tasks (A, B, C, and D in the illustration) have a missing predecessor. If 
they don’t have a logical predecessor, you need to determine if they can indeed 
start on the project start date or if they need a “Start No Earlier Than” constraint 
(under forward scheduling). You can see that A and D start at the project start 
date, but B and C have a constraint (anchor), since they start later. B and C do not 
have a driver (predecessor) and may need one. Whenever there is a constraint, a 
predecessor may be implied: it may be an external predecessor (e.g., the delivery 
of something), a resource dependency, or a logical dependency on a task that is 
not explicitly included in the WBS.

In the thousands of schedules we’ve evaluated in our curriculum, we found that 
about 50% had starting points in the network that should have had a predecessor. 
So, check your starting points carefully.

Is the Network of 
Dependencies 
Complete?
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Make sure your network of dependencies is complete.

There are two reasons why you should complete the network logic in your 
schedule:

hh If you forget to set dependencies, the schedule will not update itself 
properly when you make a change to it. It will not be a dynamic schedule. 
As we have said, having a dynamic schedule saves time and effort. When 
you enter changes based on planning scenarios or actual progress, the rest 
of the schedule is able to update itself automatically so that you quickly have 
a valid model of the project again.

hh With an incomplete network you will most likely not have a meaningful 
critical path (as explained in Chapter 9). Or worse, Project 2013 might lead 
you to think that tasks are critical that really aren’t critical at all and you 
will monitor the wrong tasks closely. Project managers also need to see their 
critical tasks, because they harbor possibilities for shortening the project 
and bringing it in on time. In the thousands of schedules we’ve evaluated in 
our curriculum, we found that in about 50% of them, the project manager 
had not identified the real critical path. (The critical path is covered in detail 
in Chapter 9.)

Remember that if you miss just one essential dependency, your critical path is 
wrong, your forecasts are not valid and your model is not dynamic. To check the 
completeness of your network, ask yourself the following questions:

hh Is the logic set only on detail tasks and milestones?
If dependencies run over summary tasks and detail tasks in parallel, it is 
too hard to check if the network is complete and too hard to trace and 
understand the critical path. Therefore, we recommend that you keep the 
logic on the detail tasks and milestones only. You can check that there are 
dependencies on summary tasks by applying the filter 04 IIL Summary 
Tasks with Dependencies.3

hh Are all the starts of the detail tasks linked to at least one other task or 
milestone? Exceptions are:
h` Tasks that can start when the project starts or that are driven by external 

forces or deliveries rather than by hand-offs within the project.
h` External delivery milestones with a Start No Earlier Than constraint 

date.
h` Recurring tasks 
h` Overhead tasks 
h` Hammock tasks

3 This filter can be found in the file IIL Project 2013 Tools available for download at www.jrosspub.com. 
Please click the link WAV Download Resource Center to enter the download site.

Why a  
Complete  
Network Is 
Important

Checks on the 
Completeness of 
the Network
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You can verify that all starts are linked by applying the filter 05 IIL Detail 
Tasks without Predecessors.4 If you used SS or FF dependencies, the filter 
is not conclusive. There will be another check on those described below.

OR

On the View tab, in the Data group, click Filter down-arrow, Display 
AutoFilter. In the Predecessors column heading, click the arrow button 
and choose the blank item in the list. Now all tasks without an entry in the 
predecessor field will be displayed, including summary tasks (this is where 
the IIL filter is better). Notice that the column heading title appears in blue 
to remind you that an AutoFilter is in effect.

hh Are all the ends of the detail tasks linked to at least one other task or 
milestone? Exceptions are:
h` The project end milestone
h` Recurring tasks
h` Overhead tasks
h` Hammock tasks

A loose end, hanger or dangling task is a detail task that does not have its 
finish tied to any other task. In any project there should only be one loose 
end, the project finish milestone. 

You can verify that all ends are linked up by applying the filter 06 IIL Detail 
Tasks without Successors.5 If you used SS or FF dependencies, the filter is 
not conclusive. There will be another check on those described below.

OR

Display the AutoFilter buttons by clicking the Filter drop down arrow 
within the Data grouping on the View tab. In the Successors column 
heading, click the arrow button and choose the blank item in the list. Now 
all tasks without an entry in the successor field will be displayed, including 
summary tasks (this is where the IIL filter is better). Notice that the column 
label appears in blue to remind you that an AutoFilter is in effect.

hh Do you have SS and FF dependencies properly linked?
Project managers often forget to give every task a successor when they use 
SS or FF dependencies.

4 Ibid.
5 Ibid.
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People often forget to set a dependency on the finish of the predecessor in 
an SS dependency (see the question marks in the illustration). The finish 
must also be linked, otherwise the predecessor could still continue even 
though the project is finished, since 
you have not linked it to anything. The 
check for detail tasks without 
successors won’t find these loose ends. 
In the illustration, Pour Concrete has an 
SS successor, but its finish is not tied to 
any other task.

People also often forget to set a dependency on the start of the successor in 
an FF dependency (see the question marks in the illustration). The task 
Train Users has an FF predecessor, but its start is not linked to any other task 

which means that you don’t need to find 
a trainer or create course material for 
the task Train Users, which is just hard 
to believe. You are probably missing a 
link. Alternatively, the start date can be 
held in place by a schedule constraint.

Again, if you only check that each detail task has a successor, you will not 
find these loose ends. If you used SS or FF dependencies in your schedule, 
you should filter and display all those tasks with SS and FF dependencies 
and check on loose ends manually. You can do this check by applying the 
filter 07 IIL Detail Tasks with SS or FF.6 Since the filter will display both 
the predecessor and successor tasks involved in the SS or FF dependency, 
you can check if they are hooked up properly to other tasks by revealing the 
Predecessors and Successors fields. What you should look for is:

h` Does a task with SS in the Successor field also have an FS or FF 
successor that ties up its end?

h` Does a task with FF in the Predecessor field also have an SS or FS 
predecessor that ties up its start?

If the answer to either question is “no,” you have found a missing link.

Make sure SS and FF links aren’t missing a beginning or ending link.

hh Are there tasks with an unreasonably large amount of total slack?
Total slack, as we’ll discuss in Chapter 9, is buffer time: the amount of time 
a task can be delayed without impacting an end date in the project. Check 
if the tasks with the most slack were expected to have a lot of slack. If not, 
you may have found missing logic. Even after you have given all detail tasks 

6 Ibid.

???
SS

Pour Concrete

Cure Concrete

???

FF

Install Software

Train Users
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a successor, you should still apply this check, because even if each task has a 
successor, it does not guarantee that you haven’t forgotten important links. 
Checking the Total Slack will actually lead you to where you forgot to set 
important dependencies in your model of the project. 

hh When a change is entered into the schedule, does it update the rest of 
the schedule automatically and appropriately through dependencies?  
Is the entire schedule still valid? Where the schedule is not valid, an essential 
dependency might be missing. If you have to check the entire schedule 
after each change, you don’t have a dynamic model. Remember, the logic 
should be helpful especially during project execution when you update your 
schedule regularly.

Certain tasks do not need links:
hh Summary tasks
hh Recurring detail tasks like status meetings
hh Overhead tasks like project management or quality control
hh Hammock tasks that support a process

All other detail tasks and milestones (except the end of the project) need to have 
at least one successor. If you cannot find logical links to other detail tasks in 
your schedule, you should create a link to the project end milestone. If you don’t 
have a project end milestone, you should create one even if this only serves the 
purpose of hooking up all your loose ends. Certain tasks can only be linked to 
the project end milestone. Examples are:

hh Tasks to inform other departments or organizations (not related to 
completing project deliverables).

hh Tasks that create entirely independent parts of a system, which can easily and 
quickly be assembled without much effort. If it will take effort, you should 
definitely consider creating a detail task for assembling the final product.

Make sure the network logic is logical and simple.

A network that is too complex to understand and maintain is not helpful in 
managing the project. Redundant dependencies clutter the view and make the 
network overly complicated. If the network is complicated, team members will 
not try to understand or use it. Many project managers fall prey to the following 
fallacy: All tasks are related to each other, and I have to set dependencies everywhere 
I notice relationships. While all tasks are related to each other (that is how you 
arrive at a complete network of dependencies), most tasks are only related 
indirectly to each other, i.e., via other tasks.

You only have to link the tasks that have a direct relationship.

Exceptions to  
the Rule of a 
Complete Network

Is the  
Network  
Logic Simple 
Enough?
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The following questions will help you determine if the network is simple enough:

hh Are there dependencies that leapfrog each other? Dependencies that skip 
over the back of multiple dependencies within a chain are redundant. These 
are the indirect relationships. Remove 
them.

hh Are there dependencies that run 
in parallel on detail tasks and their 
summary tasks? If that is the case, 
keep the detail task dependency and 
remove the parallel dependency on 
the summary task.

hh Can you, as the project manager, 
explain the network to your project 
team? If you can’t, the network is too complex.

If you can explain the network, you can immediately show a team member who 
else will be affected if his or her task slips. This is a very powerful method to 
motivate team members to deliver on time and to facilitate coordination within 
your team. 

A clear network also allows you to do a quick impact analysis of suggestions made 
by executives. Imagine that your project sponsor on a software development 
project comes to you during the execution phase and asks: “What if we wait 
for the new release of this operating system?” or “What if we use this new line 
of more powerful computers?” With a simple network, you will be able to 
indicate the impacts very clearly by following the dependency arrows from the 
components that will be affected by such a change in direction. You may be able 
to stem some unwanted turbulence, or immediately negotiate for more time or 
money.

The Task Path feature highlights tasks that are linked to a selected task (in the 
Gantt Chart, on the Format tab, in the group Bar Styles, click the Task Path 
downward button and select the desired highlight). This allows you to see how 
the selected task fits into the overall project. So at a glance, you can see which 
tasks will be affected prior to making changes to your schedule. 

There are four types of Task Path highlighting:

hh Predecessors: This will highlight predecessors of a selected task. This 
option is helpful to analyze the consequences of any predecessor slippage.

Leapfrog

Parallel

Understand 
the Task 
Relationships 
Using Task 
Path
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hh Driving Predecessors: This selection will show just the predecessor tasks 
that directly affect a selected Task. This option is very helpful to explain the 
task scheduled start date.

hh Successors: This will highlight successors of a selected task. This option is 
helpful to analyze the consequences of this task slippage on its successors.

hh Driven Successors: This will highlight successors that are directly affected 
by the selected task. This option is very helpful to explain the successor 
tasks scheduled start dates.

You may want to consider using Task Path when assessing the risk of the project 
with different scenarios where the critical path can change. Refer to Chapter 9: 
Optimizing the Schedule to define critical path.

There are some technical limitations when creating dependencies:

hh You can set only one link between two tasks
It is impossible to set more than one link between two tasks. You will receive 
the following error message: 

Limitations on 
Dependencies
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Therefore you can’t hook up both the start and the finish of two tasks 
using an SS as well as an FF dependency. For example, you may have set 
an SS dependency between relocate the drywall and wire the electricity. If 
relocating the walls takes longer than planned, your model may show that 
the electricians will finish earlier than the carpenters, which is unreasonable. 
If you could set an FF dependency between the same tasks, the problem 
would be solved. A workaround for this is to insert an extra milestone and 
run two FF dependencies to and from that milestone.

hh You cannot set links on all parts of a split task bar
You cannot set dependencies on all parts of a split task bar; you can only link 
to the start of the first part and from the finish of the last part. Therefore you 
cannot create very dynamic models with split task bars. This is the reason 
why we don’t recommend using them when you are planning the project; 
you will see enough splits appear when you update during project execution.

hh You cannot link to the finish of a summary task
You cannot set an FF or SF dependency to a summary task as the successor, 
because the finish date of a summary task is always calculated. However, you 
can link from the finish of the summary task. Remember, however, that we 
don’t recommend logic on summary tasks.

hh Percentage lags only apply to the duration of the predecessor task
You cannot set a lag that takes a percentage of the duration of the successor 
task; the percentages are always taken from the duration of the predecessor. 
So you cannot create a dependency that drives, for example, the halfway 
point of a successor.

Another way to manage a different type of relationship in Project 2013 is with 
dynamic links. These links are useful in managing overhead tasks, hammock 
tasks, and for utilizing data from other applications.

Dynamic links are useful when the start, finish, duration, or other task data affect 
elements of another task in the project schedule. 

Dynamic links tend to be easily broken and it is a good idea to attach a note to 
the linked tasks to document the link. This will assist in reestablishing a broken 
link.

To establish a dynamic link, you copy the cell of the driving task’s information, 
and then paste a link into the cell of the driven task’s information, by choosing 
Paste Special and Paste Link. The linked cell updates itself automatically when 
the driving task’s information changes and saves you the need to constantly 
adjust the affected task. The following are some of the uses for dynamic links, 
but before we get to them, here are some cautions:

A Special Topic: 
Dynamic Links
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Dynamic links are good options to assist in modeling your schedule, but we 
recommend minimizing your use of them. Every time you enter a change in 
Project 2013, the dynamic links will be updated (if the calculation mode is set to 
automatic), and you will notice a blink in the screen. If you have a lot of dynamic 
links you will have an annoying number of blinks every time you update your 
schedule.

You may have concerns with the displayed critical path and slack using dynamic 
links, because the critical path calculations use the logical dependencies.

A dynamic link adds a constraint in your task (check the icon in the Indicators 
column), but it really isn’t a constraint because it is updated according to the 
dynamically linked cells.

Overhead tasks are tasks that are ongoing during the entire project, for example 
project management, technical support and quality control. You may think it isn’t 
necessary to track these items in your schedule but they consume resources, 
create expenses and could have consequences to your project if you forget them, 
especially project management tasks. Overhead tasks are typically placed near 
the top of the project.

The overhead task is 
dynamically linked to the 

duration of  the project 
summary task.

It represents all the fine 
detail that a project manager 

does on a daily basis.

Overhead Task

You can enter overhead tasks in one of two ways: as a long-duration task (long 
task bar), or as a recurring task (discussed in detail in Chapter 4).

The long-duration task method is easier to maintain since the task bar 
automatically extends when the project extends, while the recurring task feature 
requires you to add additional occurrences and apply resource assignments 
to the new occurrences if the project extends. If you intend to solve resource 
over-allocations in your project, the long-duration task has only one resource 
assignment that may need to be modified, while the recurring task has numerous 

Overhead Tasks
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resource assignments that may need to be modified. By default, recurring tasks 
are excluded from the Level Now function (Chapter 9 includes a discussion on 
leveling options). 

The dynamic link that is recommended for an overhead task is to copy the 
duration of the overall project summary task and Paste Special, Paste Link it to 
the duration of the overhead task. 

As you have probably concluded, we recommend you enter overhead tasks as a 
long-duration task rather than a recurring task. 

Typically the project manager performs many tasks that may be too brief and 
repetitive to include in the schedule (e.g., responding to voicemail and email, 
mentoring, communications, conflict resolution). These can be rolled into a 
single item called Project Management to account for the project manager’s time 
and cost.

A hammock task is also called a supporting task (envision the shape of a 
hammock) or a task that must occur sometime within a date range or must 
occur the entire length of a date range. An example of a hammock task could be 
the task Project Management, where the project manager is assigned to the task 
and manages the project on a daily basis during the life-cycle of the project. A 
hammock task is usually illustrated as a long-duration task just below a series of 
tasks. The tasks that represent the date range might be milestone tasks or regular 
tasks, but independently they do not equal the overall duration of the hammock 
task. 

Hammock Task is hung 
from the Start date of  
the process to the End 

date of  the process.

Hammock Task

A Summary Task 
summarizes the 

information contained in 
the detail tasks below.

The dynamic link that is recommended for a hammock task is to copy the Start 
Date from the first task and Paste Special, Paste Link it to the Start Date of 
the hammock task and then copy the Finish Date from the last task and Paste 
Special, Paste Link it to the Finish Date of the hammock task. The result is the 
overall duration of the hammock is calculated. 

Hammock Tasks
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Often a hammock task is used to represent the length of time a series of tasks in 
a process will take. In this example, there are three tasks (A, B, C) that form a 
process. The hammock task D will start with the beginning of the process and 
end when the process ends. 

hh Tasks A (four days), B (three days), and C (eight days) are linked sequentially 
with Finish-to-Start logical dependencies. A, B, and C represent the flow of 
work in the process.

hh Task D is representative of the overall process. If we copy the Start Date of 
task A and then Paste Special, Paste Link into the Start Date of task D, 
then the these tasks are linked by start dates. 

hh To complete task D, we copy the Finish Date of task C and Paste Special, 
Paste Link into the Finish Date of task D. 

hh Note that the duration of task D is now 15 days (matching the duration of 
the process). 

For the dynamic links to work properly, the hammock task must not be a Fixed 
Duration task type. 

Now suppose that the duration of task B has been increased to seven days. You 
will notice that task D will adjust its duration automatically to 19 days. The 
same will occur if you increase or reduce any of the tasks included in the process 
(group).

We recommend placing the hammock task just below the process (group of 
tasks). This will allow you to update the tasks, top to bottom, and when you 
arrive at the hammock task, it will already be updated. During the tracking or 
updating cycle, just “update as scheduled.”

Do not link a predecessor task to the hammock since its position in the schedule 
and start date are already controlled by the dynamic link. 
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1. Why should a project manager set all the dependencies in her schedule?

2. How are dependencies handled in manually scheduled tasks?

3. What is the difference between Duration, Start and Finish fields, versus 
Scheduled Duration, Scheduled Start and Scheduled Finish fields?

4. What are the criteria for a good and solid network of dependencies that 
creates an entirely dynamic schedule? 

5. If you are dependent upon supplies to arrive for one deliverable in your 
project, what would you recommend in terms of scheduling this situation?

6. This chapter covered multiple ways of setting dependencies. Please name at 
least four of them.

7. Are the following valid entries in the lag field? Yes or no? Why? 
a. 5d
b. –3d
c. +30% 
d. +5ed

8. Should you allow logic on summary tasks? Why or why not?

9. How would you schedule ordering materials and receiving materials with 
a delivery time of 3 weeks? Would you use a Finish-to-Start dependency 
with a 3-week lag? Or would you split the task bar for 3 weeks? Explain your 
answer.

10. For each of the following situations determine:
h` Which task is the predecessor and successor: A or B?
h` What type of dependency you need: FS, SS, FF or SF?
h` Whether you would add a lead or a lag to the dependency? If so, as a 

relative lag or absolute lag? And how much?

Predecessor 
(A or B)

Type of 
Dependency

Add Lag? 
Relative/
Absolute? 
How much?

You gather requirements (A) and 
then you analyze requirements 
(B).

After you apply for a permit (A), 
you have to wait 3 weeks for 
permit received (B).

Review 
Questions
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Predecessor 
(A or B)

Type of 
Dependency

Add Lag? 
Relative/
Absolute? 
How much?

Halfway through perform system 
analysis (A) we typically start 
programming code (B).

You have to pour foundation (A) 
and let the concrete dry before 
you lay bricks (B) to erect the 
walls.

One day after the finish of conduct 
courses (A), write evaluation report 
(B) has to be completed.

Prepare for the PMP exam (A)
and take the PMP exam (B).

11. You have a task, test unit, with a 10-day duration, and you need to decide 
between using a FS-5d or a SS+5d dependency with this task as the 
predecessor. The FS-5d dependency will give the successor a different start 
date than the SS+5d when:
a. The start date of test unit changes
b. The finish date of test unit changes (while its start date stays the same)
c. The duration of test unit changes
d. The finish date or the duration of test unit changes

12. You have two tasks, survey clients and summarize survey results, and you need 
to decide between using a FS-30% or a SS+70% dependency between the 
two tasks. The FS-30% dependency will cause a different start date of the 
successor than the SS+70% dependency when:
a. The start date of survey clients changes
b. The finish date of survey clients changes (while its start date stays the 

same)
c. The duration of survey clients changes
d. None of the above will cause an impact between FS-30% and SS+70%

For experience working with the features you’ve learned about in this chapter, 
we strongly suggest that you do the additional exercises for this chapter that 
are included in the Case Studies appendix, available to download in the WAV 
Download Resource Center at www.jrosspub.com.

Additional Practice
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Chapter 6: Entering Deadlines, 
Constraints, and Task Calendars

Your Gantt Chart is starting to take shape. There may be certain constraint dates 
or deadline dates that you have to add to your model to make it stay within the 
boundaries of the reality of your project. In this chapter we cover three features 
that capture specific dates: constraints, deadlines, and Task Calendars.

After reading this chapter you will be able to:

hh Describe the differences between constraints and deadlines
hh Describe the different types of schedule constraints
hh Discuss in which situations to use constraints or deadlines
hh Choose the right type of constraint
hh Enter schedule constraints and deadlines into your project model
hh Describe the advantages and disadvantages of using constraints
hh Describe the advantages and disadvantages of using deadlines
hh Recognize when it’s better to use Task Calendars than constraints
hh Create a Task Calendar and restrict the scheduling of a task with it
hh Use scheduling best practices to check your deadlines, constraints, and Task 

Calendars
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Sometimes you need certain tasks to be scheduled on specific dates (e.g., if you 
are waiting on a resource and there is no logical predecessor task identified). 
There are two basic methods for identifying tasks to be started or completed on 
specific dates: using constraints or using deadlines.

hh A constraint is a date that restricts Project 2013 in scheduling a task

As we’ll see, there are various types of constraints you can set; all of them 
impact the scheduling of tasks in your project. For example, if you set a 
constraint that a task must start as soon as possible, Project 2013 will tend 
to pull related tasks towards earlier completion dates in your schedule.

This can restrict the dynamic nature with which tasks shift when you enter 
changes, create scheduling conflicts, and require you to spend more time 
resolving these conflicts. 

hh A deadline is a date you commit to that does not restrict the scheduling of 
a task

What Are 
Deadlines 
and Schedule 
Constraints?

But Sir, the electrical and plumbing won’t be
 finished for two months!

I’m happy to announce that the MEGA STADIUM
will be ready to open in two weeks!

MEGA
STADIUM
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Deadline

Constraint: Must-Start-On

Fixing dates is a matter of putting a 
schedule constraint on the task. 
One option for this would be a 
Must Start On constraint for the 
task. A Must Start On is a hard 
constraint, and Project 2013 
cannot reschedule tasks with hard 
constraints. 

Deadline dates stay visible in the timescale as down-facing green arrows. When 
you miss a deadline date Project 2013 displays a missed deadline indicator in the 
Indicators column.

We recommend that you enter dates you are committed to as deadline dates 
rather than as constraint dates. Since deadlines don’t restrict the scheduling, 
they don’t cause the same kinds of scheduling conflicts as constraints, which can 
require continuous and immediate maintenance (as we’ll see when we discuss 
the Planning Wizard warnings that scheduling conflicts cause). If tasks slip in the 
schedule, Project 2013 can adjust an unconstrained schedule to show the impact 
of the slippage on the target date. This ability to forecast in the schedule enables 
early responses instead of knee-jerk reactions at the last minute.

Although deadlines don’t restrict scheduling, they do have an impact on 
the critical path. If you enter a deadline before the task’s finish date, all of 
the predecessor tasks now show up as critical. This is due to the way Project 
calculates the backward pass. If you think about it, it makes sense because you 
are now missing a deadline and this creates negative slack (suggesting you do not 
have any time to spare). Constraints also behave this way.

1. On the Task tab in the View group, click Gantt Chart.

2. Double-click on the task for which you want to set the deadline. 

OR

Select the task for which you want to set a deadline then, on the Task tab, in 
the Properties group, click Information.

OR

Hold down SHIFT and press F2. The Task Information dialog box appears.

3. Click the Advanced tab; the dialog box will appear:

Deadlines

Entering 
Deadlines
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4. Under Constrain task, type the deadline date in the Deadline field or use 
the pull-down calendar to click on a date.

5. Click OK and you will now see a down-facing green arrow in the timescale 
that represents the deadline date you entered. If you rest your mouse pointer 
on it, you will see its screen tip.

If you want to be alerted before the deadline, it is possible to enter your deadline 
in Project 2013 at least one day before the actual deadline. 

You can move deadline dates by simply dragging the deadline arrow in the 
timescale to a new date. You can start dragging as soon as you see the four-arrow 
mouse pointer.

The down-facing arrow symbol for a deadline does not stand out in the timescale, 
particularly when there are many dependency arrows. We suggest you change it 
to a solid symbol and more striking color in the Bar Styles dialog box: on the 
Format tab, in the Gantt Chart Style group, click the Format Bar Styles down-
arrow in the lower right hand corner. 

Deadlines and other constraints can alter the critical path.

To remove a deadline, simply delete the date from the Deadline field on the 
Advanced tab of the Task Information dialog box.

You will not get automatic warning messages from Project 2013 if deadlines are 
overrun because of the slippage of a logical predecessor or the task taking longer 
than expected. What you do get is a missed deadline indicator in the Indicators 
column, which serves as a red flag that a deadline has been missed.

You can quickly display all tasks with deadlines by using one of the built-in 
filters. To do this:

Managing 
Deadlines
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On the View tab, in the Data group, click the Filter down-arrow, More Filters. 
The More Filter dialog box appears. Select Tasks with Deadlines, then Apply.

Press F3 to get rid of filtering.

Before discussing the types of constraints, we need to discuss the two basic 
scheduling regimes you can choose:

hh Forward Scheduling from the project start date
You do forward scheduling if you entered the project start date and want 
the model to tell you the expected finish date for the project. Under forward 
scheduling, tasks are scheduled as soon as possible (ASAP) by default.

hh Backward Scheduling from the project finish date
You schedule backward if you entered the project finish date and want to find 
out when to start the project to meet this date. Under backward scheduling 
tasks are scheduled As Late As Possible (ALAP) by default.

Forward Scheduling (ASAP)

Backward Scheduling (ALAP)

You can see whether you are using forward or backward scheduling by checking 
the Schedule From dropdown in the Project Information dialog box. To do 
this, on the Project tab, in the Properties group, click Project Information. 
If the value in Schedule from is Project Start Date, you’re using forward 
scheduling. If the value is Project Finish Date, you’re using backward scheduling.

If you change your scheduling regime, e.g., from forward to backward scheduling 
after you have entered tasks, the constraint for these tasks will stay ASAP; new 
tasks will be ALAP. Combining ASAP tasks with ALAP tasks in one schedule 
sometimes creates unexpected results.

Constraints
Scheduling 
Regimes
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You will have a schedule conflict when Project 2013 can’t find an acceptable and 
feasible schedule for you based on the input you’ve provided. For example, your 
schedule is currently 12 weeks long, but you have set a Finish No Later Than 
constraint for the project in week 11. Typically a schedule conflict occurs when 
a constraint date is not met. Project 2013 will immediately tell you when there is 
a schedule conflict with the message in one of the dialog boxes below. 

OR

You are forced to deal with the scheduling conflict because one of the two dialog 
boxes will keep popping up (unless you check the Don’t tell me about this 
again option).

Schedule 
Conflict
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To turn these notifications off:

1. On the File tab, in the Backstage view, click Options, Advanced.

2. In the Planning Wizard area, uncheck Advice about Scheduling and 
Advice about Errors. 

If you don’t understand why your schedule has a conflict, please click Help or 
use the checklist with schedule troubleshooting questions in the Chapter 14 
Summary. 

The eight types of constraints can be characterized as flexible, semi-flexible, or 
inflexible:

Tendencies (Flexible) constraints
hh As Soon As Possible (ASAP, the default under forward scheduling)
hh As Late As Possible (ALAP, the default under backward scheduling)

One-sided (Semi-flexible) constraints
hh Start No Earlier Than (SNET)
hh Finish No Earlier Than (FNET)
hh Start No Later Than (SNLT)
hh Finish No Later Than (FNLT)

Rigid (Inflexible) constraints
hh Must Start On (MSO)
hh Must Finish On (MFO)

Project 2013 uses forward scheduling as its default regime and schedules tasks 
As Soon As Possible (ASAP). Project 2013 will pull task bars in the timescale as 
far to the left as the network of predecessors allows.

Even when the regime is ASAP, you can still schedule certain tasks As Late As 
Possible (ALAP). For example, in a move project you might schedule packing 
equipment ALAP. Training is another task that should generally take place as 

Types of 
Constraints

Tendencies 
(Flexible) 
Constraints
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late as possible so that people remember what they’ve been taught when they 
need to use it. ALAP task bars will tend to go to the right in the timescale as 
much as the network of successors and constraints allows.

Note that the one ALAP task tends to be stronger than it’s ASAP successors, so 
check that the one ALAP task did not hijack the rest of your schedule.

Under backward scheduling, tasks are ALAP by default, but you can still change 
some tasks to ASAP scheduling.

Even though ALAP and ASAP do not have a constraint date, their attempts to 
pull tasks earlier or later have a tremendous impact on the schedule and are in 
that sense “constraining.”

Manually scheduled tasks use ASAP or ALAP constraint types only. You must 
change the task to be auto-scheduled to take advantage of other constraint types.

Semi-flexible or one-sided constraints limit the movement of task bars to only 
one direction, either to the left (no earlier than) or to the right (no later than):

hh Start No Earlier Than (SNET) and Finish No Earlier Than (FNET) 
constrain free movement of the task bars towards the left in the timescale: 
the start date (SNET) or finish date (FNET) cannot go to the left of the No 
Earlier Than date.

hh Start No Later Than (SNLT) and Finish No Later Than (FNLT) constrain 
free movement of the task bars towards the right in the timescale: the start 
date (SNLT) or finish date (FNLT) cannot go to the right of the No Later 
Than date.

An example of a Start No 
Earlier Than (SNET) 
constraint is when raw 
materials will not be delivered 
until a certain date and you 
can start the activity for which 
you need the raw materials no 
earlier than the delivery date.

An example of a Finish No 
Earlier Than (FNET) is when 
you need a final approval for a deliverable. You know the approval can take place 
during the next board meeting planned on the first day of every month. You 
enter a FNET constraint on the first of the next month. 

The No Earlier Than constraints are restricted from moving earlier in time (to 
the left in the timescale). They can be pushed to the right by the network without 

One-Sided  
(Semi-Flexible) 
Constraints

1 2 43

SNET

FNET

No Earlier Than 
Constraints
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a limit. Under ASAP scheduling they will not be able to cause a schedule conflict; 
in other words, they are soft constraints under forward scheduling.

Under backward scheduling, the project finish date is hard. As you enter 
dependencies you will see that the As Late As Possible (ALAP) task bars will 
be pushed out earlier in time (moving to the left in the timescale). They can be 
pushed to the left as far as the No Earlier Than date allows. If pushed any further, 
Project 2013 will alert you to a schedule conflict. No Earlier Than constraints 
are therefore said to be hard constraints under backward scheduling.

A tiny little red dot in the constraint icon in the Indicators column will tell you 
if a constraint is hard. If the dot is blue, it is a soft constraint.

An example of a Start No Later Than (SNLT) constraint might be the backing 
up of a computer system that can be scheduled at a later time, but would have to 
start no later than, let’s say, midnight in order to be finished on time.

1 2 43

SNLT

FNLT

An example of a Finish No Later Than (FNLT) constraint is when you commit 
to deliver a report no later than March 13 and this date is a do-or-die date.

In an instance such as this, we suggest you use both a deadline and a constraint. 
The deadline will give you an early warning before you miss the constraint (do-
or-die) date.

The No Later Than constraints are restricted from moving beyond the date 
specified (moving to the right in a timescale view). They can be allowed earlier 
by the network all the way up to the start date of the project. Under ALAP 
scheduling these constraints will not be able to cause a schedule conflict. In 
other words, they are soft under backward scheduling.

Under forward scheduling, the project start date is hard. As you enter 
dependencies, you will see that the As Soon As Possible (ASAP) task bars will 
be pushed out to the right in the timescale. They can be pushed out as far as the 
No Later Than constraint date allows. If pushed any further, Project 2013 will 
warn you that there is a schedule conflict. Therefore, No Later Than constraints 
are said to be hard constraints under forward scheduling.

No Later Than 
Constraints
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A tiny little red dot in the constraint icon in the Indicators column will tell you 
if a constraint is hard. If the dot is blue, it is a soft constraint.

The inflexible or rigid constraints—Must Start On (MSO) and Must Finish 
On (MFO)—fix one end of the task bar to the date indicated and deny any free 
movement at that end. Constraints like these will severely affect your schedule.

Note that the unconstrained end of the task bar can still move in either direction 
when you revise the estimate.

Use a semi-flexible constraint instead of a rigid or inflexible constraint whenever 
possible. With a one-sided constraint, the constrained end of the task (Start or 
Finish) can still move in one direction, giving your schedule more flexibility 
than if the end was not allowed to move at all—as is the case with the rigid 
constraints.

An example of a Must Start On 
(MSO) constraint is holding an 
important meeting that must 
start on January 9 at 9:00 AM.

An example of a Must Finish 
On (MFO) constraint is when 
you have a contractual date by 
which you must move out of 
an office space or pay a steep 
penalty.

Where you use an MSO constraint, the start will always be on the date indicated. 
With an MFO constraint, the finish will always be on the date specified. MSO 
and MFO constraints can easily cause schedule conflicts. These constraints are 
always hard constraints under both forward and backward scheduling. They 
should be used only when you absolutely need them to keep the schedule valid. 
Let’s explore some situations.

Deadlines do not need a lot of maintenance while the project is running, but 
constraints do. Every time you have a change in your schedule, you may either 
have to update all the constraint dates downstream, or you will have to solve all 
the schedule conflicts. If you don’t solve scheduling conflicts right away, Project 
2013 will keep popping up messages until you do. Constraints require immediate 
attention when you may not have time. If a task doesn’t have any constraints, its 
dependencies push it into place in the timescale.

We recommend, therefore, that you enter only the constraints that are absolutely 
necessary. However, you can enter many deadlines in your schedule without 
many disadvantages.

Rigid (Inflexible) 
Constraints

1 2 43

MSO

MFO

When Might You 
Need Constraints?
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Constraints should not be used to model temporary availability of resources. 
A better place to indicate temporary availability is through availability profiles. 
Constraints also should not be used to create a limited scheduling window for 
certain tasks, for example to force an office move task to the weekend. A better 
way to do that is through a Task Calendar (covered later in this chapter). Task 
calendars create a more dynamic model than constraints, because you can mark 
every weekend as a target for the move task. If one weekend cannot be met, the 
Task Calendar will force it to the next weekend and will update all dependent 
forecasts. With constraints you would be restricted to scheduling on one 
particular weekend.

Here are some situations where it may be appropriate to set constraints:

hh External dependencies
We recommended that an external dependency be entered as an extra 
milestone and that the milestone be held in place by a Start No Earlier 
Than (SNET) constraint.

hh Weather restrictions
For example, if you have to get road construction done before the rainy 
or winter season starts (or after it ends), a constraint can help. Later in 
this chapter we’ll cover another feature called Task Calendars that we 
recommend you use to schedule in these situations.

hh Group activities
Meetings, presentations, training, or general tasks that involve a group of 
people may require a set date. When the date is agreed upon, a constraint 
should be set on that date so Project 2013 does not move it off of its date. 
Often, you will use Must Start On or Must Finish On constraints here.

hh Certain milestones (see the following section).

Milestones are used in a schedule to indicate events like decisions, approvals, 
target dates, and ceremonies.

The type of constraint needed for a milestone will depend on the “hardness” of 
the milestone. The hardness of a milestone is the resistance you will experience 
in practice when you try to move its date.

hh For soft dates, you can use the deadline feature instead of constraints
hh For hard dates, use schedule constraints. The harder the date, the harder the 

constraint should be. The hardest constraints are MSO and MFO.

Here are the different types of milestones used in schedules, listed from soft to 
hard:

Types of 
Milestones
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hh Decision points
These are important events on which decisions about the remainder of the 
project are made. The decision can be:
h` Go/No-go: A no-go decision will end the project. A go decision will 

authorize spending for the next phase.
h` Go-left/Go-right: The how-to or direction is determined for the rest of 

the project. You will often find this type of milestone in R&D projects 
where the research findings determine the direction (the deliverables) 
for the rest of the project.

If there is a target date or a deadline for the decision point, we recommend 
using the deadline feature. The decision will typically not be taken until the 
required information is available. That is why these dates are often soft dates.

hh Target dates
These are soft deadlines that are inserted to break up a long series of tasks. 
They focus the efforts on finishing a component of a deliverable. The project 
manager decides with the team where to insert these target dates. Teams 
may need several target dates on components of their deliverable in order 
to meet the deadline of the overall deliverable. Target dates are interim 
evaluation points; they function as reminders to keep everyone focused and 
on track. For target dates, we recommend the use of the deadline feature 
and no constraints.

hh Do-or-die dates
These are hard deadlines (often contractual dates) by which you are 
committed to hand over a deliverable. These dates should be clear in the 
schedule at all times. We recommend you enter these into the schedule 
as deadlines as much as possible in order to keep the schedule dynamic. 
However, if one is a very hard contractual date (e.g., there is a huge penalty 
associated with missing the date), you could consider a Finish No Later 
Than (FNLT) constraint. This allows the task to float up to the constraint 
date and never pass it without immediately notifying you with a pop-up 
dialog.

hh Deliveries
We recommend you enter the delivery dates of raw materials, supplies or 
client deliverables as separate milestones in the work breakdown structure. 
The delivery date you agreed upon with the vendor, supplier or client should 
be entered as an event milestone with a Start No Earlier Than (SNET) 
constraint.

hh Ceremonies
Ceremonies are short official events to which many people are invited. If the 
duration of the ceremony is negligible, it can be entered as a milestone with 
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a zero duration. An example might be the official ribbon cutting to open a 
new plant. The date of a ceremony is often hard, because ceremonies are 
public events. The schedule needs a Must Start On (MSO) constraint for 
these events. If the ceremony has a duration, it is no longer a milestone, but 
a task and will still need a constraint.

hh Project end date
This is the delivery date for the project product. Meeting the project end date 
is always a challenge in project management. All the chains of dependencies 
come together in the project end milestone. A Must Finish On (MFO) or 
a Finish No Later Than (FNLT) constraint is often set on the project end 
date. You will immediately receive a scheduling conflict message when this 
date is in jeopardy. In many projects, a deadline date could do the trick as 
well. You will then only see the Missed Deadline indicator appear in the 
Indicators column if the deadline is missed.

When initially planning your schedule enter a milestone task as the last task at 
the bottom of your schedule with a deadline which represents the due date of 
your schedule. Then link all the tasks in the schedule to the milestone.

This is preferable to entering a constraint on your last task; it gives you the most 
flexibility in planning your schedule and you can visually see the date you are 
working towards.
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To access the options, click the File tab on the Ribbon to enter the Backstage 
view, then click the Options button.

P r o j e c t 
Options

Recommended Choices

Schedule Set the Schedule Options on the Schedule Tab:
Tasks will always honor their constraint dates
We recommend you keep this option on to make sure your 
schedule observes the few real and hard constraint dates that you 
may have in it. (We’ll cover this in a minute.) 

Just as with deadlines, if you have to be done before November 1, you have to 
enter October 31 as the constraint date. The constraint time will be at the end of 
the day on the date you enter. If you enter November 1 as the date, the task won’t 
be scheduled to be done until 5:00 PM on November 1.

You can set constraint dates in a variety of ways:

hh Use the Advanced tab on the Task Information dialog box

hh Use the task fields Constraint Type and Constraint Date

hh Drag task bars: 
This method will allow you to set only Start No Earlier Than (SNET) 
constraints under forward scheduling or Finish No Later Than (FNLT) 
constraints under backward scheduling.

hh Enter dates:
Under forward scheduling you can enter a start date that will set an SNET 
constraint, or you can enter a finish date that will set a Finish No Earlier 
Than (FNET) constraint. Under backward scheduling, entering a start date 
will create a Start No Later Than (SNLT) constraint; a finish date creates 
an FNLT constraint. (This is probably too much to remember!)

As is often the case in Project 2013, there are several ways to do the same thing. 
The last two ways are easy and quick, but require you to know and predict which 
constraints Project 2013 will set. Therefore, although we’ll discuss all four 
methods below, we recommend using the first two.

Entering and 
Removing 
Constraints in 
Project 2013

Choosing the 
Options

Entering 
Constraints
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We recommend you use either this method or the next method to set constraints.

1. Select the task.

2. On the Task tab, in the Properties group, click Information OR hold 
down Shift and press F2.

3. The Task Information dialog box appears. Click the Advanced tab; the 
dialog box should now look like this: 

 

4. Select the type from the Constraint type pull-down list and select a date 
from the Constraint date drop-down calendar.

5. Click OK.

With this method, you start by inserting two columns in your Gantt table.

1. First insert the field Constraint Type by right-clicking on the column 
heading before which you wish to insert and selecting Insert Column 
from the dropdown. When the new column list appears, type or select 
Constraint Type. 

2. Repeat the step above to insert the field Constraint Date as well.

3. You can now enter any type of constraint in the Gantt table by selecting the 
type from the list in the field Constraint type and picking the date from the 
drop-down calendar in Constraint date.

Setting 
Constraints 
Using the Task 
Information Dialog

Setting 
Constraints Using 
the Task Fields
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This method for setting constraints is often done accidentally and as mentioned 
earlier is not recommended since it requires you to predict the resulting 
constraint.

These steps assume that you drag the bar to the right, later in time.

1. Point to the middle of the task bar; make sure you see a four-headed arrow.

2. Click and hold down to drag the bar horizontally to where you want it 
scheduled. Make sure you see a horizontal two-headed arrow at this point.

3. Look at the pop-up window to see what the new dates will be: 

4. Release the mouse when the task bar is scheduled on the date you want. The 
Planning Wizard may prompt you to choose whether:
h` You want to keep the link and set a constraint when you moved it away 

from its predecessor, or
h` You want to set a link instead of a constraint when you moved it just 

behind another bar.

Answer the prompt of the Planning Wizard and click OK.

5. The task will now have a Start No Earlier Than constraint on it to keep it 
in its new place. (Under backward scheduling it will have a Finish No Later 
Than constraint.)

If you drag vertically, you will see the mouse pointer as a chain, and you will be 
creating dependencies instead of constraints!

Setting 
Constraints  
by Dragging Task 
Bars Horizontally
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This method for setting constraints is often done accidentally and as mentioned 
earlier is not recommended since it requires you to predict the resulting 
constraint.

In the field Start you can pick a date from the drop-down calendar. By default, 
this creates a Start No Earlier Than (SNET) constraint on the task under 
forward scheduling, and it creates a Start No Later Than (SNLT) constraint 
under backward scheduling.

In the field Finish, you can pick a date from the drop-down calendar. By default, 
this creates a Finish No Earlier Than (FNET) constraint on the task under 
forward scheduling, but it creates a Finish No Later Than (FNLT) constraint 
under backward scheduling.

Many people use the Start and Finish fields to schedule all their tasks. Most 
do not intend to create constraints, but are unaware that Project 2013 does 
exactly that. Their schedules become rigid and require a lot of work to maintain. 
If dependencies, resource constraints and calendars are used to drive the 
computation of dates instead, schedules require a lot less maintenance. We don’t 
recommend using the Start and Finish fields at all for data entry. In addition, 
using them will require you to memorize what type of constraint will be set 
under both forward and backward scheduling.

1. On the View tab, in the Data group, click the Tables down-arrow, More 
Tables. The More Tables dialog box appears: 

 

2. Select the Constraint Dates table in the list.

3. Click Apply. You can now see the fields Constraint Type and Constraint 
Dates to check all constraints on the tasks.

Setting 
Constraints  
by Entering  
Dates

To Check All 
the Scheduling 
Constraints
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4. You can apply a filter that displays all the tasks that have a constraint date. On 
the View tab, in the Data group, click the Filter down-arrow, More Filters. 
The More Filters dialog box appears. Select Tasks with Fixed Dates, then 
Apply. When done, press F3 to remove the filtering.

You can remove constraints one by one, but if you want to delete them quickly, 
you can use the fill-down feature to replace constraints with ASAP or ALAP. 
This is useful if you inadvertently entered dates in the Start and Finish fields 
without wanting the constraints that came with them.

1. To remove all constraints, click on a column heading in the Gantt Chart 
to select all tasks and on the Task tab, in the Properties group, click 
Information. The Multiple Task Information dialog box appears.

2. On the Advanced tab in the dialog box, in the Constraint Type list, select 
the appropriate constraint type: As Soon As Possible under forward 
scheduling or As Late As Possible under backward scheduling.

3. Click OK.

Make sure you don’t remove real constraint dates that are necessary to keep your 
project schedule valid.

You can focus on tasks with constraints by applying the filter 08 IIL Constraints 
other than ASAP.1

In dynamic scheduling practices, constraints have their limitations:

hh Summary tasks can only accept FNLT and SNET constraints
Project 2013 does not allow other types of constraints on summary tasks, 
because summary tasks would not be summarizing their detail tasks any 
longer. 

hh You can set a maximum of one constraint per task
Sometimes it would be nice to set two constraints on a task, especially when 
the task has to be done within a window of opportunity. For example, you 
can only do a test when a specialized lab is available. You cannot model this 
window with constraints, because you can only set one constraint on a task.

You can, however, use the Task Calendar feature that allows you to create a 
calendar for the task that reflects all the windows of opportunity, essentially 
allowing you to set multiple constraints 

An alternate approach to modeling a task that occurs within a window of time is 
the Hammock task discussed in Chapter 5.

1 This filter can be found in the file IIL Project 2013 Tools.mpp available for download at www.jrosspub.com. 
Click the link WAV Download Resource Center to enter the download site.

To Remove 
Constraints

Limitations of 
Constraints

J. Ross Publishing; All Rights Reserved



Chapter 6: Entering Deadlines, Constraints, and Task Calendars

261

6

By default, tasks are scheduled based on the Project Calendar. But Project 2013 
also allows you to create Task Calendars that override the Project Calendar for 
individual tasks.

Here are some examples of when you might want to use Task Calendars:

hh Create a winter weather 
Task Calendar to schedule 
all outdoor construction 
activities affected by winter 
weather, as shown in the 
illustration above.

hh In a research and development project, you can use a Task Calendar to 
schedule testing only for the times when you can use the lab.

hh Make sure that an office move takes place during a weekend instead of on 
weekdays

hh Make sure that demolition activities take place during evening hours or on 
the weekend

Create a Task Calendar when you want to force all of your resources on a specific 
task to work during a specific time. 

Task Calendars are good for tasks with or without resources assigned. If 
resources are assigned, the Resource Calendars and the Task Calendar may fight 
with each other, and if there are conflicts between the calendars, the following 
message will appear: 

Also, the Indicators column will display a warning icon when there is an 
unresolved conflict between calendars. You cannot leave these conflicts 
unresolved.

The order of precedence between the calendars is:

1. Task Calendar

2. Resource Calendar

3. Project Calendar

Task Calendars

Fall Winter SummerSpring

Construction
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Task Calendars override Resource Calendars, which override the Project 
Calendar. There is a task field Ignore Resource Calendar, which when selected, 
means that even if a resource is unavailable during that time, the Task Calendar 
will take precedence over the resource’s calendar and make the resource work. 

1. On the Project tab, in the Properties group, click Change Working Time. 
The Change Working Time dialog box appears: 

2. Select a base calendar that is closest to what you need for the new Task 
Calendar in the list For Calendar.

3. Click the Create New Calendar… button; the Create New Base Calendar 
dialog box appears: 

4. Enter a descriptive name for the new Task Calendar that reflects its settings 
and select either: 
Create new base calendar, or

Creating a New 
Task Calendar
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Make a copy of the calendar you selected under step 2.

5. Click OK; you have now created a new Task Calendar.

6. Enter any new task exceptions—like specific task holidays—into the Task 
Calendar by using the Exceptions tab on the Change Working Time 
dialog box. To do this:

a. Enter the name of the exception on the first empty line under the name 
column in the Change Working Time dialog box.

b. Select the Start and Finish of the exception in the next two columns.

c. Click on Details... and in the Details for dialog box, select non-
working times, decide the recurrence pattern, then decide the range of 
recurrence and click OK.

7. Enter any new task working days or working times into the Task Calendar 
by using the Work Weeks tab on the Change Working Time dialog box. 

a. Select Default on the first line of the Work Weeks dialog box to select 
ALL Work Weeks for this task calendar, or select the first empty line 
under Default to select a specific alternate work week.

b. If you did not select Default, enter the name of the specific alternate 
work week that you want to change under Default in the name column 
of the Change Working Time dialog box. 

c. Select the Start and Finish of the alternate work week in the next two 
columns. 

d. Click on Details... and in the Details for dialog box, select non-
working or decide the working times, decide the recurrence pattern, 
then decide the range of recurrence and click OK.

8. Now, all you need to do is to assign the calendar to the task.

1. Double-click on a task. 

Click the Advanced tab, and select the Task Calendar from the Calendar 
dropdown. You can also check the option Scheduling ignores Resource 
Calendars here if that is your decision in case of conflicts. 

OR

Right-click on the column heading before which you want to insert the 
Task Calendar column and choose Insert Column from the pop-up menu.

OR

Using a Task 
Calendar
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Click anywhere on the column before which you wish to insert the Task 
Calendar column, then on the Format tab, in the Columns group, click Insert 
Column. 

2. Type or select Task Calendar from the list of field names that appears.

3. Click in the Task Calendar field of a task and select a Task Calendar from 
the list provided.

4. The task will now display a Task Calendar icon in the Indicators column.

Here are some checks you can use to verify whether you’ve applied best practices 
in your use of deadlines and constraints in your dynamic model of the project:

hh Is the project deadline date captured in the schedule?
It can be set using the Deadline date feature or the Constraint feature in 
Project 2013. The deadline or constraint date needs to be set on the project 
finish milestone. Whether you use a deadline or a constraint depends on 
how hard the project target finish date is.

hh Are there as few as possible Task Calendars in the schedule?
As we discussed, Task Calendars have a very specific purpose and should 
only be used in those situations where needed.

hh Does the schedule have as few schedule constraints as possible?
Constraints make the schedule rigid and jeopardize its dynamic nature. 
However, constraints are legitimate on:
h` Recurring detail tasks like status meetings 1, status meetings 2, etc.
h` External dependencies such as delivery of supplies or arrival of materials
h` Activities that have to occur on an agreed-upon date, like presentations 

or training. In general these are activities in which a number of people 
are involved.

h` Do-or-die-by dates, such as launches or opening dates of events for 
which marketing and advertising has already been done. Huge recurring 
sporting events which take place at set times in the calendar would also 
be good examples. 

h` Activities affected by weather conditions, e.g., in Canada asphalting 
streets starts no earlier than April 1st, because of the cold. You can also 
use the Task Calendars feature for these situations. Task Calendars 
would be a better way in the case of the multi-year planning of 
infrastructural works because unlike constraints, Task Calendars will 
push a job automatically out to the next year if it will no longer fit in the 
current year.

Checks on 
Deadlines, 
Constraints, 
and Task 
Calendars
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You can display all tasks that have constraints by applying the filter 10 IIL 
Constraints other than  ASAP.2 The filter will not display recurring detail tasks. 
Recurring detail tasks have SNET constraints. This is because they are usually 
dependent on an established time rather on than another task.

2 This filter can be found in the file IIL Project Tools available for download at www.jrosspub.com. Please 
click the link WAV Download Resource Center to enter the download site.
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1. What is the difference between how Project 2013 treats constraints and 
deadline dates?

2. What is the question to be answered from a project model that is scheduled 
forward? What about one that is scheduled backward?

3. Which constraint types will possibly create scheduling conflicts for the start 
successor task when the predecessor task is late?

4. Would you set a constraint in the following situations? If so, which type of 
constraint? If you would recommend using a constraint, indicate the type in 
the table below.

Situation Type of Constraint
You have a board meeting coming up on January 16 
in which a go/no-go decision will be taken on the 
next stage of your project. The board expects certain 
reports to be ready.

A vendor needs to deliver custom-made computers 
to you that you need for testing activities in your 
project (computers delivered).

You have planned a “project burial” ceremony to close 
off your project. You have invited senior executives 
and other dignitaries for this special day.

A testing lab is only available to your project from 
March 1 to March 15.

5. Why would you want to minimize the number of constraint dates in your 
project model?

6. As a car manufacturer, you would like to use an outdoor test lab that consists 
of a 10-mile highway stretch on which different weather conditions can be 
simulated. The lab is fully booked, but there is a window of opportunity for 
your project from November 10-17 in 2015 or after April 1st in 2016. How 
would you model this in Project 2013?

For experience working with the features you’ve learned about in this chapter, 
we strongly suggest that you do the additional exercises for this chapter that 
are included in the Case Studies appendix, available to download in the WAV 
Download Resource Center at www.jrosspub.com.

Review 
Questions

Additional Practice
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Planning

2 Setup
1 Concepts

Initiating

Executing,
Monitoring & 
Controlling
  9 Optimizing
10 Updating
11 Reporting
12 Earned Value

13 Evaluating
Closing

3 Tasks
4 Estimates
5 Dependencies
6 Constraints
7 Resources
8 Assignments

Chapter 7: Entering Resources

With the tasks, estimates, dependencies, constraints (and deadlines) entered, 
you now have a Gantt Chart that is a dynamic model of the project. You could 
stop here if resources, workloads, or costs are of little concern to you. Usually, 
however, resources are a significant constraint in the schedule and to make it 
truly dynamic, you should add resources and their assignments to your schedule. 
The result is called a resource-loaded schedule.

After reading this chapter you will be able to:

hh Explain what resources are and when to add a resource to the project model
hh Identify and describe the different types of resources: work, material, and 

cost
hh Identify the important resource-related fields
hh Enter resources into a schedule using your address book or manual data 

entry
hh Enter the availability of different types of resources
hh Create Resource Calendars
hh Explain the cost features of Project 2013
hh Check the list of resources against best scheduling practices
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Resources are the people, facilities, machines, materials, or costs necessary to 
create the project product. Each activity typically needs one or more resources.

If you find an activity doesn’t need resources, we recommend you model it as a 
lag on a dependency or an event instead of as a task. For example, the task drying 
paint doesn’t need resources and would be better modeled as a lag. In this way, 
each task bar actually represents discrete effort. 

Apart from resources that produce deliverables, there are also people who are 
responsible for the activities. A responsible person doesn’t necessarily spend 
time and effort on project activities as a resource does. And while a resource 
is normally assigned to activities on the lowest level in the WBS, a responsible 
person is normally assigned on a higher level.

Responsibilities for deliverables are typically captured in a Responsibility 
Assignment Matrix1 (RAM Chart). Project 2013 doesn’t have special features 
to create a RAM type chart, but responsibilities can be captured in other ways.

We suggest you use one of the extra text fields to indicate responsibilities in 
your schedule without adding effort. Use the extra Text1 field, for example, and 
rename it Responsible Person by choosing Custom Fields on the Project tab in 
the Properties group. If you click the Lookup button, you can even create a pick 
list for this field. You can also display names of the responsible people to the left 
of the task bars in the timescale by choosing from the list Format Bar Styles 
group, on the Format tab. This method has the fewest complications and may 
therefore be the best method. We recommend displaying the names to the left of 
the task bars, since the names of resources are displayed to the right by default. 
In this way, it is clear who is responsible and who is a resource.

1 ——— PMBOK® Guide – Fifth Edition, PMI, 2013, p. 262.

What Is a 
Resource?

Responsible 
People

I’m sorry, I don’t think I’ll be attending
because I retired six months ago.

Hi! Today’s project 
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Project 2013 accommodates defining resources in the Resource Sheet and 
assigning resources in the Gantt Chart view. We will discuss defining the 
resources here in this chapter and assigning them in Chapter 8.

You should only enter a resource in the project model if you expect that resource 
to significantly affect the quality, duration or cost of the project. If not, you can 
keep your model leaner by leaving the resource out. 

A resource that is easy to replace is not likely to affect your schedule. Resources 
that are scarce can. For example, resources will increase the duration of your 
project if they aren’t available when you need them (e.g., backordered materials 
or delayed executive sign-offs). 

In addition, over-allocating resources can affect the duration of your project. If 
human resources are assigned too many tasks, their workloads need to be leveled 
and leveling often leads to longer projects. If you find that limited resource 
availability affects the scheduling of tasks, you have a resource-constrained or 
resource-limited schedule. 

Resources are the basis for project cost. To manage the cost of the project, you 
have to define the people, facilities, machines, materials, and their costs. While 
you may not be directly responsible for doing cost accounting, there is a growing 
trend to require clear accounting for project-related costs. If you are working 
with accountants, get their guidance about how to do the accounting in your 
project. You have a range of choices in Project 2013 regarding resources and 
their costs, from keeping it simple and not even including them to getting down 
into the detail of addressing the scheduling of people, machinery, equipment, 
facilities, and other resources.

On the File tab, in the Backstage view, click Options. The Project Options 
dialog box appears.

We recommend that you use the following settings when adding resources.

When to 
Add a  
Resource

Choosing the 
Options
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Project 
Options

Recommended Choices

Advanced Set the Advanced Options on the Advanced Tab:
General options for this project: All New Projects 
This sets the options as the default setting for any new schedules you 
create. Existing schedules aren’t affected, because the options are 
stored in the project schedule.  

Select the Automatically add new resources and tasks check box
This lets you enter a new resource without having to answer a prompt 
asking if you really want to create the new resource.

Default standard rate
Enter your most commonly used rate. You’ll then only have to enter 
rates for those resources where the rates are different from the default.

Default overtime rate
Enter a default rate to reduce the amount of typing you have to do.

Schedule Set the Schedule Options on the Schedule Tab:
Show assignment units as a: Percentage or Decimal
Units of resources can be expressed as a percentage or in decimals in 
the Max Units field (availability) and in the assignment Units field 
(workload). 

For example, if you have a resource that is available half-time to your 
project you can enter this as 50% (percentage) or as 0.5 (decimal) in 
the Max Units field. For part-time resources, Percentages seem to 
make the most sense.

On the other hand, if you’ll be using three carpenters on your project, 
you could enter them as a group and enter either 300% (percentage) 
or 3 (decimal). For consolidated resources the Decimals seem easier 
to understand. 

This option is a global option and applies to all your projects, existing 
or new. You can switch the option at any time. 

Project 2013 distinguishes between three types of resources: work resources, 
material resources, and cost resources. These are the three choices in the resource 
field Type on the Resource Sheet view. We will also talk about a special budget 
resource, used for budget tracking and comparisons (budget resources can also 
be work, material, or cost resources).

In practice, you will come across five different types of resources: human, facility, 
machinery/equipment, material, and cost.

Important questions for each type are:

Types of 
Resources
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hh Should the resource add to the total amount of effort in the project?
hh Should the resource be included in workload leveling?
hh Does the resource have a time-related or a unit-related cost?
hh Should Work, Material, or Cost be chosen in the resource-related field 

Type?
hh Should there be a Budget resource type associated with the resource?

We will discuss these questions for each type of resource:

hh Human resources are people whose efforts should be added in the Work 
field. The total amount of work per week for each resource should be 
reasonable, which means it is within, or close to, weekly availability. If there 
are over-allocations, their workloads should be leveled.

Human effort costs money, and human resources should be given a standard 
rate, an overtime rate, and a cost-per-use rate, if applicable. They generally 
have a time-related cost and the rate needs to be appended with /h (per 
hour), /w (per week), /mo (per month), or /y (per year).

hh Facilities should not add to the total amount of effort of the project (work) 
and therefore we make them material resources.

The cost of facilities is typically time-related, e.g., a monthly rent. Facilities 
therefore need a standard rate per time unit, and perhaps a cost-per-use 
rate. Unfortunately, only work resources can have a time-related rate. If you 
want to calculate time-related cost, you could use a workaround that will be 
explained later in the section Entering Facility and Machine Costs.

If you enter facilities as material resources, Project 2013 can’t do leveling, so, 
for example, it can’t prevent double reservations by leveling the workload of 
a conference room. You will have to keep an eye on the reservation of the 
facility yourself. You could enter the facility as a work resource to level its 
“workload,” but this would start adding its “effort” to the amount of work in 
the project, which is not desirable.

hh Machines are similar to facilities in terms of the points just made. Machines 
should not add to the effort of the project and should be entered as material 
resources.

Machines typically have a time-related cost and thus need a standard rate 
per time unit, but only work resources can have a time-related rate. We can 
use the workaround explained in the section Entering Facility and Machine 
Costs.

hh Material resources are consumable resources such as desktop computers, 
electric cable, meeting room, or concrete. They should not add to the 
amount of effort (work) of the project.
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Materials don’t have a capacity like humans or facilities and do not need to 
be leveled.

Materials do cost money and typically have a unit-related cost only. Materials 
should be entered as a material resource. The cost per unit should be entered 
in the Std. Rate field without a time unit.

hh Cost resources are financial cost items that are specific to the task such as 
hotels, meals, airfare, and car rentals. Cost resources don’t add to work and 
they don’t affect the scheduling of a task. These resources contain financial 
cost items that are not related to costs associated to work and material 
resources assigned to the task. 

hh Budget resources are a special category of resources that are created 
specifically to list a budget category needed within a project. Budget 
resources can be work, material, or cost resources. Once the budget resource 
is created and assigned, the project work and/or project cost amounts can 
be rolled-up, tracked, and compared to the budgeted amounts listed in 
the budget resource. It is important to remember that budget resources 
can be assigned only to the project summary task and must be specifically 
identified as a budget resource when created. Examples of budget resources 
are EMPLOYEE-BUDGET, PAPER-BUDGET, and TRAVEL-BUDGET.

In the planning phase, if you don’t know who is going to do a task, you can enter a 
resource under a generic name (e.g., junior programmer or senior programmer).

Not knowing the exact names of the individuals should not stop you from 
creating a resource-loaded schedule. Once you know who the people will be, you 
can easily reassign the tasks from the generic resources to real people. There are 
several easy ways to accomplish this. You can use the Generic field (see details in 
the Resource Fields section below).

On the View tab, in the Resource Views group, click Resource Sheet.

Check if the table Entry is active on the View tab, Data group, Tables down- 
arrow list. 

You will find the following fields in the Resource Sheet: 

Indicator

This field will display indicators for a variety of situations. For example, if a 
resource is over-allocated, this column will show a Resource over-allocated 
warning indicator.

Resource Name (required)

Generic 
Resources

Change the 
View to Enter 
Resources

Resource 
Fields
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Note that the name of this field in the database is Name. This is where you enter 
the name of the resource. 

Use a standard naming convention to prevent duplicating resources inadvertently. 
The convention should allow you to recognize and sort the resource names. We 
recommend using last name - first name when the list gets long.

Notice the use of a hyphen instead of a comma. The comma is used to separate 
multiple entries in a field. Project 2013 won’t let you use a comma in the resource 
name field because it thinks you are trying to enter multiple resources in one 
row.2 

What you type in the Name field will show up as the only name in the lists used 
for assigning resources, like the Assign Resources dialog. Therefore make sure 
that:

hh Your resource names are easy to recognize
hh Each resource name is unique

Make sure the same resource is not represented twice on the Resource Sheet, 
for example, William Smith and Bill Smith, or Thomas Charley and Charley 
Thomas.

Sort the resource list alphabetically.

1. On the View tab in the Data group, select the Sort down-arrow.

2. From the drop down list select Sort By...

3. In the Sort dialog, select Name from the Sort By drop down list, and check 
Permanently renumber resources.

4. Click the Sort button. The Assign Resources dialog sorts your resources.

Type (required)

The type of resource can be Work (default), Material, or Cost. Work resources 
are people. Material resources are facilities, equipment, or materials. Cost 
resources are financial cost items that are specific to the task such as hotels, 
meals, airfare, and car rentals.

Material Label (optional)

You can enter a label (for a material resource only!) that will show up in several 
other views and reports. For example, the label desktop computers will show on 
the y-axis in the Resource Graph view to indicate the number of units needed 

2 If you anticipate upgrading to Project Server, pick a resource naming convention that is consistent 
with your naming convention within Active Directory (if you use Active Directory for Windows 
authentication). This will facilitate importing legacy schedules into Project Server.
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over time. In the timescale of the Gantt Chart, it will show up to the right of the 
task bars.

The label is particularly important for bulk resources to indicate the unit of 
measurement: the material label defines one unit for the bulk resource. For 
example, concrete is measured in cubic feet or cubic meters. When 500 units of the 
bulk resource concrete are assigned, the material label will show up in the Gantt 
timescale as 500 cubic feet. 

Initials (optional) 

In previous versions of Project this field was very useful, because you could 
assign resources to tasks by typing their initials, but now you can point and 
click to assign resources or even select more than one resource with the Assign 
Resources dialog. You may still find Initials to be useful for reporting.

Group (optional)

You can use this field for any group identifier you’d like. We suggest you use it to 
record something about each resource that you may want to report on or filter 
on later. For example if you use it for department name you could filter all tasks 
for a department or see totals for work and cost by department.

Max Units (required for Work resources)

This is the maximum availability of the resource to the project:

hh Use 100% for a full-time resource in the Max Units field and 50% for a half-
time resource

hh For a consolidated resource the Max Units is the total number of team 
members on the team

hh You won’t be able to enter availability for material resources

Std. Rate (optional)

Enter the standard rate for regular work in this field (e.g., 10.50/h, for someone 
who earns $10.50 per hour). You don’t need a time unit for material resources; 
the rate will be calculated per unit of material you assign to the task. We’ll discuss 
assigning in the next chapter.
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You can use the following time units:

If you type You will see Which means
m min minutes

h hr hours

d day days

w wk weeks

mo mon months

y yr years

Ovt. Rate (optional)
Enter the rate for overtime work in this field. Do this only:
hh If you will pay for overtime instead of compensating with extra time off, and

hh If you will pay a higher rate than the standard rate.

Project 2013 expects you to indicate separately how many overtime hours are 
worked on each assignment; those hours will be charged against the overtime 
rate. Material resources can’t have an overtime rate.

Cost/Use (optional)
Enter the cost-per-use rate that is paid each time the resource is used, which 
means on each task to which it is assigned. The cost is calculated as the Cost/Use 
rate times the number of units assigned.

Accrue At (optional)
Tab to the Accrue at field and a pull-down button appears. Select one of the 
following from the pull-down list to indicate when costs are incurred:

Accrue at Incurs the Cost Example

Start As soon as the task starts. Actors

Prorated As the task progresses; the cost goes up with 
the % Complete.

Employees

End As soon as the task finishes. Consultants

The accrual options only pertain to standard and overtime rates; the cost per use 
is always accrued at the start of the task.

Base Calendar (optional)
Select a Calendar from the list. The Base Calendar specifies the general working 
hours and working days for the resource. You can create new Base Calendars. 
You can also override the Base Calendar and set individual working hours in 
the Resource Calendar. Base Calendars are useful in international projects; 
you can base the resources working in the UK on a UK Base Calendar and the 
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resources in the US on a US Base Calendar. Material resources cannot have a 
Base Calendar.

Code (optional)
Type an alphanumeric code, such as an accounting code. This is used to charge 
the expenses for the resource to a particular cost account. It can be useful for the 
finance department, but often the tasks or assignments, and not the resources, 
will be coded to charge to the cost accounts.

Budget (optional)
This field can be inserted in the Resource Sheet as a column which will display 
a Yes if the resource is designated as a budget resource and No if it’s not. After 
the Budget resource is created (as covered later in this chapter), double click on 
the budget resource name to pull-up the Resource Information dialog box and 
in the General tab, click the check box Budget to indicate its role as a budget 
resource.

Generic (optional)
Use the Yes/No Generic field to mark a resource as a generic resource (e.g., a 
carpenter rather than a specific individual). You can use generic resources during 
initial planning and then replace them with individual names. Generic resources 
are very useful for longer term planning. This field can also be inserted in the 
Resource Sheet as a column if you want to set several resources as generic at one 
time.

Inactive (optional)
The Yes/No Inactive field indicates whether the resource is still active in the 
resource pool or is inactive and kept for historical purposes only. This file can be 
inserted in the Resource Sheet as a column if you want to make it easier for you 
to set this value for more than one resource.

You can enter resources into the Resource Sheet in four ways:
hh Use the shared resource pool. The resources in this pool are managed in 

a single .mpp file and stored in a central location. See Appendix 1 for a 
discussion of consolidated projects and shared resource pools.

hh Download the resources from your Outlook address book.

hh Use the Active Directory to download the resources.

hh Key in the (rest of the) resources manually.

When connected to Project Server you are able to enter the resources from an 
Enterprise Resource Pool.

Entering 
Resources
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If you’re using Outlook for managing your contact information and address list, 
you may be able to download the resource names to Project from that list (so that 
you don’t have to retype them). If you keep your addresses in another contact 
management application, you should be able to import them into Outlook 2013 
by using the Import wizard in Outlook (on the File tab, select Open, then click 
on Import).

Once the contact information is in Outlook, you can then import it into Project:

1. On the View tab, in the Resources View group, click Resource Sheet.

2. On the Resource tab, in the Insert group, click on the Add Resources 
down-arrow. The Add Resources list is displayed:

3. Click Address Book, and the Select Resources dialog appears. 

Downloading 
Human Resources 
from Your Address 
Book
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4. In the Address Book drop-down, select the list you want to use. The list of 
resources will be displayed.

5. In the Search field, type in the first character(s) of the name of the person 
to add; the list scrolls alphabetically. Press the arrow keys up or down as 
needed to highlight the right resource. Press Enter or click Add or double-
click on the resource name.

The resource is now added to the list of people at the bottom of the screen 
that will be transferred into the Project 2013 Resource Sheet.

6. Repeat the previous step for all resources you would like to add.

7. Click OK; the resources are now added to the end of the resource list. You 
can repeat this process at any time to pick up additional resource names 
from your address book. You may want to sort the list alphabetically again 
to make it easy to find resources.

If you’re using the Active Directory to download the resources for your users’ 
information, you may be able to download the resource names from that list (so 
that you don’t have to retype them) using the following steps:

1. On the View tab, in the Resources View group, click Resource Sheet.

2. On the Resource tab, in the Insert group, click on Add Resources down-
arrow. The Add Resources list is displayed:

Using the 
Active Directory 
to Download 
Resources
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3. Click Active Directory… and the Select Users or Groups dialog appears.

4. In the Enter the object names to select box, type the object names that 
you want to find. You can search for multiple objects by separating each 
name with a semicolon. Use one of the following syntax examples:

DisplayName (example: FirstName LastName), ObjectName (example: 
Computer1), UserName (example: User1), ObjectName@DomainName 
(example: User1@Domain1), DomainName\ObjectName (example: 
Domain1\User1)

5. Click Check names. The resource is now added to the list of people at the 
bottom of the screen that will be transferred into the Project 2013 Resource 
Sheet.

6. Repeat the previous step for all resources you would like to add.

7. Click OK; the resources are now added to the end of the resource list. You 
can repeat this process at any time to pick up additional resource names 
from your Active Directory. You may want to sort the list alphabetically 
again to make it easy to find resources.

An easy way to enter data in certain cells is to click and drag over all cells in 
which you want to enter resource information. Multiple cells are selected with 
one cell still white, which is the input cell. Enter the data in this input cell and 
press the Tab key to make the cursor move to the next cell until you have entered 
them all. You can even select an adjacent series of cells by pressing and holding 
down the Control key while dragging.

Keying in 
Resources 
Manually
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Here are more precise instructions for the different fields:

1. We recommend you customize the table first so that it has the right columns 
in the right order for entering data:

h` Delete all columns you won’t use by clicking on their column headings 
and pressing the Delete key on your keyboard.

h` Insert new fields by clicking on Add New Column. A dropdown list 
appears with all the available fields. Select the field from the dropdown 
list.

h` You can drag a column by its heading if you want to move it. First click 
the column heading and when you see the mouse pointer drag the 
column to its desired place.

2. Enter the name of the resource in the field Resource Name and press:
Down-arrow key to go down (to the next row), or
Tab key to go to the right (to the next column).

3. If the resource is a material resource (facilities, machines, or materials), 
change the field Type from Work to Material and enter the unit of measure 
in the field Material Label (for example cubic yard for the resource concrete).

If you change the type of resource, you’ll lose any rates you may have entered 
for the resource. This is because Work resources require a time-related rate, 
like $50/h, whereas Material resources need a per-unit cost, like $150 per 
door.

4. Make sure material resources have a material rate and material label. When 
that resource is used, Project 2013 will automatically calculate and display 
the correct representation of the material.

5. For work resources only, enter the availability on the Resource Calendar or 
in the field Max Units. Project 2013 assumes that the availability of material 
resources is unlimited.
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6. Enter the cost rates in the fields Std. Rate, Ovt. Rate, and Cost/Use and 
determine when the cost will be accrued by choosing Start, Prorated, or 
End in Accrue at.

7. For cost resources, make sure that the resource Type field is set to Cost. 
Since Cost resources are task specific, do not enter in a cost for the cost 
resource until it is assigned to the task.

8. Enter the Base Calendar field and a list button will appear. Select the 
appropriate Base Calendar for the resource from this list. Normally this 
would be Standard unless more Base Calendars were created. You can 
create other Base Calendars by choosing Project tab, Change Working 
Time…, and clicking the button Create New Calendar. For more detailed 
information see the “Base Calendars and Resource Calendars” section later 
in this chapter.

For cost resources, enter the name of the cost resource on the Resource Sheet 
and select Cost from the field Type. Examples of cost resources are hotels, 
meals, airfare, and car rentals. Cost resources are assigned to tasks just like work 
and material resources. For example, you assign the airfare cost resource to a task 
and enter in a cost of $500 for airfare for that task on the Resources tab in the 
Task Information dialog box on the Task tab.

To enter costs for these resources select the task, then:

1. Click on the Task Information icon on the Task tab.

2. Select the Resources tab.

3. Enter the specific cost for the selected cost resource in the Cost column.

4. Click OK.

5. You can also enter in the cost for the cost resource in the Assign Resource 
dialog, when you first assign cost resources to the task. Click on the Assign 
Resources icon on the Resource tab. Then select the cost resource and 
then enter the cost in the Cost column in the Assign Resources dialog.

1. Go to the Resource Sheet and type in the budget resource name, e.g., 
TRAVEL-BUDGET.

For budget resources, use all caps and include the word BUDGET in the 
name to help you identify them for assignments. 

2. Select the type of resource, work, material, or cost budget resource, from 
the field Type. 

3. Complete the Material Label field:

Entering Cost 
Resources

Entering Budget 
Resources
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h` For Work Budget Resources, designate the budget as the budgeted 
number of hours worked. Note that for Work resources, you are not 
able to enter a Material Label.

h` For Cost Budget Resources, designate the budget as the budgeted 
cost amount. Note that for Cost resources, you are not able to enter a 
Material Label.

h` For Material Budget Resources, designate the unit of measurement 
for the material. For example, for the CEMENT-BUDGET material 
budget resource, designate the material label as Metric Tons on the 
Resource Sheet. Now when you assign the Material Budget Resource 
to the project summary task, you will be able to enter in the budgeted 
work amount for this project, say 5000 metric tons of cement . You can 
now track and compare current usage to the budgeted amount: in the 
Resource or Task Usage view, insert and compare the Budget Work 
field to the Work field for the material resource.

4. You must specifically identify the budget resource as a budget resource by 
double-clicking on the budget resource name or clicking on the Information 
icon on the Resource tab and opening the Resource Information dialog 
box. Then on the General tab, check the box for Budget and click OK.

Entering budget amounts will be discussed in Chapter 8 when we discuss 
resource assignments.

A Resource Calendar is a Calendar for a specific individual. Initially each 
Resource Calendar will have the settings you entered in the Project Calendar. 
You can then adjust individual 
working times and vacations in a 
Resource Calendar, but you don’t 
need to do this unless you expect 
the changes in availability to have 
a significant impact on the 
schedule. 

Apart from the Project Calendar, 
there can be one or more Base Calendars on which Resource Calendars can be 
based. For example, you will need Base Calendars if your team members are 
in different countries. You would create a Base Calendar for each country and 
then base each resource on his or her Country Calendar (see the illustration). 
If resources belong to different companies, you may also need multiple Base 
Calendars.

Base Calendars 
and Resource 
Calendars Standard (Project Calendar)

Base Calendar USA

Resources USAResources UK

Base Calendar UK   
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The Standard Project Calendar is the default Base Calendar for all resources. You 
can create new Base Calendars (and new task Calendars) in the following way:

1. On Project tab, in the Properties group, click Change Working Time; the 
Change Working Time dialog appears:

2. Click on the Create New Calendar button and the Create New Base 
Calendar dialog appears:

3. You can copy the standard Project Calendar as a starting point for the new 
Base Calendar. This is a onetime affair; the standard Calendar will not 
continue to be synchronized with the Base Calendar. (You’ll see this if you 
look back at the illustration of Calendar relationships at the beginning of 
this section and note the dotted arrows between the Project Calendar and 
the two Base Calendars. Also note the solid arrows that indicate that the 
standard Calendar does continue to update all the Resource Calendars.) 

Creating a Base 
Calendar

J. Ross Publishing; All Rights Reserved



284

Dynamic Scheduling® with Microsoft® Project 2013

Enter the name of the new Calendar and select either Create new Base 
Calendar or Make copy of Standard and click OK.

4. You are now back in the Change Working Time dialog, but with the newly 
created Base Calendar shown in the list For Calendar: at the top of the 
dialog.

h` Enter the default working days and times for the new Base Calendar in 
the Work Weeks tab. Select [Default], then select the days, click on 
Details. Then select From/To times in the table, and click OK.

h` Enter the holidays or non-working day exceptions in the Exceptions 
tab. Selecting the first blank cell, enter the exception name, e.g., Spring 
Vacation, then select the days on the Start and Finish columns, and 
click OK.

You are now back in the Resource Sheet view (if not, please switch to this 
view). In the resource-related field Base Calendar you can select the new Base 
Calendar from the list and assign it to certain resources. The resources will then 
be based on the Calendar and Project 2013 will schedule their work accordingly.

The Resource Calendar will initially have the same working times and holidays 
as the Project Calendar (or Base Calendar if the resource was based on a Base 
Calendar). You can override these times and holidays on each individual 
Resource Calendar. 

Resource Calendars

Project Calendar or Base Calendars

If someone takes a vacation, assignments will be delayed until the resource 
returns. The duration of the project will increase, and a poorly timed vacation 
can jeopardize deadlines. For these reasons it’s important to model vacations in 
Project 2013. It’s not a lot of work, so there’s no good reason not to do it.

To edit a Resource Calendar you can:

Double click on a resource or click on a resource and click on the Information 
icon on the Resource tab, and in the Resource Information dialog, click 
Change Working Time. This will allow you to edit one resource at a time. 

OR

If you want to edit several Resource Calendars in a row:

Editing a 
Resource 
Calendar
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1. Click the Change Working Time icon on the Project tab; the Change 
Working Time dialog appears: 

2. Select the resource for which to set the Calendar in the For 
calendar: list box. (If you don’t find any resource names in 
this list, you have not entered the resources yet into your  
schedule.)

Now you’re ready to enter specific working days and hours for the resource.

3. If you put vacation time or unique hours on a resource’s Calendar, add a 
“Note” to the resource on the Resource Sheet to help you remember. This 
saves you from having to scroll through the Resource Calendar, or print 
an exception report to find a resource’s vacation or unique working hours 
information.

1. To specify the normal business work week in the specified Resource 
Calendar, select the Work Weeks tab near the bottom of the Change 
Working Time dialog box. If you have a Monday to Friday workweek, you 
can select the workdays by selecting the Default row on the Work Weeks 
tab and then clicking on Details to open the Details for ‘[Default]’ dialog 
box.

Entering Working 
Days and Hours 
for the Resource 
Calendar
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2. When you select any Monday through Friday, the default is set for all 
weekdays to working days with default working hours of 8:00 AM-12:00 
PM and 1:00 PM-5:00 PM. It is here, in the Details dialog box, that you 
can change these default working times.

3. You have three choices in the Set working time for this work week buttons 
above the From/To times table: 
h` Use Project default times for these days 
h` Set days to nonworking time
h` Set day(s) to these specific working times

4. In the Details dialog, select the specific days you want to change. Select 
consecutive days by clicking the mouse and dragging downward, or select 
nonadjacent days by holding down the Control key and selecting each day 
you need. 

5. To set these days as nonworking time, select Set days to nonworking time. 

6. To change the working times of a working day(s) or to change a nonworking 
day to a working day, select the day(s) in the table and select Set day(s) to 
these specific working times. 

7. Next, in the From/To times table, enter the start and finish working times 
for the resource. Click into the next lower blank cell when completed to 
make sure your start and finish times are entered. 
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8. Click OK at the bottom of the Details dialog box and then click OK in the 
Change Working Time dialog box. 

You’re now ready to enter specific nonworking days or hours (exceptions), like 
vacations for the resource.

1. While still in the Change Working Time dialog box of the specific 
Resource Calendar, click the day in the Calendar whose working times 
you want to change. Notice that after clicking on a specific day, the working 
times information about that specific day is represented to the right.

2. Next, select the Exceptions tab and select the next available blank row 
in the Name column. Once selected, enter the name of the Calendar 
exception, like Spring vacation and press the Tab key. The start and finish 
dates are automatically entered, defaulting to the date that you clicked in the 
Calendar. You can change this date now, if needed, by editing the start and 
finish dates. 

3. Click on Details to open the Details dialog box. Notice that the default 
changes to a non-working day for the date that you selected. 

4. If the exception is a change other than to a non-working day, you can change 
this in the Details dialog box. For example, select Working times, then 
change the times in the From/To tables as needed. 

5. Click OK at the bottom of the Details dialog box and then click OK in the 
Change Working Time dialog box.

The task-related field Ignore Resource Calendar is by default set to “No” for all 
tasks. This field determines if Project 2013 will use the Resource Calendar when 
scheduling assignments. The field is useful when the task also has a task Calendar. 
The task Calendar overrides the Resource Calendar. With the new field you can 
let Project 2013 know that you have resolved the conflict between the Resource 
Calendar and the task Calendar. If you leave it set to “No,” the Calendar conflict 
icon will stay visible in the Indicators column. If you change it to “Yes,” it will go 
away. The schedule should stay the same.

The working hours in Resource Calendars can become very intricate and require 
a lot of data entry, such as when there are resources working day or night shifts in 
alternating weeks. You have to ask yourself if you would prefer to manage these 
shift resources as a consolidated resource instead of as individual resources. If 
you choose the latter option, your schedule might become very maintenance-
hungry.

We don’t recommend you model the exact working hours of individual resources. 
There seems to be little gain in that in terms of accuracy of the forecasts and a lot 
of effort to keep them up to date.

Entering Resource 
Calendar 
Exceptions 
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The Fixed Duration tasks will look at the Resource Calendars, but may extend 
the task duration and task bar when one of the assigned resources is not available. 
This surprises many people. Project 2013 does prompt you before extending a 
fixed duration.

The maximum units (Max Units) of a resource define what percentage of a 
resource’s work hours is available to the project. In the illustration you can see 
that Tom works 8 hours per day 
and if the Max Units is 50% 
there would be a steep over-
allocation (blue).

If the Max Units is set to 100%, 
there is a small over-allocation. 
If it is 150% there is remaining 
availability. You can see that the 
percentage entered in the Max 
Units field determines what will 
constitute an over-allocation for the resource.

Note that the Max Units percentage is relative to the working hours entered 
on the Resource Calendar. The working hours can change from week to week. 
In other words, if you enter 50% as the maximum units, the person would be 
available 4 hours per day during full-time working hours. If the working hours 
are only a half day during certain days, the availability would be only 2 hours per 
day during those days.

The availability of resources varies from one resource to another and from week 
to week. We’ll discuss the different types of availability and how to enter them 
in Project 2013. 

In many cases, you’ll have to edit the Resource Calendar. If you are a project 
manager in the Project Server environment you may not have the proper access 
rights to add or change resource availability in the enterprise resource pool, but 
you still need to know how to do this for the resources that are private to your 
project, called local resources.

If you have Lync 2010 or later installed on your computer, you can take 
advantage of the messaging feature in Project 2013 that helps you stay in touch 
with your team members. This will allow you to get progress updates and ask 
quick questions (in particular to confirm availability) all without leaving Project. 
You can start using Lync by just hovering over a Resource Name in any view 
and start an IM session, a video chat, an email, or even a phone call. Once you 
start an Instant Messaging session, you may access more functionality: 

The Max Units 
of a Resource

Tom Works 8 hrs/day:
        From:           To:
       8:00AM         12:00PM
       1:00PM          5:00PM 

He is available to this project:

Resource Graphs

Max. Units = 50% Max. Units = 100% Max. Units = 150%

150%
100%

50%

12hr

4hr

8hr

Resource 
Availability

Stay in  
Touch with  
Team  
Members 
to Confirm 
Availability
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Recent versions of Skype will provide you with similar functionality as long as 
the resource’s Email Address is populated to enable Lync presence information 
for that resource. This field is populated when adding resources via Active 
Directory or Active Directory Synchronization.

Example: Someone loaned to the project for a month.

Enter the temporary availability of a resource in the Resource Information 
dialog box:

1. Double-click a resource in the Resource Sheet view or Select the resource, 
click Resource Information on the Resource tab.

2. Click on the General tab and select Change Working Time; the dialog 
should now look like this: 

Temporary 
Availability
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3. Select the Work Week tab and select the next blank cell under Default.

4. Type in a name for the temporary availability, like April 2014 and press the 
Tab key.

5. Select the Start/Finish dates to define the period of temporary availability.

6. With the specific Start/Finish dates selected in the table, click on Details 
to open the Details dialog box for the selected temporary work weeks.

7. Select the days, (like Monday through Friday), in the Select Day(s) table 
and then either select Set days to nonworking times or Set day(s) to these 
specific times, (set specific times here).

8. Click OK in the Change Working Time dialog box.

Example: Someone who’s available full-time one month, but only half-time the 
next month.

In Project 2013 you can easily model varying availability. You can set up an 
entire profile of availability, such as 80% in April, 50% in May, 100% in June, etc. 
To enter the availability profile:

Varying Availability
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1. Double-click a resource in the Resource Sheet view or Select the resource, 
click Resource Information on the Resource tab.

2. Click on the General tab and select Change Working Time; the dialog 
should now look like this: 

3. In the fields Available from and Available to enter the dates when the 
resource is available and the percentage of availability in the Units field.

4. If you have multiple periods to enter, after you enter the Available to date 
for the first period Project 2013 automatically fills in the next Available 
from date with the next day.

5. The Max Units field in the Resource Sheet can only display one percentage of 
all percentages entered in the availability profile. The one number displayed 
in the Max Units field will be the availability percentage as of the current 
date in the Project, Project Information dialog. As time goes by, the field 
Max Units will display all the different values from the availability profile.

A part-time resource is someone who works fewer hours per day or fewer days 
per week than a full-time-equivalent resource as defined in the File tab, Options, 
Schedule, Hours per Day setting.

Part-time resources can be:

hh People who work fewer than full-time hours each workday.

Part-Time 
Availability
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Set the working-time hours in the Resource Calendar to the appropriate 
number of hours per day. For example, the working hours could be set to 
1:00 PM-5:00 PM for an afternoon job. We recommend this method.

OR

You can enter hours in the Resource Sheet with the Max Units set to 4h/8h 
* 100% = 50%. A problem with this method can be that all assignments will 
be at 50% involvement, and the person assigned to a meeting of 2 hours will 
be recorded as only spending 1 hour (2h * 50% = 1 hour) in that meeting, 
which may be unintended.

hh People who work 4 out of 5 weekdays.

Enter this into the schedule by changing the appropriate weekday to a 
nonworking day in the person’s Resource Calendar. (See “Entering Working 
Days and Hours for the Resource Calendar” above.)

hh Someone who is working on multiple projects and only available part-time 
to your project.

By default Project 2013 considers a full-time person to be someone who 
works 40 hours and 5 days a week. Microsoft has designated this as the default 
workweek, and any diversions from this are called exceptions.

People who work full-time need to have their Max Units set to 100% or 1.

The working hours set in the Resource Calendar should correspond with the 
number of Hours per Day and Hours per Week settings in the File tab, Options, 
Schedule command. For example, if the hours per day in File tab, Options, 
Schedule command is set to 7.5 hours/day, the Calendar should show, for 
example, 8:00 AM-12:00 PM and 1:00 PM-4:30 PM (double-click on the 
resource and click on Change Working Time… to check this). If these two 
settings are out of sync, you will typically see decimals appear in durations, like 
1.07 day.

One example of a compressed workweek is when a person works 10 hours per 
day, 4 days per week (called a 4-40 workweek). If there is more than one resource 
who will work a particular type of compressed workweek, we recommend you 
create a Base Calendar first. You can then base all resources who share the 
compressed workweek on this Base Calendar.

If you have only one resource working a compressed workweek change the 
Resource Calendar. For a 4-40 workweek you would typically enter it this way:

1. In the Resource Sheet select the resource, click Resource Information on 
the Resource tab, and the Resource Information dialog appears.

Full-Time 
Availability

Compressed 
Workweeks 
(Green Weeks)
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2. Click the Change Working Time button; the dialog should now look like 
this:

3. Select Default on the Work Weeks tab in the Change Working Time 
dialog. 

4. Click on Details, select Monday through Thursday, (hold down your 
Control key to select more than one day), and click on Set day(s) to these 
specific working times: 

5. In the first From/To table, enter in 7:00 AM and 12:00 PM; in the second 
From/To table, enter in 1:00 PM and 6:00 PM. Then click OK.

6. Click on Details again, select Friday and click on Set days to non working 
times. Then click OK, and then OK again in the Change Working Time 
dialog.

The 4-40 Calendar is now created. Here, the resource is working 10 hours per 
day (40 hours per week), Monday through Thursday and off on Friday. 

If you need to adjust a Resource Calendar for a special circumstance that occurs 
on a regular basis, find a way to model it rather than spending time adjusting 
it when it occurs. For example, if a resource gets every other Friday off, do not 
mark the Calendar that way, instead mark every Friday off and divide the total 

J. Ross Publishing; All Rights Reserved



294

Dynamic Scheduling® with Microsoft® Project 2013

hours the resource works on Monday through Thursday. Although this is not 
perfect, it may be close enough to model your situation.

Overtime work is work done outside the regular work hours as indicated in the 
Resource Calendar (or Project Calendar).

In the initial planning phase of a project, you wouldn’t normally plan overtime 
unless the project is extremely time-constrained. Normally the overtime feature 
is only used during the execution phase, to try to compensate for slippages.

Overtime can be entered in different ways depending on whether you pay and 
what rate you pay for overtime:

hh If the resource is not paid for overtime, but instead is compensated with 
extra time off, there are several ways to model this:
h` You can enter the overtime by increasing the Max Units in the 

Resource Sheet to greater than 100%. This is the quick and easy way to 
enter overtime, and the resource will be working overtime during the 
entire project.
OR

h` To be somewhat more precise you can create an availability profile in 
the Resource Information dialog on the Resource tab. In Resource 
Availability you could specify overtime just for the period in which the 
resource works more than 100%.
OR

h` Increase the working time in the Resource Calendar. For example, 
somebody works 10 hours overtime in one week, and in the second 
week the overtime is compensated with time off.
OR

h` Enter the overtime by changing holidays or weekend days in the 
Resource Calendar to working days. Later, weekdays are set to 
nonworking days to compensate in time.

hh If the resource is paid for overtime hours at the regular rate, you only need 
to check whether you kept the over-allocations reasonable. All regular and 
overtime hours worked are charged at the same standard rate.

hh If the resource is paid for overtime hours at a higher rate, you have to enter 
all the hours worked in overtime separately. Refer to Chapter 8 for an 
explanation of how to enter overtime hours. 

Consolidated resources are multiple resources who are entered into the schedule 
as one group instead of as individuals. For example, you can enter five Visual 
Basic programmers as five separate individuals, but you can also enter them as 
one team of five (a consolidated resource).

Overtime 
Availability

Consolidated 
Resources
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Consider using a consolidated resource instead of a list of separate individual 
generic resources if skill sets are essentially equivalent. Depending on the 
situation, you may not need to replace the consolidated resource with actual 
names. This can be useful in modeling resources of third parties or consolidated 
resources who are not directly involved in your project. 

You enter a consolidated resource as a single line item. The maximum units 
are set to the number of full-time equivalent individuals who are part of the 
consolidated resource. Full-time equivalency is defined in the File tab, Options, 
Schedule tab, Hours per Day setting. For example, if you have two full-timers 
and two half- timers on a team, the maximum units for that consolidated resource 
should be set to (2 * 1) + (2 * 0.5) = 3 or 300%.

Consolidating resources can also be a wonderful way to keep the devilish details 
out of your schedule. For example, you can make an agreement with a team 
of three resources that you will not give them more work than three full-time 
equivalent resources. They will have to determine among themselves who will 
do which task, and because they know each other’s expertise best, teams can be 
very good at that. As a project manager, you will spend a lot less time maintaining 
detailed resource data and keeping the individual workloads leveled. 

Consolidating resources only makes sense if the resources can substitute for 
each other or if the resources are functioning as a small work group, a team. If 
you have experienced and novice resources, you can create two consolidated 
resources: junior and senior. For example, if you find that the experience level 
among your programmers varies widely, create a group of junior and a group 
of senior programmers. If that does not provide enough precision, you have to 
revert to modeling resources individually.

Economists distinguish between variable cost and fixed cost:

hh Variable costs can vary with the amount of time needed, units consumed, 
or number of times used. Labor cost is a time-related human resource 
cost. Facilities can also have time-related costs, like rent or lease expenses. 
Machines can have:
h` Time-related cost such as rent

h` Unit-related cost such as for paper used in a newspaper printing machine

h` Use-related cost such as the setup cost of the printing machine. This can 
be entered in the Cost/Use field if the cost is incurred on every use of 
the resource. 

An Overview of 
Costs
Cost Situations
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hh Fixed costs typically are associated with tasks. 
Examples are expenses for licenses, patents and any fixed-price contracts 
given to subcontractors. Entering fixed costs using the resource type Cost 
and the Fixed Cost field will be covered in Chapter 8. 

The following table provides an overview and examples of the different types of 
costs as well as the way these costs are typically entered in Project 2013:34

Cost Type Example Resource 
Type

Rate Field Accrue at

Time related 3 days of work @ 
300/d

Work Std. Rate Prorated

2 months rent @ 
400/mo

Material3 Std. Rate Prorated

Unit related 3 doors @ 150/door Material Std. Rate Start

Use related $200 up front for 
bulldozer

Material Cost/Use Start (by 
default)

Varying rate Work @ $300/d, 
after  
January 1st $350/d

Work Cost Rate
Table

Prorated

Fixed Air Travel $1000 
for a trip from San 
Antonio, TX to 
Atlanta, GA.

Cost In the 
Assign 
Resources 
dialog box

Fixed Fixed-price contract 
painting the house: 
$8,500

— Gantt Chart: 
Fixed Cost

Task Field: 
Fixed Cost 
Accrual4

The first thing to determine for the expense is the resource type: work, material, 
or cost.

Then the rate needs to be entered in the appropriate rate field; Project 2013 has 
many resource-related rate fields: Std. Rate, Ovt. Rate, Cost/Use, and Cost rate 
tables.

In the field Accrue At, you determine when the cost will take place:

hh If you select Start, the cost will be scheduled on the start date of the 
assignment. Actual costs will be incurred on the Actual Start date.

3 If you make the facility a material resource, you have to enter the consumption rate in the assignment 
Units field in order to get a time-related cost. The consumption rate is the number of units used per time 
unit.

4 The task-related field Fixed Cost Accrual has the same options as the resource-related field Accrue At: 
Start, Prorated or End.
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hh If you select Prorated during the planning phase, the cost is spread across 
the task duration proportional to the number of hours that are scheduled to 
be worked each day. During the execution phase, the actual costs accrue on 
the dates on which the actual hours were worked.

hh If you select End the cost is accrued on the finish date of the task. Actual 
costs will be incurred on the Actual Finish date.

Material costs are often accrued at the start, whereas facility and machine costs 
are often accrued as prorated. For human resource costs, employees are typically 
prorated, whereas cost for consultants is often incurred at the end.

The Cost/Use is always incurred at the start of the task and cannot be changed.

Project 2013 also has task-related cost fields: Fixed Cost and Fixed Cost Accrual. 
These are useful for entering firm fixed-price contracts and license costs. Fixed-
price contracts often relate directly to a deliverable and license costs are often 
inputs to detail tasks. It makes sense to enter them in the task-related field Fixed 
Cost.

In practice, you will find more variations:

hh A resource can have more than one type of cost associated with it. For 
example, a maintenance man can have a per-use fee of $50 for travel in 
addition to an hourly rate of $100. In this case, you would enter the per-use 
fee in the Cost/Use field and the hourly rate in the Std. Rate field.

hh The cost rates themselves can change over time; this is known as varying 
cost rates or a rate profile. In Project 2013 you can capture a rate profile in 
the feature Cost Rate table. You can access the cost rate tables for a resource 
by double-clicking on the resource and clicking the tab Costs. Depending 
on when the effort is scheduled, Project 2013 will automatically take the 
appropriate rate to calculate the cost. 

hh You can have multiple cost rate tables per resource. Project 2013 provides 
up to five tables for each resource, so you can create five rate profiles per 
resource. For example, if you have a resource who does systems analysis, 
programming, and testing, you could specify three different rate profiles (A, 
B, and C) for each of these activities. When you assign the resource, you 
have to indicate per assignment which rate profile you want to use.

hh Materials may have a consumption rate: how many units of the material are 
used per time unit? For example, you pour concrete that costs $1 per cubic 
foot and you know that you typically pour 2000 cubic feet a day with the 
crew you have. This consumption rate can be entered in the assignment-
related Units field when you assign the resource to the task. In the Assign 
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Resources dialog you would enter 2000/day in the field Units. If the 
duration of the task is three days, the cost will be:
3 days * 2000/day * $1/cubic foot = $6000.

The duration of the task will determine the total cost for the task, and if 
the duration expands, more units of material will be consumed, which will 
increase the cost of the task. Essentially you have modeled a time-related 
cost for material resources.

hh You may need to attribute a portion of a large capital cost expenditure to a 
project. For example, you may need to buy expensive test equipment that 
will be used in future projects as well. You only want part of this capital 
expense charged to your project, the part that your project should carry as 
an expense. If you know the amount, you can enter it in the task field Fixed 
Cost. Project 2013 does not have features to calculate the amount to charge 
to one project (project-related depreciation cost). You can use Excel to 
calculate the contribution per project.

hh You may encounter discounts when purchasing large volumes of supplies or 
raw materials; you would need to enter a lookup table with all rate segments. 
This is something Project 2013 cannot easily handle. Again, you can use 
Excel.

hh You may need to charge taxes or subtract refundable taxes to the cost 
amounts. Again, Project 2013 does not have features for this and Excel or 
your accounting system might help.

If, for example, you temporarily hire a programmer at $300/day, you can enter 
this in the Resource Sheet with the following steps:

1. Choose View tab, Resource Sheet.

2. Enter the name of the resource in the field Resource Name.

3. Leave the Type of the resource set to the default setting of Work.

4. Enter the rate in the field Std. Rate; for the programmer you would enter 
$300/d.

5. Enter the other cost rates Ovt. Rate and Cost/Use, if applicable.

6. Select an Accrue At option; choose Start, Prorated, or End. The accrual 
determines when the cost will be incurred in the schedule and is important 
for cash flow reports.

7. Assign the human resources to the tasks (we’ll discuss this in the next 
chapter).

Entering Human 
Resource Costs
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Create an “average” or “blended” billable hourly rate for each resource instead 
of using their actual rate. This keeps their actual rates confidential. For example, 
some companies use an average rate for all resources, such as $60 per hour or 
$75 per hour. Some companies use a “blended” rate for resources. This rate is 
more specialized by the resource’s role or responsibilities. (Project managers 
could be at $60 per hour, developers at $75 per hour).

The time-related cost for facilities like rental and lease should be entered as 
material costs.

The cost of material should be incorporated into the project model only if it will 
be paid from your project budget, and if it is significant enough to track.

If you expect many small expenses, don’t track each expense separately. Project 
2013 is not meant to be used as an accounting system. We recommend you create 
a petty cash or expense category and manage it as a separate budget line item. 
You can enter it as a Fixed Cost on the project summary task or on a separate 
detail task, like manage petty cash, forcing Project 2013 to include it in the total 
project budget.

If you decide a material expense should be tracked, enter it this way:

1. Choose View tab, Resource Sheet.

2. Enter the name of the resource in the field Resource Name.

3. Click in the field Type for the resource and a list button appears: Work; 
select Material from this list.

4. Enter a Material Label, which will show up in the Resource Graph View 
and other views to remind users that this is a material resource. Enter the 
label in plural, for example bricks instead of brick, because you typically 
assign more than one unit. You can even enter thousand bricks if you will 
enter the cost of 1000 bricks in the Std. Rate field instead of the cost of one 
brick. For bulk resources, you have to enter the unit of measurement; for 
example, for concrete this would be cubic yards or cubic meters.

5. In the Std. Rate field, enter the cost per unit for this resource. For bricks we 
could enter $2.00, for example. You can fill in a Cost/Use as well; for the 
bricks this could be the cost of transportation to the site, let’s say $400.00. 
The overtime rate field is neither available nor needed for material resources. 
Notice that you cannot enter the time unit (/h or /d) for material resources; 
use consumption rates to model time-related cost for material resources.

6. Select the Accrue At method to determine on which date the cost will be 
scheduled in a time-phased view. You can choose Start, Prorated, or End. 
Materials are often accrued at the start. Prorated is spread evenly with the 

Entering Material 
Costs
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number of hours that resources work on each day of the task duration. The 
Cost/Use is always incurred at the start of the task and cannot be changed.

The next screenshot of the Resource Usage view shows how the accrual for 
material costs works. The 1000 bricks cost $2 each and are accrued at the start of 
the task: 1,000 * 2 = $2,000. The mortar costs $5 per cubic foot and is accrued 
evenly with the hours worked on the task. The trowels at $20 each are accrued 
at the end of the task:

We still need to learn how to assign the number of material resources to the 
tasks. We are going to learn this in Chapter 8.

This is the most difficult resource situation to enter into Project 2013. The use of 
facilities and machines should not add to the Work (effort) of the project. This 
leads to the conclusion that they have to be entered as Material resources. But 
you cannot enter a time-related rate, like $400/day, in the Standard Rate field for 
material resources, though this is quite a common cost arrangement for facilities 
and machine rental. You can only enter unit- or use-related cost. For example, if 
you pay a fixed amount for every use of a training room, you can enter that cost 
in the Cost/Use field.

The best way to model time-related cost for facility and machine resources is to 
enter the resource as a material resource and use the consumption rate feature as 
a work-around to model its time-related cost for the task. The consumption rate 
is entered into the assignment-related Units field, which is found in the Assign 
Resources dialog or the Task Form.

For example, the training room costs your project $600/day. You enter the 
resource training room as a material resource in the Resource Sheet and you 
enter 600 as the Std. Rate. Then you create the task training and you assign the 
training room as the resource, and you enter the consumption rate of 1/d as the 

Entering Facility 
and Machine 
Costs
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Units for the assignment, which means that you will use one room per day (as 
the consumption rate)

This will appear in the Gantt Chart as follows:

You will learn more about making modifications to the Units field during 
resource assignments in Chapter 8.

As you can see, we have used the consumption rate feature in Project 2013 to 
work around the lack of a specific resource type for facilities. You can use the 
same workaround to model time-related cost for machines, e.g., when you rent 
equipment. Facility and machine costs are often accrued as prorated or at the 
end of a task.

Facility and machine costs are often accrued as prorated or at the end of a task.

When creating a resource that could be classified different ways, consider how 
you will pay for the resource. For example, if the resource conference room incurs 
a fee each time you use it, that may imply a cost per use situation. If conference 
room incurs an hourly rate, that may be a work resource.

Varying cost rates can be entered in the Cost Rate table in the Resource 
Information dialog.

1. Select a resource and click; the Resource Information dialog appears. 
Click the tab Costs and the dialog will look like this:

Entering Varying 
Cost Rates
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2. Enter the Effective Date, then enter the rates that will apply after that date.

OR

Enter the percentage with which you want the previous rate to change and 
Project 2013 will calculate the new rate for you.

3. Repeat the previous step as many times as the rate will change over time.

4. Click OK. Project 2013 will calculate using the appropriate rate, which 
depends on when the task is scheduled over time.

In Project 2013, you can create rate profiles for all the different types of costs: 
Standard Rate, Overtime Rate, and Per Use Cost (Cost/Use). 

Use the varying cost rate feature to incorporate rate changes for resources across 
time. This can be very useful in projects that have long durations where resource 
rates change. It allows you to reflect a pay raise or pay decrease for a resource.

Perform the following checks to verify whether your resources have been 
modeled well:

hh Are all resources identified in the Resource Sheet?
This is the case if all resources that could have a potential impact on the 
project are entered into the Resource Sheet. There can be impacts on scope, 

Checks on the 
Resources
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quality, duration, or cost of the project. Resources and assignments should 
be entered for projects where:

h` You expect that limited resource availability or heavy workloads may 
affect the end date of the project

h` You have a cost budget for the project and are responsible for staying 
within that budget

h` You have a budget expressed in person months and you have to stay 
within this effort budget

h` You foresee a quality or scope impact on the project depending on 
which resources you will get

hh Are all resources named completely and consistently using a naming 
convention like <first name> <last name> or <last name>-<first name>?

hh Are there no overlaps between the resources or duplication of resources?
If there are overlaps or duplications, Project 2013 will still aggregate the 
workloads of the resources, but these total numbers will be useless when 
you check on over-allocations. If Bill Tan is listed twice as a resource (as Bill 
Tan and William Tan), you would have to sum all time-phased workloads 
in order to determine if he is over-allocated. The workloads in the Resource 
Graph and in the Resource Usage can appear to be smaller than they really 
are when duplicate or overlapping resources exist.

hh Is the availability of the resources appropriately modeled?
This can be assessed by asking yourself the following questions:
h` Does the availability of individuals not exceed 120% as captured in 

the resource field Max Units or the availability profile in the Resource 
Information dialog, General tab?
You can set an arbitrary limit and choose the maximum to be 120%. 
It is unreasonable to ask resources for more than 120% availability for 
periods longer than one week. When you ask resources to work overtime 
for extended periods, their productivity decreases dramatically. 

h` If the Max Units are less than 100%, is there a valid reason for this?
Valid reasons are that the project manager works with pure work 
time estimates, that the resources have other ongoing work (or other 
concurrent projects), or that the resource may be a part-time resource.

h` Are the vacations of individual resources captured in their Resource 
Calendars? Vacations need to be entered, particularly when vacations 
are close to important deadlines. 
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hh Are the costs of the resources appropriately modeled?
h` Are human resources entered as Work resources in the resource field 

Type? Are facilities, machines and materials entered as Material 
resources?

h` Do material resources have an appropriate Material Label to indicate 
their unit of measure? For bulk resources or consumable resources the 
Material Label should reflect the unit of measure. For example, the 
material label for cabling could be yards or meters.

h` Are cost resources entered as Cost resources in the resource field Type? 
h` Are budget resources identified as Budget resources in the General tab 

on the Resource Information dialog box? 
h` Are the rates entered in the appropriate fields?

Time-related costs for work resources in the Std. Rate field
Unit-related cost for material resources in the Std. Rate field
Time-related cost for facilities and machines as material resources using 

two fields: the Std. Rate field where you enter the per-unit cost, and 
the assignment-related Units field where you indicate the number 
of units used per time unit (e.g., enter two rooms per day as 2/day) 

Use-related costs in the Cost/Use field
Overtime costs in the Ovt. Rate field (but only if the overtime is paid 

and paid at a higher rate than the standard rate)
Rates that vary over time in the Cost Rate Tables
Multiple rates per resource in the five Cost Rate Tables and the 

appropriate cost rate table (A, B, C, D, or E) selected for each 
assignment

h` Is the cost scheduled appropriately?
This is important for managing the cash flow of the project: Can bills be 
paid when they are supposed to be paid?
Does the resource-related Accrue At field reflect when the cost occurs: 

at the Start or at the End, or Prorated with the time-phased amount 
of work?
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Is it possible to model the following cost situations in Project 2013? If so, how? 
If not, what would be a possible workaround?

1. Up-front fee of $500 for a bulldozer at a rate of $1,000/d for onsite work

2. A consultant who charges $400/d until January 1, then $450/d

3. Penalty of $1,000/d for delivering late

4. Harry, who works as a business analyst at $500/d and as a systems analyst 
for $400/d

5. Overtime hours accumulated throughout the year and paid at the end of 
the year

6. Courier costs for packages

7. Low and high season hotel room rates 

Is it possible to model the following availability situations in Project 2013? If so, 
how?

1. Movers who only work on weekends

2. A server that needs to be tested for 48 continuous hours starting on a Friday

3. Somebody who works a compressed workweek of 10 hours per day and 4 
days per week

4. An expert resource who will be available to your project for 10% in March, 
20% in April, and 50% in May; after that, she is unavailable

5. A part-time resource who only works mornings on Tuesdays and Thursdays

Which of the following resources should have its workload leveled in Project 2013?  
Enter Yes or No in the appropriate cell and explain your answer.

Resource Level Workloads?
1. Expert 

2. Computer 

3. Mortar 

4. Boardroom 

Review 
Questions
Review A

Review B

Review C
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For experience working with the features you’ve learned about in this chapter, 
we strongly suggest that you review the Case Studies appendix, available to 
download in the WAV Download Resource Center at www.jrosspub.com.

 

Additional Practice
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2 Setup
1 Concepts
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Monitoring & 
Controlling
  9 Optimizing
10 Updating
11 Reporting
12 Earned Value

13 Evaluating
Closing

3 Tasks
4 Estimates
5 Dependencies
6 Constraints
7 Resources
8 Assignments

Chapter 8: Entering Assignments

Assignments are the last type of data you need to enter into your project model. 
After you’ve finished, you’ll have a complete model of your project.

After reading this chapter you will be able to:

hh Explain what an assignment is and define assignment-specific fields 
hh Configure the Gantt Chart view to display assignment fields
hh Assign resources using the Entry table, Task Information dialog box, Assign 

Resources dialog box, Task form view, and Team Planner view
hh Assign costs for the following resource types: work, material, and cost
hh Enter fixed costs on a task
hh Create budget resources, enter budget values for each resource type, and 

compare budget values with planned values 
hh Modify assignment attributes to properly model resource availability
hh Predict the impact of task type and effort-driven settings on assignments
hh Select the most appropriate task type and effort-driven settings before 

making assignment changes
hh Verify if assignments reflect scheduling best practices
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As discussed in Chapter 7, resources refer to people, facilities, machinery, cost, 
or materials needed to create the project product. Resources are assigned to 
tasks and significantly affect the quality, duration, and cost of the project.

Earlier in this book we talked about populating task and resource fields. When 
a relationship exists between a task and a resource, you have an assignment. An 
assignment identifies which resource, in many cases in the form of a person (or 
people), will work on a task. Assigning resources to tasks is also called resource 
loading, and when you’re done you have a resource-loaded schedule. After 
resources are assigned, it is important to note that a new collection of assignment 
fields gets populated.

Each of the three data entities—tasks, resources, and assignments—has its own 
specific fields. Some fields may be called by the same name, but they contain different 
information depending on whether they belong to the task, resource or assignment. 
Here are three examples:

hh Start and Finish dates (task, resource, and assignment-related)

hh Max Units (resource-related) and Units (assignment-related)

hh Work (task, resource, and assignment-related)

What Is an 
Assignment?

Assignment-
Specific Fields

Planning this schedule was so easy!

Great! Did you have any problem 
in assigning the resources?

Was I supposed to assign resources?
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Tasks, resources and assignments all have Start and Finish dates. The start date 
of a task is not necessarily the same as the start date of its assignments. The start 
date of an assignment is when the resource starts working on the task. If Mary 
only works the last two days of the five-day task, the start date of her assignment 
is different (three days later) from the start date of the task.

In our second example the resource field Max Units represents availability 
and the assignment field Units (also called Assignment Units in some views) 
represents usage.

The Max Units field of a resource reflects the maximum availability of the 
resource to the project. For example, the Max Units would be 100% for a person 

who is entirely available to the 
project and 50% for a resource 
who is available half of her 
working hours. In the 
illustration, Mary is working 
half time on the project and has 
Max Units of 50%. 

The assignment-related field 
Units is the percentage of 
her working hours that she is 
working on the task as set in 
her calendar. In the illustration, 

Mary works a regular work week, and a 50% assignment means for her 50% * 8 
hours = 4 hours of effort per day on the task “edit report” (and not 50% * 50% 
= 25%). Four hours per day equals her maximum availability. If Mary worked 
a compressed workweek of four days a week and ten hours per day, a 50% 
assignment would mean five hours of effort per day on the task. The percentage 
is always taken from the working hours on the calendar. The following table 
provides a summary:

8

Hours in 
Resource 
Calendar

Assignment 
Units on a 

Task

Max Units on 
Resource 

Sheet

Hours 
Calculated 

per Day

8

8

8

8

8

4

4

100%

100%

50%

50%

100%

100%

50%

50%

Start and Finish

Max Units and 
Units

Assignments
Task Resource Units

Write Report
Edit Report
Print Report

Mary
Mary
Mary

25%
50%

100%

Tasks
Name

Write Report
Print Report

Resources
Name Max. Units

Mary 50%

Mary has 50% of  
her working 

hours available 
to this project

Mary works 8hrs/day:
From: To:
8:00AM 12:00PM
1:00PM 05:00PM

Mary works 50% 
of  her working
hours on this 

task
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Note: The last row in the previous table creates an over-allocation for the 
resource. This situation will be addressed in the discussion about optimizing for 
limited resources in Chapter 9. 

The assignment-related field Units reflects one of the following:

hh Whether a person works full-time or part-time on the task

hh How many individuals of a consolidated resource are needed on the task 

hh The amount of material resource that will be consumed on the task

If you want a resource to work all of her available working hours on a task, 
simply enter 100% in the field Units on the Task Form (or the Assign Resources 
window). If you enter less than 100%, you are asking the resource to work part of 
her available time on the task; you’ve created a part-time assignment.

We recommend that you set an over-allocations standard for resources in your 
organization. For example, you may want a standard that resources are assigned 
no more than 150% of their time on each day and no more than 120% of their 
time on a weekly average. You may also decide that you won’t address over-
allocations unless they reach a certain threshold.

The third and last example of how a field is different for tasks, resources, and 
assignments is the field “Work,” which is different on the Gantt table, the 
Resource Sheet, and the Task Form.

All are called by the same name (Work), but:

hh In the Gantt Chart, Work 
is the total effort of all 
resources working on the 
task.

hh In the Resource Sheet, 
Work is the total effort for 
the resource in the entire 
project. (For material 
resources, it is the total 
number of units used in the project.) 

hh On the Task Form you can see the assignment-related Work field, which 
displays the effort of one resource on one particular task. This is a low level 
estimate and not an aggregate.

Views in Project 2013 are created for a specific purpose and will restrict your 
ability to insert or display one or more of the following: task, resource, or 
assignment fields. For example, the Resource Sheet view does not allow you to 
display “Name” from the Task fields.

Work, Work, and 
Work 

Assignments
Task Resource Units

Tasks
Name

Resources
Name Max. Units

Effort 
Estimate by 
Assignment

Work Work

Work

Total Effort
by Resource

Total Effort
by Task
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The assignment-related options are shown in the following table. Before creating 
assignments, review them in the Project Options. On the File tab, in the 
Backstage view, click on Options. The Project Options dialog box appears. 

Project 
Options

Recommended Choices

Schedule Set the Options on the Schedule tab:
Show assignment units as a: Percentage

You can show assignment units in percentages or as decimals. Percentage 
is the best choice when you have part-time resources; if there are mostly 
consolidated resources, Decimal is better (e.g., 5 carpenters is easier to 
understand than 500% carpenters).

This option is a global option; if you change it to decimal in one project, 
all your projects will use decimal numbers.

If your schedule is e-mailed to someone else, it will follow the schedule 
properties of that person’s machine. 

Duration is entered in: Days
Choose the default time unit. Changing this option after tasks are 
created will only affect new tasks and summary tasks.

Work is entered in: Hours
Choose the default time unit display. This option can be changed at 
any time and all tasks already created plus any new tasks will update to 
the new time unit. 

Default task type: Fixed Duration
Choose the type of task for any new tasks you create. This option is 
meant to be a time saver. See the next section on Types of Detail Tasks 
for more information.

New tasks are effort driven
This option works with the task type to model various resource 
scenarios. Our suggestion from Chapter 4 still applies here. Leave this 
option off as the default setting. 

Choosing the 
Options
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As covered in earlier chapters, there are three types of detail tasks (or simply 
Task Types): Fixed Duration, Fixed Units, and Fixed Work. Each task has three 
variables:

hh Duration is the amount of working time that passes between the start and 
end of a task. It is usually expressed in business days or business hours.

hh Units reflect the number of resource units assigned, expressed as a 
percentage or a decimal. 

hh Work is the amount of effort applied directly to a task. It is usually expressed 
in person hours or person days. A person day represents one person working 
full-time for one day.

Calendar
Days (CD)

Person
Days (PD)

Resources

Fixed 
Work Fixed 

Duration

Fixed Units

Parameters

Business
Days (BD)

Organizations’
Resources

In Chapter 4 we discussed the 
process of estimating, shown  
in the illustration. We 
recommended using Fixed 
Duration or Fixed Work tasks 
when first entering estimates.

It’s important to be aware of 
the task type when you assign 
resources because Project 2013 

performs calculations for each task type differently. It’s a good idea, therefore, to 
insert the column Type in the Gantt table so you can see at any point what type 
of task you have. 

You may also want to insert the field Effort Driven, because this field works 
with each task type and may affect the scheduling formula Duration x Units = 
Work. In Chapter 4, we recommended keeping Effort Driven to “No” on Fixed 
Duration tasks because it works in a manner similar to the Fixed Work task type 
and it keeps the number of calculation scenarios down to a minimum. 

Now that we have reached a point in this book where we are entering assignments, 
it is important to note that the Effort Driven field may need to be switched to 
“Yes” on some Fixed Duration or Fixed Unit tasks to model a specific scenario. 
We will discuss this in detail in this chapter. 

If not already displayed, insert the field Work next to the Duration column. This 
will help you monitor changes as a result of the scheduling formula.

Improving the 
Entry Table 
for Assigning 
Resources

Types of Detail 
Tasks
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We recommend the following layout of columns when working with assignments:

We can now see all three variables of the formula Duration * Units = Work with 
the Units visible between square brackets following the resource name (unless 
the units are 1 or 100%). 

If there are multiple resources assigned to a task and you want to understand 
how the software applies the formula, you may need to consider each resource 
individually because resources may have different calendar hours per day. 

You may also notice the column Resource Names. This field displays the same 
resource information that is located to the right of the Gantt bars but you may 
prefer to see it in the entry table. 

Here’s how to create the recommended layout.

1. On the Task tab, in the View group, click Gantt Chart.

2. Choose the Entry Table (if needed). On the View tab, in the Data group, 
click on the Tables down-arrow, Entry. The Entry table is displayed by 
default and has the columns: Indicators, Task Mode, Task Name, Duration, 
Start, Finish, Predecessors, Resource Names, and Add New Column 
(placeholder).

3. To insert the column Work after the column Duration, right-click on the 
column Start and choose Insert Column from the list; the list of available 
columns appears. Type or select Work.

Repeat step 3 for the fields Type and Effort Driven; we recommend you 
arrange the columns as indicated in the next screenshot:
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Reminder: you can hide columns by right-clicking on the column and choosing 
the Hide Column button. A column can be moved by dragging the column 
heading. We are now ready to make assignments.

The following are the many different ways you can assign resources to tasks. 
The methods are organized for ease of explanation in this chapter starting with 
popular Gantt Chart view techniques. You will find some methods are simple 
(and quick) while other methods are sophisticated (and time consuming). Each 
of these methods will provide different degrees of speed and flexibility as you 
assign resources. The more sophisticated the method, the more detail it allows 
you to enter about the assignment:

hh Spreadsheet/Table (left side) 
hh Task Information dialog box
hh Assign Resources dialog box
hh Task Form view (lower pane of a combination view)
hh Team Planner view
hh Task Usage view
hh Resource Usage view

In most assignment methods, Project 2013 creates a flat workload, which means 
the work hours are evenly distributed across the life of the task. Generally, a flat 
workload is a good enough approximation of the true workload. If it isn’t, you 
should consider breaking up the tasks into smaller tasks or use the work contour 
feature. Predefined work contours (discussed later) allow you to spread the work 
across the task duration in a certain pattern. 

In general, we don’t recommend the last two methods, Task Usage or Resource 
Usage views, for assigning resources because they require entering too much 
data and the data will need to be maintained for the life of the project. During 
project execution, you will have little time to maintain the schedule, but if you 
have an uneven resource contour, you’ll need to use these two methods. It all 
depends on your specific project characteristics.

Be sure to assign a resource to every task where effort is required (every detail 
task).

Overview of 
Assigning 
Resources to 
Tasks
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We recommend and will discuss these methods in more detail: Spreadsheet/
Table, Task Information dialog box, Assign Resources dialog box, Task Form 
view, and Team Planner view.

Collectively these methods will give you the speed and flexibility you need to 
properly model the efforts of your resources.

Assigning resources will trigger a recalculation: Project 2013 recalculates the 
work if it is a Fixed Duration task, or the duration if it is a Fixed Work task. 
Information about adjusting task types to control the recalculation will be 
discussed later in this chapter. 

As a general rule, the project manager will most likely know the duration estimate 
or the work estimate of a new task, and the task type should correspond to the 
estimate that you most want to control, either Fixed Duration or Fixed Work. 
The task type should not be Fixed Units when assigning resources because you 
may have problems when Project 2013 recalculates duration or work.

One of the fast, easy ways to assign resources is to work with the popular Gantt 
Chart view and to use the default Entry table, located on the left-hand side of the 
view. If necessary, navigate here by clicking Gantt Chart in the View group on 
the Task tab. Additionally, verify you have the Entry table selected by clicking on 
the Tables down-arrow, Entry, in the Data group, on the View tab. If necessary, 
adjust the table to the recommended layout (discussed earlier). 

Here’s how to assign resources.

1. Verify you are in the Entry table of the Gantt Chart view.

2. Locate the row of the task to which you want to assign resources.

3. In the task’s Resource Names field, click the down-arrow and then click the 
check box for each resource you want to assign to the task. 

4. Click anywhere outside the resource list to accept the change.

5. Repeat for each task as needed.

Assigning 
with the 
Spreadsheet/
Table
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You will notice how very simple and fast this technique is and how the selected 
list of resource names automatically displays to the right of the Gantt bars. To 
change the assignment or remove a resource, simply repeat the same process and 
click again to select or deselect resources for the task. 

To erase all resources for a task, select the Resource Names field and press the 
Delete key. 

Selecting the Resource Names column and pressing the Delete key hides the 
column but does not remove any resource assignments.

Another fast, easy way to assign resources is to continue to work within the 
Gantt Chart view. If necessary, navigate here by clicking Gantt Chart in the 
View group on the Task tab. This option provides more choices over the last 
Spreadsheet/Table selection because it provides the ability to adjust resource 
units and has a cost field used to enter amounts on cost type resources. 

Here’s how to assign resources.

1. Verify you are in the Gantt Chart view.

2. Locate the row of the task to which you want to assign resources.

3. Double-click the Task Name field to launch the Task Information dialog 
box. 

4. On the Resources tab, in the first row, select the resource name from the 
down-arrow. If necessary fill in the Units and Cost. (Cost management will 
be discussed later).

5. Repeat for each additional resource and then click OK. 

6. Repeat for each task as needed.

Assigning 
with the Task 
Information 
Dialog
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To remove a resource from a task, select the name of the resource in the Resource 
Name field and press the Delete key. The selected list of resource names will 
automatically display to the right of the Gantt Chart bars.

The Assignment Owner field is used by Project Server to specify who is 
responsible for providing updates to the tasks in Project Web App. (Project 
Server and Project Web App are beyond the scope of this book.)

The Assign Resources dialog box behaves differently than the Task Information 
dialog box in that it allows you to navigate between task and resource information 
without having to close and open the dialog box each time.

Some additional benefits of this option include:

hh It provides filtering options to narrow down the resource list by specified 
criteria or by availability to work

hh It provides the ability to display a resource graph for each resource
hh It displays all available resources alphabetically, but shows the assigned 

resources at the top of the list for the selected task
hh It offers the ability to assign resources with the Assign button or by dragging

Using the Assign Resources Dialog box to assign several resources at once can 
yield different results than if the resources are added individually.

Assigning with 
the Assign 
Resources 
Dialog
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1. On the Resource tab in the Assignments group, click Assign Resources; 
the Assign Resources dialog box appears: 

2. Click on the resource to assign.

3. Point to the resource selector in front of the resource name; the mouse 
pointer now has a person’s (disembodied!) head attached:

4. Hold down the primary (typically left) mouse button, drag and drop the 
resource onto the task to which you want to assign it. The resource is now 
assigned; it has a check mark in front of its name. It appears in the field 
Resource Names and to the right of the task bar in the timescale.

5. If necessary, enter the Cost for any resource that has the type set to Cost. 
(Cost management will be discussed later.)

6. Repeat for additional resources as needed.

Assigning 
Resources by 
Dragging
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To assign multiple resources to multiple tasks: 

1. On the Resource tab in the Assignments group, click the Assign 
Resources button; the Assign Resources dialog box appears.

2. Select the tasks to assign by dragging them over. 

OR

Select them by holding down Ctrl and clicking if the tasks are not adjacent.

3. In the Assign Resources dialog box, select the resource you want to assign 
OR select multiple resources to assign by holding down Ctrl and clicking 
on their names:

4. Click the Assign button; a check mark appears in front of the name in the 
resource selector.

When you use the Assign button instead of dragging resources to tasks, you can 
assign resources to multiple tasks all at once.

Assign Multiple 
Resources to 
Multiple Tasks
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You can check the availability of a resource while you are making assignments 
by selecting the resource in the Assign Resources dialog box. In order to view 
over-allocations across all projects that share resources, this function is best used 
in a consolidated master schedule (discussed in Appendix 1). We recommend 
you use this feature to prevent over-allocations from occurring in the first place, 
rather than sorting them out later, which can be a frustrating task.

Check resource availability before you assign a resource to each task.

1. Select the task to which you are about to assign resources. This is an 
important step because Project 2013 checks the availability of resources 
between the start and finish date of the task that is currently selected.

2. Insert the column Work by right-clicking on a column heading and choosing 
Insert column. Select Work from the list. In this field, you can see the total 
effort required on the task

3. On the Resource tab in the Assignments group, click Assign Resources; 
the Assign Resources dialog box appears:

4. Check the Available to work box and enter the amount of effort that 
you need from the resource in the field to the right of it. Project 2013 will 
immediately list only the resources with enough availability (between the 
start and finish date of the selected task). This feature prevents you from 
having to switch to the Resource Usage view and back before you can make 
one assignment.

Check Availability 
Before Assigning
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OR

In the Assign Resources dialog box, select the resource(s) in the list and 
click Graph; a Resource Graph will appear in the lower pane of Gantt 
Chart view. The graph allows you to verify within the duration of the task if 
the resource has enough availability. 

5. The screen will look like this:

6. Select a resource from the resources that are available and click Assign. 

7. Make sure you clear the Available to work check box again so that you see 
the entire list of resources for the next task.

8. You can quickly check the working hours of a resource by double-clicking 
on its name in the list. 

To delete an assignment: 

1. On the Resource tab in the Assignments group, click Assign Resources; 
the Assign Resources dialog box appears.

2. Look at the check marks in front of the resource names that indicate which 
resources are assigned to the task(s) selected in the spreadsheet:

Delete an 
Assignment

J. Ross Publishing; All Rights Reserved



322

Dynamic Scheduling® with Microsoft® Project 2013

3. Select the resource to be removed.

4. Click the Remove button.

To replace a resource: 

1. Select the task(s) for which you want to replace the resource.

2. Display the Assign Resources button dialog box. 

3. Select one of the assigned resources you want to replace.

4. Click the Replace button; the Replace Resource dialog appears.

5. Select a resource and click OK; the resource will now be replaced without 
a recalculation.

If a task is in progress, only the remaining duration of the assignment will be 
reassigned to the new resource; all actual hours worked stay with the original 
resource. Assignments that are 100% complete will trigger an appropriate 
prompt:

Replace a 
Resource
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If you get this prompt, you may need to click Cancel. 

When you assign resources using the Assign Resources dialog box, Project 2013 
automatically assigns:
hh The maximum availability (Max Units) of individual Work resources; if the 

Max Units of the resource is 1 or less 
hh Only 1 unit of the individual Work resource; if the Max Units is greater than 

1
hh Only 1 unit of consolidated Work resources
hh Only 1 unit of a Material resource

You cannot enter a value in the Units column for Cost Resources as you would 
for Work or Material Resources. The total amount for the Cost resource applied 
to the task is entered directly to the Cost column and not calculated using the 
Units assigned. 

Units should be entered as a percentage (recommended for single resources) 
or as decimals (recommended for consolidated resources). You can work 
with either percentages or decimals by choosing Show Assignment Units as 
a (Decimal or Percentage). On the File tab, in the Backstage view, click on 
Options. The Project Options dialog box appears. Click the Schedule tab and 
look under the Schedule heading. 

Adjusting the Units may trigger a recalculation by Project 2013, so check the 
Task Type first. The task type should not be Fixed Units if you intend to change 
units. More about Task Types will be covered later in this chapter. 

After resources are assigned, you can modify the assignment units. In the 
Assign Resources dialog box, select the name of the assigned resource (should 
have a check mark) and select the field Units. Enter the percentage of the 
resource’s available working hours (or the number of resources you need from a 
consolidated resource) and then press the ENTER key. You don’t need to click 
Assign again after setting this attribute. 

Enter Assignment 
Units
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The field R/D indicates whether the assignment is a Request (requested to 
work on the task) or a Demand, (must work on the task for it to be completed 
successfully). Entering this may be relevant when using Project Server or any 
other application that requires this detail.

Even though the field Units asks for units to be entered, you can actually enter 
work in this field and Project 2013 will calculate the units required. If you do 
this, make sure you include the time unit, as in 20h, to make it clear to Project 
2013 that it should interpret your entry as person hours of work instead of as 
units.

The main advantage to this option is that you can see separate columns for units 
and work for each resource name. Using the lower pane is also an effective way to 
use your available screen space without having to move a dialog box around such 
as the Assign Resources dialog box. Note that you are limited to making resource 
assignments to one task at a time. 

While there are numerous split screen configuration options in Project 2013, we 
will focus on the optimal settings for resource assignments. 

To display the Task Form:

1. On the Task tab, in the View group, click the Gantt Chart button.

Assigning with 
the Task Form 
View
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2. If necessary, select the Entry table, from the Tables down-arrow, in the 
Data group, on the View tab.

3. On the View tab in the Split View group, split the screen by selecting the 
Details checkbox and then in the down-arrow, click Task Form. 

OR

4. Double-click on the sliding window handle at the bottom right of the 
screen:

5. Click anywhere on the Task Form to display related options on the Ribbon, 
and then on the Format tab, click Work. Review your results with the 
following screen:
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1. On the Gantt Chart (upper pane), select the task to which you want to 
assign resources. 

2. On the Task Form, click in the field Resource Name and a list button will 
appear:

3. Click the list button and select a resource from the list that appears. 

4. Optional: enter the Units (the percentage of the available working hours) 
or the Work (person hours of effort needed). 

Units and Work will be automatically filled in by Project 2013 after you click 
OK unless you decide to manually enter those values.

5. In the next blank Resource Name field, repeat steps 2-4 until you are done 
selecting resources. 

6. Click OK once all resources are assigned.

If you prefer to use the keyboard to accept the assignments, you may need to 
press the Enter key twice. The first time will accept the resource name selection 
and the second time will be equivalent to clicking OK. 

All new assignments are entered into the project model simultaneously, which 
triggers only one recalculation by Project 2013. This makes this method better 
for assigning multiple resources with specific Units or Work values; you are not 
triggering a recalculation with every assignment you add or remove, unlike in 
the Assign Resources dialog.

On the Task Form, select an assigned resource, press Delete and click OK.

On the Task Form, select an assigned resource, click the down-arrow to choose 
an alternate resource and click OK.

Assign Resources

Delete an 
Assignment
Replace a 
Resource
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Team Planner view is available only for Professional editions of Project 2013. 
The view is very easy to use and you can use drag and drop to create assignments. 
One of the unique aspects of Team Planner is you create an assignment by 
dragging a Task to a Resource versus prior techniques which focused on 
assigning a Resource to a Task. What makes this method different than prior 
methods discussed is you also have the ability to schedule the timeframe for the 
task based on effective resource usage.

Enhanced in Project 2013: Constraints will not be created when assigning tasks 
to a resource unless there is a shift on the schedule. 

1. On the Task tab, in the View group, click Team Planner.

2. Adjust the view as needed:

a. Press ALT + HOME to shift the timescale to the start of the project OR 
press F5 to jump to the specific date you need.

b. Zoom in or Zoom out using the Zoom Slider on the Status Bar until 
you display the desired level of detail.

c. Move the dividing bar separating the list of resources with the list of 
tasks up or down to display the information you need. Refer to the 
following diagram:

d. Make any other adjustments as desired.

3. Drag an unassigned task to the resource to generate the assignment.

OR

4. Right-click the unassigned task, click Reassign To and select the resource 
to generate the assignment.

Keep the following points in mind when working with this view:

Assigning with 
Team Planner 
View
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hh If tasks are unassigned, they appear on the lower section of the screen 
(below the horizontal dividing bar), regardless of the task mode.

hh If they are unscheduled (no starting date set, as is the default with new, 
manually scheduled tasks), they appear to the left of the vertical dividing 
bar. Only manually scheduled tasks can be unscheduled. 

hh For templates and older files, even though the tasks are manually scheduled, 
they may have a start date so they are not unscheduled. Thus they appear on 
the right of the vertical dividing bar.

hh In summary, manually scheduled tasks can appear anywhere, depending 
on whether they have a start date and/or resource; auto-scheduled can 
only appear on the top or bottom on the time phased portion of the Team 
Planner view, depending on whether or not they have a resource.

Dragging an auto-scheduled task in Team Planner view to a resource in a 
different date than the original will add a “Start no Earlier than” constraint on 
the designated date. As discussed in Chapter 6, we do not recommend setting 
unnecessary constraints for dynamic schedules.

Using the Team Planner view, especially with manually scheduled tasks when 
making new assignments, gives you the flexibility to schedule a task when a 
resource is available and avoid resource over-allocations. The task will start on 
the date you decide.

 Earlier in this chapter we discussed techniques for assigning resources. Now 
we’ll focus on where to enter resource costs and how Project 2013 computes the 
total cost for the task.

The total cost for a task is displayed in the field Cost in Gantt Chart view. This 
field is a summary of the variable costs associated with resource assignments and 
it includes cost per use amounts and fixed task costs. You may review your total 
estimate of the project Cost in the project summary task and compare it against 
your Budget Cost if you decide to create a budget. 

Project 2013 can help you track costs on your project when you assign work and 
material resources, such as people or equipment, or cost and budget resources, 
such as air travel or travel-budget. You can also assign a fixed cost to a task that is 
unrelated to people, equipment, or materials.

People are the most popular work resources. When you enter the standard rate 
for a person and the person is assigned to a task, Project 2013 multiplies this rate 
by the amount of assigned work to estimate the cost of the assignment. 

1. In the Resource Sheet, enter the name of the work resource for which you 
want to set the variable cost.

Cost 
Management

Entering Costs on 
an Assignment

Variable Costs for 
Work Resources
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2. In the Std. Rate field for the selected work resource, enter the standard pay 
rate, for example, $50 per hour (50/h), or $400 per day (400/d). 

3. If the resource has an overtime pay rate, enter this amount in the Ovt. Rate 
field, for example, $75 per hour (75/h). Project will apply this rate when 
you assign overtime hours. Refer to the section “To Display the Task Form” 
above for information on how to display the overtime hours. 

4. Optional: Specify the Accrue At, selecting either Start (beginning of task), 
Prorated (throughout the task duration), or End (end of task), from the 
drop-down. Prorated is the default setting.

Material resources are resources that are consumed or used up within a project. 
Examples of material resources are paper, cement, and lumber. Each material 
resource should have a specified unit of measurement in its Material Label field, 
for example, reams, pounds, or metric tons.

1. In the Resource Sheet, enter the name of the material resource for which 
you want to set the Standard Rate, for example, cement.

2. In the Type field, select Material from the type drop-down to specify this 
resource as a material resource.

3. Identify the specific unit of measurement for the resource in the Material 
Label field, for example, Metric Ton. 

4. In the Std. Rate field, enter the cost per unit of the material resource. For 
example, if cement is measured by the metric ton and one metric ton costs 
$75, enter 75 in the Std. Rate field.

When you assign a material resource to a task, you can change the number of 
Units and Project 2013 will multiply the Standard Rate by the Units to create the 
total material Cost for the task. 

Costs for Material 
Resources
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Optional: Specify the Accrue At, selecting either Start (beginning of task), 
Prorated (throughout the task duration), or End (end of task), from the drop-
down. Prorated is the default setting. 

Work resources like equipment sometimes have an additional cost for each time 
you use them. For example, a bulldozer might have a delivery charge along with 
its daily rate. Project adds this additional cost to the total variable costs each time 
the resource is used.

1. In the Resource Sheet, enter the name of the work resource for which you 
want to set the fixed cost.

2. In the Cost/Use field for the selected resource, enter the cost per use, for 
example, 250.

Cost resources are costs that help in completing a task but don’t affect the 
scheduling of the task. Cost resources are something other than the people, 
equipment, or materials on a task. They can be items such as hotels, car rentals, 
and airfare.

Cost resources can be used to represent Fixed Costs on tasks. The value assigned 
may vary from one task to another, but on an individual task, the value does not 
vary with the number of resources or the duration of the task.

You cannot enter standard rate amounts for cost resources when they are created, 
as you do with work and material resources. The cost values are entered when 
the cost resource is assigned to the task. The amount for the cost resource can 
be different depending on the task to which it is assigned. For example, airfare 
costs for the spring convention task may be different than the airfare costs for the 
summer convention task, depending on airfare rates.

1. Make sure that the cost resource is entered and designated as Cost in the 
Type drop-down on the Resource Sheet.

2. In the Gantt Chart, double-click the task to which you want to assign the 
cost resource. The Task Information dialog box appears. 

3. Click the Resources tab, click in the field Resource Name, and a list button 
will appear. Click the list button and select a resource name from the list. 

Cost Per Use for 
Resources

Costs for Cost 
Resources
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4. Type the cost amount in the Cost field. For example, if airfare for the 
Summer convention task was $500, enter this amount in the Cost field.

5. Click OK.

Sometimes you have a task cost that isn’t dependent on any resource, for example, 
the cost of publishing an initial kick-off presentation for all stakeholders, or a 
fixed price contract with a law firm to review legal documents. 

1. In the Gantt Chart, select the Cost table by going to the View tab, clicking 
on the Tables down-arrow, and selecting Cost.

2. Select the task and in the Fixed Cost field, enter in the fixed cost for the 
task. For example, for printing costs $500.

3. Specify the Fixed Cost Accrual, selecting either Start (beginning of task), 
Prorated (throughout the task duration), or End (end of task), from the 
drop-down. Prorated is the default setting.

In the default Cost table (displayed above), the Cost field is shown as Total 
Cost. 

4. Project 2013 will then calculate the total cost for the task in the field Cost 
as: Cost = Fixed Cost + All task related costs (from material, cost, and 
work resource types). 

Fixed Costs for 
Tasks
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The next screenshot shows the Task Usage view to illustrate this formula. The 
total cost of $3,800 for the task lay bricks consists of $600 fixed cost, $2,000 
material cost for the bricks and $1,200 labor cost for the bricklayers:

 

Notice that if you enter any cost directly into the Cost field for a task, the cost 
is immediately interpreted as Fixed Cost by Project 2013 and transferred into 
that field.

It is always a good idea to include a task note that identifies the fixed cost entered.

Assign a Cost resource instead of a Fixed Cost if you want a category of fixed 
costs that can be repeated across several different tasks and then aggregated by 
category.

Budget resources are special resources that are created specifically to list a budget 
category that needs to be tracked within a project on a high level (in the project 
summary task). Budget resources can be work, material, or cost resources.

Once the budget resource is created and assigned, the project work or project 
cost amounts can be rolled-up and compared to the budgeted amounts listed 
in the budget resource. (If you need to know how to create a budget resource, 
please see the section “Entering Budget Resource” in Chapter 7.)

1. You can only assign the budget resource to the project summary task. This 
is because budget items are high-level and are rolled-up to the project 
summary task for easy comparison. Make sure that you have the project 
summary task visible. To do this: on the Format tab, in the Show/Hide 
group, check Project Summary Task.

2. In the Gantt Chart view, select the project summary task (line 0) and on 
the Resource tab in the Assignments group, click Assign Resources; the 
Assign Resources dialog box appears.

Budget Costs for 
Budget Resources
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3. Locate your budget resources. (If you include the uppercase word BUDGET 
in all your budget resources, they will be easy to identify).

4. In the Assign Resource window select the budget resource that you want 
to assign to the project summary task.

5. Click Assign and then click Close.

Only resources identified as Budget resources can be assigned to the project 
summary task! The Budget column may be added to the Resource Sheet view or 
you can double-click a resource name to apply the budget attribute. 

After creating the budget resource and assigning it to the project summary task, 
you’re ready to enter the budget work amounts for work and material resources, 
and the budget cost amounts for cost resources. 

1. On the View tab, Task Views group, go to the Task Usage view (illustrated 
below) or Resource Usage view.

2. Insert the Budget Cost column and the Budget Work column in the view.

3. In the Assignment row, enter the value for Budget Cost or Budget Work 
for the BUDGET resources:

h` For Work Type Budget resources, enter the budgeted hours in the 
Budget Work column. 

Be sure the resource BUDGET Work-Hours is listed on the Resource 
Sheet with Type Work and the Budget attribute Yes. Otherwise, you 
won’t be able to enter the budgeted amount. 

h` For Material Type Budget resources (e.g., BUDGET Material-
Cement), enter the budgeted amount as the total material units in the 
Budget Work column. For example, if 10,000 metric tons of cement 
have been budgeted, enter 10000 in the Budget Work field. 

Be sure the resource (e.g., BUDGET Material-Cement) is listed on 
the Resource Sheet with Type Material and the Budget attribute Yes. 
Otherwise, you won’t be able to enter the budgeted amount. 

h` For Cost Type Budget resources (e.g., BUDGET Cost), enter the 
budgeted amount in the Budget Cost column, for example, 50000. 

Be sure the BUDGET Cost Resource is listed on the Resource Sheet 
with Type Cost and the Budget attribute Yes. Otherwise, you won’t be 
able to enter the budgeted amount. 

Budget Values for 
Work, Material, 
and Cost Budget 
Resources
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You can only enter values in the Budget Work field for Budget resources where 
the Type is set to Material or Work. You can only enter values in the Budget Cost 
field for Budget resources where the Type is set to Cost.

The Budget Cost field totals all your Budget Resources in the Project Summary 
Task row, but the Budget Work field only includes the hours of your Budget 
Resources (if you use a Material resource, the amount of the material won’t be 
added to the total hours).

Sometimes you need to track a Budget Resource for a specific time period, like 
a specific month or week.

After you’ve created and assigned your budget resource to the project summary 
task, go to the Task Usage view (illustrated below) or Resource Usage view 
(notice that your screen is split into a left and right side).

1. Continue with the Task Usage view as configured in the last section. 

2. Now you need to add Budget Cost and Budget Work to the timescale 
(right) portion of the view.
h` Move your mouse to that area, right-click, and select Detail Styles. In 

the Detail Styles dialog box, select the Usage Details tab.

h` Select “Budget Cost” from the available fields, then hold down  
your Ctrl key and select “Budget Work,” and then select Show.

h` Click OK to insert these two columns into the timescale portion of the 
view. Adjust your columns as needed to see the added fields. 

h` You may hide the Work field on the timescale section of the view. To 
do this, right-click on the timescale section, then click Work in the 
shortcut menu.

Use the Zoom Slider on the Status bar to Zoom in or Zoom out to set the specific 
time period for the budget values that you want to include. For example, you 
could show just months in the timescale.

In the Assignment view (on the right side of the screen), next to the budget 
resource for which you want to enter values, enter the budgeted work or budgeted 
cost values under the specific timescale, as shown in following screenshot.

Time-Phased 
Budget Resources 
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Project 2013 allows you to assign resources to summary tasks, but we discourage 
this: sooner or later you will end up with over-allocations that can’t be resolved 
except by removing the resource from the summary task. Let’s explain this.

If you assign a resource full-time to a summary task and also to one of its detail 
tasks, the workload of the resource will be twice its availability during that detail 
task.

In the illustration, you can see 
that Eduardo is assigned to the 
summary task ST 1.1 and its 
detail task DT 1.1.3. You may 
think that you would never 
create a situation like this, but 
you inadvertently might because 
assignments on summary tasks 
don’t show up in the default 
timescale in Project 2013 as they do in the illustration; only assignments on 
detail tasks are displayed. (You can change this: on the Format tab, in the Bar 
Styles group, click the down-arrow on Format, click Bar Styles, Text tab.)

An assignment on both a summary task and its own detail task causes an over- 
allocation that can’t be solved by Project 2013. After all, if Project 2013 moves 
the detail task to a later date, the summary task will automatically extend as well 
and continue the over-allocation. You can’t resolve the over-allocation yourself 
either, other than by removing the resource from the summary task (or from its 
detail task). So why bother assigning to summary tasks in the first place, if you 
normally assign resources to detail tasks?

A similar over-allocation can occur between the different levels of summary tasks. 
In the previous illustration you can see that Mary is assigned only to summary 
tasks ST 1 and ST 1.2. Because ST 1.2 is subordinate to ST 1, the over-allocation 
can’t be solved unless you remove the resource from one of the summary tasks.

Assignments on 
Summary Tasks

Eduardo

Mary

Eduardo

Mary

ST 1

  ST 1.1

     DT 1.1.1
     DT 1.1.2
     DT 1.1.3
     MS 1.1.4
    
ST 1.2

    DT 1.2.1
    DT 1.2.2
    DT 1.2.3
    MS 1.2.4
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This situation can occur easily if you have several indentation levels. You could 
try to control this by only assigning resources to tasks that are on a certain outline 
level. You could insert the field Outline level and use that to prevent this type of 
over-allocation. But why did you add more levels of detail tasks if you are not 
going to use them to delegate or model workloads? It looks like you could have 
saved yourself some time by not creating all those detail tasks in the first place!

Updating schedules with summary task assignments is also more cumbersome 
than when all assignments are on the lowest level. Again, we are back to one of 
our basic principles of modeling: leave things out that do not have added value.

You may be tempted to assign to a summary task if all its detail tasks are scheduled 
in sequence without gaps and all are done by the same resource(s). But since it’s 
almost as quick to select all the detail tasks and assign the resource(s) to them 
with one click, is it really worth the minimal time savings? We don’t think so, 
and don’t recommend that you assign to summary tasks even in this situation 
because of the substantial risk of encountering those stubborn over-allocations.

In short, in our view, there are no situations in which you are better off assigning 
to summary tasks rather than to detail tasks. We recommend keeping the 
assignments on the lowest level, the detail level only.

You can, however, assign resources to a recurring summary task with the Assign 
Resources tool on the Resource tab, because Project 2013 will automatically 
transfer these to the detail tasks and remove the assignment on the recurring 
summary task.

If you assign a resource to a recurring summary task with the Assign Resources 
tool, the assignments are immediately transferred to the detail tasks by Project 
2013. In the illustration, the resources Mark and Brad are assigned to the 

recurring summary task 3 Status 
Meeting and are automatically 
transferred by Project 2013 to 
the recurring detail tasks (that is 
where you want the 
assignments).

You can assign resources to the summary of recurring tasks if you want them 
all assigned to each recurrence, otherwise, assign separately to each recurrence.

You can assign to recurring tasks in situations such as:

hh Long meetings: They can require considerable effort (work) from resources.

hh Short meetings: You require attendance at short meetings, and want to show 
them as assignments in the to-do lists of team members.

Assignments on 
Recurring Tasks

3 Status Meeting

    3.1 Status meeting 1

    3.2 Status meeting 2

    3.3 Status meeting 3

Mark, Brad

Mark, Brad

Mark, Brad

Mark, Brad
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You should only assign to recurring tasks, such as status meetings, if the efforts for 
these meetings are not included in the work estimates that your team members 
provided to you.

Assigning to recurring detail tasks can easily result in over-allocations that 
Project 2013’s leveling features will not resolve. The reason is that Project 2013 
by default excludes recurring tasks from the leveling process by setting the 
field Level Assignments to No for the recurring detail tasks. You could switch 
it manually to Yes, but then your recurring tasks may be rescheduled, which 
is probably not what you want. We recommend you keep the meetings short, 
assign resources, and ignore the over-allocations on recurring tasks.

If there are multiple assignments on a task, often one will drive the duration of 
the task: usually the assignment that takes the longest or starts the latest. The 
illustration shows that three 
engineers Joe, Frank, and Mary, 
are assigned to develop a 
prototype. Joe will work 10 
days, Frank only the first 6 days, 
and Mary only the last 5 days, so 
the duration will be 10 days. Joe 
and Mary determine or “drive” the duration of the job. 

There are disadvantages to this practice:

hh It is unclear who is supposed to take the lead on the task. 

hh Entering multiple uneven assignments can make it difficult to level 
workloads manually (as discussed in Chapter 9). It is simpler if there is only 
one resource assigned per task. If you do this, however, you may end up with 
many more tasks in your schedule.

To create multiple, uneven assignments on a task you need to:

1. Split the screen in Gantt Chart view by selecting the Details checkbox and 
then in the down-arrow, click Task Form. These options can be found in the 
Split View group, on the View tab. 

2. Change the details in the Task Form to show assignment start dates by 
clicking anywhere on the Task Form to activate it, and then on the Format 
tab, click Schedule. 

3. Click in the field Resource Name and select a resource to assign from the 
list that appears. Repeat this for all resources you want to assign to the task. 
Enter a specific Scheduled Start date or Delay for each assignment. 

Multiple, 
Uneven 
Assignments

Joe: 10d

Frank: 6d at start

Mary: 5d at end
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4. Click OK; you can see the result of the uneven assignments by choosing 
Task Usage on the View tab.

The result of the previous example would look like this:

Typically, the resource with the least work finishes early, unless you change the 
start date of his or her assignment. In our example, Joe and Mary drive the task 
finish date.

Generally, we recommend that where possible, you split one task with multiple, 
uneven assignments into multiple tasks with a single assignment. There are two 
reasons:

The formula D * U = W does not apply to a task with multiple, uneven 
assignments, but it does apply to the individual assignments.

The project schedule will be simpler if you divide the task into multiple tasks, 
creating one task for each resource to avoid confusion about who is leading the 
task. This also simplifies the management of resource allocation. Where people 
need to get together to work as a group, you can create a short meeting task. (In 
the example shown in the screenshot, the meeting would take place on Monday, 
September 8.)

Another technique for adjusting assignments is to use the Assignment 
Information dialog box, for example, to change the default flat contour 
assignment pattern. This could be a useful technique to prevent over-allocations 
of resources. 

1. Switch to a usage view, either the Task Usage or Resource Usage.

2. Double-click on an assignment. (Assignments have no ID number, and are 
in italics.) The Assignment Information dialog appears:

Changing 
Assignment 
Attributes
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3. Make the changes to the assignment and click OK.

Options available in the Assignment Information dialog box are limited when 
working with unassigned tasks or budget resources. 

You can change many assignment-specific attributes; there are about 50 purely 
assignment-related fields. Some useful examples are:

hh Start and Finish: These fields allow you to have one or more resources start 
later or finish earlier on a task than the rest.

hh Delay: Instead of entering start or finish dates, you could enter a number of 
days delay for the assignment.

hh Work contour: This allows you to spread the effort on a task in a pattern you 
choose. Refer to the next section for more information. 

hh Cost rate table: This allows you to select a specific rate profile for each 
assignment. This can be useful for small consulting firms that billed 
differently for each job.

You can also document actual findings and lessons learned by assignment. This 
allows you to create a project archive as you proceed through the project.
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Units = 1 means 100% of  available hours (flat):

Units = 0.6 means 60% of  available hours (flat):

Units vary from day-to-day: work contour “turtle”:

Work Contours determine how 
the work for a task is spread over 
time. By default, Project 2013 
creates a flat contour on all 
resource assignments, meaning 
that work is distributed evenly 
across the duration of the task.

You can see three different 
assignments in the illustration. In the 100% and 60% assignments, the resource’s 
work (effort) is spread evenly across the duration of the task in a flat pattern.

You can also spread the work over a task’s duration in different, predefined 
patterns that Project 2013 calls work contours. There are eight predefined work 
contours, but you can also spread the work over the task duration yourself by 
entering the spread in the time-phased Work fields.

hh You can apply one of the predefined work contours using the Assignment 
Information dialog. If you double-click on an assignment in either the Task 
Usage or Resource Usage view, the Assignment Information dialog will 
be displayed. You can then select a predefined contour from the list Work 
contour. Project 2013 will maintain the pattern of the contour when the 
duration or the work is changed during the planning phase.

hh You can even fill in on a day-by-day basis how many hours you need from 
the resource over the duration of the task. You can enter the needed hours 
directly into the Work field in the timescale of the Task Usage view. (This 
level of detail is seldom needed in the planning of projects.)

If you do decide to enter numbers in the timescale yourself, be aware that you’ll 
spend a lot of time maintaining your schedule since Project 2013 won’t know 
how to make any needed adjustments to your spread. Particularly if you enter 
the required hours on a day-by-day basis you will have a lot of data to maintain 
and you’re not likely to keep up with it during project execution.

If you change the contour to anything other than “Flat,” or enter work values 
manually into the timescale section of the usage views, Project 2013 will show 
the Edited contour work assignment indicator in the indicators column.

Work Contours
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We’ve mentioned before that if you initially don’t know who your team members 
will be, you should simply assign generic resources. There are a couple ways in 
which you can replace generic resources with real individuals. One way is to type 
over the generic resource name with the name of the individual in the Resource 
Sheet.

Of course, this will replace the generic resource on all its assignments, so you 
only want to use it when you have a one-to-one correspondence between the 
generic resource and the individual. Otherwise, you are going to need one of the 
following methods which allows you to create just one generic resource for each 
role, function, or position you need on your team, and do long-term resource 
planning where you accumulate workload far into the future onto generic 
resources:

hh In the Resource Usage view, click on the cell on the extreme left of the 
assignment row (to select the entire row) and drag the assignment from the 
generic resource to a real person.

OR

hh With the Assign Resources dialog. First, select the tasks with the generic 
resource to replace, then select the generic resource and click Replace. 
Select the substitute resource from the list and click OK.

OR

hh In the Team Planner view, right-click the task assignment displayed in the 
timescale, select Reassign to, and click the substitute resource.

Use the Replace feature to swap resources instead of deleting the resource and 
adding another resource.

In Chapter 4 we entered data for the first time and explored the scenario where 
most of your tasks were either fixed duration or fixed work. However, we did not 
discuss the calculations that were occurring nor address various situations where 
either values or assignments may need to be changed. That will be the focus of 
this section. 

As we learned in Chapter 4, Project 2013 uses the following formula for these 
variables: Duration * Units = Work.

Replacing 
Generic 
Resources with 
Individuals

Assignments 
and Task Types
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Fixed Duration
Meeting

Fixed Units
Inspect Site

Fixed Work
Translating

2h

1

8

6h

80h1

Duration*  Units  =  Work  

 

As their names indicate, each of the three task types fixes (holds constant) one 
of the three variables in the formula. If you set a task to be fixed duration, Project 
2013 will not change this duration. (This is a comforting thought, particularly if 
you have been haunted in the past by numbers being changed by Project 2013 
that you didn’t want changed.)

When you enter the second value (units or work), Project 2013 will calculate the 
third value for you.

hh For example, if you have a task meeting with a fixed duration of two business 
hours, and you invite eight people to the meeting, Project 2013 will calculate 
2 * 8 = 16 person hours of work.

hh Another example: a task to translate a small book may take one person 80 
person hours to complete. The task would be set up as a fixed work task and 
would be completed over a 10-day duration. If a second person is assigned 
to assist with the task, Project 2013 will keep the work constant at 80 but 
recalculate the duration to 5 days.

You might ask yourself at this point: Why is Project 2013 recalculating all these 
values constantly? It makes my life miserable! The answer is that if it did not 
calculate them, you would definitely be working overtime with your calculator 
making those calculations yourself.

Project 2013 tries to help you, and it uses the broad assumption that every 
resource is equally effective and efficient, which is not true of course. However, 
in 90% of cases this assumption is accurate enough for modeling purposes. 
Remember that we are deliberately simplifying the reality when we model 
projects. We try to approach reality as closely as possible, but with as little effort 
as possible. We are not trying to recreate reality in all its complexity in our 
schedule. Many project managers seem to forget this once they get going with 
Project 2013.

The following table suggests the best use for each task Type:
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Type of task Use for
Fixed Duration hh When the duration is the first thing you estimate

hh If the duration does not decrease when human resources are 
added, such as when backing up a computer system

hh Tasks that always have a group of resources assigned, such as 
meetings or training

hh When the deadline is so tight that it’s the primary driver for 
the duration of the task: you have to make it work within the 
available time frame

hh When the workload is not your problem, e.g., you’re using 
external resources, such as subcontractors and consultants

Fixed Units 
(default)

hh When the number of resources you have for the task is the 
first thing you know

hh When you cannot get more resources to do the work
hh When you want to change the duration or the work on a task 

while keeping the number of people working on the task the 
same (assignment units). We will discuss this later in the 
chapter

hh When you want to keep the resource working on a task at a 
certain percentage of his available hours

Fixed Work hh When the effort required is the first thing you estimate
hh When the effort required is the easiest thing to estimate. This 

is often the case. For example, you estimate that painting a 
home takes 60 person hours of effort. Estimating effort is 
often easier and more accurate than estimating duration: 
you don’t need to take resource availability and holidays into 
account

The formula D * U = W does not apply to:

hh Tasks that have assignments with a work contour that is not flat. 
hh Tasks with multiple assignments where one assignment is longer than the 

others or starts later (called multiple or uneven assignments). The formula 
still applies for each individual assignment.

Here are three rules we urge you to memorize and follow when you enter or 
change assignments. If you do, Project 2013 will become your obedient servant. 
If you don’t, Project 2013 will inevitably recalculate values that you don’t want 
changed. You can even end up in an endless loop, where you change a value, it 
changes a value, you change a value, etc.

Three  
Rules for a 
Happy Life with 
Project 2013
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Here are the rules:

1. Enter the first value as a duration estimate or work estimate and fix that 
number by setting the task Type accordingly. This will prevent Project 2013 
from changing the number.
h` If you enter a duration estimate, set the task Type to Fixed Duration 

(turn off Effort Driven).
h` If you enter a work estimate, set the task Type to Fixed Work. (Effort 

Driven is always on with this task type). 

2. Provide the second value in the formula Duration * Units = Work and let 
Project 2013 calculate the third value. Always provide only two of the three 
values!

h` If you created a fixed duration task, assign the resources you need, and 
Project 2013 will calculate the work.

h` If you created a fixed work task, assign the resources and Project 2013 
will calculate the duration.

h` If you estimate both duration and work, enter the duration as the first 
value and set the task Type to Fixed Duration with Effort Driven on. 
Enter work as the second value. When you assign the resource to the 
task, Project 2013 will apply the formula to calculate units. 

By providing both the duration and the work, Project 2013 only needs to 
know who will do the task and it will calculate the number of resources 
needed (units).

3. Before making a change to any of the three values in the formula, reconsider 
the task Type by asking yourself: What Type of task do I need for this particular 
change? More on this next.

Enter the work estimate, duration estimate, or combined work/duration 
estimate; then set the task Type (select the Effort Driven choices, if needed), 
then assign the resource and let Project 2013 calculate the third variable.

The following examples will help you understand how entering an assignment 
calculates a value in Project 2013. All of these examples are on auto-scheduled 
tasks. 

For manually scheduled tasks, you will NOT be able to change the Task Types 
or Effort Driven flag. Each resource added will add to the amount of work 
regardless of the Task type or Effort driven flag.

hh Planning a task where the duration needs to stay the same and the 
resources ARE NOT working together:
1. Enter total duration for the task.
2. Set the Task as Fixed Duration with Effort Driven off.
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3. Add one resource, click OK.
4. Add a second resource, click OK.
5. Work is calculated. Notice that the work hours are the same for each 

resource.

hh Planning a task where the duration needs to stay the same and the 
resources ARE working together:
1. Enter total duration for the task.
2. Set the Task as Fixed Duration with Effort Driven on.
3. Add one resource, click OK.
4. Add a second resource, click OK.
5. Peak Units is calculated (discussed later). Notice that the total work 

hours stay the same but are divided across the resources.

If you are familiar with prior versions of Project (2007 or earlier), you will notice 
that the resource units stay at 1 (or 100%) instead of reducing to 0.5 (50%) each. 
Since Project 2010, the assignment units field no longer automatically changes 
during resource assignments. This is due to feedback from customers (including 
our own) that you do not want initial assignments to change. Refer to the next 
section on changing assignments for further information.

hh Planning a task where the work needs to stay the same (resources are 
working together):
1. Enter total work for the task.
2. Set the Task as Fixed Work (Effort Driven is on automatically).
3. Add one resource, click OK.
4. Add a second resource, click OK.
5. Duration is calculated. Notice that the duration reduces by half. 

hh Planning a task where you know the number of resources and the work 
hours, but you would like Project to calculate duration:
1. Enter total work for the task.
2. Set the task as Fixed Units, Effort Driven on.
3. Add the resource name and enter the number of Units available, click 

OK.
4. Duration is calculated. Notice the length of time is based on number 

of Units. 

hh Planning a task where you know both duration and work, but you 
would like Project to calculate resource units:
1. Enter total work and total duration for the task.
2. Set the task as Fixed Duration, Effort Driven on.
3. Add the resource name, click OK.
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4. Resource Units is calculated. Notice the number of Units reflects how 
many people you would need to complete the total hours within the 
length of time provided. 

Before you make any changes to a task that could affect any of the three values 
in the formula D * U = W, you should always first think about the task type you 
need for that change. With every change, Project 2013 will recalculate one other 
value, and it may not recalculate the one you want.

The task Type and the Effort Driven attribute determine how Project 2013 will 
react. We suggest these steps when you change an assignment:

hh Display and configure Task Usage view (explained below).
hh Review or change the task Type.
hh Determine the appropriate task Type by asking yourself: I will be making a 

change to a value in the formula; which value do I want to keep the same? The 
answer to this question will tell you which task Type you need. For example, 
if you want to keep the duration the same while you change the work, you 
should set the Type to Fixed Duration. If you want to keep the total amount 
of work on the task the same while you change the duration, you need Fixed 
Work.

In Project 2013, Units remains the same for existing resource assignments 
(refer to the examples below).

hh Ensure Effort Driven is set to your desired option. For Fixed Work tasks, the 
effort driven is on by default. 

hh Then edit the value that you want to change on the assignment. 

Avoid changing the variable that is fixed if you want to predict what Project 2013 
will do. 

Before you change a variable, set or change the task Type and Effort driven 
choices, accept that change, and then change the variable.

When there are multiple, uneven assignments, one or more of the assignments 
can drive the duration of the task. Before you make a change, you should identify 
which assignment drives the duration of the task. Consider changing assignment 
fields instead of task fields.

Notice that when you apply the task type Fixed Work the attribute Effort Driven 
is automatically turned on by Project 2013. When you change to a different 
task type again, the Effort Driven attribute stays on. Don’t forget to turn it off 
if needed.

To replace one resource with another, Project 2013 provides a shortcut that 
doesn’t trigger recalculations. Use the Assign Resources dialog, select the 

Changing  
an  
Assignment
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assigned resource and click Replace. Select the new one and click OK. Unlike 
removing the resource and then reassigning someone else, replacing a resource 
doesn’t cause recalculations.

For each task Type and Effort or Non Effort driven, the following table illustrates 
the impact on Duration, Work, and Peak units based on the change in one 
variable:

Type of 
task

Adding/
removing 
resource, 
this will 
change

Changing 
duration, 
this will 
change

Changing 
work, this 
will change

Changing 
units, this 
will change

Fixed Duration 
Effort Driven

Peak Work Peak Work

Fixed 
Duration Non 
Effort Driven

Work Work Peak Work

Fixed Units 
Effort Driven

Duration Work Duration Duration

Fixed Units 
Non Effort 
Driven

Work Work Duration Duration

Fixed Work Duration Peak Duration Duration

Before we provide specific examples, it’s important to understand the difference 
between Assignment Units and Peak units (referred to as Peak in Project 2013):

hh Assignment Units is the portion of a resource’s time that you initially 
allocate to a given task (100% or 1 by default). 

hh Peak units show the maximum percentage of a resource’s time that is needed 
at any point over the duration of the task. A resource will be considered 
over-allocated if for a period of time, the sum of their Peak Units—across all 
their tasks or assignments—is greater than their Max Units entered on the 
Resource Sheet. 

Changing 
Assignment 
Examples
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In prior versions to Project 2010, the role of these two fields was not clearly 
defined and in many cases Assignment Units would change in response to 
changes to other variables. Project 2013 changes Peak units so you can clearly 
see what is available (Assignment Units) versus what you are requesting 
(Peak units) for a specific task. In order to take advantage of these features, we 
recommend that you change variables using Task Usage view, and that you insert 
both the Assignment Unit and Peak fields in the Usage Table. 

Configure Task Usage View:

1. On the Task tab, in the View group, click the Gantt Chart down-arrow and 
choose Task Usage. 

2. On the View tab, in the Data group, click the Tables down-arrow and 
choose Usage. 

3. Right-click on Start and in the shortcut menu choose Insert Column and 
then click Assignment Units.

4. Right-click on Start and in the shortcut menu choose Insert Column and 
then click Peak. 

When changing variables after resources have been assigned, use Task Usage 
View and display Assignment Units and Peak fields.

As a reminder of an earlier best practice, change the task Type and Effort Driven 
settings to isolate what variable you wish to freeze before changing another 
variable or modifying an assignment that would trigger a calculation. The 
instructions to change the task Type will apply to every situation below. Feel 
free to review the examples to help determine what task Type you need to set.

Change the task Type and Effort Driven Attribute before changing a variable:

1. In Task Usage view, double-click the name of the Task (the row with the ID 
number). The Task Information dialog box appears. 

2. On the Advanced tab, in the Task Type list, choose the desired type. 

3. On the Effort Driven check box, click the box either on (checked) or off 
(clear, not shaded).

4. Click OK.

You are now ready to change your desired value. 
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To Change Work:

For Fixed Duration, Effort Driven Off task, or Fixed Duration, Effort Driven On 
task, change the Work value of the task (the row with the ID number) and watch 
the results:

To Change Duration:

For a Fixed Work task, change the Duration value of the task (the row with the 
ID number) and notice the Peak value changes:

To Change Assignment Units:

For a Fixed Work task, change the Assignment Units value on each resource and 
notice the Peak value changes:

The task Type is not something you set once and never look at again. You 
continue to monitor it in order to control what Project 2013 calculates. If you 
reconsider the Type of task before every change, you will be able to predict and 
control Project 2013’s recalculations.

Here are some checks to help you verify whether you have applied best practices 
to the assignments in your schedule:

hh Are you paying attention to the task-related fields Type and Effort Driven 
for the detail tasks?
The available Types are: Fixed Duration, Fixed Units and Fixed Work. With 
this field, you can control what Project 2013 recalculates: duration, units, 
or work. If you don’t monitor the field Type, you are not controlling what 
Project 2013 does. If you don’t use the field Type, you are using Project 2013 
in a trial and error fashion: you change a field here, Project 2013 recalculates 

Checks on 
Assignments
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a value there, you don’t like what you see and you change it back again… 
and you start chasing after your own tail. 

hh Does each detail task have at least one human resource assigned?
If there are detail tasks without human resources assigned, you have not 
captured all the workloads in your project. If workloads are missing, the 
schedule may be too optimistic, since leveling workloads typically leads 
to longer schedules and later forecasts. An exception to this rule is that 
recurring detail tasks do not need resources assigned to them. You can 
check on this in one of three ways:

h` In the Resource Usage view, there should be no detail tasks listed under 
the first category Unassigned.

h` You can also apply filter 09a IIL Detail tasks without Resources Assigned.1 
The filter allows you to easily copy the tasks including their ID numbers 
into a schedule evaluation report.

h` In the Team planner view, there should be no tasks in the Unassigned 
Task section (the bottom section).

Note that there may still be detail tasks with only material resources assigned 
if you check the Unassigned category or apply the filter, so neither check is 
bullet proof.

hh Are there no assignments on the summary tasks?
As we discussed, if you assign resources to summary tasks you can easily 
end up with over-allocations that can’t be resolved other than by removing 
the resource from the summary task. If you assign only to detail tasks, 
you will never end up with this stubborn type of over-allocation and will 
save yourself time when leveling workloads. Resolving over-allocations 
is challenging enough. You can check for assignments on summary tasks 
easily by applying the filter 09b IIL Summary Tasks with Resources Assigned.2

hh Are all the costs appropriately modeled to include variable and fixed costs?
Variable costs are driven by the number of units (percentage) of work or 
material resources assigned to a task. Task- or deliverable-related fixed costs 
are entered in the Fixed Cost field in the Gantt Chart or as a Cost resource 
from the Assign Resources dialog box. 

hh Is the cost scheduled appropriately?
h` Does the task-related Fixed Cost Accrual field reflect when the fixed 

cost will be incurred? 

1 This filter can be found in the file IIL Project 2013 Tools.mpp available for download at www.jrosspub.com. 
Click the link WAV Download Resource Center to enter the download site. 

2 Ibid.
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h` You can review the time-phased cost in the Task Usage or Resource 
Usage views. 

hh Have you utilized Budget resources to help you identify variances between 
your planned and projected costs?
Budget variables—created by setting the Budget flag in the Resource 
Information window—can be assigned only to the Project Summary task. 
The values for these resources are entered in the Budget Cost or Budget 
Work fields of the Task Usage or Resource Usage views.
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1. What is the definition of an assignment?

2. In your own words, describe what the following fields represent:
a. Units field in the Task Form
b. Units field in the Resource Information dialog, tab General
c. Max Units field in the Resource Sheet 
d. Work field in the Gantt Chart
e. Work field in the Task Form
f. Work field in the Resource Sheet

3. In your own words, what is a Work Contour?

4. A project manager realizes that she wants to model her project on a high 
level. She will only enter consolidated resources (pooled resources) in her 
Resource Sheet. What setting would you recommend she use in the “Show 
assignment units as” choice in the Project Options? 

5. What are the three task types? How does each task type function? How 
would you use this feature of Project 2013?

6. In your own words, what are the three rules that will help you control what 
Project 2013 does when creating and changing assignments?

7. Before you make a change to an assignment, what question should you ask 
yourself and what field(s) should you check?

8. Would you recommend making multiple, uneven assignments to many 
tasks in your schedule? Justify your answer in terms of pros and cons.

9. Would you recommend assigning resources to summary tasks? Justify your 
answer in terms of pros and cons.

10. When you assign a resource to a recurring summary task with the Assign 
Resources dialog, what will Project 2013 automatically do?

11. A resource is writing two different documents concurrently and you cannot 
plan or predict when he will be working on one or the other. How would 
you model this situation in Project 2013? In particular, what tasks and 
assignments would you create and what number of resource units would 
you assign?

Review 
Questions
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Read the following situations and determine if you will likely make your first 
estimate in person days work (PD), business days duration (BD), or elapsed days 
duration (ED) and explain why. Indicate which type of task you recommend: 
Fixed Duration (FD), Fixed Units (FU), or Fixed Work (FW), and explain why.

PD, BD, or 
ED? Why?

FD, FU, or 
FW? Why?

1. Writing a 10 page report that normally 
takes a person 4 hours per page to 
produce

2. One load to be transported over a 
distance of 4,000 miles with one driver

3. One package that has to be flown a 
distance of over 4,000 miles and has to 
arrive in 2 working days

4. A house painter who is asked for a fixed 
price quote and the earliest end date for 
painting a family home

5. A contractor gives a painter a maximum 
of 2 weeks to finish painting a building

6. Backing up a computer system before 
the conversion to a new operating 
system, where the backing up requires 
little supervision once started

For experience working with the features you’ve learned about in this chapter, 
we strongly suggest that you do the additional exercises for this chapter that are 
included in Case Studies appendix, available to download in the WAV Download 
Resource Center at www.jrosspub.com.

Review B

Additional Practice
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Chapter 9: Optimizing the Schedule

The good news is that you now have a dynamic model of your project. The 
worrisome news is that it’s likely to reveal any or all of the following: the 
duration is too long, the cost is too high, and/or the workloads are unreasonable. 
Fortunately, with a dynamic model you can easily develop and explore different 
scenarios to find the best solution. You can optimize for time; for time and cost; 
or for time, cost, and resource availability.

After reading this chapter you will be able to:

hh Choose the appropriate approach for optimizing
hh Optimize a project for time; for time and cost; or for time, cost, and resources
hh Solve a fragmented critical path
hh Describe the difference between free slack and total slack
hh Explain the assumptions and shortcomings of the Critical Path Method 

(CPM)
hh Make workloads and over-allocations visible in Project 2013
hh Solve problems with the workloads of your resources
hh Determine and use the Resource-Critical Path for optimizing
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During the project life-cycle, the project may be pulled by many forces that 
compete against one another and can make strong demands upon it. These are 
commonly referred to as the competing demands and include: scope, time, cost, 
quality, resources, and risk. 
These competing demands are 
initially client- and sponsor-
driven. Then, through 
negotiation, they are turned 
into a realistic plan, and need to 
be maintained in balance 
through the project life-cycle to 
produce the specified product, 
service, or result. A change in one demand will impact change in the others. 

Optimizing the schedule is the process of making sure that the various factors 
that drive the schedule are in the best possible balance to minimize time and cost 
while meeting quality and scope requirements, using the limited resources in the 
best way, and of course, keeping the risk at acceptable thresholds.

Optimizing is the true art of scheduling and requires you to consider all aspects 
of the project. 

You typically optimize during planning in order to model or refine your project 
schedule to hit specified deadlines or constraints. Then, once you start execution, 
the monitoring and controlling processes will require further optimizations when 
you are moving away from your baseline and need to modify the remainder of 
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TimeProject

Hey! Follow me! This way is shorter!
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the schedule. Managing the baseline is a topic we’ll discuss when we talk about 
preparing for accepting updates.

Optimizing the schedule means managing all the competing demands of the 
project with regard to one another. It begins by managing each dimension 
individually. Project 2013 provides sufficient features to manage many, but not 
all, demands of the project:

hh Quality
The quality of deliverables must correspond to the specifications and 
expectations of the client. While you can schedule quality activities in 
Project 2013, the tool doesn’t provide a full-fledged quality management 
system. Such a system typically contains the requirements, specifications 
or acceptance criteria for the deliverables, test scenarios and cases, etc. 
For software development and engineering projects, we recommend you 
complement Project 2013 with a requirements tracking system. However, 
even without a quality tracking system, quality impacts can and should 
always be considered while optimizing.

hh Scope
The scope of a project is represented by the work breakdown structure. It 
contains the deliverables to be produced and the activities to be performed 
to produce them. Project 2013 is an excellent tool for managing project 
scope (“the work performed to deliver a product, service, or result with the 
specified features and functions”).1 However, it is not made for managing 
the product scope (“the features and functions that characterize a product, 
service or result”).2 The product scope as it is described in requirements and 
specifications must be managed externally. The results of scope management 
(in particular, changes) should be reflected in the Project 2013 schedule. 

hh Time
Project 2013 does a fine job of managing the schedule and deadlines. Since 
a project is a temporary endeavor, every project manager will monitor and 
manage the duration of his or her project by definition.

hh Cost
You can create a budget and manage the expenses for labor, facilities, 
machines, materials, and other expenses with Project 2013. Not all project 
managers are given a monetary budget and not all monitor their project 
costs. In recent years, however, more organizations are empowering their 
project managers with budgets—and challenging them to stay within 
them. Project 2013 permits project managers to compare planned budgets 

1 ——— PMBOK® Guide – Fifth Edition, PMI, 2013, p. 555.
2 Ibid., p. 552.

Where Project 
2013 Helps in 
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Schedule
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with financial budgets from 3rd party accounting and enterprise resource 
planning applications.

hh Resources
Workloads must stay within the availability of the resources. You can do 
workload leveling with Project 2013. When you level resource workloads, 
the critical path can become fragmented. We’ll introduce a new concept 
for dealing with this: the resource-critical path that is needed to optimize 
resource-constrained schedules.

It should be noted that leveling an individual project, in the absence of other 
projects that share the same resources, can be a waste of time. More than 
that, attempting to level an individual project can actually create resource 
allocation issues that did not exist prior to leveling. For this reason, we’ll 
introduce the subject of consolidated schedules in Appendix 1.

hh Risk
When we define a schedule, we use estimates and assumptions that may 
change, so we need to consider risk dimension in our planning and 
forecasting. As explained in Chapter 4, it is highly recommended to use 
three point estimates for durations to measure risks and uncertainties, either 
applying PERT analysis, or Monte Carlo simulation. The PERT analysis 
is really easy to apply in Project 2013 using custom fields. If you want to 
develop more sophisticated quantitative risk analysis like Monte Carlo 
simulations, you will need to acquire some add-on app that complements 
Project 2013.

If you use Project Server 2013 and/or SharePoint 2013, you may perform 
qualitative risk analysis to identify risks, evaluate their probabilities and 
impacts, prioritize, assign owners and develop the risk response planning 
strategies, and to monitor and control the risk processes during execution.

Consider impacts on quality, scope, time, cost, resources, and risk with every 
optimization change.

Improving one dimension of the project often impacts others. When the impact 
is negative, you are trading off among the dimensions. For example, if you hire 
more resources to meet a tight deadline, the impact may be positive on time, but 
negative on cost. Sometimes, you can find methods that are positive in more 
than one respect and neutral in others. 
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Individually managing the six competing demands that influence the project is 
not enough (or even possible). They are all interrelated. For example, duration 
(time) is driven by scope, but scope may be influenced by time, as when project 
scope is reduced in order to hit an important deadline. Resources influence 
time, cost, and scope, etc. Optimizing the schedule requires integration of the 
dimensions that affect the project schedule.

We’ll present three different approaches for optimizing schedules. In all three we 
consider quality, scope, and risk but because these dimensions don’t differentiate 
the approaches, we haven’t included the words scope, quality or risk in the 
approach names.

The three approaches we’ll present are: Optimizing for Time; Optimizing for 
Time and Cost; and Optimizing for Time, Cost, and Resources.

hh Optimizing for Time
This is also known as optimizing under the assumption of unlimited 
resources (the capacity to hire and release any resources you need when 
you need to). The other approaches will not assume that you have access to 
unlimited resources.

Having unlimited resources also assumes that cost is not your primary 
concern and that you only need to consider the forces of quality, scope, risk, 
and time. The common technique used in this situation is the Critical Path 
Method (CPM). Many industries have used CPM for decades; typically, 
the construction and consulting industries apply CPM. These industries 
tend to hire and release resources on an as-needed basis, often working with 
temporary or freelance resources. Other industries find this optimization 
too narrow, particularly when cost is a concern or resources are not readily 
available.

hh Optimizing for Time and Cost
If you have a limited budget and cost is your primary concern, you should 
apply this approach. It is also applicable if you can find more money to solve 
quality, scope, or time problems. For example, you could use additional 
money to buy better raw materials, rent better equipment or pay penalties 
for late delivery. However, if you use the extra money to increase resource 
availability, you should use the next approach instead of just focusing on 
time and cost, since you are now affecting the resources. You increase 
availability when you hire more people, subcontract to free-lancers or rent 
more facilities or equipment.

hh Optimizing for Time, Cost, and Resources
If you must also consider the availability and capacity of resources in 
order to derive a feasible schedule for your project, use this approach. You 

Three 
Approaches for 
Optimizing
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make trade-off decisions among quality, scope, time, cost, and resource 
availability. An example of optimizing for time, cost, and resources is when 
you consider paying extra to get more overtime from your team. If your 
resources are scarce, you will have to level the resource workloads.

As you can see, we are adding one dimension with each optimization approach, 
and the optimizations become more complex as we add more dimensions. 
Including five out of the eight dimensions is the most complex optimization we 
will discuss in this book. It also is the most complex configuration Project 2013 
can assist you with as a standalone tool.

On the File tab, in the Backstage view, click Options, Advanced tab in order to 
access the following options that are relevant for all optimizing approaches (use 
the scroll bar to find the sections):

Project 
Options

Recommended Choices

Advanced Set the Display options for this project on the Advanced 
Tab:
Show project summary task
The project summary task (ID number zero) is inserted at the top of 
the task list. This is useful when optimizing because it displays the 
total duration, effort and cost of the project.
You can choose to have this option only for the current project or 
to establish it as a default for all new projects, just choose <All new 
projects> in the drop down. 

Advanced Set the Calculation Options on the Advanced Tab:
Calculate multiple critical paths
We recommend you keep this option turned off, since a single project 
should only have one ending point in the network logic. If there are 
multiple ending points, there are multiple critical paths. This option 
is stored in the project schedule.

Tasks are critical if slack is less than or equal to days
This field creates a threshold for marking tasks that are critical. 
Normally, this option is set to zero, which means critical tasks are 
those with zero or negative total slack, shown in red in the Tracking 
Gantt view. This option is stored in the project schedule.

Choosing the 
Options
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The dimensions that we consider in this approach to optimization are quality, 
scope, time, and risk as indicated by the solid arrows in the illustration. When 
you try to decrease the duration of the project and trade-off against quality, risk, 

or scope you are essentially 
doing an optimization on the 
dimension of time. The 
technique for this type of 
optimization is the CPM. Many 
project managers make a habit 
of keeping their eye on the cost 
and resources while crashing 
the critical path (shortening 

duration by adding resources), but we won’t do that. We will discuss the CPM 
here in its original form, using time optimization only.

There are three principle techniques used in optimizing time: CPM, PERT, and 
simulation.

hh The Critical Path Method 
CPM helps project managers meet deadlines by finding and highlighting 
the series of tasks that are most likely to affect those deadlines. The logical 
network is the basis for CPM. Using task durations, the longest (critical) 
path is determined and float on other paths’ tasks are determined. Happily 
this is all done automatically by Project 2013. 

Float or slack is the amount of time a task can be delayed before it affects the 
project end date. A critical task does not have float or slack, and any delay 
experienced on a critical task means your project end date will slip. CPM 
uses a single duration estimate for each task. We’ll discuss CPM in more 
detail after we describe the other two techniques, PERT and simulation.

hh The PERT Method
The Program Evaluation and Review Technique (PERT) Method is a 
more sophisticated application of CPM. CPM uses one duration estimate 
for each task, while PERT uses three: optimistic (O), most likely (ML), and 
pessimistic (P). These durations are converted to an expected duration with 
the following formula: Expected Duration = (O + [4*ML] + P) / 6. This 
multipoint estimating introduces some adjustment for risk and probability.

To do a PERT analysis in Project 2013:

1. Choose four duration custom fields and rename them as Optimistic, 
Most Likely, Pessimistic and Expected Duration. 

2. In the Expected Duration field capture the formula ([Optimistic]+4* 
[Most Likely]+[Pesimistic])/6.

Optimizing 
for Time - 
Techniques

Quality

Resources

Cost

Risk Scope

TimeProject
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3. Insert the custom fields in the Entry table.

4. Enter the O, ML and P values for each task. 

5. Copy the values in Most Likely to Duration. Considering the network 
of dependencies is complete, this is the Most Likely scenario for your 
project.

6. You can copy the Optimistic, Pessimistic, and Expected Duration as well 
to analyze the different scenarios. 

The steps provided are just general steps of how to apply the PERT analysis, 
however, doing and taking advantage of PERT analysis may require to 
understand concepts explained in different chapters of this book such as 
estimating in Chapter 4, entering dependencies in Chapter 5, the use 
of constraints and deadlines in Chapter 6, the Critical Path Method in 
this Chapter 9, customize fields in Chapter 11 and creating interim plans 
in Chapter 10 in case you want to capture the different scenarios for 
comparison purposes.

Creating a PERT analysis should return a better understanding of the 
variation ranges of the project. These ranges represent the uncertainty of the 
project and should give you an idea of whether Time Contingency Reserves 
are needed.

hh Simulation of the Schedule
Another way to make probability visible is by subjecting the schedule to 
Monte Carlo simulation. This type of simulation creates many versions of 
the same schedule based on the probability ranges you provide for certain 
estimates. The simulation software then averages over all the versions of the 
schedule to arrive at the probability for each possible finish date. Simulation 
is more powerful than PERT, because it quantifies the compounding effect 
of parallel paths as well. Due to the complexity of the calculations, Monte 
Carlo simulation is typically done with computer software which may be 
integrated into Microsoft Project. 

We will further elaborate on CPM and Monte Carlo simulation in this book.

The critical path determines how long your project will take. The concept is 
fairly simple. The illustration depicts a simple authoring project: outline the 
document, write the text, and 
edit the text, while somebody 
else makes graphics. When the 
text and the graphics are ready, 
the format can be created and 
the project is finished. All 
arrows are finish-to-start 

Write
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Slack
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Edit
2d

Outline
2d

Make Graphics
8d

Format
2d

The Critical Path 
Method
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dependencies and durations are shown below the task names. Before we explain 
the critical path theory, you should ask yourself: What is the minimum duration 
for this project?

If you came up with the correct answer, twelve days, you understand the critical 
path concept intuitively. If you came up with a different answer, find the critical 
path by comparing the two parallel paths. Add the durations and any lags on each 
path and compare the totals. The longest one is the critical path: it determines 
the minimum duration of the project.

In the illustration, the two parallel alternatives for the critical path are the path 
write (3d) and edit (2d) which is 5 days long in total versus the path make graphics 
(8d). It is clear that the make graphics path is the longest and determines the 
project end date. To find the critical path, continue comparing parallel paths until 
you have checked them all and found the longest path in the whole network: 
this is the critical path. Sometimes a few chains are equally critical and you have 
multiple critical paths.

Parallel chains of tasks or paths make up a network, of which all but the critical 
path(s) have slack. Slack exists on a chain of tasks when it is performed in parallel 
with another chain that takes more time.

The critical path determines the minimum duration of the project. We call it 
the minimum duration, because the real duration may be longer when some 
resources are over-allocated. Over-allocations may force tasks to be delayed past 
the minimum duration.

Finding the critical path is challenging:
hh When there are many parallel paths
hh When different types of dependencies are used (Finish-to-Start, Start-to-

Start, Finish-to-Finish, Start-to-Finish)
hh When there are lags or leads on the dependencies

In these cases, it is nice to have a tool like Project 2013 that will identify the 
critical path for you.

To find the critical path, Project 
2013 starts with all tasks stacked 
up at the project start date, as 
shown in the illustration. Then, 
based on task dependencies and 
durations, it schedules them out 
to the earliest possible dates (As 
Soon As Possible scheduling). 
Project 2013 performs this 
forward pass calculation to 
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determine the earliest possible dates (early dates). Then it schedules all tasks 
As Late As Possible in the backward pass and calculates the latest allowable 
dates (late dates) to meet the earliest possible project finish date. The difference 
between early and late dates for a task is the task’s slack.

1 111098765432 1312
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On the forward pass, Project 2013 
calculates two dates for each task: 
the Early Start (ES) and the Early 
Finish (EF) date. The result of this 
forward pass is shown in the 
illustration. Project 2013 starts 
with the first task (outline), looks at 
its duration (2 days) and calculates 
the earliest date it can be ready. 
This is the Early Finish date. The 
outline will be ready at the end of 
day 2.

Project 2013 will then determine the date of the successor(s). Write and make 
graphics are the successors; they can start on day 3. The Early Start date of the 
successors will be the same as the Early Finish date of outline, unless other 
dependencies on the successors cause them to start later.

Project 2013 continues to calculate the Early Finish for write and make graphics. 
Format cannot start until both edit and make graphics are finished, and the 
earliest start date for format is therefore day 11 even though format could start 
on day 8, if it depended solely on edit. Project 2013 continues through the last 
task in the chain. The software now knows what the earliest finish date is for the 
project—day 12 in our example.

Project 2013 then goes backward through the network starting at the project 
end date of day 12, to calculate the Late Finish dates for the tasks, as shown in 

the illustration. The Late Finish 
date is the latest date a task should 
be finished in order to meet the 
project end date. By subtracting 
the duration of the task from the 
finish date, Project 2013 then 
calculates the Late Start date. The 
Late Start date is the latest date you 
can start working on the task to 
finish by its Late Finish date. For 
format, this is day 11, the same as 
its Early Finish date. You then 
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continue with the Late Finish dates of the predecessors. Edit can finish on day 10 
at the latest and the project will still end on day 12. Edit has a Late Finish date 
(day 10) that is three days later than its Early Finish date (day 7); therefore, edit 
has a time buffer called slack and is not a critical task.

If a task has more than one successor, like outline, Project 2013 has to take all 
successors into consideration to determine the late date. The start date of the 
earliest successor determines the Late Finish date of the task, in this case day 2 
(make graphics), not day 5 (write). So, the latest finish for creating the outline is 
determined by the Late Start date of make graphics, and not the Late Start date of 
write. As a result, the early and the late dates for outline are the same; outline does 
not have slack and is another critical task.

There are two kinds of slack: Total Slack and Free Slack. 

Total Slack (TS) is the amount of time you can delay a task without affecting the 
project end date. The total slack is the Late Finish (LF) date minus the Early 
Finish (EF) date of a task: TS = LF – EF.3 

Total Slack tells you how much a task 
can slip before delaying the whole 
project or other hard constraint dates 
in the schedule.

For example, the illustration shows 
that the task Write has three days of 
total slack (TS = 8 – 5 = 3). If the 
author calls you and tells you he fell 
ill, you would ask, “When do you think you might be better?” If the answer is 
more than three days, you know you should find somebody else if you can’t 
permit the project to slip. (If the answer is less than three days, you may still have 
a problem, because the editor will now receive the text later, which might cause 
conflicts in her schedule. You need to communicate!)

The total slack of tasks can be:

hh Greater than zero: positive slack
These tasks have slack and can be delayed for a period equal to their total 
slack. If you delay them more than that, the project as a whole will slip. You 
can often level some workloads by using the total slack of a task.

hh Equal to zero: zero slack
Where the Late Finish date is equal to the Early Finish date, there is no 
slack. Tasks without slack are by definition on the critical path.

3 In fact, Project 2013 also calculates total slack on the start dates: TS = LS – ES; the lesser of the two total 
slacks will be the total slack displayed on the task.
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hh Less than zero: negative slack
Tasks with a negative slack are tasks that don’t meet the project deadline 
or hard constraint dates set in the schedule. Slack can only be negative if 
there are constraints, deadlines, or other forces in the schedule that inhibit 
Project 2013 from finding and displaying a schedule that meets all those 
constraints.

The free slack (FS) of a task is the Early Start date of the task’s successor minus 
the Early Finish date of the task itself. If there is more than one successor, you 
should take the Early Start date of the earliest successor: FS = ES(earliest successor) – 
EF. The free slack of a task is always less than or equal to its total slack.

In the illustration, the earliest successor of task Write is Edit, not Task x. The free 
slack tells you how much you can let the task slip before it affects any of its 
successors. Write does not have free slack, since the successor Edit starts 
immediately after Write finishes. 

The difference between total slack 
and free slack manifests itself in 
the task Write; it has no free slack 
but three days of total slack. It can 
use the free slack of its successor 
Edit and slip without delaying the 
project end date. That is the beauty 
of the concept of total slack: it 
immediately tells you for each task 
when the project finish date or other 
constraint dates are in jeopardy.

Project 2013 generates all the dates we discussed in the task fields Early Start, 
Early Finish, Late Start, and Late Finish. The two slack fields are Total Slack and 
Free Slack.

The critical path is the path with the tasks that have zero total slack. In our 
example, the tasks Outline, Make Graphics, and Format are the tasks on the 
critical path. They are the dark 
task bars in the illustration. 

In the Tracking Gantt view the 
critical path is shown in red. You 
can also see the critical path in 
the Gantt Chart view: on the 
Format tab, in the Bar Styles 
group, select Critical Tasks. It’s 
important to keep your eye on 

Calculating Free 
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the critical path in order to bring your project in on time. Find critical tasks and 
optimize them to shorten your schedule and finish on time.

 1 111098765432 1312

Outline

Write

Edit

Make
Graphics

Format

Ready

ES EF

ES EF

ES EF

ES EF

ES EF

LS LF

LS LF

LS LF

Finish No Later Than Day 11

LS LF

LS LF

FS = 0
TS = -1

FS = 0
TS = 2

FS = 0
TS = -1

FS = 2
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When you enter constraints 
into the schedule, all slack 
amounts change. The backward 
pass is calculated from the 
Finish No Later Than 
constraint date instead of the 
earliest possible project finish 
date. As a result, the late dates 
and total slack numbers change 
when you insert such a 
constraint. In our sample 

project, we will introduce a hard constraint that is one day before the earliest 
possible finish date of the project. The illustration shows how this constraint 
changes the total slack numbers of all tasks.

The forward pass determines the early dates, regardless of constraints. The 
backward pass takes constraints like Finish No Later Than into account.

You can see that the slack turns negative when the latest allowable dates (LF) are 
before the earliest possible dates (EF). The critical tasks now have –1 day total 
slack. Project 2013 identifies this as a scheduling conflict and warns you with a 
dialog:

As you can see, Project 2013 gives you suggestions about how to resolve the 
conflict. The constraints that can cause scheduling conflicts, or negative slack, 
under forward scheduling are:
hh Must Finish On
hh Must Start On
hh Finish No Later Than
hh Start No Later Than

In backward scheduling, the following constraints can cause negative slack:
hh Must Finish On

Constraints and 
Negative Slack
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hh Must Start On
hh Start No Earlier Than
hh Finish No Earlier Than

Because constraints affect the calculation of slack, you should use them as 
sparingly as possible, without compromising the quality of the project model. 
We recommend entering constraints for very hard deadlines only—the do-or-
die dates. If the deadline dates are soft deadlines or target dates, use the deadline 
feature instead. Also, if you have constraints in the middle of your schedule, 
you will not see by how much the project end date is missed overall because 
constraints prevent tasks from floating past them. See Chapter 6 for more 
information regarding constraints and deadlines.

If you do use the deadline feature, you won’t get warning dialogs that alert you 
to conflicts in your schedule. Instead, a red flag will be raised in the Indicators 
column. Deadlines also allow you to see what the total slippage is on the project 
end date.

You can display a line in the timescale for the amount of negative slack a task has. 
In the Gantt Chart view, on the Format tab, in the Bar Styles group, click on 
the Format down-arrow, Bar Styles. There is an item called Negative Slack in 
the list under From and To. It allows you to display a line in front of the task bars 
that represents the amount of time a task slipped past its latest allowable finish 
date (Late Finish). To use this, choose the following settings:

The result would look like this screenshot:
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Project 2013 will make all CPM calculations for manually scheduled tasks 
and for auto-scheduled tasks, but be careful: when you change something in a 
manually scheduled task, CPM calculations will not be updated. In addition, 
constraints are deactivated for manually scheduled tasks.

1. Show or highlight the critical path and slacks
2. Identify which tasks have potential time savings
3. Make a change to those tasks
4. Consider impacts on quality, scope, and risk
5. Decide whether you want to keep the change
6. Repeat steps 3 – 6 

In step 1 you identify the critical tasks since they drive the project duration. Do 
this by having Project 2013 show the critical path in red or highlight the cells 
with yellow. If the critical path switches to another parallel path while you are 
optimizing, Project 2013 will immediately show the new critical path, so that 
you always know which tasks are critical. Also, obtain the information about 
total slack and free slack, so that you know the flexibility of a task’s scheduling 
when optimizing for time. 

In step 2 you identify the critical task(s) with the greatest opportunity for saving 
time, so you should focus on those first. (In other words: Don’t sweat the small 
stuff!)

Steps to 
Optimize for 
Time
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In step 3 for each task you’ve selected, you come up with a way to do the work 
faster or with more overlap with other tasks. We will identify and explain 
crashing and fast-tracking approaches for reducing overall duration. You also 
need to evaluate whether the trade-offs (step 4 and 5) on quality, scope, or risk 
are too high a price to pay for the time saved (we’ll address cost and resources in 
the following optimizing approaches).

The explanation of these steps will take quite a few pages. We’ll repeat the list of 
steps as we go.

Before you optimize, show or highlight the critical path on the Gantt Chart view.

There are many ways to do this in Project 2013; here are a few:

hh Switch to the Tracking Gantt view that shows the critical tasks in red by 
default. On the View tab, in the Task Views group, click the Gantt Chart 
down-arrow and click Tracking Gantt. 

hh Use the one-click critical path option. In any Gantt Chart view, on the 
Format tab, in the Bar Styles group, check Critical Tasks. 

hh Use the right-click feature for displaying the Critical Tasks.

1. In any Gantt Chart view, if you right-click on any blank part in Gantt Chart 
section, you will get a mini-menu with some options. Put the cursor over 
Show/Hide Bar Styles and a second mini-menu will appear:

2. On the second mini-menu, click Critical Tasks.

hh Use the Highlight tool

1. In the Gantt Chart view (any task view), on the View tab, in the Data 
group, click the Highlight down-arrow to display the option list:

Showing or 
Highlighting  
the Critical  
Path
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2. Select Critical. All critical task cells in the table now appear with yellow 
highlighting. 

If you have schedules developed with previous versions of Project, in some cases, 
when you apply the highlighting feature you will get a change in the color of the 
fonts instead of a change in the color of the background.

hh Use Text Styles to change the color of the critical task names or the color 
of the background:

1. In the Gantt Chart view (any task view), on the Format tab, in the Format 
group, click on Text Styles. The Text Styles dialog box will appear:

2. Select from the list Item to Change All the item Critical Tasks.

3. From the list Color, select the color you want, for example red.
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4. From the list Background Color, select the color you want, for example 
yellow. 

5. Click OK. All critical task information in the table (except critical 
milestones) are now in red and their cells are in yellow.

Before we continue our discussion on optimizing for time, it is useful to note 
that the Total Slack field can be inserted or the total slack bar can be shown 
to troubleshoot issues in your schedule or to complement the one-click critical 
path.

Any tasks with a very large positive total slack number may have been accidentally 
left off the critical path because they are missing one or more dependencies to 
other tasks in the schedule. 

hh To insert the Total Slack column in any task table:

1. Right-click on the column heading just after where you want to insert it.

 

2. From the list of field names select the item Total Slack; you can do this 
quickly by typing the first few characters of the field name; then click OK.

3. The field will now be displayed in the table. You can drag the dividing bar 
(between the table and the timescale) to the right to accommodate the new 
field in the view. To position the dividing bar on the edge of the nearest 
column, double-click on the divider.

You can also follow these steps to insert the Free Slack column to help you 
analyze the flexibility of your tasks related to their successor tasks.
hh Show the Free Slack bar using the new one-click critical path option. In any 

Gantt Chart view, on the Format tab, in the Bar Styles group, check Slack. 

hh Show both, total and free slacks by switching to the Schedule table. In any 
Gantt Chart view, on the View tab, click Tables and select Schedule. 

Displaying the 
Total Slack
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The total slack identifies which tasks are critical (total slack less than or equal 
to zero) and which ones are not (total slack greater than zero). If the total slack 
is negative, you are missing the project deadline or one or more hard constraint 
dates in your schedule.

By default, Project 2013 shows tasks as critical if their total slack is less than or 
equal to zero. You can change this threshold: on the File tab, in the Backstage 
view, click Options, Advanced tab. Under the Calculation options for this 
project:, increase the field Tasks are Critical if Slack is less than or equal to: 
0 days to the value you prefer . For example, you may want to identify tasks with 
1 or 2 days of slack in order to keep an eye on the “near” critical tasks. With this 
you are raising the threshold for criticality in the CPM calculation. 

What you will often see when you display the critical path for the first time in a 
schedule is that it is not a complete chain of tasks that stretches from the project 
start date to the project end date. Instead you’ll see a fragmented critical path. 
We’ll explore the possible causes of fragmentation. Project managers need to 
understand all paths that explain the entire project duration. 

Normally, the critical path provides a complete explanation of what happens 
between the project start and finish dates. However, the critical path often looks 

fragmented at first and may not 
immediately offer this complete 
explanation.

Only if you shorten the 
duration of a task on the critical 
path will the project duration 
shorten. If you cannot see 
the complete critical path, 
optimizing becomes a painful 

process of trial and error. Therefore, we recommend you analyze the causes of 
fragmentation first to find the complete critical path. 

The critical path can become fragmented for various reasons:
hh Unavailability of resources
hh Schedule constraints and deadlines
hh Elapsed durations
hh Task calendars
hh External predecessors
hh Workload leveling

We’ll discuss each of these.

A Fragmented 
Critical Path: 
Possible Causes

WBS

Time

Parts of  the 
Critical Path
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In the illustration, the Implement task could take place on a week when Cindy 
has her vacation. The result is 
that Project 2013 will schedule 
Implement on the first next 
workable day when the resource 
is available, as shown in the 
illustration. Depending on when 
the predecessors of Implement 
are done, this could create slack. When slack is created before the task Implement, 
the critical path will only start with the task Implement and therefore, only 
partially explain the project duration.

Is this real slack? Real slack is time that can be used as a buffer to compensate for 
slippages. In this case, the slack is real, because if the task Design slips one week, 
this will not impact the project end date.

In some situations, slippage is desirable. For example, you may want to finish the 
design and then start the implementation without a week in the middle (set to 
allow John to deliver the design to Cindy in the best possible way). This could be 
accomplished by making the schedule constraint As Late As Possible for the task 
Design (in the Task Information dialog box on the Task tab, in the Properties 
group). If you were to do this, the slack just moves over to the predecessors of 
Design, and the critical path will start with this task.

Because slack now exists on tasks earlier in the project, we consider them critical 
tasks because if we can compress them, they will impact the total duration of 
the project. To analyze this you need to be aware of the total slack and consider 
that any task with total slack equal or less than the slack produced for the 
unavailability of resources could be considered as a task where you can optimize 
its time and then optimize the total duration of the project. One option for 
showing these tasks as critical tasks is to raise the threshold for criticality by the 
same amount as the slack produced by the unavailability of resources. This will 
adjust the display of critical tasks and you will see a complete critical path. (You 
can adjust the criticality threshold explained earlier in this chapter.)

If you adjust the critical threshold, this will be used to define critical tasks in 
the whole project, not just the period where you’ve detected the problem of a 
fragmented critical path. You may want to use the new threshold to analyze part 
of the schedule, detect the tasks that drive the total duration, and then return to 
the normal threshold equal to zero to continue with your project.

We have already seen that constraints can cause negative slack when they are 
tight, but they can also cause positive slack when they are far out. Positive slack is 
essentially a buffer. Deadlines also affect the slack calculation in a fashion similar 
to constraints.

Unavailability of 
Resources

Week 1 Week 3Week 2

Design

ImplementCindy’s 
Vacations

John

Cindy

Schedule 
Constraints and 
Deadlines
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The illustration has two tasks: Prepare Agenda and Meeting. Typically, a formal 
meeting occurs on a specific date and should be entered with a Must Start On 
constraint. When you enter a 
fixed date, slack can be created 
on the predecessors of that task, 
and the critical path starts to look 
disjointed. Only the task Meeting 
will be indicated as critical, 
because Prepare Agenda now has 
slack.

This is another reason why we recommend using as few schedule constraints as 
possible without compromising the validity of the model of your project. In this 
situation, constraints make it more difficult to find the critical path because they 
tend to break it.

The constraints that can cause positive slack in forward and backward scheduling 
are listed in the Constraints and Negative Slack section earlier in this chapter. 
Other types of constraints won’t fragment your critical path.

Again, you have to ask yourself: Is this real slack? In this case, the slack is real, 
because slippage on the predecessor Prepare Agenda doesn’t impact the end 
date unless it slips more than a day. You have to solve this again by raising the 
threshold for critical tasks.

Under certain circumstances, deadlines can also fragment the critical path, for 
example when there is a tight deadline halfway through the project and a time 
buffer at the end. In this case, you’ll only see a partial critical path that runs to 
the deadline date. While this may be a reason to not use many deadline dates 
in your project schedule, if you must set either a constraint or a deadline, we 
recommend using a deadline. Deadlines let you see the compounded effect on 
the project end date that hard constraints obscure.

Th TuMoSuSaFr

Install Server

Test Server 2ed

An elapsed duration is expressed 
in calendar days (as opposed to 
business days). A task with an 
elapsed duration can end during 
non-working time, whereas its 
non-elapsed successor cannot 

start during non-working time; it can only start on the next business day. This 
creates slack on the elapsed duration task. In the illustration, we are installing a 
server, which is scheduled to start on Monday, because it has a regular duration. 
Before we can install the server, we want to test the server for two days 
continuously to make sure it does not fail under the testing conditions. Since the 
test is automated, we can have it end on a non-working day, like a weekend, then 

Mo SaFrThWeTu

Meeting

Prepare Agenda
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start the next task on the next business day. The task Test Server can slip until 
8:00 AM Monday morning without affecting Install Server. This creates one day 
of slack on Test Server, which has a duration of two elapsed days (2ed).

Once more you have to ask yourself: Is this real slack? The slack is real here, 
because the Test Server task could continue for another day without impacting 
the project. Again, you can resolve this by raising the threshold for critical tasks.

SpringWinter

Construct

Design

Task calendars can fragment the 
critical path. If the task Design 
can be ready long before the 
weather is good enough to start 
construction, it will have slack, 
and therefore will not be seen as 

critical. The task Construct and its successors will be critical, as shown in the 
illustration. The slack is real, and Design could take all slack without impacting 
the start date of Construct. The only way to find a complete path of the critical 
tasks before Construct is by raising the threshold for criticality.

An external predecessor is a task from another project schedule that drives a task 
in your schedule (see the illustration). 
If a task has an external predecessor, 
this predecessor could very well drive 
the task farther out than the other 
internal predecessors inside your 
schedule. If it does, it creates slack on 
these predecessors. This slack is real 
slack, because it can be used to 
compensate for slippages in your 
schedule. Again, it can be addressed by 
raising the threshold for criticality.

Leveling
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This illustration shows two tasks with one successor task. Review SW and Review 
HW could be done in parallel. They are independent of each other and can be 
done in any order; there is no logical dependency between them. After they are 
completed, the successor task Propose Improvement can be done. You have one 
resource, Mario, assigned full time to both predecessor tasks. Mario is over-
loaded and you decide to level his workload.

In this instance, no other resource is available and you’ve determined that the 
only way to solve the over-allocation is by delaying one of the tasks. As you delay 
one task, you create slack on the other task that competes for the same resource. 
As a result, the slack makes critical tasks noncritical, and part of the critical path 
evaporates before your eyes.

One last time, you have to ask yourself: Is this slack real? In this case, the answer 
is “no.” The slack is not real slack, because any delay in either task does impact the 
next task, and because they are in the critical path, does impact the project end 
date. If Mario needs more time for Review SW, his other task, Review HW, will 
slip. How are you going to solve this?

If the task Review SW slips, it will drive the task Review HW farther out, because 
the same resource does both, and there is a resource dependency between the 
two tasks. Both tasks are resource-critical, even though the current critical 
path algorithm suggests that only the task Review HW is critical. The CPM 
algorithm only looks at dependencies when it calculates the early and late dates: 
it doesn’t take resource workloads into account. Remember that CPM assumes 
that resources are available in unlimited quantities. We will address the issue of 
limited resources later in this chapter. 

When we discussed dependencies we advised against using logical dependencies 
to show a resource dependency. Some people suggest that you should add 
dependencies to level out the 
workloads of the resources. Of 
course, you could model 
resource dependencies as 
logical dependencies that would 
be soft dependencies. This works well until you start changing the assignments. 
In the illustration, if you substitute Mario on one of the two tasks, your schedule 
could be shorter than it is, because of a soft dependency that has now become 
obsolete! Adding logic to level workloads in order to keep your critical path 
intact is a static solution for a dynamic problem. As a consequence, the solution 
will have a short life. That’s why we added question marks to the dependency in 
the illustration.

Should You 
Add Logical 
Dependencies?

Review SW

Review HW

Mario

Mario

???
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We recommend keeping your schedule dynamic. We’ll explain a different 
method for resolving the over-allocations and optimizing in this situation in the 
section below on Optimizing for Time, Cost, and Resources.

Many schedulers keep the resource workloads reasonable by creating extra 
logical dependencies. They know the schedule would not be feasible if they didn’t 
use these extra dependencies that really do not reflect a mandatory sequence of 
tasks. If you are in this category, we invite you to consider a new method instead: 
the Resource-Critical Path method.

1. Show or highlight the critical path and slacks
2. Identify which tasks have potential time savings
3. Make a change to those tasks
4. Consider impacts on quality, scope, and risk
5. Decide whether you want to keep the change
6. Repeat steps 3 – 6

Now that you’ve highlighted the critical path and total slack, and done your best 
to make it continuous from start to end, the next step is find those tasks where 
you can gain the most time. 

To do this, you need to analyze the logic of your whole schedule, critical path, 
and total slack. Here are some filters and views that may help you do this:

hh If your schedule is long, obtain a complete view of it: on the View tab, in the 
Zoom group, select Entire Project zoom. 

hh If you have a lot of tasks, you can also filter your schedule by critical path to 
obtain a more manageable view for your analysis.

hh Long critical tasks may offer a better opportunity for applying actions 
to save time, so you might want to apply a sort by duration to help focus 
your view on long critical tasks. If you’re applying rolling wave planning, 
some phases of your project life-cycle may be at the first levels with long 
durations; of course, you’ll be limited in optimizing these phases until you 
have more information .

For more information about how to apply filters and sorts, see Chapter 11.

The most important objectives are to understand the network of your schedule, 
determine if any parallel critical paths have appeared, decide if you need further 
breakdown or integration, and understand how your resources are participating. 
We’ll present different approaches to reducing your schedule’s time in the 
following section; each can be applied in different situations.

Identify Tasks with 
Potential Time 
Savings
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1. Show or highlight the critical path and slacks
2. Identify which tasks have potential time savings
3. Make a change to those tasks
4. Consider impacts on quality, scope, and risk
5. Decide whether you want to keep the change
6. Repeat steps 3 – 6

You want to optimize by analyzing the critical tasks and shortening them to 
shorten the project duration. 

At this point you will be changing the schedule (time). Any change has to be 
evaluated in terms of the impact on the other competing demands: quality, 
scope, and risk. (We could consider cost and resources, but in order to explain 
the actions to optimize time, for the moment we assume that unlimited resources 
are available to us. We will consider cost and resources later.) 

The best solutions are those that reduce time without affecting quality, scope, 
and risk. There are rarely, if ever, such ideal solutions and most solutions will 
require trade-offs.

The list below provides ideas on how to improve the schedule with the most 
effective ideas first. The first two actions involve fast-tracking or overlapping 
activities. Fast-tracking follows the principle of working smarter instead of 
harder. If you choose to add resources instead, you will be working harder. 
Adding resources is called crashing. 

We recommend you start by exploring whether the first two fast-tracking 
actions can be applied to your critical tasks. After exhausting the fast-tracking 
possibilities on critical tasks, go to the next action in the list. This is the quickest 
way to find the most time in your project schedule.

All actions are for tasks in the critical path. When you apply a change, you need 
to verify whether the critical path has changed as a result. It’s also possible that 
you’ll create parallel critical paths, so you’ll need to apply actions in those parallel 
paths to get total schedule compression. 

Schedule 
Compression

Shortening the 
Critical Path
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Action
1. Change sequential dependencies into partial dependencies (fast-tracking)

2. Create parallel paths from a sequential path (fast-tracking)

3. Split long tasks into shorter ones

4. Change schedule constraints

5. Shorten lags (waiting periods)

6. Split task bars around Must Start On tasks

7. Decrease duration estimates

8. Add resources (crashing)

9. Reduce the scope or delete tasks

Before making any change, check the current total duration of the project so 
you can see how the changes you make affect it. In the Gantt Chart view, on the 
Format tab, in the Show/Hide group, select Project Summary Task.

There are four types of dependencies that can be combined with a positive lag 
time (waiting time/gap) or 
negative lag time (overlap/lead). 
The illustration on the right shows 
a Finish-to-Start dependency that 
is changed into an overlap of three 
weeks (lead or negative lag of 
–3w): FS – 3w. The overlap can be 
entered as an absolute lag in a 
number of days or weeks, like -3w. 
It can also be entered as a 
percentage of the duration of the predecessor (relative lag), like -40%. Since the 
start of the successor is dependent upon the partial completion of the 
predecessor, one could also speak of a partial dependency.

1. In the timescale of the Gantt Chart view, point the tip of the mouse pointer 
on the arrow of the dependency. Wait until the screen tip appears. Check to 
see if you are pointing to the dependency between the right tasks, because 
the dependency arrows can overlap one another.

2. Double-click if you have the correct one; the Task Dependency dialog box 
appears:

Checklist for Finding 
Potential Time 
Savings:

Change from 
Sequential to Partial 
Dependencies 
(Fast-Tracking)

FS
Sequential
Dependency

Partial 
Dependency

FS    3W
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You can keep the Finish-to-Start and make the lag negative (lead).

OR

You can select from the list Type: the Start-to-Start or Finish-to-Finish 
to overlap tasks.

3. Type in the Lag with absolute time units, like -2d, or in a percentage of the 
duration of the predecessor, like -30%. In a Finish-to-Start dependency, you 
will overlap the predecessor for the lag you specify. For Start-to-Start or 
Finish-to-Finish dependencies, enter zero or a positive lag to create partial 
dependencies.

4. Click OK; you should now see the overlap you want between the two task 
bars in the timescale.

If you can’t select the right dependency with the mouse, you can use the Task 
Details Form to create the overlap. Click on the successor task in the Gantt 
table. On the Task tab, in the Properties group, click on Details, Display Task 
Details to display the Task Details Form, and you can make the lag negative in 
the Lag field of the predecessor.

You can cut soft dependencies. Hard, mandatory dependencies should not be 
cut; it’s just not realistic. 

Cutting soft dependencies 
on critical tasks can result in 
large time gains, as shown in 
the illustration. However, you 
need to look at all the potential 
impacts. In the top scenario in 
the illustration, there is no risk 
of damaging the new carpet, 
because it is laid after the cabinets have been installed (sequential dependency). 
In the bottom scenario, the carpet layers will have to protect the new carpet, 
because the two tasks are scheduled concurrently (parallel path). Of course 

Creating Parallel 
Paths

FS
Sequential
Dependency
(soft)

Parallel
Path

Install 
Cabinetry

Lay 
Carpet

Install 
Cabinetry

Lay 
Carpet
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the risk of damage will be higher and more effort may be required. Resource 
dependencies must be considered as well.

We recommend you set a new dependency to the soft successor first before 
cutting the dependency, because otherwise the successor task bar might 
disappear off the screen to the start date of the project.

1. In the Gantt Chart view, point the tip of the mouse pointer to the arrow of 
the dependency and double-click on it; the Task Dependency dialog box 
appears:

2. Verify whether the correct dependency is shown and click Delete.

3. Click OK; the dependency is now removed.

When you apply fast-tracking consider these factors:

hh You do not want scope and quality to change: consider techniques to meet 
all initial requirements and standards because there aren’t any change in 
deliverables and task durations.

hh Total duration of your project will be reduced.
hh Fast-tracking may change the critical path. The reduction in critical path 

duration may be greater than total slack or some other parallel path, so you 
need to review your whole schedule every time you apply this technique.

hh When you create overlaps or parallel paths, you change your resource 
requirements; you need to review their real availability before you accept 
the change.

hh If the total duration of the project is reduced, overhead costs may also be 
reduced (facilities, supervision tasks, etc.).

hh The cost may be increased if you require new resources (for parallel tasks) 
with higher rates, or if you need to increase supervision or facilities.

hh Fast-tracking definitely increases risk on your project. For instance, if you 
have quality issues in some activity with fast-tracking considerations, and 
need to rework it, you must also rework the parallel or overlap activity. You 
must analyze the trade-off between time and risk (less time means more 
risk) before you accept the change.
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Breaking a long task into smaller tasks gives you more possibilities to optimize, 
as depicted in the illustration. The benefit is immediate if you can assign portions 

of the task to other non-critical, and 
perhaps even less expensive 
resources. The easiest way to break 
up a long task is by changing it to a 
summary task and adding detail 
tasks below it. You’ll have to take 
the assignments and dependencies 
off the summary task. One 
advantage of this approach is that 

only the lowest level of detail of your schedule will change, which isn’t very 
visible in reports. The possible disadvantage is that you are increasing the 
number of tasks and you will need more effort to keep your schedule updated 
during monitoring and controlling.

For a refresher on task management and linking, see Chapters 4 and 5.

Look for creative ways to remove constraints from your schedule. For example, 
if your project needs approvals 
from an executive board that meets 
only monthly, lobby hard for a 
faster, alternative route for 
approvals. This could take some 
“anchors” out of your schedule.

1. Select the task with the 
constraint.

2. On the Task tab, in the Properties group, click Task Information, and the 
dialog box appears.

3. Click on the Advanced tab.

Break Long Tasks 
into Shorter Ones

Harry

Harry

Harry

Harry

Ted

Change Schedule 
Constraints

Board Meeting
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4. Under Constrain task, change the Constraint type to As Soon As 
Possible.

OR

Change the Constraint date to an earlier date.

5. Click OK.

If you find any lag between critical tasks, you might be able to reduce it now that 
you are armed with the argument that the lag is on the critical path. In the 

illustration example, you have 
to wait for the board’s decision, 
and you typically have to wait 
three weeks before the board 
convenes. You might be able to 
lobby for an executive decision 
instead of a full board decision, 
which would save a few weeks 
and be a significant gain.

If the wait is for receiving supplies from a vendor, you can often work miracles by 
offering your supplier extra money for faster delivery.

To decrease lag:

1. In the Gantt Chart view, point the tip of the mouse pointer to the arrow of 
the dependency. Double-click on the arrow. The Task Dependency dialog 
box appears:

Shorten Lags

FS + 3wOrder Printer

Receive and Setup Printer
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2. Verify whether the right dependency is shown and decrease the amount of 
Lag, then click OK.

If a team member has a meeting or training to attend, she has to drop her regular 
work on the agreed upon, fixed date for the meeting or training. You can model 
this by using schedule 
constraints like Must Start On. 
In the illustration on the right, 
your ongoing task cannot be 
completed before the meeting, 
and could be scheduled entirely 
after the meeting, but splitting it 
around the meeting gives the 
tightest schedule.

To split a task bar:

1. Click on a task, choose the Task tab, and in the Schedule group, click Split 
Task on the Standard toolbar. A pop-up window appears, and the mouse 
pointer changes.

2. Point to a task bar, and click to split it, then drag it to where you want the 
split to occur. A part of the task bar is split off and in the pop-up, you are 
shown what the new start and finish dates of the part will be when you 
release the mouse:

3. You can drag the split bar to any date you want and release the mouse 
button; the task bar will be split into two parts connected by dots: 

Split Task Bars 
around Must Start 
On Tasks 

Meeting

Meeting

Before Optimization

After Optimization

Ongoing Work

Ongoing Work
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Even though this feature appears to work well at first glance, we do not 
recommend using it during the planning phase of the project. The predecessors 
may reschedule the ongoing task, and its split should be moved accordingly to 
keep it scheduled around the short task with a fixed date. The problem is that 
the split does not move automatically. You may have to adjust your schedule 
manually every time a change occurs. Another problem is that you can only link 
the start or finish of the whole activity, not the middle parts. That’s why we don’t 
recommend using this feature.

There are better approaches:

hh You can break down the task into multiple subtasks. For example, electricians 
wire a building, but after the inspection they have to come back to install 
the switch plates. You could show this as one task with a split task bar, but 
it would be better to break it down into two tasks: pull cables and install 
switch plates. Now you can set dependencies between these tasks and keep 
your model entirely dynamic. If you have a choice between task breakdown 
and bar splitting, we recommend you break down the task rather than split 
its bar.

hh Create a task calendar for those tasks that might be affected. In the task 
calendar, you indicate nonworking time for the duration of the Must Start 
On task. As long as the Must Start On date does not change, the calendar 
will do a fine job. 

hh Alternatively, you could allow the over-allocation of the resource to occur 
and then level the workloads. On the Resource tab, in the Level group, 
click Leveling Options and select Leveling can create splits in remaining 
work. In this case, the leveling will create a split, and when you level again, 
it will move the split as needed.

hh Lastly, you could ignore the over-allocation, assuming that the resources 
will manage both tasks or maybe work overtime.

Often when you get closer to the tasks at hand you can provide more precise 
duration estimates. Sometimes you’ll find that a task duration has been 

overestimated. And sometimes 
you can find a better and quicker 
way to accomplish the task. In 
both cases, you can cut some of 
the duration. In many cases, 
however, decreasing the 
estimate is at the expense of 
quality or scope, and you should 
examine the trade-offs closely.

Decrease Duration 
Estimates
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Often, managers ask for more resources when they start to feel the heat of their 
deadlines. In the illustrated example, the project manager asked for and got Ed 

to help out with Harry’s work. 
Adding resources may cost you 
more money, and may not 
reduce the duration. We have 
often observed that when new 
resources arrive, the best 
resources are taken off their jobs 

to train the new ones. This causes an initial increase in the slippage instead of a 
decrease.

How many people can you add to tasks? When optimizing for time only, you 
could in theory add an unlimited number, but in practice, there are limits. If 
you add too many people, they will get in each other’s way and keep each other 
from being productive. The law of diminishing returns is applicable when adding 
resources. How many carpenters can work in one 10-by-15-foot room? Does 
adding more people to a meeting shorten the meeting duration? The degree to 
which additional resources will reduce duration depends on the nature of the 
work. If a task can be discretely divided into multiple subtasks that can be nicely 
divided among workers, then duration reduction is possible (but do consider 
supervision and training time). 

There are also simple practical limits. Even though we have assumed we have 
access to unlimited resources, it doesn’t seem reasonable to add more than the 
maximum units available in the resource sheet.

Crashing is defined by the PMBOK as “a schedule compression technique in 
which cost and schedule tradeoffs are analyzed to determine how to obtain 
the greatest amount of compression for the least incremental cost.”4 So, once 
you have decided which tasks you want to crash, you need to analyze the extra 
resources needed for each task along with their cost implications to select the 
order or priority for crashing. Of course, you need to also analyze the risk 
implications.

Make sure you change the task type to Fixed Work before adding resources. This 
will ensure that the duration decreases when you add them.

4 ——— PMBOK® Guide − Fifth Edition, PMI, 2013, p. 181.

Add Resources 
(Crashing)

Harry, Ed

Harry
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Reducing scope is a matter of deleting deliverables. If you delete deliverables 
that are on the critical path, you will reduce the duration of the project. Just 
because a deliverable is on the 
critical path doesn’t necessarily 
mean it is an important deliverable. 
The word critical in project 
management simply means that it is 
driving the project end date. If there 
were deliverables in critical tasks 
qualified as nice-to-have, these 
would be good candidates to delete. 
For example, in a course manual the 
deliverables index and glossary may 
be left out of an early version to save 
time. Of course, not delivering on what you promised may be dangerous from a 
contractual point of view; you must manage any change in deliverable with your 
client and sponsor.

Alternatively, you could focus on the level below deliverables and find critical 
tasks to delete, as shown in the illustration. Sometimes you can find nice-if-we-
get-around-to-it activities to cut. This may happen at the expense of the quality 
of the deliverables. If the quality requirement is a nice-to-have, you could cut 
the task. Deleting a task is as easy as clicking its row heading (ID number) and 
pressing the Delete key. Note that testing and quality control tasks are easy to 
delete, but we strongly recommend that you restrain (or retrain) yourself from 
doing so.

If you delete a task, you will lose all dependencies (predecessors and successors). 
First redefine the new dependencies that explain the logic of our network, then 
delete the task.

Instead of deleting a task, you may decide to use the Inactivate Task feature to 
make the task Inactive, and preserve the original task information.

1. Show or highlight the critical path and slacks
2. Identify which tasks have potential time savings
3. Make a change to those tasks
4. Consider impacts on quality, scope, and risk
5. Decide whether you want to keep the change
6. Repeat steps 3 – 6 

Next you have to evaluate the impact on quality, scope, and risk of the change 
in time you’ve made. You also need to consider cost and resources implications. 

Reduce Scope or 
Delete Tasks

Consider Impacts 
on Quality, Scope, 
and Risk
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From the new project duration, you can see how much time you have gained, 
and whether it is worth the sacrifices you made on the scope of the project, the 
quality of the deliverables, and/or the addition of risk. Realize that if you have 
used constraint dates or odd resource calendars in the back end of your schedule, 
the project end date may be held captive. Only if you have an entirely dynamic 
model will you see that changes immediately pull the project end date back.

If you find that the change did not yield the expected result, simply click undo 
the correct number of times to get rid of it.

Then repeat steps 3 to 6 in the optimizing process until you have solved the 
scheduling conflict.

You can check the impact of your optimization changes in the Project Statistics 
dialog box. To view it:

1. On the Project tab, in Properties group, click on Project Information. In 
the Project Information dialog box, click on Statistics at the bottom to 
open the Project Statistics dialog window:

 

2. In the intersection of the Current row and the Duration column, you can 
see the new duration of the project.

Modifying the Quick Access Toolbar, you can add the Project Statistics icon 
to your commands. This way you can view it from wherever you are in your 
project without having to jump to the top of the project. 

Earlier we introduced schedule simulation as one of the techniques used in 
optimizing the schedule. One thing is certain: unforeseen events will happen 
and you will need a time buffer to compensate for those events. This is a generally 
accepted project management best practice. 

Once you have optimized the critical path, you should ask yourself: How much 
buffer should I reserve in my schedule in order to protect the project deadline? 
A time buffer is also known as a time contingency or time reserve. The harder 

Project Statistics 
Dialog Box

Monte Carlo 
Simulation
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your project deadline is, the more carefully you need to assess your buffer needs. 
Simulation can help you determine your buffer needs. Note that while the PERT 
method also addresses uncertainty, it is not as effective as simulation.

Project 2013 does not have simulation capabilities, but there are good add-ons 
available with which you can simulate Project 2013 schedules.

Monte Carlo simulation is the best known simulation technique. For tasks that 
are hard to predict, you specify the lower and upper limits of an estimate and 
choose a probability curve between those limits.

The simulating software generates estimates for all the tasks using these 
parameters. It uses number generators that produce estimates that comply with 

the range and the distribution 
curve you have chosen for the 
estimate. It creates the first 
version of the entire schedule 
and calculates the critical path. 
In the illustration on the left, the 
original schedule is shown as 
well as the 1st, the 2nd, and 1000th 
version created by the 
simulation software. 

Simulation will create as many 
versions as you want, but after 

a certain number of versions, every next one has less and less added value (the 
concept of diminishing returns). Simulations often create up to a thousand 
versions of the schedule. In each version, the critical path of the schedule is 
calculated. The simulation software will then calculate average project duration 
and probabilities for a range of finish dates.

Simulation software creates an s-curve from the many versions of the schedule. 
An s-curve shows projected finish dates charted against the probability of 
meeting those dates. The 
illustration shows such an 
s-curve. The benefit of the 
s-curve is that you can see the 
chance of completing your 
project by the date that Project 
2013 indicates as the project 
finish date in your schedule (see 
current finish date in the 
illustration and its current 
probability).

What Is Monte 
Carlo Simulation?

1st

2nd

1000th

Original

B: 10d
A: 10d

A: 9d

A: 11d

B: 12d

B: 12d

B: 11d

22d

21d

22d

Avg 21.8d

A: 10d

Output of Monte 
Carlo Simulation

Desired
Probability

Probability
100%

Corresponding
Finish Date

0% Dates

Current
Probability

Current
Finish Date

Time Buffer Needed
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Alternatively, you can choose the level of probability you feel comfortable with, 
and derive the project finish date, or you can let executives choose it for you (see 
desired probability in the illustration). With the desired probability, you can find 
the corresponding finish date. You can quote this date to the client with a known 
degree of confidence that it can be met. There may still be other risks that you do 
not know about (unknown risks), but at least you have quantified known risks.

You can also calculate the size of the time buffer you need in your project. If 
you read from the s-curve that you need to add three weeks as a buffer to your 
current Project 2013 schedule to have 90% probability, you should insert this 
as a buffer “task” just before the project finish milestone and have it push out 
the milestone. Alternatively, you could include the buffer in your schedule as 
increased durations if you need to, but this is not the preferred way.

Monte Carlo Simulation is often crucial, particularly in large complex projects, 
for two reasons:

hh Forecasts from one-point estimates tend to be too optimistic
Experience has shown that schedules made with single estimates per task 
are optimistic in nature. The PERT technique, which uses multipoint 
estimates, addresses this problem, but doesn’t address the next problem, 
that of converging paths.

hh Converging paths compound the time risk
Converging paths decrease the probability of meeting a milestone date. The 
chance that the milestone will be accomplished on time decreases with every 
path that is added leading 
into the milestone. In the 
illustration, each path has 
an admirable chance for on 
time delivery of 90%, but 
the chance of delivering the 
milestone on time is exactly 
81%. If one path is early, 
the other may be late and 
vice versa. When two paths 
both have to be finished for 
a milestone, you have to multiply their chances: 90% * 90% = 81%.

The more parallel paths you have in your schedule, the greater the schedule 
risk. In addition, the more equal the durations of the paths are, the greater the 
schedule risk. 

This phenomenon is known as path convergence or merge bias. The aggregated 
effect of many merging paths of different lengths is very difficult to predict. While 

Why Do You Need 
Simulation?

1 432
Weeks

Write

Chart

Edit

Revise

90% on time

90% on time

???
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there may be rules of thumb and algorithms based on past experience to assess 
the need for contingency, simulation is the only way to statistically find out. The 
more parallel paths you see in your schedule, the more you will need to simulate 
the schedule. This need is even greater if those paths have similar durations.

The paths make it unlikely that your end date, as shown by your Project 2013 
schedule, will be met. That is why project managers developed the habit of 
padding their schedules. Padding, as we define it, is inflating tasks to take risk 
and uncertainty into account. For example, a task that is most likely to get done 
in a week is estimated at two weeks because under adverse conditions, that’s how 
long it might take. Alternatively, contingency reserves or buffers are allowances 
for slippage which are explicitly set aside. Tasks are estimated realistically and 
therefore the project can be controlled more tightly, while the targeted finish 
date or key milestone dates have realistically high probabilities of being met. 

Simulation will help you to find the compounded effect of the parallel paths. 
You can use simulation to quantify how much of a contingency reserve or buffer 
you will need in your schedule. As you see, we recommend using simulation 
in combination with the Critical Path Method as an alternative to padding 
estimates for risk.

In summary, critical path theory is based on three assumptions:
hh Assumption 1: Task estimates are considered as one-point and deterministic 

data.
hh Assumption 2: There is no merge bias or path convergence.
hh Assumption 3: You have unlimited resources available.

We saw that Assumption 1 does not hold true, but we can determine the 
magnitude of its effect by applying PERT or simulation.

As for Assumption 2, merge bias (the effect of path convergence) does exist. 
This effect often causes the largest slippages in projects. Simulation is the only 
technique that can make the compounded effect of converging paths visible. 
Applying the CPM is useful, as long as you simulate as well. Many overruns can 
actually be foreseen and quantified when simulation is applied to schedules.

Assumption 3 is more difficult to deal with. Both the CPM and the PERT 
techniques assume that resources are available in unlimited quantities. If this 
is the case, the assumption can stand and the CPM is the technique to use. 
However, it is rare to have access to unlimited resources. 

If you are managing the workload of your own scarce internal resources, CPM 
and the PERT techniques must be augmented by resource leveling. 

Extra resources can be bought with money. We will therefore first introduce cost 
into the optimization (optimizing for time and cost), and then we will add the 
limited availability of resources (optimizing for time, cost and resources).

Assumptions of 
the Critical Path 
Method
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When you optimize for time and cost, you should also consider scope, quality, 
and risk. We will discuss the 
cost dimension before the 
resource dimension, because 
most resource decisions impact 
the cost side of our model. So 
the logical progression in our 
view is optimizing for time, then 
time and cost, then time, cost, 
and resources.

1. Show or highlight the critical path and slacks
2. Identify which tasks have potential time savings
3. Make a change to those tasks
4. Consider impacts on quality, scope, and risk
5. Decide whether you want to keep the change
6. Repeat steps 3 – 6

Any project manager who has a budget in money or in person hours should apply 
this type of optimization. The steps for optimizing for time and cost are very 
similar to the steps for optimizing for time. The differences are highlighted in 
bold in the illustration. Because you should not lose sight of the time dimension 
of the project, you still have to find the critical path. If you want to bring the 
duration of the project down, you should also apply the optimizing for time 
methods discussed in the previous section. Keeping the duration of a project 
as short as possible will also keep the cost of overhead expenses down. To keep 
the discussion on the process for time and cost optimizing simple, we will focus 
mainly on cost in the text that follows.

If you find that the restricted availability of resources is driving your finish 
date out, you will need to optimize for time, cost, and resources, which is the 
third approach for optimizing. In that case, you should read this section as well, 
because in the next approach we will not discuss any methods to reduce cost.

Sort the tasks on cost to find the most expensive tasks. Develop ideas for how 
you might bring down the cost with no or minimal compromise on time, scope, 
quality or risk. Enter the change and check the results to see whether you want 
to keep the change. We will discuss how to accomplish some of these steps in 
Project 2013.

You can show or highlight the critical path following the steps from the 
Optimizing for Time section above. Identifying the critical tasks and the slacks 
for normal tasks will allow you to consider the time impact when you apply 
some of the cost optimizing recommendations we present in the following steps.

Optimizing for 
Time & Cost

Quality

Resources

Cost

Risk Scope

TimeProject

Steps to Optimize 
for Time and Cost

Display the Critical 
Path
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To find the tasks which offer significant savings, you should analyze the whole 
project on all WBS levels. As with time, higher cost tasks may offer greater 
opportunity for savings, so you may want to sort the tasks on cost. You can use 
the table Cost in any task view, and then apply the sort (see Chapter 11 to review 
sorting).

Use sorting for a temporary view, document your results, and sort back by ID 
number.

The best measurements are those that improve cost and don’t impact the other 
competing demands of quality, scope, risk, resources, and time. Good luck 
finding these! However, here are ideas about what you can do. 

Checklist for Finding Cost Saving Opportunities:

The actions are listed in order of overall perceived effectiveness; start at the top 
of the table and work your way down.

Action For
1 Find lower cost contracts External contractors, consultants

2 Reassign to lower cost resources Expensive resources

3 Break down a long task and reassign 
portions to lower cost resources

Long (critical) tasks

4 Shorten the project duration to decrease 
overhead cost

Critical tasks

5 Prevent paid overtime work Resources with a higher overtime 
rate

6 Smooth the workloads Resources with erratic workloads

7 Decrease the cost estimate Any tasks with costs involved

8 Reduce the scope or delete tasks Any tasks with costs involved

If you need to bring down the duration of your project as well, use the optimizing 
for time methods. Make sure you select those methods that do not increase 
the cost again. If you shorten the project duration, the overhead costs will also 
decrease (see method 4). You will save on expenses for project management, 
facilities, support staff, and other overhead costs. Usually there is a stronger 
constraint, cost, or time. Start with the stronger one and then work with the 
other. Of course, review trade-offs between competing demands.

If you are to manage the cash flow of your project as well as the overall cost, 
another measurement might be to renegotiate when the costs accrue and change 
the resource field Accrue at accordingly. Delaying the accrual of expenses will 
improve your cash flow.

Identify Tasks with 
Potential Cost 
Savings

Make Changes
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If you don’t solicit multiple bids or proposals, doing so may create significant 
savings. Suppliers of materials, contractors, and consultants are quick to 
determine whether or not they are in a competitive situation and will often 
quote accordingly. Another option is to research whether there are specialized 
firms that are quicker or better at their trade than other suppliers. If a specialized 
firm is using better technology, techniques, equipment, or resources, it may be 
less expensive, even though the hourly rate may be higher. Remember to analyze 
risk aspects or any contract considerations: you may appear to have reduced 
cost, but if you’ve increased risk, your cost savings may not be realized.

Use the Resource Usage view to find less expensive resources within your resource 
pool that you can substitute for expensive resources. Insert the columns with the 
total costs (Cost) and rates (Standard Rate) and find which assignments you 
can move to less expensive resources. You can reassign by simply dragging the 
assignment to another resource in the Team Planner view (Resource tab, View 
group) or using the Replace function on the Assign Resources icon (Resource 
tab, Assignments group). To analyze the possible impact on the total duration 
of the project, you also may need to level the resources.

Keep in mind that using a less expensive resource sometimes mean using a less 
effective resource (e.g., a junior resource with less experience). For other kinds 
of resources (machines, materials, software products), less expensive may mean 
lower quality, which may result in more effort and higher risk. Be careful not to 
be overly simplistic and optimistic in your thinking. And always consider risk 
impacts.

If you decide to break up a long task, perhaps the best way is to insert subtasks 
below it, thereby promoting it to a summary task. Then you assign less expensive 
resources to those subtasks to which they are suited and remove or reduce the 
use of the expensive resource. Don’t forget to set appropriate dependencies, so 
as not to leave any loose ends in the network logic. If you can hook up some 
portions to much earlier tasks, you could save time as well. Also remember to 
factor in time and effort for supervision, communication, and coordination. 

If you decrease the project duration, the overhead costs will decrease; you’ll have 
less expense for the project manager, team leaders, facilities, equipment, etc. 

Preventing overtime work will only bring down the cost if you are actually paying 
a higher rate for overtime. For the how-to steps for decreasing overtime, refer to 
Chapter 7. Of course, if you reduce overtime, you may be extending your project 
duration, which is a simple trade-off against the time dimension. You should 
only do that if saving cost is more important than finishing as early as possible.

Find Lower Cost 
Contracts

Reassign to Lower 
Cost Resources

Reassign Portions 
of a Long Task

Shorten the Project 
Duration

Prevent Overtime 
Work
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Workloads can be smoothed to reduce irregularities over time. In the illustration, 
the total workload before and after smoothing is the same 100 person days, 

which would cost the same. 
However, if you’re carrying the 
cost of the resource with the 
erratic workload during the 
times when the resource isn’t 
working on your project, the 
actual cost is higher. The project 
budget doesn’t show this cost, 
because it only shows the cost of 

the planned assignments. The extra cost of an erratic workload is a hidden cost 
in the plan; if you smooth the workload, you will decrease it. This hidden cost is 
difficult to quantify during the planning phase, but in general, you can say that 
the more erratic the workload, the higher the hidden cost in the project plan.

In addition, during the valleys, the resource with an erratic workload may lose 
momentum and have to re-ramp up. This cost is also hard to see unless the 
estimate for the tasks includes ramp up time.

An intriguing paradox is that the scarcer a resource is, the more the resource 
should be shared between projects from the organization’s point of view, but 
the less likely that project managers actually will share this scarce resource, 
particularly if they don’t have cost responsibility.

Often when you get closer to the tasks at hand you can provide more precise cost 
estimates. Sometimes you’ll find that a task has been overestimated in duration, 
in resources or in costs. And sometimes you can find a better way to accomplish 
the task. In both cases, you can cut some of the associated costs. In many cases, 
however, decreasing the estimate is at the expense of increasing the risk for not 
meeting quality or scope objectives, and you should examine the trade-offs 
closely.

As with time optimization, reducing scope means eliminating or changing 
deliverables and activity estimates. Remember that scope changes should be 
approved in advance. 

When optimizing for time and cost, keep in mind the potential for impact on 
scope, quality, and risk (resources will be addressed in the next section). The 
competing demands are interrelated and the relationship between them must 
remain realistic and rational. 

We discussed the advantages of applying simulation techniques to your critical 
path. You can also do cost simulations to analyze the impact of variables such as 
rates or fixed costs. 

Smooth Workloads

100%
Ed’s workload Histogram

Workload
Smoothing

100%

Decrease Cost 
Estimates

Reducing the Scope 
or Deleting Tasks

Cost Simulation
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The output variable of the simulation could be the total cost of the project (Cost 
field) or the total cost at any level of the WBS. The s-curve output from the 
simulation will indicate the costs of the project against their probability, and will 
also allow you to establish the cost reserve for your project.

Desired
Probability

Probability
100%

Corresponding
Cost

0% Cost

Current
Probability

Current
Cost

Cost Buffer Needed

This concludes the second approach of optimizing for time and cost. We will 
now add the next dimension: resources.

Quality

Resources

Cost

Risk Scope

TimeProject

The next blue arrow we’ll add to 
the illustration is resources. We 
add it to the dimensions we 
already monitor: quality, scope, 
risk, time, and cost. Inclusion of 
resources means that you will 
monitor the workload of your 
resources relative to their 
availability. If you find that the 

limited availability (or unavailability) of resources affects the forecast dates, you 
are in a resource-constrained or resource-limited situation. In this case, you need 
to include resources in your optimization, otherwise your schedule will be too 
optimistic.

The resource dimension may involve trade-offs with:
hh Cost, when you have to pay for extra resources or pay more for overtime
hh Time, when you cannot solve over-allocations in any other way than by 

delaying tasks

In this section, to keep the discussion simple, we will only discuss how to trade 
off between time and resources. If you also need to bring down the cost of your 
project, you should consider the methods discussed above to optimize for time 
and cost.

Optimizing for 
Time, Cost, and 
Resources
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The optimization with resources becomes more complex, but if you handle 
this complexity, you can have confidence that the project is feasible as far as 
resources are concerned. This will increase the validity of your forecasts. A 
dynamic schedule should be able to change, or at least flag the need for change, 
as resources and their assignments change or as task durations change and affect 
resource dependent tasks.

1. Check the workloads and level them
2. Show the resource-critical path (RCP)
3. Find the critical resources
4. Make a change to those tasks
5. Consider impacts on quality, scope, and risk
6. Decide whether you want to keep the change
7. Repeat steps 3 – 7

As the steps in the process chart show, the first thing you have to do is resource 
workload leveling (also called workload leveling or resource leveling). You have 
to check whether:
hh The workloads are within the availability of the human resources
hh The demand for facilities is within the availability of the facilities
hh The work is within the capacity of the equipment

When resources are scarce, you will often find that the schedule extends when 
you level the workloads. This fragments the critical path, and you will need to find 
the resource-critical path (RCP). Once you have found the RCP, optimization is 
very similar to the methods used with the Critical Path Method.

The first step in optimizing for time, cost, and resources is checking the 
workloads. If there are over-allocations, the workloads need to be leveled, that 
is, they have to be adjusted to eliminate overloads or accepted by authorizing 
overtime. 

Ideally, you will have prevented over-allocations in the first place, since they are 
always painful to solve, particularly when you share resources with other project 
managers. You should consider using a master schedule to level resources 
that are shared among several projects. Within a single project, each project 
manager has the responsibility to make sure that the workloads are reasonable. 
Of the thousands of schedules we have evaluated, we’ve found that this is often 
neglected: about 50% of the schedules we’ve evaluated had over-allocations.

We’ll discuss how to level workloads in two different ways: by making manual 
changes to the schedule, or by letting Project 2013 automatically solve all over-
allocations for you. 

Steps to Optimize 
for Time, Cost, 
and Resources

Workload Leveling
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On the View tab, in Resource Views group, click on Other Views down-arrow, 
Resource Graph. 

1. Hold down the Contol key and press the Home key to make the timescale 
jump to the start of the project.

2. While still on the View tab, in the Zoom group, click on the Zoom down-
arrow, then Zoom Out and Zoom In to adjust the timescale.

3. Press the Page Down key to go to the next resource OR press the Page Up 
key to go to a previous resource.

The Resource Graph is also known as the resource histogram.5

By default the Resource Graph shows the Peak Units. Peak Units allow you to find 
over-allocations very easily by zooming out; if you see a red bar you have found 
an over-allocation. On the other hand, Peak Units presents an inflated picture 
of the real work when zoomed out, because it shows the highest bar during the 
time period summarized. In the Resource Graph view, on the Format tab, in 
the Data group, click on the Graph down-arrow to select a more realistic view 
of the workloads.

5 ——— PMBOK® Guide − Fifth Edition, PMI, 2013 , p.265-266.

Checking the 
Workloads: 
Resource Graph
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There are many ways to resolve the workloads by hand without using the 
Automatic Leveling or Level All features of Project 2013. The methods are listed 
in order of perceived effectiveness, with the first being the most effective in our 
view.

1. Reassign the best resources to critical tasks first and only to critical tasks. 
Take non-critical tasks away from the best resources to reduce their workloads. 
Matching people to tasks so that the best person does the task also results in 
time gained, and is one of the rare methods for improving time and workloads 
at the same time.

2. Reassign tasks from critical resources to noncritical resources. Critical 
resources are resources that force critical tasks to be delayed in order to keep 
their workloads sane. Critical resources extend the project duration and if you 
take some of their tasks away, you level their workloads and perhaps shorten the 
project duration

3. Take the critical resource off a task. Sometimes you can do this when more 
than one person is working on the task, or as soon as you know who can handle 
the task other than the critical resource. Remember that the word “critical” 
doesn’t mean the resource is an important resource; it just means the resource 
is driving the task and project duration. That sometimes makes it possible to 
simply remove the critical resource from the task to bring the workload down.

4. Hire extra resources. If you hire extra resources, you can reassign the tasks 
from your critical resources to the new resources. This works well if the new 
resources have skills similar to or better than your existing resources.

5. Contract work out to subcontractors. One definition of a subcontractor is 
someone who solves your workload problems in exchange for money.

6. Negotiate more resources from subcontractors. If you can get more resources 
from subcontractors, the workload of existing resources can be reduced.

7. Fine-tune the number of units assigned to the tasks involved in the over-
allocation. For example, you could keep two tasks scheduled in parallel if you 
decrease the involvement of the resource to 50%, but make sure you keep the 
resource working with 100% focus on a critical task.

8. Break down long tasks into many shorter ones and reassign the short 
tasks to noncritical resources. Breaking down tasks increases the number of 
scheduling possibilities dramatically.

9. Delay vacations until after the deadline. This is where you start to trade-off 
against resources and require a lot of goodwill from your resources. Be careful 
to not put unreasonable demands on your resources because they will either 
burn out or leave.

10. Work during the weekend. If an over-allocation occurs on a Friday, you can 
easily solve such a situation by asking the resource to work some hours over the 
weekend. Again you are trading off against the resource dimension.

Manually Resolve 
the Workloads
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11. Assign overtime. Even though this does not solve the over-allocation, it 
shows that it has been dealt with. Again you are trading off against the resource 
dimension.

12. Change dependencies. Decrease overlaps between tasks that are done by 
the same resource. Or, in the special case in which you have a team of people 
going from one city to another to install a system, consider setting additional 
soft dependencies to prevent the team from being in two spots at the same 
time. This solidifies the order in which locations are rolled out and keeps the 
workloads reasonable.

13. Review quality standards and work estimates, which may decrease 
the workload. You can often cut corners in the category of nice-to-have 
requirements without jeopardizing the project product.

14. Split task bars when multiple resources are assigned to move the workloads 
of the individual resources to where the workloads fit into their availability.

15. Delay tasks. Slip one of the tasks that compete for the same resource. If you 
decide to delay one task, choose the task that has the most slack and the least 
number of resources assigned. If you delay a task with other resources assigned, 
you may cause many new over-allocations. The less other resources are assigned, 
the less checking on workloads you need to do. Through the dependencies, 
successors may cause new over-allocations; you can never really tell what will 
happen when you start delaying tasks. You have to do it week by week.

Project 2013 can’t replace you as a manager in making these decisions:
hh Adjust the units on assignments—how can software determine what a 

reasonable level of involvement is for all assigned resources?
hh Adjust an effort estimate based on the overhead required for multiple 

resources and for different levels of resource expertise or quality
hh Find qualified, external resources
hh Ask resources what non-working time they are willing to sacrifice for the 

betterment of the project
hh Determine which quality standards can be lowered without jeopardizing 

commitments or contracts
hh Determine who the best resource is
hh Determine who the most critical resource is
hh Reassign tasks to less critical resources. (Project 2013 can’t do this by itself; 

only with access to the enterprise resource pool from Project Server can it 
now find substitutes if all of the skills of the resources and skill requirements 
on the assignments are coded.)

What Project 2013 can do for you is:
hh Split task bars where multiple resources are assigned (method 14), or
hh Delay task bars (method 15).

J. Ross Publishing; All Rights Reserved



402

Dynamic Scheduling® with Microsoft® Project 2013

Therefore, you have to level the workloads by hand if you want the tightest 
schedule possible. Let’s explore the steps to do this in the easiest way possible.

Optimize resources first by using the Resource Allocation view or the new 
Team Planner view to evaluate over-allocations and then apply manual leveling 
techniques to resolve them.

1. To work with the Resource Allocation view, on the View tab, in the 
Resource Views, click the Other Views down-arrow. Click More Views, 
Resource Allocation and click on Apply.

 

2. A combination view appears with the Resource Usage view in the top pane 
and the Leveling Gantt in the bottom pane. The top view shows the over-
allocated resources and the bottom view shows the conflicting tasks.

The Steps to  
Level  
Workloads 
Yourself
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3. Check to see if you forgot any assignments; if you did, there is no use 
starting the workload leveling. The heading Unassigned at the top contains 
the unassigned tasks. Click on the left Expand outline button to show 
them, and click Collapse outline button to hide them again. Typically, only 
the milestones and perhaps the recurring detail tasks should be listed in 
the Unassigned category. If you have not assigned resources to all detail 
tasks, you have not captured all the workloads, and you should not start the 
manual leveling process. Before you level, you want to be sure you have all of 
the players in the schedule. Hide all assignments in the top view by clicking 
on any column heading and then on the View tab, in the Data group, click 
on the Outline down-arrow. Select Hide Subtasks.

4. The over-allocated resources are shown in red. Position your mouse pointer 
above the exclamation mark in the Indicators column. This is one indication 
of the need to level. Another is to look at the Indicators column in the lower 
part of the window (the Leveling Gantt) and position your mouse over the 
red “person” symbol.

The over-allocation identification depends on the level of granularity set for 
the project, this could be hours, days, weeks or months. You can review the 
granularity definition in the Leveling Options. Go to Resource tab, Level 
group, and click Leveling Options. In the option Look for overallocations 
on a ... basis select a proper definition and click OK. More details about the 
Leveling Options will be explained later in this chapter.

5. Scroll to the start of the project by dragging the scroll box on the horizontal 
scrollbar of the timescale to the far left. This step is important, since the tool 
will only look for over-allocations forward in time. Unfortunately, Control 
key + Home key does not work in the Resource Usage view.

6. Go to the first over-allocation by choosing the Resource tab, in the Level 
group, and clicking on Next Over-allocation. Project 2013 starts at the 
date you have in view and searches forward day by day to find the next over-
allocation. It does not stick to the selected resource.

7. Determine if the over-allocation is serious enough that it needs resolution. 
In our curriculum, we require project managers to resolve over-allocations 
when they exceeded 150% of a person’s availability on a day-to-day basis and 
120% on a week-by-week basis. Thresholds like these should be established 
within your organization. Resolve the serious over-allocations one by one.

Please note that the tool Next Over-allocation:
hh Often finds trivial over-allocations that you should ignore, for example two 

one-hour tasks overlap
hh Skips over-allocations that happened in the past, which is fine
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hh Sometimes does not find over-allocations that are serious

Nevertheless, we recommend this tool as the best tool available in Project 2013.

In the next illustration, you can see how the over-allocation is solved by delaying 
one of the tasks that was competing for the same resource:

The bottom view can be improved by displaying a line for the total slack as well. 
If the free slack is not large enough, the total slack may provide possibilities to 
resolve the over-allocation. You will have to add a colored line for total slack to 
each task bar.

Click in the timescale portion of the bottom view, right-click and choose Bar 
Styles. Scroll down until you see the Slack line item which depicts free slack. 
Cut the Slack line and paste it back in twice. Change the Name of the first one 
to Total Slack and under To select Total Slack from the list. Change the name 
of the second one to Free Slack and change the Shape to the second to last item 
in the list (bar in middle) and change the color to Lime (light green) as shown 
in the following screenshot:
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If you keep the same shape, the lines will fall on top of one another. If you insert 
the total slack item above the free slack item, the shorter free slack line will be 
superimposed on the total slack line. Project 2013 creates the bars in the order 
they are listed. Now you can see how far you can delay tasks without affecting 
the next constraint date or the project end date.

If a task does not have enough free slack to solve over-allocations, you can use its 
total slack to solve the work overload. In the illustration, task A doesn’t have 

enough free slack to solve the 
over-allocation, but it does have 
enough total slack. If you go 
beyond the total slack, you are 
slipping a constraint date or 
increasing the project duration. 
In the illustrated example, we 
would prefer to delay task B, 
since it resolves the over-
allocation within the free slack, 
even though task B has less total 
slack. This assures us that no 
other successor is affected, 

which keeps the rest of the schedule the same. That is why we suggested the 
bright green for free slack and darker green for total slack. If we delay task A, 
successors will be affected. The art of project management is often to minimize 
the turbulence.

In Project 2013, the Team Planner view displays the assignments for each 
resource in a time-phased, horizontal bar chart. The over-allocated portion of 
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each assignment is indicated with a red bracket. Where previous versions of 
Project required you to assign resources to tasks, the Team Planner lets you 
assign tasks to resources. You may find this more intuitive to use.

To view the Team Planner, on the Resource tab, in the View group, click on 
Team Planner.

This new view allows you to manually level workloads visually. Tasks can be:
hh Dragged into another resource’s “swim lane” to reallocate the work
hh Dragged to a new date (not recommended because you’ll add a constraint 

date)
hh Redistributed between different resources using defined assignment units

To level human resources, you fill workloads up to the limit of their availability. 
If someone is only used 80% of his time, another small, part-time task could be 
added without causing over-allocation. We call this percentage leveling, since 
you try to fill availability up to 100%. This is what Project 2013 does.

In general, facilities and machines are either occupied or not and need yes/no 
leveling. Unfortunately, Project 2013 doesn’t consider facilities and machines as 
separate types of resources. If you only assign facilities and machines at 100%, 
you can emulate yes/no leveling. Many people create a reservation system for 

Have Project 
2013 Level the 
Workloads
Level Facility and 
Machine Resources
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boardrooms and training rooms outside of Project 2013 to keep their “workload” 
reasonable. You want planned availability to affect the forecasts in your project 
model. This assumes that you treat machines and facilities as work resources for 
the purpose of leveling.

Materials are consumable and don’t need leveling. Materials are excluded from 
leveling and Project 2013 automatically sets the resource field Can Level to No.

On the Resource tab, in the Level group, click on Leveling Options to access 
the Resource Leveling dialog box. We will discuss this dialog box section by 
section:

Leveling calculations

hh We recommend you select Manual. If you select manual leveling, you can 
still have Project 2013 level the workloads whenever you want by clicking 
Level All at the bottom of the same dialog. You can also delete any traces of 
leveling by clicking Clear Leveling in this dialog; this will change all values 
in the task field Leveling Delay to zero.

Automatic leveling continuously levels the workloads and makes the task 
bars jump all over the place with every change you make in the schedule. 
Project 2013 levels mostly by delaying tasks. This option is a global option 
that takes effect in all your project schedules. Also, because you can often find 
better schedules by hand, we don’t recommend using automatic leveling.

hh In the list, Look for over-allocations on a … basis, you can choose the 
granularity with which Project 2013 combs through the data to find over-
allocations. A double workload on Monday, but a total workload of 16 
hours in a week, constitutes an overload on a day-by-day basis, but not on 
a week-by-week basis. The setting is about the granularity of leveling. We 
recommend using Day by Day or Week by Week for most projects.

hh Select Clear Leveling values before leveling if you want to clear the 
field Leveling delay of values left by previous leveling. Clear it if you want 
Project 2013 to add to the leveling delays incrementally; this often leads to 
unnecessarily long project durations. You may want to check this box if you 
are leveling one resource at a time. With this box checked, Project 2013 will 
not erase the previous resource you leveled.

Leveling range for <name of project>

hh Select Level entire project. You normally level the entire project, but you 
can also indicate a date range.

Resolving over-allocations

hh Select or clear Level only within available Slack. 

Choose the Leveling 
Options
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You can check this option to develop a scenario when you want to know how 
many of the over-allocations Project 2013 can resolve within a certain time 
frame. Clear it if you want Project 2013 to resolve all your over-allocations; 
if you have kept the schedule dynamic, it will solve them all.

hh Leveling can adjust individual assignments on a task
Check this option if you want to find the shortest, leveled schedule. If you 
have more than one person assigned to a task, this option will reschedule 
the individual assignments rather than all assignments as a group. The result 
is that task bars are often split into multiple parts, because each assignment 
on the task will be scheduled separately. This option is not applicable to 
tasks on which people are supposed to collaborate live in real time. If you 
use this option, you can still override it for certain tasks by entering No in 
the task field Level Assignments. Notice that Project 2013 sets this field by 
default to No for fixed duration and recurring detail tasks; for all other tasks 
it is set to Yes. If you clear it, Project 2013 will schedule the task only when 
the whole group is available.

hh Leveling can create splits in remaining work
Select this option if you want to allow Project 2013 to split task bars. Splitting 
may generate a tighter schedule, because if you allow splitting, Project 2013 
can schedule around tasks that have fixed dates. The drawback is that task 
bars become fragmented. If you want to exclude certain tasks from being 
split, clear their task field Leveling can split. Fixed duration tasks have 
this field set to No and will not be split by Project 2013, because it would 
increase their duration.

Again, make sure you have assigned resources to detail tasks before you start 
automatic leveling. If you haven’t assigned resources to all detail tasks, you have 
not captured all the workloads, and the forecasts after leveling will be too 
optimistic. In the Resource Usage view, click on the heading Unassigned, and 
then the Expand outline button to view unassigned tasks. Typically, only the 
milestones and perhaps the recurring detail tasks should be listed in the 
Unassigned category. You can also use the Team Planner view to review 
unassigned tasks.

There are three scenarios you 
can develop with Project 2013, 
and you can switch back and 
forth among them as many 
times as you need to. Each 
scenario provides some useful 

Three Automatic 
Leveling Scenarios

No Leveling

Leveling within Slack

Complete Leveling

workloads

workloads

workloads
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information. The illustration shows all three, with the over-allocations shown 
in blue.

hh No leveling
If you look at the timescale in the Gantt Chart view, you often see several 
tasks scheduled concurrently. Where two concurrent tasks have the same 
resource assigned, the workloads can exceed the availability of the resource. 
If there are no over-allocations, you will not need to level. In that case, only 
the task durations and dependencies drive the duration of the project. 
This scenario answers the question: What is the project duration when the 
workloads are not leveled? This scenario tells us the minimum duration for 
the project.

hh Leveling within the slack of the project
If you create a milestone with a Must Finish On constraint on the proposed 
target date, you can level within the slack this hard date creates. This scenario 
answers the question: What workload will critical resources have while 
meeting the project target date? This scenario tells you how many extra 
resources you should hire in order to meet the target date.

hh Complete leveling
This answers: What is the end date of the project if the workloads of all 
resources are entirely leveled? This shows a comfortable deadline for the 
project and the team.

All three scenarios provide useful information when negotiating deadlines with 
upper management or clients:

hh The no-leveling date from the first scenario is your resistance point in 
negotiations; you should not commit to an earlier date. You will still have 
to resolve all over-allocations if you commit to this date without delaying 
the project finish date which can be challenging depending on how many 
over-allocations you have.

hh The remaining over-allocations from the second scenario may provide the 
common ground in your negotiations with the client. You can ask Project 
2013 to resolve as many over-allocations as it can while staying within a 
certain time frame. You can then easily find out how many extra resources 
you need to hire to meet the target date and calculate the cost. If the client 
is willing to pay for the extra resources, you may have a date that meets your 
mutual needs.

hh The finish date of the third scenario of complete leveling is the date we 
recommend you first quote to your client. It is a date that is nice to have, and 
that you will likely not get. It could be your starting position in negotiations.
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Use the Leveling Gantt view to review the results of the leveling feature.

On the Task tab, in the View group, click on the Gantt Chart down-arrow. 
Select More Views, select Leveling Gantt from the list and click Apply.

This view includes the field Leveling Delay as one of the columns, and also 
shows the delay graphically with a brown colored line to the left of any task bars 
that were delayed.

You can even make the three scenarios show up side by side in one Gantt Chart, 
which we will explain in detail.

You can only clear the leveling if you are in one of the task views. Change to a 
task view first, if necessary.

1. If you have leveled workloads before, the field Leveling Delay will have 
entries. To check if this is the case, make sure you see the Leveling Delay 
column.

2. To remove the leveling delay, on the Resource tab, in the Level group, click 
on Leveling Options. The Resource Leveling dialog box appears:

No Leveling or 
Clearing the 
Leveling
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3. Select Manual and click Clear Leveling button; the Clear Leveling dialog 
appears:

4. Select Entire Project and click OK; you are now back in the task view. The 
numbers in the field Leveling Delay should all be zero.

5. If you want to compare all three scenarios in one Gantt Chart, you should at 
this point save the dates of this version. On the Project tab, in the Schedule 
group, click on Set Baseline down-arrow, Set Baseline and select Save 
interim plan and Copy Start/Finish into Start1/Finish1.

You now know the minimum duration for your project; there can still be over-
allocations in the schedule that need to be taken care of.

1. Make sure you have a project finish milestone where all dependencies come 
together. The project milestone should have a Must Finish On constraint on 
the proposed target date; a Finish No Later Than constraint does not work 
here. Make sure you have a minimum of other constraint dates, since they 
hinder the automatic leveling.

2. On the Resource tab, in the Level group, click Leveling Options and the 
Resource Leveling dialog box appears:

Leveling within the 
Slack of the Project
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3. Choose the granularity of the leveling by selecting from the list Look for 
over-allocations on a … basis the time unit in which Project 2013 should 
find over-allocations. We recommend Day by Day or Week by Week for 
most projects.

4. Check Clear leveling values before leveling to clear the field Leveling 
delay of old leveling values; Project 2013 will make a fresh start with the 
leveling.

5. Check Level only within available slack.

6. Clear Level resources with the proposed booking type unless you 
want the workloads of resources that are proposed but not committed on 
potential projects to be leveled as well.

7. Click Level All button. Project 2013 may alert you that it cannot resolve 
certain over-allocations, which is what we expected, since we gave it a fixed 
time frame.

8. Click OK.

9. Check the workloads of the resources; there are often some over-allocations 
left.

10. If you want to compare all three scenarios in one Gantt Chart, you should at 
this point save the dates of this version. On the Project tab, in the Schedule 
group, click the Set Baseline down-arrow, Set Baseline and select Set 
interim plan and Copy Start/Finish into Start2/Finish2. 

The workloads of the resources are likely still too high to meet the deadline, 
and you can analyze how much extra expense you would have to solve the over-
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allocations by hiring temporary workers. Or you can explore other methods to 
make the workloads reasonable.

1. Check if you have many hard scheduling constraints, because they will 
hinder this process of complete leveling.

2. If needed, insert the column Leveling Delay by right-clicking on the 
column heading Duration, choosing Insert Column and selecting the field 
Leveling Delay from the list. This field allows us to see the result of the 
leveling.

3. On the Resource tab, in the Level group, click Leveling Options within 
the Level grouping …; the Resource Leveling dialog appears: 

4. Choose the precision of the leveling by selecting from the list Look for 
over-allocations on a granularity with which Project 2013 should find 
over-allocations. We recommend Day by Day or Week by Week for most 
projects.

5. Select Clear leveling values before leveling if you want to clear the field 
Leveling delay of old leveling values, which we recommend.

6. Select Level entire project.

7. Clear Level only within available slack; otherwise Project 2013 may not 
solve all over-allocations.

8. Select Leveling can adjust individual assignments on a task if you want to 
find the shortest leveled schedule. Project 2013 schedules the assignments 
individually instead of as a group. You may end up with split task bars, but 
you can redo the leveling and clear the option to prevent bar splits, or you 
can set the task field Level assignments to No for task bars you don’t want 
to be split.

Complete Leveling
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9. Select Leveling can create splits in remaining work if you want to allow 
Project 2013 to split task bars. The drawback is that the task bars become 
fragmented. If you want to exclude certain tasks from being split, set their 
task field Leveling can split to No. Fixed duration tasks have this field 
already set to No.

10. Clear Level resources with the proposed booking type, unless you want 
resource workloads that are proposed but not committed on potential 
projects to be leveled as well. This is only relevant when using Project Server 
2013.

11. Select Level manually scheduled tasks (unless there is a reason not to).

12. Click Level All. Project 2013 will delay certain tasks. In the column 
Leveling Delay, you can see which tasks have been delayed and by how 
long.

13. If you want to compare all three scenarios in one Gantt Chart, you should at 
this point save the dates of this version. On the Project tab, in the Schedule 
group, click on Set Baseline down-arrow, Set Baseline and select Set 
interim plan and Copy Start/Finish into Start3/Finish3.

The schedule is now realistic in the sense that the resources can finish the work 
assigned to them without the project end date slipping further. Check the end 
date in the Finish column of the project summary task; it has likely been delayed. 
Project 2013 will only be able to solve over-allocations without delaying the 
project finish when they are small.

To compare the three scenarios in terms of dates on the different milestones, you 
should create a new view and select separate bar styles for the Start1/Start2/
Start3 data sets. These steps assume that you have already captured the three 
scenarios as shown in previous procedures.

Comparing the 
Three Scenarios in 
One Gantt Chart
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1. On the Task tab, in the View group, click on Gantt Chart down-arrow, 
More Views and the More Views dialog box appears:

2. Select Multiple Baselines Gantt and click Copy.

3. The View Definition dialog box appears:

4. Change the name of the new view to a descriptive title such as Leveling 
Scenarios. You can keep the rest of the settings. 

5. Select Show in menu; the view will be available with only three mouse-
clicks.

6. Click OK; you are now back in the More Views dialog.

7. Click Apply.

8. In the Gantt Chart view, on the Format tab, in the Bar Styles group, click 
on the Format down-arrow, Bar Styles, and change the settings so that 
instead of the baseline dates the Start1/Finish1- Start3/Finish3 dates are 
shown. The changes you need to make are shown in the following dialog:
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9. Notice the order in which the dates are entered into the dialog. This order 
is a deliberate choice, since items listed higher are overlaid by lower items. 
Click OK.

10. You should now see the three task bars for each task and have the three 
scenarios next to each other in the timescale:
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How can you predict which tasks will be postponed when resources are over-
allocated? When you ask Project 2013 to level your schedule, it will try to 
intelligently choose which tasks to delay. It looks at the amount of slack on both 
tasks that compete for the same resource. It will delay the task that has most 
slack. This is smart, because the tasks with most slack are least likely to affect 
your project end date. However, it does not always delay the task you would 
prefer. Project 2013 offers you three choices to influence which tasks are delayed. 
You will find these on the Resources tab: in the Level group, click Leveling 
Options, Leveling order list down-arrow.

Here are some suggestions on when to use each:

hh ID Only
Project 2013 will level tasks based upon their ID numbers. It will give 
priority to tasks higher up in the list of tasks. Use this setting to prioritize 
projects in a consolidated schedule. Put your highest priority projects at the 
top of the list and then level your consolidated schedule using this option. 
Dragging projects up and down the list is less effort than maintaining 
priority numbers. (See Appendix 1 for information on how to consolidate 
schedules.)

hh Standard
This is the default setting and is used for regular leveling. Under standard 
leveling, tasks will be examined within predecessor dependencies, slacks, 
dates, priorities, and constraints.

hh Priority, Standard
When you aren’t entirely happy with Project 2013’s leveling, you can enter 
a priority number for certain tasks in the field Priority. In this way, you can 
influence which task is delayed in the leveling. This involves a fair bit of work 
if you do it on a task-by-task basis; it’s quicker if you fill down a priority 
number for all tasks of a deliverable. Priority numbers can range from 0 to 
1000. The higher the number, the higher the priority, and the more likely it 
will be that the task keeps its current dates. 

Another way to influence leveling is to exclude certain tasks or resources as 
candidates for leveling.

If the priority number is set to 1000, Project 2013 will not delay the task, and 
will effectively exclude it from the leveling process. This is even the case if you 
use the ID or Standard setting in the Leveling order list.

Influencing Project 
2013’s Leveling

Excluding  
Tasks from  
Project 2013 
Leveling
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Typically, you would exclude subcontractor resources from leveling, because the 
workload of people external to your organization is normally not your problem.

You can exclude human resources by entering No in the resource field Can 
Level, or you can select which resources you want to level:

1. In the Resource Sheet view select the resources you want to include. 

2. In the Resource tab, in Level Group, click Level Resource, the Level 
Resource dialog box appears:

3. You can change the resources selected in the dialog box, and then click the 
Level Now button. Project 2013 will only level the workloads for those 
resources you selected. This allows you to quickly develops several scenarios.

We’ve now discussed both ways of leveling workloads: doing it yourself or 
having Project 2013 do it for you. If you struggle with which to choose, here are 
some guidelines:

hh If you have just a few over-allocations in your schedule, you could probably 
resolve them all yourself without puzzling for hours. If this is the case, we 
recommend you do it yourself by hand and don’t use Project 2013’s leveling 
features. You can think of ways to resolve these over-allocations that Project 
2013 is not capable of doing. Project 2013 can only resolve over-allocations 
by delaying tasks, which may delay your project end date.

Excluding 
Resources from 
Project 2013 
Leveling

Should I Level 
Myself or Have 
Project 2013 
Level?
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hh If there are many over-allocations in your schedule, resolving them all by 
hand is a lot of work, and in that case, it may be easier to perform a complete 
leveling. This will likely push your project end date far out. You can then 
improve that date by finding the resource-critical path in your schedule and 
focusing on the resource-critical tasks. We will explain the concept of the 
resource-critical path in the next section.

In the illustration below, there are two tasks: write a report and read another 
unrelated document. The tasks are not dependent upon each other; Harry can 

choose to do them in any order. Before 
leveling, the critical path is the task write. 
After leveling, read is the only critical 
task. Try this out in Project 2013! Don’t 
worry, there is nothing wrong with your 
software; this is how the critical path 
algorithm is supposed to work and works 
in other scheduling software as well. The 

critical path theory assumes that you have access to unlimited resources.

In Project 2013, the leveled mini-schedule looks as follows:

Here are the mathematics of the algorithm:

hh On the forward pass, the Early Start for write is day 1 and the Early Finish 
is day 3 given the duration of three days. For read the Early Start is day 1; 
remember that there is no dependency between the tasks, and the Early 
Finish is at the end of day 5, given the delayed start date of day 4.

hh On the backward pass, the Late Finish for read is also day 5; the Late Start, 
therefore, is day 4. Write has to be finished on the project finish date; the 
Late Finish date is day 5, since there is no dependency between the two. It 
has to start, at the latest, on day 3 to meet this date.

The total slack (Early Finish date subtracted from Late Finish date) of the 
task read is 5 – 5 = 0 days; the task is critical and highlighted in red. The 
total slack for write is 5 – 3 = 2 days; the task is not seen as critical by the 
algorithm. However, common sense dictates that there really is no slack on 
the task write, because it competes for the same resource, Harry. And if the 
task write takes longer, the task read will be moved out.

How Leveling 
Affects the Critical 
Path Write

Read

Write

Read

Harry 3D

Harry 2D

Harry 2D

Harry 3D

Leveling
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This example demonstrates the weakness of the critical path algorithm. The 
algorithm doesn’t take resource dependencies into account, because it is 
built on the assumption that you have access to unlimited resources.

Access to unlimited resources is seldom the current reality in the global 
marketplace. Many organizations find themselves having to level the workloads 
of their resources, and in doing so, the critical path often becomes fragmented. 
The leveling of tasks can make the calculated total slack value of tasks meaningless 
and therefore the critical path as well. In fact, tasks with total slack may be driving 
the project end date, as is the case with the task write in the previous example. 
If write slips, it will move read, because of the resource dependency of Harry 
assigned to both tasks. The slack is false slack.

We need a smarter critical path that takes resource dependencies as well as 
logical dependencies into account. We call this the resource-critical path (RCP).

Leveling

Review SW (5d)

Review HW (5d)

Propose Improvement (8d)

Mario

Ed

Mario

Review SW (5d)

Review HW (5d)

Mario

Ed

Mario

Propose Improvement (8d)

CP = 13d

RCP = 18d

Given the example in the illustration, what should a project manager monitor, 
the critical path (CP) or the RCP? The answer is obvious. One should try to find 
the RCP in resource-constrained projects, rather than the critical path. Only the 
RCP provides a complete explanation of the project duration. It shows what 
drives the project end date at any time during the project duration, just as the 
critical path does in logic-constrained projects. The RCP is more helpful in a 
leveled schedule.

The RCP describes a condition when tasks compete for the same resource at 
any point in time; those tasks have a resource dependency. An RCP looks at the 
logical dependencies and resource dependencies in the series of tasks and then 
determines the project duration based on this.

A task can be resource-critical because of a logical dependency or a resource 
dependency with another task. Notice the definition of an RCP is not very 
different from the critical path definition. However, other common descriptions 
of the critical path, like the sequence of tasks without slack, do not apply to 
the RCP, because resource-critical tasks can have slack. In the example we just 

Critical Path or 
Resource-Critical 
Path?

The Resource-
Critical Path
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discussed, the task write has slack, but still drives the project end date and is 
therefore as critical as read. Both are resource-critical tasks, however, because 
the same resource works on them. The RCP, in other words, is the chain of tasks 
that drives the project end date while taking into account that resources have 
limited availability. When you have relatively few resources, you should focus on 
the RCP instead of on the critical path.

An easy way to find out if you’re in a resource-constrained situation is by leveling 
the workloads completely: if your project end date slips and the over-allocations 
are gone, you are in a resource-constrained project. If the end date did not slip, 
you are in a logic-constrained project.

WBS

TimeCritical Path

WBS

TimeResource-Critical Path

You can see in the illustration above that the RCP often includes some early 
critical tasks and then resource-critical tasks that are delayed, because of 
leveling. All those tasks drive the project end date. Resource-critical tasks are 
tasks that, when delayed, make the project end date slip. In a leveled schedule, 
any resource can be so limited in availability, or needed so much, that it could 
drive the project finish date. 

1. Check the workloads and level them
2. Show the resource-critical path (RCP)
3. Find the critical resources
4. Make a change to those tasks
5. Consider impacts on quality, scope, and risk
6. Decide whether you want to keep the change
7. Repeat steps 3 – 7

The next step is to find and highlight the RCP. There is no feature in Project 2013 
that highlights the RCP for you. Therefore, it will involve some effort from you 
to implement the concept of the RCP. In order to optimize the schedule, it is 
imperative that you do identify the RCP.

Finding the 
Resource-Critical 
Path
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We will discuss two methods to find the RCP: a manual process and an 
automatic process. IIL provides a macro that will automate finding your RCP.6 If 
you manage resource-constrained projects, it will make your life much simpler.

hh Manual process
We recommend this process for small projects. Also, this process will 
help you truly understand the concept of an RCP and for that reason, we 
recommend you try this process first to enhance your understanding of 
RCPs.

hh Automatic process
After you understand the concept of the RCP, use our macro that identifies 
the RCP in your schedule very quickly. This macro is included in the files 
available for download that come with this book.7

It’s easiest to identify resource-critical tasks by starting at the project end 
milestone and tracking backward. Look for driving predecessors or resources 
that are shared between the tasks. Tasks that are resource-critical have either 
a logical dependency or a resource dependency with earlier tasks. A logical 
dependency is shown as an arrow between the task bars in the Gantt timescale. 
A resource dependency occurs when two tasks are competing for the same 
resource. We recommend that you use the Gantt chart to identify the RCP: you 
can see in the timescale to the right of the task bars which resources are assigned.

Once you understand the process, you can find the RCP manually in a small 
schedule of up to one hundred tasks within minutes. In larger schedules, we 
recommend you use the automatic process.

The flowchart gives an overview 
of the process. You will work 
backwards starting with the 
project finish milestone. This 
milestone is by definition 
resource-critical, so you mark 
it using the Marked field right 
away. You then ask yourself for 
this milestone: Does a logical 
dependency drive it? You check 

all the predecessors of the project milestone and determine which one is driving 
it to the date on which it starts. You will find a predecessor that has a finish date 
that is just before the start date of the finish milestone. Once you have found the 

6 The RCP macro only works properly with the English version of Project 2013. IIL owns the copyright of 
this macro that was developed by Ken Jamison and adapted by Rafael Ruiz. This macro is provided for 
personal use only. If you would like to use this macro for business purposes, please contact our USA sales 
staff (212-758-0177) to purchase a corporate license.

7 See www.jrosspub.com. 

Manual Process

Mark the project end milestone

Does a 
logical

dependency
drive it?

Does a 
resource

dependency
drive it?

All resource-critical tasks marked

Mark the 
driving 

predecessor

Mark the task 
that competes 

for same 
resource

No

Yes

Yes

No
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driving task, you mark it as a resource-critical task. Then you go back to the top 
of the list of steps and start all over again with the marked task as the next task 
to analyze.

You start with the first question again: Does a logical dependency drive it? You 
check all its predecessors and check which predecessor finishes just before the 
detail task starts; this is most likely the driving predecessor. You may have to 
check for lags on dependencies to determine if the link is driving. If you find a 
driving predecessor, you mark it and go back to the top of the chart and continue 
with that task.

If you did not find a driving predecessor (which is often the case for detail tasks 
in a resource-constrained, leveled schedule), ask yourself the second question 
in the list of steps: Does a resource dependency drive it? Now you look at each 
resource assigned to the task, and you look for another task that finishes just 
before it that uses the same resource. Once you have found the driving task, you 
use the Marked field to mark the task that competes for the same resource and 
go back to the top of the step list and continue with that task. You continue until 
you have arrived at the project start date, at which point all resource-critical tasks 
are marked.

As you can see in the screenshot, we recommend using the Gantt Chart with 
the Task Detail Form displayed at the bottom of the view to find the RCP. Make 
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sure you insert the task field Marked to tag the tasks that you find to be resource-
critical.

The steps to identify the RCP in your schedule are:

1. On the Task tab, in the View group, click on Gantt Chart down-arrow, 
Gantt Chart. Format the bars so that the resource name is shown to the 
right of the bars. Also, on the Task tab, in the Properties group, click on 
Details to display the Task Details Form (right-click in the large grey blank 
area and select Resources & Predecessors) with the dependencies and 
their lags. Insert the field Marked and enter Yes for those tasks that you 
identified as resource-critical tasks. Mark all resource-critical tasks using the 
process explained above.

2. On the Task tab, in the View group, click the Gantt Chart down-arrow, 
Tracking Gantt, because it already has Format, Bar Styles settings that 
color the critical tasks red. Notice that the critical path is entirely fragmented: 
it does not explain the entire project duration, but the RCP does.

3. We will now make changes to the bar styles of the view, but you probably 
want to preserve the original Tracking Gantt view as well. Therefore, you 
should copy the Tracking Gantt view first. On the View tab, in the Task 
Views group, click on Gantt Chart down-arrow, Save View. The Save View 
dialog appears, enter a new name for the view, for example Resource-Critical 
Path and click OK. You are now back in the main screen with the new view 
displayed.

4. We will make the RCP look the same as the critical path. Choose the 
Format tab, and in the Bar Styles group, click Format down-arrow. Select 
Bar Styles and make changes to the bars so that all normal tasks have a 
blue task bar, except for tasks that are marked; they will appear in red. These 
changes are circled in the following screenshot:
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5. Click OK. You can now color task bars red if you change their field Marked 
to Yes, or you can change them back to blue by entering No in the Marked 
field. This is useful if you need to make corrections to your RCP.

6. Click in the column heading Marked and choose Yes. This filters and 
displays the resource-critical tasks only. To turn off the AutoFilter, on 
the View tab, in the Data group, click on the Filter down-arrow, Display 
AutoFilter selection to toggle on/off the AutoFilter.

7. Replace the % Complete to the right of the task bars with the resource 
names. On the Format tab, in Bar Styles group, click on Format down-
arrow, Bar Styles and select the item Critical. Click tab Text and replace 
% Complete with Resource Names. You may want to get rid of the % 
Complete on the Summary tasks as well.

8. Make the dependency arrows disappear by starting with a Gantt Chart 
view and choosing the Format tab in the Format group. Click on Layout 
and under Links, select the first option.
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If you follow these steps, the schedule should now look like this:

To the uninitiated, the schedule now looks as if the regular red critical path is 
shown, except that it really is the RCP. The RCP drives the project end date, just 
like the critical path. The RCP provides a complete explanation for the project 
duration, just like the critical path would in a logic-constrained project. You 
could present this as your critical path to people who are not familiar with the 
concept of the RCP. They will not argue about the correctness of it, because you 
can easily prove that all red tasks drive the project end date. After all, if any of the 
tasks on the RCP slips, the project will take longer.

Identifying the RCP should be done in an automated fashion, because when you 
are making changes to the schedule during optimization, you need to find the 
new RCP over and over again (just as you do with the critical path).

IIL now provides a macro that can identify the RCP in your schedule. You 
can run this macro by opening the file IIL Project 2013 Tools.mpp available for 
download at www.jrosspub.com. Click the link WAV Download Resource Center 
to enter the download site.

The RCP macro identifies inactive and manual tasks and treats them as follows:

hh Inactive tasks: 
The schedule may contain inactive tasks. The macro simply does not 
consider them in the process to find the RCP.

hh Manual tasks: 
If the schedule contains a manual task that has a valid start date, a valid finish 
date, and a valid duration, then the macro will include the task during the 
process to find the RCP. 

Automatic Process
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If the schedule contains a manual task that has an invalid start date, finish 
date, or duration, then the macro will inform you about it before the process 
begins. 

You still may go on with the RCP process but the results will be incomplete 
if the invalid manual task happened to be in the RCP.

Here are the steps to run the RCP macro successfully:

1. Make a backup copy of the file you want to work with.

2. Open the file you want to work with.

3. On the View tab, in the Macros group, click the Macros down-arrow, 
Macro Security, Macro Settings. Select the Disable all macros with 
notification radio button.
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4. Resolve all over-allocations in your .mpp file BEFORE you run the RCP 
macro.

5. Open a second file that contains the Macro IIL Project 2013 Tools.mpp. 
Enable macros when you open the file.

6. Switch to the .mpp file that you will run the RCP macro on, (View tab, 
Window group, select the Switch Windows icon).

7. On the View tab, in the Macros group, click the Macros down-arrow, View 
Macros. Select the RCP_2013 macro and click on Run to run the Macro.

8. Click on Yes to acknowledge the author and the copyrights of the macro.

9. The macro uses the Marked field. In the case that your schedule has one or 
more tasks with a Yes value in the Marked field, a dialog box will give you 
an opportunity to copy the values of the Marked field to another Flag field.

10. When the macro finishes the RCP process, you will see a view called 
RCP auto that has been created by the macro. This view shows all tasks, 
highlighting the Resource Critical Path.
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11. If you want to focus on the Resource Critical Path, apply the filter, also with 
the name RCP auto, that was created by the macro. 

12. Before saving your schedule, make sure it is still intact, since IIL does 
not provide any warranties and cannot be held liable for damage to your 
schedule.

Since understanding the RCP approach requires some effort, we feel compelled 
to raise your motivation. Here are five reasons why applying the RCP approach 
is worthwhile in any resource-constrained schedule: the RCP drives the project 
end date, reveals the critical resource(s), uncovers potential domino effects, 
allows workload smoothing, and allows smarter fast-tracking.

hh The RCP Drives the Project End Date

WBS

TimeCritical Path

WBS

TimeResource-Critical Path

Typically, somewhere 
along the critical path, the 
resources start to constrain 
the schedule more than the 
logic, and the RCP 
overtakes the critical path, 
driving the project end 
date. As you can see in the 
illustration, the white tasks 
constitute the regular 
critical path, but leveling 
has delayed many of them. 
The result of leveling is 
shown as blue tasks. The 

RCP is the combination of the critical tasks early in the schedule and all the 
resource-dependent tasks later on. If any of these tasks slip, the project will 
finish later; the resource-critical tasks drive the project end date.

Needing to review the RCP doesn’t mean you can ignore CPM. There are 
many situations that are not resource-constrained, as well as situations in 

Why Should I 
Care About the 
Resource-Critical 
Path?
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which organizations decide not to allow (lack of) resources to drive the 
schedule out. In those situations, the RCP is not needed and CPM will do.

hh The RCP Reveals the Critical Resource(s)

WBS

TimeCritical Path

WBS

TimeResource-Critical Path

Harry (Analyst)

Tom (Programmer)

Di (Tester)

The RCP shows who the 
critical resources are and 
when they are critical. It’s 
important to know at any 
time which resource 
determines the speed of 
progress in your project. 
Only when you know who 
is critical can you pay 
special attention to 
facilitating their work  
(e.g., provide a work 
environment that is free of 
interruptions, respond to 

issues promptly, and announce each week to the team who the critical 
resources are and ask the team to respect their time and provide whatever 
cooperation they need). 

Managers get things done through others and the RCP allows project 
managers to focus on people instead of on tasks.

hh The RCP Uncovers Potential Domino Effects 

Write

Print

Edit

John John

Mary

Gord

Mary

Gord

Have you ever experienced 
an avalanche of changes 
after you made one small 
change? If you make one 
change to a schedule, you 
may trigger a disastrous 

domino effect. 

The illustration above shows that when John became sick, his task slipped. 
Mary had planned to finish her part just before her holiday. When John 
finished late, Mary had left for her holiday, so her part slipped even more. 
When she returned, finished her part and handed off to Gord, he was 
temporarily reassigned to another project and would return in three weeks. 
You decide not to wait for Gord and assign a new person. The new person 
will need one week of introduction and training, and so forth and so 
on… One little slip that seems innocuous can cause big delays because of 
resource dependencies. As we’ve said, project management is often the art 
of minimizing the turbulence.
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The RCP makes the most important resource dependencies visible. If 
you make the relationships between the resources visible, you can make 
changes to the schedule in a more educated fashion. If you monitor only 
the conventional critical path, you may not realize that you are creating an 
avalanche of changes.

hh The RCP Allows Workload Smoothing

100%
Ed’s workload histogram

Workload
Smoothing

100%

Often there is a huge cost 
involved with erratic 
workloads, as shown in the 
illustration. 

How much does Ed’s 
workload cost before 
and after smoothing? He 
has periods when he can 
twiddle his thumbs and 

other periods when he is overloaded (and may be wishing he had another 
job). We often see companies burn out their critical resources, especially in 
time-to-market organizations. If a critical resource burns out, the individual 
and the organization are severely hurt. For organizations, this often has 
expensive consequences in terms of dissatisfied employees, demoralized 
work culture, sick leave, attrition, as well as the cost of finding new, highly 
specialized people. It also costs money when deadlines are missed or 
contracts are lost.

The RCP keeps an eye on the workloads continuously, because workloads 
drive the RCP. Therefore, it allows you to monitor and manage workloads 
better. The eventual cost of a smooth workload is often less than the cost of 
an erratic one.

hh The RCP Helps to Fast-Track Smarter

Gantt Chart Gantt Chart

Resource Graph Resource Graph

Write

Read

100%

Harry 9D Harry 9D

Harry 6D Harry 6D

When fast-tracking your 
schedule, you may create 
workload problems if you 
only focus on the critical 
path. 

You may work a long time to 
find a shorter schedule, and 
just when you think you 

have a better schedule, you may find you have only replaced time problems 
with workload problems. In the illustration, the dependency between write 
and read was cut, and this created an over-allocation for Harry. The schedule 
is no longer feasible. If you ignore the resource dependencies and just focus 
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on logical dependencies, you may create short schedules. However, because 
of new over-allocations, these schedules may not be feasible.

Now that you understand why it’s important, we’ll explore the nature of the RCP 
a bit further.

First, it’s important to realize 
that each resource has its own 
RCP. In the illustration, the 
schedule is leveled every time 
for only one of the resources. 
This creates as many RCPs as 
there are resources. Harry, Ed, 
and Di are all critical resources, 
but when leveled, Di pushes 
the end date out farther than Harry or Ed does. Di is the most critical resource. 
When shortening Di’s RCP, you will arrive at a point after which Ed is more 
critical than Di. At that point, you have to shift your focus to Ed’s workload 
instead of Di’s. 

What we left out of this picture is that there are hand-off points between 
resources. The RCP may be pushed out farther than you would expect simply 
based on the RCPs of individuals. These hand-off points always run over a 
logical dependency. The logical dependencies link the chains of the resource 
dependencies together. The RCP has tasks that may be resource dependent 
on each other or logically dependent. The RCP typically reveals that multiple 
resources are on the RCP.

We’ll present three different specific situations in which finding the correct RCP 
can be challenging:
hh The RCP with multiple critical resources
hh When multiple resources are assigned
hh Both logical dependencies and resource dependencies exist

Scheduling software will have to find the right RCP in all three situations before 
one can reasonably state that a solid RCP algorithm has been found and this 
challenge has been met.

What Is the Nature 
of the Beast?

Harry Ed Di
WBS

Time
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hh The RCP with Multiple Critical Resources
Different resources typically 
work on tasks on the RCP. 
In the typical software 
development project, the 
analysts drive the front 
end of the schedule, the 
programmers the middle, 
and the testers the back end. 
Every time there’s a hand-off 
to the next resource, there 
is a logical dependency. 
Again, logical dependencies 
connect the chains of 

resource-dependent tasks. The RCP clearly shows who is driving the project 
duration and when they are driving it.

hh When Multiple Resources are Assigned

Write

Meet

Code

Read

Bob 5D

Harry 9D

Todd 6D

Harry, Todd, Bob 7D

Multiple resources on a 
task pose a challenge for the 
algorithm that finds the 
RCP. The illustrated 
example has resources 
assigned full-time to the 
tasks shown and multiple 
resources assigned to the 

last task, Meet. The algorithm has to pick the right resource as the critical 
one. In this case, Harry is the critical resource. In the traditional Critical 
Path Method, this is similar to a task that has multiple predecessors and the 
algorithm has to identify the driving predecessor.

hh Logical Dependencies and Resource Dependencies

Write

Meet

Code

Read

Harry 6D

Harry 5D

Harry 9D

Harry 7D

In the illustration, leveling 
has delayed the tasks Code 
and Meet. The difficulty in 
this situation is that there is 
no hard dependency 
between Write and Code, 
only a resource dependency. 
An algorithm that identifies 
the RCP has to be able to 

handle a combination of logical dependencies and resource dependencies. 
In the Manual Process flowchart, you therefore ask both questions. First, 

WBS

TimeCritical Path

WBS

TimeResource-Critical Path

Harry (Analyst)

Tom (Programmer)

Di (Tester)
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does a logical dependency drive the schedule? If not, does a resource 
dependency drive the schedule?

1. Check the workloads and level them
2. Show the resource-critical path (RCP)
3. Find the critical resources
4. Make a change to those tasks
5. Consider impacts on quality, scope, and risk
6. Decide whether you want to keep the change
7. Repeat steps 3 – 7 

We’re now ready to make changes to the resource-critical tasks. When the 
project has to finish earlier than the current schedule, it has to be shortened. 
The best measurements are those that improve time, cost, and resources, and 
meet quality and scope requirements without increasing risk. Unfortunately, 
there are no such ideal measurements. What you choose will depend on your 
project’s environment and context. The next table provides indications as to 
what the effect of each action could be in a typical project, but you have to ask 
yourself what the possible impacts in your own project might be. You need to 
consider actions previously explained in the sections on optimizing for time and 
optimizing for time and cost, and use them in combination with the following.

The actions are ranked in order of overall effectiveness. We recommend starting 
at the top of the table with the two fast-tracking methods. After exhausting the 
fast-tracking, go to the next action in the table.

Methods to 
Optimize for 
Time, Cost, and 
Resources
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Action For
1. Change sequential dependencies into partial 

dependencies (fast-tracking)
resource-critical tasks

2. Create parallel paths from a sequential path (fast-
tracking)

resource-critical tasks

3. Break down long tasks into many shorter ones resource-critical tasks

4. Change schedule constraints resource-critical tasks

5. Shorten lags (waiting periods) resource-critical tasks

6. Split task bars around a Must Start On task resource-critical tasks

7. Decrease duration estimates resource-critical tasks

8. Reduce the scope or delete tasks resource-critical tasks

9. Reallocate the best resources to the resource critical 
tasks

resource-critical tasks

10. Increase assignment units to full-time assignments 
for critical resources

resource-critical, 
fixed work tasks

11. Assign overtime hours to critical resources resource-critical, 
fixed work tasks

12. Add noncritical resources resource-critical, 
fixed work tasks

13. Replace critical resources with noncritical resources resource-critical, 
fixed work tasks

14. Remove a critical resource when multiple resources 
are assigned

resource-critical tasks

15. Postpone vacation of critical resources to after the 
deadline

resource-critical tasks

Some remarks about optimizing an RCP:

hh The methods are repeated in this table, because they are also valid in 
situations with limited resources. The difference is that these methods will 
now only work on resource-critical tasks instead of critical tasks. The actions 
are ranked by overall effectiveness.

hh Fast-tracking on the RCP is not as effective as on the critical path. However, 
it still is the preferred method to start with because it is quality, scope and 
cost neutral. Fast-tracking is less effective on the RCP, because:
h` There are fewer dependencies on a RCP, since it consists of logical 

dependencies and resource dependencies.
h` You can’t fast-track two tasks if the same resource is working on both 

tasks and they are linked. Fast-tracking is changing the dependencies 
in such a way that more tasks take place concurrently. When you 
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overlap tasks, workloads are moved as well, and you may create over-
allocations. Fast-tracking has to be applied with greater care. The RCP 
will show you which tasks have the same resources assigned that will 
cause new over-allocations when you overlap them. You should focus 
your fast-tracking efforts on tasks that are done by different resources. 
For example, when you remodel an office, the tasks of carpenters and 
electricians can overlap each other, as long as the carpenters start a 
few days ahead and finish a few days earlier. Fast-tracking is typically 
effective at hand-off points between critical resources.

hh Actions 10 through 13 can shorten the durations of resource-critical tasks. 
These methods will work for all task types except Fixed Duration tasks. 
Before using one of these methods, you have to change the task Type to 
Fixed Work, assuming the amount of effort required stays the same.

hh Overhead or support tasks should not be on the RCP. Overhead tasks 
support the real work and should not drive the project end date. If you see 
the project manager, team leaders, or technical support or administrative 
support people on resource-critical tasks, you may have found an easy way 
to shorten your project. In most cases, these people can and should be 
taken off the RCP. After all, they are managing or supporting the real critical 
resources (or at least that is what they are supposed to do).

We discussed the first eight methods; we will discuss the remainder of them 
next.

hh Reallocate the Best Resources to the Resource Critical Tasks

Resource 
Critical 

Path

Jack

Rino

Paula

WBS

Time This is the best and most 
basic principle to apply when 
trying to find the shortest 
schedule possible while 
keeping quality up and cost 
down. After you have created 
the detailed schedule and 
leveled the workloads, you 
have a better idea about 

which tasks are driving your project duration: these are the resource-critical 
tasks. Ask yourself: Have I assigned my best resources to my most critical 
tasks? If not, you have an opportunity to shorten your project duration by 
moving your best resources to these tasks.
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hh Increase Assignment Units

Harry [100%]

Harry [50%]
If a resource is working 
half-time on a critical task, 
you can finish the task 
earlier if you can get the 
resource to temporarily 
work full-time on it. Again, 
the right task type—fixed 

work—has to be applied if you want to see the duration decrease. You may 
have to negotiate for Harry with another project manager. (But remember 
to remind the other project manager that if you can have him full-time, 
you’ll be able to release him sooner.)

To change a resource to full time, in the Gantt Chart, select a resource-
critical task.

1. On the View tab, in the Split View group, select Details to display the 
Task Details Form at the bottom of the screen:

2. Determine which assignment drives the duration of the task if more 
than one resource is assigned.

3. Set the Task type to Fixed Units and click OK. This assures that Project 
2013 will shorten the duration when you increase the resource units.

4. Increase the resource units on the task so that the resource works full-
time on the critical task. Click OK. The duration should be decreased.
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hh Assign Overtime Hours
If you can get resources to 
work overtime, critical tasks 
can often be finished earlier. 
In the illustration, the second 
bar shows a shorter duration. 
Two situations can arise: 

h` If overtime will not be charged to the project, then change the resource 
calendar of that particular resource. You can increase the working hours 
or change holidays to working days. You can compensate by giving the 
resource time off later.

h` If overtime will be charged to the project at a higher overtime rate, then 
overtime should be entered in the overtime field (Ovt. Work) in the 
Task Details Form. The cost of the project will increase. 

The detailed steps are:

1. Select a resource-critical task.

2. Pull up the Task Details Form in the bottom pane and right-click in 
the large gray area to the right. Select Work to display the Ovt. Work 
field. The screen should now look like this: 

3. Set the Task type to Fixed Work and click OK.

4. Determine which resource drives the duration of the task, and enter the 
overtime hours to be worked in the field Ovt. Work.

5. Click OK; Project 2013 schedules the hours worked in overtime 
outside the regular working time and automatically calculates a shorter 
duration.

Do not lower the original work estimate; Project 2013 subtracts overtime 
from the original estimate before calculating the new duration.

hh Add Noncritical Resources

Harry: 40h

Harry:  30h + 10h overtime
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Harry, Ed

Harry
Two resources can normally finish 
a task faster than one (assuming it 
is easily divided). When you add a 
resource, the duration will 
decrease, but it will only decrease if 
you have the right task type applied 

to the task before adding the resource. When you add a resource to a fixed 
work task, the same amount of work is now performed by two resources and 
can be done twice as fast. Project 2013 will calculate this for you.

Let’s think about what happens in practice. When you hire new resources, 
you have to train them. You would typically take your best resources off their 
crunching to train the new ones. At first, you will see a short-term decrease 
in the rate of progress. If all works well, you hope that in the longer term 
the progress accelerates. For this reason we have marked this method with 
a “?” for the Time dimension in the table. Look carefully at your situation to 
judge whether adding resources would actually help.

1. Select a resource-critical task.

2. On the Task tab, in the Properties group, click on Details to display 
the Task Details Form in the bottom of the screen. Determine which 
resource drives the duration of the task.

3. Set the Task type to Fixed Work to ensure that Project 2013 will 
shorten the duration when a resource is added. Click OK.

4. Assign another resource and click OK; the duration should decrease.

hh Replace Critical Resources

Ted

Harry

Harry

If you replace a critical resource 
with a noncritical resource, you 
may be able to schedule more 
tasks in parallel. In the 
illustration, Ted replaces 
critical Harry on the second 
task, which can now be done in 

parallel with the first one. The gain in time equals the duration of the second 
task.

Some people argue that you cannot substitute critical resources; otherwise 
they would not be critical (as in “important”). Remember that the word 
critical has a different meaning in project management: it doesn’t mean that 
the resource is important to the task, it simply means that the resource is 
driving the project duration. In fact, the resource could be a second-choice 
resource, and it is not a good idea to have your project duration be driven 
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by second-choice resources if you are working against time. That’s why we 
started by having you check if you applied your best resources to your most 
critical tasks.

1. In the Gantt Chart, select a resource-critical task on which you can 
replace a critical resource.

2. On the Task tab, in the Properties group, click on Details to display 
the Task Details Form on the bottom of the screen. Determine which 
resource drives the duration of the task.

3. Click on the name of the critical resource in the Task Details Form 
and use the list to select the substitute resource.

4. Click OK.

If you prefer to use the Assign Resources dialog instead:

1. On the Resource tab, in the Assignments group, select Assign 
Resources and the dialog box appears: 

2. Click on the critical resource in the Assign Resources dialog.

3. Click Replace. The Replace Resource dialog overlays the Assign 
Resources dialog.

4. Click on the replacement resource, and click OK. Level your schedule 
again and keep the change if the duration of the project decreased; 
otherwise, return to the previous version by closing the schedule 
without saving.
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hh Remove a critical resource when multiple resources are assigned

Write

Meet

Code

Read Todd 6D

Harry 9D

Bob 5D

Harry, Todd, Bob 7D

If there are multiple people 
working on a task, and one 
of them is a critical resource 
who has a lot of other work 
at the same time, you should 
ask yourself how important 
the involvement of the 
critical resource is on this 
task. If the other people 

could do without the critical resource, you should consider removing the 
critical resource from the task. (Again, a critical resource does not mean 
that the resource is important for the successful completion of the task.) In 
the illustration, Harry is removed from the task, which shortens the RCP.

hh Postpone vacations
If you can convince your resource 
to postpone a vacation until 
after a critical deadline, you may 
be able to meet the deadline. In 
the illustration, the deadline is 
depicted as a diamond.

To move a vacation:

1. On the Project tab, in the Properties group, click Change Working 
Time and the Change Working Time dialog box appears:

Vacation

Vacation
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2. Under For calendar: Standard (Project Calendar) select the specific 
resource calendar (previously created) with the vacation you want to 
postpone.

3. On the Exceptions tab in the Change Working Time dialog box, select 
the vacation exception that you want to edit under the Name column.

4. Move the vacation for this resource to later dates after the deadline in 
the Start and Finish columns. Move and edit these new vacation dates 
by clicking on the Start and Finish columns. 

5. Next, select Details and in the Details dialog box make sure that 
Nonworking is selected for the new vacation exception time frame, 
then click OK.

6. Click OK. The schedule should now be shorter.

1. Check the workloads and level them
2. Show the resource-critical path (RCP)
3. Find the critical resources
4. Make a change to those tasks
5. Consider impacts on quality, scope, and risk
6. Decide whether you want to keep the change
7. Repeat steps 3 – 7 

After making changes to time, cost, and resources, you have to consider the 
impacts on quality, scope, and risk (the six competing demands).

You can now see how much time you have gained, and whether it is worth any 
sacrifices you may have made on the scope of the project or the quality of the 
deliverables.

Whenever you make a change to a resource-critical task, the workloads may 
move or change. You can check to see if this created new over-allocations by 
displaying the Resource Usage view. You may have to level the schedule again 
and determine the new RCP once more. You could make several changes before 
identifying the new RCP. At this point it may very well be an entirely different 
series of tasks.

Before identifying the RCP tasks again, we recommend that you unmark all 
resource-critical tasks first. To unmark all, click on the column heading Marked 
and on the Task tab, in the Editing group, Clear within the Editing grouping, 
click the Clear down-arrow, Clear All. 

Optimizing for time, cost, and resources is challenging and practitioners are 
greatly helped now that the RCP can be found automatically.

Consider the 
Impacts
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We discussed simulation of the critical path. You can also simulate resource-
critical paths in resource-constrained schedules. You do need to change the 
leveling to automatic leveling so that the simulation software does not forget to 
keep the workloads reasonable.

On the Resource tab, in the Level group, click Leveling Options select 
Automatic and clear Level only within available slack. 

This ensures that for each scenario of the schedule the workloads are entirely 
leveled before the project duration is calculated.

As you can imagine, simulating RCPs requires major computing power, so make 
sure you run this on the fastest computer in your office.

The reasons why you should consider simulating RCPs are the same reasons 
you’d simulate the critical path:

hh Durations are more likely to extend than shrink. Estimates do not follow a 
normal distribution, but have a distribution that is typically skewed to the 
pessimistic side.

hh The more parallel paths you have, the more delays will compound at the 
merge points (path convergence or merge bias).

If you simulate the RCP, you have taken care of all three assumptions that cripple 
the utility of the traditional critical path: the previous two reasons and the fact 
that the critical path assumes access to unlimited resources. This is what we 
recommend for resource-constrained projects.

Apart from that, there are extra factors that are quantified when you simulate 
resource-constrained schedules. We referred to these factors previously as 
domino effects:

hh The average effect of fixed date personal vacations on the project duration. 
It is hard to predict how much the project end date will change when some 
tasks are moved a little bit. The simulation software will run many scenarios 
and will eventually average the impact of the hard-date vacations.

hh The average effect on the project duration of asynchronous working hours 
of resources: What overall delay will you experience from some resources 
working a regular workweek and some a compressed workweek? This effect 
is also hard to predict other than through simulation.

hh When you identify activities that have time risk, you should also identify 
those activities where exact resource availability is not entirely certain. 
When you decide what distribution curve you need on those tasks, you can 
incorporate the likelihood of resource availability in the range of estimates 
and the curve you choose for these tasks.

Simulation of the 
Resource-Critical 
Path
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The s-curve output from the simulation will indicate the probability by date 
for a range of project finish dates. Our experience is that most people tend to 
underestimate the overall effect of all the factors discussed. We see this over 
and over again in classes where we ask participants to estimate the outcome 
of a simulation on a tiny project while showing them the exact inputs of the 
simulation. We therefore recommend you quantify the factors we discussed that 
can throw your schedule off its baseline by simulating your schedules. After all, 
as a project manager, it is prudent to minimize so-called known risks. You will 
still have to deal with enough unknown unknowns.

Here are checks to verify if you have applied best practices when optimizing 
your schedule.

hh Is the total effort within the person hour budget of the project (if a budget 
is available)?
To find the total effort of the project on the Project tab, in the Properties 
group, click Project Information, Statistics… and look in row Current, 
column Work.

hh Are the workloads for the resources reasonable?
h` We work with these limits: the workload for individuals should not 

exceed 150% of their regular availability within any week and should 
not exceed 120% for periods longer than a week. The parameters may 
differ for your organization. Be sure to check with your PMO (project 
management office) or the authority that sets these guidelines.

h` The workload of consolidated resources (groups) should not exceed 
their availability.

h` The workloads should be fairly smooth, since there are hidden costs 
involved with erratic workloads. 

Note that it is not enough to just check if there is any red in the Resource 
Usage view. Project 2013 often highlights more resources in red than are truly 
over-allocated. If there is an over-allocation during only one business hour, 
the resource will be shown in red. On the Resource tab, in the Level group, 
click on Next Over-allocation to check the over-allocations. This tool is more 
selective and more reliable. However, even this tool does not always find all over-
allocations, and it also highlights trivial over-allocations (e.g., 1 hour). 

hh Is the cost modeled using the right fields and in the appropriate way? 
The following fields are available in Project 2013:

Checks on 
the Optimized 
Schedule
Optimizing 
Workloads

Optimizing Costs
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h` Resource Sheet fields: Type, Material Label, Standard Rate, 
Overtime Rate, Cost Per Use and Accrue At. A resource can also have 
a Cost Rate Table.

h` Gantt Chart fields: Fixed cost and Fixed cost accrual.

hh Is the total cost within the budget of the project (if a cost budget is available)?
You can find the total cost of the project by checking Project Statistics and 
looking in row Current, column Cost.

hh Are there as many parallel paths as logically possible in the network of 
dependencies?
Novice schedulers tend to schedule all tasks in one long sequential chain. 
This creates many soft dependencies that make the duration of the project 
unnecessarily long. When optimizing for time, it is important to schedule in 
parallel what logically can happen simultaneously.

hh Are there any unresolved conflicts between the task calendars and resource 
calendars?
If there are conflicts, the forecasts may be too optimistic. You can find the 
conflicts by looking in the Indicators column for a warning icon. 

hh Are the deadline dates and other constraints met in the schedule?
You can check this by applying filter 10 IIL Deadlines or Constraints not 
met.8 It displays tasks with deadlines or constraints that have negative slack. 
When deadline or constraint dates are not met, the schedule may forecast a 
project end date that is too optimistic.

hh Does the schedule have a critical path or a resource-critical path?
You can check the critical path by applying the Tracking Gantt view. This 
view highlights the critical path in red by default.
h` If a schedule is extended when the workloads are leveled, a resource-

critical path needs to be identified. Resource-critical tasks need to be 
marked manually.

h` The (Resource) critical path can only consist of detail tasks and 
milestones. It should not contain level of effort tasks (overhead tasks 
or recurring tasks) or summary tasks (since the logic and the resources 
should be kept on the detail tasks).

hh Does the (resource) critical path provide a complete explanation for the 
project duration?
You can check the completeness by displaying the (resource) critical path 
and checking for gaps. Normally, there should be no gaps and every business 
day should have at least one critical task (unless there are lags on critical 

8 This filter can be found in the file IIL Project 2013 Tools.mpp available for download at www.jrosspub.com. 
Click the link WAV Download Resource Center to enter the download site.

Optimizing Time
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dependencies). If you find gaps, the (resource) critical path is fragmented, 
and the tasks that are most critical need to be identified in the schedule. 

In each of the optimization techniques, there is a need to analyze the impact 
of changes each time you attempt to compress the schedule. In presenting this 
material, we have suggested that you insert the project summary line (line 0) or 
use the Project Statistics tool to see the overall impact on the project. Project 
2013 also offers three tools to assist you with viewing impacts at the task level.

Out of the box, Project 2013 comes with 20 levels of undo. You can increased 
this up to 99 levels: on the File tab, click on Options, Advanced. Under the 
General section, change the Undo levels: to the desired number.

Having the ability to perform multiple levels of undo permits you to try out 
several different scenarios and “back out” of each one. You can try one set of 
changes and see the impact. If the impact is not what you were looking for, 
simply back out using the Undo toolbar button or use the drop-down-arrow to 
the right of the button to select the point you want to roll back to.

When you make a change to a cell within Project 2013’s tables, for example the 
Entry Table, Project 2013 will highlight all of the cells impacted by this change. 
This provides you with a great way to measure all of the impact to your schedule, 
not just the high-level overview. This feature can be customized through the 
Gantt Chart view, on the Format tab, in the Format group, click Text Styles. 
Under Item to Change select Changed Cells. Pick a background color to 
indicate the cells that have changed. 

Having the ability to highlight the Gantt bars, identifying the tasks affected by 
each other through logical dependencies just with a click can save you a lot of 
time with the new task path feature. Gantt Chart, on the Format tab, in the 
Bar Styles group, click the Task Path downward button and select the desired 
highlight.

The Task Path feature does not substitute the critical path calculation but it is 
of great help to assist you in understanding the logical dependencies that tasks 
have on the overall schedule (refer to Chapter 5 for more information related to 
Task Path).

During the discussion of Optimizing for Resources, we emphasized the 
importance of being able to determine the true driver of a task when identifying 
the resource critical path. We focused our discussion on logical dependencies 
and resource dependencies. Project 2013 provides a tool for helping identify 
the drivers of a particular task. On the Task tab, in the Tasks group, click on the 
Inspect down-arrow, Inspect Task to display the Task Inspector side pane on 
the left of the screen. 

Tools to Assist 
with Analyzing 
the Impact of 
Changes

Multiple  
Levels of  
Undo

Change 
Highlighting

Task Path

Task Inspector
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The Task Inspector side pane will indicate what is driving a particular task to 
start on a given date. Factors affecting the start of tasks include:
hh Over-allocations and Repair Options
hh Manual or Auto Scheduling Options
hh Predecessor tasks
hh Project, task, and resource calendars
hh Lags and leads
hh Constraints
hh Leveling delays

Since the driving force on any task could be a combination of these items, you 
will need to analyze the information to determine which of these is the primary 
driving force.

Create an RCP to focus on both critical tasks and resource limits by marking 
the appropriate tasks and, if desired, formatting the chart to display the resource 
critical tasks.
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1. We described three optimization approaches in this chapter: optimizing 
for time; optimizing for time and cost; and optimizing for time, cost, and 
resources.
a. What are the main differences between these approaches?
b. Describe the situations in which you should apply each.
c. What are the common techniques used in each approach?

2. Total slack is:
a. The amount of time a task can move freely without affecting its 

successors.
b. The difference between the Late Finish date and Early Finish date of 

the task.
c. The amount of time in which the resource has to complete the task.
d. The difference between the Early Start of the earliest successor and the 

Early Finish date of the task.

3. You receive a schedule and notice that the project finish milestone has a 
negative Total Slack of ten days. In your own words, what does this mean?

4. There are six possible causes for fragmentation of the critical path; list four 
of them.

5. When optimizing for time:
a. What are the six process steps for shortening the critical path?
b. What are at least six of the nine possible methods to shorten the critical 

path?

6. One of your team leaders suggests that the duration of one of her critical 
tasks could be decreased if you provide her with more people to do the 
work. What factors should you consider?

7. What methods are available to decrease the cost of a project? Give at least 
four of the eight methods discussed.

8. If you have Project 2013 level the workloads in your schedule, would the 
project duration be longer or shorter than if you leveled the workloads 
yourself? Why?

9. There are many ways to level workloads manually. Name at least eight.

10. In your own words, how does Project 2013 leveling affect the calculation 
and the display of the critical path?

11. We discussed five reasons why finding the resource-critical path might be a 
good idea. Name three.

12. There are 15 methods with which you can shorten the resource-critical 
path. Name as many as you can.

Review 
Questions
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13. A project is experiencing a lack of progress during execution.
a. How would you determine which resources you should ask to work 

overtime in order to make up the slippage? They will not be paid a 
higher rate for overtime.

b. What Ribbon items do you need to choose and what mouse-clicks do 
you need to make to enter overtime into Project 2013?

14. One way a project manager can identify task drivers is to “walk” backwards 
through the schedule identifying the logical dependencies or the resource 
dependencies. Project 2013 provides what tools that can assist with this? 
What are the advantages of these tools?

For experience working with the features you’ve learned about in this chapter, 
we strongly suggest that you do the additional exercises for this chapter that 
are included in the Case Studies appendix, available to download in the WAV 
Download Resource Center at www.jrosspub.com.

Additional Practice
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Chapter 10: Updating the Schedule

In the previous chapter on Optimizing, we compressed our schedule to make 
sure it was on track to meet project deadlines. In this chapter, we’ll explore what 
you need to do after you have the go-ahead and can start executing the work on 
the project.

After reading this chapter you will be able to:

hh Prepare your schedule for updating
hh Set and maintain the baseline
hh Determine whether to update your schedule by updating tasks or by 

updating assignments
hh Update on the task level using actual start and finish, or actual and remaining 

duration
hh Update on the assignment level using actual work in the timescale grid
hh Handle the wide variety of update situations that occur in practice
hh Communicate the status and the forecasts of your project
hh Check whether your schedule is updated properly using scheduling best 

practices
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You update a project schedule to record both what has happened in the past (the 
actuals) and what you forecast for the future of the project.

Executing a project is often a more chaotic experience than anticipated in the 
project plan:
hh Progress can run behind on some tasks and ahead on others
hh When a critical task slips, corrections to the schedule have to be made in 

order to meet the deadline
hh Unexpected expenses or sudden budget cuts may have to be compensated 

for
hh Tasks are completed out of sequence (e.g., team members work on tasks in 

the order they prefer)
hh Deliverables or external dependencies may become delayed
hh People fall sick

The basic process steps for updating a schedule are:
hh Baseline the schedule: set it once for the entire schedule and maintain its 

integrity.
hh Choose the client reporting period.
hh Choose the update method.

h` Tasks update: collect progress information on the task level. This 
requires less effort than updating assignments.

I guess he didn’t get the update 
about this year’s party.
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h` Assignments update: collect actual hours worked, by day, by resource. 
When you update assignments, you work with time sheets.

hh Update the schedule: enter the actual values and remaining estimates. This 
is discussed separately for each update strategy.

hh Check to make sure the schedule has been updated correctly.
hh Prepare status and forecast reports. You may need to re-optimize your 

schedule before reporting.

The baseline is a frozen copy of the final approved schedule. It is the target to 
aim for. As much as possible, the baseline should remain the same throughout 
the project.

Make sure you set the baseline after you have replaced any generic resources 
with real people. From a workload point of view you can’t perform a feasibility 
check on your schedule until you have real people assigned.

In the illustration, you can 
see that each task bar is split 
into two parts. The top part 
is the current schedule—the 
dynamic model of the project. 
The bottom part is the static 
baseline you compare to the 
current schedule. If you display 
the status date as a line in the 
timescale, you have all you need 
to visually assess the status of a 
project.

1. On the View tab, in the Task Views group, click on the Gantt Chart down-
arrow and select Tracking Gantt. The Tracking Gantt displays two task bars 
for each task: the current schedule at the top and the baseline schedule (if 
present) at the bottom.

2. On the View tab, in the Data group, click on Tables, and then select More 
Tables.

3. Make sure the Task radio button is selected at the top of the dialog box, then 
choose the table Baseline in the list. 

The Baseline

Now

Schedule
Baseline

Viewing the 
Baseline
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4. Click Apply.

The fields in the baseline date columns show NA when the baseline has not yet 
been set for the tasks.

1. On the Project tab, in the Schedule group, click Set Baseline, then select 
Set Baseline.

2. Select Set Baseline and from the drop-down menu, choose Baseline.

3. To set the baseline for all tasks, select Entire Project.

4. Click OK; the original schedule is copied to the Baseline fields for 
comparison

Setting the First 
Baseline
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hh Baseline Fields
When you save a baseline, you save fourteen specific fields for tasks as we 
show in the following table below. This is done each time a new baseline is 
set.

Field Copy to Baseline Field
Budget Cost Baseline Budget Cost
Budget Work Baseline Budget Work
Cost Baseline Cost
Deliverable Finish Baseline Deliverable Finish (Project Server 2013)
Deliverable Start Baseline Deliverable Start (Project Server 2013)
Duration Baseline Duration
Scheduled Duration Baseline Estimated Duration
Scheduled Finish Baseline Estimated Finish
Scheduled Start Baseline Estimated Start
Finish Baseline Finish
Fixed Cost Baseline Fixed Cost
Fixed Cost Accrual Baseline Fixed Cost Accrual
Start Baseline Start
Work Baseline Work

The resource and assignment fields also have baseline fields that are copied 
when you set the baseline. 
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Resource Baseline Fields:

Field Copy to Baseline Field
Budget Cost Baseline Budget Cost 
Budget Work Baseline Budget Work
Cost Baseline Cost
Finish Baseline Finish
Start Baseline Start
Work Baseline Work

Assignment Baseline Fields:

Field Copy to Baseline Field
Budget Cost Baseline Budget Cost 
Budget Work Baseline Budget Work
Cost Baseline Cost
Finish Baseline Finish
Start Baseline Start
Work Baseline Cost
Cumulative Work Baseline Cumulative Work
Remaining Cumulative Work Baseline Remaining Cumulative Work
Remaining Tasks Baseline Remaining Tasks

As you see, a baseline is not a complete version of the schedule; many task-
related fields are not captured in baseline fields. Don’t use baselines if what 
you really need is a complete version of the schedule.

After you have final approval of the schedule and before you begin work, 
set the baseline. Even if it is only a temporary baseline and you plan to set a 
final baseline later, this gives you the option to compare plan against actuals 
early in the project.

After you baseline, check to see if your baseline is complete and includes 
values for all the baseline fields. You can check this by using the IIL filter 
called 11 IIL Tasks with missing baseline info.1

hh Additional Baselines
Sometimes you want to save additional baselines, for example, after specific 
phases, time frames, or major scope changes. As we’ll see later in this 
chapter, you can save up to eleven different baselines in Project 2013, which 

1 This filter can be found in the file IIL Project 2013 Tools.mpp available for download at www.jrosspub.com. 
Click the link WAV Download Resource Center to enter the download site.
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can be helpful in comparing variances between baselines and the schedule 
at different points in time. 

Project 2013 captures the date of each baseline in the name of the baseline. 
To see the date on which you set the baseline, on the Project tab, in the 
Schedule group, click Set Baseline.

Save a duplicate copy of your baseline in an empty additional baseline field 
to prevent losing the original baseline as explained later in this chapter. 
Immediately after you baseline, baseline again into one of the numbered 
baseline fields. This will set the correct date in both baselines. Record 
information on baselines in Notes on the project summary task.

In Project 2013 you can instantly view specific baselines that you captured 
in your schedule. On the Format tab, Bar Styles group, click on Baseline, 
and select the captured baseline in the drop-down menu that you would 
like to view.

hh Interim Plans
There are also ten interim plans (Start1/Finish1 through Start10/Finish10), 
which are extra sets of the scheduled Start and Finish date fields. In each 
of these you can store a set of start and finish dates you would like to keep.

You can copy a set into any other set at any time, even back into the current 
schedule (Scheduled Start/Finish). However, we don’t recommend this 
because it affects the Duration and Work numbers. Be aware that unlike 
the baselines, the interim plans only contain the start and finish dates, and 
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hold no duration, work, or cost data. The interim plans are useful for a quick 
comparison before and after a series of changes.

Use interim plans to see the effects of a series of changes, focusing on Start 
1 and Finish 1. Make sure you are not using these fields for other functions.

The baseline is essentially a contract between the project manager and the 
sponsor or client of the project. You normally set the baseline only once, unless 
one of the following occurs.

hh There are formal changes approved after the baseline has been set. These 
changes could be:
h` Scope changes that entail adding or removing deliverables
h` Substantial additions or deletions of tasks
h` Substantial additions or losses of resources
h` Substantial changes in resource rates or fixed cost
h` Substantial changes in cost resources
h` Substantial changes in budget cost and/or budget work
h` Substantial changes in fixed cost accruals
h` Substantial changes in the duration, start, or finish

hh Other changes are approved or imposed that force you to re-think and 
re-baseline your schedule, like budget increases, changes of deadline, or 
availability of crucial resources.

hh If errors in the schedule turn up unexpectedly, you would need to get formal 
approval to re-baseline the affected tasks.

hh There might be exceptional circumstances such as a fire, strike, or sudden 
economic recession.

hh Acts of nature (e.g., a hurricane) may also affect your schedule. Even if these 
happen elsewhere, shipments for your project could be affected.

Only change or re-save the baseline when you receive formally approved 
changes. This is subject to each company’s policies, so it is important to establish 
an approved baseline procedure for projects within your company.

If you acquire approval, you should re-baseline only those tasks that are affected. 
These are, of course, the tasks that are new and inserted, but don’t forget their 
dependent successor tasks. You should initially be able to use the Change 
Highlighting feature to see which tasks may need to be re-baselined as a result of 
a previous change.

It’s not a good idea to reset the baseline often, because comparing to a baseline 
that moves constantly is not meaningful. Your project becomes a heat-seeking 
missile trying to catch up with a constantly moving target. Treat the baseline 
as a contractual agreement, even if it wasn’t formalized with signatures. Insist 

Maintaining  
the Baseline
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that changes are brought forward through formal change requests. Incorporate 
changes only after they are formally approved. Pay attention to creating a clear 
and smooth change request process and communicating it to your stakeholders.

If you baseline the entire schedule for a second time in the same way you 
did originally, you overwrite all the values in the baseline fields shown in the 
preceding tables and the date on which the baseline was set. You may lose 
valuable (contractual) information if you do this inadvertently.

There is a way to preserve baselines. Project 2013 has fields for ten extra baselines 
(Baseline1 through Baseline10), and you can copy any of these baselines back 
into the active Baseline fields and between each other. This allows you to compare 
against any of your ten “steady states.” Before you copy another baseline back 
into the baseline fields, make sure you save your most current baseline in the 
next available set of baseline fields and you document what each baseline set is 
for.

If you plan on using Earned Value this may be of particular importance. The 
Earned Value calculations can be based on any of these eleven baselines. On the 
File tab, in the Backstage view, click on Options, Advanced. In the Earned 
Value Options for this Project section, choose the current project or All New 
Projects in the drop-down, and then select the baseline that you want Project 
2013 to point to from the list Baseline for Earned Value calculation. By 
default, Project 2013 points to Baseline, without any number after it. Please see 
Chapter 12 for more information on Earned Value Management (EVM).

Here are the steps for changing the baseline:

1. To set the current baseline first, on the Project tab, in the Schedule group, 
click Set Baseline, and then select Set Baseline from the drop-down. The 
Set Baseline dialog appears.

It’s a good idea to set a baseline into baseline (#) each time you baseline and 
re-baseline your schedule. This means you save two baselines each time you 
baseline (or re-baseline), but the advantage is that you will have the proper 
data stored and available for analysis and rollbacks. All of the baseline fields 
without a number (1 through 10) reflect the current baseline and are used 
in default variance calculations.

2. Select Set interim plan.

3. Under Copy select the current Baseline and under Into select the next 
available set of baseline fields. 

The first time you revise your baseline this would be Baseline1. In that case, 
the dialog should now look like this: 

Changing  
the Baseline in  
Project 2013
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4. Click OK; the date on which you copied the baseline is captured in the name 
of the baseline in the list. This will help you manage multiple baselines.

5. Now you can revise the current baseline. Select the tasks affected by the 
change request in the Gantt spreadsheet. These can be:
h` Newly inserted deliverables or tasks and any other tasks that are 

dependent on the new ones that may have shifted
h` Successor tasks affected by canceled deliverables or tasks

6. On the Project tab, in the Schedule group, click Set Baseline, and then 
select Set Baseline from the drop-down. The Set Baseline dialog appears 
again.

7. Select the option For: Selected tasks.

8. Under Roll up baselines, check:
h` To all summary tasks to update baseline information on all the higher-

level summary tasks of the detail tasks selected.
h` From subtasks into selected summary task(s) to update only the 

summary tasks that you selected. If you had not selected the specific 
summary tasks in step 1 and want to use this option, cancel the dialog, 
include those summary tasks in your selection as well, and start at step 
5 again.
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9. Click OK.

In Project 2013, you can inactivate a task but still keep a record of it in the project 
schedule. When you inactivate a task, the inactive task does not affect resource 
availability, how the project is scheduled, or the timing and/or sequence of how 
the other tasks are scheduled, but it still remains in the project plan. You can also 
reactivate the task if you need to.

Why would you want to inactivate a task? You may have tasks in your project 
plan that are no longer used or one that no one devotes time to anymore. Or you 
may want to analyze the effects of a constraint on a project without deleting the 
task permanently. 

We recommend that you inactivate tasks that are not used anymore rather than 
deleting them. Once you baseline your schedule, you should not delete a task. 
Deleting tasks after baselining affects baseline integrity and destroys project 
history.

Inactivating a task is not a good way to archive completed tasks in your project 
schedule and this technique could have negative effects on the remaining 
schedule. We recommend that you leave these tasks as completed, instead of 
inactivating them.

To make a task inactive, select it and then on the Task tab, in the Schedule 
group, select Inactivate.

Inactive Tasks
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Choosing the Inactivate button will:
hh Change the font color of the task text
hh Change the appearance of the bar style
hh Change the work and cost to zero
hh Add a strike-through line through the task name

In addition:
hh Predecessor and successor dependencies will still be present but will not be 

taken into account for the calculation of dates, slacks, etc.
hh If you re-activate a task, all dependencies will again be considered in the 

calculations.

If an inactivated task has dependent successor task(s), the dependency may 
appear to be intact, but it is not. Inactivating a task will remove the dependency 
from the schedule logic. It is important to reconnect the predecessor of the 
inactivated task to other successors in your schedule.

You should consider submitting change requests to re-baseline your changes.

If there is no formal change request, you have to be careful with deleting tasks that 
you don’t need any longer, particularly when you do Earned Value performance 
reporting. If you simply delete these tasks, you compromise the integrity of the 
baseline, because it decreases the total baseline work and baseline cost on the 
summary tasks the next time you change the baseline and roll up to the summary 
tasks. See also EVM Special Cases in Chapter 12.

Establish an approved clearing or deleting baseline procedure within your 
company.

Updates of your schedule should be synchronized with your client reporting 
period. As we discussed in Chapter 3, ten reporting periods can be used as a 
guideline for providing your client with enough information to allow for 
corrective action. Of course your sponsor, client or project management office 
(PMO) may request a specific reporting cycle.

The Client 
Reporting 
Period
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You don’t want more reporting periods than you need, because each progress 
report takes time and effort to prepare and adds to the overhead cost of managing 
the project. Overhead can run up to 25% of the total cost of projects, which can 
be a lot of money. 

What does this mean for our projects? Here are guidelines you can use for 
projects of different durations.

Project 
Duration

Minimum Client 
Reporting Frequency

Maximum Client 
Reporting Frequency

1 month every other business day every business day

3 months weekly twice a week

1 year monthly every week 

2 years every two months every month

5 years every half year every two months

As the project manager you should ask your team to report status back to you 
at least as frequently as the client needs reports. Sometimes, team members can 
report more frequently to you as the project manager than you report to the 
client.

Project progress can be seen best in the Tracking Gantt view. This view displays 
the task bars as shown in the illustration. The scheduled task will fill in with solid 
dark blue in Project 2013 to 
indicate how much progress has 
been made (Actual). Notice 
that the actual duration 
represents the number of days a 
team member has worked on 
the task to date, even though 
people tend to think of it only as 
the number of days the task 
took when completed.

Ideally, the actual duration runs up to the status date, indicating that the task is 
progressing as scheduled. In the illustration, you can see that the progress has 
fallen behind. The rest of the bar, Remaining (in light blue in Project 2013), 
represents the Remaining Duration—the time remaining before the task will 
be completed. 

Showing 
Progress

1 3 42

Status Date

Actual Remaining

Baseline

Graphically – 
Tracking Gantt 
View
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Project 2013 uses the following formula: 
Actual Duration + Remaining Duration = Duration

You can see that the duration is often recalculated through this formula when 
you update the schedule, which causes deviations from the baseline duration.

The Baseline allows us to analyze slippages. In the illustration, where the 
timescale indicates weeks, you can see that:

hh The task started 0.5 week later (Actual Start) than scheduled (Baseline 
Start).

hh The task duration was already revised from 2.5 (Baseline Duration) to 3.5 
weeks (current Duration); this is a 1-week difference.

hh The progress is still behind; the task is also progressing 0.5 week slower, 
because the Actual Duration (progress) is 0.5 week behind the status date. 
This 0.5 week of work to be done should be rescheduled to the future. It 
is likely the slippage will further increase, since progress was slower than 
expected in the last update period, and the remaining duration may need to 
be increased again.

You can express progress in terms of the duration progress at the task level. As 
long as you keep revising the Remaining Duration with your latest estimates, the 
total Duration will be recalculated and Project 2013 will calculate the % 
Complete. 

The % Complete in the illustrated formula is a calculated indicator of progress 
on tasks. If you want, you can even have Project 2013 calculate and enter time 

sheet information based on 
Actual Durations entered. 

Alternatively, you can collect 
time sheets and enter the 
actual hours worked on the 
level of assignments from the 
time sheets. If you revise the 
Remaining Work, the total 

work will be recalculated. The formula is similar to the one for durations: Actual 
Work + Remaining Work = Work. Project 2013 will then calculate the % Work 
Complete, which will also be a useful progress indicator. With this information, 
Project 2013 can also calculate the Actual Duration and Remaining Duration on 
the task level, and update the tasks accordingly.

Mathematically

% Complete =
Actual Duration

Duration

% Work Complete =
Actual Work

Work
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There are two different strategies for updating your schedule: you can update 
tasks or update assignments. An assignment is always a combination of a task 
and a resource, as discussed in Chapter 8. Assignments are on a more detailed 
level than tasks, since one task can have multiple assignments if there are multiple 
resources assigned.

hh Updating tasks means updating these fields for each task in the following 
order:
h` Actual Start
h` Actual Duration
h` Remaining Duration (if the task is in progress)
h` Actual Finish (if the task is already finished)

hh When you update assignments with time sheet information, you typically 
update for every assignment of a resource:
h` Actual hours by day or by week in the timescale field Actual Work. 

(Note that there is also an assignment-related field Actual Work in 
the spreadsheet that is the total of all the timescale entries; we are not 
referring to that field here.)

h` Remaining hours by assignment in the field Remaining Work in the 
spreadsheet.

The illustration summarizes the two ways of updating the schedule. If you update 
tasks, Project 2013 can update the assignments for you. If you update the 

assignments from the time 
sheets, Project 2013 can update 
the tasks. Project 2013 will do 
this for you if you select this 
option on the File tab, in the 
Backstage View, click on 
Options, Schedule. Under the 
Calculation options for this 
project: section, check 
Updating task status updates 
resource status.

Updating 
Strategies

Actual Start
Actual Duration
Remaining Duration
Actual Finish

Actual Hours
Remaining Hours

By Resource
By Day or Week
By AssignmentBy Task

You 
Update 
Tasks

Assignments
Updated

by Project

Tasks
Updated

by Project

You
Update

Assignments
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Updating tasks is quick and easy: you only have to enter actual dates and 
durations, and in most cases, you can do that with the mouse. Since you only 
specify the Actual Start date and not all the dates on which the work took place, 
Project 2013 proportionally spreads the actual hours in the timescale. This 
makes this method less precise than entering actual hours worked from time 
sheets when you update assignments, but in many situations it is precise enough. 

Updating assignments requires more numbers to process and therefore more 
work during project execution. For example, if you have a schedule with 300 
tasks and 10 weekly reporting periods, every week you may have to update an 
average of 30 tasks, 20 of which may have been completed in that week.

In the previous example, if you do a task update:
hh For the 20 completed tasks, you’d collect actual start and actual finish, 

but if you are not interested in exact dates, you would only have 20 actual 
durations.

hh For the 10 tasks in progress, you’d collect actual start, actual duration, 
and remaining duration. If you are not interested in exact dates, you could 
make do with 20 pieces of information (10 actual durations, 10 remaining 
durations). 

The grand total for updating tasks therefore is 20 + 20 = 40 pieces of data 
(recommended).

For an assignment update, we’ll have to make more assumptions. Let’s assume 
that the average task duration is four days and the average number of resources 
per task is 1.5:
hh For the 20 completed tasks: 20 tasks * 4 days * 1.5 resources = 120 pieces 

of data
hh For the 10 tasks in progress: 10 tasks * 4 days * 1.5 resources = 60 pieces of 

data

The grand total for updating assignments is: 120 + 60 = 180 pieces of data.

As you can see, if you update assignments instead of tasks, you’ll be processing 
roughly two to four times as much data during the project execution phase when 
you are very busy. If you don’t have an electronic time sheet system in place, we 
recommend you do task updates instead of assignment updates. 

We’ve seen too many project managers stop updating their schedules during 
project execution because they either fail to get the information needed from 
team members or they drown in the flood of data and/or errors. If you abandon 
updating your schedule, you lose the model that provides you with up-to-date 
forecasts and allows you to do what-if scenarios to determine the best course of 
action. You lose your grip on the project. It is better to have a less precise grip 
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than no grip. We recommend that you consider carefully which update strategy 
best fits your situation.

Let’s move on to a detailed discussion of updating tasks.

Here are the things you need to do when updating tasks:

hh Collect the update information by task
hh Choose the Options. On the File tab, in the Backstage View, click on 

Options. 
hh Prepare the view:

h` Change the view to Tracking Gantt
h` Apply the Tracking table
h` On the Task tab, Schedule group, you will find icons for Tracking.

hh Set the Status Date for updating 
hh Set the task Type of the tasks you will update to Fixed Units (we recommend 

this, but it’s up to you which variable you want to control)
hh Enter the update information 
hh Check whether the schedule is updated correctly 
hh Prepare the status and forecast report. You may need to re-optimize your 

schedule before reporting on it

When you update tasks, it’s helpful to be aware of the formulas shown in the 
illustration. They explain the 
values that Project 2013 
calculates when we enter 
actuals. Notice that Actual 
Duration is not only the number 
of days that you worked on a 
task after it is done. While the 
task is in progress, Actual 
Duration is the number of days that you have worked on it up until the status 
date. Remaining Duration is the forecast of how many additional days a task will 
take from the status date forward to completion.

When you update tasks, you enter the Actual Duration and can allow Project 
2013 to calculate the Remaining Duration and the % Complete using the 
formulas shown in the illustration.

Once resources start working on a task, they can often make much better 
estimates about how long it will take. If you find that the remaining duration 
calculated by Project 2013 is too short or too long, you should update the 
Remaining Duration field with a more precise estimate. Project 2013 will then 
recalculate the total Duration (Actual plus Remaining) and decrease or increase 
the % Complete accordingly.

Updating Tasks

What Data to 
Collect?

Actual Duration + Remaining Duration = Duration

Actual Duration / Duration = % Complete 
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If you want to enter % Complete instead of the Actual Duration, it will be a 
longer, two-step process that follows the formulas in the illustration on the left. 

You can see that it is more 
complicated. First you enter the 
% Complete (step 1 in 
illustration), but when you 
revise the Remaining Duration 
(step 2), Project 2013 
recalculates the % Complete 
you first entered. You may not 
like that. Why enter a number 

that will change in most cases?

More importantly, you have to ask yourself what it means if a team member tells 
you “I am at 90% complete.” Does it mean:
hh I’m almost finished! (this is what we would like it to mean, of course)
hh I have spent 90% of the time I was supposed to spend on this task
hh I have just figured out how to do this, and now I will do it
hh I did all the easy stuff, now I will start the difficult stuff!
hh Last week it was 80% complete, so this week it must be 90%
hh I want the project manager to think that I am at 90% complete!
hh Leave me alone, so I can do my work; I am busy enough!
hh I have started to work on the task!

We ask groups of project managers what they have found 90% complete means, 
and inevitably they indicate that 90% complete can mean any of the above! We 
therefore recommend you ask for Actual Start, Actual Duration, and Remaining 
Duration instead of % Complete when collecting update information; ask for 
facts rather than fiction. Using % Complete is less objective than entering the 
actual number of business days that people worked on a task (Actual Duration). 
The number of days somebody really worked on a task can easily be counted and 
is factual information.

If you choose to enter % Complete instead of having it calculated by Project 
2013, we recommend that you:

hh Still ask for Remaining Duration updates, since they will keep your forecasts 
accurate. If you only enter % Complete your forecasts will be inaccurate.

hh Allow fairly rough increments in % Complete only. We suggest increments 
such as 0%, 25%, 50%, 75%, 100% as shown on the Tracking tool icons on 
the Ribbon. To use these, go to the Task tab, Schedule group, and view the 
Tracking tool icons. You may want to only allow 0% and 100%. In this case, 
you can simply ask: Are you finished or not? This question does not leave 
much room for wishful thinking (or outright manipulation). However, you 

% Complete * Duration  =  Actual Duration

Duration - Actual Duration = Remaining Duration

Actual Duration + Remaining Duration = Duration

Actual Duration / Duration = % Complete 

1.

2.

Updating % 
Complete?
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need to have a fairly detailed schedule in order to get good results with 
rough percentages. The durations of the detail tasks should be nearer to 1% 
than 10% in the 1% – 10% rule. If you create tasks that are small enough, you 
can get to the facts more easily.

hh Consider the Options that will influence how Project 2013 will spread the 
actual hours worked when entering % Complete. On the File tab, in the 
Backstage view, click on Options, Advanced; the main options are:

h` Move end of completed parts after status date back to status date 
which moves the actual hours worked to before the status date.

h` Move start of remaining parts before status date forward to status 
date which moves the remaining durations to after the status date.

h` Edits to total task % complete will be spread to the status date. If 
you change a % complete, Project 2013 can calculate the actual progress 
and spread it out to the status date when this option is on. When it is 
off, the actual progress will be entered where it was scheduled or from 
the Actual Start date onward to the actual duration of the task.

Since we don’t recommend it, we won’t discuss updating with % Complete 
any further and will instead explain how to update with Actual Duration and 
Remaining Duration in more detail.

You need to collect the following information for task updates from your team 
members. We recommend that you use the following questions:

hh On what date did you start working on the task? (Actual Start)
This question is only needed if accuracy of actual dates is important.

hh How many business days have you worked on the task as of the status date?  
(Actual Duration)

hh How many business days will you still need to finish the task after the status date? 
(Remaining Duration) You need to ask this question only for tasks that are 
currently in progress.

Collecting Data
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hh On what date was the task finished? (Actual Finish)
This question is often not needed if you kept the remaining durations up to 
date in previous updates.

If you don’t want to collect and enter this much information, we recommend 
you choose Remaining Duration as the absolute minimum. If you only keep the 
remaining duration estimates up-to-date and schedule them after the status date, 
the forecasts will be valid. The next thing to add to the mix would be the Actual 
Duration.

Instead of collecting Actual Duration and Remaining Duration, you can also 
collect Actual Work and Remaining Work on the task level. If most of your tasks 
are based on effort (Work), this may make even more sense. You enter your data 
into the fields Actual Work and Remaining Work, of course.

There are two common ways to collect data for task updates:

hh Regular status meetings:
In a short meeting (one hour at most), you can quickly ask each team 
member for this information. You then enter it, or have it entered. Some 
project managers have it entered immediately during the status meeting and 
display the schedule on a large screen to reveal new schedule conflicts that 
can be discussed and resolved right away.

hh To-do list turn-around reports:
You can distribute to each team member to-do lists that also contain empty 
fill-in fields for the status information. Ask the team members to enter the 
status information and return it to you by the end of the week, at which 
time they’ll get the next to-do list. If you report weekly, create a to-do list 
that covers two weeks ahead to show what is coming up, and to allow the 
resource to make progress ahead of schedule. Note that such a list is not as 
detailed as a time sheet.

On the File tab, in the Backstage view, click on Options. Here are the options 
we recommend for updating tasks using Actual and Remaining Duration:

For each option, you’ll need to select either the name of the project you want 
the changes applied to or All New Projects for any new schedules you want to 
create. If you choose All New Projects, the existing schedules are not affected, 
because these options are stored in the project schedule.

Updating Tasks 
with Actual and  
Remaining 
Duration
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Project 
Options

Recommended Choices

Advanced Set the Calculation Options on the Advanced tab:
In the Calculation options for this project, select either <schedule 
name of the project> in the drop-down or All New Projects. 

Move end of completed parts after status date back to status date 
This moves the actual duration bar to before the status date. Actual 
work done is moved into the past. We recommend you turn this on. 
And move start of remaining parts back to status date The 
remaining duration bar will cuddle up to the status date (unless there 
are dependencies that keep it where it is). You can turn this off.

Move start of remaining parts before status date forward to status 
date This moves the remaining duration bar to after the status date. 
Work still to be completed is moved to the future. We recommend 
you turn this on.
And move end of completed parts forward to status date This 
moves the actual duration bar to cuddle up to the status date. You can 
turn this off.

Edits to total task % complete will be spread to the status date 
Clear the checkmark. When selected, the progress entered will be 
evenly spread to the status date. When not selected, the progress 
entered will spread to the end of actual duration task. This option is 
only relevant if you enter % Complete.

Advanced Set the General Options on the Advanced tab:
In the General options for this project, select either <schedule 
name of the project> in the drop-down or All New Projects.

Automatically add new resources and tasks
Clear checkmark to prevent a typo in a resource name from 
accidentally adding a new resource. Works similarly for tasks.

Allow cell drag and drop
Clear checkmark to prevent accidentally dragging data on top of 
other data in your baselined schedule.

Schedule Set the Scheduling Options on the Schedule tab:
In the Scheduling options for this project, select either <schedule 
name of the project> in the drop-down or All New Projects. 

Split in-progress tasks
Keeping checked allows moving the uncompleted portion of a task 
to after the Status Date by splitting the task bar. With this option 
cleared, the options on the Calculation tab cannot split any task bars 
and will behave quite differently as a result. 
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Project 
Options

Recommended Choices

In the Calculation options for this project, select either <schedule 
name of the project> in the drop-down or All New Projects.

Updating task status updates resource status

Updating the tasks will update the actual work of the assignments. 
We recommend you keep this option checked for task updates. Only 
clear it if you want to update the tasks and the assignments separately.

Actual costs are always calculated by Project Updating the tasks 
will update the Actual Cost. It is up to you whether you want Project 
2013 to do that.

Notice that the Advanced and Schedule tabs options, (on the File tab, in the 
Backstage view, click on Options, then select Advanced or Schedule tabs), 
help to reschedule in-progress tasks, but they have no effect on tasks that have 
not started yet but should have started per the status date. These tasks may have 
to be rescheduled to after the status date to put them into the future where they 
belong, since work can only be done in the future. As you can see, these options 
help when updating the schedule, but do not guarantee that your schedule will 
be entirely up to date.

1. On the View tab, in the Task Views group, click on the Gantt Chart down-
arrow and select Tracking Gantt.
The current schedule is shown in the top half of the task bars (colored blue 
or red). The baseline is shown as the gray bottom half of the task bars (there 
is no gray bottom task bar if the project has not been baselined).

2. The Tracking table has all the fields in which to enter data for task updates. 
To apply it, on the View tab, in the Data group, click on Tables and select 
Tracking from the drop-down. The Tracking table looks like the following 
screenshot:

Prepare the View
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3. To select the Tracking tool icons, go to the Task tab, Schedule group.

The Tracking tool icons are the handy tools you’ll need for updating.

Always set the Status Date before each update, as Project 2013 uses this date in 
some key calculations.

1. On the Project tab, Properties group, click on Project Information, and 
set the Status Date. Or on the Project tab, Status group, click on Status 
Date and set the Status Date.

2. Change the Status Date to the date through which you want to update tasks 
and compare the schedule against the baseline.

3. The Status Date does not yet appear as a vertical line in the timescale. 
While in the Gantt Chart view, on the Format tab, Format group, select 
the Gridlines drop-down arrow, select Gridlines and select Status Date in 
the list as the line to change. Choose a dashed line in a bright color. 

 

4. Click OK; the Status Date line is now visible in the timescale, similar to this:

Set the  
Status Date

J. Ross Publishing; All Rights Reserved



474

Dynamic Scheduling® with Microsoft® Project 2013

Project 2013 uses the system date of your computer to continuously update 
the current date. When you open your schedule again tomorrow, you will find 
tomorrow’s date as the current date. The status date stays the same, since you last 
entered it, and will refresh your memory about when your last update took place. 
The line for the status date is displayed at the end of the day, whereas the line for 
the current date is displayed at the start of the day.

When you enter updated information into Project 2013, you trigger recalculations 
in the formula D * U = W (Duration * Units of resources assigned = Work). The 
task Type has to be set so that it triggers the recalculations you want from Project 
2013.

When we update tasks, we change the durations. Fixed duration is therefore 
not the right Type of task, because we are not controlling what Project 2013 
recalculates. When you extend task durations, you typically want to keep the 
resources that work on the task the same (units), and see the total work (effort) 
increase. The type Fixed Units is appropriate for that purpose. If you want the 
number of resource units to be recalculated when the duration changes, you 
could choose Fixed Work.

1. Click on any column heading in the Tracking Gantt spreadsheet to select 
all tasks. 

OR

Select just those tasks that need to be updated.

2. On the Task tab, Properties group, click Task Information on the Ribbon 
and the Multiple Task Information dialog appears (the Multiple Task 

Set the Task 
Type for Tasks to 
Update
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Information dialog appears because more than one task was selected). Click 
the Advanced tab; the dialog should now look like this:

3. Select from the list Task type the item Fixed Units. Changing the task 
type does not trigger a recalculation. Only a change in one variable in the 
formula: Duration * Units = Work will do that.

4. Clear Effort driven and click OK. Note that summary tasks continue to be 
Fixed Duration.

The following six situations are the basic ones you will come across (or 
combinations thereof) when updating tasks:
hh Tasks that Ran as Scheduled
hh Tasks that are Running as Scheduled
hh Tasks that are Running Behind
hh Tasks that Will Take Longer (or Shorter)
hh Tasks that Started Late (or Early)
hh Tasks that Finished Late (or Early)

You will encounter all of these situations, and there is a best way to update 
information for each of them. We will detail how-to steps for each situation.

If you know that your project is almost on schedule, a quick way of updating 
most of your schedule is by clicking on a column heading to select all the tasks 
and then clicking the Mark On Track icon on the Task tab, Schedule group on 
the Ribbon. This updates your entire project as if it is running exactly according 
to schedule. Now you can tweak the status of some tasks that are off schedule 
with the next steps.

J. Ross Publishing; All Rights Reserved



476

Dynamic Scheduling® with Microsoft® Project 2013

You simply need to mark these tasks as 100% complete.

1. In the Tracking Gantt view, select the tasks 
that were completed as scheduled by dragging 
or holding down Control and clicking on the 
tasks.

2. Click 100% Complete on the Task tab, 
Schedule group

OR

Enter 100% in the % Complete field of the 
tracking table.

OR

Click Mark On Track

In this case, you want to show actual progress up to the status date.

1. Select the tasks that are on schedule by 
dragging or by holding down Control and 
clicking on them.

2. Click Mark On Track on the Task tab, 
Tracking group; this updates all selected tasks 
as if they are exactly on schedule as of the 
status date.

Status 
Date

Last Status
Date

This situation requires more updating 
effort. You will need to capture the 
actual progress, but because the task is 
behind, you will also have to bring the 
incomplete portion of the task bar 
forward to after the status date. Lastly, 
you will have to review the forecast of 
the remaining duration. If the task is 
progressing slower than planned, it was 
underestimated and you may have to 

increase the remaining duration.

In the illustration, you can see that progress is falling behind, because the solid 
color of the actual progress does not run up to the status date in the task bar at 
the top. The bottom task bar has a split showing the incomplete portion of work 
rescheduled to after the status date

1. Enter the Actual Duration of the task (the number of days you have worked 
on the task); Project 2013 will calculate the new Remaining Duration and 

Tasks that Ran as 
Scheduled

Status Date

100%

Status Date

75%

Tasks that Are 
Running as 
Scheduled

Tasks That Are 
Running Behind
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% Complete. If you need, you can enter a new Remaining Duration (the 
number of business days still to go) and Project 2013 will calculate the new 
% Complete.

2. If there is remaining duration scheduled in the past, reschedule it in the 
future, after the status date. You can do this by dragging that part of the task 
bar.

OR

Select the task and click the Update Project icon (located on the Project 
tab, Status group, select Update Project). Then select the radio button 
Reschedule uncompleted work to start after: and select the date to 
reschedule the uncompleted work from the calendar drop-down. Then 
select for the Entire project or for Selected tasks. This will split the task 
bar if the option Split in-progress tasks is in effect (found on the File tab, 
in the Backstage view. Click on Options, and select the Schedule tab).

OR

You don’t need to do a thing if you checked Move start of remaining 
parts before status date forward to status date (on the File tab, in the 
Backstage view, Options, Advanced).

You have to move the remaining duration out to the future, so that the dependent 
successors will be rescheduled. If you forget this, you end up with a status report 
instead of a forecast report. A status report is like a report on yesterday’s weather 
instead of a forecast report on tomorrow’s.

You still have to ask yourself if the forecasted finish date is accurate. If you look at 
the rate of progress in the illustration, you will notice that it is more or less half 
of what it should be. Half of the work that should have been completed since the 
last status has been accomplished. If the interruptions or slow progress continue, 
the eventual duration will be double the baseline duration. You can see that 
currently the forecasted duration is less than double the baseline duration. The 
remaining duration should be increased even more if you expect the progress to 
continue at the same pace. Running behind now goes hand in hand with taking 
longer in the future.
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To check whether your schedule is updated correctly, make sure all completed 
work is before the status date and uncompleted work is after the status date. 
Reschedule uncompleted work into the future. 

Add a note to any task where progress is not going as planned to record the 
reasons why, as this provides good project documentation.

In this situation, good progress was made, but the realization sinks in that the 
remaining duration will not suffice. We need to increase the remaining estimate, 
or we may need to shorten it. (Hey, it happens!)

Since we are going to change the 
duration, you’ll trigger a recalculation 
through the formula D * U = W. You 
should not leave the task type set to 
Fixed Duration, since Project 2013 
might recalculate the units or the work. 
If you choose Fixed Units, the work will 
change. If you choose Fixed Work, the 
number of resources (units) working 
on the task will change.

1. If needed, set the Type of task to Fixed Units tasks (or Fixed Work).

2. Enter the Actual Duration of the task.

3. Revise the Remaining Duration. 

OR

Change the remaining duration with the mouse by pointing to the right 
side of its task bar. When you see the single-headed arrow mouse pointer, 
drag to change the remaining duration to compensate for the slippage. If 
you cannot get it on the right date, click Zoom In (on the View tab, Zoom 
group, click Zoom, and select Zoom In from the drop-down first).

4. You may have to use optimization methods to shorten your schedule to 
compensate for the slipped finish date.

In this situation, the task did not start 
when planned. The illustration shows 
that the top task started late, and the 
bottom task started early. If you updated 
your schedule regularly and if you had a 
dynamic schedule (with all dependencies 
and few constraints), the start date may 
have moved already to the right date. If 
that is not the case, you have to enter it.

Status Date

Longer

Shorter

Tasks That  
Will Take Longer 
or Shorter

Tasks That Started 
Late or Early

Status Date

Late

Early
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1. Point to the middle of the blue task bar, and when you see a four-headed 
arrow mouse pointer, drag the task bar to its new start date. If you cannot get 
it on the date you want, click Zoom In (on the View tab, Zoom group, click 
Zoom, and select Zoom In from the drop-down first).

OR

Enter the date in the field Act. Start of the Tracking table. 

OR

Select the task with a delayed start. Click Update Tasks, located on the 
Task tab, Schedule group, select the drop-down arrow on the Mark On 
Track icon, Update Tasks, then fill in the Actual Start date and click OK.

2. You may have to use optimization methods to shorten your schedule to 
compensate for the slipped finish date.

In this situation, you need to enter the finish dates. In the illustration, you can 
see that the top task finished late relative to the 
black baseline bar. The bottom task finished early. 
If you update your schedule regularly, however, 
you often don’t need to enter finish dates. When 
you revise the remaining duration, Project 2013 
changes the finish date to the right date, or close to 
it. If it still isn’t the right date, you can enter that 
date into the project schedule.

The steps are:

1. Point to the right side of the task’s blue task bar, and when you see a single-
headed arrow mouse pointer drag the finish to its new date. Set the task to 
100% complete.

OR

Enter the date in Act. Finish of the Tracking table. 

Tasks That 
Finished Late  
or Early

Status Date

Late

Early
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OR

Select the task with a slipped finish date, and on the Task tab, Schedule 
group, select the Mark On Track icon down-arrow, and choose Update 
Tasks. In the Update Tasks window, enter the Actual Finish date and click 
OK.

2. You may have to use optimization methods to shorten your schedule to 
compensate for the slipped finish date.

There are certain situations that seem more difficult to update than those we’ve 
discussed:

hh Combination of situations
For example, what to do with a task that started late, runs behind and will 
take longer?

hh Updating out of sequence
What if tasks have been done out of sequence? For example, a task is already 
in progress that is scheduled to start in the future.

hh New activities on the fly
What if you realize while working on a task that it actually consists of more 
tasks, or what if you decide to reassign resources?

We will discuss each situation in more detail.

No matter how complex your situation is, it is always a combination of the six 
situations we’ve already discussed.

For example, let’s say the situation on a two-day task on Aug. 26th at 5PM is:
hh The Actual Start date is Aug. 26th with a Baseline Start of Aug. 25th (Task 

started late)
hh The Remaining Duration is revised from one day to two days (Task running 

behind)

In a situation like this, we recommend you start with updating the Actual 
Start, then the Actual Duration, and the Remaining Duration last. Graphically 
speaking, you enter data going from left to right over the task bar. If you keep this 
in mind, you will never see unexpected results in Project 2013. It will help you if 
you put the columns in the right order.

The resource worked only Aug. 26th on the task; the Actual Duration is one day. 
The % Complete will be calculated at 50%. 

“My Reality Is 
More Complex…”

Combination of 
Situations
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When you enter the Remaining Duration, you trigger a recalculation of the % 
Complete and it will be 33%; you have completed one day of a three-day task 
that was a two-day task. 

Occasionally, you may need to show progress on a task that is scheduled in 
the future. But since normally a task can only start when its predecessors are 
finished the predecessors of the task may logically prevent you from moving the 
task earlier. If work has started on a future task, you need to show progress on 
it, regardless of the logic of the dependencies. This is known as out-of-sequence 
updating.

Updating out of sequence is simple, because actuals are stronger than any other 
scheduling feature in Project 2013. Entering actuals overrides the logic of the 
dependencies and even schedule constraints, so you can go ahead and update in 
the same way.

The option Split in-progress tasks (on the File tab, in the Backstage view, 
click on Options, Schedule) will affect the result in out-of-sequence situations 
assuming you’ve selected Move end of completed parts after status date 
back to status date (on the File tab, in the Backstage view, click on Options, 
Advanced):

hh If selected, the remaining duration stays where its dependencies hold the 
task. This is called retained logic.

hh If cleared, the remaining duration is scheduled to start on the status date, 
which pulls the successors back to the status date. This is called a logic 
override, or a progress override.

Make sure you check the final result, because in some cases you want to retain 
the logic and in other cases you want to override it.

During project execution, you often realize you omitted some tasks, or you may 
find better approaches for creating deliverables. Generally it is better to add new 
activities to show changes rather than to attempt to modify existing activities.

This is particularly true if you have already reported any progress on the activities. 
For example, if progress is lagging, you could decide to reassign a portion of a 
task to somebody else. In that case, you can make this clearer if you leave the 
baselined activities as they are and create a new activity for this extra resource. 
The new activities end up without a baseline and are clearly marked as new 
activities that are inserted on the fly to capture how the project really unfolded. 
In the case of contract disputes, you need to communicate clearly what the 

Updating Out of 
Sequence

New Activities  
on the Fly
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plan was and what happened in reality. Some experts go as far as capturing all 
impacts by creating new tasks. This technique is particularly useful for litigation 
when a contract dispute erupts, but it also allows you to learn from your project 
experience. 

You may need to manually schedule a task because you don’t have all the 
information about the task or you are using the rolling wave planning approach. 

If you have created a manually scheduled task, it will not be automatically 
adjusted from changes made to task dependencies or to the project calendar: 
a manually scheduled task will stay right where you put it in the schedule. You 
will need to keep it manually updated in your schedule. You will also need to 
review any direct dependencies to the manually scheduled task for accuracy in 
your logic.

As you can see in the screenshot below, the manually scheduled task has a 
different look in the Gantt Chart, shown with a teal Gantt bar color. If the auto-
scheduled tasks are updated and move out, the manually scheduled task stays 
put, but the teal Gantt bar now will contain a dotted line surrounding it. This 
signals that a scheduling conflict may be present.

If you hover over this bar, the Manual Task Warning dialog appears as shown 
below. If you right-click on this dotted bar, a mini-menu appears, giving you 
choices on how to resolve this possible conflict. You can Respect Links, Fix in 
Task Inspector, or Ignore Problems For This Task. 

Here are the things you need to do when updating assignments using time 
sheets: 
hh Choose the options: on the File tab, in the Backstage view, click on 

Options.
hh Prepare the view:

h` Change the view to Resource Usage, and customize it
h` Apply the table Work, and customize it

hh Set the Status Date for this update

Updating Manually 
Scheduled Tasks

Updating 
Assignments
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hh Set the task Type to Fixed Units for all tasks to be updated

When updating assignments, set ALL task types to Fixed Units.

hh Collect the data using time sheets.
For electronic time sheets, you can use the Project Web App if your 
organization installs and deploys Project Server or third party time sheets 
that integrate well with Project 2013. You could also work with paper time 
sheets, but such a system is laborious and often abandoned during project 
execution. We’ll focus on electronic time sheets only. If you don’t have an 
electronic time sheet system, we recommend updating tasks instead.

hh Transfer the time sheet information into the schedule.
This is where the Project Web App sets itself apart from many other time 
sheet systems. Once you’ve reviewed the time sheet numbers, you simply 
click one button to transfer the accepted numbers from Project Web App 
into the Project 2013 schedule. Other time sheet systems may not transfer 
the time sheet information into the Project 2013 schedule.

hh Check whether the schedule is updated correctly.

hh Prepare the status and forecast report.
You may need to re-optimize your schedule before reporting on it.

You need to make choices about what data to collect from your team members 
and enter into the Resource Usage or Task Usage view:

hh Percentage of work complete
Because percentage of work complete is such a weak metric, we don’t 
recommend using this type of time sheet.

hh Actual Work completed
Collapse or expand the timescale to reflect the frequency with which you 
collect data. For example, you can collect daily data, weekly data or even 
bimonthly data, depending on your project’s needs.

hh Remaining Work
Insert a column for Remaining Work and enter estimates of what remains 
to be done.

hh Actual Start and Actual Finish
Entering Actual Start and Actual Finish is not necessary when updating by 
assignment and using the Resource Usage view, because these are entered 
automatically when you fill in your timesheet. However, it may be necessary 
to enter this if you use a timescale other than daily.

What Data to 
Collect?
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On the File tab, in the Backstage view, choose Options to set the following 
options:

For each option, you’ll need to select either the name of the project you want the 
changes applied to or All New Projects for any new schedules you want to create. 
If you choose All New Projects, the existing schedules are not affected, because 
these options are stored in the project schedule.

Project 
Options

Recommended Choices

Schedule Set the Calculation Options on the Schedule tab:
In the Calculation options for this project, select either <schedule 
name of the project> in the drop-down or All New Projects.

Updating task status updates resource status
We recommend you check this option so that Project 2013 calculates 
the % Complete on the task level. However, if you turn this off, you 
will not see % Complete on tasks which allows you to enter them. 
This is useful if you want to update both tasks and assignments 
simultaneously. (Doing both types of updates is a lot of work.)

Actual costs are always calculated by Project. Project 2013 will 
calculate the actual cost if you keep this turned on. If you want to enter 
actual cost numbers yourself, you should turn it off.

Schedule Set the Scheduling Options on the Schedule tab:
In the Scheduling options for this project, select either <schedule 
name of the project> in the drop-down or All New Projects.

Autolink inserted or moved tasks
Disabling Autolink will prevent accidental changes to the network 
logic in the baselined schedule.

Split in-progress tasks
Allows you to split the task bar and move the remaining duration after 
the status date. We recommend keeping this option on.

Advanced Set the Calculation Options on the Advanced tab:
In the Calculation options for this project, select either <schedule 
name of the project> in the drop-down or All New Projects.

Move end of completed parts after status date back to status date

And move start of remaining parts back to status date

Move start of remaining parts before status date forward to status 
date

And move end of completed parts forward to status date

Choosing the 
Options for an 
Assignments 
Update
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Project 
Options

Recommended Choices

Selecting or clearing the four options has no effect when you work 
with traditional time sheets. (See also explanations after this table.)

Advanced Set the General Options on the Advanced tab:
In the General options for this project, set either for the current 
open project <schedule name of the project> in the drop-down or 
select All New Projects for any new schedules you want to create. 

If you choose All New Projects, the existing schedules are not 
affected, because these options are stored in the project schedule.

Automatically add new resources and tasks 
Disabling the option prevents accidentally adding resources during 
updating and re-optimizing

Allow cell drag and drop
Prevents accidentally dragging data on top of other data in your 
baselined schedule. We recommend turning it off at this point.

We will first explain how to create a timesheet using the Resource Usage view in 
Project 2013.

In case you receive updates from each resource individually, you should probably 
use the Resource Usage view. Unfortunately, the view cannot display the status 
date line. Instead, click on the timescale on that date; it stays selected and can act 
as a status date.

1. On the View tab, in the Task Views group, click on the Gantt Chart down-
arrow and select Resource Usage from the drop-down.

2. Create a new table. On the View tab, Data group, click Tables, More 
Tables; the More Tables dialog appears:

Prepare the View
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3. Select the table Work, and click Copy...; the Table Definition dialog 
appears:

4. Give the table a name, for example Update Assignments. After the field 
Name, insert the fields Baseline Work, Work, Actual Work, Remaining 
Work and % Work Complete. Abbreviate their column titles in the field 
Title to save space, (e.g., Bas.Work, Work, Act.Work). Click OK and Apply.

5. Change the time to a one-character time unit label to save character space: 
on the File tab, in the Backstage view, click on Options, Advanced. Under 
the Display Options for this Project section, make the change, then click 
OK.

6. Make sure you are back in the Resource Usage view. On the timescale, 
notice that only the field Work is shown. Right-click anywhere on the right-
side below the timescale and select Detail Styles… from the pop-up menu; 
the Detail Styles dialog appears:
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7. In the list Available Fields, select Baseline Work and click on Show>>. Do 
the same for the field Actual Work, which will be the input field. Perhaps 
you should even give this field a different background color. Rearrange the 
fields so that the Baseline Work field is at the top. Click OK.

The view should now look like:
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Actual Work + Remaining Work = Work  

Actual Work
Work

=  % Work Complete

The illustration shows the 
formulas that Project 2013 will 
use when updating the 
assignments in your project. 
You should keep these formulas 
in the back of your mind, 
because they explain the values 
that Project 2013 calculates and 

displays. The formulas define the relationships between the four variables: 
Actual Work, Remaining Work, Work and % Work Complete. If you enter only 
two of the four, Project 2013 will use the formulas to calculate the other two.

Rem. WorkActual Work

Fixed Work is not the correct task type 
because Units or Duration will recalculate 

D * U = W

The task field Type has to be set 
in such a way that it triggers the 
right recalculations. When 
working with time sheets, we 
will be entering Actual Work 
and Remaining Work values 

that cause the Work value to be recalculated as shown in the illustration: Actual 
Work + Remaining Work = Work. Fixed work is therefore not the right type of 
task, because we will not control what Project 2013 recalculates; will it recalculate 
the units or the duration? Remember you change one, fix another and have 
Project 2013 calculate the third one. When updating assignments, you typically 
want to see the effect on the Duration of the task (forecast), while keeping the 
same resources on the task (Fixed Units). Again, Fixed Units seems the most 
appropriate type of task for updating assignments as it was for updating tasks. If 
the task duration cannot be extended, you can consider adding resources.

1. Switch to the Tracking Gantt view. On the View tab, in the Task Views 
group, click on the Gantt Chart down-arrow and select Tracking Gantt 
from the drop-down.

2. Click on a column heading in the table area of the Gantt chart view to select 
all the tasks.

3. On the Task tab, Properties group, click the Information icon on the 
Ribbon and the Multiple Task Information dialog appears (because more 
than one task was selected):

The Formulas 
Behind the 
Screens

Set the Task Type 
for All Tasks
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4. Click the Advanced tab and select Fixed Units from the list Task type.

5. Clear Effort Driven and click OK. We recommended earlier that you keep 
Effort Driven turned off. Note that summary tasks continue to be Fixed 
Duration.

Actual Cost
Remaining Cost

Actual Cost
Cost (there is no 

remaining cost field)

By Resource
By Day or Week
By AssignmentBy Task

You 
Update 
Tasks

Assignments
Updated

by Project

Tasks
Updated

by Project

You
Update

Assignments

Updating costs is similar to updating 
the schedule:

hhYou can update the tasks and have 
the assignment details automatically 
updated by Project 2013.
hhYou can update the assignments 

and have the tasks automatically 
updated by Project 2013.

Project 2013 uses information about your task and assignment progress 
and actual work data to update actual costs, but depending on your project 
considerations, you may need to update your cost manually if:
hh Rates of your real resources are different from what you defined in your 

baseline
hh Fixed Costs change

Updating the 
Costs
Cost Updating 
Strategies
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hh Some other actual cost considerations cause you to need to update them 
manually 

If a resource rate changes and the tasks where this resource is assigned haven’t 
started yet, you just need to change the rate in the resource information, and 
Project will use the new rate to calculate the new cost.

If the resource with the new rate is assigned to a task with some previous progress, 
the new rate will be updated for past actual cost records and for remaining costs. 
You need to decide if this is what you want. If your change in the resource rate 
needs to be applied as of a specific date, you will need to update the new rate 
using the Cost Rate Tables for the resource and establish the date where the 
new rate should be used (see Chapter 7 for more information about Cost Rate 
Tables).

If you need to update tasks with fixed costs, do it in the same form where you 
enter the initial fixed cost information. As soon you enter progress in the tasks, 
Project 2013 will calculate the actual costs with the updated fixed costs. Of 
course you can compare your new costs against your baseline records. 

You can manually enter actual costs in the time-phased Actual Cost fields on the 
task level or on the assignment level. This can be a useful way to keep the cost of 
your project up-to-date on a daily or weekly basis.

By default, Project 2013 calculates actual costs automatically, based on the 
accrual method you set and the actual time progress you enter. If you want to 
enter actual costs yourself, you must first turn off the automatic updating of 
actual costs.

1. To turn off automatic updating of actual costs, on the File tab, in the 
Backstage view, click on Options, then select the Schedule tab.

2. In the Calculation options for this project section in the lower portion, 
clear Actual costs are always calculated by Project.

3. Click OK.

1. On the View tab, in the Task Views group, click on the Gantt Chart down-
arrow. Select More Views and choose the Task Usage view from the drop-
down, then click on Apply.

2. On the View tab, Data group, click Tables, and choose Tracking; the fields 
for updating tasks are displayed.

3. Right-click anywhere on the right-side of the Task Usage view below the 
timescale and select Detail Styles… from the pop-up menu; the Detail 
Styles dialog appears.

Updates in 
Resource Rates

Updates in Fixed 
Costs

Manual Updates in 
Actual Costs

Setting the  
Options for 
Assignment  
Cost Updates

Preparing the 
View for Updating 
Costs
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4. In the list Available Fields (left-side) of the Detail Styles dialog, select 
Cost and click Show>> to add it to the Show These Fields window area on 
the right-hand side. Do the same for Actual Cost. Click OK. The Cost and 
Act. Cost fields are now also displayed in the timescale:

 

5. Update running totals on the task or assignment level: add the new cost to 
the running total displayed in the spreadsheet column Act. Cost, and enter 
the new running total of actual cost. 

OR

Update in the timescale on a week-by-week basis on the task or assignment 
level: enter expenditures in the Act. Cost row in the week you incurred 
those costs.

The following checks reflect best practices for updating schedules. A schedule 
has to be updated if today’s date is later than the project start date. If the project 
should have started, the schedule needs to show actuals and revised forecasts.

The following questions will help you determine if the best practices for updating 
schedules were applied:

hh The schedule needs a good baseline, because it will be the standard for 
comparing the progress. What is the quality of the baseline in the schedule?
h` Is a baseline present?

Keep in mind that projects planned far into the future that haven’t been 
approved yet don’t necessarily need a baseline.

h` Is the baseline complete?
You can verify the presence and completeness by applying the filter 11 
IIL Tasks with missing baseline info.2 The filter displays any tasks 

2 This filter can be found in the file IIL Project 2013 Tools.mpp available for download at www.jrosspub.com. 
Click the link WAV Download Resource Center to enter the download site.

Checks on 
an Updated 
Schedule
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without entries in Baseline Start, Baseline Finish, Baseline Duration or 
Baseline Work. (When assignments are created after the baseline is set, 
the Baseline Work field is still empty. Note that the filter does not check 
on the field Baseline Cost.)

h` Is the baseline the approved baseline?
The baseline cannot be reset without formal approval of the appropriate 
project stakeholders.

h` Is the baseline relevant?
If the project has deviated too far from the baseline, a new baseline 
needs to be negotiated, since the baseline should provide a meaningful 
standard of comparison for the current schedule. You can check this by 
looking at how far the current schedule is removed from the baseline. 
Does the project have a fighting chance to catch up with the baseline 
again, or is it a lost cause? If it is a lost cause, you should submit a change 
request to change the baseline.

hh Are the appropriate options selected (on the File tab, in the Backstage 
view, Options) for the chosen updating strategy?
h` For task updating (revising the task-related Actual Duration and 

Remaining Duration fields), the options should be set as follows: 
Tab Schedule: Check Split in-progress tasks 
Tab Schedule: Check Updating task status updates resource status

h` For assignment updating (entering numbers from the time sheets into 
the assignment-related Actual Work and Remaining Work fields), the 
options should be set as follows:
Tab Schedule: Check Split in-progress tasks
Tab Schedule: Check Updating task status updates resource status
If you keep this option selected, you should not enter % Complete on 
tasks, because this may override time sheet data.

h` For updating both the tasks and the assignments, the options should 
be set as follows:
Tab Schedule: Check Split in-progress tasks
Tab Schedule: Uncheck Updating task status updates resource 
status
You cannot enter both types of information unless you clear this option.

hh Is the Status Date set to an appropriate date?
The Status Date, (on the Project tab, in the Properties group, click on 
Project Information), should be set to a date that is close to today’s date. 
If it is too far in the past, the schedule may be out-of-date. If it is too far in 
the future, the project manager is guessing the progress instead of entering 
factual progress.
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hh Is the task type of soon-to-be-updated tasks set to Fixed Units and non 
Effort-driven?
When you update the schedule, you change the durations (task updates) 
or the work (assignment updates). We recommended Fixed Units and non 
Effort-Driven, because you typically first would like to see what the schedule 
looks like when the same resources continue to work on the task. You can 
always re-optimize the schedule.

hh Is the schedule up to date per the Status date?
h` Are all actual durations (actual work/actual hours worked) scheduled 

in the past? 
The actuals are scheduled in the past if they are earlier than the status 
date. Otherwise, the schedule does not have up-to-date forecasts. 
When you bring actual durations to the past, all their dependent tasks 
may be rescheduled earlier as well, which improves the forecasts. This is 
why rescheduling is important. You can verify this by applying the filter 
12 IIL Reschedule Actual Durations…3

h` Are all remaining durations (remaining work) scheduled in the future?
The remaining estimates are scheduled in the future if they are later than 
the status date. You cannot leave unfinished work scheduled in the past. 
The work should be moved to the future to update the forecast dates 
of all dependent tasks. Otherwise, the schedule does not reflect up-to-
date forecasts and you have created a status report, instead of a forecast 
report. You can verify this by applying the filter 13 IIL Reschedule 
Remaining Durations...4

h` Are the remaining durations (remaining work) revised?
If not, the schedule may not reflect up-to-date forecasts. If the project 
manager has been revising the durations of detail tasks, these will be 
displayed. This filter is different from the other filters in the sense that 
if it displays tasks, it is good. If the filter does not display any tasks, it is 
an indication that the project manager is not revising his (remaining) 
durations while updating. If remaining durations are not revised, the 
forecasts are not very accurate, and may not even be reliable. You can 
display the tasks with a revised duration by applying the filter 14 IIL 
Remaining Durations revised.5

3 This filter can be found in the file IIL Project 2013 Tools.mpp available for download at www.jrosspub.com. 
Click the link WAV Download Resource Center to enter the download site.

4 Ibid.
5 Ibid.
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Whether you update tasks or assignments, the Tracking Gantt chart is good for 
reporting progress and new forecasts. On the View tab, in the Task Views group, 
click on Gantt Chart arrow, and select Tracking Gantt from the drop-down to 
apply this view.

On the View tab, Data group, click Tables, More Tables and select Variance. 
Click Apply to see the current schedule and baseline dates. The screen should 
look similar to this:

The Tracking Gantt view depicts progress using the calculated date field 
Complete Through. To see this field on the Format tab, Bar Styles group, click 
Format and choose Bar styles. Look under To.

The Complete Through field:
hh Follows closely the Actual Duration that you enter when you update tasks
hh Is the number of days for which actual hours are entered when you update 

assignments

If you work with time sheets and you cleared the option Updating Task Status 
updates Resource Status (File tab, Options, Schedule tab), the Tracking 
Gantt view will not show progress on the tasks because % Complete and Actual 
Duration are not calculated for tasks.

Prepare the 
Status and 
Forecast Report
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1. What are the process steps for updating schedules?

2. a. What benefit can you gain from a baseline in your schedule?
b. How do you set a baseline in Project 2013?
c. How often do you set it?

3. What are legitimate reasons for changing your baseline?

4. How do the following indicators relate to each other? Please describe their 
relationship using formulas.
h` Actual Duration
h` Remaining Duration
h` Duration
h` % Complete

5. There are two main strategies for updating schedules. What are they and 
what are the main differences between them?

6. When collecting update data, you could ask for % complete. What are the 
weaknesses of this metric?

7. a. What Tab on the Ribbon do you need to choose to set the status date?
b. Why do you need a status date?

8. What task type do you recommend when updating tasks?

9. What are the pieces of data that you will need to collect when you want to 
update assignments?

10. When updating tasks, different situations can come across. Mention six 
typical situations and a good way to update them.

11. What is the advantage of updating your schedule properly?

For experience working with the features you’ve learned about in this chapter, 
we strongly suggest that you do the additional exercises for this chapter that 
are included in the Case Studies appendix, available to download in the WAV 
Download Resource Center at www.jrosspub.com. 

Review 
Questions

Additional Practice
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Chapter 11: Reporting

Now that you’ve learned how to create and update your project schedule, we’ll 
move on to methods for reporting on the schedule and budget, and enabling 
stakeholders to monitor project progress against the plan.

After reading this chapter you will be able to:

hh Use and customize the new graphical reports provided by the Report 
feature in Project 2013

hh Customize views for reporting with custom tables, filters and groupings
hh Create Visual Reports by using Excel 2013 and Visio 2013
hh Create some useful and hard-to-get-at reports, as well as one-page 

performance reports
hh Use the Organizer to copy custom objects between projects
hh Format and print outputs from reports and views 
hh Export information to other Office applications for a quick report or 

presentation
hh Create a Macro to automate a complex or frequently used function
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Do you suppose they know that we were coming 
to bring food and supplies?

Project communications management is about making sure that project 
stakeholders get the information they need to effectively carry out their roles to 
perform, manage and direct the project. The reporting capabilities available in 
Project 2013 can be of tremendous value in achieving this goal.

There are some options you’ll want to be aware of when reporting. To review the 
options, on the File tab, in the Backstage view, click on Options.

Project 
Options

Recommended Choices

Schedule Set the Calendar options on the Schedule Tab:

Project  
Communications 
Management

Choosing the 
Options
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Project 
Options

Recommended Choices

Week starts on:

By default the selection is Week starts on Sunday but some 
companies prefer to use the first day as Monday to avoid 
confusion in a timescale view like a Gantt Chart.

Fiscal year starts in:

By default the selection is January but some companies use 
different fiscal year dates. This setting prevents confusion in a 
timescale view like a Gantt Chart.

Schedule Set the Scheduling options on the Schedule Tab:
Show that scheduled tasks have estimated durations

Project 2013 considers auto-scheduled task durations to be 
estimated durations. For tasks that are auto-scheduled (rather 
than manually scheduled) it will show a question mark (?) in 
the duration column. This might be confusing to stakeholders. 
To suppress the question marks, clear the check box.
Duration is entered in: Days

For projects 1 year to 18 months long, the most common unit 
for duration is days. However for reporting purposes you may 
want to change this option.
Work is entered in: Hours

For projects 6 to 18 months long, the most common unit to 
show work effort is hours. However for reporting purposes you 
may want to change this option.
Show assignment units as a: Decimal

You’ll want to choose what will best represent your resource 
needs for reporting: a Percentage or Decimal format. If you 
are using generic resources such as Architect, it is easier to say 
“10 architects” rather than “1000% architect availability.

Advanced Set the Display options on the Advanced Tab:
You may need to change the time units for Minutes, Hours, 
Days, Weeks, Months, and Years to a shorter abbreviation for 
written reports.
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For manually scheduled tasks, you can enter a status comment as a placeholder 
in the Duration field or in the Start and Finish date fields. See more on manually 
scheduled tasks in Chapter 3: Entering Tasks.

In this chapter, we will use the words printout, output, and work performance 
reports to refer to what people normally call a report.

You can print a report or a view to communicate information.

hh Reports and Dashboards
Several  new reports and dashboards are available in Project 2013 on the 
Report tab, View Reports group. In some places in this book, we refer 
to these as “new graphical reports’” which reflect the new appearance of 
the reports. The reports contain built-in charts and tables with numeric 
information coming directly from updates to the project tasks and resources, 
allowing an immediate assessment of the health of the project. With these 
reports you can add, change, move, and format data as you need in a single 
step. Once you have the report you want, you can print or send the report 
to other programs that support graphics. These new reports and dashboards 
replace the old table-like reports in previous versions of Project.

hh Views
A view is what you see on the screen; Project 2013 always has a view 
applied. A printout of a view shows on paper whatever you created on the 
screen. Project 2013 is very user-friendly in this respect: rarely will you see 
differences between the screen and paper printouts.

h` You can print any view from the menu except for any of the form 
views (Task Form, Resource Form, and Relationships Diagram) or 
combination views. You can use a screen capture tool to copy and print 
these views. Windows 8 comes with a snipping tool. 

h` Timescale and some graphical charts, like the Gantt Chart, Network 
Diagram, and Resource Graph can only be printed through views. 

h` Most of the views can be copied as pictures to other Office programs. 
(On the Task tab, Clipboard group, select Copy Picture from the 
Copy icon drop-down list.)

h` The copy and paste functions allow you to move project content 
defined in a view to and from Office programs more easily, retaining 
the formatting, outline levels, and column headers.

hh Visual Reports
Visual Reports utilize the power of a desktop OLAP cube to create 
PivotTables, PivotCharts, and PivotDiagrams by integrating with Excel 
2013 and Visio 2013. This expands the reporting ability of Project 2013 to a 
level that was previously limited to Project Server.

Communication 
Features in 
Project 2013
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Using this capability you can rapidly “slice and dice” project data to 
create more meaningful reports. Once these reports are created, you can 
dynamically change them by altering their dimensions and measures to 
answer any question that may arise during an executive or management 
briefing. To create and view these reports, see “Visual Reports” later in the 
chapter.

hh SharePoint 2013 and Project Server 2013 
SharePoint 2013 is an excellent collaboration tool that allows project 
managers to communicate with stakeholders either by exporting project 
files to a SharePoint site or by synchronizing to a task list with Project 
Professional. This is a quick and easy way to collaborate and share project 
status where you don’t need Project Server as a foundation. 

For more information about SharePoint 2013 and the synchronization of 
task lists, refer to Chapter 3: Entering Tasks.

Project Server 2013 is a full Project, Program, and Portfolio Management 
solution that can scale to meet enterprise requirements and allow you to 
communicate with stakeholders via a website. Project Server 2013 is not 
only a communication tool; it facilitates team collaboration and delegation 
during the entire life-cycle of the projects.

Since the scope of this book is limited to Project Standard 2013, Project 
Professional 2013, and Project Pro for Office 365, any mention of Project 
Server 2013 is only a reference of functionality.

You may be able to find specialized report apps in the Office App Store 
(Project tab, Apps group, click Apps for Office).

hh Comparison of Reporting Options
The following table provides a comparison of your reporting options. 
This may help you determine which option is best suited for a particular 
situation:

Reports and 
Dashboards

Views Visual 
Reports

SharePoint 
2013

Project 
Server 
2013

Paper & view 
based

Paper & view 
based

Paper & view 
based

Online multi-
device access

Online 
multi-device 
access
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Reports and 
Dashboards

Views Visual 
Reports

SharePoint 
2013

Project 
Server 
2013

One-way 
communication 
with an ability 
to meet the 
needs of a 
broad audience

One-way 
communication

One-way 
communication 
with an ability 
to meet the 
needs of a 
broad audience

Two-way 
collaboration

Two-way 
collaboration

Edits possible Edits possible Edits possible Some edits 
possible

Some edits 
possible

Highly 
customizable

Highly 
customizable

Highly 
customizable

Somewhat 
customizable

Highly 
customizable

Quick and easy More effort May require 
some effort 
to learn about 
Pivot Tables, 
but quick and 
easy after that

Most effort 
to create new 
reports, but 
quick and easy 
after they are 
defined

Most effort 
to create new 
reports, but 
quick and 
easy after 
they are 
defined

Tables, Charts, 
Images, Shapes 
and Text Boxes

Tables & 
timescale 
charts

PivotTables, 
PivotCharts 
and 
PivotDiagrams

Tables & 
Calendar, 
Gantt and 
Timeline 
views.

Tables, 
written 
reports, 
views, 
PivotTables 
& all kind of 
charts

In this chapter, we will discuss printing reports and views on paper and how to 
create meaningful Visual Reports.

Reports and dashboards allow us to tell the story of our projects through tables 
and charts supplied dynamically from the schedule updates with emphasis on 
the overall health of the project (or particular elements such as work progress 
on tasks and deliverables, upcoming tasks and milestones, project cash flow, or 
over-allocated resources). 

On the Report tab, in the View Reports group, Project 2013 groups reports 
into different categories.

Using 
Reports and 
Dashboards
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To print a report, first select the report category you want and then select a 
specific report. You can choose a graphical report from these categories:

hh Dashboards
This category includes five predefined reports showing relevant information 
on the project through several charts and tables per dashboard. You will find 
the Burndown, Cost Overview, Project Overview, Upcoming Tasks, 
and Work Overview reports.

hh In Progress
This report category includes four predefined reports with a variety of 
information about tasks, including: tasks without progress to the status date 
(Late Tasks); milestones that are late, coming up, or completed (Milestones 
Report); tasks that are driving the duration of the project (Critical Tasks); 
and tasks forecasted to finish behind their baseline (Slipping Tasks).

hh Costs
This category includes five predefined reports showing time-phased budget 
(Cash Flow), tasks and resources that are over budget (Cost Overruns), 
earned value information (Earned Value Report), cost information on 
resources (Resource Cost Overview), and cost information on project 
tasks (Task Cost Overview).

hh Resources
Includes two predefined reports showing over-allocations (Over-allocated 
Resources) and workloads with resource usage information (Resource 
overview).

There is also a Custom category where you can access any customized report, 
and a New Report category which allows you to create new reports from blank 
or standard templates with graph, table, or comparison elements.

It is not the intention of this book to explain each report, however it is useful 
to understand what information is available and here are some examples of the 
information included in some of the dashboards: 

A Few Relevant 
Dashboards

J. Ross Publishing; All Rights Reserved



504

Dynamic Scheduling® with Microsoft® Project 2013

Project Overview

Let’s say you need a report to review the general status of the project by answering 
the following questions:

hh What are the phases or major deliverables and their progress?
hh What is the general progress of the project?
hh Which major milestones are due next?
hh What tasks represent a risk or an issue?

On the Report tab, View Reports group, click the Dashboards down-arrow 
and select the report you want to use, in this case select Project Overview. The 
Project Overview report appears:

If you are using a dynamic scheduling approach, it is a good idea to change the 
filter used in the Late Tasks table with a filter that identifies the slipped tasks. A 
good option is the built-in filter Slipped/Late Progress.

Burndown

Let’s say you need a report to provide picture of the status of the project in terms 
of effort and scope, this report allows you to answer the following questions just 
by viewing a couple of graphs:

hh How much effort does the project require?

hh How much work has been performed and how much work remains?

hh How many tasks have been performed and how many tasks remain?

hh Are we going to finish on time? If not, what is the forecast?

hh Has the scope of the project changed?
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On the Report tab, View Reports group, click the Dashboards down-arrow 
and select Burndown. The Burndown report appears:

For better reports, be sure to capture the work of all tasks and set a baseline. 

Cost Overview

Let’s say you need a report to provide a picture of the status of the project in terms 
of costs, with the cost overview report you’ll be able to answer the following 
questions using a couple of charts and tables:

hh What’s the current overall cost of the project including actuals and forecast?
hh What’s the current remaining cost of the project?
hh What’s the overall progress of the project?
hh What’s the status of costs at the first level of the WBS?
hh Is the project financial status healthy?
hh Does the progress of the project reflect the expenditures to date?
hh What are the variations of cost against the baseline?

On the Report tab, View Reports group, click the Dashboards down-arrow 
and select Cost Overview. The Cost Overview report appears:
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For better reports, be sure to capture the cost of all tasks and set a baseline. If 
the cost for all tasks is not available you can capture top level task costs or a 
combination of them.

The development of a good WBS is important for high-level reports.

Tips for developing a good WBS can be found in Chapter 3: Entering Tasks.

Work Overview

If you need a report to provide a picture of the status of the project in terms of 
work, you will need to be able to answer the following questions with the help 
of charts and tables:

hh What’s the progress of the project in terms of work?
hh How much work has been performed and how much work remains?
hh Are we going to finish on time? If not, what is the forecast?
hh What is the variance between effort and the baseline?
hh What’s the status of work for the first level of the WBS?
hh What’s the status of work for each work resource?
hh What’s the remaining availability for each work resource?

On the Report tab, View Reports group, click the Dashboards down-arrow 
and select Work Overview. The Work Overview report appears:
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For better reports, be sure to capture the work of all tasks and set a baseline.

The built-in reports are very helpful but it is most likely that you will need to 
customize some elements to display specific information. To customize a report:

Choose an existing report

1. On the Report tab, View Reports group, choose the report you want to 
customize:

2. The Report Tools on the Design tab is activated for the selected report. 
From this tab you are able to change the format, insert new elements, and 
manage the report.

Add or Modify Information

3. Select the table or chart you want to modify by clicking on it. The Field List 
panel will appear to the right.

4. In the Field List panel you will be able to add, remove, filter, group, select 
the outline level, and sort the information of a selected table or graphic.

Customize a 
Report
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You can take advantage of any custom field, filter, and group that you’ve created 
for regular views or tables. Creation of custom fields, filters, and groups is 
discussed in the following pages.

Format and Refine

5. Resize and relocate any element by dragging and dropping.

6. Edit the format of any element by clicking on it. Additional tools will appear 
on the ribbon (i.e., select a chart and you will see the Chart Tools with two 
tabs, Design tab and Layout tab).

OR

Right-click on the chart or any element in the chart you want to change and 
some options will appear.
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Rename the Custom Report

7. Rename the report by clicking on the Design tab, Report group, Manage 
button, select Rename Report. This action will put the modified report 
under the Custom category.

It is convenient to rename any modified report with a descriptive name to 
identify it and avoid confusion with the built in reports. 

Renaming a modified report is equivalent to saving it as new and resetting 
the original report to its native configuration.

Share the Report

8. Now you can print the report from the File tab, Print 

OR 

9. Send it to Power Point or any software that supports graphics by going 
to the Design tab, Report group, Copy Report. This option will put the 
report on the clipboard.

10. From PowerPoint, click Paste.

You can always create reports from any of the standard templates, Blank, Chart, 
Table, or Comparison.

1. Go to Report tab, View Reports group, New Report, select a template.

2. In the Report Name window, enter a Name for the new report.

Creating New 
Reports
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3. In the new report page, Design tab, Insert group, insert the elements you 
want to include in your report. 

4. You can copy elements from other reports and paste them into your current 
report.

5. Follow the same steps to format and edit your report (refer to the section on 
Custom Reports).

Reports exist as a separate object in the Organizer (Go to File tab, in the 
Backstage view, click on Info tab, select the Organizer button and in the 
Organizer window, click the Report tabs) so you are able to share/distribute 
any custom report between projects to standardize the reports within your 
group.

Views can be customized in many ways. The steps for customizing views may 
seem complicated, but we think you’ll find that the time you invest in customizing 
views is worth it:

hh Many times you can mine specific data from Project 2013 simply by creating 
a custom view. This data can be filtered, grouped, and presented in such 
a way that changes the raw data into useful information useful in making 
timely decisions.

hh Once you’ve customized a view you can access it with only two mouse-clicks
hh You may be able to re-use customized views in other projects

A view applies a screen (e.g., Gantt, Form, Calendar), a table (which may contain 
custom fields), a filter and a group. Because the definition of the view asks what 
screen, table, filter and group to use, it is best to create those first. A view contains 
many other settings:

hh The sorting order (View tab, Data group, Sort arrow)
hh Any formats applied or objects created through the Format tab
hh All page setup settings from the Print Backstage view. (Go to the File tab, 

in the Backstage view, click on Print and then select Page Setup.)

Some views may apply only the screen as it appears in the Timeline view, or a 
combination of those objects, for example, the Calendar view which contains 
only the screen and filter.

Here’s the sequence of steps for customizing a View:

1. Define the fields you want to show. Fields can be either existing fields or 
fields that you can customize. In the extra fields in Project 2013 (like Text1, 
Number1, Flag1, among others) you can enter Excel-like formulas. You can 
even add graphical indicators like red/yellow/green to indicate status.

Use Views to 
Create Reports
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Customized Fields will be explained in detail later in this chapter.

2. Select existing or create new Table: which fields do you want?

3. Select existing or create new Filter: which tasks or resources do you want 
to show?

4. Select existing or create new Group to categorize the tasks or resources.

5. Select existing or create new View that also applies the newly created Table, 
Filter, and Group.

6. Sort the records.

7. Apply any formats you want, such as text styles or bar styles.

8. Choose the Page Setup settings.

9. Draw using the Drawing dropdown list. (On the Format tab, Drawings 
group, choose the Drawing icon and select a form from the drop-down list.) 

10. If you are using a pre-existing view, save the view as a new view.

You can work on any pre-existing view and save the changes as a new view with 
the Save View command (On the View tab, click any view button down-arrow 
and click Save View). By doing this, Project 2013 will save both the existing 
view and its table with the name you assign it. This way you can always return 
to the pre-existing view and table by using the Reset to Default command. This 
feature is also available for Tables with the command Save Fields as a New 
Table (on the View tab, in the Data group, click Tables).

The table, filter and group also exist as separate objects in the Organizer (Go to 
File tab, in the Backstage view, click on Info tab, select the Organizer button). 
If you want to create a new customized view, for example a one-page Executive 
Overview view, you can create a table called Executive Overview, a filter called 
Executive Overview, and a group called Executive Overview. When you create this 
new Executive Overview view, make sure you specify the newly created table, 
filter, and group in the dialog box. Now when you apply the view, it will apply 
all its Executive Overview components. If you name them all the same, it is clear 
that they belong together. This helps when you want to share the view with the 
Organizer; you can easily see which objects belong together.

You can start the name of certain objects with an * (asterisk) or a number to 
shuffle them to the top of the list. Or you can use an acronym to indicate they are 
customized for your organization (for example, at the International Institute for 
Learning, we use IIL).

New views can be created using a single view or a combination view. A 
combination view, as explained in Chapter 2, applies two other views, one in 
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the top and one in the bottom pane. Combination views are useful for analyzing 
projects, because what you select in the top view is always shown in more detail 
in the bottom view.

Now that we’ve seen the sequence of steps for customizing a view, let’s examine 
each step in detail.

ID Name Duration Start Finish Critical Status

Field: Number 1

Project Database

Each industry has its own unique 
perspective of the values they 
want to control. Project 2013 has 
some functions that can be very 
useful to calculate these values. 
For example, the ProjDateDiff 
function can give you the number 
of business days between two 

dates and even calculate this on a base calendar of your choice. These functions 
are often better than using your own, like [Baseline Finish] – [Finish], since the 
function will give you the number of calendar days instead of business days. 
Most data in Project 2013 is expressed in business days. 

Project 2013 has many generic fields in the project database that are called 
Text1-Text30, Flag1-Flag20, or Number1-Number20. You can claim and rename 
these generic fields. You can even enter Excel-like formulas in them so that they 
calculate performance measurement metrics specific to your organization. You 
can also go one step further and choose graphical indicators for the metrics 
(red/yellow/green) to reveal the health of the project quickly. In the illustration, 
the Number1 field was changed to traffic light indicators. Executives tend to like 
traffic lights; they can quickly find the problem areas. 

The steps to customize fields are:

1. On the Project tab, in the Properties group, click Custom Fields. Custom 
Fields dialog box appears:

Customize Fields
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2. First decide if you want to customize a Task or a Resource field. Notice 
that the Project radio button is not available unless you are working with 
Project Server.

3. Then select from the Type list. There are a total of 130 task-related fields 
and 130 resource-related fields, in addition to the Lookup fields, that can 
also be customized.
h` Cost1 - Cost10 fields can capture cost information like committed 

cost, which is useful if you have a budget from which to commit funds. 
You can use another cost field to calculate the amount of available 
budget, which is the total budget minus the committed amount. (The 
accounting system typically does not help here because it only becomes 
aware of expenditures when invoices are received.)

h` Date1 - Date10 fields can store dates. For example, you can register 
the actual payment to contractors to facilitate your payment control; or 
you can calculate the forecast of your project dates by using your own 
algorithms.

h` Duration1 - Duration10 fields can be used to store durations of 
interim plans. You have to either calculate or copy them yourself, since 
saving an interim plan (Project tab, Set Baseline, Set interim plan) 
only saves the start and finish dates.

h` Finish1 - Finish10 fields are used to store finish dates in interim plans. 
h` Flag1 - Flag20 fields are used to save yes/no information, for example 

to indicate if a resource is willing to travel.
h` Number1 - Number20 fields are often used to enter formulas that 

calculate with other numeric fields. For example, you create a formula 
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that calculates the time performance with an under/over percentage; 
this formula could look like: (Duration Variance / Baseline 
Duration)* 100.

h` Start1 - Start10 fields are used to store start dates in interim plans.
h` Text1 - Text30 fields are used to store extra textual information, like 

the name of the performing organization for tasks or the position or 
department for resources. Text fields can be enriched with a pick list, 
known as a Lookup table in Project 2013. The Lookup table allows 
you to restrict users to select only predefined values. 

h` Outline Code1 – Outline Code10 fields are customizable codes that 
let you categorize tasks and resources. With custom Outline Codes 
you can create breakdown structures other than the deliverable-
oriented work breakdown structure (WBS). You will need to first 
establish a Code Mask and then set a Lookup table compatible with 
the defined Code Mask so that users can choose structured values from 
a list. You can then sort, group, or filter your tasks or resources using 
this structure, e.g., group all employees on an organization breakdown 
structure (OBS), or sort by cost code.

4. Select an available field in the list. The Field list is refreshed when you 
choose the Type.

5. Click Rename and in the Rename Field dialog, give the field a more 
descriptive name that reveals its purpose. Click OK.

Eventually you will see that the field is now listed under both names in 
the database. For example, if you changed the name Cost1 to Committed 
Budget, you will see that the field is listed as Cost1 (Committed Budget) and 
Committed Budget (Cost1).

6. Set Custom attributes:
h` You can create a pick list for the field. Click Lookup...
h` If you are creating an Outline Code you will need to define the Code 

Mask. In the Edit Lookup Table for <Outline Code1> expand the 
Code Mask (optional) section and click the Edit Mask… button. The 
Code Mask Definition for <Outline Code1> dialog appears. Define 
the characteristics to code every level of your Outline and click OK.

h` You can enter an Excel-like formula in the field. Click Formula in 
the Formula for <Duration1> dialog, you will find available basic 
functions such as a multiplier or divider; access to all available fields 
in the project database from the Fields dropdown list; and in the 
Function dropdown list, you will find more advanced and convenient 
functions to work with such as If-Then functions or more sophisticated 
functions to work with date and time information. You can try the 
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following formula in a Duration field: ProjDateDiff([Baseline 
Finish],[Finish],[Project Calendar]).

7. Decide if you want Project 2013 to calculate values on summary tasks or on 
group headings by selecting your preferences under Calculation for task 
and group summary rows. You can select the Rollup if you want the result 
to be calculated by Sum, Average, Maximum, or Minimum value or select 
the respective radio button Use formula to apply the same formula. These 
options can vary depending on the Type of field used.

Leaving the default option set to None will prevent to display a value for 
summary tasks from being displayed.

8. Under Values to display you can create Graphical Indicators by specifying 
a Test and choosing an image for the range of Value(s). You can add tests 
and images for each different range of values:
h` Nonsummary rows: Define tests, values, and images for detail tasks.
h` Summary rows: Define tests, values, and images for summary rows or 

use the same criteria for detail tasks by checking:
Summary rows inherit criteria from nonsummary rows

h` Project summary: Define tests, values, and images for the Project 
summary row or use the same criteria for detail tasks by checking:

Project summary inherits criteria from summary rows

In Chapter 12 about Earned Value Management you will find plenty of useful 
formulas to calculate some project performance indicators.

When you develop formulas, you can only enter the type of data that corresponds 
to the Type of field you are customizing (e.g., you can’t put letters in number 
fields or numbers in flag fields).

When defining the Test for Graphical Indicators, it is important to know the 
order of the tests, excluding the results of the previous tests. For example, if you 
test for a value that is greater than 1, you can’t then test whether the value is 
within 1 and 2 because the first test already excluded any value greater than 1. In 
other words, make sure your test is set up in logical order using the stated criteria 
values.

You can also rename columns by selecting the column and then on the Format 
tab, in the Columns group, click Column Settings, then select Field Settings. 
The Field Settings dialog appears so you can edit the field Title. If you do this, 
the field will only be renamed in the active table, since the column titles are 
stored in the table object. 
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ID Name Duration Start Finish Critical Predecessors

Project Database

ID Name Duration A table is a selection of fields from 
the project database, including 
their order of display. You can use 
fields you may have customized 
in a table. A table doesn’t contain 
project data; it is only a layout. In 
this respect Project 2013 is 
different from other applications 
like Word or Excel where tables 

do contain data. In the illustration above, the table at the top displays only the 
fields ID, Name, and Duration out of all the fields present in the Project 2013 
database.

1. Make sure you are in one of the table views—a spreadsheet with columns 
and rows. The Network Diagram, Resource Graph, Team Planner, Timeline, 
or Calendar views don’t use tables, nor do views that are fill-in forms.

2. On the View tab, in the Data group, click Tables, and choose the table you 
want to apply. The currently displayed table (if listed) has a check mark in 
front of it. 
OR
Right-click on the Table/Cell Select pointer located where the column 
headings intersect with the row headings in the spreadsheet. A pop-up 
menu appears from which you can choose the table to apply.

3. The layout of columns is now replaced by a new layout which follows the 
definition of the table object you applied.

4. You can rearrange the columns very quickly by clicking on a column 
heading, releasing the mouse and dragging the column when you see the 
Drag Task/Column pointer (four-headed arrow mouse pointer).

5. Insert or remove columns manually. Right-click over the column heading 
and click either Insert Column or Hide Column.

6. Decide if you want to keep this table as a new table. To save the table as a 
new one, on the View tab, in the Data group, click Tables, and select Save 
Fields as a New Table. The Save Table dialog appears. Type the name of 
the table and click OK.

7. Return to the original table. To reset the table to the default, on the View 
tab, in the Data group, click Tables, and select Reset to Default.

Some worthwhile tables to be aware of are:

hh Cost table contains the Fixed Cost fields that are handy when you have 
subcontracts

Tables

Use an Existing 
Table
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hh Schedule table contains all the fields related to the Critical Path Method
hh Summary table, which brings date, duration, cost and effort data together 

in one table. Most other tables have either cost or schedule data
hh Tracking table which is used for updating as shown in the previous chapter
hh Work table is useful when you track the work (effort) completed rather than 

the task completion
hh Variance table which is used to track variances between the baseline dates 

and real or forecast dates

There are more tables available. On the View tab, in the Data group, click Tables, 
More Tables… Some of the additional tables are:

hh Baseline table that shows all baseline fields
hh Constraints table shows the fields Constraint Type and Constraint Date, 

allowing you to view any constraints you might have in your schedule
hh Earned Value table for Earned Value progress reporting

Instead of constantly changing the Entry table for reports you want to create, 
you can create and save a new table object for each report you need with options 
in addition to move, add or hide columns. 

1. On the View tab, in the Data group, click Tables, More Tables...; the More 
Tables dialog appears.

2. To list the task tables, select Task; for resource tables select Resource.

3. In the Tables box select the table that is closest to what you want, and click 
Copy to create a duplicate with which to work. The Table Definition dialog 
appears:

4. In the Name box, type a new name for the table.

Design a New Table
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5. Now you’re ready to customize it:
h` To delete a field in the table, click the row to delete and click Delete 

row.
h` To insert a new field in the table, click the row before which you want 

the new field to appear and click Insert row.
h` To replace a field, click on its Field Name and select the new field from 

the list that appears.

6. In Project 2013, you can choose to wrap the text in each column heading by 
setting Header Wrapping to Yes.

7. You can also wrap the text in the field by selecting Yes in Text Wrapping. 
The row height will be affected with this option. For more detail on this 
topic go to Wrap Task Names later in this chapter.

8. If you want to list the new table in the menu, check Show in menu.

9. If you want to lock the first field, check Lock first column. This allows you 
to select an entire task or resource record in the database without the locked 
title scrolling off the screen. The data can’t be edited in the locked column, 
which is just fine for ID numbers which are maintained by Project 2013 
anyway.

10. In Project 2013, you can choose to Auto-adjust header row heights.

11. You are also able to choose Show ‘Add New Column’ interface. This 
option will show a blank column at the end of the table where adding a new 
column is very easy.

12. If you are showing dates in the table, you can select a different format specific 
for this view by changing the Date format. 

13. When you’re done, click OK. You are now back in the More Tables dialog.

14. To apply the table and return to your project, click Apply.

15. You can now adjust the column width of a column by clicking and dragging 
anywhere on the right-hand side of the column heading.

When you want to establish shortcut keys for the tables, you can add the “&” 
symbol before the specific letter you want to use as the shortcut. For example, 
the Entry table has the shortcut key using the “E” and it is indicated in the Name 
as: “&Entry”. In the Table dropdown button, it is showed as Entry.
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A filter selects and displays records from the project database based on criteria 
that you set. Let’s say you need to show all the milestones of the project or that 
you want to focus on the tasks that are late so you can analyze alternatives to 
conclude the project under the original time specifications. For these scenarios, 
you just apply the built in filters Milestones or Late Tasks. You can filter tasks or 
resources. Project 2013 allows you to create criteria that look in any field in the 
database. The filter does not contain the project data; it is just the screen applied 
to the project database. In the illustration, the tasks with a duration greater than 
five days have been filtered from the database, which renders only two records 
from the database.

Highlight filters use the same filter definitions but it works by highlighting 
only the records that match the selected criteria. You can use either a filter or a 
highlight filter, but not both.

ID Name Duration

1  write 
2  edit    

ID Name Start Finish Critical Predecessors

Project Database

1  write
2  edit    
3  read   

Duration > 5d

Duration

7d
6d

7d
6d
2d

A filter doesn’t display any detail tasks that are collapsed under their summary 
task, even if they meet the criteria. To display detail tasks, expand all summary 
tasks, before you apply a filter, go to View tab, in the Data group, click Outline 
and select All Subtasks.

When applying a filter, the summary task’s information includes both the detail 
tasks that are included in the filter and the detail tasks that are not. So if you want 
your summary task to reflect only a subset of detail tasks it is better to apply a 
grouping than a filter.

The filter [No Filter] is the default filter in task views so that you see all tasks 
or all resources. As their names suggest, these are not real filters, because they 
display every record present in the project database. To get rid of a filter in a view, 
reapply the [No Filter] “filter” or select Clear Filter or press F3.

1. On the View tab, in the Data group, click the list Filter. 

2. Select a filter from the list. Only the records that meet the criteria in the filter 
definition are now displayed. If you want to see a filter’s definition, select 
from the list Filter: More Filters… and click Edit.

Some useful filters included in Project 2013 are:

Filters or Highlight

Apply an Existing 
Filter
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hh Critical displays all tasks that drive your project end date. Note that the 
word critical doesn’t mean important, it simply means that there is a Yes in 
the calculated field Critical.

hh Cost Overbudget displays the tasks that cost more than their baseline cost.

hh Date Range… displays tasks that fall in whole or in part within the period 
you indicate. This allows you to focus on the tasks in the coming weeks.

hh Milestones displays all important events in your schedule such as the 
delivery dates for deliverables. It looks for Yes in the calculated field 
Milestone.

hh Slipping Tasks displays all tasks that are forecasted to finish later than their 
baseline.

hh Summary Tasks displays all summary tasks and gives you a high-level view 
of the project. It looks for Yes in the calculated field Summary.

hh Using Resource… displays tasks assigned to a resource of your choice. This 
allows you to create simple to-do lists. It looks for tasks that contain the 
name of the resource in the Resource Names field.

hh Active Tasks displays tasks that are still part of the scope of the project. It 
looks for Yes in the calculated field Active.

hh Late Tasks displays tasks classified as late according to the Status field.

hh Manually Scheduled Tasks displays tasks that are manually scheduled.

hh Tasks Without Dates displays tasks that don’t have a Start or Finish date.

Some useful resource filters to be aware of are:

hh Overallocated Resources displays resources with too much work at 
certain times. Realize though, that it will display resources that may only 
have an over-allocation during a single hour in the entire project. It looks for 
resources with Yes in the calculated field Overallocated.

hh Slipping Assignments, when applied in the Resource Usage view, displays 
those resources with assignments that are late.

Just as with tables, there are advantages to creating a new filter object for each 
reporting need, so you will not have to change or recreate your filter every time.
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1. On the View tab, in the Data group, select from the list Filter and pick 
More Filters…; the More Filters dialog appears:

2. Select Task to see a list of task-related filters or Resource for resource-
related filters.

3. Click on a filter that is close to what you want and click Copy; this will keep 
the original intact. The Filter Definition dialog appears:

4. Enter a name for the filter; keep it the same as the table you created.

5. To list the new filter in the menu, check Show in menu.

6. Change the filter definition: 

Select the field to filter on from the list under Field Name. 

Select the comparison from the list under Test. 

Enter the Value(s); for an explanation of your many options in this field, see 
the discussion that follows these steps.

7. You can add more conditions by adding And or Or in the And/Or field 
and entering the second condition on the second line. And results in fewer 
records displayed, whereas Or results in more records displayed.

8. Check Show related summary rows, if you want to see the summary rows 
related to the tasks that are compliant with the filter definition.

9. Click Save.

10. Click Apply.

The Value field in the Filter Definition dialog can contain:

Design a New Filter
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hh Other field names that you select from the list
This allows you to make comparisons between fields. For example, to 
display all tasks that have slipped, the filter definition would be: Finish is 
greater than [Baseline Finish]. Notice that in the field Value, field names are 
enclosed in square brackets.

hh Literal values that you type in, for example:
h` Yes to filter on a flag field
h` $10,000 to filter on a cost field
h` 5 days to filter on duration or work
h` Jan 15, 2012 to filter on dates

hh Prompts for the user to enter a value
This creates a totally customized, interactive filter. You have to enter the 
prompt in a format similar to: “<text of the prompt>”? where <text of 
the prompt> is the question to display. An example is “Enter the minimum 
duration”?. Notice that you need to include the quotation marks and the 
question mark at the end. As a result, the following dialog appears when 
you apply the filter, and after clicking OK the desired records are displayed:

Groups allow you to categorize the tasks (or resources) on certain attributes. 
When you apply a grouping to the task list, the original structure of the WBS will 
be temporarily hidden and the new grouping will be displayed.

ID Name Duration Start Finish Critical Predecessors

Project Database

ID Name Duration

1  write 
2  edit   
3  read 

    Critical: Yes
1  write
2  edit   
    Critical: No
3  read  

Critical?

Yes
Yes
No

7d

2d

4d

7d

2d
4d

In the illustration, you can see 
that the tasks are categorized on 
the attribute Critical in two 
groups of Yes and No. The task-
related field Critical is a calculated 
yes/no field that indicates 
whether or not a task is critical. 
When you apply No Group again, 
the grouping will disappear, and 
the work breakdown structure 
will reappear.

Grouping can be done on multiple levels. You can create alternative breakdown 
structures by grouping on a field. You can even create multi-level breakdown 

Groups
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structures that are an alternative to the WBS. You can do so using an outline field 
(e.g., Outline Code1) in which you code the levels of the new breakdown. 

For example, your finance department may request a breakdown of tasks by 
accounting codes for Team member, Manager, and Subcontractors: 

As you can see in the screenshot, the original WBS is entirely hidden and all task 
records follow a new breakdown structure. The grouping feature even calculates 
totals on the group headings.

This grouping feature ability gives Project 2013 the features of a relational 
database.

An example of a grouping of resources is shown in the following screenshot. 
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Notice that if an item falls in more than one group, the item is repeated. For 
example, if you assigned two resources to a task and then grouped the tasks by 
resource, the task name will show up under both resources. In this case, the 
subtotals would be meaningless.

1. On the View tab, in the Data group, click the list Group by: the list with 
different groupings appears. 

2. Select a group from the list; the task or resource records are sorted and 
displayed within their groups.

Some worthwhile standard groups that are available are:

hh Complete and Incomplete Tasks which separates past tasks from future 
tasks.

hh Milestones which allow you to display milestones at the top of your list in 
two clicks. If you need more sophistication, for example only hand-picked 
milestones, you will have to mark them in one of the extra Flag fields and 
develop a custom filter.

hh Priority Keeping Outline Structure which allows you to recreate the WBS 
original outline code with an additional grouping by priority. This group is 
a very good example of nesting by several characteristics.

hh Active v. Inactive which allows you to organize tasks into active and 
inactive groups.

hh Auto Scheduled v. Manually Scheduled which organizes tasks by Task 
Mode, Auto, or Manually Scheduled.

hh Resource which organizes tasks by assigned resource.

hh Status which organizes tasks into the groups Future Task, On Schedule, 
Late, and Complete.

Just as with tables and filters, there are advantages to creating a new group object 
for each reporting need, so you won’t have to recreate your group every time.

1. On the View tab, in the Data group, select from the list Group by. Select 
More Groups…; the More Groups dialog appears.

2. Select Task to see a list of task-related groupings or Resource for resource-
related groupings.

3. Click on a group that is close to what you want and click Copy; this will 
keep the original intact. The Group Definition dialog appears.

Apply an Existing 
Grouping

Design a New 
Grouping
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4. Enter a Name for the group; keep it the same as the name of the table you 
created.

5. To list the new group in the menu, check Show in menu.

6. Change the group definition: 
Select the field to Group by or Then by from the list under Field Name.
Select Descending or Ascending from the list under Order.

If you choose a numeric field, it is important to select the intervals as well by 
clicking Define Group Intervals. If you skip this, Project 2013 will group 
on each value, which is rarely useful.

7. Click Save; you are now back in the More Groups dialog.

8. Click Apply.

Notice that you can group on assignment fields in the Task Usage view instead 
of on tasks; if you do so, the tasks will disappear temporarily. Instead of grouping 
on the task-related Cost field, for example, you can group the assignments 
instead. In the Group Definition dialog, check Group assignments, not tasks; 
this enables the list under Field Type. From this list, select Assignment. The 
grouping will now hide the task-related rows and use the assignment-related 
rows instead. In the Resource Usage view, you can group the assignments 
instead of resources.
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A view contains:

hh A reference to the screen name that reflects the graphic area (Gantt Chart, 
Calendar, Resource Form, Task Form, etc.)

hh A reference to the table it uses, which can contain custom fields
hh A reference to the filter it applies
hh A reference to the group by which it categorizes the records
hh Any formats applied through the Format tab
hh The sorting order applied via View tab, Data group, select Sort
hh The Page Setup settings (on the File tab, on the Backstage view, select the 

Print tab and choose Page Setup)
hh Any drawing objects created with the Drawing dropdown list (on the 

Format tab, Drawings group, select the Drawing icon)

The following illustration depicts this:

ID Name Duration

    Critical: Yes
1  write 
2  edit    
    Critical: No
3  read   

Page Setup
Formats 

Sort
Drawing Objects

Table

Filter

Group

7d
4d

2d

Perhaps you’ve noticed that the 
Format tab looks different in 
each view. For example, the 
Calendar view provides different 
format menu items than the 
Gantt Chart view. Also, the Page 
Setup dialog contains different 
options for each view. The fact 
that the menus change when you 
switch views can be confusing to 
the occasional user of Project 

2013. The reason for the changes is that the settings are specific to each view and 
are stored in the view object. Thanks to it, the view provides a steady display and 
printout of the project information.

The Format tab contains “specialized tools” for the specific view that you are 
currently in. Notice these specific tools, represented in the highlighted area over 
the Format tab, are available in the Calendar, Gantt, Network Diagram, Resource 
Sheet, Resource Usage, Task Form, Task Sheet, Task Usage, Team Planner, and 
Timeline views.

It’s a good idea to create a new view for each of your reporting needs. The view 
can also be added to the Built-in menu: on the Task tab, in the View group, click 
on the Gantt Chart down-arrow. If you do this, the view can then be accessed 
with two simple mouse-clicks. The appearance of views can be fine-tuned using 
the sorting and format menus.

Select a View
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1. On the Task tab, in the View group, click on the Gantt Chart down-arrow, 
More Views; the More Views dialog appears:

2. Choose the view that is closest to what you want and click Copy.
OR
Click New; the Define New View dialog appears, which allows you to 
choose between creating a Single view or a Combination view. We will 
focus on a single view in the rest of the steps. Click OK.

3. The View Definition dialog appears:

4. Fill in the Name of the new view and select the Table, the Group and the 
Filter from the lists. If you’ve given all the components of the view the same 
name, it’s obvious they belong together. If you haven’t, you can still return to 
the definition dialogs for table, group, and filter to rename them.

5. If you want this view to show the filtered criteria instead of applying the 
filter, check Highlight filter; the view will highlight the tasks that are 
compatible with the filter criteria.

Create a New View
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6. If you want this view to show in the menu, check Show in menu; the view 
will be available with only two mouse-clicks.

7. Click OK; you are now back in the More Views dialog.

8. Click Apply.

When creating a New view from scratch, you will also be able to select the 
Screen you want to have (for example, Gantt Chart, Task Usage, Resource Form, 
Network Diagram).

On the View tab, in the Data group, click on the Sort down-arrow and pick one 
of the listed sort orders. Note that the records won’t be sorted on individual line 
items, but first by the summary task families and then by individual line items.

If you want to customize the sort order:

1. Make sure you are in a Task view to sort tasks and in a Resource view to 
sort resources. On the View tab, in the Data group, click on the Sort down-
arrow, and select Sort by; the Sort dialog appears:

2. Select the first sort order key from the Sort by list; if you think you’ll need a 
second sort key to break any ties, select it from the list Then by.

3. An important choice is whether you want to check the Keep outline 
structure box. If you do, Project 2013 will only sort the families of summary 
tasks. If you don’t keep the outline structure, Project 2013 will do a complete 
and continuous sort of all line items, ignoring the breakdown structure.

Be careful to never check the Permanently renumber tasks box in any task 
view; this is the quickest way to wreck the structure of your WBS completely.

4. Click Sort and the sort will be applied.

Sort the Records
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5. To reset the sort order (if you did not renumber), simply resort by ID 
number by choosing Task tab, in the Data group, click on the Sort down-
arrow, by ID.
OR
Click Undo to set it straight. 
OR
Close your schedule without saving. This one is very effective if you did 
accidentally renumber.

The sort order is stored in the view object in which you applied the sort. 
Each view can have a different sort order.

Once you have created a report, table, custom field, filter, group, or view object, 
you can use it in other projects or share it with other people. You can even put it 
in your Global.mpt file and use it in all your other project schedules.

1. Open the schedule that contains the object, and open the schedule to which 
you want to copy the object.

2. On the File tab, in the Backstage view, click Info, Organizer button; the 
Organizer dialog appears:

3. Click on the Report tab as the type of object to copy.

4. In the list on the left at the bottom of the dialog, under Reports available 
in, select the schedule from which to copy the object and in the list on the 
right, select the schedule to copy to.

5. Select the report object to copy and click Copy.

Copy Views 
and Reports 
Between 
Projects
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The arrows pointing direction in the Copy button will modify themselves in 
order to indicate where to copy, left-right or right-left. 

6. Repeat steps 3 to 5 for the other objects your report or your view requires 
such as filters, groups, tables, etc.

Before copying a view object to other projects, make sure you know all the 
related objects of this view (table, filter, group, and any custom fields) in order 
to copy them with the view. Otherwise the view will not perform as you expect.

As you can see, it’s a lot easier to see which objects are the components of one 
view if you’ve given them all the same name.

The Organizer allows you to copy objects into the Global.mpt file. Any objects 
you put into this global template are visible in all your projects, unless there is 
already an object in the project schedule that has the same name. Give objects 
unique names if you want to see them in any schedule to which you copy them.

Visual Reports extend the reporting capability by using Microsoft Excel to create 
PivotTables and PivotCharts, and Microsoft Visio to create PivotDiagrams. 
Those PivotTables, PivotCharts, and PivotDiagrams allow you to automatically 
sort, count, break down, and total the data stored in a database in order to 
change the summary’s structure by dragging and dropping fields graphically. 
The Visual Reports enable you to make informed decisions about critical data in 
your projects and your organization. The technology that permits this capability 
is found in Project 2013’s local OLAP (On-line Analytical Processing) Cube. 

OLAP Cubes 

There are two basic types of databases. One stores transactional data (similar 
to your bank account) and the other is a data warehouse that stores static data. 
OLAP cubes mine data from static databases to provide information needed to 
make decisions. If data in the static database changes, the OLAP cube must be 
refreshed in order to be current. Since the OLAP cube is dealing with predefined 
static data structures, it is a very fast way to deliver data to the end user.

Project 2013 includes 16 out-of-the-box reports that can be used immediately 
for any project. To utilize them, on the Report tab, in the Export group, click on 
Visual Reports. The Visual Reports – Create Report dialog appears.

Visual Reports

Pre-Defined Visual 
Reports
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The top section displays all of the predefined reports. These are filtered by the 
applications that were used to create them. You can check the Microsoft Excel 
checkbox to view only the Excel reports, or the Microsoft Visio checkbox to 
view the Visio reports, or both to see all available reports.

The predefined reports are grouped on tabs that represent each of the six 
available cubes and we can classify them as follows:

Category Description
All All 16 available reports are shown combining 

Summary and Usage.
Summary (Task, Resource 
or Assignment)

The summary reports do not include timephased 
data, (duration data distributed over time as in 
weeks, months, or years) so you are able to review 
totals of the available fields.

Usage (Task, Resource or 
Assignment)

The usage reports are based on timephased data, so 
you can establish reports of fields performing over 
time.

Information may vary depending of the cube that is being created (Task, 
Resource, or Assignment). 
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Also note that some of the reports are created using the metric scale and others 
use the U.S. conventions.

Follow these steps to generate a predefined Visual Report:

1. On the Report tab, in the Export group, click Visual Reports.

2. In the Visual Reports – Create Report dialog, select the tab for the report 
category you want. 

3. Select the report you want and notice that a Sample report appears to the 
right in the sample box.

If you want to open a different report located in a specific folder, check Include 
report templates from: and click Modify. The Modify Location dialog appears 
so you can navigate your libraries to locate the <folder> where the additional 
templates are located and click OK.

4. In the Select Level Of Usage Data To Include In The Report box, select 
years, quarters, months, weeks, or days. This will be the lowest level to 
which you want to drill down. Give this some thought because the lower 
the level, the more data has to be stored in the cube and the slower your 
response time will be.

5. Once you have defined the cube, click the View button.

Project will compile the information required by the selected report and 
will build the OLAP cube and display the visual report in either Excel or 
Visio. This will take you to a graphic of your data. If the graphic was created 
with Excel, you are looking at a PivotChart; if the graphic was created with 
Visio, you are looking at a PivotDiagram. A PivotDiagram is a hierarchical 
layout of the data, much like a WBS or an OBS. The data is aggregated from 
the lower levels up to the higher levels. This gives you a great breakdown of 
the composition of the summary data.
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In the Excel Visual Report, you can view or change the PivotTable data (the data 
that the report is based on) by going to the second tab (called either Assignment 
Usage or Task Summary or similar) below the worksheet. 
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If you change the data, variables, or depth of detail, the chart will immediately 
change to reflect the data.

6. You can print and/or save the report in Excel 2013. On the File tab, in the 
Backstage view, click either Print to send it to a printer or Export to save it 
as a file (PDF, XPS, XLSX).

Some worthwhile Visual Reports to be aware of are:

• Cash Flow Report is a Task Usage report in Excel that 
allows you to review partial and cumulative costs over 
time in a bar graph. This report is very helpful to look at 
project costs over the duration of the project.

 
• Resource Work Summary Report is a Resource Usage 

report in Excel that allows you to review and analyze 
the resource capacity against the work, the remaining 
availability and the actual work in a bar graph. This 
can be very helpful in understanding resource needs, 
especially if you are using a resource pool.

• Cash Flow Report (Metric/US) is a Resource Usage 
report in Visio that allows you to review the project 
planned costs and actual costs on a timephased basis. 
This report is separated by the type of costs and then 
by the resource type (work, material, and cost). If 
planned costs exceed baseline costs in your report, an 
indicator appears in the report.

• Baseline Work Report is an Assignment Usage report 
in Excel that allows you to review the baseline for 
scheduled work, planned work, and actual work for 
your project displayed across tasks in a bar graph.

• Baseline Cost Report is an Assignment Usage 
report in Excel that allows you to review the baseline 
scheduled cost, planned cost, and actual cost for your 
project displayed across tasks in a bar graph.

• Earned Value Over Time Report is an Assignment 
Usage report in Excel that allows you to review a 
line chart report that plots AC (actual cost of work 
performed), planned value (budgeted cost of work 
scheduled), and earned value (budgeted cost of work 
performed) over a timephased duration.
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• Task Status Report is an Assignment Summary 
report in Visio that allows you to review a diagram 
of the work and percent of work complete for project 
tasks, containing indicators showing when baseline 
work exceeds work, when baseline work equals work, 
and when work exceeds baseline work. Percent of 
work complete is represented by the data bar.

• Resource Remaining Work Report is a Resource 
Summary report in Excel that allows you to review a 
bar graph, displaying remaining work and actual work 
for each work resource, represented in assignment 
units. This report is very easy to understand because 
the columns with actual work look like they are being 
filled and the ones with no actual work look empty.

The PivotTable data for any of the reports is shown in a split window. On the left 
is the PivotTable with rows, columns, the body of the table, and the filters. 

 

On the right side of the screen is the PivotTable field list. The top portion of this 
panel is a list of the fields that are included in the cube in the form of dimensions 
and measures with the following characteristics:

hh Dimensions - A structural attribute of a cube that is a list of members, all 
of which are of a similar type in the user’s perception of the data. In Project 
2013, Tasks, Resources, Type, and Time are considered Dimensions.

Dimensions can only be placed in rows, columns, and the filter areas.

hh Measures - Data that can be examined and analyzed, such as effort or cost 
data. Cost, Duration, Work, and Dates are considered Measures.

Modifying Visual 
Reports
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hh Property Fields - A characteristic of the dimensions. If you have difficulties 
finding a custom field you were trying to use in a pivot table…it’s probably 
because it was created as a property field and not listed with the Measures 
and Dimensions. Property fields include such things as Finish Variance, 
Early Start, and Slack. You can locate the properties by right-clicking the 
dimension at the lowest level shown.

To select or change the data presented on the chart, drag fields into the 
appropriate areas below referred to as as Rows, Columns, Filters, and Values.

Alternatively, you can drag the fields directly onto the PivotTable. To do this, drag 
the column data (often timescale information) into the column area on the table. 
Then drag the fields that you want to see in the rows (perhaps organizational 
data, such as resources or departments) to the row area. Finally, drag whatever 
data you want “sliced and diced” to the body of the table. When you are finished, 
you have a multi-dimensional table—a PivotTable.

Depending on the cube you are editing (Summary or Usage), you may need to 
display Property Fields not listed in the PivotTable Fields list such as custom 
fields, dates, %complete, etc. In PivotTable, right-click on any task and select 
Show Properties in Report. A list of the available property fields are shown so 
you can pick the ones you want to display in the table.

Because the cube is saved once it’s created, you can change or “pivot” the data 
to look at different aspects. This could help you when you’re meeting with a 
stakeholder who asks to see the data from a different perspective or asks you to 
drill down further.

If the fields that you want to include in your table are not present in the PivotTable 
field list or in the Properties field list, you will need to create a new template 
(cube) or modify an existing template. To do this, open up the Visual Reporting 
feature, choose New Template or Edit Template and you will be presented with 
a field picker. Choose the fields you want to include in your PivotTable. Once 
the new cube is complete, you need to save the cube before proceeding.

Most of the time, the predefined report templates will serve you well enough. 
If they don’t meet your needs, you can edit the templates or create new ones by 
following these steps:

1. On the Report tab, in the Export group, click Visual Reports.

2. In the Visual Reports dialog, click New Template button. The Visual 
Reports-New Template dialog appears.

Define a New 
Visual Report
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3. In the Select Application section, choose between Excel to create an Excel 
template, or Visio (Metric) to create a Visio template, by selecting the 
appropriate radio button.

If you install Project 2013 in English, you will be able to select Visio with 
US units.

4. In the Select Data Type section, select the type of data that you want to use 
in the report (Task Usage, Resource Usage, Assignments Usage, Task 
Summary, Resource Summary, or Assignment Summary). 

5. To verify the fields available for the Data Type selected, click the Field 
Picker button. The Visual Reports-Field Picker dialog appears.

6. Add or Remove fields and click OK.

7. In the Visual Reports-New Template, click OK. The program chosen to 
create the template is opened. Now you are able to define your PivotTable, 
PivotChart, or PivotDiagram.

8. When the report is ready, go to the File tab, in the Backstage view, click 
Save as.

9. In the Save As view, click Computer and then Browse. This path allows 
you to save the template in the Templates folder, allowing you to allocate 
your report template within the other built in templates to be available. If 
you want to choose a different place, you are able to do it from the Save as 
backstage view. 

10. In the File name box, give a name to your template and click Save.

11. In the Pop up window, click Yes to clear the data before saving the template.
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As in views and tables, Visual Reports also allows you create a new template 
from an existing one. You just have to select the report that is similar to what you 
want to create and click Edit Template. The Field Picker dialog will be shown 
so you can add or remove fields and then click Edit Template. Save the report 
with a different name than the original template.

While standard reports are managed in the Organizer (File tab, Info tab, 
Organizer, Reports tab); Visual Reports are managed here under Manage 
Template. To do this, select the existing or customized Visual Report and then 
click Manage Template. The following location, which can vary according to the 
language of your installation, will be open: <C:\Users\username\Roaming\
Microsoft\Templates>. Any new template dropped in this location will be 
available for your Visual Reports.

If you are completely new to PivotTables, PivotCharts, or PivotDiagrams, a good 
reference manual on Excel, Visio, or even PivotTables will serve you well here.

As an alternative way to share the Project OLAP reporting cube database to do 
more advanced data analysis in either Excel or Access, you can export the OLAP 
database as a .cub or .mdb file. Once saved in a specific format, you can open 
the cube (.cub) in Excel and create a PivotTable with the imported fields or you 
can open the data in Access (.mdb), to create any kind of report in this platform. 

To save a cube or database follow these steps:

1. On the Report tab, in the Export group, click Visual Reports.

2. In the Visual Reports dialog, click Save Data... The Visual Reports-Save 
Reporting Data dialog appears.

Saving a Cube or 
Database
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3. You can either Save Cube or Save Database data in Access. To save the cube 
select the kind of data you are saving (e.g., Task Usage, Resource Usage, 
Assignment Usage, or Task Summary, Resource Summary, Assignment 
Summary). If you need additional data not currently included, use the 
Field Picker button to select additional fields that you would like to include 
in your cube. 

4. Click the Save Cube… button to save the cube or click the Save Data… 
button to save the data in Access.

5. Browse to the location where you want to save the cube data, and then click 
Save. The process to save will end with a message indicating the save was 
successful.

6. Click Close in the dialog boxes and now you are able to manipulate the 
exported file.

House

Roofing of  the House

Foundation
Walls
Roof

Roof
   frame
   sheet
   shingle
   roof  ready

This heading may seem 
pretentious if you are juggling a 
schedule with thousands of 
tasks. Regardless of the size of 
the project, you can always 
surprise your executives and 
clients with one-page 
performance reports. There is a 
simple technique to do this, and 
it will make your stakeholders 

happy as they often prefer concise information, such as a one-page report.

The first one-page report should only show the major milestones. That is all you 
need if all the milestones are on schedule and the budgets are feasible. Where a 
milestone is off its baseline, you provide a second one-page report that gives an 
explanation for the discrepancy.

In the illustration, the milestone chart at the top shows slippage on the Roof 
milestone. In the bottom one-page report, the detailed cause of the slippage is 
shown. With a few one-page reports, you can give an adequate status and forecast 
report for a project of any size.

In a similar fashion, you can create a one-page high-level cost report. If there are 
discrepancies, you can create another one-page report with the explanation for 
the differences.

In Project 2013 you have plenty of choices to prepare this kind of report either 
by using the built-in reports or custom views. It is important to understand the 
possibilities of comparing the baseline against the actuals and forecasts or just 

One-Page 
Performance 
Reports
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comparing the current date versus the scheduled dates if no baseline is available. 
You will have to master the filters feature of Project 2013 to accomplish this. 

Some worthwhile reports are:

Milestones Report (Report tab, View Reports group, In Progress downward 
button, click Milestones Report). You can show a snapshot of the remaining 
tasks as well a selection of accomplished milestones, future milestones, and late 
milestones. By default, this report does not need a baseline to be generated and 
it is calculated by comparing the current date to the scheduled tasks.

Timeline view (View tab, Split View group, check Timeline checkbox. In 
the Format tab, click Existing tasks and activate all the milestones you want 
to show in the check-box) allows you to summarize the main milestones or 
tasks in a single continuous timeline. This report shows only current or forecast 
information, not the baseline. 

Tracking Gantt with Milestones Filter (View tab, Tasks Views group, Gantt 
Chart downward menu, select Tracking Gantt. In the same View tab, Data 
group, select the Milestones filter.) This traditional report from a view allows 
you to summarize the main milestones or tasks with an ability to understand the 
slippage from the baseline.
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We will discuss the following special reports in more detail. Some are very 
useful, others are just hard to get at:

hh Responsibilities by department
hh Workload histogram for individuals and groups 
hh To-do lists in the Calendar view 

With the Group feature, it is easy to communicate lists of responsibilities by 
department, or resources by type. The next screenshot shows a resource by type 
grouping:

1. On the View tab, in the Resource Views group, click Resource sheet.

2. Enter the department in which each person works in the field Group.

3. On the View tab, in the Resource Views group, click Resource Usage.

4. Select from the list Group by on the Ribbon in the Data group, the item 
Resource Group; the result will show three outline levels:
h` The first level shows the resource groups, e.g., departments
h` The second level shows all resources working in each department
h` The third level shows all the assignments for each resource

Workload histogram is synonymous with Resource Graph in Project 2013. 
When you enter the group or department the resource works in, you can 
create interesting workload histograms. For example, you can create a graph 
that compares the workload of an individual with the total work for that group 
(department).

Examples 
of Useful or 
Hard-to-Get-At 
Reports

Responsibilities by 
Department

Workload 
Histograms
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The next screenshot shows the total work of Nancy Hilcrest relative to the total 
workload of all internal resources (as characterized in the field Group) displayed 
using the Group… filter. 

1. Choose View tab, in the Resource Views group, click Resource sheet.

2. Enter the department in the Group field for each resource.

3. On the View tab, in the Resource Views group, click Other Views down-
arrow, Resource Graph.

4. Press Page Down until you see the graph of the individual for whom you 
want to compare the workload to the total workload of the department or 
group.

5. Notice that the Resource graph displays Peak Units by default. The Peak 
Units format always displays the highest over-allocation in red, even if it is 
just one 200% over-allocation during one hour in an entire year. On the 
Format tab, in the Data group, select from the list Graph: Work, which 
exchanges the Peak Units for Work numbers. Work provides a more 
accurate picture than Peak Units. The format Work displays the total number 
of person days of effort per time unit.

6. While still in the Resource graph view, on the Format tab, Format group, 
select the Bar Styles icon and the Bar Styles dialog appears:
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7. In the Filtered Resources section (left) select from the list Show as, select 
Step Line for both Overallocated work and Allocated work as shown in 
the previous screenshot, and click OK. The view now shows stepped bars 
for the workload of the resource and a red line for the total work in the 
project (filter is still All Resources).

8. Go to the View tab, on the Data group, in the list Filter select Group… the 
Group dialog appears:

9. In the field Group name, enter the name of the group to which the resource 
belongs and click OK. Now you see the workload of the resource relative to 
the total workload of the department the person belongs to.

10. Create the header and footer by choosing File tab, in the Backstage view, 
click on the Print tab, then select Page Setup.

For further explanations on Page Setup settings, refer to the section Adjust 
the Page Setup later in this chapter.
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The Calendar view doesn’t show many tasks within a one-day view. When we 
first discussed this view (review Chapter 2: Getting Started with Project 2013), 
we stated that the Calendar view is particularly suited for creating to-do lists by 
resource. There are several reasons for this:

hh Typically, a resource has only one or two tasks on any given day. Two to four 
tasks can easily be displayed in the Calendar view.

hh Not all people understand Gantt Charts, but most people can read calendars. 
To-do lists in the Calendar view are generally easier to understand than in 
the Gantt Chart.

hh You can show the resource-specific holidays and vacation days in this view.

1. On the View tab, in the Task Views group, click Calendar.

2. In the list Filter select Using Resource… 
The Using Resource dialog appears:

3. From the list Show tasks using, select the resource for which to create the 
to-do list. Click OK.

4. To create the shading for vacation time, right-click over the calendar and 
select Timescale…; the Timescale dialog appears. Click the tab Date 
Shading:

To-Do Lists in 
Calendar View

Create a To-Do List 
for a Resource
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5. Under Show working time for, select the resource of this to-do list and 
choose the appropriate pattern and color settings. Click OK. The view now 
colors or shades the Resource Calendar Nonworking Days.

6. Create the header and footer by choosing the File tab in the Backstage 
view. Click on Print, Page Setup.

Now that you’ve created your view, it’s time to format and print that report that 
you want to distribute to various stakeholders. No matter how interesting and 
to the point the data is, very few will scan through pages and pages of small, 
mono-font reports to get to the substance of the report. Your reports need to be 
formatted in a way that makes the data easy to find, read, and interpret.

The Format tab offers many options to improve the appearance of the output. 
Any change you make through the Format tab will be stored in the view object 
that you have on the screen when you make the change.

The Format tab changes when you apply another view. For example, when you 
are in the Gantt Chart view, the Format tab has a legend at the top indicating 
Gantt Chart Tools; this is the way that you know that clicking the Format tab, 
you will access specific options available to format this view. When you realize 
that each view has its own format menu, you understand that Project 2013 is a 
much bigger application than it first appears to be.

Following a discussion of general formatting and printing considerations, we 
will examine the different formatting and printing options for the Gantt Chart, 
Assignment views (Resource Usage and Task Usage), and Resource Graph 
views.

Formatting & 
Printing Reports

General 
Formatting 
Considerations
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Choices that are available to you include:

hh What text and bar formats do you want?

You can customize the text for an individual task using the Tasks tab, and 
apply any option in the Font group or format an individual bar by double-
clicking the bar and applying any format in the Format Bar dialog box. You 
can do it faster by applying a style to each type of task by choosing Format 
tab, and in the Format group, click Text Styles or in the Bar Styles group, 
click Format down-arrow and choose Bar Styles. We recommend you use 
the styles first before overriding the styles for single tasks. 

You will also find very helpful the predefined menu of Gantt Chart Styles 
which can be accessed by choosing Format tab, and in the Gantt Chart 
Style group, click the down-arrow. The available styles are in two groups: 
Scheduling Styles and Presentation Styles. The first group uses the colors 
of the bars to distinguish between manually or auto-scheduled tasks and the 
second group will format all the tasks with the same format. You can verify 
this by applying any available format and then accessing the Bar Styles 
dialog box, by choosing Format tab, in the Bar Styles group, click Format 
down-arrow and choose Bar Styles.

hh Which date formats do you want in the spreadsheet and in the timescale?

First choose the default date format for all date fields. On the File tab, in 
the Backstage view, click Options. In the Project Options dialog, in 
the Project View section, select from the Date Format list, the format 
you want to keep for your file. If you want to change the date order (e.g., 
from mmddyy to ddmmyy), you have to go to the Control Panel, Clock, 
Language, and Region, Region and Language. 

To override the default date format in a specific table, on the View tab, in 
the Data group, click Tables, More Tables…, click Edit... and select the 
format you want from the Date Format list at the bottom. 

To override the default date format in the timescale when you display dates 
next to the task bars, on the Format tab, in the Format group, click Layout 
and select the date format from the list Date Format.

hh Do you want to show dependencies in the Gantt Chart or Tracking Gantt?

On the Format tab, in the Format group, click Layout. The Layout dialog 
appears; in the Links section select the the option without links or with 
straight or hooked arrows.

hh Do you want to roll up detail task bars into their summary task bars in the 
Gantt Chart?
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A regular summary task bar looks like a gray thin bar. A rolled-up summary 
task bar contains detail task bars or milestones rolled up onto it. You can 
choose between:
h` No rolling up (default)
h` Rolling up certain hand-picked detail task bars

Choose the task bar by double clicking on it. On the Task Information 
dialog, check Rollup and click OK. Take similar steps for the summary 
task to allow the roll up of detail tasks.

h` Rolling up all detail task bars onto their summary task bars
On the Format tab, in the Format group, click Layout. On the Layout 
dialog, check Always roll up Gantt bars. To make the rollup appear 
only when summary tasks are collapsed, you can then also check Hide 
roll up bars when summary expanded. Click OK.

hh What fields do you want to show in the timescale of the Task Usage and 
Resource Usage views?

You can select fields other than the default Work field. On the Format tab, 
in the Details group check any of the available fields for a quick pick. Better 
yet, click the Add Details button for a complete list. The Detail Styles 
dialog will pop up allowing you to quickly pick a field listed in the Available 
fields: list and send it to the Show these fields list by clicking Show (or 
Hide to do the opposite).

hh What graph details do you want on the Resource Graph view?

You can graph details other than the default Peak Units. On the Format tab, 
in the Data group, select from the Graph: list the details you want to graph 
(Work, Cost, Percent Allocation, Remaining Availability, etc.). 

Notice that the peak units allow you to find over-allocations quickly, but 
give an inflated impression of the workloads when you zoom out from days 
to weeks to months in the timescale. Workloads seem to inflate, because 
Project 2013 takes the highest bar (the peak unit) of the four weeks in a 
month to summarize the entire month. You should consider changing to the 
details Work for a more realistic depiction of the expected workload over 
time. 
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Use the Backstage Print preview to check the header, footer, legend, margins and 
the timescale before printing or to check the position of the boxes on a Network 
Diagram.

1. Apply the view you want to print.

2. On the File tab, in the Backstage view, click Print:

3. Use the Multiple Pages button (bottom right) to zoom out and get an 
overview of all the printed pages, and then click on one of the pages to zoom 
into that page. 

4. On the Backstage Print preview, click where you would like to zoom in to 
see part of a page in more detail. Click again to zoom out.

5. To change the options available for your printer, click Printer Properties.

6. To change the margins, header, footer, or legend text, click Page Setup.

7. To print the view, click Print.

Colors you may have used are automatically replaced by hatch patterns on a 
black-and-white printer.

 To print the current view, select from the following settings in print preview 
(File tab, in the Backstage view, click Print):

General Printing 
Considerations
The Backstage Print 
Preview

Print Settings
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hh Print range of Pages and Dates
Under Settings, in the first down-arrow list, select the range you want to 
print. You can select the Entire Project, Specific Dates, and/or Pages.

hh Paper Orientation
Use the second down-arrow list of the Settings to choose Portrait or 
Landscape Orientation.

hh Paper size
Use the last down-arrow list of the Settings to define your paper size.

The page setup settings are stored in the view object. 

To see them on the File tab, in the Backstage view, click Print. Under Settings, 
click the Page Setup link.

hh Page tab
h` Orientation: When you print the timescale, it is often best to change 

from Portrait to Landscape. This may allow you to keep the entire 
timescale on one-page.

h` The Scaling option will shrink or enlarge the print image from 10% to 
500%, but is only available if your printer can handle scaling.

hh Header, Footer, Legend tab
Choose the position first: Left, Center or Right. You can type text, or 
better, use the lists General or Project Fields at the bottom of the dialog 
to generate standard phrases. Select the item from the list and then click 
Add; this will add a cryptic code for it in the header, footer, or legend. These 

Page Setup Settings
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codes refer to entries you made in the Advanced Properties. If you make 
changes in that dialog, all headers of all views will be updated automatically.

By default, the header font size is small. To increase it, select the text by 
dragging over it and clicking the Format Text Font button; the Font dialog 
appears, where you can choose the font, style, and size.

To access the Advanced Properties information of the project file, on 
the File tab, in the Backstage view, click Info, and then click the Project 
Information downward menu, and select Advanced Properties.

hh View tab
The important options for task views (except the Calendar view) are:

h` Print all sheet columns will print all columns, even if they are hidden 
behind the timescale.

h` Print first 3 columns on all pages: You should not have to use this 
option if your report is only one-page wide.

h` Print Notes: This will create a separate page with notes by task. The 
task IDs are used to relate the notes to the tasks.

h` Print blank pages will print a page even if it does not show any task 
bars (timescale) or nodes (Network Diagram).

h` Fit timescale to end of page is only useful when your timescale does not 
reach the right-hand side of the page. This option will stretch it, filling 
the page. Note that it does not shrink the timescale; it only stretches it.

h` Available in Task Usage or Resource Usage views only: 
Print row totals for values within print date range
Print column totals
These options allow you to add the row totals to the timescale of the 
usage views on the right-hand side and column totals at the bottom by 
day, by week, or by month, depending on the current time unit.

More detailed information on the Page Setup settings can be found in this 
chapter under the subject Formatting & Printing the Gantt Chart View. 

1. On the File tab, in the Backstage view, click Print.

2. Under Settings, click the Page Setup link.

3. Click the tab Header or Footer.

4. Choose the position: Left, Center, or Right 

5. Click Insert picture button; the Insert Picture dialog appears:

Insert the Project 
Logo into the 
Header or Footer
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6. Navigate through your directory system and select the image file with the 
logo of your project.

7. Click Insert; the logo is now displayed in the header.

8. If the logo image is too big, you can click on it and selection handles will 
appear around the image. Point to a corner selection handle and drag it to 
resize the picture.

Any object you insert in the file increases the file size, so it is useful to determine 
an appropriate size and resolution for the logo before inserting it. This way you 
will be able to handle it in another application before moving it into Project to 
control the resolution and file size.

Built-in reports allow you to insert images and text boxes along the entire report, 
allowing you to save time on the page setup.

Before you start the spell checker, you should prevent Project 2013 from 
highlighting abbreviations or codes you use:

1. On the File tab, in the Backstage view, click Options, Proofing in order to 
access the spelling options that are relevant. 

2. In the When correcting spelling in Microsoft Office programs, check the 
following options:
h` Ignore words in UPPERCASE
h` Ignore words that contain numbers to eliminate stopping on 

abbreviations or codes
3. Under the When correcting spelling in Project, keep checked those 

columns you want the spell-checker to check; uncheck the rest.

Check the  
Spelling
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4. Click OK.

5. To perform the spell checking, on the Project tab, in the Proofing group, 
click the Spelling button (ABC) or just press F7.

6. When the spell checker displays a misspelled word in the Not In Dictionary 
field, you can:

h` Click Ignore or Ignore All to ignore one or all occurrences of the 
misspelled word
OR

h` Type the correction in the Change To box and click Change or click 
Change All.

h` Click Add in case you want to add the word to the user dictionary.

Project 2013 does not perform the spelling check for the additional text boxes 
you add. You may want to do this review in other office application such as Word 
2013 by copying and pasting the text box.

In views, you can insert a page break to control exactly what information prints 
on which page. Although this functionality is not by default in the ribbon, you 
can customize the Ribbon or the Quick Access Toolbar to make it available. 

1. On the File tab, in the Backstage view, click Options, Quick Access 
Toolbar. 

2. In the Project Options dialog, in the Choose commands from: drop-
down list, click All Commands.

3. Scroll down the commands box until you find the Insert Page Break 
command, click Add, and click OK. The Insert Page Break button is now 
available in the Quick Access Toolbar.

4. Select the task or resource where you want to begin the next page.

5. Click the Insert Page Break button. A line that represents the page break 
will appear above the task or resource you selected.

6. On the File tab, in the Backstage view, click Print and verify the page break 
in the Backstage Preview. 

To remove page breaks, position your cursor in any cell below the line of the 
page break (e.g., same cell when you inserted it) and click the Insert Page Break 
button.

Reports allow you to visualize the page breaks from the Design tab, in the Page 
Setup group. You can work with both Page Setup options to get the desired 
results, the one in the Print preview, and the one in the Design tab.

Insert Manual Page 
Breaks
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In views, the timescale often has to be adjusted either because it spills over onto 
the second page and you want to shorten it, or because it occupies only a small 
part of the page and you want to stretch it.

hh Shorten the Timescale
1. On the View tab, in the Zoom group, select from the list Timescale: 

Timescale… or double-click on the timescale; the Timescale dialog 
appears.

2. On any of the tier tabs (Top Tier, Middle Tier, Bottom Tier), 
decrease the Size percentage which will shorten the timescale. Check 
the Preview box at the bottom to see how far you can go.
Or
Modify the units by modifying the Units drop-down and the Count 
field. It is a good practice to start with the Bottom Tier, then the 
Middle Tier and if shown, the Top Tier. 

In the task and resource usage views, you can drag the width of the time unit 
columns to the size you want.

hh Stretch the Timescale to One-Page
1. On the File tab, in the Backstage view, click Print. Under Settings, 

click the Page Setup link. The Page Setup dialog appears.

2. Click the View tab and check Fit timescale to end of page. This will 
stretch the timescale to fill the page.

To send a schedule to colleagues:
By email:

1. On the File tab, in the Backstage view, select Share, and click Email.

2. Click the Send as Attachment button. The schedule will be attached to the 
email. The Choose Profile dialog may appear: select a user profile, and click 
OK. The new e-mail message dialog appears.

3. In the email body, fill in the To and the CC fields, and send the message.

Notice that you don’t even need to save your schedule before sending it; the 
system always sends the schedule as it appears on your screen

Export your schedule as PDF/XPS

If you don’t want your colleagues to be able to change your project schedule, you 
should create a Portable Document File (PDF) or a XML Paper Specification 
(XPS) using the new support of Project 2013 to export in those formats. 

Shorten or Stretch 
The Timescale

Share the 
Schedule with 
Colleagues
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1. Locate the view or report you want to export as PDF/XPS.

2. On the File tab, in the Backstage view, select Export, and click Create 
PDF/XPS Document. 

3. Click the Create PDF/XPS Document button. The Browse dialog 
will appear. Indicate the name of the file and the place to drop it. 

4. In the Save as Type box, select PDF or XPS format, and click OK.

5. In the Document Export Options, select the options you want to 
consider in the file and click OK.

Sometimes when printing or viewing your document, it is important to retain its 
data and formatting. Using the PDF and XPS formats in the Create PDF/XPS 
Document feature helps with this. Note that the PDF format is more frequently 
used for sharing documents than for printing documents.

Copy and Paste Views as Pictures:

For copying and pasting views, you can use the Copy Picture on the Task 
tab. This wizard has potential, but requires trial and error to adjust the copied 
picture, as it can be so small that you can’t read it. This is because the wizard 
doesn’t allow you to adjust the timescale (time units, skip factor for time units, 
zoom factor/size). We recommend that you first make it look good on the screen 
and then use this wizard to quickly export what you see on the screen to Word, 
PowerPoint, or Visio. 

1. To access the Copy Picture wizard, on the Task tab, in the Clipboard 
group, click the Copy down-arrow, and click Copy Picture.

2. In the Copy Picture dialog, select whether you want to render the Image, 
select the rows you want to copy or the entire image and the timescale you 
need.

3.    Paste the image.

Copy and Paste Reports:

For reports you can share with any software that supports graphics such as Power 
Point. Unlike copy picture for views, the Copy Report command in reports 
sends information in an editable format.

1. In the report you want to share, go to the Design tab, Report group, click 
Copy Report. This option will put the report on the clipboard.

2. From Power Point, click Paste.

3. Edit as necessary.
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To Sync the tasks with SharePoint for sharing purposes, please refer to the end 
of Chapter 3.

In this section we’ll prepare the Gantt Chart view for printing. Some of these 
options are available for many views.

Text styles can be applied to certain task types. The dialog is similar to the Font 
dialog except that the font dialog is used for formatting only those tasks that are 
selected, whereas the Text Styles dialog allows you to format based on the type 
of task.

1. On the Format tab, in the Format group, click Text Styles; the Text Styles 
dialog appears:

2. From the list Item to Change: at the top, select the type of task to change. 
Then select the format using Font, Font style, Size, and Color. Check the 
Sample box at the bottom to see your selections.

3. Click OK.

If you select the item All, all the text will be affected, even the text styles you 
previously set.

The Bar Styles group, on the Format ribbon allows you to color the critical task 
bars red. With the Text Styles dialog you can color the text of the task names of 
the critical tasks red as well to make them appear uniform and stand out whether 
you look in the spreadsheet or in the timescale.

Formatting & 
Printing the 
Gantt Chart 
View

Adjust Text Styles
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You can double the row height of only the tasks with long names (skip the first 
step if you want to do this) or you can double the height of all rows. The task 
names will wrap around automatically.

1. Select the tasks to adjust the row height by holding down the Control key 
and clicking the row headers of the tasks to adjust.

2. Point to one of the selected row dividers in the row headings (normally the 
ID column); make sure you see the double-headed arrow mouse pointer.

3. Drag the divider down to at least double the row height. Project 2013 will 
automatically wrap the text onto the second line, but only wrap the words 
in the text fields, like Task Name, Notes, and the extra fields (Text1, Text2, 
etc.).

OR

On the Format tab, in the Columns group, click Wrap Text icon.

You will double the number of pages in your printout if you double the row 
height for all rows.

hh You can wrap the text in the column headings as well. Right-click on the 
column heading and on the pop up list select Field Settings; in the Field 
Settings dialog check Header Text Wrapping and click OK. If the column 
width is too narrow for the title, it will start wrapping automatically.

hh You can also adjust the column width. Right-click on the column heading and 
on the pop up list select Field Settings; the Field Settings dialog appears. 
Click Best Fit; the column width automatically takes the appropriate width 
for all tasks in the project, even the ones not currently visible on the screen.

OR

Point to the divider in the column heading, and make sure you see a double-
headed mouse pointer. Double-click. The width of the column is now wide 
enough to accommodate the widest text in the field for the entire project 
(up to a maximum of about 150 characters).

You can put the vertical divider between the spreadsheet and the Gantt chart 
exactly on the border of a column.

1. Point with the mouse pointer anywhere on the vertical divider that separates 
the spreadsheet from the timescale; you should now see the mouse pointer 
in a vertical split divider form.

2. Drag it close to the column split where you want it.

Wrap Task Names

Adjust Column 
Width

Position the  
Pane Divider  
on a Column  
Split
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3. While you continue to see the mouse pointer in the vertical split divider 
form, double-click and the divider now jumps to the column split that is 
closest to it.

This option will change the timescale so that you can see the entire project 
within one screen width.

On the View tab, in the Zoom group, click Entire Project. 

In the Status bar, you are able to zoom in or zoom out by directly clicking on the 
zoom slider at the bottom right or on the View tab, in the Zoom group, click 
Zoom downward button, and select Zoom Out or Zoom In.

To customize the timescale to your exact preference:

1. Double-click on the timescale itself from the view. 

OR

On the View tab, in the Zoom group, in the list Timescale, select Timescale. 
The Timescale dialog appears:

2. If you want to display the third tier, select Three tiers in the Show list. 
Choose the settings for the Top Tier (top of the timescale), the Middle 
Tier and the Bottom Tier by clicking on the appropriate tabs. The Count is 
an increment: if it is set to 2 in a day-by-day timescale, it will go from the 1st 
to the 3rd and so forth. As a result, only every other day will be displayed.

3. Click OK.

Having three tiers in the timescale allows you to show the fiscal year and calendar 
year timescales next to each other so that there can be no misunderstanding 

View the Whole 
Project Timescale

Format the 
Timescale
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about dates. (You can set the start month of the fiscal year in File tab, Options, 
Schedule. Select from the list Fiscal year starts in.)

By using the Timescale drop-down menu, you are able to set the bottom tier and 
project automatically assigns the middle or upper tier a logical timescale that is 
larger than the previous. On the View tab, in the Zoom group, select from the 
list Timescale: the scale-unit for the bottom tier.

 To modify the format of the task bars:

1. Double-click anywhere in the background of the timescale area. 

OR

On the Format tab, in the Bar Styles group, click Format down-arrow and 
choose Bar Styles. The Bar Styles dialog appears:

2. In the list in the top half (see next screenshot), select the type of task for 
which you want to change the appearance: Task, Split, Milestone, Summary, 
Project Summary, etc.

3. Choose your settings for the selected task type at the bottom of the dialog 
on the Text and Bars tabs.

4. Click OK.

Some remarks about this powerful, but not so intuitive dialog box:

hh Order is important: Project 2013 first creates in the Gantt chart the task bar 
listed at the top, and then draws the second task bar on top of the first one. 

Format the  
Task Bars
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If they overlap, only the second bar can be seen fully. Therefore, the order in 
which the items are listed is important. Lower ones can cover higher ones 
in the list. 

hh Under Show For … Tasks:

h` The word Normal is used as a default for any task that is not a summary 
task, not a milestone, not a flagged and not any of the other task types 
shown in the pull-down list.

h` You can use the listed items. You can also type in the word Not in front 
of each item to create an exception for that type of task. Not Summary 
means format the task bars as specified for any task type except for 
summary tasks.

h` You can specify multiple criteria separated by a comma. The comma 
functions as a “logical and”, i.e., if you request Normal, Split the comma 
between Normal and Split means that it will apply this bar style only to 
tasks that are normal and have a split. No other tasks are affected.

hh The lists you can display in the fields From and To have all the regular task 
fields in them, but also some additional ones specifically for the timescale, 
like the CompleteThrough date and Negative Slack. Neither one is a regular 
task field you can display in the spreadsheet. The CompleteThrough is used 
in the Tracking Gantt to display progress bars. 

hh On the Text tab in the bottom half of the dialog, you can add text to the 
left of, the right of, or even inside the task bars. You will find the following 
default settings in the Gantt Chart:
h` Resource Names are shown to the right of detail task bars.
h` The Start dates are shown to the right of milestone diamonds.

To create a header, footer, or legend:

1. On the File tab, in the Backstage view, click Print. Under Settings, click 
the Page Setup link, and the Page Setup dialog appears. Click the tab 
Header, Footer, or Legend:

Create a Header, 
Footer, or Legend

J. Ross Publishing; All Rights Reserved



560

Dynamic Scheduling® with Microsoft® Project 2013

2. Click the tab Left, Center, or Right and position the cursor inside the text 
box where you want to add a reference to project data. You can even press 
Enter to create extra lines.

3. Select a reference from the General list at the bottom such as Project 
Title and click Add. The reference is inserted at your cursor position. 
Add as many text references as needed; most refer to data entered in 
Advanced Properties (on the File tab, Backstage view, Info tab, Project 
Information) and the Project Information (on Project tab, Properties 
group) dialogs and all start with an ampersand (&). You can also type literal 
text such as: Page &[Page] of &[Pages], which will print as Page 1 of 9.

4. Using the Project fields list at the bottom, you can insert project-level 
information, like the Baseline Finish and forecast Finish date, or the 
Baseline Cost and forecast Cost, or calculated values, like the % Complete 
and Remaining Duration for the project.

5. Click one of the buttons to add information quickly:

Button 
(from left 
to right)

For

Format Text 
Font

Font, size, and style
To format the text in the header, select the text first, and then 
click the Format Text Font button

Insert Page 
Number:

Page number
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Button 
(from left 
to right)

For

Insert Total 
Page Count:

Total number of pages

Insert Current 
Date:

The system date

Insert Current 
Time:

The system time

Insert File 
Name:

The schedule name

Insert Picture: Takes you into a dialog for inserting a graphic image into the 
header, footer or legend; often used to insert the project logo.

6. Click OK.

The Notes field can hold a lot of text; there is virtually no limit to it. You may 
need to capture a lot of text when creating a WBS dictionary or capturing 
checklist items or reminders to yourself. To include the notes in a report, you 
can print all the notes together on a separate notes page using a view.

The following is an example of a separate notes page using views:

Reports That 
Include the 
Notes
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To create it, follow these steps:

1. In the Gantt Chart, on the File tab, in the Backstage view, click the Print 
tab. Under Settings, select Notes from the first down-arrow list.

OR

Click the Page Setup link. The Page Setup dialog appears.

2. Click the View tab.

3. Check Print notes.

4. Click OK.

Some of the more common printing issues, their symptoms, and fixes are listed 
in the following table.

Printing Issue Symptom Fix
Timescale cropped The last unit of time 

on the time line is 
truncated at the edge 
of the page.

Choose Page Setup, View. Select 
Fit timescale to end of page. Check 
results in Print Preview.

Wrong print range The printout contains 
too many or too few 
rows or columns from 
the selected table.

Pre-select the desired number of rows 
in the table. Also, in Page Setup, 
View, select Print first [x] columns 
on all pages to pre-set the desired 
number of columns from the table. 
Check results in Print Preview.

Wrong page breaks 
in Views

The page break occurs 
at an inappropriate 
place in the selected 
list of rows from the 
table.

Select the row in the data table just 
below where you want the page 
break to appear. Choose Insert, Page 
Break to force the page break at that 
location. Check results first in Print 
Preview.

Wrong zoom factor The printout of the 
chart portion of the 
Gantt Chart view has 
either too narrow or 
too wide a time line. 

In the Standard toolbar, click either 
Zoom In or Zoom Out to adjust 
the timescale before printing. Check 
results in Print Preview.

Wrong legend data The data displayed 
in the legend area is 
either incorrect or 
missing.

Choose Page Setup, Legend. Fill in 
the Legend with the desired text or 
field names. Check results in Print 
Preview.

Common 
Printing 
Problems and 
Their Fixes

J. Ross Publishing; All Rights Reserved



Chapter 11: Reporting

563

11

Printing Issue Symptom Fix
Wrong page breaks 
in Reports

The page break cuts 
part or a table or a 
graph.

In the report, in the Design tab, in the 
Page Setup group, click Page Breaks. 
Modify the Margins, Orientation, 
and Size of paper in the same 
ribbon plus drag, drop, and resize as 
necessary.
In the File tab, Print preview, click 
Page Setup and modify the Scaling.

A macro is a piece of programming code. You can insert a macro into a Project 
file to add new functionality or to simplify the use of Project 2013.

Using macros, you can customize your project so it fits almost every requirement 
you or your user may have. For example, you can:
hh Insert predefined tasks in your project, including their names, duration, etc., 

with a single click.
hh Add a new capture form to register customized fields values, simplifying the 

capture process if your project has a large number of customized task fields.
hh Transfer the data from your project to Excel or another system in a specific 

required format.
hh Transfer data from another system to your project, validating the data in the 

process. The macro can also generate a log file to show you the changes in 
your project and any external data that was not accepted.

hh Do an automatic review of the quality of your project, considering the 
criteria and rules defined in your organization. For example, the macro can 
check that all the task names in the first level of the WBS start with a three 
digit code.

Some of these examples require programming skills, but you can make very 
interesting macros with not too much effort.

In order to use the macro options, you must configure the Macro Settings in the 
Trust Center so the macros are enabled. On the View tab, in the Macros group, 
click Macros down-arrow, and select Macro Security. There you can select 
Enable all macros and click OK.

You can create a macro in two ways:
hh Use the Record Macro menu option (no programming)

How to Build a 
Macro
What is a macro?
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hh Write the programming code directly in the Visual Basic for Applications 
(VBA) editor

Let’s create a simple macro that changes the font color of a selected cell to red:

1. Select a task in the Task Name field.

2. On the View tab, in the Macros group, click Macros down-arrow, and 
select Record Macro.

OR

On the Developer tab, in the Code group, click Record Macro.

If you don’t have the Developer tab displayed, you will need to activate it. On 
the File tab, in the Backstage view, click Options, Customize the Ribbon. On 
the right box under Main Tabs, check the box Developer and click OK.

3. Fill the Record Macro dialog box:
a. Macro Name: <ChangeCellToRed> (the macro name cannot have 

spaces nor special characters).
b. Enter the Shortcut Key (E, for example) that you want to use to 

execute the macro. Most of the letters cannot be used here because they 
are already associated with another action. Usually A, E, J, L, M, Q, are 
available. (If, when you finish this procedure, your macro does not run, 
try changing the shortcut key).

c. Select Store macro in: <This Project>.
d. Capture any description you like.
e. Under Row References: keep selected Relative (the default value).
f. Under Column references: keep selected Absolute (the default 

value).

Create a macro 
using the Record 
Macro menu 
option
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4. Click OK.

After you click OK, Project 2013 records every action you perform, so be careful 
to perform only the actions you want the macro to capture. Since Project 2013 
is recording, the Record Option in the Developer Menu has changed to Stop 
Recording.

5. On the Task tab, in the Font group, click Font Color down-arrow, and 
select Dark Red. You just changed the selected cell font color to red.

6. On the Developer tab, in the Code group, click Stop Recording.

Your macro is generated. You can now simply click Ctrl+E (or whatever key you 
selected as shortcut key) on any cell to change the font color to red. Or you can 
select multiple cells in the usual way (with Ctrl or with Shift keys) and run the 
macro. All the selected cells will be in red.

You can undo the macro’s actions with Undo (Ctrl+Z).

All macros, including the ones created with the Record Macro option, are 
generated with VBA code.

For this example, we will use the previous macro. To follow the example we 
recommend that you first use the Record Macro option described in the previous 
steps to record the macro.

To see the code generated by the Record Macro option with the VBA Editor:

1. Do one of the following:

On the Developer tab, in the Code group, click Visual Basic.

OR

Press Alt + F11

In the Visual Basic for Application Editor, the left side of the screen 
shows a Project Explorer window, the right side shows the code window.

2. In the Project Explorer (left) window, in the VBA Project branch, select 
the Project you are using under the folder Microsoft Project Objects.

3. In the Modules folder double-click to open Module1. You can now see 
something like this:

Create a macro 
writing VBA code
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The VBA code of the macro you created is displayed in the Code Window. The 
Sub <ChangeCellToRed> is the subroutine that performs the color change on 
the selected cell.

It is beyond the scope of this book to explain Visual Basic structures and 
programming techniques, but here is a piece of code that facilitates the review of 
a schedule by performing the following actions:

hh Verify that the current project has a status date.

hh Verify for each detail task in the project that if the task started before the 
status date and the task’s % Complete field equals 0, informs the user that 
the task must be updated.

The macro’s name is <CheckTasksNotUpdated>.

To start writing the code: 

1. Go to the Visual Basic for Application Editor by pressing Alt + F11. 

2. In the Project Explorer (left) window, in the VBA Project branch, under the 
folder Microsoft Project Objects, right-click the <Project> you are using, 
point Insert and select Module. 

3. On the Module window, you can start capturing the code. Notes after an 
apostrophe are simply comments to clarify the code. 

Check Tasks Not 
Updated Macro
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After you’ve created the macro, here’s how you run it:

On the Developer tab, in the Code group, click ViewMacros, select the macro 
CheckTasksNotUpdated and click on Run.

For each situation you will see a window:

hh If the macro found that the Status Date is not established then it shows a 
message like this: 

hh When the macro finds a task scheduled to start earlier than the Status Date 
and % Complete of 0, it displays a message like the following:
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hh At the end of execution, the message is:

The code in this example is self-documented, so you can follow it easily. If you 
have any doubts, you can copy the code to your project from the file IIL Project 
2013 Tools.mpp.1

For example, selecting the word MsgBox and pressing F1 opens the help 
window with the following information:

1 The file IIL Project 2013 Tools.mpp is available for download at www.jrosspub.com. Click the link WAV 
Download Resource Center to enter the download site.
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Macros are a very powerful tool in Project. We think you’ll find it worthwhile to 
study and use them.

Use the following checks to verify whether you used best practices for project 
reporting. The checks pertain to what custom view objects you developed in 
your schedule:

hh Is there a one-page status report available as a separate view object in your 
project schedule that displays the major milestones relative to the baseline?

h` Are the milestones filtered in this view instead of listed together in the 
WBS?
h` Many project managers put the major milestones at the top of their 

schedule to create a one-page overview of the project. This makes 
the network of dependencies very complex in the Gantt Chart, 
because the dependencies run up and down with long arrows. 
Instead, we recommend using a separate view that displays all 
milestones using the Milestones filter.

h` Are the appropriate milestones chosen to represent the status and to 
forecast a large project?
h` If you have many milestones, you may end up with multiple 

pages. Instead of reporting on all milestones, you can mark certain 
milestones as major milestones using a flag field (Flag1 - Flag20). 
The filter of the view should display these major milestones. 

Checks on 
Reporting
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If you are using the Timeline view, you can just select the milestones or 
tasks you want to show and Add or Remove the from the Timeline. On 
the Task tab, in the Properties group, click Add to Timeline and click 
again if you want to remove it.

h` Does the one-page view report give an appropriate impression of the 
health of the project?

hh If your schedule has a Resource-critical path, is there a separate view object 
that displays it?

The view should have the resource-critical tasks flagged in the field Marked 
or in a Flag field.

hh Is there a set of views or built in reports with an appropriate selection of 
objects to deliver different information to different stakeholders?

hh Does the report answer the primary concerns of the audience?

Using the views and built-in reports is a great idea, however you must be 
able to explain the information displayed in such reports. It is important to 
be familiar with the information needs of the stakeholders and apply the 
necessary modifications to answer those questions. For this reason you have 
to understand the applied filters, groups, formats, printing settings, and 
limitations of the delivery format (PDF, XPS, Excel, Power Point, etc.). For 
example, an executive needs to answer some questions that may be included 
in the built in Cost Overview dashboard, however the last time he saw this 
report, he was not able to see Level 2 information and also requested a brief 
explanation of why the remaining cost for the last phase was reported above 
the baseline cost. You can add an additional Cost Status table displaying a 
Level 2 of the WBS by copying and pasting the existing table and inserting a 
Text Box with a brief explanation of the changes from last report to this one. 

hh Are you aware of the format in which every stakeholder prefers to review 
the information? Some stakeholders prefer graphics (use Visual Reports 
and the new graphic reports), others like fast and understandable tables 
(use views and tables), while others analyze the information in other tools 
like Excel or other databases (save the database in an OLAP cube or Access 
format). 

hh Is there a process when updating your project that you can automate?

You can start your own macros to facilitate this process.
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1. Is it possible to create a one-page report for a 1,000-task schedule that 
reflects the performance of the project? Would you recommend doing this? 
What feature would you recommend in Project 2013?

2. What are the different reporting options in Project 2013? 
What are their main differences?

3. What objects, elements, and settings are stored in a view?

4. How can you transfer an object to another project schedule?

5. Can you print the following items?
Would you do this through a report or through a view? 
Please indicate the exact name of the report or view.

Can you print? Yes/No
Through which Report 
or View? 

a. Gantt Chart  

d. Comparison between Project 
progress and Cost

 

c. Resource Calendar  

d. Cash outflow report  

e. Notes  

6. How would you quickly format all the milestone task names and milestone 
Gantt bars?

7. How would you create a Visual Report in Excel for a Resource Work 
Summary Report?

8. What information should be included in your header, footer, or legend on 
every printout? Why?

9. We discussed several ways to display the critical path on the Gantt chart. 
Name one of those ways.

10. Is there a way in which you can easily display the entire project duration 
in the timescale on your screen? If so, what are the steps in Project 2013 to 
accomplish this?

11. Discuss ways in which you might modify versions of a status report to better 
address the needs of the target audiences.

Review 
Questions
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For experience working with the features you’ve learned about in this chapter, 
we strongly suggest that you do the additional exercises for this chapter that are 
included in Case Studies appendix, available to download in the WAV Download 
Resource Center at www.jrosspub.com. 

Additional Practice
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Chapter 12: Earned Value Management

In previous chapters, we’ve reviewed how to effectively use Project 2013 to 
plan and control a project. In this chapter, we’ll explain what Earned Value 
Management (EVM) is, and how it can be applied using Project 2013.

After reading this chapter you will be able to:

hh Explain EVM elements
hh Integrate scope, schedule, and cost into a planned performance measurement 

baseline for applying EVM
hh Identify the different Earned Value Measurement methods and how to 

apply them with Project 2013
hh Explain the different settings and options that control EVM calculations in 

Project 2013
hh Measure the value you have earned on your project by comparing the 

planned to actual work
hh Evaluate schedule, cost, and work performance on a project
hh Identify variances between actual and baseline information
hh Get forecasts for your projects
hh Update and maintain the project performance baseline
hh Print EVM reports 
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A key success factor in any project is the project manager’s ability to make the 
right decisions on a timely basis. You can only do this if you have information on 
your project’s progress that is clear, reliable and up-to-date. Equally important 
is the ability to give stakeholders like customers and sponsors clear and concise 
information about the project’s progress and probable outcome.

EVM is an approach to measuring project performance that is based on 
comparing planned and actual progress related to scope, time, and cost.

If you have a good EVM system in place, you’ll get the feedback you need, and 
this will enable you to identify problems and issues early, report them, and help 
you keep your project on time and on budget.

EVM is a controversial topic. Some people believe it’s impossible to manage a 
project successfully without EVM and that it is fundamental to making correct 
decisions on their projects. Others think that EVM is a complex technique that 
isn’t worth the effort necessary to implement it.

At IIL, we are in the first group: we think EVM is important. We believe that 
those who are not convinced about the advantages of EVM may not know how 
to simplify its application with a tool like Project 2013. In some countries like 

Overview of 
Earned Value 
Management

Didn’t you say you were 90% done?

Yes, we have 90% of the materials 
and we have used 90% of the time.
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the US, there are government agencies and other organizations that mandate the 
use of EVM in managing projects.

EVM gives you objective answers to the most common questions asked in a 
project environment: 
hh How is the project going?
hh Are we ahead of or behind schedule?
hh Are we running under or over budget? 

EVM also helps you answer questions about the future of your project such as:
hh What is the remaining work going to cost?
hh When is the project going to finish?
hh What will the total cost be?

Because EVM helps you analyze performance patterns and trends, you can make 
forecasts and based on them, implement needed corrective actions.

In order to implement EVM in a project, it’s critical to integrate the approach in 
the initial planning of the project. EVM must be used to define, in an integrative 
way, what work is to be done in the project (scope), when the work should be 
done (schedule), and the needed resources and their rates to perform the work 
(cost). With these three key parts—scope, schedule and cost—you can define a 
Performance Measurement Baseline (PMB) and get commitments from the key 
stakeholders. A PMB is an approved and integrated scope-schedule-cost plan 
for the work against which project execution is compared to measure project 
performance, as shown in the following graphic.

Time

Cost

Scope (WBS)

Cost 
(Cost Estimate - 

Budget)

Performance Measurement 
Baseline

$1
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During project execution EVM is used to monitor and control the planned 
work by providing information on progress in a clear and accurate way. EVM 
is a critical assist in helping you keep the project performance within tolerance 
limits you determine for variances against the PMB, and in allowing you to make 
reliable forecasts related to project completion.

There are three key values (and other calculated values) which are used to 
measure all progress. The three key values are:

hh Planned Value (PV)
PV is the value of the performance measurement baseline at the status date. 
It represents what you should have done according to the plan. It is also 
known as the Budgeted Cost of Work Scheduled (BCWS).

hh Earned Value (EV)
EV is what you have accomplished at the status date, valued with the costs 
used to define the performance measurement baseline. EV is also known as 
Budgeted Cost of Work Performed (BCWP).

hh Actual Cost (AC)
AC is the cost you have incurred for the accomplished work at the status 
date. AC is also known as Actual Cost of Work Performed (ACWP).

The three key elements described above can also be expressed in percentages, 
dividing the values by the final project planned cost in the original performance 
measurement baseline, which is known as Budget at Completion (BAC).

hh Planned Value Percentage (PV%): PV% = PV / BAC
hh Earned Value Percentage (EV%): EV% = EV / BAC
hh Actual Cost Percentage (AC%): AC% = AC / BAC

Based on these three key values, you can calculate variances, indices, and 
forecasts as follows.

hh Schedule Variance (SV). SV = EV – PV
SV represents the deviation against the baseline schedule at the status date.

hh Cost Variance (CV). CV = EV – AC
CV represents the deviation against the baseline cost at the status date.

hh Schedule Variance Percentage (SV%). SV% = SV / PV
SV in percentage

hh Cost Variance Percentage (CV%). CV% = CV / EV
CV in percentage

The Basic 
Elements

Variances
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A positive variance means performance is better than planned, zero variance 
means performance is as planned, and a negative variance means performance 
is worse than planned.

hh Schedule Performance Index (SPI). SPI = EV / PV
SPI is the efficiency rate for measuring schedule performance: it tells you 
whether you are ahead of, on, or behind schedule.

If the status date is later than the finish baseline date and the project or task 
is not finished, the SPI will only improve as work progresses. In this case, 
SPI will always be equal to one when work is finished independently of the 
actual finish date; thus, SPI does not provide any schedule performance 
information after a project or task is finished.

hh Cost Performance Index (CPI). CPI = EV / AC
CPI is the efficiency rate to measure cost performance: it tells you whether 
you are under or over budget.

Indices greater than one mean performance is better than planned, indices 
equal to one mean performance is as planned, and indices less than one 
mean performance is worse than planned.

hh To Complete Performance Index (TCPI). TCPI = (BAC – EV) / (BAC – 
AC)
TCPI is the efficiency rate required for the remaining work needed to finish 
the project within budget.

A TCPI of greater than one means cost performance for the remaining work 
must be better than planned to finish on budget, a TCPI equal to one means 
cost performance for the remaining work must be as planned to finish on 
budget, and a TCPI less than one means cost performance for the remaining 
work could be less than planned and still finish on budget.

hh Estimate at Completion (EAC).
The forecasted final project cost. EAC can be calculated in different ways, 
depending on historical performance data and trends.

h` EAC = BAC – CV
Future costs would be the same as in the baseline because variances to 
date were atypical.

h` EAC = BAC / CPI
Future costs are calculated based on the cost performance efficiency 
rate to date.

h` EAC = BAC / (CPI * SPI)
Future costs are calculated based on the cost and schedule performance 
efficiency rates to date.

Indices

Forecasts
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h` EAC = AC + New estimate for remaining work
Future costs are calculated based on a new cost estimate.

hh Estimate to Complete (ETC). ETC = EAC – AC
Forecasted cost of remaining work

hh Variance at Completion (VAC). VAC = BAC – EAC
Forecasted cost deviation at project completion

hh Variance at Completion Percentage (VAC%). VAC% = VAC / BAC
VAC in percentage

hh Cost Performance Index at Completion (CPIAC). CPIAC = BAC / EAC
The forecasted cost performance efficiency rate at project completion

There is an approach in EVM that takes time-based schedule measures instead 
of cost measures to calculate the schedule performance, using the time axis (x) 
instead of a cost axis (y) in calculations.1 The idea is to have schedule performance 
using durations instead of cost values.

The previous forecasts, variances, and indices are all cost related. Using EVM 
you can also calculate time-based forecasts, variances, and indices as follows:

hh Time Estimate at Completion (EACt). The forecasted duration of the 
project.
EACt = (BAC / SPI) / (BAC / Baseline Duration) = Baseline Duration / 
SPI

SPI is used to generate a rough estimate of when you will complete a project 
if the trends continue. It’s a good estimate, but doesn’t take into account the 
critical path and slacks. For example, you may have delays in non-critical tasks 
that cause an SPI less than one, that will cause an EACt greater than the baseline 
duration. Analyzing the critical path in your schedule will enable you to see if 
you will deliver on time.

Our recommendation is to use a dynamic schedule and update remaining work 
that will allow you to update the whole schedule. The updated duration of your 
dynamic schedule will be your best EACt. 

hh Time Variance at Completion (VACt). VACt = Baseline Duration – EACt 
Forecasted schedule deviation at project completion

hh Time Variance at Completion Percentage (VACt%). VACt% = VACt / 
Baseline Duration VACt in percentage

1 ——— Practice Standard for Earned Value Management, 2nd Edition, PMI, 2011, p. 97.

Forecasts with 
Time-Based 
Schedule Measures 
in EVM
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hh Time Schedule Performance Index at Completion (SPIACt).
SPIACt = Baseline Duration / EACt
Forecasted schedule performance efficiency rate at project completion.

SPIACt in conjunction with SPI provides adequate schedule performance data, 
when the status date is later than the finish date, and after the project or task is 
finished.

The EVM key elements, variances, indices, and forecasts previously explained 
are shown in the following graphic. 
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In summary, EVM gives you a better and more complete picture of project 
performance and helps you to make forecasts, but more importantly, it gives you 
the feedback you need to make the right decisions about the remaining work and 
to propose corrective actions that enable you to finish on time and on budget. 

We are going to present how to apply EVM using Project 2013. You need to enter 
certain elements correctly in your project to obtain correct EVM information.

There are many EVM tables, views and fields that come with Project 2013 that 
will help you to manage your projects. You can also customize fields in Project 
2013 in order to cover all of the calculations mentioned above. We’ll cover these 
as they arise in the chapter.

As stated above, EVM relies on having a well laid out plan that addresses scope, 
schedule, and cost. Let’s look more deeply at that requirement.

During project scoping, you need to decompose the project work into 
manageable elements that will be the control cells of your project; these 

Applying 
Earned Value 
Management 
with Project 
2013
EVM and Planning

Scope
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elements are commonly called control accounts. Control accounts are where 
scope, schedule, and budget (planned cost) all come together at a level of detail 
in the WBS. Control accounts are made up of one or more work packages. Each 
work package must be in one and only one control account. If you develop a 
good WBS, you will have an excellent foundation for applying EVM.

As we’ll discuss later in this chapter, you need to define the detail level you want 
to manage in the control accounts because this will allow you to implement 
EVM in a practical way with Project 2013.

We recommend that you establish the control accounts at the lowest level of the 
WBS (detailed tasks) in Project 2013 because it is where the duration, resources, 
and costs are defined.

Once you’ve defined the WBS, we recommend that you assign a unique 
management responsibility for each control account. You can do this easily 
using a Responsibility Assignment Matrix.

EVM relies on a schedule for the accomplishment of the work. In terms of 
schedule, EVM can be applied with the static information we get from a Gantt 
diagram, but we highly recommend that you have a dynamic schedule that will 
enable you to respond to change and keep the schedule up to date. The schedule 
enables you to see what accomplishments were planned for what points in time, 
and then determine the degree to which the project is both on schedule and on 
budget.

To use EVM you must provide resource effort and cost estimates for tasks. As 
you’ve learned, Project 2013 allows you to manage different types of resources 
and rates to model all project costs.

If for some reason you won’t be performing detailed resource control, you can 
manage fixed cost to the control accounts. This is useful in large projects where 
you need to control costs on a higher level, or when you have subcontractors 
who do their own detailed resource control. 

EVM requires a time-phased budget: this is the key to effective implementation 
of EVM. A time-phased budget is a project budget that identifies how much 
money or labor is to be expended on each task for each time period in the 
project schedule. Project 2013 will automatically generate the time-phased 
budget if you have created a schedule and entered effort and cost data for your 
control accounts. But it may not be exactly what you need for monitoring and 
controlling with EVM. You need to address a fundamental question, which is 
how you are going to measure the progress of task completion, and reflect this in 
your planning information in Project 2013. 

Schedule

Resources  
and Cost

Time-Phased 
Budget and 
Earned Value 
Measurement 
Methods
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PMI’s Practice Standard for Earned Value Management2 describes Earned Value 
measurement methods. The following table is an adaptation of the methods 
established in the PMI standard. The methods primarily refer to the way you 
account for task progress. 

Planning and Progress Earned Value Measurement Methods
Deliverables or 
Work Product 

Characteristics

Duration of  
Work Effort

Recommended EV  
Measurement Method

Tangible

1 or 2 Measurement 
Periods Fixed Formula

More than 2 
Measurement Periods

Weighted Milestones

Percent 
Complete

% Duration Complete
% Work complete
% Physical Units Complete
% Physical Complete

Intangible Any Apportioned Effort
Level of effort

As we can see from the table, the recommended method for measuring progress 
on task completion depends on two factors: the tangibility of the deliverable 
being produced and the task duration.

The following discussion of various EV measurement methods includes 
recommendations for how to model each method in Project 2013 based on the 
results we’ve obtained in real projects. You may find, though, that there are other 
modeling methods and techniques that provide good results as well.

This is a simplified method for assessing task progress quickly and easily. The 
most common fixed formulas are 0/100 and 50/50. With the 0/100 formula, 
no progress is credited until 100% of a task or deliverable is done. With 50/50, 
you credit a task or deliverable as 50% complete when the task is started, and the 
other 50% when it’s finished. Any other percentage combination can be used, 
e.g., 30/70, 25/75.

We recommend this method when you have short duration tasks (one or 
two reporting periods) and when you don’t want to have to bother with the 
evaluation of partial task progress during the project. 

hh Fixed Formula 0/100 in Project 2013
To model tasks with a 0/100 formula in Project 2013, the simplest method 
is to select End in field Accrue At in the resource you are assigning to the 
task. If you are not assigning resources, just directly a fixed cost, then select 
End in tasks field Fixed Cost Accrual. 

2 ——— Practice Standard for Earned Value Management, 2nd Edition PMI, 2011

Fixed Formula
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If you modify the field Accrue At for a resource, costs will be accrued 
at the end of the task for all tasks to which this resource is assigned. You 
should review whether the resource is used in other tasks where other EV 
measurement methods would be more suitable.

hh Fixed Formula 50/50 in Project 2013
There is no direct way to apply the 50/50 formula method in Project 2013. 
You need to break down the task into two subtasks: one for the first 50% 
with resources or fixed costs accrued at the start, and the other for the 
remaining 50% with resources or costs accrued at the end. (You can take the 
same approach with other splits, e.g., 30/70, 25/75.)

We’ve seen schedules with costs prorated to generate the baseline, and then 
progress managed with the 50/50 formula, crediting 50% of progress at 
the actual start, and 100% at the finish. This is a mistake: for the correct 
application of EVM, the baseline must be generated with the same approach 
that you will use to track progress. 

The following picture presents examples of tasks planned with Fixed Formulas. 
It includes a Gantt Chart view and a Task Usage view. The tasks included have 
the following characteristics:

hh Task 1. Normal Task. 10 days duration, Resource 1 assigned with rate 
$100/hr, accrued prorated.

hh Task 3. 0/100 with Resource. 10 days duration, Resource 0/100 assigned 
with rate $100/hr, accrued at end.

hh Task 4. 0/100 with Fixed Costs. 10 days duration, $8,000 fixed cost 
accrued at end.

hh Task 6. 50/50 with Resource, broken down into two tasks:
h` Task 7. 50% at the beginning. 5 days duration, Resource 50/50 B 

assigned with rate $100/hr, accrued at start.
h` Task 8. 50% at the end. 5 days duration, Resource 50/50 E assigned 

with rate $100/hr, accrued at end.

hh Task 10. 50/50 with Fixed Costs, broken down into two tasks:
h` Task 11. 50% at the beginning. 5 days duration, $4,000 fixed cost 

accrued at start.
h` Task 12. 50% at the end. 5 days duration, $4,000 fixed cost accrued 

at end.
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As you can see, the 0/100 formula is easy to apply, but the 50/50 formula triples 
your number of tasks (the summary original task and two subtasks.) This could 
complicate your planning, but also simplify your monitoring and controlling.

The weighted milestones method is recommended for tasks with relatively 
long durations (more than two reporting periods), where it could be difficult to 
evaluate partial progress, but where you have specific milestones with verifiable 
deliverables to which you can assign weighted values in relation to the total cost 
of the task.

hh Weighted Milestones in Project 2013
The easiest way to apply weighted milestones is to break the task into 
the different required milestones, and assign to each new task fixed costs 
according to its specific weighted value. To model the durations, you can 
link the milestones and define lag times.

If you need to manage resources for a task, do not assign resources as milestones 
if you are going to use EVM. A milestone has zero duration, so the work will 
always be zero, and all EVM will also be zero.

If you need to manage resources, we recommend that you break down the task 
into subtasks with material resources, with rates according to the weighted 
values, accrued at the end. These subtasks will have the duration needed to 
reflect the delivery times, and if you want, they can be marked as milestones so 
they are represented with the milestone symbol in the Gantt diagram.

The following screen shows two tasks with weighted milestones. One has 
milestones and fixed costs, and lag times in the links to establish the durations. 

Weighted 
Milestones
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The other has subtasks with the durations shown and marked as milestones, 
with material resources with costs accrued at the end. They are shown in the 
Gantt Chart view and Task Usage view.

The most generally used EV measurement method is percent complete, where 
progress is credited according to the percentage completed at the status date. 
The main problem with this approach is establishing an objective way to decide 
the percentages of progress. We’ll cover this later.

You can calculate the percent complete using any of four methods that are 
suitable for different situations:

hh % Duration Complete = Actual Duration/Total Duration
This can be used for almost any task; the only condition is that you use the 
actual duration to date to establish the amount of progress. This means that 
the task will have a continuous linear performance through its duration. % 
Duration Complete can be misleading for many, if not most tasks. A task 
estimated for two weeks is not necessarily 50% complete because 50% of 
the duration has passed. To apply this in Project 2013, you just need to 
establish the plan and the Performance Measurement Baseline and then use 
% Complete as the Earned Value method, showed later in this chapter in 
the EVM Performance Analysis and Forecasting section.

hh % Work Complete = Actual Work/Total Work
This is recommended for tasks where the progress on work is uneven, for 
example where the assigned resources work different hours per day, or where 
you have split tasks. Note that total work is actual work + remaining work. 

Percent Complete
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Estimated remaining work to completion should be assessed regularly. This 
option is not included in Project 2013, see the Advanced Topic Appendix 
for Earned Value Management for further explanation to apply it.

hh % Physical Units Complete = Actual Units/Total Units
Use this measure when the task has material outcomes or deliverables that 
you can measure in physical units (e.g., number of items produced, tons, 
cubic meters, etc.) that are relatively equal in effort applied and proportion 
of time used. This option is not included in Project 2013, see the Advanced 
Topic Appendix for Earned Value Management for further explanation to 
apply it.

hh % Physical Complete
Use when the partial progress of the task is determined based on the subjective 
evaluation of physical progress made toward producing its deliverables, and 
this physical progress can’t be evaluated with an objective measurement 
like one of the three described above. To apply this in Project 2013, you 
just need to establish the plan and the Performance Measurement Baseline 
using the Physical % Complete as the Earned Value method, shown later in 
this chapter in the EVM Performance Analysis and Forecasting section. 

This method is recommended when a task has a direct relation with another task 
that has its own EV measurement method. The first task could have a tangible 
and verifiable deliverable, but it is difficult to evaluate its partial progress. Instead 
we can define its partial progress according to the partial progress of the related 
task. An example of this kind of task could be the quality assurance (QA) of a 
design task. To apply this method in Project 2013, the only thing you need to 
do during planning is to make sure both tasks use the same EV measurement 
method. 

There are tasks that do not produce tangible and verifiable deliverables, or that 
produce a lot of them and you do not want to control them individually, for 
instance, in a project management task where you produce a lot of products 
like analysis, plans, updates, reports, meetings results, etc. For these tasks, we 
recommend you use the method called Level of Effort (LOE), which means to 
assign a certain level of resources during task duration, without specific criteria to 
evaluate partial progress on the task. To apply this in Project 2013, just assign the 
resources needed to the corresponding tasks; no special adjustment is needed.

To get the PMB in Project 2013, you need to set the baseline of your project (see 
Chapter 10).

The total cost of the project that you have defined in your baseline is known as 
Budget at Completion (BAC). In Project 2013 the name of the field is Baseline 
Cost, although it is shown as BAC in the different Earned Value tables.

Apportioned Effort

Level of Effort

Performance 
Measurement 
Baseline
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Project 2013 has integrated all that you need to manage the three EVM basic 
elements, with some considerations we’ll explain.

In Project 2013, PV is calculated automatically based on your status date and 
your previously established baseline. The name of the field is BCWS, although 
in the different views it appears as Planned Value - PV (BCWS), but this is just 
the label for the column title.

If you manage different baselines in your project, you can select which baseline 
you want your calculations to report against. 

1. On the File tab, in the Backstage view, click on Options. In the Project 
Options dialog box, click Advanced.

2. Use the scroll bar to see the Earned Value options for this project, and on 
Baseline for Earned Value calculation, select which Baseline you want to 
use to make earned value comparisons in your project, then click OK.

EVM 
Performance 
Analysis and 
Forecasting
The Basic 
Elements with 
Project 2013
Planned Value (PV)
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In Project 2013, the name of the earned value field is BCWP, and it is shown as 
Earned Value - EV (BCWP) in different views. Project 2013 uses one of two 
calculations for EV, depending on which you have previously selected:
hh EV = % Complete * Baseline Cost
hh EV = Physical % Complete * Baseline Cost

As you see, these two methods of calculation don’t cover all the EV measurement 
methods described above, but we’ll see how you can apply the others, and what 
advantages and limitations you will encounter. 

You can select % Complete or % Physical Complete for the whole project.

1. On the File tab, in the Backstage view, click on Options. In the Project 
Options dialog box, click Advanced.

2. On Advanced, use the scroll bar to see the Earned Value options for 
this project, and on Default task Earned Value method select whether 
% Complete or Physical % Complete should be used for earned value 
analysis in your project, then click OK. 

If you want to change the method for a specific task(s) rather than all tasks, in the 
task dialog box, Advanced tab, in Earned value method, select % Complete 
or Physical % Complete, as you see in the screen below.

In Project 2013 the name of the actual cost field is ACWP, and it is shown 
as Actual Cost - AC (ACWP) in the different views. Project 2013 by default 
calculates AC as you enter your progress, but you can choose to enter the AC.

1. On the File tab, in the Backstage view, click on Options. In the Project 
Options dialog box, click Schedule. 

Earned Value (EV)

Actual Cost (AC)
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2. On Schedule, use the scroll bar to see the Calculation options for this 
project and then uncheck the Actual costs are always calculated by 
Project box. 

If you want the three basic EVM elements in percentages, you will need to define 
customized fields in Project 2013. You need to divide the values by Budget at 
Completion (BAC). Remember that in Project 2013, BAC is in the Baseline 
Cost field.

As an example, here are the steps for defining PV%:
1. On the Format tab, in the Columns group, click Custom Fields. The 

Custom Fields dialog box appears:

2. In the Custom Fields dialog box, in Type, select Text. (The text type will 
allow you to manage the formulas and format of the field.)

3. In the Field portion of the screen, select a Text field that is free (we’ll use 
Text1).

4. Click the Rename button and in the Rename Field dialog box, type “PV%”.

5. Under Custom attributes, click the Formula button.

Plan Value,  
Earned Value,  
and Actual  
Cost in Percentages
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6. In the Formula for ‘PV%’ dialog box, type:

IIf([Baseline Cost]=0,”NA”,Format([BCWS]/[Baseline Cost],”0.00%”))

Instead of typing the entire formula, you can use the buttons: Insert Field, 
Insert Function, Import Function and mathematic and logical operations. 
Note that we include a conditional verification, If Baseline Cost = 0 then 
“NA”, to avoid a division by zero error. We also include a percent format for 
the field. When you finish click OK.

7. You will see a warning message:

Click OK.

8. Under Calculation for task and group summary rows, choose Use 
formula.

9. Under Values to display, choose Data.

10. Click OK.

Now, you just need to insert the new customized field in the view you want.

As we have said, a major benefit of EVM is the ability to assess variance and 
make forecasts based on the performance to date. In Project 2013 there are 
default fields for many of the variances, indices, and forecasts. In the following 
table we have included EVM names, formulas and their corresponding fields 
and formulas in Project 2013.

All Project 2013 fields included in the following table are referred to as Task 
Fields. There could be some differences between these and the equivalent fields 
used for resource, assignment, task-assignment, resource-assignment, resource 
time-phased, and assignment time-phased fields. You can consult Project 2013 
Help to review considerations and formulas used in each field.

Variances, 
Indices, and 
Forecasts with 
Project 2013
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Where customized field is shown in the table, it means that there is not a default 
field in Project 2013, but you can use a customized field using the indicated 
formulas.

EVM Project 2013
Name Formula Field Name Formula
DATA
Planned Value (PV) BCWS Calculated as cumulative time-phased 

baseline costs up to the status date or 
today’s date

Earned Value (EV) BCWP BCWP = % Complete * Baseline Cost
Or
BCWP = Physical % Complete * 
Baseline Cost

Actual Cost (AC) ACWP Calculated as cost of work performed 
or Manual

Budget at Completion 
(BAC)

Baseline Cost Copy Cost field information when 
Baseline set

Planned Value % (PV%) PV% = PV / BAC Customized Field PV% = BCWS / Baseline Cost
Earned Value % (EV%) EV% = EV / BAC Customized Field EV% = BCWP / Baseline Cost
Actual Cost % (AC%) AC% = AC / BAC Customized Field AC% = ACWP / Baseline Cost
VARIANCES
Schedule Variance (SV) SV = EV – PV SV SV = BCWP – BCWS
Cost Variance (CV) CV = EV – AC CV CV = BCWP – ACWP
Schedule Var. % (SV%) SV% = SV / PV SV% SV% = (SV / BCWS) * 100
Cost Variance % (CV%) CV% = CV / EV CV% CV% = [(BCWP – ACWP) / BCWP] 

* 100
(Same formula as CV% = CV / BCWP)

INDICES
Schedule Performance 
Index (SPI)

SPI = EV / PV SPI SPI = BCWP / BCWS

Cost Performance Index 
(CPI)

CPI = EV / AC CPI CPI = BCWP / ACWP

To Complete 
Performance Index 
(TCPI)

TCPI = (BAC – 
EV) / (BAC – AC)

TCPI TCPI = (Baseline Cost – BCWP) / 
(Baseline Cost – ACWP)

FORECASTS

Estimate at Completion 
(EAC)

(Depending on your 
project situation, you may 
choose between different 
options)

EAC = BAC – CV Customized Field EAC1 = Baseline Cost - CV
EAC = BAC / CPI EAC EAC = ACWP + (Baseline Cost – 

BCWP) / CPI
(Same formula as EAC = BAC / CPI)

EAC = BAC / 
(CPI * SPI)

Customized Field EAC3 = Baseline Cost / (CPI * SPI)

EAC = AC + 
New Estimate to 
Complete

Cost Calculated as costs already incurred for 
work performed by resources assigned 
to the tasks, in addition to the costs 
planned for the remaining work

Estimate to Complete 
(ETC)

ETC = EAC – AC Customized Field ETC = EAC – AC
(If you chose a different formula for EAC, 
you should use the customized field for 
the EAC you selected) 

Variance at Completion 
(VAC)

VAC = BAC – 
EAC

VAC VAC = Baseline Cost – EAC
(If you chose a different formula for EAC, 
you would need to calculate a new VAC 
with a customized field)
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EVM Project 2013
Name Formula Field Name Formula
Variance at Completion 
% (VAC%)

VAC% = VAC / 
BAC

Customized Field VAC% = VAC / Baseline Cost

Cost Performance Index 
at Completion (CPIAC)

CPIAC = BAC / 
EAC

Customized Field CPIAC = Baseline Cost / EAC
(If you chose a different formula for EAC, 
you would need to calculate a new VAC 
with a customized field)

(*) Time Estimate at 
Completion (EACt) 

EACt = Baseline 
Duration / SPI

Customized Field EACt = Baseline Duration / SPI

New duration 
based on network 
and critical path 
analysis

Duration
(If you have a 
dynamic schedule 
and you are 
updating remaining 
work information)

(*) Time Variance at 
Completion (VACt)

VACt = Baseline 
Duration – EACt

Finish Variance Finish variance = Finish Date – 
Baseline Finish Date
(Project 2013 differs from the EVM 
approach here: negative days means 
ahead of schedule and positive days 
means behind schedule. If you want 
to follow the same approach as other 
variances, you should use a customized 
field: VACt = – Finish Variance)

(*) Time Variance at 
Completion % (VACt%)

VACt% = VACt / 
Baseline Duration

Customized Field VACt% = VACt / Baseline Duration

(*) Time Schedule 
Performance Index at 
Completion (SPIACt)

SPIACt = Baseline 
Duration / 
Duration

Customized Field SPIACt = Baseline Duration / 
Duration 

(*) If your Actual Start date is different than your Baseline Start date, EACt, 
VACt, VACt%, and SPIACt could be biased. For instance, take a 10-day baseline 
duration task that has an actual start date 5 work days ahead of the baseline start 
date, and the estimated duration at completion (EACt) for the task is the same 
10 days already planned. Applying the formulas presented in the table, you 
would have:
hh Baseline Duration = 10 days
hh EACt = 10 days (using the updated duration that is the same as planned)
hh VACt = 10 – 10 = 0 days
hh VACt% = 0 / 10 = 0%
hh SPIt = 10 / 10 = 1.00

Analyzing the results you can conclude that the task will be delivered as planned, 
when in fact it’s obvious that there will be a 5-day delay in task delivery (the 
Finish Variance field will show 5 days, which is correct).

To correct this problem, you may create a new EACt field calculated as the 
Baseline Duration plus Finish Variance: EACt = Baseline Duration + Finish 
Variance

With this adjustment, your results will be:
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hh Baseline Duration = 10 days
hh EACt = 10 + 5 = 15 days 
hh VACt = 10 – 15 = -5 days. (5 days delayed)
hh VACt% = -5 / 10 = -50%. (50% delayed)
hh SPIt = 10 / 15 = 0.67 (index below one, performance worse than planned)

Now, we have a better representation of schedule performance. Of course you 
can combine the formulas to obtain the analysis you prefer.

In every company there are acceptable tolerances of performance, and EVM 
allows you to establish quality thresholds so you’ll know if the project is within 
the control limits or is out of control. This will also allow you to practice 
management by exception, directing your attention to projects and tasks with 
problems.

The indices and variances calculated in EVM are perfect for this. You can define 
tolerable zones (green) for a specific range of an index, then a warning zone 
(yellow) to attract attention, and a trouble zone (red) that indicates a major 
correction is needed. The following graphic illustrates this: 

Dark Blue

Blue
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Data
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MUCL    PI < UCL 

MLCL    PI    MUCL 

LCL < PI     MLCL 
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Quality Thresholds and Performance Indices
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MLCL      
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Performance Index
Upper Control Limit
Lower Control Limit
Medium Upper Control Limit
Medium Lower Control Limit

The graphic shows the results of control limits with traffic light indicators. We 
have included the blue zone if the performance indices are “too good,” because 
this is not really good. If you are performing far better than your baseline, you 
may have, for example, excess resources who could be used on other projects 
or excessive padding in your schedule. In the graphic, you can substitute any 
performance index you’re using (SPI, CPI, CPIAC, SPIACt, etc.) for the “PI” 
in the graphic. 

Control limits can be determined according to your quality system (six sigma or 
other), or your own best criteria. Once you have defined your control limits, you 
can use customized fields and use whatever graphics you prefer. The following 
picture is an example of a view with traffic signals for SPI, CPI, SPIACt, and 
CPIAC. (The signals are in red, yellow, green, and blue depending on status.)

EVM and 
Quality 
Thresholds
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It is fundamental to maintain the integrity of the performance measurement 
baseline throughout the project lifecycle. The integrity of scope, schedule and 
cost should all be maintained. There are two common situations where we need 
to change and update our baseline. If the scope of the work changes, then the 
estimated cost and schedule could also change and these changes should be 
reflected in a revised baseline. Or if we have had such poor performance that the 
original baseline is worthless as a tool for measuring the current performance, 
then a revised baseline may be needed. Of course all changes to the baseline 
must be done according to your integrated change control plan.

In our professional experience, we’ve found some special cases where the use of 
EVM has some issues or roadblocks. Here is a summary of those situations with 
our recommendations for managing them.

You can use all of the earned value calculations with manually scheduled tasks 
without any problem. The performance of manually scheduled tasks in earned 
value calculations is the same as automatically scheduled tasks. 

If you inactivate a task before you set the baseline, the task won’t be considered 
in baseline values and won’t affect any future earned value calculation.

If you set the baseline and later you inactivate a task, the task is in the original 
baseline considerations, so the Planned Value will be calculated as you define 
the status date. Of course, if you inactivate the task, you won’t update it and you 
won’t have Earned Value or Actual Cost. This means you will have variances 
against the baseline because of the inactivated task. That may be correct, but if 
you don’t want these variances, you will need to re-baseline the project. (See the 
Performance Measurement Baseline Updating section earlier in this chapter.)

We have found some organizations (more than we imagined) where cost control 
in projects is not used. In these organizations projects developed by internal 
resources do not need to control cost management, they only control hours. 

Performance 
Measurement 
Baseline 
Updating

EVM Special 
Cases 

Manually 
Scheduled 
Tasks

Inactive Tasks

No Cost 
Management
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Actually the hours control is indeed a form of cost control; they just need to 
multiply the hours by the rates and they will have a cost management system. 
But, some organizations are not likely to manage actual costs in internal projects 
and we need to find a solution.

Project 2013 bases EVM on cost fields, but if you don’t track costs, you can use 
one of following recommendations:

hh $ 1.00 / hour Rate
If you have resources assigned to your project tasks, and these resources 
do not have rates, just use a general rate of $1.00/hour. With this, you will 
have your EVM calculations using the common unit “Hour” instead of “$”. 
Of course your views and tables will show the currency symbol, but you 
will know that the numbers represent hours. Some organizations evolve in 
this way: they start with the $1.00/hour rate, then the Finance Department 
provides a prorated general cost per hour, until finally they arrive at a cost 
management system with actual rates by resource.

hh Weighted Factors
We’ve also found organizations that manage projects without resource 
assignments. This is not recommended. If you have one of these projects, 
we recommend you establish a weighted factors system. You simply assign 
a weighted factor to each task, based on your experience as a project 
manager (greater weights are given to the most important tasks). You can 
use the Fixed Cost field to assign the weighted factors, and when you set 
the baseline, you will have enough data to use EVM. Of course, all the cost 
indicators will be meaningless because your EV will be always equal to the 
AC, but all of the schedule indicators should help you to improve your 
project results.

hh Days as Cost
If you don’t have costs and don’t want to use weighted factors, you can just 
copy the Duration of the tasks in the Fixed Cost field and set the baseline. 
With this you will have the durations as weighted factors that allow you to 
have all schedule indicators in your project. This could be good for projects 
that have short tasks with one resource assigned to each one. We don’t really 
like this approach, but in some small projects, it is better than having just the 
Gantt bars. 

We have often found projects where some tasks have associated costs (e.g., 
external contractors) while others don’t (e.g., internal resources). This is a big 
issue if you want to apply EVM, because the tasks without costs will not have 
a cost baseline (BAC), and without a cost baseline your PV, EV, and AC will 
be zero. This means that whether or not you accomplish these tasks, you will 
not have any indication in your variances and indexes. The solution should be 

Some Tasks with 
Costs and Some 
Tasks without 
Costs
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assigning the right costs to all tasks, but we know that in some environments 
that isn’t easy.

To address this you can do one of the following:

hh Master Project with Two Sub-Projects
One solution is to set up one project for your tasks with associated costs 
and another project for your tasks without costs, and then consolidate both 
projects in a Master Project (see Appendix 1 for information about Master 
Projects). For the project without costs we recommend that you follow the 
weighted factors approach described above. Try to use weighted factors that 
represent a total cost that can be compared against the other project with 
costs, in a proportion that you consider a reasonable split between the two.

With this approach, you’ll have a total EVM for your project with costs, 
and an EVM with schedule indicators for your project without costs and 
for your master project. This has functioned well in some environments: if 
you want to analyze your cost performance, you just go to your project with 
costs; if you want to look at schedule performance, you can use your master 
project indicators.

hh Project with Flags and Filters
If you don’t want to manage a master project and two different projects, or 
your project has the tasks assigned so that you can’t easily separate them 
into two projects (e.g., a lot of interactions between internal resources and 
external resources), you will need to combine tasks with and without costs 
in the same project. Our recommendation is to assign costs as weighted 
factors in internal tasks and use a customized flag field to mark which tasks 
have real costs and which tasks have costs as weighted factors. Then you 
can use filters and specific views to show real cost indicators and schedule 
indicators. 

As we’ve seen throughout the chapter, EVM in Project 2013 functions better 
with uniform assignments. If you have uneven resource assignments we saw that 
it is better to change to physical % complete as your EV method for the task and 
copy the % Work Complete into the Physical % Complete field. This could be 
laborious but simple.

A bigger problem is when you have multiple resources with different rates assigned 
to the same task, and for any reason those resources do not work uniformly. The 
problem now is that neither % Complete nor % Work Complete will represent 
task progress because the rates are not the same. In these instances you’ll need to 
make some manual computations to arrive at the correct % of progress. To avoid 
this, try to assign one resource per task. If that is not possible, try to manage 

Uneven Resource 
Assignment 
and Multiple 
Resources
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uniform distributions in order to use % Complete. If that is not possible, you 
may need to accept some approximations in your EVM calculations.

The general recommendation is to have your control accounts at the lowest level 
of your WBS, where you normally assign resources and costs in Project 2013. 
But in some large projects you may need to define your control accounts at some 
middle level of your WBS, and then continue your breakdown until you have 
tasks that you can integrate in your network. This could be a problem, because 
you also need to break down your costs and resources through the lowest level 
of the WBS, and you may not have the elements to do this.

We have said that you should not assign resources or costs to summary tasks, 
but this could be the only solution to this problem. Keep in mind that assigning 
resources at the summary level may cause some problems with progress 
information, because the progress of a summary task depends on its detailed 
tasks, and if you have parallel paths you may have some percentages that may not 
represent the real status.

Remember you can always use your views as reports. 

The default EVM tables and fields that you can use in task views are:

hh Earned Value table: Task Name, Planned Value – PV (BCWS), Earned 
Value – EV (BCWP), AC (ACWP), SV, CV, EAC, BAC, VAC

hh Earned Value Cost Indicators table: Task Name, Planned Value – PV 
(BCWS), Earned Value – EV (BCWP), CV, CV%, CPI, BAC, EAC, VAC, 
TCPI. (Note that AC is missing in this Cost Indicators table, but you can 
insert it.)

hh Earned Value Schedule Indicators table: Task Name, Planned Value – PV 
(BCWS), Earned Value – EV (BCWP), SV, SV%, SPI

The default EVM tables and fields you can use in Resource views are:

hh Earned Value table: Resource Name, Planned Value – PV (BCWS), Earned 
Value – EV (BCWP), SV, CV, EAC, BAC, VAC

We recommend using customized views to support your EVM reporting needs; 
you can include customized fields and graphic indicators that help with the 
interpretation and analysis of data.

Information at the 
Middle Level of 
the WBS

Reporting EVM 
with Project 
2013
Using Views as 
EVM Reports
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The enhanced built in Earned Value Report shows the values for EAC, ACWP, 
BCWP, BCWS, SV, CV, SPI, and CPI for an entire project. You can click on any 
chart to determine which information should be displayed. As mentioned in 
Chapter 11, you can print or send the report to other programs that support 
graphics.

Follow these steps to run this report:

1. On the Report tab, in the Reports group, click on the Cost button, and 
select Earned Value Report. The following view appears:

The Excel visual report called Earned Value Over Time Report takes the Actual 
Cost of Work Performed, Budgeted Cost of Work Scheduled, and Budgeted 
Cost of Work Performed, and plots this task information over time on a line 
chart for the project. 

Follow these steps to run this report:

1. On the Report tab, in the Export group, click Visual Reports; the Visual 
Reports – Create Report dialog box appears: 

Earned  
Value Report

Visual Report: 
Earned Value 
Over Time
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2. In the Visual Reports – Create Report dialog box, click the All tab or the 
Assignment Usage tab, then select the Earned Value Over Time Report.

3. On the bottom of the Visual Reports dialog box, select View, and your 
Earned Value Over Time Report will now be created in Excel. (See Chapter 
11 for more information about Visual Reports.)

EVM is a great method when you have the right information and Project 2013 is 
a powerful tool to facilitate your application of EVM.

The key to effective implementation of EVM is to keep your model as simple as 
you can. You need to balance the necessity of accurate detailed information with 
the need for easy handling of your model.

To enhance EVM with Project 2013 there are add-ons in the market which offer 
improved features and graphical reporting. These add-ons work very well with 
Project 2013 in a standalone environment, but most of them have problems when 
you are working connected to Project Server 2013 because of incompatibilities 
with the Enterprise Global Template.

We have reviewed different ways to apply EVM with 2013; each has advantages, 
disadvantages, and limitations.

Try to analyze your project and define what will work best for you. Don’t force 
your project to fit some specific approach.

Always remember the main objective of EVM is to give you the right feedback 
to facilitate your decision making; EVM itself will not make successful projects. 
That requires a project manager willing to do the required analysis and take 
corrective actions when needed.

EVM and 
Project 2013 
Conclusions
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Here’s a summary of our recommendations for applying EVM with Project 
2013:

Setting Up

hh Define the customized fields you want to use for EVM. (These could be in a 
Template defined by your PMO) 

hh Define customized views and reports for EVM. (These could be a Template 
defined by your PMO)

hh Define a default task Earned Value method (% Complete or Physical % 
Complete) for all projects (choose the method you think will be used the 
most) 

hh Define different options that affect EVM calculations

hh Define quality thresholds for EVM variances and indices

Planning (all steps need to include previous step review in an iterative way)

hh Define the WBS and the Control Accounts

hh Define the Earned Value measurement method to be used in each task

hh Define your dynamic schedule

hh Assign resources and/or fixed costs to all tasks

hh Establish your time phased budget (Project 2013 will do this automatically)

hh Set your performance measurement baseline

Executing, Monitoring, and Controlling (for each report period)

hh Set the status date

hh Record progress for each task according to the EV measurement method 
defined in planning (update actual work, rates, costs, etc.)

hh Update remaining work, duration, rates, costs, etc., for each task

hh Perform EVM data analysis

hh Calculate or define forecasts

hh Propose corrective actions as needed for the remaining work

hh Deliver reports

hh Maintain the integrity of the baseline
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1. What are the benefits of EVM?

2. You have been preparing Earned Value reports for your sponsor each 
month. The partial results of your reports are reflected in the chart below. 
How would you describe the performance of your project to date? What, if 
any, actions should you be taking?

Status Date SPI CPI
1-September-2015 1.50 1.40

1-October-2015 1.35 1.40

1-November-2015 1.20 1.28

1- December-2015 ? ?

3. Stoplight charts have become an increasingly popular way to implement 
Management By Exception (MBE). Describe how you would implement 
this in your organization and how you might calculate tolerance levels for 
your graphical dashboard.

4. What are the differences between % Complete and Physical % Complete? 
When is it appropriate to use one versus the other? Where do you go in 
Project 2013 to select this option?

5. You find a problem in a project. The project has a defined baseline and task 
progress has been entered for all tasks for the first report period. The ACWP 
field show the right cost for the work reported, but the BCWP and BCWS 
fields are zero. What could be the problem here?

6. You realize that it is important to maintain the baseline on your project. You 
are in the practice of keeping the original baseline stored in the “Baseline 
without a number.” As you receive approved scope changes you store 
a new baseline in Baseline##. What will be the impact of this practice in 
your earned value reporting? What are ways that you could prevent these 
impacts?

7. Describe and define the following acronyms:
h` PV
h` EV
h` AC
h` ETC
h` EAC
h` VAC
h` BAC

8. What is the common unit that earned value uses to report values in Project 
2013?

Review 
Questions
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9. What do the following indications mean:

Term Indication Meaning
VARIANCES
Cost Variance (CV) < 0
Cost Variance (CV) > 0
Schedule Variance (SV) < 0
Schedule Variance (SV) > 0
INDICES

Schedule Performance Index (SPI) < 1
Schedule Performance Index (SPI) > 1
Cost Performance Index (CPI) > 1
Cost Performance Index (CPI) < 1
To Complete Performance Index (TCPI) < 1
To Complete Performance Index (TCPI) > 1

10. Provide task examples where you can use each of the following EVM 
methods, and a brief explanation of your recommendation:

EV Measurement Method Example Explanation
0/100 Fixed Formula

50/50 Fixed Formula

Weighted Milestones

% Duration Complete

% Work Complete

% Physical Units Complete

% Physical Complete

Apportioned Effort

Level of Effort

For experience working with the features you’ve learned about in this chapter, 
we strongly suggest that you do the additional exercises for this chapter that 
are included in the Case Studies appendix, available to download in the WAV 
Download Resource Center at www.jrosspub.com.

Additional Practice
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Chapter 13: Evaluating the Project

Reviewing and evaluating the project’s performance is part of the closing process 
of any project since it will influence the results of future projects. In this chapter, 
we’ll explore how to analyze your experience on a completed project to become 
a better project manager on future projects.

The success of a project should be evaluated in terms of the accomplishment of 
the objectives and benefits that were defined when the project was approved, 
keeping in mind that these objectives may have changed during the project 
lifecycle, so you should review the impact of changes and variances in project 
objectives that may have affected project benefits. 

After reading this chapter you will be able to:

hh Explain why project evaluation is important
hh Review the actual results against the baseline
hh Review the history of baselines set
hh Compare two versions of a schedule
hh Prepare a list of questions that will help you evaluate a finished project
hh Create templates for future projects
hh Discuss what to capture in lessons learned
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Project evaluations can be a waste of time: if you allow the focus of the evaluation 
to be on assigning blame for things that went wrong, you’ll create an atmosphere 
loaded with animosity and finger pointing. Evaluations that focus only on finding 
fault with people for past mistakes are worse than a waste of time.

The purpose of project evaluation is to analyze both the successes and the 
failures of a completed project to help conduct better projects in the future. 
Only by learning from the past can we become better prepared for the future. 
But evaluation is useful only when the focus is on—and stays on—the future. 
Lessons learned can lead to improvements in all phases of future projects, e.g., 
the integrity of the WBS, the accuracy of estimates, the use of dependencies, the 
management of resources, and the appropriateness of assignments.

It’s important to include your team in the project evaluation process, both for 
their benefit as a learning experience and for the value of their contributions to 
lessons learned. If you decide to hold a team debriefing meeting, make sure you 
lead it in a way that encourages people to focus on gain for the future instead of 
on pain from the past. One way you can prevent finger pointing is to encourage 
self assessment by starting each question with: “What could I have done to …?” 
It is equally important to analyze your successes, so that the things you and your 
team did well can be leveraged for future projects. 

Why Evaluate?

Dad when I asked for a lion for my birthday, 
I wanted one I could play with!
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There is always room to deliver projects better. When you stop asking yourself 
the question What could we have done better?, you will stop learning from your 
experiences. In this age where the only constant seems to be rapid change, 
nobody can afford to stop learning. Life-long learning is the motto for success.

We need to remember that projects are authorized for the value they are expected 
to provide. For most projects, the value may not appear until sometime later—
sometimes years after their completion. On others, the value may be evident as 
soon as we deliver the results or even with some partial deliverables. In any case, 
the real evaluation of a project must include the analysis of the benefits achieved 
against the value originally defined in the business case.

Our book scope doesn’t cover project benefits definition and analysis, so we 
are going to talk in this section about project performance evaluation based on 
variations against the baseline. 

During project performance, the competing demands pull in different ways and 
may cause some tradeoffs between project objectives during the execution of 
the project. Therefore, we should review our results against both the original and 
any revised commitments. In order to do this, we compare our results against the 
baseline(s) set and we compare different versions of a schedule.

You can evaluate the performance of your project by comparing your actual 
results to your baseline(s). You may also find it useful to compare either different 
baseline versions or different schedule versions you’ve saved at different times. 
This will help to:

hh Evaluate project results (the final baseline or schedule) against versions 
used at earlier phases of the project

hh Learn from past projects by comparing successive versions of a baseline or 
schedule

You can compare the actual data against the baseline you have defined. You can 
use different views and tables for this, and you may also include your customized 
fields or the EVM evaluation. For instance, here is an example of a finished 
project where you can easily review the actual against the baseline data:

 

What to 
Evaluate: 
Project Results 
and Benefits

Comparing 
Baselines or 
Schedules

Comparing 
Results against 
Baseline(s)
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In some projects you may need to define multiple baselines to keep your 
schedule dynamic and to capture historical changes. For instance, you might 
have the following:

hh Baseline 1: based on the original commitments with the client
hh Baseline 2: based on the design developed by the contractors awarded the 

work
hh Baseline 3: based on an approved major scope change

To analyze the different baselines used in your schedule, you can review the 
Multiple Baselines Gantt view:
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You can also evaluate the performance of your project by comparing two 
schedule versions that you may have saved at different times, depending on the 
information that was available. You can use this feature to:

hh Evaluate project results (final schedule) against schedule versions used in 
earlier phases of the project

hh Learn from past projects by comparing successive versions of a schedule
hh Troubleshoot a schedule by comparing it to previous versions
hh Check what changes collaborators or subcontractors made to their schedules 

after you sent a version for them to start working with
hh Learn from exercises in this book. For example, to check your results in the 

Relocation Project exercises (Case Studies appendix), you can compare 
your files against the solution file. Both the Case Studies appendix and 
solution files are available for download at www.jrosspub.com. Please click 
the link WAV Download Resource Center to enter the download site

To create a report showing the differences between two versions of one schedule:

1. Open the most recent version of the schedule.

2. On the Report tab, Project group, click Compare Projects, and the dialog 
Compare Project Versions appears: 

3. In the Compare Project Versions dialog, select or Browse the previous 
version of the schedule and select Task Table and Resource Table to be 
included in the report.

Comparing 
Two Versions 
of One Project 
Schedule
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If the file you wish to compare with is already open, simply select it from the list.

4. Click OK. Project 2013 will show the task Comparison Report:

5. On the Ribbon, on the Compare Projects tab, View group, you can click 
the Resource Comparison button:

6. Perform your analysis. You may find useful tools to filter items such as 
Changed items or to show selective columns like the Differences columns 
only in the Show group of the Compare Projects tab.

7. Once you have finished your analysis, select the Close Comparison icon 
on the Compare Projects tab, Compare group, to continue working on 
your projects. The comparison report remains open until you close it or you 
can save it for future reference. You save a comparison report the same way 
you save a project.
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8. To proceed with saving, just use Save or Save As in the usual way.

When saving a project comparison report, use a standard naming convention 
like Comparison_Report or Comp_Rpt in the file name for easy identification 
later.

In addition to the objectives evaluations previously explained, you should 
complement your project analysis with some evaluation questions that really 
touch on all aspects of the project. There are many tools you can use for project 
evaluation: interviews with key stakeholders, questionnaires, review of your 
project results, and change management forms.

Here are a few suggestions with respect to evaluating how you used your schedule 
as a tool to manage and control the project:

1. Was the schedule clear to all stakeholders? How can we make it clearer in 
future projects?

2. Was the WBS complete? Was it easy to understand? Did it function as a tool 
for delegation? Were the deliverables in it clearly formulated, or did some 
deliverables cause confusion? How can we improve the WBS for similar 
projects in the future?

3. Were the estimates optimistic or pessimistic? What factors caused the 
estimates to be optimistic or pessimistic? How can we better forecast these 
factors in future projects?

4. You may gain a rough insight into people’s tendencies by studying their 
track records from previous projects. You can get a quick impression if 
you look in the Actual Work field and compare it to the Baseline Work 
field of a finished project. The more estimates a person has made, the more 
confidence you can have in this tendency to err. Was there enough of a time 
buffer in the schedule to compensate for unforeseen events? Which tasks 
consumed most of the buffer? Why? We discussed how up to three versions 
of the schedule can be shown next to each other in the timescale; a view like 
this would be very helpful for this analysis. What can we do in the future to 
prevent similar tasks from slipping?

5. Was the schedule easy enough to maintain during project execution? Was 
the network of dependencies complete, and did it update the forecasts 
automatically? Could accurate status and forecast reports be generated 
at each reporting period? How can we produce the reports more easily in 
future projects?

6. Were the right resources available at the right times? How can we better 
predict or ensure the availability of resources in future projects?

Evaluation 
Questions
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7. Did we apply the best practices to our schedule that were described 
throughout the book and summarized in Chapter 14? How can we improve 
our skills in Project 2013? Are there features that were particularly helpful? 
Are there features that we did not take advantage of? 

We recommend you capture these findings in lessons learned on the project.

To prevent painful lessons learned in the school of hard knocks, we recommend 
you use a checklist to evaluate the quality of your schedule during the planning 
phase of the project. In the next chapter, we will provide a checklist you can use 
to check the quality of the schedule as soon as it is created. This checklist will 
allow you to be more proactive in your future projects.

Once you have evaluated the results of your project, it’s a good practice to transfer 
your knowledge and the lessons learned about your project to other colleagues 
in your organization. You can prepare an evaluation summary to communicate 
your evaluation and you can also create a template to be used in futures projects, 
if you and your PMO support this.

To create a template using best practices you:

1. Open the schedule for which you want to create the template.

2. On the Format tab, in the Drawings group, click Drawings, and select Text 
Box.

3. The mouse pointer changes to a black cross, click and drag within the Gantt 
Chart area until you draw a box.

4. Inside the box provide instructions on using the template. For example, can 
you add or delete tasks and summary tasks, describe the areas the template 
provides and the areas future users need to provide, and add reminders to 
check the start date and calendar, etc. 

Draw a large box so it is easily noticed. Be sure to remind people to delete the 
text box before saving or printing the schedule. 

5. On File tab, click Save As.

6. In the Save As backstage view, click Computer and then Browse. 

You can select to save your template in any other location or service such as 
Onedrive so you can share the template with your peers.

7. The Save As screen appears.

8. Enter the name of your template in File name:

Creating 
Templates
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9. On Save as type choose Project Template. The dialog box will change to 
the local templates folder on your computer:

If do not want to save the template in the local templates folder, just click the 
Back to… button to return to the original location or just navigate to a different 
location.

10. Then click Save and the Save As Template dialog appears:

11. Choose which schedule information you don’t want included with the 
template. Then click Save and your template is ready.

It is highly recommendable to avoid including the values for Baseline Data, 
Actuals, and whether tasks have been published, as these will be unique to 
each project. As well, depending on the audience, you must consider including 
potentially confidential information such as Resource Rates or Fixed Costs.
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12. If you need to apply changes to the saved template, just repeat steps 5-10. 
Be sure to give the same name to substitute your updated template for the 
existing one.

To open your template, refer to Chapter 2.
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1. You have been managing a new project for the last couple of months. As 
you enter into phase three of the project, you want to compare the different 
baselines, to see variances along the way. What view do you use in Project 
2013 for this comparison and how did you capture these baselines along the 
way, assuming that you captured an original, phase 1, and phase 2 baseline? 

2. You made a copy of the original project plan and now you are optimizing 
duration on the copy and doing some “what-if ” analysis to see if you can 
shorten the finish date. You like what you see, but want to compare your 
results to the original plan before making these changes to it. How would 
you go about this comparison using Project 2013?

3. You are in the PMO and notice that most of the processes for departments 
follow the same project management methodologies. Your project managers 
create new projects from scratch, which takes a lot of extra development 
time in the planning phase. How could you help your project managers 
using Project 2013 to cut down their development time for planning?

For experience working with the features you’ve learned about in this chapter, 
we strongly suggest that you do the additional exercises for this chapter that 
are included in the Case Studies appendix, available to download in the WAV 
Download Resource Center at www.jrosspub.com.

Review 
Questions

Additional Practice
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Chapter 14: Summary

We’ve now discussed the use of Project 2013 throughout the entire life-cycle of 
a project. As a summary, we’ll bring together the many recommendations we’ve 
made regarding best scheduling practices, and provide you with checklists, 
instructions and tools for future use.

Here’s what this chapter includes:

hh A final discussion of the attributes of a dynamic project model
hh Instructions for obtaining additional tools we’ve provided for checking 

schedules
hh Our best practices checklist
hh A checklist for troubleshooting dates in Project 2013 schedules
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A good schedule:

hh Is a model of the project
hh Provides valid forecasts
hh Is dynamic and easy to maintain

hh A model should be a deliberate simplification of the complex reality. If you 
can’t explain the model to your stakeholders, the model is too complex.

hh A model of the project provides forecasts

A schedule will only produce valid forecasts if:
hh It contains all deliverables
hh The basis for estimates is consistent with the working times on the project 

calendar
hh The time estimates seem reasonable for the work to be done
hh During the project, the schedule produces accurate forecasts. You should 

assess this throughout the project’s life-cycle by seeing how actual results 
compare to planned results, milestone by milestone.

The ideal of a totally dynamic model is that if one thing changes in reality, you 
should have to change only one field in your Project 2013 model. Even though 
this ideal is hard to reach, you can get very close to it if you set your schedule up 
in the right way. A schedule is dynamic if it:

hh Has as few constraints as possible
hh Has a complete network of dependencies

Attributes of 
a Dynamic 
Project Model

A Model of the 
Project

Provides Valid 
Forecasts

Dynamic and Easy 
to Maintain

 

It didn’t take as long as you’d think: 
I used Dynamic Scheduling with Microsoft Project 2013!
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hh Has resource dependencies clearly and accurately stated
hh Is easy to maintain so that it can be kept alive during project execution
hh Is kept up to date in a timely manner
hh Continuously provides forecasts
hh Is in an electronic format and could be accessible online

Throughout the book, we’ve made many recommendations for making your 
schedule a valid and dynamic model of your project. These recommendations 
are compiled in the best practices checklist later in this chapter. You can use this 
list to evaluate the quality of your project schedule and to check the use of best 
practices.

If your schedule meets these guidelines, you have created a valid, dynamic model 
of your project. You have positioned yourself to bring the project to a successful 
completion. From experience, we can say that managing a large schedule is a 
nearly impossible task if it does not meet the requirements of the checklist. 
Schedules that meet the requirements need the least maintenance during the 
execution of the project.

They are also the easiest schedules to work with when you are managing multiple 
projects. 

You need the single schedules to meet all requirements on the checklist if:
hh You need to create an integrated program schedule for a large endeavor 

from subschedules. To accomplish this, you’ll need to apply the checklist 
to the subschedules as well. For more information on subschedules and 
consolidated Schedules, see Appendix 1 about Consolidated Schedules.

hh You want to monitor and level the workloads across multiple projects.
hh You want to apply Monte Carlo simulation to your schedules.

We provide tools with the checklist to check your schedules in an efficient 
manner, and we will discuss these next.

The tools and checklist are copyrighted material: © 2014 by International 
Institute for Learning, Inc. This checklist is provided to you for personal purposes 
only. If you would like to use this checklist for commercial purposes within your 
organization, please contact IIL and talk to one of our sales representatives about 
licensing these tools and the checklist. See www.iil.com or call 1.212.758.0177 
(USA).

DISCLAIMER: “No rights to copy, decompile, reverse engineer, create derivative 
works, or distribute are being granted or implied. By choosing to use the filters 
and macros, you understand and agree (1) that IIL cannot be held liable for any 
damage to your schedule or business as a result of using the filters and macros 

Tools and 
Best Practices 
Checklist

Copyright of  
the Tools  
and Checklist
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and (2) to indemnify IIL from all liability whatsoever for any damages that may 
occur resulting from the use of these tools.”

We provide several tools to make checking your schedules easier. You will 
find them in the file IIL Project 2013 Tools.mpp available for download at  
www.jrosspub.com. Click the link WAV Download Resource Center to enter the 
download site.

Here’s what you’ll find there.

The RCP Macro will identify the resource-critical path in a resource-constrained 
schedule. Please note that the RCP Macro only works properly with the English 
version of Project 2013. Refer to Chapter 9 for more detail about the resource 
critical path and for instructions on how to use the RCP Macro.

You can copy the filters to specific projects or to your Global.mpt by using the 
Organizer:

1. Open the file IIL Project 2013 Tools.mpp in Project 2013 that you 
downloaded from the WAV Download Resource Center.

2. On the File tab, choose Info, and select Organizer.

3. In the Organizer window, select the Filter tab to copy all of the customized 
IIL filters into your schedule.

Now that you’ve copied the filters to your Global.mpt, they will be available for 
your projects.

Open the project and apply the specific filter as described below. Make sure that 
all summary tasks are expanded before applying any of these filters, since filters 
never display detail tasks that are collapsed under their summary tasks.

On the View tab, in the Data group, click the Outline down-arrow, then select 
All Subtasks to expand all detail tasks. After you use a filter, press the F3 key to 
stop the filter and display all tasks again. 

hh 00 IIL nr of uncompleted tasks: An interactive filter that prompts for the 
date when the schedule was submitted to display all uncompleted tasks 
from that date to the future.

hh 01 IIL Level of Detail < 1% of Proj Dur…: An interactive filter that 
prompts for the minimum duration for detail tasks to check the level 
of detail in the WBS using the 1% – 10% rule. The filter does not display 
summary tasks, recurring tasks or inactive tasks.

hh 02 IIL Level of Detail > 10% of Proj Dur…: An interactive filter that 
prompts for the maximum duration for detail tasks to check the level 

Tools to Check 
Your Schedules

RCP Macro

Filters
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of detail in the WBS using the 1% – 10% rule. The filter does not display 
summary tasks, recurring tasks, or inactive tasks.

hh 03 IIL Inactive Tasks: Allows you to display the inactive tasks. You can use 
this filter to help you determine if any of your inactive tasks can be activated 
or deleted.

hh 04 IIL Summary Tasks with Dependencies: Displays all active summary 
tasks with dependencies on them. If there are many summary tasks with 
dependencies, it makes checking the completeness of the network logic and 
tracing the critical path too difficult. We recommend keeping the logic on 
detail tasks as much as possible.

hh 05 IIL Detail Tasks without Predecessors: A filter that displays detail 
tasks without any predecessors to find the starting points of the network of 
dependencies. Detail tasks without predecessors may start on the project 
start date or will have a Start No Earlier Than constraint (SNET). The 
network of dependencies can have multiple starting points, but only one 
ending point. This filter displays all starting points of the network. You can 
then see if there are starting points in the network that should perhaps have 
a predecessor. This filter does not show recurring tasks and inactive tasks. 

hh 06 IIL Detail Tasks without Successors: A filter that displays detail tasks 
without any successor to find tasks that are not incorporated in the network 
of dependencies (loose ends). There should be only one ending point in 
the network of dependencies, otherwise critical path and slack calculations 
are not likely to be correct. This filter does not show recurring and inactive 
tasks. 

hh 07 IIL Detail Tasks with SS or FF: This filter displays all tasks involved 
in a Start-to-Start (SS) or Finish-to-Finish (FF) dependency. SS and FF 
dependencies can easily have loose ends in the network of dependencies 
and have to be checked separately and carefully. Inactive tasks are shown by 
this filter when they are part of an SS or FF dependency.

hh 08 IIL Constraints other than ASAP: A filter that displays any tasks with 
a constraint other than As Soon As Possible (ASAP). A dynamic model 
should have as few constraints as possible. Recurring tasks are not shown, 
because they should have constraints. This filter does not show inactive 
tasks.

hh 09a IIL Detail Tasks without Resources Assigned: This filter displays 
all detail tasks without any resources assigned. You can also check this by 
looking under Unassigned in the Resource Usage view, but this filter allows 
you to copy the task IDs and names into a report of what tasks do not have 
resources assigned. With that information, you can find the tasks without 
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assignments easily. If assignments haven’t been made, workloads won’t be 
accurate and forecasted dates may be too optimistic. This filter does not 
show milestones or inactive tasks.

hh 09b IIL Summary Tasks with Resources Assigned: This filter 
complements the 09a IIL Detail Tasks without Resource Assigned filter and 
displays all summary tasks with resources assigned. If summary tasks have 
assignments, you can easily end up with over-allocations. We recommend 
keeping the assignments on detail tasks as much as possible. This filter does 
not show inactive summary tasks.

hh 10 IIL Deadlines or Constraints not met: This filter displays items 
with deadlines or constraints that have negative slack. These deadlines or 
constraint dates are not met, and the schedule may forecast dates that are 
wrong. Special consideration is taken for manual tasks because their total 
slack is always zero and they have no constraint dates, so the filter shows 
manual tasks that have a deadline in which the finish date is greater than the 
deadline. This filter does not show inactive tasks. 

hh 11 IIL Tasks with missing baseline info: A filter that displays any tasks 
that do not have baseline information in Baseline Start, Baseline Finish, 
Baseline Duration, or Baseline Work. When assignments are created after 
the baseline is set, the Baseline Work field is often empty on these tasks. 
Notice that the filter does not check the field Baseline Cost. This filter does 
not show milestones or inactive tasks.

hh 12 IIL Reschedule Actual Durations…: An interactive filter that prompts 
you for the status date twice and displays tasks with an Actual Start or 
Actual Finish date after the status date. All actual dates should be in the past, 
i.e., earlier than the status date. As the status date, enter the date on which 
the schedule was submitted. With this filter, you can determine if there are 
actuals in the future, which does not make sense. There should be no Actual 
Start or Actual Finish dates later than the status date. The filter shows if the 
schedule is updated properly and thus if the forecasted dates are accurate 
and reliable. This filter does not show inactive tasks.

hh 13 IIL Reschedule Remaining Durations…: An interactive filter that 
prompts you for the status date twice and displays tasks with remaining 
durations scheduled in the past (earlier than the status date). With this filter 
you can determine if the schedule is updated properly and if the forecasted 
dates are accurate and reliable. This filter does not show inactive tasks.

hh 14 IIL Remaining Durations revised: This filter displays all detail tasks 
for which the current duration is not equal to the baseline duration. If 
the filter displays any tasks, it would indicate that the project manager is 
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revising the remaining durations. Regular revision of remaining durations 
is important to ensure that the forecasted dates are accurate and reliable. 
Provide feedback to the project manager only if the filter does not display 
any detail tasks. This filter does not show inactive tasks.

In the checklist, we have used the words summary task and detail task very 
carefully. It is important that the words are interpreted correctly for the 
guidelines to make sense. A summary task is any task with indented subtasks 
listed beneath it on a lower level in the WBS. A detail task is any task without 
indented subtasks in the WBS.

The checklist is a succinct summary of this book. It has the following categories 
that correspond to chapters in this book:
hh Background Information about the Project 
hh Setting up the Project
hh Entering Tasks 
hh Entering Estimates
hh Entering Dependencies
hh Entering Deadlines, Constraints, and Task Calendars
hh Entering Resources
hh Entering Assignments
hh Optimizing the Schedule
hh Updating the Schedule
hh Reporting 
hh Earned Value Management
hh Evaluating the Project

The filters mentioned in the checklist can be found in the file  
IIL Project 2013 Tools.mpp available for download at www.jrosspub.com. Please 
click the link WAV Download Resource Center to enter the download site.

Best Practices 
Checklist for 
Schedules
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You need to know the answers to the following questions in order to make a 
thorough evaluation of the schedule:

hh What is the benefit of the project?

hh What are the priorities and risks inherent to the project?

hh Who are the key stakeholders of the project?

hh Does the project need to address a specific methodology or process?

hh What is the objective or final product of the project? 

hh What is the deadline date of the project? Is it shown as a deadline date in 
the schedule?

hh Does the project have a cost budget? If yes, how much?

hh Does the project have a person hour budget (effort)? If yes, how many 
person hours, person days, person weeks, person months, or person years?

hh Did the project manager gather pure work time estimates or gross work time 
estimates? 

hh Did the project manager apply the rolling wave approach in the schedule? If 
so, what is the duration of the detail planning window? 

hh Will the project manager do task updates (durations) or assignment updates 
(time sheets) or both?

Here are some checks to verify that you used best practices when setting up your 
project:

hh Does the Comments field in the Project Properties (File, Info, Project 
Information, Advanced Properties) contain a succinct description of the 
objective or final product of the project?

The description is visible as a Note on the project summary task. You need 
to have appropriate background information on the project to properly 
evaluate the schedule.

hh Are the Exception days (holidays and other non-working time) entered in 
the Standard Calendar?

hh Do the working hours as specified in the Project Calendar through Change 
Working Time correspond to the Hours per day conversion values set in the 
Project Options?

For example, working times of 8:00 AM-12:00 PM and 1:00 PM-5:00 PM 
are consistent with 8 hours per day and 40 hours per week. If the settings 
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are inconsistent, your forecasts are either too optimistic or too pessimistic. 
Also, you might see decimals in the task durations.

The quickest way to check consistency is by launching the Change Working 
Time window from the Project tab of the Ribbon. The button Options will 
take you directly to the Project Options.

hh Do all of the project options match your organization’s standards and your 
personal selections? Click the File tab to go to the Backstage, then click 
Options to review all the settings.

hh Do you want the default for your new tasks to be auto-scheduled or manually 
scheduled (on the File tab, Backstage view, Options, Schedule tab)?

hh Are there deliverables in the WBS and are the deliverables complete, but 
lean?

hh Does the WBS have a logical hierarchy?
h` Is the WBS an indented list with multiple hierarchical levels instead of 

a long list without structure?
h` Does each summary task have at least two subtasks?
h` Is there any duplication or logical overlap between deliverables?
h` Does each group of subtasks capture all the work of their summary task 

(top-down check)?
h` Does each item logically relate to its summary tasks on all higher levels 

(bottom-up check)?
h` Is the Project Summary Task used instead of a physical project 

summary task? (On the Format tab, Show/Hide group, select the check 
box for Project Summary Task.) Project 2013’s project summary task 
has ID number 0 (zero) in the first column.

hh Are there enough milestones—roughly one for each summary task? You 
can check this by applying the standard filter Milestones.

hh Does the WBS have the right level of detail?
h` Is it clear how deliverables will be created and what the activities 

involved are?
h` Is the WBS lean enough that you’ll be able to update all detail tasks in 

the schedule during project execution?

hh Is the WBS clear to all project stakeholders?

Entering Tasks
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 Once you’ve gathered initial estimates, you’ll want to perform some reasonability 
checks on them. 

hh Are the estimates reasonable given the work that needs to be performed?
You will need some technical expertise and recorded past experience to 
verify if estimates are reasonable. If you don’t have this technical expertise, 
you can:
h` Review the schedules of previous, similar projects
h` Ask team members with technical knowledge to peer review each 

others’ estimates
h` Ask a subject matter expert to review the estimates

hh Did you include manually scheduled tasks for items where you are not able 
to provide a complete estimate?

hh Was the rolling wave approach applied to activities in the future that you are 
only planning at a high level?

hh Did your estimate for each task include a work or duration estimate and did 
you set the appropriate task type and effort-driven settings?

hh Are the estimates that you collected consistent with the working hours 
entered in the Standard Project Calendar? For example, if you collected 
pure estimates did you reduce the hours per day to reflect purely productive 
hours per day, such as 5.5 or 6? If they are not consistent, the schedule will 
be too long or too short.

hh Do the durations of your estimates fall within the 1% – 10% Rule (as 
discussed in Chapter 3 and reviewed below)?

hh Are the completion of key deliverables of your project modeled as milestones 
with zero days duration? 

hh Did you include buffers to address schedule risk?

Once you have done your estimating and the other steps in the process (including 
assigning resources and setting dependencies), you can find the project duration 
easily by: 

Clicking Project Information on the Project tab and clicking Statistics...

OR 

Viewing the Duration field of the project summary task. You can display the 
project summary task by choosing the Project Summary Task checkbox on the 
Format tab. This task will appear at the top of the list as a task with ID number 0.

In Chapter 3 we covered the 1% – 10% rule: the duration of any detail task 
should be between a minimum of 1% of the project duration (rounded) and 
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a maximum of 10% of the project duration (rounded). Note that this rule is a 
guideline.

If you find a task that is longer than 10% of the project, you can split the task into 
multiple subtasks. Or if the assigned resources are working part-time on the task, 
you can increase their commitment to full-time, and the duration will decrease. 
This is more refinement to the WBS, discussed in Chapter 3.

Notice that the 1% – 10% rule should only be applied to the durations and not 
to the work values (effort). If there are many part-time assignments or many 
multiple assignments per task, the boundaries for work estimates should be 
narrower or wider than for the duration. In general, the minimum and maximum 
values for work are harder to indicate, which is why we stayed away from that.

You can check the 1% – 10% rule in your project by applying the filter 01 IIL 
Level of Detail < 1% of Proj Dur or filter 02 IIL Level of Detail > 10% Proj 
Dur.

hh Is the network of dependencies complete?
A complete network allows the schedule to update itself and displays the 
correct critical path. The network is complete if the task bars of all detail 
tasks and milestones are tied up at the end of the schedule. The network 
can have multiple starting points, but only one ending point. Only then will 
the critical path calculation be correct. The following questions will help 
determine if the network is complete:
h` Is the logic only set on detail tasks and milestones?

If dependencies run over summary tasks and detail tasks in parallel, it is 
too hard to check if the network is complete and too hard to both trace 
and understand the critical path. Therefore, we recommend that you 
keep the logic on the detail tasks and milestones only. You can check if 
there are dependencies on summary tasks by applying the filter 04 IIL 
Summary Tasks with Dependencies.

h` Are all the starts of the detail tasks and milestones linked to at least one 
other detail task or milestone? Exceptions are:
Tasks that can start when the project starts or those that are driven by 

external forces or deliveries rather than by hand-offs within the 
project

External delivery milestones with a Start No Earlier Than constraint 
date

Recurring tasks 
Overhead tasks 
Hammock tasks

Entering 
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You can verify if all starts are linked by applying the filter 05 Detail 
Tasks without Predecessors. If you used SS or FF dependencies, the 
filter is not conclusive. There will be another check on those.

h` Are all ends of the detail tasks and milestones linked to at least one 
other detail task or milestone? Exceptions are:
The project end milestone
Recurring tasks
Overhead tasks
Hammock tasks
A loose end, hanger, or dangling task is a detail task that does not have 
its finish tied to any other task. In any project there should only be one 
loose end, the project finish milestone.
You can verify if all ends are linked up by applying the filter 06 IIL 
Detail Tasks without Successors. If you used SS or FF dependencies, 
the filter is not conclusive. There will be another check on those.

h` Do you have SS and FF dependencies properly linked up?
If you used SS or FF dependencies in your schedule, you should filter 
and display all those tasks with SS and FF dependencies and check on 
loose ends manually. You can do this check by applying the filter 07 
IIL Detail Tasks with SS or FF. Since the filter will display both the 
predecessor and successor involved in the SS or FF dependency, you 
can check if they are hooked up properly to other tasks by revealing the 
Predecessors and Successors fields. What you should look for is:
Does a task with SS in the Successor field also have an FS or FF 

successor that ties up its end?
Does a task with FF in the Predecessor field also have an SS or FS 

predecessor that ties up its start?

If the answer to either question is “no,” you found a missing link.

h` Are there tasks with an unreasonably large amount of Total Slack?
Check if the tasks with most slack were expected to have a lot of slack. 
If not, you have found missing logic. Even after you have given all detail 
tasks a successor, you should still apply this check because even if each 
task has a successor, it does not guarantee that you haven’t forgotten 
important links. Checking the Total Slack will actually lead you to 
where you forgot to set important dependencies in your model of the 
project.

h` When a change is entered into the schedule, does it update the rest of 
the schedule automatically and appropriately through dependencies?
Is the entire schedule still valid? Where the schedule is not valid, an 
essential dependency might be missing. If you have to check the 
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entire schedule after each change, you don’t have a dynamic model. 
Remember, the logic should be helpful, especially during project 
execution when you update your schedule regularly.

hh Is the Network Logic simple enough?
If you can’t explain the network to your project team, it’s too complex. 
Redundant dependencies make the network overly complicated to explain 
and maintain. Link the tasks that have a direct relationship. Use the following 
questions to determine if the network is simple enough:
h` Are there dependencies that leapfrog each other? Dependencies 

that skip over the back of multiple dependencies within a chain are 
redundant. These are indirect relationships. Remove them.

h` Are there dependencies that run in parallel on detail tasks and 
their summary tasks? If that is the case, remove the summary task 
dependencies.

hh Does the network have circular logic?
Circular logic does not make sense, because it is not clear which task should 
be scheduled first. Project 2013 warns you not to set circular logic within a 
single schedule.

hh Does the logic of the network make sense?
After the previous checks on dependencies are done, you should perform 
one more high-level check to see if the resulting schedule actually makes 
sense. You can best check this by showing only the first outline levels of the 
WBS and checking if the timing of the deliverables (or phases) makes sense 
on this high level. Use the Outline down-arrow button on the View tab, in 
the Data group, and select level 2 or Outline level 3 depending on the size 
of your project. Even though you may not be an expert in the field of this 
project, you can pick up on common sense problems like design scheduled 
before construction, write before print, etc. Realize that if you followed our 
recommendations and minimized the number of constraints and entered 
all dependencies, the start and finish dates of the tasks are entirely driven by 
the network of dependencies. If the resulting schedule does not make sense, 
you probably overlooked an essential dependency. 

 Here are some checks you can use to verify whether you’ve applied best practices 
in your use of deadlines and constraints in your dynamic model of the project: 

hh Is the project deadline date captured in the schedule?
It can be set using the Deadline feature date or using the Constraint feature in 
Project 2013. The deadline or constraint date needs to be set on the project 
finish milestone. Whether you use a deadline or a constraint depends on 
how hard the project target finish date is.

Checks on 
Deadlines, 
Constraints, and 
Task Calendars
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hh Are there as few as possible Task Calendars in the schedule?
As we discussed, Task Calendars have a very specific purpose and should 
only be used in those situations where needed.

hh Does the schedule have as few schedule constraints as possible?
Constraints make the schedule rigid and jeopardize a dynamic schedule. 
However, constraints are legitimate on:
h` Recurring detail tasks (like status meetings 1, status meetings 2, etc.)
h` External dependencies, such as delivery of supplies or arrival of 

materials
h` Activities that have to take place on a certain agreed-upon date, like 

deliver presentation and conduct training. In general, these are activities 
in which a number of people are involved.

h` Do-or-die-by dates, such as launches or opening dates of events for 
which marketing and advertising has already been done. Huge recurring 
sporting events which take place at set times in the calendar would also 
be good examples. 

h` Activities affected by weather conditions (e.g., in Canada asphalting 
streets starts no earlier than April 1st, because of the cold). You 
can also use the Task Calendars feature for these situations. Task 
Calendars would be a better way in the case of the multi-year planning 
of infrastructural works; unlike constraints, task calendars will push a 
job automatically out to the next year if it will no longer fit within the 
current year.

You can display all tasks that have constraints by applying the filter 08 IIL 
Constraints other than ASAP. The filter will not display recurring detail tasks. 
Recurring detail tasks have SNET constraints. This is because they are usually 
dependent on an established time rather than on another task.

Resources and assignments are particularly important in projects in which you 
expect that limited resource availability or huge workloads will influence the 
project end date. They are also important if there is a budget and the cost needs 
to be managed.

hh Are all resources identified in the Resource Sheet?
This is the case if all resources that could have a potential impact on the 
project are entered into the Resource Sheet. Resources and assignments 
should be entered for projects where:
h` You expect that limited resource availability or huge workloads will 

affect the end date of the project
h` You have a cost budget for the project and you are responsible for 

staying within that budget

Entering 
Resources
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h` You have a budget expressed in person months and you have to stay 
within this effort budget

h` You foresee a quality or scope impact on the project depending on 
which resources you will get

hh Are Budget resources identified and entered in on the project summary 
task?

hh Are all resources named completely and consistently using a naming 
convention like <first name> <last name> or <last name>-<first name>?

hh Are there no overlaps between the resources or duplication of resources?
If there are overlaps or duplications, Project 2013 will still aggregate the 
workloads of the resources, but these total numbers will be useless when 
you check on over-allocations. If Bill Tan is listed twice as a resource (as Bill 
Tan and William Tan), you would have to sum all time-phased workloads 
in order to determine if he is over-allocated. The workloads in the Resource 
Graph and in the Resource Usage can appear to be smaller than they really 
are when duplicate or overlapping resources exist. 

hh Is the availability of the resources appropriately modeled?
This can be assessed by asking yourself the following questions: 
h` Does the availability of individuals not exceed 120% as captured in the 

resource field Max Units or the availability profile in the Resource 
Information dialog box, General tab?
You can set an arbitrary limit and choose the maximum to be 120%. 
It is unreasonable to ask resources for more than 120% availability for 
periods longer than one week. When you ask resources to work overtime 
for extended periods, their productivity decreases dramatically.

h` If the Max. Units are less than 100%, is there a valid reason for this?
Valid reasons are that the project manager works with pure work 
time estimates, that the resources have other ongoing work (or other 
concurrent projects), or that the resources may only be part-time 
resources.

h` Are the vacations of individual resources captured in their resource 
calendars? Vacations need to be entered, particularly when vacations 
are close to important deadlines. 

hh Are the costs of the resources appropriately modeled?
h` Are human resources entered as Work resources in the resource field 

Type? Are facilities, machines, and materials entered as Material 
resources?

h` Do material resources have an appropriate Material Label to indicate 
their unit of measure? For bulk resources or consumable resources 
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the material label should reflect the unit of measure, for example, the 
material label for cabling could be yards or meters.

h` Are cost resources entered as Cost resources in the resource field Type? 
h` Are budget resources identified as a Budget resource in the General tab 

on the Resource Information dialog box? 
h` Are the rates entered in the appropriate fields?

Time-related costs for work resources in the Std. Rate field.
Unit-related cost for material resources in the Std. Rate field.
Time-related cost for facilities and machines as material resources using 

two fields: the Std. Rate field where you enter the per-unit cost, and 
the assignment-related Units field where you indicate the number 
of units used per time unit, for example, 2 rooms each day should 
be entered as 2/day.

Use-related costs in the Cost/Use field.
Overtime costs in the Ovt. Rate field (but only if the overtime is paid 

and paid at a higher rate than the standard rate). 
Rates that vary over time in the Cost Rate Tables.
Multiple rates per resource in the five Cost Rate Tables and the 

appropriate Cost Rate Table (A, B, C, D, or E) selected for each 
assignment.

h` Is the cost scheduled appropriately?
This is important for managing the cash flow of the project: Can bills be 
paid when they are supposed to be paid?
Does the resource-related Accrue At field reflect when the cost occurs: 

at the Start or at the End, or Prorated with the time-phased amount 
of work?

Here are some checks to help you verify whether you have applied best practices 
to the assignments in your schedule:

hh Are you paying attention to the task-related fields Type and Effort Driven 
for the detail tasks?
The available types in the field Type are: Fixed Duration, Fixed Units, or 
Fixed Work. With this field, you can control what Project 2013 recalculates: 
duration, units, or work. If you don’t monitor the field Type, you are not 
controlling what Project 2013 does. You are using a software tool, but 
you have no idea what the tool can do for you. This is similar to having a 
carpenter’s stud finder, but not knowing how to use it. Instead you start 
drilling holes in the drywall hoping to find the studs by trial and error. If 
you don’t use the field Type, you are using Project 2013 in a trial and error 
fashion; you change a field here, Project 2013 recalculates a value there, 
you don’t like what you see and you change it back again … and you start 
running after your own tail.

Entering 
Assignments
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hh Does each detail task have at least one human resource assigned?
If there are detail tasks without human resources assigned, you have not 
captured all the workloads in your project. If workloads are missing, the 
schedule may be too optimistic, since leveling workloads typically leads 
to longer schedules and later forecasts. An exception to this rule is that 
recurring detail tasks do not need resources assigned to them. You can 
check on this in one of three ways:
h` In the Resource Usage view, there should be no detail tasks listed under 

the first category Unassigned.
h` You can check for detail tasks without resources assigned by applying 

the filter 09a IIL Detail Tasks without Resources Assigned.
h` In the Team planner view, there should be no tasks in the Unassigned 

Task section (the bottom section).

hh Are there no assignments on the summary tasks?
As we discussed, if you assign resources to summary tasks you can easily 
end up with over-allocations that can’t be resolved other than by removing 
the resource from the summary task. If you assign only to detail tasks, 
you will never end up with this stubborn type of over-allocation and will 
save yourself time when leveling workloads. Resolving over-allocations is 
challenging enough. You can check for assignments on summary tasks easily 
by applying the filter 09b IIL Summary Tasks with Resources Assigned.

hh Are all the costs appropriately modeled to include variable and fixed costs?
Variable costs are driven by the number of units (percentage) of work or 
material resources assigned to a task. Task- or deliverable-related fixed costs 
are entered in the Fixed Cost field in the Gantt Chart or as a Cost resource 
from the Assign Resources dialog box. 

hh Is the cost scheduled appropriately?
h` Does the task-related Fixed Cost Accrual field reflect when the fixed 

cost will be incurred? 
h` You can review the time-phased cost in the Task Usage or Resource 

Usage views. 

hh Have you utilized Budget resources to help you identify variances between 
your planned and projected costs?
Budget variables—created by setting the Budget flag in the Resource 
Information window—can be assigned only to the Project Summary task. 
The values for these resources are entered in the Budget Cost or Budget 
Work fields of the Task Usage or Resource Usage views.
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hh Is the total effort within the person hour budget of the project (if a budget 
is available)?
To find the total effort of the project on the Project tab, in the Properties 
group, click Project Information, Statistics… and look in row Current, 
column Work.

hh Are the workloads for the resources reasonable?
h` We work with these limits: the workload for individuals should not 

exceed 150% of their regular availability within any week and should 
not exceed 120% for periods longer than a week. We chose these levels 
to prevent burnout, attrition, and dramatic loss of productivity. The 
parameters may differ for your organization. Be sure to check with 
your PMO (project management office) or the authority that sets these 
guidelines.

h` The workload of consolidated resources (groups) should not exceed 
their availability.

h` The workloads should be fairly smooth, since there are hidden costs 
involved with erratic workloads. 

Note that it is not enough to just check if there is any red in the Resource 
Usage view. Project 2013 often highlights more resources in red than are truly 
over-allocated. If there is an over-allocation during only one business hour, 
the resource will be shown in red. Use the Next Overallocation tool on the 
Resource tab in the Level group to check the over-allocations. This tool is more 
selective and more reliable. However, even this tool does not always find all over-
allocations, and it also highlights trivial over-allocations (e.g., 1 hour). 

hh Is the cost modeled using the right fields and in the appropriate way?
The following fields are available in Project 2013: 
h` Resource fields: Type, Material Label, Standard Rate, Overtime Rate, 

Cost/Use, and Accrual At. A resource can also have cost rate tables.
h` Task fields: Fixed Cost and Fixed Cost Accrual.

hh Is the total cost within the budget of the project (if a cost budget is available)?
You can find the total cost of the project in the Project Statistics summary 
(Project tab, in the Properties group, click Project Information, 
Statistics…) looking in the Current row and Cost column. 

hh Are there as many parallel paths as logically possible in the network of 
dependencies?
Novice schedulers tend to schedule all tasks in one long sequential chain. 
This creates many soft dependencies that make the duration of the project 
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unnecessarily long. When optimizing for time, it is important to schedule in 
parallel what logically can happen simultaneously.

hh Are there any unresolved conflicts between the task calendars and resource 
calendars?
If there are conflicts, the forecasts may be too optimistic. You can find the 
conflicts by looking in the Indicators column for a warning icon.

hh Are the deadline dates and other constraints met in the schedule?
You can check this by applying filter 10 IIL Deadlines or Constraints not 
met. It displays tasks with deadlines or constraints that have negative slack. 
When deadline or constraint dates are not met, the schedule may forecast a 
project end date that is too optimistic.

hh Does the schedule have a critical path or a resource-critical path?
You can check the critical path by applying the Tracking Gantt view. This 
view highlights the critical path in red by default.

h` If a schedule is extended when the workloads are leveled, a resource-
critical path needs to be identified. Resource-critical tasks need to be 
marked manually.

h` The (resource) critical path can only consist of detail tasks and 
milestones. It should not contain level-of-effort tasks (overhead tasks 
or recurring tasks) or summary tasks (since the logic and the resources 
should be kept on the detail tasks).

hh Does the (resource) critical path provide a complete explanation for the 
project duration?
You can check the completeness by displaying the (Resource) critical path 
and checking for gaps. Normally, there should be no gaps and every business 
day should have at least one critical task (unless there are lags on critical 
dependencies). If you find gaps, the (resource) critical path is fragmented, 
and the tasks that are most critical need to be identified in the schedule. 

The following checks reflect best practices for updating schedules. A schedule 
has to be updated if today’s date is later than the project start date. If the project 
should have started, the schedule needs to show updated information with 
actuals and revised forecasts.

The following questions will help you determine if the best practices for updating 
schedules were applied: 

hh What is the quality of the baseline in the schedule? 
The schedule needs a good baseline, because it will be the standard for 
comparing the progress. 

h` Is a baseline present?

Updating the 
Schedule
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Keep in mind that projects planned far into the future that haven’t been 
approved yet don’t necessarily need a baseline.

h` Is the baseline complete?
You can verify the presence and completeness by applying the filter 
11 IIL Tasks with missing baseline info. The filter displays any tasks 
without entries in Baseline Start, Baseline Finish, Baseline Duration, or 
Baseline Work. When assignments are created after the baseline is set, 
the Baseline Work field is still empty. Note that the filter does not check 
on the field Baseline Cost.

h` Is the baseline the approved baseline?
The baseline cannot be reset without formal approval of the appropriate 
project stakeholders.

h` Is the baseline relevant?
If the project deviated too far from the baseline, a new baseline needs to 
be negotiated, since the baseline should provide a meaningful standard 
of comparison for the current schedule. You can check this by looking 
at how far the current schedule is removed from the baseline. Does the 
project have a fighting chance to catch up with the baseline again, or is 
it a lost cause? If it is a lost cause, you should submit a change request 
to change the baseline.

hh Are the appropriate options selected in File tab, on Backstage view, on 
Options, for the chosen updating strategy? 
h` For task updating (revising the task-related Actual Duration and 

Remaining Duration fields), the options should be set as follows: 
Tab Schedule: Check Split in-progress tasks 
Tab Schedule: Check Updating task status updates resource status 

h` For assignment updating (entering numbers from the time sheets into 
the assignment-related Actual Work and Remaining Work fields), the 
options should be set as follows:
Tab Schedule: Check Split in-progress tasks 
Tab Schedule: Check Updating task status updates resource status 
If you keep this option selected, you should not enter % Complete on 
tasks, because this may override time sheet data. 

h` For updating both the tasks and the assignments, the options should 
be set as follows: 
Tab Schedule: Check Split in-progress tasks 
Tab Schedule: Uncheck Updating task status updates resource 
status. You cannot enter both types of information unless you clear 
this option.
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hh Is the Status Date set to an appropriate date? 
The Status Date (on the Project tab, in the Properties group, click on 
Project Information), should be set to a date that is close to today’s date. 
If it is too far in the past, the schedule may be out-of-date. If it is too far in 
the future, the project manager is guessing the progress instead of entering 
factual progress.

hh Is the task type of soon-to-be-updated tasks set to Fixed Units and non 
Effort-driven? 
When you update the schedule, you change the durations (task updates) 
or the work (assignment updates). We recommended Fixed Units and non 
Effort-Driven, because you typically first would like to see what the schedule 
looks like when the same resources continue to work on the task. You can 
always re-optimize the schedule.

hh Is the schedule up to date per the Status date? 
h` Are all actual durations (actual work/actual hours worked) scheduled 

in the past? 
The actuals are scheduled in the past if they are earlier than the status 
date. Otherwise, the schedule does not have up-to-date forecasts. 
When you bring actual durations to the past, all their dependent tasks 
may be rescheduled earlier as well, which improves the forecasts. This is 
why rescheduling is important. You can verify this by applying the filter 
12 IIL Reschedule Actual Durations

hh Is there a one-page status report available as a separate View object in your 
project schedule that displays the major milestones relative to the baseline?
h` Are the milestones filtered in this view instead of listed together in the 

WBS?
Many project managers put the major milestones at the top of their 
schedule to create a one-page overview of the project. This makes the 
network of dependencies very complex in the Gantt Chart, because 
the dependencies run up and down with long arrows. This also makes 
it very difficult to check if the network of dependencies is complete. 
Instead, we advocate using a separate view that displays all milestones 
using the Milestones filter. 

h` Are the appropriate milestones chosen to represent the status and to 
forecast a large project?

h` Does the one-page view report (often prized by executives) give an 
appropriate impression of the health of the project?

hh If your schedule has a resource-critical path, is there a separate view object 
that displays it?

Reporting
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The view should have the resource-critical tasks flagged in the field Marked 
or in a Flag field.

hh Is there a set of views with an appropriate selection of objects to deliver 
different information to different stakeholders?

hh Does the report answer the primary concerns of the audience?
Using the views and built-in reports is a great idea, however you must be 
able to explain the information displayed in such reports. It is important to 
be familiar with the information needs of the stakeholders and apply the 
necessary modifications to answer those questions. For this reason you have 
to understand the applied filters, groups, formats, printing settings, and 
limitations of the delivery format (PDF, XPS, Excel, Power Point, etc.). For 
example, an executive needs to answer some questions that may be included 
in the built in Cost Overview dashboard, however the last time he saw this 
report, he was not able to see Level 2 information and also requested a brief 
explanation of why the remaining cost for the last phase was reported above 
the baseline cost. You can add an additional Cost Status table displaying a 
Level 2 of the WBS by copying and pasting the existing table and inserting a 
Text Box with a brief explanation of the changes from last report to this one.

hh Are you aware of the format in which every stakeholder prefers to review 
the information? Some stakeholders prefer graphics (use Visual Reports 
and the new graphic reports), others like fast and understandable tables 
(use views and tables), while others analyze the information in other tools 
like Excel or other databases (save the database in an OLAP cube or Access 
format). 

hh Is there a process when updating your project that you can automate? You 
can start your own macros to facilitate this process. 

hh Setting Up
h` Are you going to use default EVM fields? If not, have you defined 

customized fields you want to use for EVM?
h` Are you going to use EVM default views and reports? If not, have you 

defined customized views and reports for EVM?
h` Have you defined a default task Earned Value method (% Complete or 

Physical % Complete?)
h` Have you defined the different options that affect EVM calculations?
h` Have you defined quality thresholds for EVM variances and indices?

hh Planning
h` Have you defined your WBS and Control Accounts?
h` Have you defined an earned value measurement method for each task?
h` Have you defined your dynamic schedule?

Earned Value 
Management 
(EVM)
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h` Have you assigned resources (with rates) and/or fixed costs to all tasks?
h` Have you established your time phased budget?
h` Have you set your performance measurement baseline?

hh Executing, Monitoring, and Controlling (for each report period)
h` Have you set the status date?
h` Have you recorded progress for each task according to the EV 

measurement method defined in planning (update actual work, rates, 
costs, etc.)?

h` Have you updated remaining work, duration, rates, costs, etc. for each 
task?

h` Have you performed EVM data analysis?
h` Have you calculated or defined forecasts?
h` Have you proposed corrective actions as needed for the remaining 

work?
h` Have you delivered reports?
h` Have you maintained the integrity of the baseline?

hh Project Evaluation
h` Was the schedule clear to all stakeholders? 
h` How can you make it clearer in future projects?
h` Was the WBS complete and easy to understand? 
h` Did the WBS function as a tool for delegation? 
h` Were the deliverables in the WBS clearly formulated or did some 

deliverables cause confusion? 
h` How can you improve the WBS for similar projects in the future?
h` Were the estimates optimistic or pessimistic? 
h` What factors caused the estimates to be optimistic or pessimistic? 
h` How can you better forecast these factors in future projects?
h` Was there enough of a time buffer in the schedule to compensate for 

unforeseen events?
h` Which tasks consumed most of the buffer? Why?
h` Was the schedule easy enough to maintain during project execution?

hh Baseline
h` Did you capture an initial baseline?
h` Did you update the baseline after approved changes?
h` Did you compare baselines against your current schedule? 
h` Were you able to do forecasting on your project after you baselined?

hh Capturing Lessons Learned
h` Did you capture lessons learned and share them with stakeholders? 
h` Did you create project templates for future use based on lessons 

learned?

Evaluating the 
Project
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h` How can you improve for the next project?

Use this checklist of questions if you’re having trouble figuring out why a task is 
scheduled on particular dates. The questions are ranked in terms of precedence: 
the higher on the list, the stronger the effect on the task dates. Start at the top of 
the list and continue down until you find the item that explains the task’s date.

1. First, press the F9 key to force a recalculation. Even if you have automatic 
recalculation on, you may occasionally have to do this to refresh a calculation. 
Check to see if this solved the problem.

2. Does the task have an actual start date?
Does one of its predecessors or successors have an actual start date? 
Insert the column Actual Start to check this. Task Inspector panel (Task 
tab, Tasks group, click Inspect Task) can help to answer.

3. Is there a hard constraint on the task or on its predecessors or successors? 
Insert the column Constraint Type to check.

4. Is there a task calendar on the task or on its predecessors or successors?
Insert the column Task calendar. To see the task calendar’s non-working 
days, on the Project tab, on Properties group, click Change working time, 
then on the Change Working Time dialog box, select the task calendar 
from the list at the top under For Calendar. Also Task Inspector panel 
(Task tab, Tasks group, click Inspect Task) can help to answer.

5. Is there a leveling delay on the task (or on its predecessors)?
Insert the column Leveling Delay. If the task is delayed for the purpose of 
leveling the workload of resources, there will be an entry in this field. Task 
Inspector panel (Task tab, Tasks group, click Inspect Task) can help to 
answer.

6. What predecessors does the task have?
Insert the field Predecessors. Is there a lag on the dependency?
If there is more than one predecessor, typically only one of them drives the 
start date of the task in question. Using the new Task Path feature (Format 
tab, Bar Styles group, Task Path button) will help you to find the driving 
predecessors and successors very fast.
Also the Task Inspector panel (Task tab, Tasks group, click Inspect Task) 
can help to answer.

7. For Fixed Work/Fixed Units tasks: Are there vacation days set on the 
calendar of the resource who works on the task or on its predecessors or 
successors?

8. Are there splits in the task bars?

Checklist for 
Troubleshooting 
Dates in Project 
2013 Schedules
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Fixed Duration tasks can have weird splits in their task bars if one of the 
resources is not available when the task is scheduled. Fixed Duration task 
bars can also have leading dots before the task bar or trailing dots following 
the task bar that are leftover task bar splits. You can often get rid of these 
dots by changing the task type to Fixed Units or Fixed Work.

9. Task-specific constraint tendencies (ASAP or ALAP):
If you have an ALAP task constraint in an ASAP schedule, it tends to move 
dependent ASAP tasks out to later dates.

10. Default constraint tendencies (ASAP or ALAP):
You can check the default constraint in Project tab, on Properties group, 
click Project Information. If you Schedule from Project Start Date, the 
default is ASAP; if you Schedule From Project Finish Date, the default is 
ALAP. Under ASAP scheduling, tasks will tend to stay close to the project 
start date, unless one of the previous factors overrides this. Under ALAP 
scheduling, tasks will tend to stay close to the project finish date.
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If you have any further questions, don’t hesitate to contact us. 

We invite you to take on the challenge of becoming certified in Microsoft Project 
2013. You can take advantage of IIL’s Project 2013 Belt curriculum (White Belt, 
Orange Belt 2013, Blue Belt 2013, and Black Belt 2013) through self-study, live 
virtual training, or through traditional classes—public or onsite. Please visit our 
Web site, www.iil.com, to read up on our entire certification curriculum. We 
hope to personally welcome you into one of these courses. 

And remember that the files below are available for download at  
www.jrosspub.com. Click the link WAV Download Resource Center to enter the 
download site:

hh Case Studies appendix
hh The solution files for the case study exercises included in the Case Studies 

appendix.
hh Filters to check the quality of your own schedules included in the IIL Project 

2013 Tools.mpp file.
hh The RCP macro for identifying the resource-critical path included in the IIL 

Project 2013 Tools.mpp file.
hh Advanced Topics appendix that includes more ideas and good practices for 

specific situations.
hh Instructor material is available to academic instructors who have adopted 

the book as required reading for their students.

We thank you for the time you spent reading this book; we hope you found it 
worthwhile.

In Closing
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A consolidated schedule can be used to bring separate subproject schedules 
together into a single schedule for managing, reporting, analyzing, and/or 
leveling shared resources.

After reading this appendix you will be able to:

hh Describe the benefits of rolling up subproject schedules into a consolidated 
schedule

hh Insert subprojects into a consolidated schedule
hh Decide whether to insert subprojects with or without links and in read-only 

or read-write mode
hh Refresh a consolidated schedule
hh Explain what a cross-project link is and why it is used
hh Set cross-project dependencies in a program to create an integrated program 

schedule
hh Monitor, manage, and maintain the links between projects
hh List the advantages and disadvantages of cross-project links
hh Follow the Do’s and Don’ts when working with linked schedules
hh Analyze integrated program schedules using gates
hh Create a central resource pool from scratch or from an existing schedule
hh Baseline a consolidated schedule

A consolidated schedule is assembled from: 

hh Independent subproject schedules that are brought together for reporting 
purposes

hh Independent subproject schedules that share resources and are consolidated 
for analyzing and leveling purposes

hh Interdependent subproject schedules that share resources and are 
consolidated for analyzing and leveling purposes

hh Interdependent subproject schedules without shared resources that are 
consolidated for purposes of understanding the larger picture and reporting

Learning 
Objectives

What is a 
Consolidated 
Schedule?
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We use the term consolidated schedule to mean bringing multiple subproject 
schedules together into one schedule, regardless of the purpose. Many texts 
differentiate between the types of consolidated schedules, for example:

hh Master Project Schedule: A collection of smaller project schedules that 
are elements of the master (larger picture) project. An example might be 
a project where each department produces its own departmental schedule 
for the work.

hh Program Schedule or Integrated Program Schedule: A collection of 
individual, but related, project or program schedules that are consolidated 
to facilitate the management of the program. An example might be a testing 
program, where each administration of a test rolls up into the testing 
program schedule.

hh Consolidated Schedule: A more limited definition of consolidated schedules 
that includes schedules that have no relationship to each other, but are 
consolidated for purposes like leveling and reporting.

Many may view these as distinctions without a difference, but while the 
techniques are similar, the characteristics and use vary. For example, note that in 
each of the above definitions:
hh Resources may or may not be from a common pool.
hh The consolidated schedules may be temporary (brought together just for 

reporting or leveling) or may persist and be used to manage the program/
project.

Project 2013 refers to all of these instances as Master Projects and Subprojects 
in the help resource.

There are two common situations in which consolidated schedules are useful:

Large schedules can quickly become unwieldy, and can benefit from being 
broken down into subprojects and then inserted into a consolidated schedule. 
There are two criteria you can use to determine if you have a large project that 
would benefit from this treatment:

hh The number of hierarchical levels in your project team. 
If you have more than two levels in your project team, you have a large 
project. In small or medium sized projects, the project manager interacts 
directly with the team members. If the project manager interacts with team 
leaders who supervise the team members, you have three levels in the 
project team hierarchy and your project is large.

When to 
Consolidate 
Schedules
Large Schedules
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hh The number of tasks in the project schedule. 
You need to break a large schedule into multiple sub-schedules if the number 
of tasks gets difficult to handle in a single schedule. For example, finding the 
critical path in an extremely large schedule is a challenge, but in a smaller 
task schedule, the critical path may fit within one screen.

The other situation where consolidated schedules are of use is when you have 
existing project schedules that you want to bring together. For example, you 
might want to bring a number of project schedules together into a consolidated 
program schedule.

PMI defines a program as “A group of related projects, subprograms, and 
program activities managed in a coordinated way to obtain benefits not available 
from managing them 
individually.”1 

Managing a large project with 
many separate, non-integrated 
schedules can be cumbersome; 
Project 2013 allows you to 
place multiple projects into 
one “umbrella” or consolidated 
project. Project schedules you roll up into the consolidated project are often 
called subprojects or sub schedules.

Consolidating schedules can be especially useful in the following situations.

hh Subprojects share the same pool of resources
Consolidating schedules is useful for analyzing and leveling resource use, 
particularly when there is competition for scarce resources.

hh Subprojects have dependencies between them
This is the case, for example, in a large software development program that 
is divided into the following subprojects: Design, Development, Testing, 
Deployment, Documentation, Logistics, and Training. There are obviously 
many dependencies between these subprojects and benefits can be obtained 
from managing the subprojects in a coordinated fashion and treating them 
as an integrated program schedule.

hh There are specific reporting needs on a group of projects
Consolidating projects makes it easy to treat them as a program for reporting 
purposes.

hh An organization runs many similar projects for one client

1 ——— PMBOK® Guide — Fifth Edition, PMI, 2013, p. 553.

Multiple Schedules 
that Require 
Integration

Tasks

Subprojects

Integrated
Program
Schedule

Why 
Consolidate 
Schedules?
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The projects are often treated as an integrated program schedule.

Consolidated schedules can include either internal or external subprojects, or a 
combination of both. For example:

hh Internal subprojects.
All components are created by in-house departments. Examples:
h` High-tech product development programs and pharmaceutical 

programs are often entirely internal, because of the confidential nature 
of these projects.

h` Many IT-programs within multi-nationals are set up this way.

hh External subprojects.
The owner organization has subcontracted all components of the overall 
program. The project managers within the owner organization are managing 
the subcontractors using high-level schedules only, and are more like 
contract managers or outsourcing managers. The subcontractors maintain 
the detailed subschedules. 

hh Mix of internal and external subprojects.
The owner creates some components, and has subcontracted some 
components to external performing organizations. This is a mixed program 
with some internal subproject and some external subprojects.

Each schedule that is to be consolidated should be checked first for the following 
characteristics, and any problems addressed before consolidating.

hh Did the scheduler follow consistent scheduling guidelines?
These guidelines are extremely important for large schedules. For example, 
if there are many constraints in the subprojects, you cannot analyze a large 
schedule easily, let alone optimize and/or change it.

hh Is the baseline still what it should be?
The baseline has to be the original baseline or a baseline that reflects only 
approved change requests. 

hh Are there errors?
The scheduler could make accidental errors; to avoid them, ask:
h` Are estimates reasonable?
h` Are there inaccurate dependencies?
h` Are there any over-allocations?
h` Are there any scheduling conflicts?

hh Are there omissions?
The scheduler could have omitted the following things:
h` Contractual deliverables/tasks
h` Crucial dependencies

Checks to 
Perform before 
Consolidating
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h` Scarce expert resources
h` Assignments of the scarce resources

If you receive a subproject schedule from a subcontractor, we recommend that 
you first analyze the schedule to see if any changes were made, particularly to 
the baseline. Subcontractors should not make changes to the baseline without 
your approval. You can use the project comparison feature for this by choosing 
Project tab, Reports group, select Compare Projects (see Chapter 13).

When you create a consolidated schedule, it’s important to remember that the 
subproject schedules will inherit many of the settings from the consolidated 
schedule. Several areas you should check include, but are not limited to:
hh Calendars
hh Fonts
hh Default settings

To avoid confusion between the subprojects and the consolidated schedule, it is 
a good idea to standardize each schedule before consolidating.

One setting that is often confused is the setting to calculate multiple critical 
paths or a single critical path. 

1. On the File tab, in the Backstage view, click Options, Schedule. The 
Project Options dialog appears.

2. At the bottom, under Calculation options for this project, the setting 
Inserted projects are calculated like summary tasks is used for 
Consolidated projects.
h` Check this box if you want a single critical path
h` Clear this box if you want to see a critical path for each subproject

3. In the Project Options dialog, click on Advanced tab.

4. The setting Calculate multiple critical paths will be helpful if you want 
to review independent critical paths for subprojects that are not necessarily 
part of the consolidated critical path.

When working with projects that eventually will be consolidated as subprojects, 
it is a good practice to create a project template that contains all the options, 
calendars, custom fields, and defaults necessary for consolidation and deliver 
it to the stakeholders to use in their projects. This will make your consolidation 
process very fluent.

Reviewing 
Options and 
Settings
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There are two ways to create consolidated schedules. The first automatically 
links the files, this is that any change in the subproject will impact the master 
project and vice-versa. The second allows you to choose whether you want the 
files linked.

With this method you will consolidate all the projects that you select into a 
new master project. The files are automatically linked, which means that if any 
change takes place in the master or subproject file, the other file(s) will reflect 
the change.

1. Open all of the projects to be consolidated.

2. On the View tab, in the Window group click New Window.

3. In the New Window dialog, select the projects that you want included and 
the View you want to display with the consolidated project and click OK.

If you use this method, you may not get certain warning messages, such as for 
circular dependencies.

To save the changes see the Saving section below. 

With this method you’re able to choose whether or not you want the subproject 
files linked to the master.

Inserting a subproject into a master project and checking the Link to Project 
box creates a dynamic link between the two files. 

Inserting a subproject into a master project and clearing the Link to Project box 
actually creates a copy of the project in the master project. This is a static copy: 
future changes to the subproject won’t be reflected in the master project and 
vice-versa.

1. Open a new, blank schedule. Save and name this file <XYZ Master Project> 
(follow your company’s naming conventions for master projects).

2. Put your cursor on the first line in the Task Name column.

3. Choose Project tab and in the Insert group, click Subproject.

4. In the Insert Project pane navigate to the name of the first project file you 
want to consolidate and select it.

5. Check or clear Link to project. 

6. Click Insert to insert the file, 

OR

Creating a 
Consolidated 
Schedule

Consolidate with 
Automatic Linking 
of Files

Consolidate  
with Optional 
Linking of Files
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If you’ve checked Link to project, you can insert a read-only copy of the 
file by clicking the down-arrow on the right of the Insert button and select 
Insert Read-only. 

7. Notice that the Subproject summary line is inserted.

8. Continue to do this on each subsequent line for each additional project you 
want to add.

We recommend that you insert subprojects as read-only as a standard practice 
to prevent:

hh Hogging the sub-schedules: if you insert a subproject read-write and 
you open the master project, while you’re editing the master project, the 
subproject manager can’t open his/her schedule in read-write mode and 
can’t make changes to it.

hh Accidental changes to the subprojects: you don’t want to inadvertently 
change the schedules that are maintained by others.

You will, however, need read-write access to the subprojects when you want to 
do any of the following:
hh Create cross-project dependencies
hh Resolve over-allocations
hh Solve schedule conflicts in the master schedule

You can easily switch a read-only file to read-write and vice versa (see the section 
“Working with a Consolidated Schedule” below).

When you close out of the master file, you will be asked if you want to save the 
master file and individually you will be asked if you want to save each subproject 
file. You do not have to save the master file to maintain the changes and 
dependencies created in the master and affected on the subproject schedules. If 
you’ve consolidated subprojects for a temporary purpose such as for reporting, 
it’s not recommended that you save the consolidated master file.

Be careful when inserting new tasks under either a collapsed or expanded 
subproject:

hh If you insert a task inside or just beneath an expanded subproject, the task 
will end up in the subproject.

Options for 
Consolidating 
Subprojects
Read-write  
or Read-only  
Access

Saving

Inserting  
New Tasks
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hh If you insert a new task just beneath a collapsed subproject, the task will end 
up in the program schedule.

hh You can see in which schedule a task was inserted by looking at the ID-
number. Note that the ID-numbering starts at 1 inside each subproject.

You can insert a subproject on any indentation/outline level. This allows you 
to create a true breakdown structure for the program in which you insert the 
project schedules at the appropriate places to create the program breakdown 
structure the way you want it to be. 

The maximum number of schedules you can roll up in a master project using 
the Insert Subproject feature (on the Project tab, in the Insert group, click 
Subproject) is about 998. The maximum number of tasks within one schedule 
is 400,000, so you can insert about 998 subproject schedules of 400 tasks each.2 

Be aware that actual limits and performance speed depend on your computer’s 
configuration.

You can consolidate master schedules. For example, if you have several subproject 
schedules, you can create a master schedule from them for the program. If your 
department has multiple program schedules, you can create a department 
schedule from the program schedules by inserting them into a consolidated 
department schedule.

Although Project 2013 lets you nest several levels of sub-projects, managing 
multiple levels of master projects can be cumbersome. A good practice before 
doing this is to establish the level of control that you really need and define a very 
good process of consolidation for updates. In general, the simpler your model is, 
the better.

If you are creating a breakdown structure for the program in which you are 
inserting project schedules, you can establish a WBS-specific codification 
(coding scheme) that facilitates the localization of the subprojects into the 
consolidated project.

To modify the WBS code, you must define the codification in the Master Project 
as well as in the subprojects by following these simple steps:

1. On the Project tab, in the Properties group, click the WBS icon, Define 
Code. The WBS Code Definition dialog appears.

2. In the WBS Code Definition dialog, you can set the following:
a. Project Code Prefix: This field is very useful when consolidating 

projects. Every subproject will have a specific Code that distinguishes 
it from others. For instance, if one of the subprojects is the Phase II of 

2 These specifications can be consulted at the site http://office.microsoft.com/en-us/project-help/
specifications-for-microsoft-project-HA102749083.aspx?CTT=1

Inserting 
Subprojects on 
Outline Levels

Maximum Number 
of Inserted 
Projects

Multiple Levels of 
Consolidation

Modifying 
the WBS to 
Consolidate 
Projects

J. Ross Publishing; All Rights Reserved



Appendix 1: Consolidated Schedules

649

a consolidated project, the prefix could be defined as <PHII>. With 
this option, all the tasks that belong to this subproject will be identified 
with the prefix <PHII>.

b. Code mask: Use this to set the number of levels and the mask for every 
level. For the Master Project, you should establish at least the first level.
You can choose a mask of numbers, uppercase or lowercase letters 
or special characters, depending on how you are modifying the WBS 
Code. You can do the same for the sub-projects.

c. Code preview: This field allows you to preview the codification that is 
being established by the Code mask and Project Code Prefix.

When using characters (instead of numbers or letters) to define the code mask 
of any level in the WBS, a placeholder asterisk “*” will be displayed in the code 
so you can manually substitute the placeholder.

3. Click OK.

4. If you are using a code mask other than Characters, go to step 7.

5. Right-click the Task Name column, Insert, WBS.

6. Manually substitute the place holder asterisk “*” in the desired level. 

7. Repeat this process for every Subproject.
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The following discussion assumes that the projects you are working with are on 
a shared drive with appropriate access.

hh Refresh takes place upon expanding the subproject schedules
If you open a program schedule and the subproject schedules are collapsed, 
you may not see the latest forecasts. Only when you expand the subproject 
schedules within the master schedule will Project 2013 retrieve the latest 
data from the subproject schedules or recalculate them.
h` You have to make sure that when you open a master project, you 

first expand all subprojects. (In the master project select the project 
summary task and on the View tab, in the Data group, click Outline, 
All Subtasks.)

h` As an alternative, before you close the master project, if you expand all 
the subprojects, the next time you open the master, all subprojects will 
be refreshed.

hh Ensure you have the latest version of the schedule
There are specific task-related fields for subprojects that can help you 
determine the latest version of your schedule:
h` Inserted Project Indicator: In the Gantt Chart view, on the column 

Indicators, an Inserted Project icon will be shown for any inserted 
project summary task. Hovering the mouse over this icon will display a 
Smart Tag indicating the path of the subproject.

h` Inserted Project Information dialog: Double-click the subproject 
task and the Inserted Project Information dialog appears; click the 

Working with a 
Consolidated 
Schedule
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Advanced tab. Under Link to Project you can read the path and the 
name of the subproject. Click Browse to reroute to the latest version 
of the project

hh Toggle a read-only file to read-write and vice versa
You need to toggle to read-write before you can make any changes to 
subprojects inside a master project. You need to do this when you try to 
resolve scheduling conflicts or over-allocations within the master project, 
or to set cross-project links in the master schedule.

Double-click the subproject task and the Inserted Project Information 
dialog appears; click the Advanced tab: 
Read Only: is checked if the subproject was inserted read-only. If you clear 
the checkbox to Read-only the schedule will switch to read-write. After you 
click OK, save the changes to the master project and re-open.

If you have the subprojects open in read-write mode in the master project, 
the subproject managers cannot make any changes to their subprojects! 
You need to minimize the time you keep the subprojects open in read-write 
mode. You should also establish processes and clearly communicate with 
the subproject managers who own the schedules about what times you will 
open their schedules read-write.

hh Save changes to program/subproject schedules:
If you have made any changes to the master project schedule and you close it, 
first you will be asked if you want to save the changes for the master project 
and then for each of the subproject schedules. You must click an instruction 
for each project and you also have the option to say Yes to All or Not to All.

Sometimes, you want schedulers or project managers to have their own schedules 
and work independently while there are dependencies between their projects. 

For example, the software 
development project may drive the 
software-testing project. These links 
are called cross-project links or 
interdependencies. Such projects 
are often subprojects in an integrated 
program schedule.

There are options to consider on 
File tab, Backstage view, Options, 
Advanced, section Cross-Project 
Linking options for this project:

Preceding Project

Succeeding Project

Cross-Projects 
Dependencies
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hh When the Show external successors and Show external predecessors options are 
checked, you can make sure you see the external tasks listed in the task list; 
they are shown in gray.

hh When the Show ‘Links Between Projects’ dialog box on open is checked, any 
subproject manager will be shown a report of the external cross-project 
links displaying the updates as explained in the following pages.

If you create a cross-project dependency using the New Window method (on 
the View tab, in the Window group, click New Window) and create a temporary 
merge of two sub-schedules for 
which you want to set cross-
project dependencies, you can 
easily create circular 
dependencies in the overall 
master schedule. A circular 
dependency will stop automatic 
recalculation, since Project 
2013 cannot produce a schedule 
that meets the requirements of 
all dependencies. The master 
schedule is useless at that point. 
If you always create the cross-project dependencies in the master schedule, 
Project 2013 will immediately warn you if you are creating a circular dependency.

We recommend you create cross-project dependencies in the master schedule, 
because it will prevent you from accidentally creating a circular dependency.

You need to have read-write access to the subprojects in order to create cross 
subproject dependencies. If the subprojects are currently read-only, you have to 
toggle them to read-write, then close and re-open the master schedule.

In the master schedule, you can create cross-project dependencies as you would 
set dependencies in single schedules. You can:
hh Use the Link the selected tasks tool located on the Task tab, Schedule group 

(recommended method).
hh Drag between task bars to create the links by mouse. (If the tasks are far 

apart, this can be difficult.)

We recommend you to use the Entry Table in the Gantt Chart view to 
review cross-project dependencies, by pointing the task link or selecting the 
Predecessors field for the specific task. 

= Circular
   Dependency

Setting Cross-
Project 
Dependencies 
in the Master 
Schedule

J. Ross Publishing; All Rights Reserved



Appendix 1: Consolidated Schedules

653

Establishing predecessors between projects is not as simple as entering the ID-
numbers of the predecessor or successor as you can in a single schedule when 
setting dependencies. This is because the ID-numbers in a master schedule 
with linked sub-schedules will vary after you set cross-project dependencies. 
The tasks of the subprojects keep their original ID-numbers except for the sub-
schedule summary task which acquires an ID-number according to its position 
in the master schedule. 
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Although in master schedules the tasks of the sub-schedules keep their ID-
numbers, when opened independently, if the Show external predecessors and 
Show external successors options are checked (File tab, Backstage view, Options, 
Advanced, Cross-Project Linking options for this project section), cross-
project dependencies will be shown in a degraded gray color, acquiring an ID-
number in the sub-schedule. 

To quickly jump from the predecessor schedule to the successor schedule and 
back, double-click on the gray ghost task (the external task).

1. In Project 2013, open the successor project, and access the Links Between 
Projects In dialog. On the Project tab, in the Properties group, click Links 
between Projects.

If the option Show Links Between Projects dialog box on open is activated (File tab, 
Backstage view, Options, Advanced, section Cross-Project Linking options 
for this project), the dialog will pop up automatically when opening if changes 
were made to the related sub-schedules.

2. Click tab External Predecessor, and select one of the listed predecessor 
tasks in the list (these are the ones without an ID number); the buttons 
Accept, All, Delete Link and Browse are now enabled.

3. To update the selected link and accept the differences, click Accept. 
To accept all differences listed in the dialog, click All.  
To delete a link, select it and click Delete Link. 
To indicate a new location or name of the schedule, click Browse.

4. View the External Successors and verify if the project manager who is 
dependent on your project has resolved all Differences. If you don’t have 

Maintaining the 
Cross-Project 
Links
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read-write access to the successor project, you don’t have authority to accept 
or reject changes. Contact the project manager of the external successor 
project to resolve any differences that continue to appear.

Notice that the Accept button is not disabled for external successors, even 
though you cannot make the decisions on behalf of the successor project 
manager. You cannot make the differences go away if you have read-only 
access. 

The Links Between Projects dialog always has at least two lines for an external 
dependency. The first line (with ID number) contains the task in your project. 
The next line(s) contain information on the external task(s). The next screenshot 
shows that your task 2 has an external predecessor:

When you have an external predecessor or successor selected, you can see below 
the list the path and name of the schedule that contains the task.

The dialog has two columns that need more explanation.

hh Date:
The Date field here should be interpreted as the “old date.” It is the old start 
date if it shows Start on the same line under Differences or the old finish 
date if it shows Finish on the same line under Differences.

hh Differences: notes you can find in this field are:

The Links 
Between  
Projects Dialog
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Remark Explanation What to do?

None The link is up-to-date. Nothing.

File not 
Found

The linked schedule is 
deleted or renamed.

If moved, use the Browse button 
to point to the new schedule. If the 
schedule is found the message will 
change to: File Located.

Delete 
External

The other scheduler 
deleted the anchor task for 
the external dependency 
(not the link!).

Select it and click Accept to remove 
your side of the dependency and 
remove the external task from your 
task list.

Create 
External

The link is partially set. One 
reason could be that the 
link was added by another 
scheduler who only had 
read-only access to your 
schedule and the link was 
saved in one schedule but 
not in the other.

Select it and click Accept to create a 
cross-project dependency and add an 
external task to your schedule.

Task Start 
to <date>

The start date of your 
dependent task is changed, 
often driven out.

Accept the new date if you can 
manage it within the buffer of your 
project. If you can’t accept it, ask the 
other project manager to resolve the 
slippage.

Task Finish 
to <date>

The finish date of your 
dependent task is changed, 
often driven out. This can 
happen with a Finish-to-
Finish dependency.

Accept the new date if you can 
manage it within the buffer of your 
project. If you can’t accept it, ask the 
other project manager to resolve the 
slippage.

If an external link itself is removed or a link is recorded partially (the link is 
visible in one sub-schedule but not the other), it does not cause the message 
Delete External to be displayed in the linked schedule. Instead, it shows up as 
no difference (None) or as a difference in start date (Start To) or finish date 
(Finish to) that makes it look like the link is still alive. If you double-click on 
such a ghost external task in the Gantt Table, the dependent schedule comes up 
and shows you the remark Create External. This allows you to re-establish the 
external link. The problem is that you cannot see if a link is still alive or not when 
the other person removed the external link.

If the predecessor task is inactivated with the new feature to do so (Task tab, 
Schedule group, Inactivate), you will receive a notification that dates changed 
but until you accept it and close the dialog you will see on the screen the inactive 
task (task name with a line through the middle). Remember that this inactivate 
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task option does not remove the task from the schedule. The inactivate task 
feature also does not affect any resource availability or how other tasks are 
scheduled, so your related tasks could be affected in an unexpected way. You will 
need to establish with the master schedule manager or the other sub-schedule 
manager how to establish a new reference.

Cross-project links have both strengths and limitations.

Advantages:

hh Automatic, but controlled impacts between schedules 
Links allow you to keep the schedule up-to-date automatically when other 
projects affect your schedule. The updating is controlled: upon opening the 
schedule, you are prompted as to which impacts you want to allow into your 
schedule.

hh Ability to delegate ownership 
Links allow you to delegate schedule ownership to the responsible people 
while maintaining program integrity.

Disadvantages:

hh Requires one central repository (either a server or PC) 
You need a central repository on a network server that is accessible to all 
project managers. If schedules are large, the connection needs to be fast.

hh Takes full control (and ownership) away from the project manager 
Some project managers feel that the ownership of their schedules is taken 
away from them because of the external links that impact their schedules. 
The fact of the matter is that you can review and control which impacts you 
accept. And even if you choose not to model the cross-project impacts, you 
will still need to monitor and manage them.

hh One project manager can break a dependency without the other project 
manager being notified
When you break a link, the other project manager will not see a specific 
notification in the Links between Projects dialog. The dialog just shows 
None, Start to, or Finish to which makes you think the link is still alive.

Because cross-project links can be tricky to manage, we suggest you adhere to 
the following list of do’s and don’ts.

hh Document the cross-project links by writing a Note on the external task. 
The Notes field is one of the few fields of external tasks that you can edit. 
The note is stored and visible in your schedule only.

Advantages & 
Disadvantages 
of Cross-Project 
Links

Do’s and Don’ts 
for Cross-Project 
Links

Do’s

J. Ross Publishing; All Rights Reserved



658

Dynamic Scheduling® with Microsoft® Project 2013

hh Set Deadlines in the dependent tasks so the driving project manager will be 
able to view these deadlines in the successor tasks and he also will be able to 
manage his own considerations or commitments.

hh Create milestone tasks with the name <External dependency> to help the 
master-scheduler understand your dependencies with other projects and 
facilitate the management of tasks which connect to other projects.

hh If you need to move an externally linked task, instead of cutting and pasting, 
you should drag and drop the task. Cut and paste is a temporary delete!

hh Keep the Show External Predecessor and Show External Successor 
turned on (File tab, Backstage view, Options, Advanced, Cross-Project 
Linking options for this project section). This will help prevent accidental 
deletion of tasks with external links.

hh Keep the external task listed next to its internal task by dragging the pair of 
tasks with the mouse (do not use cut & paste, since this will remove links). 
Keep external predecessors above your task and external successors below 
it.

hh Notice that the driving project manager can see if the dependent project 
manager has accepted the impacts or not. The driving project manager can 
call the dependent project manager to resolve issues if the Differences 
persist. The driving project manager cannot Accept the Differences, 
because (s)he does not own the driven schedule. The visibility creates peer 
review and peer pressure to resolve issues and keep the integrated program 
schedule valid.

hh Don’t delete an externally linked task.
If you delete an anchor task (task with an external dependency), you remove 
the external link as well.

hh Don’t cut and paste an externally linked task.
If you cut a task that has an external dependency using the clipboard tools, 
you will break the link. Instead, move it by dragging. Cutting a task is 
temporarily deleting it, and the link will be lost. The link may even be re-
routed to another task in a best guess by Project 2013.

hh Don’t set the cross-project links to your project summary tasks.
We don’t recommend this because the external tasks will not be visible to the 
other project manager and may cause confusion. Don’t allow other project 
managers to link to your project summary task. Nothing can be shown 
above project summary task with ID 0 (zero) in the task list in Project 2013. 
Those links will only be visible in the master schedule. In Chapter 5 you can 
find a more extended explanation.

Don’ts
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hh Don’t open two schedules with Differences between them on one computer 
unless you are using a master-schedule.
As soon as you open both schedules and edit them, all Differences between 
the two schedules are automatically accepted, even if you have just read-only 
rights to the other schedule. If you want to keep the Differences, save and 
close the one schedule first, and then open the second one. Make a quick 
screenshot if you want to compare the schedules. If you have read-write 
access to both schedules and save them, all differences will be automatically 
accepted without a prompt.

hh Don’t create long chains between many serial projects.
If a project manager who is in the middle of the chain goes on vacation, 
the successor project managers will not see any impacts during his vacation. 
The chain will be only as strong as its weakest link.

When dealing with cross-linked projects you should avoid not accepting those 
changes to your schedule made by another project manager without first talking 
to the original project manager who made the change. Not accepting changes 
(in the Link Between Projects dialog, click Close) certainly will not affect the 
tasks in your schedule, but it does not mean there is no dependency.

If you have a truly integrated program schedule with a series of subprojects that 
are all dependent upon one another, there should only be one critical path. All 
paths should come together in the program finish milestone.

But the critical path in a large schedule of 10,000 tasks can easily comprise a 
thousand tasks. This is too many to make sense of; we have to change the way we 
analyze the critical path in a large schedule.

In large program schedules, there are often several major milestones or gates 
with hard deadline dates. These constraints can cut the large network into 
independent sub networks. 
Now you can analyze each sub 
network and avoid having to 
deal with more data than you 
can analyze.

We recommend that you focus 
on one milestone at a time, 
and find the critical path on the 
milestone.

Analyzing the 
Critical Path by 
Gate

Subproject A

Subproject B

Subproject C

Master Schedule Gates

Time

WBS
Program
Schedule

Gate1 Gate2 Gate3
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You can find the critical path on a gate milestone by looking at the amount of 
total slack of its predecessors and identifying the tasks that have the same (or 
smaller or more negative) amount of total slack. That predecessor is driving the 
gate milestone.

You can analyze a gate milestone by using various tools explained in previous 
chapters, mainly chapters 9 and 11. These tools range from very simple to more 
sophisticated:

hh Task Inspect: Here you can trace back all the factors affecting a path of tasks. 
Select the task gate (milestone) and on the Task tab, in the Tasks group, 
click Inspect.

hh The Tracking Gantt view differentiates the critical and non-critical tasks.
hh The Schedule Table which allows you to review the Free Slack and Total 

Slack of tasks.
hh You can apply a filter of Critical tasks or Date Range.
hh You can create a custom field to classify tasks affecting a specific gate. Then 

create a filter or a group to see the specific gate tasks and create a view where 
you can differentiate critical and non critical tasks, and also see the total 
slack to perform the analysis.

hh Create a Macro that helps you perform this analysis.

A resource pool is a group of resources available for assignment to project tasks. 
It can be used by only one project or shared by multiple projects. 

After you consolidate files into a master project file, the resources for the 
consolidated files remain separate. If you change resource information in the 
master project, the changes will be replicated in the subproject’s source file. But 
you can’t assign a resource to any project other than the subproject it came from. 

If you insert several subproject schedules that have resources assigned to tasks, 
your master schedule Resource Sheet may contain duplicate resource names. 
This can be a real mess to try to straighten out. A single, central resource pool 
can be used to:
hh Prevent duplications in the master schedule’s resource sheet
hh Facilitate the management of a large resource pool
hh Standardize resource information within each schedule

Creating 
a Central 
Resource Pool
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If you create a centralized resource pool, you may also want to delegate a single 
individual or the project management office to maintain this file by keeping 
resource information current and making sure it’s backed-up

There are two approaches to creating a central resource pool. One is appropriate 
if you don’t have any existing projects using resources. The second approach 
takes advantage of existing schedules with resources to quickly build the central 
resource pool, keeping rates, skills, and general information current.

Whenever you have schedules without resources, you can begin building your 
resource pool from scratch. To do this:

1. Open a new blank schedule. Save and name this file <ABC Resource Pool>, 
where ABC stands for your company’s or division’s name.

2. Go to the Resource Sheet view (View tab, Resource Views group, 
Resource Sheet) and enter each resource’s name and information, just as 

Building a 
Resource Pool 

J. Ross Publishing; All Rights Reserved



662

Dynamic Scheduling® with Microsoft® Project 2013

you would for a single project. This time you will include all resources to be 
shared.

3. The Resource Pool file must be open to allow project schedules to use the 
pool.

4. Open the project that will be using these resources. On the Resource tab, 
in the Assignments group, click Resource Pool, Share Resources. The 
Share Resources dialog opens.

5. Under Resources for <ABCProject>, select the radio button that reads 
Use Resources From and click the box to select the resource pool <ABC 
Resource Pool>.

6. Under On conflict with calendar or resource information, chose either 
Pool takes precedence or Sharer takes precedence to resolve conflicts in 
a manner consistent with your organization’s policies. (We suggest that in 
the event of a conflict, the resource pool should take precedence.)

If you go to the schedule’s Resource Sheet view, you will now see all of the 
resources that were listed in the resource pool.

If you have schedules that already contain entries in the Resource Sheet view, 
you can capitalize on this to facilitate the building of the resource pool. 

You can either clean the project with the Resource Sheet entries of all tasks, 
assignments, etc.; or migrate the resource database to a new project. (To migrate 
the resources click the ID-number of the rows you want to take, right-click, and 
in the floating list, select Copy. Then go to the Resource Sheet view of the new 
file, select the first available row, and on the Task tab, in the Clipboard group, 
click Paste.)

You should standardize all of the resource names and information in the 
schedules before creating the resource pool. If any of the names are spelled 
differently or if nicknames are used, there will be an entry in the resource pool 
for every name variation. 

If your company intends to move to an enterprise project management solution 
such as Project Server, you may want to consider using a resource naming 
convention that is consistent with either your application in Outlook or Active 
Directory, depending on where you contemplate importing resources from.

When you open the resource pool you will be prompted with an Open Resource 
Pool dialog. You will need to select from the following options:

Building a 
Resource Pool 
from Existing 
Schedules

Working with a 
Resource Pool

J. Ross Publishing; All Rights Reserved



Appendix 1: Consolidated Schedules

663

hh Open resource pool read-only allowing others to work on projects 
connected to the pool. This option will allow you to analyze all the 
assignments by using the Team Planner view or the Resource Usage view.

hh Open resource pool read-write so that you can make changes to 
resource information (like pay rates, etc.), although this will lock 
others out of updating the pool with new information. This option, will 
allow you to edit certain characteristics of the resources; it won’t allow you 
to level any over-allocation of the resources.

hh Open resource pool read-write and all other sharer files into a new 
master project file. You can access this new master project file from 
the View tab, Switch Windows command. This option will allow you to 
modify the resource characteristics (calendar, pay rates, etc.) and also will 
allow you to level any over-allocation by using the same methods discussed 
in Chapter 9.

Adding more and more cross-linked projects to a centralized resource pool will 
degrade performance. If you start to see performance suffer, you may want to 
consider going to Project Server.

When you baseline a Master Schedule (consolidated schedule), keep in mind 
that you are working with a project file with its tasks; the project summary tasks 
of sub-schedules are the regular tasks for the Master schedule. When you set the 
baseline by following the standard process (Project tab, Schedule group, Set 
Baseline, Set Baseline, Entire project, OK), you are setting the baseline for 
the regular tasks of the master project. As the project summary tasks of the sub-
schedules are in this category, they will have a baseline but it will not include the 
sub-tasks of those sub-schedules.

 

Baselining 
a Master 
Schedule
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This approach can be very helpful when the master schedule manager wants to 
set a baseline to measure the performance of the master schedule, allowing the 
sub-schedule managers to set their own performance baselines. In the case of a 
program, the program manager will be able to measure against his commitments 
with the program board, while the project managers of sub-schedules will 
measure against their own commitments with the program manager.

The baseline of master schedules is easy to review in the Tracking Gantt view or 
by applying some simple commands on the Format tab. However, to review the 
baseline of the subprojects summary, follow these steps: 

1. On the Format tab, in the Bar Styles group, click Format, Bar Styles. The 
Bar Styles dialog appears.

2. Scroll down to the first available row, and on the Name column write 
<Baseline Summary>, in the Show For … Tasks column, type Project 
Summary, Summary.

3. In the From column, select Baseline Start and in the To column, select 
Baseline Finish.

4. At the bottom of the dialog, click the Bars tab and in the zone Middle, in 
the Shape field select the option you prefer and in the Color field select a 
dark color. 

For the Shape field, we suggest you use the 4th option which is a thin box aligned 
to the bottom of the Gantt.

If the master schedule manager and the sub-schedule managers agree on the 
same performance baseline, you can set the baseline for all the tasks by following 
the next steps:

1. In the master schedule, ensure all the tasks are displayed. Select all tasks and 
on the View tab, in the Data group, click Outline, All Subtasks.

2. On the Project tab, in the Schedule group, click Set Baseline, Set Baseline. 
The Set Baseline dialog appears.

3. Under For, click the Selected tasks.

4. Under Roll up baselines check the To all summary tasks option.

5. Click OK.

An alternative approach to establish commitment is to set the baseline in the 
master schedule to the master project level, but do the actual baselining in each 
of the subproject schedules.

Using separate performance baselines between the master schedule and the 
sub-schedules can be very helpful to measure different levels of commitment, 

Set the Sub-
Schedules 
Baseline
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however it is important that the different stakeholders receive the appropriate 
information. The person in charge of coordinating the performance baselines 
should be very skilled at this, otherwise you run the risk of measuring lots and 
lots of information but losing control.

1. Leveling resources from individual schedules that are shared with other 
projects will not take into account the over-allocation in other projects.

2. Since not all dependencies can be complete until the subproject schedules 
are consolidated, optimization should wait until leveling and dependencies 
can be reviewed in the consolidated schedule.

3. Because of number 1 and 2 above, you can’t gain agreement from 
stakeholders on finalized dates and costs. 

4. Due to 1, 2, and 3 above, you should wait to baseline the schedule until 
after the consolidation has been accomplished (unless it is a “temporary/
preliminary” baseline for impact analysis). In these cases you may want 
to use the rolling wave planning approach explained in Chapters 3 and 4, 
where commitments to earlier phases can be established but later phases are 
set in a high-level plan.

For experience working with the features you’ve learned about in this chapter, 
we strongly suggest that you do the additional exercises for this chapter that 
are included in the Case Studies appendix, available to download in the WAV 
Download Resource Center at www.jrosspub.com.

Final 
Thoughts on 
Consolidated 
Schedules

Additional 
Practice
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Project Options for  311
on recurring tasks  336
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rules for happy life with Project 2013  343–345
on summary tasks  335
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Info section, Advanced Properties  550
Open command  58
page setup settings  510, 549
Print command  63
print preview  548
project options  133
Save & Send command  553
spell checker options  551

backward scheduling  96, 247, 364
constraints causing negative slack  367
No Later Than constraints under  251
setting constraints by entering start and finish 

dates  259
Bar Styles dialog  246, 546

formatting task bar in Gantt Chart view  558
for Resource Graph  542

Base Calendar field  275, 281, 284
base calendars  106

creating  283
resource calendars and  282

Baseline Cost field  585
Baseline Cost Report  534
baseline schedule

baselining consolidated (master) schedule  663
changing in Project 2013  459–461
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comparing to schedule in completed project  
605

evaluating for completed project  637
fields  455
interim plans  457
maintaining  458
performance measurement baseline updating  

593
saving additional baselines  456
selecting for earned value calculation  586
setting first baseline  454
tracking progress against  79
using for analysis of slippages  464
viewing  453

Baseline Start date  591
Baseline table  517
Baseline Work field  160, 486

displaying in Resource Usage view  487
Baseline Work Report  534
BCWP (budgeted cost of work performed)  576. 

See earned value
BCWP field  587
BCWS (budgeted cost of work scheduled)  576. 

See planned value
BCWS field  586
benchmarking  32
best practices checklists  617. See also entries under 

topics throughout
blank project, creating  94
Box Styles (Network Diagram)  221
budget at completion (BAC)  585, 588
Budget Cost field  333, 334
budgeted cosst of work performed (BCWP). 

See earned value
budgeted cost of work performed (BCWP)  576
budgeted cost of work scheduled (BCWS)  576. 

See planned value
Budget field  276
budget resources

budget costs for  332–334
defined  272
entering  281

Budget Work field  333, 334

comparing to Work field  282
buffers  392

defending visible buffers  174
defined  169
eliminating hidden time buffers  170
methods used for hiding  170–173
reasons for making them visible  173
using simulation to determine  389

Burndown dashboard  504
business days  106

conversion to calendar days  180
elapsed duration tasks and  375
estimates entered in Duration fields  176
estimating in example project  180
standard working days and hours  109
task duration expressed in  176

Busy Mode  147

C
Calculate project after each edit option  105
calculation options for optimizing  360
calculations, leveling  407
calendar days  177

conversion of business days to  180
elapsed duration in  375
estimating number of  180

calendar exceptions  106
changing in resource calendar to enter overtime  

294
entering for resource calendars  287
one-time  112–114
recurring  113

Calendar options, Hours per Day  105
calendars

Base and Resource Calendars  282
conflict between  261
order of precedence  261
for resources  275, 281
setting Project Calendar  106
task  178, 262
task and resource  106

Calendar view
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moving task bars  74
to-do lists in  544

capital cost expenditures  298
Cash Flow Report  534
cells

copying between projects  197
copying, moving, or clearing  195

changes
help with, Smart Tags  91
highlighting  446

Change Working Time command, Project tab  169
Change Working Time dialog  106, 112

creating a base calendar  283
creating new Task Calendar  262
editing resource calendars  285
entering alternate work week with specific work-

ing hours  111
entering new task working days or times  263
entering one-time and recurring calendar excep-

tions  112–114
entering resource calendar exceptions  287
entering task exceptions  263
entering working days and hours for resource 

calendar  285
Exceptions and Work Weeks tabs  108
specifying normal business work week in Stan-

dard calendar  109
temporary availability of resource  289
varying availability of resource  291

Check All the Scheduling Constraints  259
checklists for best practices  617. See also entries 

under topics throughout
checkpoints  212
Choose Profile dialog  553
chronological breakdown in WBS  122
clearing data

from cells  195
clearing leveling values before leveling  407
from rows  196

Clear Leveling dialog  411
client reporting periods, synchronizing schedule 

updates with  462
closing

files  60
projects  35

Code field  276
Code mask  146, 649
codes (WBS)

customizable, categorizing tasks and resources  
514

defining  648
collaboration, improvements in  2
Collapse Boxes button (Network Diagram)  224
columns

adjusting width of  556
copying  196
locking first column of a table  149
moving  196
positioning pane divider on column split  556

combination of situations, task updates in  480
combination views  85, 511

creating  86
Gantt Chart and Task Form  324
Gantt Chart/Relationship Diagram view  220
switching back to single view  87

commands
adding to custom groups on Ribbon  56

Comments field (Properties dialog)  96
common language for project management  32
common processes in project management  32
communications

features in Project 2013  500
project communication management  498

Compare Projects feature  645
Compare Project Versions dialog  607
competing demands  356
completed tasks  476

finished late or early  479
complete leveling  409, 413
compressed workweeks  292
conflicts  248

between calendars  261
consolidated resources  294

decimals in Max Units and Units fields  270
consolidated schedules

analyzing critical path by gate  659
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baselining  663
checks before consolidating  644
creating central resource pool  660–663
creating with automatic file linking  646
cross-project dependencies  651–659
defined  641
important considerations with  665
inserting new tasks  647
inserting subprojects  648
modifying WBS to consolidate projects  648
options and settings  645
read-write or read-only access to  647
reasons for consolidating  643
situations for using  642
working with  650

Constraint Date field  256, 257, 517
Constraint Dates table  259
constraints  247–261

added by dynamic links  237
causing fragmented critical path  374
changing to shorten  critical path  383
checking all  259
checks on  264, 628
Constraints table  517
defined  244
entering  256
implied predecessor and  229
limitations on  260
for manual scheduling of tasks  204
on milestones  253–255
Must Start On  245
negative slack and  367
no earler than  250
no later than  251
one-sided (semi-flexible)  250
on recurring detail tasks  191
removing  260
on resources  327
rigid (inflexible)  252
scheduling conflicts and  248
scheduling regimes  247
setting by dragging task bars horizontally  258

setting by entering dates  259
setting Project Option for  256
setting using task fields  257
setting using Task Information dialog  257
situations for use  252
Start No Earlier Than  213
tendencies (flexible) constraints  249
types of  249

Constraint Type field  256, 257, 517
consumption rate

for faciility and machine costs  301
for materials  297

contingency reserves  392
continuous improvement in project management  32
contracts, time buffers and  170
control accounts  580

defined at middle level of WBS  596
controlling. See monitoring and controlling
Control Panel (Windows), setting date order  103
copying and moving data

clearing cells  195
copying a column  196
copying between projects  196
copying cells  195
copying entire project  198
copying or moving a row  196
copying reports between projects  529
copying views between projects  529
copying with Fill Down  193
copying with Fill Handle  194
moving a column  196
moving cells  195
moving deadline dates  246
Paste Special and Paste Link commands  236, 

238
clearing rows  196
speeding up entry of estimates  192
tasks  149–151

copyright, tools and checklists  617
Cost1 - Cost10 fields  513
Cost Budget Resources  282
Cost field  328
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calculation of total cost for a task by Project  331
displaying in Task Usage view  491

Cost = Fixed Cost + All task related costs  331
Cost Overbudget filter  520
Cost Overview dashboard  505
cost performance index at completion (CPIAC)  

578
cost performance index (CPI)  577

to complete performance index (TCPI)  577
cost resources  81, 273, 281

defined  272
entering values for cost budget resources  333
facility and machine resource costs  300
human resource costs  298
material costs  299
overview of types of costs  295–298
representing fixed costs on tasks  330
setting costs on an assignment  330
varying cost rates  301

costs
Baseline Cost Report  534
checking  304
creating budget and managing expenses  357
EVM and cost estimates for tasks  580
managing  328–335
mixture of tasks with and without, EVM and  

594
modeling  304
no cost management, EVM and  593
opptimizing for time and cost  393–397
optimizing, checks on  444, 632
optimizing for  359
overview of different types  295–298
projecting final cost, benefits of dynamic sched-

ule for  206
reporting category  503
simulating  396
task-related cost fields  297
updating  489–491

Cost table  516
Cost/Use field  275, 281, 295, 297, 330

material costs  299
cost variance (CV)  576

cost variance percentage (CV%)  576
CP. See critical path
crashing  379, 387
Create New Base Calendar dialog  262, 283
Critical field  522
Critical filter  520
critical path  366

analyzing by gate  659
calculating multiple paths  360
complete network of dependencies and  230
deadlines and  246
dynamic links and  237
effects of leveling on  419
finding, challenges to  363
finding, summary dependencies and  225
fragmented, causes of  373–378
impact of deadlines  245
or resource-critical path  358, 420
shortening  379–388
showing or highlighting in Gantt Chart views  

370–372
critical path method (CPM)  359, 361

assumptions of  392
calculations performed by Project  369
fields in Schedule table  517
overview of  362
resource dependencies and  377

critical resources
revealed by RCP  430

critical tasks
changing threshold for  373
deleting to shorten critical path  388
display in Network Diagram view  78
threshold for marking task critical  360

cross-project dependencies  651–659
dos and don’ts for cross-project links  657–659
Links Between Projects dialog  655
maintaining cross-project links  654

Cross Project Linking options  651
cross-project links. See also cross-project dependen-

cies
.cub files  538
Currency option  104
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Custom Fields dialog
Text fields, managing formulas and formats  588

Custom reporting categories  503
CV (cost variance)  576
CV% (cost variance percentage)  576

D
Dashboards  503–506
databases

Project 2013 as relational database application  
53

saving OLAP database  538
transactional or storing static data  530

data in project files  52
data mining from static databases  530
data type

selecting for Visual Reports  537
Date1 - Date10 fields  513
Date Range filter  520
dates. See also constraints; deadlines

asking for start and finish date estimates  162
changing start date on existing project file used 

for new project  95
checklist for troubleshooting in Project 2013 

schedules  638
choosing default format for  546
Date column in Links Between Projects dialog  

655
entering to set constraints  256
estimating, questions to determine accuracy  

168
hard or fixed, minimizing in dynamic scheduling  

203
setting date order  103

days as costs  594
Days per month option  104
Deadline field  246
deadlines  368

causing fragmented critical path  375
checks on  264, 627
defined  244
display of  245
entering  245

impact on critical path  245
managing  246
using with No Later Than constraints  251

Deadlines or Constraints not met filter (IIL)  445
decimals in Max Units and Units fields  270
decision point dependencies  212
decision points  212

milestones  254
decomposition of deliverables into smaller parts  119
Default dialog box  110
Default Task Type setting  133, 182
Define New View dialog  527
delaying

leveling delay on task or predecessors  638
delegating work, using schedules  41
deleting

all dependencies for a task  217
assignments  321, 326
chain of dependencies between tasks  216
constraints  260
deadlines  246
dependency in Gantt Chart  218
dependency in Network Diagram  222
tasks  148, 388

deliverables
best practices checklist  623
breaking down into smaller parts  119
defined  119, 122
focus during WBS development  119–122
in Gantt Chart view  75
handling in a good WBS  131
naming and describing  125
reducing scope by deleting deliverables  388

deliveries, as milestones  254
dependencies  201–242

absolute lead or lag time  208
adding logical dependencies to level workloads  

377
changing from sequential to partial  380
checks on  227, 625–627
checks on completeness of network  230
choosing right type of  210
cross-project  651–659
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cutting soft dependencies for time savings  381
decision point  212
defined  205
different applications of  212
dynamic links  236–239
entering dependency logic  214
entering in Gantt Chart view  215–220
entering in Network Diagram view  221
exceptions to complete network rule  233
external  213
hard and soft  212
importance of complete network  230
importance to dynamic scheduling  202
inactivating tasks and  462
and level of detail in WBS  127
limitations on  235
and manually scheduled tasks  226
multiple predecessors and sucessors  209
preserving when copying tasks  150
preserving when moving tasks  151
reasons for using  205
recurring detail tasks and  191
relative lead or lag time  209
resource  214
setting on summary tasks  225
showing in Gantt Chart or Tracking Gantt  546
simplicity level of network logic  233
Task Path feature and  234
types of  207

Design tab, Page Setup group  552
detail, level of, in WBS  127
Details dialog box  110

calendar exceptions in  112
changing default normal working time  111
entering working times for alternate work weeks  

112
Detail Styles dialog  334, 486

preparing Task Usage view for updating costs  
490

selecting fields to show in usage views  547
detail task bar  189
detail tasks. See also tasks

applying filter to  519
defined  136
display in Network Diagram view  78
duration of, 1%-10% rule  129
entering  140
filter for tasks without predecessors  231
filter for tasks with SS or FF dependencies  232
in Gantt Chart view  76
indenting series of tasks in WBS  143
not having finish linked to any other task  231
recurring, assignments to  337
recurring, constraints on  191
types of  312

Developer tab, Record Macro  564
dialog boxes

navigating  70
dictionary (WBS)  126
direct relationship, linking tasks with  233
discounts for volume purchases  298
discretionary dependencies  213
Display options for this project  183
Display tab (Project Options)  104
domino effects, potential, revealed by RCP  430
Don’t tell me about this again (in Planning Wizard)  

90
Do-or-die dates  254
Download Resource Center  vi
drag and drop

Allow cell drag and drop option  183
disabling  192
dragging deadline arrow in timescale  246
dragging task bars to set constraints  258
dragging to indent and outdent tasks  143
in Network Diagram view  221
task bars in Gantt Chart view  217

drawing
drawing objects in views  526
using Drawing dropdown list  511

driving forces for projects, time buffers and  170
driving predecessors  235, 422

troubleshooting dates and  638
Duration1 - Duration10 fields  513
Duration field
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elapsed duration in  178
entering estimate into  176
inserting into Gantt Chart for entering estimates  

184
for milestones  141
time units used in  182

durations
Actual Duration + Remaining Duration = Dura-

tion  464
assignment, entered in days  311
changing for Fixed Work tasks  349
checking current total project duration  380
considerations for tasks  129–131
current, keeping when changing Hours per Day  

105
days as costs in EVM  594
decreasing estimates for  386
estimated  183
fixed work tasks  186
forecasted project duration  578
milestones  192
% Duration Complete  584
percentage lag on predecessor tasks  236
recalculation triggered by resource assignment to 

Fixed Work tasks  315
short, fixed formula for measureing task progress  

581
sorting tasks by  378
task type impact on  347
in time optimization techniques  361
updating tasks with  470–472
work effort versus  175

Duration * Units = Work (D*U=W)  178, 313
not applicable to task with multiple, uneven as-

signments  338
recalculations triggered by task updates  474
rule for happy life with  344
tasks it doesn’t apply to  343

dynamic links  236–239
with hammock tasks  239
with overhead tasks  238

dynamic models
advantages of  43

attributes of project model  616
dynamic scheduling

benefits and uses of  41–46
benefits for forecasting  206
importance of dependencies  202

E
EAC (estimate at completion)  577
EACt (time estimate at completion)  578

EACt field calculation  591
Early Start (ES) and Early Finish (EF) dates  364
earned value (EV)  576

BCWP field  587
calculating  587

earned value management (EVM)  573–602
applying  579–585
basic values for progress measurement  576–

578
best practices checklist  636
conclusions and recommendations on  598
forecasts  577
key elements, graphically displayed  579
managing basic elements of  586–589
overview  574–585
performance measurement baseline updating  

593
quality thresholds and  592
special cases  593
use for tracking  42
variances, indices, and forecasts with Project 

2013  589–592
Earned Value Over Time Report  534
Earned Value Report  597
Earned Value table  517
editing data

dependencies  218
dependency in Network Diagram view  222

Edit Mode  147
effort. See also work; work effort

level of effort (LOE)  585
Effort Driven field

inserting into Gantt Chart for entering estimates  
184
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effort driven setting  133, 182, 312, 346
automatically turned on for Fixed Work tasks  

346
changing before changing an assignment  348
Project Options setting for assignments  311

elapsed days  177
elapsed duration  375
elapsed duration lag  208
electronic time sheets  483
e-mail message dialog  553
End in field Accrue At  581
End in tasks field Fixed Cost Accrual  581
enterprise project management (EPM). See 

also project management
components of  29
defined  28
process model  30, 31

Enterprise Resource Pool  276
Entire Project zoom  378
estimate at completion (EAC)  577
estimate to complete (ETC)  578
estimating

asking for start or finish dates  162
best practices checklist  624
checking estimates  198
choosing Project Options before entering esti-

mates  182
common problems in  159
copying and moving data to speed up estimate 

entry  192–198
decreasing duration estimates  386
defending visible buffers  174
difficulties of  158
duration and work effort  175
duration estimates for tasks in optimizing for 

time  361
eliminating hidden time buffers  170
entering activities with incomplete estimates  

175
entering duration estimate for Fixed Duration 

tasks  185
entering work estimate for Fixed Work tasks  

186

estimated durations in Project 2013  183
example project, repainting your home  179
factoring in unknowns  162
human tendencies in  159
living document approach to  165
measuring planning and performance  169
methods used to hide buffers  170–173
performed by people not doing the work  161
preparing Gantt Chart for entering estimates  

184
process of  180, 312
and Project formula Duration * Units = Work  

178
pure work time or gross work time  166–169
reasons for making buffers visible  173
unknown events, rolling wave approach  162
unknown experience and skill levels  164
unknown learning curves  164
unknown resources  163

EV. See earned value
evaluating completed projects  603–614

checklist for best practices  637
comparing two versions of one project schedule  

607–609
creating templates from lessons learned  610
project results and benefits  605
questions to ask  609
reasons to evaluate  604

EVM. See earned value management
Excel

creating new project schedule from  94
Earned Value Over Time Report  597
mapping of fields in files imported from  152
printing and/or saving Visual Reports in  534
viewing only Excel reports  531
Visual Reports  533

Exceptions tab (Change Working Time dialog)  108
executing

defined  35
EVM checklist for best practices  637
recommendations for EVM  599

executives and upper management
estimates from  161

J. Ross Publishing; All Rights Reserved



Index

677

maturity in project management  170
Expected Duration, calculating  361
experience and skill levels, unknown  164
exporting

and synchronizing Project tasks to SharePoint  
153

tasks using SharePoint 2013  152
external dependencies  213

constraints with  253
external predecessors and successors  654

accepting or deleting  654
external predecessors  376
Show External Predecessor/Successor  654

external subprojects  644

F
facilities  81, 271

cost accrual  297
entering costs for  300
leveling facility resources  406
time-related costs entered as material costs  299
variables costs of  295

fast-tracking  379
changing from sequential to partial dependen-

cies  380
considerations when applying  382
creating parallel paths  381
critical path versus the RCP  435
smarter, facilitated by RCP  431

FF (Finish-to-Finish) dependencies  207
check on proper linking of  231

fields
baseline  455
customizing  512
defining for views  510
editing for multiple tasks  192
for EVM variances, indices, and forecasts  

589–592
Field Settings dialog  515, 556
filtering on  521
help with  90
inserting into Gantt Chart Entry table for esti-

mates  184

mapping when importing non-default files  152
picking for Visual Reports  537
restrictions on inserting/displaying in views  

310
selecting for timescale of Task Usage and Re-

source Usage  547
fields (assignment-related)

changing in Assignment Information dialog  339
Finish  309
Start  309
Units  270, 291, 296, 297, 309
Work  310

fields (resource-related)
Accrue At  275, 281, 296, 298, 581
Available from, Available to  291
Base Calendar  275, 281, 284
Budget  276
Code  276
Cost  328
Cost/Use  275, 281, 295, 299, 330
Generic  276
Group  274, 542
Inactive  276
Indicator  272
Initials  274
Material Label  273, 281, 299
Max Units  81, 270, 274, 288, 291, 309
Name  81, 273
Ovt.Rate  275, 281
Resource Name  272
Resource Names  315, 520
Std. Rate  274, 281, 298, 299
Type  81, 273, 280, 281
Work  310

fields (task-related)
Actual Duration  465
Actual Finish  480
Actual Start  465, 479
Actual Work  486
Baseline Cost  585
Baseline Work  486, 487
BCWS  586, 587
Constraint Date  256, 257, 517
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Constraint Type  256, 257, 517
copied to baseline fields  455
Critical  522
Deadline  246
Duration  176
Effort Driven  312
for EVM  589–592
Finish  259
Fixed Cost  297, 331
Fixed Cost Accrual  297, 331, 581
Ignore Resource Calendar  287
Inactive  388
Lag  208
Level Assignments  408
Leveling Delay  407, 410
Marked  423–425
Milestone Note  141
Name  486
Notes  128
% Work Complete  486
Remaining Duration  465
Remaining Work  486
Start  259
Summary  520
Task Calendar  264
Task Name  316
Total Slack  372
Type  105, 474
Work  177, 310, 486

files
backwards compatibility with previous Project 

versions  53
file types in Project 2013  52
importing in non-default formats  151
opening  58–60
sharing, using options in Backstage view  2

fill down feature  193
using to remove constraints  260

fill handle feature  194
Filter Definition dialog  521
filters

All Resources  543

applied by views  510
applying existing filter  519
AutoFilter  231
copying to Global.mpt file  618
designing new filter  521
detail tasks without successors  231
detail tasks with SS or FF  232
displaying all tasks with constraints  260
displaying all tasks with deadlines  246
filtering schedule by critical path  378
for detail tasks without predecessors  231
for summary tasks with dependencies  230
list of IIL filters  618–621
project with flags and filters  595
selecting for views  527
Tasks with missing baseline info filter  456

Finish1 - Finish10 fields  513
Finish dates. See Start and Finish dates
Finish No Earlier Than (FNET) constraints  249, 

250, 259
setting by entering finish date  256

Finish No Later Than (FNLT) constraints  249, 
250, 259

for do-or-die dates  254
example of  251
on project end date  255
setting by dragging task bars  256, 258
setting by entering dates  256

Finish-to-Start dependencies. See FS dependencies
Finish Variance field  591
fiscal year timescale, displaying with calendar year 

timescale  557
Fixed Cost Accrual field  297, 331, 581
Fixed Cost field  297, 516

entering costs  331
fixed costs  296

interpretation by Project of any amount entered 
in Cost field  332

updates in  490
Fixed Duration tasks  179, 288, 312

best uses for  342
changing Work value  349
as default task type  182

J. Ross Publishing; All Rights Reserved



Index

679

entering duration estimate for  185
recalculation triggered by assigning recources 

to  315
fixed formulas for assessing task progress  581

0/100  581
50/50  582

Fixed Units tasks  312
best uses of  343
default task type for assignments  311
setting for assignment updates  483, 488
setting for task updates  474
unit adjustments and  323

Fixed Work tasks  179, 312
best uses of  343
changing Assignment Units  349
changing Duration value  349
entering work estimate for  186
recalculation triggered by assigning recources 

to  315
setting for updating tasks  474

Flag1 - Flag20 fields  512, 513
flags, project with filters and  595
flexible constraints  249
float. See slack
FNET. See Finish No Earlier Than constraints
FNLT. See Finish No Later Than constraints
Font dialog  555
fonts

changing cell font color in macro  565
formatting in Text Styles dialog  555

forecasting  42
advantages of dynamic models for  43
benefits of dynamic scheduling for  206

forecasts
earned value management (EVM)  577
fields for  589
valid, provided by good schedule  616

Format Bar dialog  546
Format tab  55, 545

specialized tools for views  526
formatting. See also printing

Gantt Chart view for printing  555
Formula for ‘PV%’ dialog  589

formulas
entered in Number1-Number20 fields  513
Excel-like, entering into fields  512
fixed formula for assessing task progress  581
used in updating assignments  488

forward scheduling  96, 247, 364
constraints causing scheduling conflicts or nega-

tive slack  367
hard project start date  251
setting constraints by entering start and finish 

dates  259
fragmented critical path, causes of  373–378
free slack

calculating  366
displaying  372

FS. See free slack
FS (Finish-to-Start) dependencies  205, 207

creating chain of  216
creating using mouse to draw dependencies  217

full-time availability (resources)  292

G
Gantt Chart/Relationship Diagram combination 

view  220
Gantt Chart Styles menu  546
Gantt Chart view  75–77

combination with Task Form view  324, 337
creating improved Entry table for assignments  

313
critical path in  366
displaying more of table or timescale  76
displaying negative slack  368
entering dependencies  215–220
entering tasks  139
finding task bars  77
formatting and printing  555–561
making lag negative  380
preparing for entering estimates  184
printing with separate notes page  561
removing constraints in  260
rolling up detail task bars into summary task bars  

546
showing dependencies  546
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showing or highlighting critical path in  370
in Task Entry view  85
task bars  188
tasks planned with fixed formulas  582
using to identify the RCP  422
Work field  310

gates  212. See also milestones
analyzing critical path by  659

Generic field  276
generic resources  272

replacing with individuals  341
Global.mpt file

copying filters to  618
copying objects into  530

global options  103
graphical indicators  515
green weeks (compressed workweeks)  292
gross work time  166–169
group activities, constraints on  253
Group Definition dialog  524
Group dialog  543
Group field  274, 542
groups  522

applied by views  510
applying existing grouping  524
designing new  524
resource  541
selecting for views  527

H
hammock tasks  230

defined  238
dynamic links with  239
no need for links  233
no predecessor for  239

hard and soft dependencies  212
hardness of milestones  253
headers and footers for reports  543, 545

creating for Gantt Chart view  559
inserting project logo into  550
options for  549

help

with fields  90
making changes, with Smart Tags  91
online  89
Project Help task pane  88–90
scheduling, with Planning Wizard  90
with tasks, Task Inspector  92

hierarchical WBS  119. See also outline structure
indenting series of detail tasks  143

highlighting  519
changes  446
Highlight filter option  527
Highlight tool  370
Task Paths  234

holidays  106. See also calendar exceptions
creating and setting for several years  114

Hours per Day setting  104, 109, 295
and working hours set in resource calendar  292
versus working time  109

Hours per Week setting  104, 109
and working hours set in resource calendar  292

human resources  81, 271
cost accrual for  297
downloading from Outlook address book  277
entering costs for  298

human tendencies in estimating  159

I
ID field

in Gantt Chart Entry table for estimates  184
leveling tasks based on  417

Ignore Resource Calendar field  287
IIL (International Institute for Learning)

filters  230, 618–621
Project 2013 Belt curriculum  640
Project 2013 Tools.mpp file  568
RCP macro  426
tools and checklist copyright  617

importing
Outlook contacts into Project  277
tasks  151–154

Import SharePoint Tasks List dialog  153
Import Wizard  151
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Inactivate button  461
Inactive field  276, 388
inactive tasks  426, 461

earned value calculations wiht  593
indented list format for WBS  123
indenting and outdenting tasks

by dragging  143
indenting series of detail tasks  143

Indicator field  272
Indicators column (Gantt Chart)  75

hard and soft constraint indicators  252
indicator for unresolved conflict between calen-

dars  261
indices (EVM)  577

fields for  589
indirect relationships among tasks  233
inflexible constraints  249, 252
Info area (Backstage view)  61
initiating

defined  35
In Progress report category  503
Inserted Project Information dialog  651
Insert Milestone Task command  137
Insert Page Break command  552
Insert Picture dialog  550
Insert Summary Task command  140
interface (Project 2013). See user interface
interim plans  459

fields for saving information  513
internal subprojects  644
iterative processes  122

K
keyboard shortcuts

dialog box navigation  70
editng tasks in WBS  147
establishing for a table  518

keying in resources  279–282

L
labor costs  295
Late Finish (LF) and Late Start (LS) dates  364

Late Tasks filter  520
Layout dialog box  546

in Network Diagram view  223
lead or lag time

absolute  208
entering in Task Dependency dialog  218
entering in Task Details form  220
entering using Task Information dialog  219
Lag field  208
negative lag to change sequential to partial de-

pendencies  380
percentage lags  236
relative  209
shortening lags  384

learning curves  164
Legacy Formats, Trust Center dialog  151
legends. See also headers and footers for reports

creating for Gantt Chart view  559
wrong data problem  562

Length, defining for WBS Code  146
lessons learned, capturing  637
Level Assignments field  337, 408
Leveling Delay field  407, 410
Leveling Gantt view

combination with Resource Usage view  402
in Resource Allocation view  86
reviewing results of leveling features  410

Leveling Options  407
Leveling order list drop-down  417

leveling range option  407
leveling workloads  358, 406–420

causing fragmented critical path  377
comparing scenarios in a Gantt Chart  414–416
creating split tasks  386
effects on critical path  419
excluding resources from automatic  418
excluding tasks from automatic  417
manually resolving workloads  400–402
manual vs. automatic  418
in optimizing time, cost, and resources  398
within slack  409, 411
steps to doing your own leveling  402

level of effort (LOE)  585
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Level Resource dialog  418
levels, revealing for tasks  144
LF (Late Finish) and LS (Late Start) dates  364
Link button, setting dependencies with  222
Link Labels option  221
links. See also dependencies

consolidating schedules with linking of files  646
cross-project  651–659
Cross Project Linking options  651
dynamic  236
tasks not needing  233

Links Between Projects dialog  655
Link Tasks command  216
link tool  216
living document approach  165
locking first column of a table  149
LOE (level of effort)  585
logic

checking for dependencies in Network Diagram  
223

dependency logic on summary tasks  225
logical dependencies  212

adding to level workloads  377
handling by algorithm to find RCP  433

long-duration tasks, overhead tasks entered as  237
Lookup table  514
Lync 2010  288

M
machines  81, 271

cost accrual for  297
entering costs for  300
leveling machine resources  406

macros  563–569
creating by writing VBA code  565
creating using Record Macro menu option  564
defined  563
RCP  426–429
RCP macro  618

main screen  66
Status Bar  147
View Bar  68

Manager field (Properties dialog)  96
manually scheduled tasks  138

Auto vs  524
changing, CPM calculations not updated  369
choosing between automatic scheduling and  

203
creating unscheduled tasks  175
dependencies and  226
earned value calculations with  593
Manually Scheduled Tasks filter  520
minimizing number in dynamic scheduling  203
status comment as placeholder  500
updating  482

Manual Task Warning dialog  482
mapping  152
Marked field  423–425
Mark On Track icon  475
Mark task as milestone (Task Information dialog)  

142
master project

setting cross-project dependencies in  652–660
with two subprojects, using for EVM  595

Master Project Schedule. See also consolidated 
schedules

Material Label field  273, 281, 299
materials  81, 271, 273

budget resources  282
consumption rate  297
cost accrual  297
entering material costs  299, 329
entering values for material budget resources  

333
exclusion from leveling  407
facilities  271
Material Budget Resources  282
material rate and material label  280

maximum units (Max Units) of a resource  288
assignments using Assign Resources dialog  323
consolidated resources  295

Max Units field  270, 274, 288, 291, 309
overtime in  294
in Resource Sheet view  81

.mdb files  538
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merge bias  391, 392
MFO. See Must Finish On constraints
Microsoft Project Plan files. See .mpp files
Microsoft Project Professional 2013  51
Microsoft Project Template (.mpt) files  52
Microsoft SharePoint Server 2013  51
Microsoft Windows Server 2012  51
Milestone Note field  141
milestones

constraints on  253
defined  136
display in Network Diagram view  78
durations  192
entering  141
for external dependencies  213
major, analyzing critical path by  659
milestone diamond task bar  189
Milestones filter  520
naming  126
reporting on  539
types of  253–255
weighted  583

Milestones Report  540
Mini-Toolbar

Indent and Outdent icons  141
mix of internal and external subprojects  644
modeling

resource availability  303
static chart vs. dynamic model  42

Modify Location dialog  532
monitoring and controlling

control enabled by right level of detail in WBS 
and reporting  131

defined  35
EVM checklist for best practices  637
recommendations for EVM  599

Monte Carlo simulation  160, 362, 389–392
defined  390
output  390
reasons for using  391

More Filters dialog  247, 260, 521
More Groups dialog  524
More Tables dialog  259, 517

More Views dialog  415, 527
changing top view in combination views  86

most likely estimates  160
mouse

pointer, changing to double-headed arrow  87
right- or double-clicks  68
using to draw dependencies  217
using to set dependencies in Network Diagram  

221
Move Project dialog  95
moving data. See copying and moving data
.mpp (Microsoft Project Plan) files  52. See 

also project files
saving in OneDrive  101

.mpt (Microsoft Project Template) files  52
MSO. See Must Start On constraints
Multiple Baselines Gantt view  415
Multiple Task Information dialog  192, 474

removing constraints  260
uses of  193

multiple, uneven assignments  337
Must Finish On (MFO) constraints  252

on project end date  255
Must Start On (MSO) constraints  245

splitting task bars around MSO tasks  385

N
Name field  81, 273
naming

conventions  303
deliverables  125
tasks and milestones  126

negative lag  208, 380
negative slack  366

constraints and  367
displaying line in timescale for, in Gantt Chart  

368
Network Diagram view  77

editing or deleting a dependency  222
entering dependencies  221
gaining overview of the network  224
using to display the schedule  223
using to enter tasks  139
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network of dependencies. See also dependencies
appropriately simple network logic  233
checks on completeness of  230
example of typical network  229
exceptions to rule of complete network  233
importance of completeness  230

Next Over-allocation tool  403, 444
Night Shift calendar  106
No Earlier Than constraints  250
No Later Than constraints  251
no leveling  409
non effort-driven tasks  493
nonworking time  286
notes

including in reports  561
printing view with separate notes page  561

Notes field
documenting soft or discretionary dependencies  

213
for tasks  128

Number1 - Number20 fields  512, 513

O
objectives, identifying  37
objects

copying between projects  197
in project files  52

Office 365  51
backstage and  57
places, adding  60
Sync with SharePoint Task List feature  152

Office 2013  51
checking spelling in  551

OLAP (On-line Analytical Processing) cubes  530
saving  538

OneDrive
backstage and  57
places, adding  60
saving in  101
saving templates to  610

1% – 10% rule  129, 199
using with rolling wave planning  163

one-sided constraints  249–252
one-time calendar exceptions  112
one-to-many relationships of data  54
online templates  94
optimistic estimates  160
optimistic (O), most likely (ML) and pessimistic (P) 

estimates in PERT  361
optimizing  355–450

approaches to optimizing schedules  359
causes of fragmented critical path  373–378
checking impact in Project Statistics dialog  389
checks on optimized schedules  444–447
considering impacts of optimizing fot time, cost, 

and resources  442
considering impacts on other project dimensions  

358, 388
displaying total slack  372
for time, cost, and resources  397–444
identifying tasks with potential time savings  

378
impacts of time optimizing on quality, scope, and 

risk  388
methods to optimize for time, cost, and resourc-

es  434
noting tasks with soft dependencies  213
Project Options for  360
review questions on  448
schedule compression, shortening critical path  

379–388
schedules, checks on  632
showing or highlighting the critical path  

370–372
simulation of resource-critical path  443
steps in optimizing for time  369
techniques used in optimizing time  361–369
for time and cost  393–397
for time, cost, and resources  397
tools to assist in analyzing impact of changes  

446
using Monte Carlo simulation  389–392

options. See also Project Options; Project Options 
dialog

setting Project Options  102
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organizational project management (OPM)  28
organization chart format

not applicable to WBS  132
use for WBS  123

Organizer  197, 511, 529
copying filters to Global.mpt file  618

orientation (page setup)  549
outdenting tasks in WBS  143
Outline Code1 – Outline Code10 fields  514
Outline Code, Task Name field  145
Outline Level, revealing  144
Outline Number (tasks)  145
outline structure  524

inserting supbrojects, in consolidated schedules  
648

Keep outline structure option for views  528
Outlook

downloading resources from address book  
276–278

importing files from  152
out-of-sequence task updates  481
Overallocated Resources filter  520
over-allocations

caused by assignment of summary task and its 
detal task  335

granularity setting for  403
options for resolving  407
resulting from assigning to recurring detail tasks  

337
standards for resources  310

overhead tasks  230
defined  237
dynamic links with  238
entering  237
no need for links  233

overlapping activities. See fast-tracking
overlapping resources, checking  303
overtime  294

Ovt. Rate field  275, 281, 329

P
padding schedules  392
page breaks

inserting  552
removing  552
visualizing  552
wrong page break in printout  562

Page Setup dialog
creating header, footer, or legend  559
printing view with separate notes page  562

page setup settings  510, 549
creating header and footer for report  543
Fit timescale to end of page  553
important options for views  550
inserting project logo into header or footer  550

pane divider on column split  556
parallel paths  381

finding effect of, using simulation  391
partial dependencies

changing sequential dependencies to  380
part-time availability (resources)  291
Paste Special and Paste Link commands  236, 238
path convergence  391, 392
PDF files

exporting schedules as  553
Peak units  347, 542

shown in Resource Graph  399
task type impact on  347

percentage lags  236
percentages

assignment units as  311
basic EVM elements in  588
% Complete  464, 476
in Max Units and Units fields  270, 309
% Work Complete  486
selecting %Complete and %Physical Complete 

for project  587
performance. See also earned value measurement 

(EVM)
measuring planning and performance  169
one-page reports on  539
performance measurement baseline updating  

593
performance measurement baseline (PMB)  575, 

585
personal activities during working time  167
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personal information, removing from existing project 
files  95

person days
entering estimates into Work field  177
in example project estimate  180

person hours  177
entering as work for fixed duration task  185

PERT (program evaluation and review technique)  
160, 361

pessimistic estimates  160
phases, WBS organized by  121
physical progress

% Physical Complete  585
pictures

copying and pasting views as, to Office programs  
500

Insert Picture dialog  550
PIT (Project Initiation Team) estimating teams  161
PivotCharts  532
PivotDiagrams  532
PivotTables

display of data for reports  535
properties of  535
viewing or changing data in Excel Visual Reports  

533
places, adding  60
planned value (PV)  576

calculation  586
planning

defined  35
description of  36
earned value management (EVM) and  579
earned value measurement techniques  581
EVM checklist for best practices  636
identifying scope, objectives, and requirements  

37
living document approach to  165
measuring planning and performance  169
recommendations for EVM  599
strategic planning for project management  31
processes, listed  118
using Autolink option during  206

Planning Wizard  90

Advice from Planning Wizard option  105
prompts when dragging task bars to set con-

straints  258
schedule conflict messages  248
turning off schedule conflict notifications  249
using for dependency entry in Gantt Chart  215

PMBOK® Guide – Fifth Edition  5
PMB (performance measurement baseline)  575, 

585
PMI (Project Management Institute)

Practice Standard for Earned Value Management  
581

Portable Document Format. See PDF files
portfolio management  29
positive lag  380
positive slack  365
predecessor and successor tasks  205

assigning multiple predecessors to a task  219
checking for detail tasks with SS or FF depen-

dencies  232
checking for missing predecessor  229
detail tasks without successors  231
external predecessors  376
filter for detail tasks without predecessors  231
hammock tasks and  239
multiple  209
percentage lag on predecessor tasks  236
predecessors  638
setting muliple, using Task Details form  219
showing external  654

predecessors  234
troubleshooting dates and  638

predictive power of dynamic models  43
prefix for tasks, Project Code Prefix  146
Presentation Styles  546
Print Backstage view  510. See also page setup set-

tings
Print command (Backstage)  63
printing  548–554

changing printer options  548
common printing problems and fixes  562
formatting and printing Gantt Chart view  

555–561
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formatting and printing reports  545–553
general considerations for reports  548
including notes in reports  561–563
inserting manual page breaks  552
page setup settings  549
print preview in Backstage view  548
shortening or stretching timescale  553

processes
common processes in project management  32
managing and controlling in project manage-

ment  35
product scope  357
program, defined  643
program evaluation and review technique. See PERT
progress

earned value measurement techniques  581
expressing mathematically  464
measuring, key values for  576
showing in Tracking Gantt view  463
tracking  79

Project 2013
assignment units remaining the same for existing 

assignments  345
benefits for project management  33
editions of  51
hanging up in editing process  147
help in managing the schedule  357
interface. See user interface
PERT analysis in  361
rules for happy life when entering/changing as-

signments  343–346
setting up new project schedule  93–116
spell-checker options  551
working with files  52
working with schedules from standalone mode  

53
Project 2013 Belt curriculum (IIL)  640
Project Calendar

base for Resource Calendar  282
Calender view vs.  72
changing working times for everybody  169
functions of  108
one-time and recurring exceptions  112–114

setting  106–109
Project Code Prefix  146
project communications management  498
project end date  255
project files

closing  60
converting  100
creating, options for  94
exporting  64
moving around in  69
new, creating from existing files  95
new, creating from existing projects  94
printing  63
regular (.mpp) and template (.mpt)  52
setting up, checks on best practices  114
sharing  64, 100–102
synching with SharePoint  100–102

Project Information dialog  95
checking for forward or backward scheduling  

247
Statistics  389

Project Initiation Team (PIT) estimating teams  161
project management maturity model (PMMM)  31

levels of  32
project management (PM)

accounting for project manager’s time and cost  
238

benefits of using Project 2013  33
importance of WBS  132
knowing project status at all times  131
managing individual projects  33
maturity of upper management in  170
planning process  36–39
process groups involved in  35
schedule as dynamic model or static chart  42
steps or phases in  16
strategic planning for  31

Project Online  51
Project Options

actual costs calculated by project  587
affecting manual or auto scheduling behavior  

204
for assignment updates  484
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for assignments  311
Autolink inserteed or move tasks  150
Auto Scheduled tasks  203
Baseline for Earned Value calculation  586
choosing before entering estimates  182
for consolidated schedules  645
cross-project linking  654
Hours per Day option versus working time  109
inserting page breaks  552
Project View, Date Format list  546
recommended for setting dependencies  206
for reporting  498
selecting %Complete and %Physical Complete  

587
setting before entering constraints  256
setting before entering tasks  133
setting for new project  104–107
setting options for assignment cost updates  490
settings for optimizing  360
setting when adding resources  269
Split in-progress tasks option  481
Trust Center  151
updating task status updates resource status  465

Project Options dialog  102
customizing the Ribbon  55
Screen Tip Style settings  90

Project Overview dashboard  504
projects

background information about  622
demands of  33
setting up, checks on best practices  622
small, importance of  28

Project Server 2013  33, 51
collaboration and communication tools  501
qualitative risk analysis  358
syncing tasks with SharePoint 2013  153

project-specific options  103
Project Start Date (Project Information dialog)  96
Project Statistics dialog  389
Project Statistics summary  632
project summary task  134

assigning budget resources to  332

displaying  139, 360
viewing Duration field  199

Project Web App (PWA)  51
time sheet system  483

prompts for user to enter a value (filters)  522
Properties dialog  96
prorated costs  296
pulling forces for projects  356

time buffers and  170
pure work time  166–169
PV (planned value)  586

Q
quality

evaluating impact of time optimizing on  389
EVM and quality thresholds  592

question mark (?), in estimated durations  183
Quick Access Toolbar  57

adding insert page breaks  552
adding Project Statistics icon  389

Quick View Switching and Zoom (Status Bar)  148

R
Range of recurrence  191
rate profiles  297, 302
rates

cost rates varying over time  297
creating average or blended billable hourly rate 

for resources  299
default standard rate  270
entering varying cost rates for resources  301
human resource costs  298
material costs  299
multiple cost rate tables per resource  297
overtime work  294
resource-related rate fields  296
updates in resource rates  490

RCP. See resource-critical path
RCP macro  426–429, 618
R/D field  324
Ready Mode  147
Record Macro option
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creating a macro  564
with VBA Editor  565

records, sorting in views  528
Recurrence Pattern  191
recurring calendar exceptions  113
recurring task bars  189
recurring tasks  190

assigning to  336
assignment to recurring summary tasks  336
detail tasks not needing links  233
overhead tasks as  237

references, creating for Gantt Chart view  560
relational database application, Project 2013 as  53
Relationship Diagram view

Gantt Chart/Relationship Diagram view  220
relative lag  380
relative lead or lag time  209
Remaining Duration

updating tasks with  470–472
Remaining Duration field  465
Remaining Work field  486
Rename Field dialog  588
rent expenses  295
renumbering tasks  528
Replace Resource dialog  322
replacing assigned resources  322, 326

generic resources, replacing with individuals  
341

without triggering recalculations  346
reporting  497–572

building a macro  563–569
categories of  502
checklist for best practices  635
checks on  569
choosing Project Options for  498
common printing problems and fixes  562
comparison of options  501
customized  507
examples of useful or hard-to-get-at reports  

541–545
formatting and printing Gantt Chart view  

555–561
formatting and printing reports  545–553

project communications management  498
sending a schedule to colleagues  553
synchronizing schedule updates with client 

reporting  462
use of right level of detail in WBS  131
using views to create reports  510–529
Visual Reports  530–539

reporting period, task duration and  129
reports

copying between projects  529
custom  503
including notes in  561
one-page performance  539
showing differences between schedule versions  

607–609
Report tab  502
requirements, identifying  37
Resource Allocation view  86

optimizing resources  402
resource baseline fields  456
Resource Calendars  106, 275, 282

adjusting for recurring special circumstance  293
editing  284
entering exceptions  287
entering overtime  294
entering working days and hours  285

Resource Comparison button  608
resource-critical path (RCP)  358, 420

advantages of RCP approach  429–432
benefits of using  429–431
finding, using automatic process  426–429
finding, using manual prcess  422–426
nature of  432–434
simulation of  443

resource-critical tasks
assigning best resources to  436

resource dependencies  214, 377
handling by algorithm to find RCP  433

Resource Form view  84
Resource Graph view  321

checking workloads  399
graph details in  547
workload histograms  541
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Resource group  524
Resource Information dialog

budget resources  282
changing working time  284
entering temporary availability of resource  289
entering varying availability of resource  291
overtiime availability  294

resource leveling. See leveling workloads
Resource Leveling dialog  410
Resource Name field  272, 315, 520
resource pool, creating  660–663
Resource Remaining Work Report  535
resources  18. See also assignments

adding (crashing)  387
analyzing during planning stage  39
assigning to tasks. See assignments
assignment to recurring tasks  192
availability of  167, 288–292
Base Calendars and Resource Calendars  282
checking availability before assigning to tasks  

320
checks on  302–304, 628–631
communicating with  288
consolidated  294
constraints on  327
costs, overview of  295–298
creating centralized resource pool  660–663
defined  268
downloading human resources from Outlook  

277–279
downloading using Active Directory  278
entering budget resources  281
entering cost resources  281
entering human resource costs  298
entering into Resource Sheet view  276
entering material costs  299
EVM and estimates of effort  580
excluding from automatic leveling  418
for fixed duration tasks  185
for fixed work tasks  186
generic  272
grouping  523, 524
keying in manually  279–282

managing for a task, using EVM  583
maximum units  288
naming conventions  273
optimizing for  358
optimizing for time, cost, and resources  359
options for entering  269
people responsible for activities  268
replacing assigned resources  322, 326
reporting category  503
in Resource Usage view  82
Resource Sheet view  272–276
review questions on  305
temporary availability of, constraints and  253
to-do list in Calendar view for  544
types of  270
unavailability of, causing fragmented critical path  

374
unknown,  in estimating  163
unlimited, optimizing under assumption of  359, 

392
updates in rates  490
when to add  269

Resource Sheet view
checking  302
entering variable costs for work resources  328
fields  272–276
Work field  310

Resource Usage view
changing assignment attributes  338
combination with Leveling Gantt view  402
configuring to update assignments  482
creating timesheets  485
replacing generic resources with individuals  341
in Resource Allocation view  86
selecting fields to display in timescale  547
Slipping Assignments filter  520

Resource Work Summary Report  534
Respect Links icon  204
responsibilities  268. See also assignments

responsibilities by department report  541
Responsibility Assignment Matrix (RAM) chart  

268
Ribbon
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displaying Developer tab on  564
Format tab  55
navigating views with View Bar or View tab  85
Project tab, Change Working Time dialog  106
Timescape dropdown  77

right- or double-clicks, mouse or touchpad  68
rigid constraints  249–253
risk  358

evaluating impact of time optimizing on  389
increasing with fast-tracking  382

rolling up task bars  546
rolling wave approach  162

creating unscheduled tasks for future activities  
175

implementing living document approach  166
long task durations in  378

rows
clearing  196
copying or moving a row  196

S
sales representatives, estimates from  161
Save & Send command

saving Visual Report to file  534
Send as Attachment  553

scaling option for printing  549
schedule conflicts  248

constraints causing negative slack  367
schedule constraints. See constraints
Scheduled Start and Finish date fields  457
schedule performance index (SPI)  577
schedules

comparing to baselines in completed project  
605

comparing two versions of one project schedule  
607

creating from project templates  97
displaying using Network Diagram view  223
producing valid forecasts  616
reliance of EVM on  580
setting up new project schedule  93
static chart vs. dynamic model  42
tools for checking  618

using to sell a new project  41
working with, from Project 2013 standalone  53

Schedule table  516
Schedule tab (Project Options dialog)

options for new project  104
otpions to set before entering estimates  182
setting options before entering tasks  133

schedule variance percentage (SV%)  576
schedule variance (SV)  576
scheduling

authors’ perspective on  8
help with Planning Wizard  90
options  104
questions providing basic information for  48

scheduling messages, showing  104
scheduling regimes  247

changing after entering tasks  247
Scheduling Styles  546
SCI. See schedule performance index
scope  357, 579

evaluating impacts of time optimizing on  388
EVM (earned value management) and  579
identifying  37
identifying in WBS  119
reducing  388
statement of, starting point for WBS  124

screens
main screen. See main screen

Screen Tip Style setting  90, 104
screen (views)  510
scroll bars in main screen  68
Select Resources dialog  277
Select users dialog  279
selling a project, using schedules  41
semi-flexible constraints  249, 250

using instead of rigid constraints  252
Separator, defining for WBS Code  146
Sequence, defining for WBS Code  146
Set Baseline dialog  459, 664
SF (Start-to-Finish) dependencies  205, 207
SharePoint 2013

creating new project schedule from task list  94
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exporting and synchronizing Project tasks to  
153

importing/exporting tasks using  152
Project Server and  501
qualitative risk analysis  358
saving or synching with  100–102
using to communicate with stakeholders  501

SharePoint Online  65, 152
Share Resources dialog  662
Shortcut menu

Copy and Paste  150
Cut and Paste  150

shortcut menus, popping up with right- or double-
clicks  68

Show External Predecessor and Show External Suc-
cessor  654, 658

Show Links Between Projects dialog  654
Show Project Summary Task option  135
Show scheduling messages option  104
simulation  362

of costs  396
Monte Carlo simulation  389–392
of resource-critical path (RCP)  443

single views  85
switching from compound view to  87

singular methodoloy in project management  32
Site URL list  153
Skype  289
slack  361

calculating free slack (FS)  366
calculating total slack (TS)  365
checks on tasks with too large amounts of total 

slack  232
constraints and negative slack  367
displaying negative slack in Gantt Chart view  

368
displaying total slack (TS)  372
dynamic links and  237
effects of contraints and deadlines on  374
leveling within  409, 411
produced by unavailability of resources  374
setting for marking critical tasks  360
total slack (TS) and free slack (FS)  365

sliding window handle  87, 325
slippages

desirability of, in some situations  374
Slipping Assignments filter  520
Slipping Tasks filter  520

Smart Tags  91
deleting tasks  148

SNET. See Start No Earlier Than constraints
SNLT. See Start No Later Than constraints
soft dependencies  213

cutting on critical tasks for time savings  381
sorting

options for groups  525
records in views  528
tasks by duration  378
in views  526

spelling, checking  551
SPIACt (ttme schedule performance index at 

completion)  579
SPI (schedule performance index)  577
Split in-progress tasks option  481
split task bars  189
split tasks  189
spreadsheet/table, using for assignments  315
SS (Start-to-Start) dependencies  207

check on proper linking of  231
stakeholders

WBS as important communication tool for  132
Standard calendar  106

specifying normal business work week  110
Start1 - Start10 fields  514
Start and Finish dates  309

asking for estimates on  162
benefits of dynamic schedule for predicing finish 

data  206
Early Start (ES) and Early Finish (EF) dates  

364
entering notes for unscheduled activities  175
entering to set constraints  256, 259
forward and backward scheduling from  96
Late Finish and Late Start dates  364

Start No Earlier Than (SNET) constraints  213, 
229, 249, 250, 259
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accidental  215
on milestone representing external dependency  

253
setting by dragging task bars horizontally  256, 

258
Start No Later Than (SNLT) constraints  249, 250, 

259
example of  251
setting by entering start date  256

Start screen, showing  104
Start-to-Finish dependencies. See SF dependencies
static charts vs. dynamic models  42
Status Bar  68, 147
status date

setting  492
Status group (tasks)  524
Status Items  147
status reports, importance of  131
Std. Rate field  274, 281, 298

cost per unit for materials  299
entering pay for work resources  329
material costs in  329

Stop Recording (Record Option in Developer 
Menu)  565

strategic planning for project management  31
strategies for updating the schedule  465
structure of WBS

importance of right structure  130
indented list or organization chart  123
rules for  131

subprojects. See also consolidated schedules
inserting on outline levels in consolidated sched-

ule  648
internal, external, and mixed  644
setting sub-schedules baseline  664

successors  235
driven  235

successor tasks. See predecessor and successor tasks
Summary field  520
Summary table  516
summary task bars  188
summary tasks  135

applying filter to  519

assignments on  335
checking for dependencies on  230
copying or moving  149
copying or moving summary family  151
display in Network Diagram view  78
entering  139
in Gantt Chart view  76
recurring  190
setting dependencies  225–227
Summary Tasks filter  520

supporting tasks. See hammock tasks
SV. See schedule variance (SV)
syncing tasks betwee Project 2013 and SharePoint 

2013  153
Sync to Tasks Lists options  153
Sync with SharePoint Task List feature  152

T
Table Definition dialog  486, 517
tables  510–518

defined  516
designing new table  517
locking first column  149
More Tables dialog  517
using existing tables  516

target dates  254
task bars  188

detail, rolling up into summary task bars  546
dragging horizontally to set constraints  256, 

258
dragging to link to another task in Gantt Chart 

view  217
finding for tasks in Gantt Chart  77
formatting in Gantt Chart  558–560
moving in Calendar view  74
splitting  385, 408
splitting around Must Start On tasks  385

Task Calendar field  264
Task Calendars  106, 178, 261–265

causing fragmented critical path  376
checking  628
checks on  264
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creating  262
situations for use  261
using  263
using instead of constraints  253

Task Dependency dialog  218
deleting a dependency  382
editing a dependency in Network Diagram  222
making lag negative  380
shortening lag times  384

Task Details form  219
making lag negative  381

Task Entry view  85
task fields. See also fields (task-related)
Task Form view

assigning with  324–326
multiple, uneven assignments on a task  337
in Task Entry view  85
Work field  310

Task Information dialog  74
adding tasks to Timeline  83
changing constraints  383
changing default task type  187
changing task Type and Effort Driven settings  

348
entering constraints  256
entering cost resources  281
entering costs  330
entering deadlines  245
entering dependencies  219
General tab, Estimated option  183
Mark task as milestone feature  142
removing a deadline  246
setting constraints  257

Task Inspector panel  638
Task Inspector view  92

identifying drivers of a task  446
task lists, importing from SharePoint into Project  

153
Task Mode field  184
Task Name field  316

inserrting into Gantt Chart for entering estimates  
184

Task Name Field, Outline Code  145

Task Path feature  234, 446
tasks. See also WBS

Active vs Inactive group  524
adding to Timeline view  83
assignment updates, setting task type  483
auto scheduled  138
best practices checklist  623
breakdown in working time  166
breaking long tasks into shorter one  383
changing default task type  187
copying and moving  149–151
cost resources assigned to  281
deleting  148, 388
detail  312
developing work breakdown structure  119
direct and indirect relationships among  233
display of different types in Network Diagram  

78
duration and work effort  175
duration considerations  129–131
editing  74
editing fields for multiple tasks  192
editing name in WBS  146
entering and choosing options for  133
entering detail tasks  140
entering duration estimate for Fixed Duration 

tasks  185
entering duration or business day estimates  176
entering milestones  141
entering summary tasks  139
entering work effort or person day estimates in 

Work field  177
entering work estimate for Fixed Work tasks  

186
estimating process for types of tasks  180
excluding from automatic leveling  417
exporting and synchronizing from Project to 

SharePoint  153
fixed costs for  331
Fixed Work and Fixed Duration  179
in Gantt Chart view  75
grouping  524
help with, using Task Inspector  92
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identifying tasks with potential time savings  
378

importing  151
importing/exporting using SharePoint 2013  

152
inactive  461
with incomplete estimates, entering  175
inserting into consolidated schedules  647
inserting multiple  148
manually scheduled  138
moving  150
naming  126
not needing links  233
Outline Numbers  145
planned with fixed formulas  582
planning processes  118
recurring  190
revealing levels  144
split  189
structure in Project 2013  137
in Task Usage view  78
too many, in WBS  128
types of  134–137
types of, assignments and  341–343
updating  465–476
updating, situations encountered in  475–482
weighted milestones  583

Task Status Report  535
Tasks with Fixed Dates filter  260
Tasks with missing baseline info filter  456
Tasks Without Dates filter  520
Task tab, Properties group

View Information  192
Task Usage view  333

budget resources, time-phased  334
changing assignment attributes  338
grouping on assignment fields  525
preparing for updating costs  490
selecting fields to display in timescale  547
tasks planned with fixed formula for EVM  582

task views
default EVM tables and fields  596

TCPI (to complete performance index)  577

team members, helping in constructing the WBS  
125

Team Planner view
manually leveling workloads visually  405

template files  52
templates

creating from lessons learned on completed 
project  610

creating new schedule from  97
local or online, creating projects from  94
personal, creating new project schedule from  94
using a project template  97

temporary availability of resources  253, 289
Temporary Pool (Status Bar)  148
tendencies (flexible) constraints  249
Test for Graphical Indicators  515
text

formats for  546
formatting for Gantt Chart task bar  559

Text1 - Text30 fields  512, 514, 588
text boxes

spell checking  552
Text Styles dialog

adjusting text styles  555
changing color of critical task names or back-

ground  371
text wrapping  518, 556
the Ribbon. See Ribbon
three point estimates  160
time. See also optimizing

checklist for finding potential time savings  379
checklist for optimizing  445, 632
identifying tasks with potential time savings  

378
management help in Project 2013  357
optimization checklist  445
optimizing for  359
optimizing for, steps in  369
optimizing for, techniques  361–369

time-based schedule measures, forecasts with  578
time buffers. See buffers
time estimate at completion (EACt)  578
Timeline  67
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Timeline view  540
showing in combination views  86

time-phased budget resources  334
time-phased budgets

EVM measurement techniques and  580
time-related costs  295
timescale

cropped timescale in printout  562
deadline arrow  246
in Gantt Chart view  75
shortening or stretching  553
viewing for entire project in Gantt Chart view  

557
Timescale dialog  544

formatting timescale for display in Gantt Chart  
557

time schedule performance index at completion 
(SPIACt)  579

timesheets
creating in Resource Usage view  485
transferring information into the schedule  483
updating assignments with  465

time spent at work, breakdown of activities  166
time units

Display options for this project  183
for entering work and duration  182

time variance at completion percentage (VACt%)  
578

time variance at completion (VACt)  578
Title field (Properties dialog)  96
to complete performance index (TCPI)  577
to-do lists in Calendar view  544
tools and best practices checklist  617
tools for checking schedules  618
Total Slack

checking  626
total slack (TS)

calculating  365
displaying  372
tasks with unreasonably large amounts of  232

Touch/Mouse mode  57
touchpad, right- or double-clicks  68
Tracking Gantt view  79

baseline schedule in  453
critical path in  366
displaying project progress  463
showing dependencies  546
showing or highlighting critical path in  370

Tracking Gantt with Milestones Filter  540
tracking progress  79
Tracking table  517
tracking, using schedules  42
Trust Center  151

Macro Settings  563
TS. See total slack
ttme schedule performance index at completion 

(SPIACt)  579
24 Hours calendar  106
Type field

Fixed Units  105
inserting into Gantt Chart for entering estimates  

184
in Resource Sheet view  81
resources  273, 281
setting for assignment updates  488
setting for tasks to update  474

U
Undo

multiple levels of  446
unit-related costs  295
units

assignment, in percentages or decimals  311, 
323

assignment units no longer automatically chang-
ing  345

assignment versus peak units  347
automatic calculation of assignment units by 

Project  326
display when working with assignments  313
for material resources  329
modifying assignment units, triggering recalcula-

tion by Project  323
Percent Physical Units Complete  585
of resources  270, 312

Units field  270, 291, 296, 297, 309
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entering work in  324
remaining unchanged for existing assignments  

346
units of measurement

for material budget resources  282
metric scale or U.S. units, for reports  532, 537

unknowns in estimating  162
dealing with, using living document approach  

165
resources  163
unknown events, rolling wave approach  162

Unlink Tasks command  217
unscheduled tasks, creating  175
updating schedules  451–496

assignments  482–488
baseline  453–459
basic steps in process  452
checklist for best practices  491, 633
costs  489–491
after entering change  233
failure from incomplete network of dependen-

cies  230
manually scheduled tasks  482
new activities, on the fly  481
performance measurement baseline  593
showing progress  463
strategies for  465–467
synchronizing with client reporting periods  462
task completed as scheduled  476
tasks finished late or early  479
tasks running as scheduled  476
tasks running behind  476
tasks started late or early  478
tasks taking longer or shorter time  478
task updates in more complex situations  480
task updates out of sequence  481
updating tasks  467–476

URLs (SharePoint site)  153
use-related costs  295
user information, administering  65
user interface

main screen  66
mouse or touchpad, right- or double-clicks  68

moving around in a project  69
Network Diagram view  77
Quick Access Toolbar  57
views  71–87

User Name option  104
user profile  553
Using Resource dialog  544
Using Resource… filter  520
U.S. measurement units  537

V
VACT% (time variance at completion percentage)  

578
Value field, Filter Definition dialog  521
variable costs  295

entering for work resources  328
variances

fields for  589
schedule variance (SV)  576
time variance at completion (VACt)  578
variance at completion percentage (VAC%)  578
variance at completion (VAC)  578

Variance table  517
varying availability of resources  290
varying cost rates  297

entering for resources  301
VBA (Visual Basic for Applications) editor  564

writing VBA code to create a macro  565
verifiability in a project  122
View Bar  68

displaying and selecting views  85
View Definition dialog  415, 527
views  71–87

components of  526
copying between projects  529
creating  527
creating combination view  86
customizing  510
Format tab  545
Gantt Chart  75
page setup options for task views  550
printing to communicate information  500
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Quick View Switching and Zoom (Status Bar)  
148

Resource Form  84
restricting ability to insert/display fields  310
single versus combination view  85
switching  85
switching from compound to single  87
table views  516
Tracking Gantt  79
using as EVM reports  596
using to create reports  510–529

View tab (Ribbon)
Split View group  86

Visio
viewing only Visio reports  531

Visual Basic for Applications (VBA) editor  564
writing code to create a macro  565

Visual Reports  500, 530–540
modifying  535

Visual Reports – Create Report dialog  530
Visual Reports-Field Picker dialog  537
Visual Reports-New Template dialog  536
Visual Reports-Save Reporting Data dialog  538

W
waiting time, inclusion in estimates  178
WAV Download Resource Center  640
WBS Code Definition dialog  145, 648
WBS Codes  145

customizing  145
displaying customized codes  146

WBS (work breakdown structure)
checklist for evaluating  623

weather restrictions, representing with constraints  
253

website for this book  640
weighted factors system  594
weighted milestones  583
windows, sliding window handle  87, 325
Windows systems

changing date order  546
setting date order  103

work

Actual Work + Remaining Work = Work  464, 
488

Baseline Work Report  534
calculating, Duration * Units = Work  178
defined  312
entering budgeted hours for  333
entering estimate for Fixed Work tasks  186
entering in Units field  324
Percent Work Complete  584
recalculation triggered by assigning resources  

315
Resource Work Summary Report  534
task type impact on  347
Work table  517

work breakdown structure (WBS)  119
checklist for evaluating  154
collapsing and expanding levels  76
control accounts for EVM  580
creating hierarchical WBS  142
defined  119
dictionary  126
editing a task name  146
entering tasks and choosing options  133
example of  120
in Gantt Chart view  75
as hierarchical decomposition  119
importance of  132
importance of right level of detail and structure  

130
indented list or organization chart format  123
information at middle level, EVM and  596
level of detail  127
logic for being deliverable-oriented  121
modifying to consolidate projects  648
names and descriptions of deliverables  125
organizing  120
questions identifying too little detail  127
structural rules for  131
task duration considerations  129–131
task structure in Project 2013  137
too many tasks in  128
top-down and bottom-up approaches to  124
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Work Budget Resources  282
work contours  340
work effort

duration versus  175
entering estimates into Work field  177

Work field  310, 486
automatic calculation by Project after assign-

ments  326
changing value for Fixed Duration tasks  349
comparing Budget Work field to  282
entering estimates into  177
inserting into Gantt Chart for entering estimates  

184
time units used in  182

working hours  106
working time

basic types of activities in  166
calendar days and  177
Change Working Time dialog  106
changing default in Details dialog  111
compressed workweeks  292
editing on resource calendars  284
entering alternate work weeks  111
entering resource calendar exceptions  287
entering working days and hours for resource 

calendar  285
Hours per Day option versus  109
one-time and recurring calendar exceptions  

112–114
overtime availability  294
pure work time or gross work time  166–169
temporary availability of resource  289
varying availability of resource  291
working hours set in resource calendar  292

workload histograms  541
workload leveling. See leveling workloads
workloads

checking in Resource Graph  399
checklist for evaluating  632
optimizing, checks on  444

workload smoothing, facilitated by RCS  431
Work Overview dashboard  506
work resources  270, 273

entering availability  280
entering budget costs  333
maximum availability to project  274
Max Units of, assignments in Assign Resources 

dialog  323
overtime rate  275
standard rate for  274
time-related rate  280
variable costs for  328

work week, alternate  106
Work Weeks tab (Change Working Time dialog)  

108
entering hours for alternate work weeks  111
opening Details for Default dialog  110

wrapping text  518
task names in Gantt Chart view  556

X
XML Paper Specification (XPS) format  553

Y
yes/no information in Flag fields  513

Z
zero slack  365
zooming

Entire Project zoom  378
Quick View Switching and Zoom (Status Bar)  

148
using zoom slider on status bar or View tab 

Zoom group  557
wrong zoom factor in printout  562

Zoom Slider
adjusting level of detail with  224
using to set time period for budget values  334
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